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Introduction 
If you have ever wanted to learn about using either the Microsoft operating system or 
the Mac operating system, along with productivity tools necessary for the modern busi-
ness world, then this book is for you. You might be a new student who has little to no 
experience with this type of software or maybe you are a novice computer user wanting 
to learn to use an alternative platform; in either case, you should find this book to be a 
helpful and constructive companion on your journey. 

When we first started looking at developing an introductory textbook, we noticed 
that a variety of schools offered intro courses that focused on the Microsoft environ-
ment, yet many students seemed to be showing up to class with Apple. Through the 
years, we have noticed that students come to class with both Microsoft and Apple prod-
ucts and there has never been a book that could successfully address both versions of 
the software used in the course. 

We have yet to find an introductory textbook that offers the range of alternatives 
that this book offers. Microsoft Office 365 and Beyond is divided into five sections with 
16 chapters that progressively introduce you to computer concepts from the moment 
you hit the power button all the way through to using a variety of productivity software 
applications available in Microsoft Office 2013 and Microsoft Office for Mac 2011.

Section I is composed of six chapters that introduce you to the computer environ-
ment. In Section I, you will learn about hardware and software, including everything 
from turning on your computer to identifying its major hardware components, no mat-
ter which platform you are using. Here you will also learn about using the Web and 
email functionality on a variety of platforms.

Section II is composed of three chapters and introduces you to word processing soft-
ware that includes Microsoft Word for both the Mac and Microsoft environments. Here 
you will learn to develop basic word processing documents, as well as add advanced 
functionality.
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Section III is composed of three chapters and introduces you to presentation soft-
ware that includes Microsoft PowerPoint 2013 and Microsoft PowerPoint for Mac 2011. 
In this section, you will learn how to plan your presentation as well as how to build 
advanced presentations that incorporate a variety of media elements.

Section IV is composed of three chapters that introduce you to spreadsheet software. 
Just about any type of organization uses spreadsheet software to transform data into 
useful information that adds value to the organization. In this section, you will learn 
how to manipulate data by developing useful spreadsheets and to present data visually 
using graphics and charts.

Section V is composed of a chapter which introduces you to the world of databases 
using Microsoft Access 2013 (which is only available for the Microsoft operating sys-
tem). Databases are much different than spreadsheets, although at first you might think 
they are similar. By using Access, you can establish complex relationships between data 
sets, populate a database with data, and develop powerful queries that produce useful 
information.

The appendices of the textbook have information on other common computer appli-
cations, including Adobe Reader (for reading PDF files) and Microsoft OneNote for 
Windows (for managing files). Additional productivity tools like OpenOffice.org are pre-
sented here as well with some instruction on how to complete the chapter projects using 
this software suite.

Chapter Structure
Each chapter is structured to provide an overview of the key concepts in order for 

you to demonstrate mastery at the completion of the chapter project. The sections on 
productivity software include a project for each chapter with detailed descriptions of 
how to use the various tools, functions, and commands in the respective software pack-
ages. In addition, we include the theory and history of how these applications have 
evolved and information on how these applications can be used to accomplish multiple 
tasks. Finally, chapter review questions and “Knowledge Checks” are provided to test 
your comprehension of the chapters. 

Each chapter contains in-text activities that give you hands-on practice as you move 
through the chapter. You will also be given practice exercises for basic comprehension 
and challenge exercises to move you toward a higher level of mastery for the concepts 
presented in the chapter.

Companion Disc (Student Resource DVD)
The textbook provides a DVD inside the back cover that includes resources for the 

student. This DVD includes all of the files needed to complete the chapter exercises 
within the text. You will also find video tutorials, a repository of high-resolution images 
from the chapters, and samples of completed projects for comparison. 



Instructor Resource DVD (Available Upon Adoption)
The instructor DVD contains the complete set of video tutorials, all the solutions for 

the Knowledge Check exercises, PowerPoint presentations for each chapter, high resolu-
tion color figures, and sample tests for each chapter to use in conjunction with the book. 

Online Resources
Digital versions of the text and all of the instructor and student materials are avail-

able at www.authorcloudware.com. Electronic review and desk copies are also available. 
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CHAPTER  

1
Introduction 
to Computer Concepts

IN THIS CHAPTER

This chapter is an introduction to foundational computer concepts. You will 

learn how to perform basic tasks on a computer and identify hardware interfaces 

on your machine. You will also learn about the essential components that allow a 

computer to function. Once you have completed the chapter, you will be able to:

●	Discuss modern computer systems

●	Choose and identify an adequate computer specific to 
your needs based on software requirements

●	Explain how a computer works

●	Identify input and output devices

●	Identify modern operating systems

●	Demonstrate basic tasks on commonly used operating 
systemsMicrosoft Office 

2013/365 and 
Beyond

MSOffice-Beyond-CH01.indd   1 6/24/2014   9:34:15 AM
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absolutely everywhere in our daily life, and 

they come in many forms, such as desk-

top computers and laptops, and in cars, 

boats, airplanes, and phones. The desktop 

computer found in our homes and schools 

uses powerful applications that enable 

you to send email, develop professionally 

formatted documents, and process finan-

cial data for either personal or business 

applications.

If you are just getting started with com-

puters, the actual thought of turning on the 

computer can be overwhelming, but there 

is no need to panic. This text will guide you 

to proficiency in both basic computer opera-

tions and productivity tasks. A computer 

system works with two elements: software 

and hardware devices. The following sec-

tions introduce you to these terms so you 

can get a better understanding of how your 

computer operates. 

Computer Software
A software program is also referred to 

as an application. Applications are devel-

oped by computer programmers and are 

used to perform a series of tasks that 

1.1.1

WHAT IS A 
COMPUTER?

Computers are widespread throughout 

today’s world, whether for home or busi-

ness use or in a handheld device. All of these 

devices are centered on the fundamental 

need to manage, store, and use informa-

tion. On a personal level, you probably have 

information that is important to you and 

that you need to access on a regular basis. 

This can range from phone numbers and 

addresses of family and friends to account 

information for a variety of services.

Organizations have the same needs 

when it comes to information, as they must 

constantly innovate to maintain a com-

petitive edge. Organizations have two very 

important assets that contribute to research 

and development, which in turn leads to 

increased profitability. The first important 

asset is the intellectual capital the organi-

zation maintains. Intellectual capital is the 

knowledge derived from ideas and innova-

tion from its personnel. As a result, organi-

zations develop large amounts of data that 

must be processed into useful information. 

To do this, they use the organization’s infor-

mation systems infrastructure, which is 

the second important asset an organization 

maintains. In this chapter, you will learn 

about the foundational component that 

helps to create, process, and store the infor-

mation people need to operate as businesses 

or individuals in the world today: the mod-

ern computer.

Computers are used to convert 

data into useful information. They are 

1.1 A COMPUTER is an electronic program-
mable device used to store, process, and 
manipulate data.

An APPLICATION, or software program, 
is an executable piece of code that runs on 
computer hardware to perform a specified 
task. Applications can be automated to 
run without user interaction or they can 
be interactive, requiring input from the 
user to perform some task.
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Computer Hardware
Hardware is any physical device that is 

attached to the computer. Hardware devices 

come in many forms, such as input, pro-

cessing, data storage, and output devices. 

Common input devices are the keyboard, 

mouse, and video camera (or Webcam). An 

input device is any physical interface that 

accepts information from the user and 

translates it for use inside the machine. For 

instance, you press a key on the keyboard 

and the code for the key you pressed is 

translated for the computer to understand. 

Processing of input data happens 

through a microprocessor. The micropro-

cessor that controls the overall operation of 

the computer is called the central processing 

unit (CPU). Computers can have one proces-

sor or multiple processors that comprise the 

CPU. Other devices, such as video cards and 

sound cards, which provide enhancements 

to the computer system may also contain 

their own processors. 

In addition to processing information 

for use, the computer needs somewhere to 

store the information. A data storage device 

is a hardware device that saves data and 

information to a location where it can be 

accessed later. A common example is a hard 

drive (also called a hard disk). There are also 

attachable devices such as flash drives or 

1.1.2process data in some way. One of the most 

important software programs on your com-

puter is the operating system (OS). The OS 

can be viewed as the manager of the other 

software on your machine; this program 

takes the commands you input and trans-

lates them into actions in the computer, 

such as running other applications or stor-

ing information. Some other software pro-

grams you may recognize are the Microsoft® 

Office suite; this is an example of productiv-

ity software, which typically contains word 

processing, spreadsheet, and presentation 

applications. 

There are two types of common software 

applications with which you should become 

familiar. The first type is the client-based 

program. These programs are installed with 

a disk or downloaded from the World Wide 

Web (or Web) and installed on the computer. 

These types of applications assist a user in 

performing common tasks. Microsoft Office 

is an example of a client-based software 

program.

The second type of application is the 

Web-based application, and it is accessed via 

the Web. Examples of Web-based applica-

tions are a Web portal, such as the one you 

use to access your bank checking account 

balance, and an online store, such as www.

amazon.com, where you can safely shop and 

conduct secure financial transactions. As 

connections among computers have become 

more common and more robust, the number 

of applications that are available on the Web 

has increased dramatically.

HARDWARE is a physical device that performs 
some function in allowing the computer system 
to run. Common types of hardware are input 
devices, processing devices, data storage devices, 
and output devices.
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Colossus was used by the British military 

to successfully break the famous German 

Enigma cipher. For its time, this was a mas-

sive achievement that was partially respon-

sible for the defeat of Germany in World War 

II. The development of Colossus and the 

construction of the vacuum tube computer 

ENIAC in the United States around the 

same time were important stepping stones 

toward the modern computing model. While 

these early computers were big enough to 

fill an entire room, they could only perform 

limited calculations.

In the 1970s, silicon chips, the foun-

dation for today’s high-speed computing 

devices, were developed. These chips allowed 

computers to become faster, smaller, and less 

expensive, leading to the computing devices 

you see today. Today’s mobile devices, such 

as smartphones, have millions of times more 

capability than early computers because 

of the advent of silicon-based chips. The 

advancement in computing technology 

continues. For the foreseeable future, com-

puting devices will continue to get smaller, 

faster, and more powerful with increased 

processing and data storage capabilities. 

PURCHASING A NEW 
COMPUTER SYSTEM

Now that you have learned about some 

aspects of a computer system, how do you 

know which system to buy? You may have 

gone to the local computer store and been 

tempted to purchase the most expensive 

system, but that may not be the best solu-

tion for your needs. Purchasing a computer 

can be accomplished most effectively by 

1.3

external drives that can be added for addi-

tional storage space. 

Output devices translate information 

back to the user. The most common example 

of an output device is the computer moni-

tor; this translates the internal information 

of the machine into a viewable output signal 

that you can understand. Additional exam-

ples of output devices include printers and 

speakers.

HISTORY AND 
BACKGROUND 
OF COMPUTING 
TECHNOLOGY

Now that you have some understand-

ing of the different elements of a computer, 

you may be wondering where and how com-

puter technology came about and how you 

know it works. It is important to note that 

the principles that drive a computer sys-

tem have been around for a very long time. 

Ancient civilizations as long ago as 4000 

B.C. in Sumer began to try to organize data 

into useful information on clay tablets. The 

abacus, one of the earliest forms of a calcu-

lating device, was developed in Babylonia in 

approximately 3000 B.C. 

These early computing tools were not 

electronic but rather were mechanical 

instruments that assisted in computation. 

It was not until 1943, after much research 

on the theory of digital circuits and other 

developments in computing, that Colossus, 

a British computer, became operational. 

Because this was a wartime project, it 

remained classified for a number of years. 

1.2
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guide your computer purchase or direct your 

concentration as you go through the rest of 

the text. Be sure to focus on the areas of com-

puting in which you have the greatest need.

There are many other questions to 

answer. For example, what size and type of 

monitor do you need? Smaller monitors can 

be strenuous on the eyes, so a bigger moni-

tor is usually better; in a laptop environ-

ment, however, a larger monitor means a 

heavier machine. Memory is another factor 

to consider. There are two types of computer 

memory: random-access memory (RAM) 

and read-only memory (ROM). RAM is 

volatile memory; this means it is temporary. 

Anything stored in RAM is lost once the 

computer is turned off. You can run mul-

tiple applications more smoothly when you 

have more RAM, as an increase in RAM can 

improve performance. ROM, on the other 

hand, is not volatile. This means that when 

you shut down your computer, the last set of 

instructions and the data you have saved to 

ROM are not lost.

Other options to examine include data 

storage capability such as hard drive space. 

The growth of technology in data storage 

solutions has made hard drive technology 

affordable to most users. Hard drives have 

two aspects to consider: storage space and 

speed. The faster the hard drive speed, the 

faster data travels. Normally faster and 

higher performance applications benefit 

from the increased speeds, however, these 

speeds are not generally required for the 

average user.

Storage space allows you to keep more 

data in your hard drive, such as pictures and 

knowing what to look for and by conducting 

a little research. A computer purchase must 

be made based primarily on the require-

ments of its use. If you were to buy the most 

expensive system, you might just be spend-

ing money on processing power and storage 

space you will never need.

The first question to ask is: What tasks 

do you need to perform on the computer? 

You may simply want to surf the Web and 

perform basic functions like word process-

ing and email. Or you could require the 

much heavier processing power associated 

with computer gaming applications. The 

next question is: What system requirements 

does the software have? One way to begin 

your research is to simply take a look at the 

processing requirements of the applications 

you intend to use. For example, you can 

find the system requirements for Microsoft 

Office on the outside of the packaging for 

the application or look for the information 

on the Web at the Microsoft TechNet site 

(http://technet.microsoft.com/en-us/library/

ee624351.aspx). Finding the correct hard-

ware requirements for the software you 

intend to use and taking the largest value in 

each category will give you a good idea of the 

minimum requirements for your system.

Activity 1.1—
Computer Needs

For this activity, you will identify the 

primary reasons why you need to use a 

computer. You can make the list as exten-

sive and detailed as you want, but the main 

goal should be to identify the daily tasks you 

will perform on the machine. This will help 
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entire environment should be kept free of 

dust to enable a long life for the system. 

Dust is one of the biggest enemies of elec-

tronic components. Note that this particular 

motherboard has a video card and a sound 

card that fit into its expansion slots.

Sound and video options can also be 

a factor in your selection of a new system. 

Many computer systems include an inte-

grated sound card. These sound cards are 

more than adequate for the average user. 

Video cards also come integrated to deliver 

information to the computer monitor but 

can be upgraded to much higher quality 

cards that improve video output. If you are 

the average user running office applications 

and email, you may not need a very high-

quality video card. If you like to edit video 

or play performance-intensive computer 

games, then a more expensive and capable 

video card is most likely necessary.

Other factors to consider include oper-

ating system. These more advanced topics 

are discussed in the next sections, but it is 

important to realize that there is a differ-

ence between operating systems and how 

they perform. While the Windows® 7 and 

Windows® 8 operating system are more 

widely used, there are other operating sys-

tems to consider, such as the Apple® Mac® 

OS X® and Linux®. Macintosh® operating 

systems are generally considered to be more 

secure than some other brands of OS. 

Ergonomics are also a consideration 

when deciding on a computer purchase. 

Ergonomics include your posture, how you 

sit, and how your hands rest on the key-

board. Keyboards and computer mice, along 

video. If you take lots of digital pictures and 

video, then a larger hard drive is essential. 

Most computers today have hard drives in 

the range of 500 GB (gigabytes) to 1 TB 

(terabyte) of storage space.

Figure 1.1 shows the inside of a personal 

computer (PC). Note that this is an older 

model and could be classified as a midrange 

system. The layout is similar to many of the 

systems you find today. Notice the moth-

erboard in the background of the picture; 

this in essence is the heart of the computer 

chassis in every system out there today, as it 

provides the connections between the vari-

ous hardware components and disseminates 

electrical power. The item in Figure 1.1 

labeled “Microprocessor” has a silver slotted 

appearance; this is the heat sink that keeps 

the small CPU cool enough to operate safely.

You can also see the power supply that 

powers the motherboard and the memory 

modules. This 

 FIGURE 1.1
Sample inside of a 
personal computer 
chassis

RAM modules

Power supply

Video card

Sound card

Motherboard

Microprocessor
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the center of the modern desk-

top computer is the CPU that is 

attached to the motherboard. The 

motherboard is the interface that 

allows the user to connect physi-

cally attached hardware devices to 

the computer. When a power but-

ton, like the one shown in Figure 

1.2, is pressed, the computer power sup-

ply converts the 120 volts of electricity it 

receives from the outlet to 12 volts, which 

moves into the motherboard at the speed of 

light.

This process happens practically 

instantly as the electrons travel at approx-

imately 186,000 miles per second. The 

instant power enters the motherboard, 

it powers up the BIOS. The BIOS, or the 

basic input/output system, is the firmware 

(or software built into the computer) of the 

machine and is the first software that loads 

from the ROM (which as you might remem-

ber is nonvolatile, meaning that it does not 

go away when the computer is turned off). 

The BIOS handles all input into the com-

puter when it is first turned on and handles 

all of the hardware attached to the mother-

board, including everything from the key-

board to external disk drives.

The BIOS signals the hard drive to spin 

up and load the operating system, which is 

the user interface you see when you turn on 

the computer, such as the Windows 7 oper-

ating system. The BIOS also manages the 

boot order; this is the order in which the 

hard drive or disk drive loads up during the 

power-up operations. The process of initial 

startup where the motherboard is powered 

with special office furniture, are some-

times included with a computer purchase. 

Ergonomically correct computer equipment 

can be helpful, but you should always test 

any products under consideration to be sure 

you have the right product for you. 

Additionally, there are a number of 

options for purchasing a computer. You can 

find equivalent value on a new system either 

online or in a physical (brick and mortar) 

store. Whether you purchase a Mac or PC, 

there are several steps to take before getting 

started. Most systems provide quick-start 

guides that guide you through the process of 

unpacking and installing your new system. 

One of the first steps after connecting the 

external hardware as instructed is pressing 

the power button. If you have purchased a 

new system, you will be guided through sys-

tem setup when you first start the machine.

HOW THE 
COMPUTER WORKS

So far you have learned that a computer 

can accept data, process data, store data, and 

output data. There are several hardware 

components and software that help modern 

computers complete this series of tasks. At 

1.4

The power button is located in different places 
depending on which system you purchase, but it 
is usually at the front of the computer as shown 
in Figure 1.2. It looks like a 1 character inside of 
a 0 character. This was originally two separate 
characters signifying on and off, respectively. 
However, as technology evolved, it became eas-
ier to use the same pushbutton switch for both 
powering up and powering down a computer. 
Finding the power button should be your first 
task on any computer system.

 FIGURE 1.2
iMac power button
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hardware and basic maintenance activities, 

especially if you ever want to open your 

machine chassis. It is also important to rou-

tinely use an air can, available at computer 

stores, to blow dust out of the inside of the 

computer chassis. Dust should be blown 

from all components, the power supply, and 

system fans.

Input Hardware Devices
Input hardware devices are responsible 

for providing input to the computer system. 

For example, a mouse, a keyboard, a video 

camera, and a microphone are all consid-

ered input devices. In order to use all of 

these hardware devices, the computer must 

have the proper drivers installed so that the 

devices all work correctly. 

1.4.1

up, hard drives spin, and the operating sys-

tem loads is known as the booting process. 

Once the computer has booted up, it 

continues to load any required default appli-

cations and hardware. Another important 

hardware device that starts up during boot 

up is the video card. The video card trans-

mits data to your monitor so that you can see 

the user interface or the operating system 

screen. The BIOS also runs initial system 

checks such as verifying that the memory 

chips are all working and functional. 

The BIOS is also responsible for load-

ing up system drivers that allow compat-

ibility between the motherboard and the 

hardware. For example, you may have 

purchased both a computer and a printer. 

Proper installation of the printer requires 

installation of the system drivers. Each indi-

vidual computer platform (whether Mac or 

Windows) requires system drivers for effec-

tive compatibility with associated hardware 

devices. 

Proper care and safety procedures are 

important for any computer. It is impor-

tant to understand the basic operation of 

With most systems, you can usually hit one of the 
function keys at the top of your keyboard, such as F8 
or F11, to enter the BIOS system menu. Through this 
menu you can check such things as the microproces-
sor temperature (either one or multiple processors if 
equipped) and system fan operation. Computer opera-
tions produce a great deal of heat and require the use 
of fans to keep the system cool.

A DRIVER is software code written by a hard-
ware manufacturer that tells the hardware device 
how to communicate with the operating system.

Always keep in mind that the motherboard 
contains capacitors that can discharge danger-
ous or even potentially deadly voltage several 
minutes after the computer has been shut 
down. It is imperative that you not open the 
cover of the computer until the capacitor has 
discharged after the computer has been shut 
down and unplugged from the power supply. 
The time frame of discharge and the danger 
level of the capacitors will vary by computer; 
generally, the smaller the machine the less 
time it will take and the less you need to worry 
about the capacitor voltage. You can assure 
your safety by wearing an anti-static wrist 
strap and keeping the computer and its com-
ponents off of external metal surfaces when 
working with the internal components of the 
machine. Always check the system documen-
tation to determine how to open your com-
puter chassis cover for maintenance and how 
long you should wait for the capacitors on the 
machine to discharge. This is not an activity 
for novices.
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Companies can use them to monitor secu-

rity and provide training events. The data 

stream for a video camera can be saved in a 

digital format on the computer’s main hard 

drive or even an external hard drive.

Output Hardware  
Devices

Output devices are used to process 

output data feeds from the computer. This 

is usually done as a result of data that has 

been processed through the computer in 

some fashion. The most common output 

device is the computer monitor screen; this 

provides a visual interface between the user 

and the computer. Most monitors today are 

liquid crystal displays (LCDs), which pro-

vide a sharp image and transmit video data 

streams to the user. Additionally, there are 

overhead projectors that can display your 

computer screen directly on a wall; this is 

useful for showing multimedia presenta-

tions to large crowds. 

Another example of an output device 

is a printer. A printer produces printed 

pages that contain output from an appli-

cation. Some printers can also be used as 

input devices; for example, you may have 

seen printers that are referred to as all-in-

one devices that have built-in fax machines 

(which can both send and receive faxes) and 

scanners (which convert an object or text 

into a digital image). Some printers have 

document feeders that allow you to make 

copies of important documents.

Your computer’s speakers are another 

common output device. The speakers are 

integrated devices within a laptop but are 

1.4.2

The keyboard is the most common type 

of input device and is used to type instruc-

tions to the computer. The keyboard plugs 

into the desktop computer using a USB 

port and transmits a signal for further pro-

cessing. The keyboard can also be used to 

execute shortcut key instructions such as 

Ctrl-C (which is a shortcut for copying text 

or an object from a document). 

The mouse is also a very common device 

and is used to move the cursor (which 

by default looks like an arrow) along the 

screen. The mouse also has two buttons (a 

left-click button and a right-click button) 

and an optional scroll button. You can use 

the mouse to point at an application and 

then double-left-click to execute the appli-

cation. You can examine the properties of a 

file or folder by pointing and selecting the 

right-click button on the mouse. The scroll 

button can be used to scroll through pages 

in a document that contains a scrollbar.

A microphone is another example of 

an input device that can be used for many 

purposes when properly installed with 

the assigned drivers on the computer. The 

microphone is generally plugged into the 

back of the desktop in the sound card audio 

input jack or one of the USB ports. This 

signal can then be used in many ways. For 

example, the signal can simply be stored on 

the hard drive and the file can then be pro-

cessed using some other application, or you 

might create a PowerPoint® presentation 

and want to add narration so that a viewer 

can listen and view slides simultaneously.

Video cameras are used extensively 

for Web conferences and to record video. 
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and storage devices via the BIOS firmware 

that resides in the ROM. The motherboard 

is the circuit board where the CPU and 

memory attach. 

All of these devices help to process and 

produce results based on the instructions 

received from the input devices. The CPU 

receives data transmissions as you have 

already learned, but what does the computer 

actually see? It is actually simpler than you 

might think. When you type a letter or num-

ber into your computer, the computer does 

not actually read or understand the charac-

ter you typed.

What the computer is really processing 

are ones and zeros. In the world of mathe-

matics, they refer to this number scheme as 

the binary system. For example, the decimal 

number 1 is interpreted as the 4-bit binary 

number 0001. Each digit in a binary num-

ber system refers to a power of two based on 

its position (beginning with 20 for the right-

most binary digit); each binary digit is called 

a bit. 

The binary system is a base two system 

in which each bit is double the value of the 

previous bit, following the pattern of 1, 2, 4, 

8, 16, 32, 64, and so on. The pure mathemat-

ics are beyond the scope of this text, but a 

1 in any of the positions for the bit indi-

cates that particular power of two should be 

included in the sum of the value to convert 

it to the decimal system with which you are 

familiar. An example of this is the binary 

number 0101, which converts to the decimal 

value 5. Even if you do not fully follow the 

logic of this, you should understand that the 

computer processes information using this 

externally attached to the desktop computer. 

On an iMac, the speakers are integrated 

output devices. External speakers are con-

nected directly to the sound card toward the 

rear of the desktop computer via the output 

sound jack that connects to the computer’s 

sound card. Other output devices include 

headphones that allow you to hear sound 

privately rather than through the speakers. 

Most sound cards have an output jack for 

headphones. 

Activity 1.2—Hardware 
Identification

Using your computer and the informa-

tion in this chapter, identify what ports your 

computer has available. All computers will 

have a port for a power cord to attach. Most 

modern computing systems will include one 

or more USB ports and an audio jack for 

speakers. Visit a computer store to identify 

several hardware devices that are compat-

ible with your computer. For instance, does 

your computer come with a DVD or Blu-Ray 

player? Which model would you be able to 

attach externally to your computer? Which 

printer model would work for the port that 

you have available? Identifying these will 

help you determine compatibility when you 

are making a purchase for a new component 

for your computer system or network.

Processing Hardware 
Devices

The main functions of the CPU are to 

process instructions, manage the flow of 

information, and perform calculations. The 

CPU is considered the brain of the computer 

and communicates with the output, input, 

1.4.3
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recovery technician, even in cases of fire or 

water damage. Secondly, you should always 

use a secondary storage device, such as an 

external hard drive, to back up all of your 

important files and photographs so you do 

not lose them. External hard drives are 

readily available and can be used to store or 

back up all of your system files and prefer-

ences. External hard drives usually come 

with either USB or FireWire® connections. 

Most hard drives come formatted to be used 

in either a Windows or Mac computer.

Disk formatting is the process of prepar-

ing a disk or hard drive for use with a partic-

ular operating system. This process installs 

the filesystem or structure compatible 

with the particular operating system. The 

Windows OS uses the New Technology File 

System (NTFS) filesystem format which is 

configured on your hard drive or disk at the 

time of formatting. On a Mac, you would 

need either a Mac OS (Journaled) partition 

if the disk is to be used for booting purposes 

or a Mac OS Extended (No Journaling) par-

tition if you will just be using the partition 

to store files, pictures, and video. 

A partition is a block of storage in a 

particular file structure that allows it to be 

accessed by the chosen operating system. 

You can set up multiple partitions on your 

hard drive at the time of formatting to allow 

for multiple purposes. For example, if you 

want to use an external hard drive on both a 

Mac and a Windows PC, you would create a 

Mac partition and an NTFS partition.

There are other types of data storage 

devices that you can use to store either 

backup copies or important files. Flash 

binary system, which equates everything to 

a yes or no value (or equivalently an on or 

off value).

Data Storage
You have already learned about com-

puter memory that stores nonvolatile and 

volatile memory on your computer. In order 

to store large amounts of data, though, you 

must have a hard drive. This is typically 

located inside your computer. The hard 

drive has a disk inside that can be rewritten 

repeatedly to store documents, video, multi-

media presentations, and photographs. This 

internal hard drive is also where your oper-

ating system resides, along with all of your 

system settings and preferences. 

Data on a hard drive is stored in a binary 

format of ones and zeroes using a magnetic 

storage technique. Hard disk data can last 

a very long time and information is rarely 

completely erased. Most people mistakenly 

assume that pressing the Delete button or 

emptying the Recycle Bin or Trash folder on 

your machine automatically deletes infor-

mation forever, but this is not the case; while 

the information is removed from the operat-

ing system’s repository, the data still exists 

on the drive until something else overwrites 

it. It is important to note that although 

sometimes hard drives fail or become dam-

aged, much, if not all, of the data can be 

recovered using special techniques. 

You may have heard someone men-

tion their computer breaking and losing 

their information. There are two important 

things to remember here. First, all of the 

data can probably be recovered by a data 

1.4.4

MSOffice-Beyond-CH01.indd   11 6/24/2014   9:34:16 AM



12 — Microso f t  Of f i ce  2013/365 and  Be yond

based on data that has been collected over 

time. Although these types of decision sup-

port systems continue to improve, they 

are far from being able to think or act like 

humans without human direction. All com-

puters, no matter how advanced they are, 

must be programmed to complete their 

assigned tasks.

This also means that the results a com-

puter provides are only as good as the data 

put into the system. You have probably called 

a bank, the human resources department at 

your employer, or a utility company, only to 

find they have incorrect information about 

you. This is an example of where a human 

enters incorrect data in the system and the 

computer system provides that same incor-

rect data back to the user. The computer 

lacks the ability to correct mistakes made by 

humans. There is no telling what the future 

holds as far as technology goes, but for now, 

computer output is only as good as the input 

provided by its user.

INTRODUCTION 
TO THE WINDOWS 
OPERATING SYSTEM

The Microsoft Windows OS is a graphi-

cal interface used to interact with the com-

puter and applications that reside on the 

hard disk. The new OS comes with many 

features that make working in the envi-

ronment easy and convenient. Microsoft 

currently has two versions of its Windows 

Operating System that are still widely used 

in the market: Windows 7 and Windows 

8. While most of the differences are cos-

metic, the shift in Windows 8 is significant 

1.5

drives (commonly called 

thumb drives), DVDs, 

and CD-ROMs are all 

commonly used for data storage. In any 

case, all data storage devices must be for-

matted for the correct operating system or 

media format desired. Figure 1.3 shows an 

example of a USB attached Western Digital® 

My Passport® 1 TB external hard drive.

What Computers Can 
and Cannot Do

Computers are not devices that can 

actually think or make decisions unless you 

program them to give you specific facts based 

on predetermined rules. In other words, 

computers are not self-aware. Despite the 

fact that they contain lots of processing 

power, computers are not able to make their 

own decisions nor do they have any feelings 

or morals. Computers must be programmed 

to complete every single task they perform.

Some technologies specific to the deci-

sion support field use advanced algorithms 

to help humans make the right decisions 

1.4.5

 FIGURE 1.3
Western Digital My Passport 1 TB external  
hard drive
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larger image as shown in Figure 1.5; this 

action displays a grouped image with a 

preview of all of the open windows for that 

application. By using the Aero Peek feature, 

you can also close files from the thumbnails 

themselves by holding your mouse over the 

application group and selecting the Close 

icon (which looks like an X).

The Show Desktop button on the bot-

tom-right corner of the taskbar (shown in 

Figure 1.4) can be used to quickly alternate 

between the applications that are open by 

minimizing them with one click (of the left-

mouse button) and maximizing them with a 

second click.

if you are familiar with previous versions of 

Windows. The next two sections will detail 

the basics of each of these versions.

Windows 7
You can see the basic desktop environ-

ment in Figure 1.4. This is the view you will 

see after you login to your computer. You can 

see the layout is similar to previous versions 

of Windows, but there are some differences 

that increase the ease of use.

The taskbar at the bottom of the screen 

has a new Aero Peek feature that lets you 

view thumbnails (preview images) of run-

ning applications. You can place your mouse 

over the icon for the application to see a 

1.5.1

Your application 
shortcuts are 

visibly displayed. 
Shortcuts can be 

applications,network 
connections, 
or folders.

The Windows 
Start button is 
used to access 
programs and 

files stored 
on your hard 

drive.

The Aero 
Peek feature 
is accessed 
on the lower-

left side.
The Show 
desktop 

button is on 
the bottom-
right side of 
the screen.

 FIGURE 1.4
Windows 7 
desktop

 FIGURE 1.5
Using the Aero 
Peek feature
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information, including the software 

that is running on the machine and 

the hardware components of the 

system. In Windows 7, you can find the 

system information by selecting the Start 

menu, choosing Computer, and then select-

ing System properties in the window that 

opens. When you have followed this pro-

cess, you will see a screen similar to the one 

shown in Figure 1.7.

Windows 8
Instead of going straight to the desktop 

view, Windows 8 uses a Start screen which 

has icons for your installed applications and 

apps from the Windows store. The Desktop 

is one of the apps that is shown in the lower-

right corner of the screen. You can click this 

icon to go the traditional Windows desktop 

view. You can see an example Start screen 

for Windows 8 in Figure 1.8.

The desktop environment for Windows 

8 is very similar to Windows 7 in appear-

ance. The Aero Peek feature is included in 

1.5.2

By clicking on the Windows Start but-

ton in the lower-left corner, you will see the 

menu shown in Figure 1.6. You have sev-

eral options here, including customizing 

the way listed applications appear. You can 

add programs to this initial menu list by 

right-clicking the mouse on the application 

you want to add and selecting Add to start 

menu. If you hold your mouse cursor (which 

looks like an arrow) over one of the appli-

cations, you will see all of the most recent 

files used within that particular application. 

In Chapter 2, “Navigating and Using the 

Computer Environment,” you will continue 

to learn more of the features available with 

Windows 7 and how to perform additional 

tasks with the operating system that will 

help you to refine your skills and become 

proficient with the Windows 7 OS.

Another important task on an oper-

ating system is to identify the system 

 FIGURE 1.6
The Windows 7 Start menu

 FIGURE 1.7
System properties for Windows 7
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would simply click the Windows logo that 

appears in the lower left corner of the inter-

face. If you click and hold on the Windows 

logo, you will be prompted with a menu that 

includes the Shut down or sign out option 

to close down your computer from the soft-

ware. You can also hold the power button to 

cycle through the shutdown procedure.

Windows 8 as well as the full file and folder 

structure common to Windows 7, so you 

can create shortcut icons on the desktop 

and use Windows Explorer to view folder 

contents. You can see an example desk-

top for Windows 8 in 

Figure 1.9. To get back 

to the Start screen, you 

 FIGURE 1.8
Windows 8 Start 
screen

 FIGURE 1.9
Windows 8 desktop environment 
and swipe menu
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interface used to interact with the computer 

and applications that reside on the hard 

disk and works in a manner similar to the 

Windows platform. When you first log into 

your computer, you are in the Finder win-

dow as displayed in Figure 1.10; this is the 

equivalent of a PC desktop or workspace.

The Mac platform is credited with being 

one of the most user-friendly operating sys-

tems, as well as an operating system that 

faces far fewer security threats than the 

Windows platform. If you are new to the 

Because Windows 8 is made primar-

ily for touch screen computers, most of the 

system activities you can perform are based 

on swiping left or right from the outside of 

the screen. Swiping in from the right to the 

center of the screen will open the menu for 

settings and customization. You can see an 

example of this in Figure 1.9. To get the sys-

tem information, you would swipe the right 

menu into view and choose Settings and 

then PC info. This will display the system 

information for the computer.

INTRODUCTION 
TO MAC OS X

This section is an introduction to the 

elements of the Macintosh OS X desk-

top. The Mac OS X platform is a graphical 

1.6

 FIGURE 1.10
The Mac OS X 
Finder window

Apple 
menu

Menu 
bar

The Dock is Mac’s launcher 
where you can place 

applications,files,and folders.
Unlike in previous 
versions of the 

Mac OS, the trash 
can is now located 

on the Dock.

Menu 
extras

Divider

Menu extras are located on the top right 
hand portion of the Mac OS window and 
let you control system volume or manage 
your Internet connections as illustrated in 
Figure 1.10.
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as a double-click) on an application’s icon 

opens that application. Minimizing applica-

tions is a matter of clicking on the yellow 

button at the top left of any application win-

dow; the application minimizes to the right 

side of the Dock. Chapter 2 will continue the 

exploration and use of the Macintosh OS X 

interface. As of OS X Mavericks, tabs are 

allowed in the Finder windows as well.

The Apple menu (as shown in Figure 

1.10 on the upper-left corner of the inter-

face) is where you can shut down or restart 

your system. Choosing the About This Mac 

selection provides information about system 

specifics such as operating system version 

and basic capability. Choosing Restart gives 

you the ability to restart your system, which 

is often necessary after system updates or 

software installation. It is important to save 

all of your important files prior to restart-

ing your system to avoid losing important 

information. 

Apple platform and are used to Microsoft’s 

products, there is a significant learning 

curve involved.

The Mac platform can perform the 

same tasks that a Windows machine can, 

although sometimes different procedures 

are necessary to achieve equivalent func-

tionality. The iMac desktop shown in Figure 

1.10 contains display features you might not 

recognize, but you must learn about these as 

a first step toward building proficiency with 

the Mac OS X platform.

Along the right side of the screen you 

will find the Macintosh HD icon. It is impor-

tant to note that Apple prefers users to keep 

their desktops clear of any icons. If you are 

using the Mountain Lion or newer version, 

you should not have anything on the desk-

top at all unless you upgraded from a previ-

ous version and you kept those icons on your 

desktop.

The Dock is the launcher for all of your 

programs and files; it is located along the 

bottom of the interface. The Dock has a 

divider line designed to keep applications on 

the left side and files and folders on the right 

side. You can easily drag new programs to 

the Dock or remove them by dragging them 

off of the Dock. The Apple menu, shown ear-

lier in the chapter, is used to shut down the 

computer or put it in sleep mode. You are 

also able to initiate software updates and 

adjust system preferences here.

The Sidebar (shown in Figure 1.11) is 

located on the left-side pane of every Finder 

window. The sidebar has four sections: 

Devices, Shared, Places, and Search For. A 

double left-click (hereafter referred to simply 

 FIGURE 1.11
The Mac OS X 
sidebar in the 
Finder window

Sidebar
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available to you depending on which sys-

tem you purchase. It is important to follow 

the proper shutdown procedure to prevent 

problems with your computer, such as data 

loss or corruption. Failing to properly shut 

down your computer can create issues with 

your system, which include the following:

•	Systems with system restore soft-
ware can fail during restoration if the 
system was in the process of saving 
important files supporting a restora-
tion point.

•	Losing files not saved due to improper 
shutdown.

•	Damage to hardware (on a Macintosh).

You can see an example Start menu 

(accessed through the icon in the lower-

left corner of the computer screen) for a 

Windows 7 machine in Figure 1.12; choos-

ing Shut down will close all applications and 

then terminate power to the machine. A 

closer look at Figure 1.12 reveals that there 

are a few other options available to you such 

as powering down your sys-

tem. Sleep is a power-saving 

measure that places your 

computer in a state in 

which you can save energy, 

yet quickly bring your com-

puter back up to where you 

left off so you can resume 

any activities you were per-

forming. Windows 8 has 

a similar menu when the 

Windows logo in the lower-

left corner of the interface 

is held down for a few 

seconds.

Activity 1.3—System 
Information

For this activity, you will follow the 

process for getting the system information 

for your computer. This should include the 

version of the OS that is in use along with 

the profile of hardware included on your 

machine. Follow the instructions provided 

for your OS in the previous sections and 

describe the information that is presented. 

When would this be useful or necessary 

information to have?

SHUTDOWN 
PROCEDURES

It is important not to treat the power 

button as a light switch; it does not simply 

shut down the computer. Although holding 

down the power button for immediate shut-

down might be your only option in some 

cases, it should be avoided whenever pos-

sible. There are several shutdown options 

1.7

Pressing the Start 
button and then 

selecting the Shut down 
button begins the proper 

shutdown process.

Selecting the right arrow 
button brings up a menu 

with more options.

The Shut down 
menu offers options 

including restarting the 
system or placing the 
system in hibernation 

or sleep mode.

 FIGURE 1.12
Start menu in Windows 7
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during a power 

outage. You can 

avoid this prob-

lem by using an 

Uninterruptable 

Power Supply 

(UPS). A UPS is 

basically a sys-

tem that plugs 

into the wall and 

keeps a battery 

inside charged; it 

contains a power strip that not only protects 

the power source, but also stabilizes the 

power level to keep your electronic equip-

ment from being damaged during a power 

surge caused by lightning or some other 

event. In most cases, UPS systems will 

detect the power outage and automatically 

shut down your computer in a predeter-

mined amount of time. 

The default Macintosh OS X operating 

system uses energy saver preference fea-

tures that place your Mac in sleep or idle 

mode when it detects a lack of activity. If you 

are using a Mac laptop, your computer will 

enter sleep mode automatically when you 

close the lid to your laptop. When a Mac is in 

sleep mode, three things will transpire:

1. The computer microprocessor reduces 
the amount of power consumption.

2. The video card turns off.

3. The hard disks turn off.

To place your Mac into sleep mode, 

select Sleep from the Apple menu, as shown 

in Figure 1.13. You will notice that the Apple 

menu contains several other options aside 

from Shut Down and Sleep.

Hibernate is primarily used in laptops. 

During hibernation, your laptop can be 

brought back up for use much more rap-

idly than from a completely powered-down 

state but slower than when in sleep mode. 

Hibernation mode is the setting that draws 

the least amount of power of all the power-

saving modes available. Hibernation actu-

ally places your open documents and files 

on the hard drive and then shuts down; this 

enables your laptop battery to last longer. 

The Shut Down menu offers additional 

options, including locking your computer. 

During computer setup you will be asked 

to create a username and password for your 

system. Many people mistakenly leave the 

password blank, making their computer 

vulnerable to security threats by unauthor-

ized users. Always be sure to set up a strong 

password that uses a combination of letters, 

numbers, and special characters. It is also 

important that you avoid using static pass-

words. A static password is a password you 

use for many systems. For example, some 

people will use the same password to log 

into their bank checking account system, 

school portal, and favorite shopping site. It 

is important that you develop unique pass-

words (known as dynamic passwords) for 

each system.

You can power down your Mac by 

selecting Shut Down from the Apple menu 

(accessed by clicking the apple icon at the 

upper-left corner of the computer screen 

as shown in Figure 1.13) is the safest way 

to shut down your computer to avoid caus-

ing hardware damage. Sometimes you 

cannot avoid improper shutdown, such as 

 FIGURE 1.13
Mac OS X Apple 
menu
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finished the process, press the power button 

again to start the computer and log back 

into the operating system. This whole proce-

dure can be done in one step by selecting the 

Restart option instead of the option to shut 

down the machine completely.

Activity 1.4—Shutting 
Down and Restarting
For this activity, you will cycle through 

the shutdown procedure for your computer. 

Shut the computer down using the proce-

dure for your operating system. When it has 

CHAPTER SUMMARY
This chapter provided an introduction to computer concepts and covered 

the hardware and software components used in modern personal computers. 

Additionally, you reviewed a brief historical basis for computer systems and 

pointed out the basic elements of both the Windows and the Mac platforms. This 

text is designed so that both Mac and Windows users are able to acquire enough 

knowledge to successfully start their computer and navigate the desktop. The 

next chapter will cover how to successfully manage files and folders. Users will 

develop proficiency in all of the basic tasks needed to successfully manage a 

personal computer at the operating system level.

CHAPTER KNOWLEDGE CHECK
What was the earliest device used for mathematical calculations?

 A. Abacus

 B. Clay tablet

 C. Bean counter

 D. Both A & B

The Colossus was the first vacuum tube-based computer used to crack the Enigma code.

 A. True

 B. False

1

2
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 options can also be a factor in selecting your new system.

 A. Sound and video

 B. Video and battery

 C. Monitor and video card

 D. Hard drive and ROM

The power button on a computer is always located on the back of the monitor.

 A. True

 B. False

A  is a system that plugs into the wall and keeps a battery inside 
charged. It contains a power strip that not only protects the power source, but also stabilizes the 
power source to keep your electronic equipment from being damaged during a power surge.

 A. Power outage

 B. Brown out

 C. UPS

 D. Lightning

Computers are devices that can actually think and make decisions without you having to set any 
predetermined rules.

 A. True

 B. False

The  feature lets you view thumbnails of applications that are running.

 A. Aero Peek

 B. PC Peek

 C. Finder View

 D. Presentation View

The Mac platform can perform all of the same tasks that a Windows machine can.

 A. True

 B. False

The  is located on the left side of every Finder window. 

 A. Sidebar

 B. Dock 

 C. Color icon

 D. None of the above

3

4

5

6

7

8

9
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The  is the launcher for all of your programs and files on the Mac platform.

 A. Menulet

 B. Dock

 C. Finder window

 D. Both A & B

10

CHAPTER REVIEW QUESTIONS
Are there employment fields which could benefit from computer technologies that do not already 
utilize computers? Give examples to support your conclusions.

What are the differences between client-based and Web-based software applications? Are there 
benefits to using one over the other? How are the different types of applications utilized in 
organizations?

What types of hardware devices can provide enhancements to a computer system? What type of 
enhancements do they provide and who can benefit from them?

Consider the differences between a Mac and PC. Describe your current or projected career field. 
Would one of these two systems be more functional than the other in performing your duties? Why 
or why not?

Many people often experience data loss. To protect data you can perform regularly scheduled 
backups. Which storage device would you choose to backup all of your school assignments? How 
often should data be backed up?

Explain the difference between the Start menu in Windows 7 and the Start screen in Windows 8. 
Which of these is more useful for accessing programs quickly? Justify your answer.

Describe an element of your operating system that was not covered in this chapter. This could be a 
menu, feature, or application. What function does it serve or what information does it provide?

Using the information in the chapter, explain two differences between a Mac and a PC. Do these 
differences affect how the computer is used and what it can do? Justify your answer.

Explain in your own words how the Aero Peek feature of Windows is beneficial and how it assists 
productivity on the computer. Give examples to support your conclusion.

In your own words, explain the difference between shutting down a computer and restarting it. Give 
at least two examples of when you would use each one.

1

2

3

4

5

6

7

8

9

10
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PRACTICE EXERCISES
This exercise requires you to conduct some basic research using the World Wide Web to learn about 
various aspects required to select and purchase the right personal computer to meet your needs. 
Because you still have yet to cover the Web, complete this assignment by visiting your local library 
and working with the librarian. (Optionally, if you do have some computing experience, you may use 
the Web on your own to complete this assignment.) Begin by thinking about which category of user 
you fall under, such as student or gamer. The student user usually needs a computer that is able to 
run Microsoft Office applications or some variant. A gamer or high-performance computer user 
requires more memory, faster processors, and a high-performance graphics card. Using the Web, 
find additional research supporting facts required to purchase the right system. For this exercise, 
research the minimum system requirements for the software you will be using or would like to use. 
Once you have the system requirements, go to the Web and use three online shopping sites to find 
the three best prices for a PC that meets your specific needs. List the system requirements and the 
PCs you chose and provide a substantive explanation for your decision. You do not have to use any 
computer applications to write this assignment.

In this exercise, you will be researching different types of software applications. First, choose the 
operating system you prefer. Then research at least ten different applications available for that 
system not already listed in this chapter. List the ten different applications you found. Then, choose 
the application with which you are the most familiar and write a 500 word research paper about 
that application. Make sure to include the following information in your paper: its purpose 
(entertainment, professional, financial, etc.), system requirements, price, where it can be purchased, 
and any other pertinent information about the application you chose. Be sure to cite all of your 
sources in a reference page.  

For this assignment you will need to do some field research. Locate a local business, library, or 
educational institution that utilizes computers. You will need to make a visit to your chosen location 
to gather information about the various hardware devices they utilize. Make a list of all the input and 
output hardware devices for one of their computers. Then take this list home and outline how each 
device was being used by that organization. Include how the device helps the business, library, or 
other organization to function efficiently.

1

2

3

CHALLENGE EXERCISES
Use the Windows PC to create a detailed instruction manual for the startup and shut down process. 
Describe all of the options included in the shut down menu along with when to utilize each feature. 
In your manual, be sure to include a section on computer login security. 

Go to the local library or use the Web to develop a historical time line that explains the development 
of computing technology. Optionally, if you have some computer skills you may use the Web on your 
own to complete the assignment. Write out a time line on paper that explains important milestones 
and lists the contributors responsible for each achievement. 

1

2
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Briefly explain the login process for your operating system. Include the steps that are needed and 
the security in place for accessing the computer. When you restart the computer, is it necessary to 
log into it again? Explain if this is a good setup for logging back into a computer from shutting it 
down.

3
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CHAPTER  

2
Navigating and Using  
the Computer Environment

IN THIS CHAPTER

This chapter will teach you how to navigate and use the computer desktop 

environment. You will learn how to work in the computer environment using 

files and folders you develop from client applications available on your computer. 

You will also learn about navigating the environment by searching for files 

and folders as well as by using keyboard shortcuts to traverse the desktop 

environment. Once you have completed the chapter, you will be able to:

●	Describe and identify elements of the user interface

●	Navigate the desktop and locate applications, files, and 
folders

●	Demonstrate the use of folders to organize files on your 
computer

●	Construct and save files from basic applicationsMicrosoft Office 
2013/365 and 

Beyond
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NAVIGATING 
THE DESKTOP

Whether you are using a Mac or a 

Windows-based computer while working 

your way through this text, navigation is done 

by interacting with the computer’s graphi-

cal user interface (GUI). The user interface 

is the visual (graphical) display provided by 

the computer’s operating system that allows 

the user to visually interact and issue tasking 

commands into the BIOS. By interacting with 

the user interface, software applications can 

be started, closed, installed, and uninstalled. 

The Windows Desktop
In the previous chapter, you were intro-

duced to the Windows desktop environment, 

which is the computer’s user interface. One 

of the primary functions of a user interface 

is to help humans visually interact with the 

computer and utilize the software programs 

available for various activities. Accessing the 

software programs on your computer can be 

done in one of two ways: by using the Start 

button in Windows 7 (or the Start screen 

in Windows 8) shown in Figure 2.1 or by 

double-clicking on a particular shortcut icon 

on the desktop or in 

the folder in which the 

application is installed.

The mouse is the 

hardware device you 

use to move the cur-

sor on the computer screen over the desk-

top to interact with programs and files. You 

can begin your exploration by moving your 

cursor (by moving the mouse) to the Start 

2.1

2.1.1

The GRAPHICAL USER INTERFACE (or 
GUI) is the graphical display that allows 
the computer user to see the computer out-
put and interact with the core components 
of the computer in a visual manner. 
The DESKTOP is the primary workspace 
for a graphical user interface; it is the dig-
ital equivalent of a physical desk. It typi-
cally contains menus to perform system 
functions and icons that represent appli-
cations or files on the computer system.
An ICON is a small graphical representa-
tion of a program or command; clicking 
it usually starts a program or performs 
an action, depending on what the icon 
represents.
A WINDOW is an area of the screen act-
ing as a standalone user interface to an 
application. A single application may use 
multiple windows (commonly one window 
per open file).
A MENU is a selection of commands and 
options that are similar enough to form a 
group; the title of the menu is generally 
indicative of the type of commands it con-
tains. Common examples of a menu are 
the File menu and Help menu.
A TOOLBAR is a collection of icons that 
acts like the visual equivalent of a text 
menu, typically providing shortcuts to 
common commands and actions.
A PANE is a section of a window with a 
specific purpose.
A DIALOG BOX is an encapsulated ver-
sion of a user interface that is typically 
used for minor data entry or configura-
tion. In most applications, an open dialog 
box has to be closed or otherwise dealt with 
to perform other tasks in the application.

 FIGURE 2.1
Windows 7 Start button
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Jump Lists allow a user to quickly open a 

recent file from an application on the task-

bar or a pinned application on the Start 

menu, as shown in Figure 2.5. You can also 

pin items to Jump Lists on the taskbar, 

which is available in Windows 8 as well. 

Task Manager

Sometimes a program on your com-

puter may lock up and cease to function. 

Most of the time Windows will automati-

cally send you a warning and either restart 

the program or close it completely. If for 

some reason the program does not close, you 

can open the Task Manager and end a pro-

cess that has stopped working by pressing 

the End Task button at the bottom of the 

window shown in Figure 2.6. 

2.1.1.3

button and pressing the left button 

on the mouse one time. Performing 

this action will activate the Start 

menu, shown in Figure 2.2. 

The Control Panel

The right side of the Start 

menu in Windows 7 has sev-

eral fixed options, one of which 

is the Control Panel option. The 

Control Panel (shown in Figure 

2.3) gives the user the ability to 

make system setting changes. This 

includes hardware and software 

installations and uninstallations 

(uninstalls). The Control Panel in 

Windows 8 is accessed by swiping 

in the right side, choosing Settings 

and then selecting Control Panel. 

This will activate a window similar 

to the Windows 7 Control Panel.

Notice the Appearance and 

Personalization submenu in the Control 

Panel. Selecting this option brings up several 

options available to customize your desktop 

environment, as shown in Figure 2.4.  

Notice in the Appearance and 

Personalization submenu in Figure 2.4 that 

you can personalize your desktop by chang-

ing the desktop theme, colors, and back-

ground. This submenu is also where you will 

find the display properties where you can 

adjust your graphics card’s properties such 

as its screen resolution and whether you use 

one screen or two screens.

Jump Lists

Another feature to help you navigate 

the desktop more efficiently is a Jump List. 

2.1.1.1

2.1.1.2

The All Programs 
menu selection 
is used to start 

your applications.

The Control Panel 
selection is used 

for making system 
changes and 
changing user 
preferences.

The Search 
window is used 

to search for files 
and folders on 
your computer.

 FIGURE 2.2
Windows 7 Start 
menu
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 FIGURE 2.3
The Windows 7 Control Panel

The User Accounts and Family Safety 
settings can be used to set up 

parental safety controls or add a new 
user to the computing environment.

The Appearance and Personalization 
submenu allows the user to customize 

the overall appearance of the 
desktop as well as the Start menu.

The Clock, Language, and Region 
submenu can be used to adjust 

the time and date and to set your 
time zone and global region.

The Ease of Access submenu 
is used to optimize displays, 

system sounds, and your system’s 
speech recognition capabilities.

The System 
and Security 

submenu helps 
you set up 

a scheduled 
backup for 

your computer 
and can also 

help you 
find system 
problems.

The Hardware 
and Sound 
options are 

used to view all 
of the devices 

on your 
computer. You 

may also update 
divers to ensure 

your devices 
work properly.

The Programs 
submenu 
is used to 
uninstall 
software 

applications on 
your computer.

The Network 
and Internet 
submenu 
is used to 
activate 

an Internet 
connection 
or add a 

computer to 
a network.

 FIGURE 2.4
Appearance and Personalization options

Taskbar and Start 
Menu customization 

options.
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first activated. You can view the full details 

by choosing the More details option.

Libraries Feature

Over time you may accumulate a large 

number of files and folders on your desktop, 

which can make navigating the desktop dif-

ficult. Libraries are a feature in Windows 

that can help you find and organize your 

2.1.1.4

You can open the Task Manager in 

two ways. First, you can simply move the 

pointer to the taskbar, right-click, and select 

Task Manager from the menu that appears. 

The second way to get to the Task Manager 

is to use the keyboard shortcut by press-

ing Ctrl+Shift+Esc. The Task Manager 

displays programs and services that are 

running on your computer at the time you 

open the window. You can also use the Task 

Manager to view network processes or users 

logged into your system. In Windows 8, a 

shortened Task Manager appears when it is 

Notice this Jump List shows Recent 
items and Pinned items.

Right-clicking on one of your 
Recent items gives you the option 

to add it to your Pinned list.

 FIGURE 2.5
Taskbar and Start Menu Properties

A KEYBOARD SHORTCUT is a particular com-
bination of keys pressed at the same time and is 
used to access menus or other services efficiently 
without the use of the mouse.
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the Libraries icon can be seen in Figure 2.7. 

The Libraries window has a search box that 

allows the user to search for files and folders 

using options such as Kind, Date modified, 

Type, and Name as search criteria.

You can see by looking at Figure 2.7 

that there are four standard libraries: 

Documents, Music, Pictures, and Videos. 

You can also create new libraries to help 

you organize your collections of files and 

folders. To create a new library, highlight 

the Libraries selection at the left side of 

the window, as shown in Figure 2.7, and 

right-click. This will produce a new menu; 

select New, then Library and name the new 

library folder. For example, this might be a 

library for all of your schoolwork. You might 

name the library Undergraduate or give it 

the name of the school you are attending 

and then have subfolders in the library for 

each course that you are taking.

files in one consolidated location. This 

allows you to save time by having one place 

where all of your files and folders can easily 

be located. To access the Libraries feature, 

click the Libraries icon on the lower-left 

side of the taskbar. A visual reference of 

The tabs allow you 
to have different 

views of services and 
processes occurring 
on your computer.

You can easily stop 
an unresponsive 

application by either 
right-clicking the 
application and 

selecting End Task 
or by clicking the file 
name and selecting 

End Task at the 
bottom of the window.

 FIGURE 2.6
Task Manager

 FIGURE 2.7
Libraries window

By clicking inside the window 
and using any of the search 

criteria, you can easily 
search for files and folders.

The left pane is a one-
stop location for all of 
the drives and libraries 

on your computer.

Notice the blue tab. 
This location gives you 

information about the folder 
or file that you highlight.

The Libraries icon can be 
found on the far-left side 
of the task bar. Click the 
icon with your mouse to 

open the Libraries window.
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The Finder

If you are using a new implementation 

of the Mac OS X system, there is nothing on 

your desktop and you might be wondering 

how you access applications 

because there is so much 

more available than what you 

see on the Dock. The applica-

tions on your computer are 

found in the Applications 

folder. You can use the Finder window to 

access the Applications folder by clicking on 

the Finder program icon on the Dock (see 

Figure 2.10). 

If you do not have any applications run-

ning, you will notice that the Finder menu is 

available at the top of your screen. You can 

alternatively click on the background of the 

screen and the active application menu will 

be the Finder application. If a Finder window 

does not appear, you can select the Go option 

on the Finder menu, as shown in Figure 2.11. 

The Go menu gives you the ability to 

navigate to different areas on your computer 

system. You will notice that to the right of 

the options are your shortcut keys. Mac has 

a wide selection of shortcut keys you can use 

to quickly navigate to areas within your sys-

tem and perform common tasks. 

2.1.2.1

The Macintosh 
OS X Desktop

Although the Mac has a similar appear-

ance, it is different from a Windows-based 

PC. Unlike the Windows platform, many of 

the desktop settings on the 

Mac can be found in the 

Apple menu. As you might 

remember from previous 

sections, the Apple menu 

is accessed by clicking the 

apple icon (shown in Figure 2.8) at the top-

left side of the menu bar. 

Starting an application also works much 

differently than on a Windows machine. In a 

Windows environment, you may have used 

the Start screen or Start button to access 

all of your settings and applications. On a 

Mac, all of the applications you use regularly 

reside on the Dock near the bottom of the 

interface (as shown in Figure 2.9). 

To access applications on a Mac, you 

can start them either from the Dock or from 

the application’s icon in the Applications 

folder. It is easy to add or remove applica-

tions from the Dock. You can simply click on 

a program icon and drag it away from the 

Dock to remove the application. To add an 

application to the Dock, you simply click on 

the application you want in the Applications 

folder and drag it to the left side of the 

divider (the dotted white vertical line) on 

the Dock. You can click and drag icons on 

the Dock to reorder them.

2.1.2

 FIGURE 2.8
Apple icon to 
access the Apple 
menu

 FIGURE 2.9
The Dock

 FIGURE 2.10
Finder program 
icon

The DOCK is the collection of program icons 
at the bottom of the Mac desktop screen used 
to quickly access the applications you use most 
frequently. 
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program icons, 

it is not imme-

diately appar-

ent that there 

are more 

options avail-

able to the user. 

Simultaneously 

pressing the 

Ctrl button and 

clicking on a 

particular pro-

gram’s icon (the 

Mail icon in Figure 2.13) displays 

the hidden menu for that program. 

You can clearly see there are additional 

options in the hidden menu. At the top of 

the menu in Figure 2.13, you can see that 

there is an open associated file. Clicking on 

the open file labeled TOC brings up an email 

window. You can perform this action with 

any of your applications on the Dock or the 

OS X desktop to view hidden menus.

The Dashboard, Exposé, and 
Spaces

In the OS X environment, you have 

widgets available in the Dashboard. When 

you activate the Dashboard (which will then 

appear to float over your desktop), you will 

see that it contains a clock, calendar, cal-

culator, and the weather. You can use the 

Dashboard’s hidden menu to change your 

Dashboard settings or add new widgets 

you find online. You can also change your 

Dashboard settings by accessing the Apple 

menu and selecting System Preferences. 

System Preferences is also where you can 

adjust settings for Exposé and Spaces.

2.1.2.3

The Dock

If the Dock is too small or too large for 

your personal preference, you can quickly 

and easily adjust its size by selecting the 

Apple menu, then the Dock selection, and 

finally Dock Preferences to open the window 

shown in Figure 2.12. Now you can simply 

move the Size slider to increase or decrease 

the size of the Dock. 

One final feature on the Dock that you 

may need is the ability to view hidden menus. 

If you are simply taking a look at your 

2.1.2.2

 FIGURE 2.11
The Finder menu 
Go selection

 FIGURE 2.13
Hidden menu for the 
Mail application

 FIGURE 2.12
Dock Preferences 
window
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Rather than placing a preview at the 

bottom of the taskbar for minimized appli-

cations, Exposé places your open and mini-

mized application windows in small preview 

windows laid out so that you can see every 

application you have open at once as shown in 

Figure 2.15. Clicking on one of the application 

windows maximizes the window and brings 

you to the desired application.

Exposé and Spaces are features within 

the Mac OS X environment that make desktop 

navigation and organization a breeze. Exposé 

is similar to the Aero Peek feature in Windows 

7; both of these give you a preview of the appli-

cations you have open and let you open one 

by moving your cursor to it and clicking. With 

most keyboards, you simply press the F3 key 

to view the Exposé of active applications.

 FIGURE 2.14
Dashboard 
displaying widgets 
on desktop and 
hidden menu 
snippet

 FIGURE 2.15
Active Exposé 
view

The Dashboard hidden 
menu allows you to add 
more widgets or adjust 

how the dashboard 
appears. The four arrows 

are highlighting the 
standard widgets available 
when you install the OS.
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Spaces is the other tab on the Exposé 

& Spaces configuration window. The Spaces 

feature lets you organize the applications 

on your desktop in a way that is efficient 

to the way you work. This feature allows 

you to assign applications to one of four 

spaces on your desktop. In Figure 2.16, you 

can see that if you select the + symbol you 

can add desired applications to a particular 

quadrant. This way, each time you open an 

application on the Dock, it appears in the 

quadrant you have selected.

Force Quit

If you want to stop an unresponsive 

application when using the Macintosh OS, 

you must use the Force Quit option. It is 

important that you only use the Force Quit 

option if you are absolutely unable to work 

with the application and it is unresponsive. 

Using this option will cause the application 

to close without saving any work. You can 

Force Quit out of an application by select-

ing the Force Quit option from the Apple 

2.1.2.4

 FIGURE 2.16
Spaces 
configuration 
settings
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Files and Folders 
in Windows

Organizing files and folders on Windows 

is a common task, and there are many fea-

tures that can be quite helpful if used prop-

erly. One of the first things to start off with 

is storing files in appropriate folders. Think 

of organizing files and folders on your com-

puter as similar to organizing a filing cabi-

net at your home or office. Assume you 

wanted to use your filing cabinet to store 

all of your homework assignments for your 

first semester of undergraduate education. 

If you are taking four courses, you might 

make four folders. For this example, pretend 

you are taking Biology, Math, Sociology, and 

Business Ethics. 

Creating your folders with categories is 

the first step to help you sort all of the docu-

ments you will quickly begin to accumulate 

during the semester. If your courses are 

eight weeks long, you might want eight sub-

folders to store assignments by week. This 

might require that you now create 8 subfold-

ers for each course category for a total of 32 

subfolders. Once you have your filing cabi-

net categorized with folders and subfolders, 

you can begin to populate them with assign-

ments, tests, and quizzes for each week of 

the semester. Each one of these documents 

you collect is part of the set of files that will 

populate your filing cabinet. 

To translate this to the environment of 

the computer, the filing cabinet on the com-

puter is located in the chosen storage loca-

tion on the media you select. Recall from the 

previous chapter that media can be the com-

puter’s internal hard drive, an external hard 

2.2.1menu. As an alternative, you can press the 

Command+Option+Esc keys simultane-

ously. You must then select the unresponsive 

application from the menu that appears. 

Activity 2.1—Process 
Monitoring

Use either the Task Manager in Windows 

or the Activity Monitor in Mac OS X (located 

in the Applications/Utilities folder under the 

hard drive). Identify the processes and appli-

cations that are running on your machine. 

Describe the information about each process 

or application that is being presented to you. 

How is this information useful for manag-

ing the computer system?

ORGANIZING FILES 
AND FOLDERS 

Organizing files and folders is an essen-

tial task on a computer. By organizing your 

files effectively, you can quickly find docu-

ments you need. Part of this organization 

process is the use of folders to group similar 

content. These work just like real folders 

that you can use to organize paper docu-

ments. The fundamental principles are the 

same, regardless of the operating system 

you use. Each folder can contain subfolders 

in a hierarchical arrangement. Ultimately, 

all of your folders will stem from one source, 

such as your hard drive (typically labeled C 

on a Windows machine); the folders within 

that are subfolders, and each of those can 

contain subfolders. Even your desktop is a 

subfolder of the hard drive on which your 

operating system is stored.

2.2
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You can see in Figure 2.17 that the 

Libraries and Documents selections on the left 

have been expanded and the My Documents 

folder is highlighted. The My Documents 

folder shown here does not have any files 

in it. Highlighting the My Documents folder 

opens the folder for you to view its contents. 

In this case, the folder simply has a title at the 

top of the window indicating the Documents 

library in green letters and My Documents 

in black letters. Now simply right-click with 

your mouse pointer in the window and a 

menu appears with New as an option near 

the bottom. Selecting New gives you many 

options, as shown in the menu at the right; 

one of them is the creation of a new folder. 

drive, or a thumb drive that you use to store 

all of your important data. In the following 

example, you will use the My Documents 

folder (accessible via the Libraries function-

ality) to create a file structure to store your 

school documents.

You can create a folder anywhere on your hard drive, 
external media, or desktop. Windows contains a 
default folder you can use for this purpose called My 
Documents. The problem, though, is that if you just 
drop all of your documents in there, over time it can 
become a mess. Imagine having to scroll through 75 
files. It is not as hard as you might think to accumu-
late that many files in a short amount of time. A great 
place to start the project of organizing your docu-
ments is to create your folders in the My Documents 
folder for each category of organization you want to 
have, such as folders for Home, Work, and School.

 FIGURE 2.17
Using the Windows 
Libraries feature 
to create a new 
folder
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storage location for all of the work you com-

plete and collect for the science course you 

are taking, and you can create a subfolder 

within that for each week during the term. 

In Figure 2.20, you can see there are 

now four subfolders within the main School 

folder. Each subfolder represents a course 

you are taking. You could further develop 

each subfolder by adding subfolders repre-

senting each week in your school term.

Selecting Folder cre-

ates a new folder as shown 

in Figure 2.18 with the title 

New folder highlighted in 

blue. This indicates you can 

proceed to type a desired 

name for the new folder. You 

should always take care to 

title your folders immedi-

ately, or you may forget what 

they contain or what their 

original purpose was sup-

posed to be.

Now take a look at Figure 2.19 where 

the newly created School folder resides in 

the My Documents location of your com-

puter; you can think of this as your School 

category. Now you can add subfolders that 

reside within this School folder. For exam-

ple, you might create a subfolder within 

the School folder titled Biology, indicating a 

 FIGURE 2.18
A new folder in the 
My Documents 
folder

 FIGURE 2.19
The new School 
folder in the My 
Documents folder

 FIGURE 2.20
School folder with new 
subfolders

School folder

Notice four subfolders 
now reside within 
the School folder.
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create folders anywhere on the Mac includ-

ing the desktop, but the current Mac culture 

encourages users to keep the desktop clean. 

For this example, you will begin by creating 

a filing system for your school documents in 

the Documents folder, as shown in Figure 

2.21.

To create the main folder titled School, 

double-click on the Documents folder to open 

it. The Documents folder in this instance 

contains only a Microsoft User Data folder 

that stores the preference settings for the 

Microsoft Office 2011 suite of applica-

tions. (The Snagit folder stores images for 

a screen capture application). The School 

folder will be used to file schoolwork. Notice 

in Figure 2.21 how the button with a gear 

and a drop-down arrow is activated. A new 

menu has appeared beneath it. Select New 

Folder to create a folder. 

Activity 2.2—
Creating a Folder

Create a new folder on your computer 

named Activity2_2. Move the folder to the 

proper location on your machine for saving 

documents. Describe the process of creating 

the folder and the process of navigating to 

the proper location for documents to reside 

on the computer.

Files and Folders 
on a Mac

Organizing files and folders on a Mac 

is essential. If you have read the previous 

sections relating to the Mac environment, 

then you have already been introduced to 

the place where you will start. Your start-

ing point is the Finder window, where you 

can access all of the applications and fold-

ers on your computer. You can actually 

2.2.2

 FIGURE 2.21
Finder window
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method matches a hierarchical structure. 

Following a similar format for data storage 

of all types will help you stay organized as 

you work with your computer.

Activity 2.3—
Creating a Folder

Navigate to the Activity2_2 folder you 

created. Once you have found it, create two 

subfolders within it named Activity2_3_1 

and Activity2_3_2. Remove the folder 

Activity2_3_1. Describe the process of creat-

ing the subfolders and the process of remov-

ing one of them.

WORKING WITH 
FILES ON YOUR 
COMPUTER

Now that you have learned about get-

ting around on your system and developing a 

filing structure to organize application files, 

you can begin learning about files. A file can 

be an application document or image that 

can be stored on digital media, either exter-

nally or internally (such as on your computer 

hard drive). You have already learned about 

applications on your computer system, so it 

is time to put them to use. 

2.3

Once the new folder appears on the 

desktop, you have the option to name the 

folder. In this case, name it School. Now if 

you were to dump all of your assignments in 

the School folder without any further orga-

nization, the folder would quickly become 

very cluttered and disorganized. The next 

step is to create subfolders for each subject 

that will reside in the School folder. Open 

the School folder and create four subfolders, 

as shown in Figure 2.22. Subfolders are cre-

ated in the same way you created the School 

folder.

Because you do not want clutter in your 

subfolders, you can create additional sub-

folders within your course subject for the 

weeks of the course as shown in Figure 2.23. 

You can name these new subfolders by week 

so that you can categorize and store each 

week’s assignments in an organized fash-

ion. Once you have finished creating this 

new structure, you will notice that this filing 

 FIGURE 2.22
School folder in Finder window

 FIGURE 2.23
Subfolders 
broken down 
into weeks

The SUBFOLDER is simply a folder that 
resides within another folder.
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WordPad on Windows
WordPad is a basic word-processing 

application on the Windows platform. To 

start WordPad in Windows 7, click with your 

pointer on the Start menu and select All 

Programs and then the Accessories folder. 

Within the Accessories folder, you will find 

the WordPad icon. Click on the WordPad 

icon to start the application. In Windows 8, 

you can access WordPad by swiping in the 

menu on the right, selecting Search, and 

typing “WordPad” in the search box.

Enter the following message in the 

WordPad interface: This is my first WordPad 

document. I am going to save it for future ref-

erence. (See Figure 2.24.) If you are following 

along with your own version of WordPad, 

then congratulations, you have just created 

your first WordPad document.

We will not go into a lot of the func-

tionality of WordPad here because you will 

be learning about more advanced Office 

applications in the next several chapters; 

just keep in mind that there is a lot you can 

do with it. If you have no other alternative, 

2.3.1You are probably reading this text to 

learn to use productivity software to con-

struct professional presentations, data-

bases, and other professional documents. 

Before you approach that task, you should 

get started with one of the basic applications 

that came with your personal computer to 

introduce you to the concept of a file. There 

are a couple of things you need to know 

about files. You may recall an earlier dis-

cussion on the concept of storage space on 

your computer in both the forms of available 

space on your hard drive and other media 

devices you use to store files. Before saving 

a file, you need to know where you will save 

it and the type of file it will be saved as. All 

files are associated with a file extension, 

which is usually a period (or decimal point) 

followed by three letters. For example, the 

name mytext.txt is a valid filename. You get 

to define the part to the left of the period, 

but the part to the right should come from 

a list of existing file types so your machine 

can recognize it and know how to process 

the information.

 FIGURE 2.24
WordPad 
document sample
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school folders, which you developed inside 

your My Documents folder.

In the Libraries dialog that appears 

on the desktop, as shown in Figure 2.28, 

expand the Documents library and open 

the School folder you created. Once you 

have the location selected, place your cur-

sor in the File name text box and type the 

name for your new file, which in this case 

is MyFirstWordPadDocument. Be sure the 

correct file type extension, rich text format 

(RTF) in this case, is selected in the Save as 

type text box. Finally, press the Save button 

to save your new WordPad file to your cho-

sen location. To view the properties of the 

file, select the file location, right-click on 

the icon for the file, and select Properties. 

This will open a new window with the file 

properties, such as size, date created, date 

modified, and the program that is assigned 

to open the file.

you can use WordPad 

to type documents and 

then open them later 

in the Microsoft Word 

application by using a 

file extension that Word 

understands.

Every application 

file needs to be saved 

with a file extension. 

Every application opens 

files based on the file 

extension with which 

it was saved. Now that 

you have created your 

first WordPad docu-

ment, you must save 

it to avoid losing the 

information. Saving the document will allow 

you to reopen it at a future date. 

To save your new WordPad file, select 

the WordPad button shown at the top left 

of Figure 2.25, and then select Save as and 

Rich Text document.

The file extension associates your new 

file with the applications that can open your 

file. It is important to keep in mind that 

sometimes more than one application may 

have the capability to open your file but may 

not be set as the primary application. In 

such cases, you should open the application 

you wish to use and open the file manually 

from within that application.

Now that you have selected to save 

your new WordPad file as a rich text format 

(RTF) file, the Libraries menu comes up on 

your desktop. You may remember that ear-

lier you created the folder structure for your 

To save your WordPad 
file, click the WordPad 
button, select Save as, 
and then select the file 

type, which will give 
the file an extension.

Selecting the Rich Text 
document type will append 

.rtf to your filename.

 FIGURE 2.25
Saving a WordPad file
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computer and can be located using the 

Finder application in the Dock on your desk-

top. Once you have the application open, 

type the following in the main document 

pane: This is my first TextEdit document. I 

am going to save it for future reference. 

TextEdit for Macintosh
It is important to note that with any 

operating system you will use file exten-

sions. Every time you save a new file, you 

have the opportunity to select the file type, 

which gives the file a new extension to 

associate it with an application that is able 

to open it. On the Macintosh, you have 

an application similar to WordPad called 

TextEdit. The TextEdit application also 

enables you to develop documents and even 

save the file as a Microsoft Word document. 

Notice in Figure 2.27 that the File Format 

options include some of the older Microsoft 

Word formats.

The TextEdit application can be found 

in the Applications folder on your Macintosh 

2.3.2

 FIGURE 2.26
Using the Libraries feature to select the location for your new file

 FIGURE 2.27
Choosing the file type for a sample TextEdit document
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pressing the Save button. To examine 

the properties of the file you created in 

TextEdit, simply return to the folder 

where you stored it in the Documents 

folder, as shown in Figure 2.29. 

Click on the file named 

MyFirstTextEditDocument and click 

on the Action menu. From the Action 

menu, you can select GetInfo; the 

menu appears very similar to what 

you would see in the Windows environ-

ment showing the file properties. From 

this menu, you can change the file extension 

type and even the program that opens the file.

Activity 2.4—File 
Properties

Using the file you created in the text edi-

tor, follow the process to examine the file prop-

erties for your OS. Explain the information 

that is presented and the options you have to 

change the file or its behavior. When would 

this be useful in managing documents?

Locate the Documents folder in the 

Finder view, as shown in Figure 2.28, and 

save the file to the School folder you created 

earlier when you developed a file structure 

for all of your schoolwork. Notice the Untitled 

Save as window gives you the option to save 

the file with a name that you choose, which 

in this case is MyFirstTextEditDocument. 

After selecting where to save the file (the 

Documents folder) and the file format (Rich 

Text Format), it’s time to save the file by 

 FIGURE 2.29
Viewing file 
information on the 
Macintosh

The little button with the 
gear on it is the Action 
menu on a Macintosh.

Select the get Info option from the 
Action menu, which is similar to File 

Properties in the Windows environment.

Notice the name & 
Extension window 
and the Open with 
selection window. 
You can change 
which application 

opens the file.

The Getinfo menu 
provides similar 

Information to the 
Properties menu 
in the Windows 
environment.

 FIGURE 2.28
Sample Documents view

Notice the file 
information we would like 

to view is highlighted.
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CHAPTER SUMMARY
This chapter provided an introduction to navigating the Windows and Macintosh desk-

tops in an efficient manner. It covered the user interface on both operating systems and gave 

users an introduction to modifying system preferences and managing documents. Managing 

files and folders are an important part of using any computer system. You should now be able 

to create folders and subfolders to effectively organize your personal computing filing system. 

The next chapter focuses on the use of the Internet as a productivity tool; this will help you 

tremendously as you learn to use the different productivity software applications covered in 

this text.

CHAPTER KNOWLEDGE CHECK
The  is the graphical display provided by the computer’s operating system that 
allows the user to visually interact with and issue tasking commands to the Basic Input/Output System.

 A. User interface

 B. iPad2

 C. Visual display

 D. Both a and b

The mouse is the hardware device you use to move the pointer over the desktop to access 
programs and files.

 A. True

 B. False

To remove a program from the Start menu, simply right-click and then click  
from the Start menu.

 A. Delete

 B. Unpin

 C. Rename

 D. None of the above

The Spaces feature allows you to assign applications to one of four areas on your desktop.

 A. True

 B. False

1

2

3

4
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Exposé places your open and minimized application windows in a small window laid out so that you 
can see every application you have open.

 A. True

 B. False

 are a feature in Windows that can help you find and organize your files in one 
consolidated location. 

 A. Libraries

 B. Shelves

 C. Folders

 D. My Documents

Most Mac keyboards allow you to simply press the F3 key to view your Exposé of active 
applications.

 A. True

 B. False

The Windows desktop is almost identical in Windows 7 and Windows 8, with the Start menu and 
Start screen being the primary difference.

 A. True

 B. False

It is possible to change the desktop appearance on both a Windows PC and a Mac.

 A. True

 B. False

The Apple menu and the Start menu contain all of the same options.

 A. True

 B. False

5

6

7

8

9

10
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CHAPTER REVIEW QUESTIONS
Of the two user interfaces, Windows and Mac OS X, which do you see as the most user-friendly? 
Consider the accessibility, features, and functions of the GUI.  

Consider your daily activities, both personal and professional, performed using your computer. What 
applications should be stored in a Mac OS Dock for maximum efficiency? What is the equivalent of 
this quick access on Windows? 

What means are available for managing an unresponsive program? When should you apply each 
method? 

What are the drawbacks of having multiple levels of subfolders in a filing system?

Why is it important to have the functionality for the Task Manager or Force Quit to close an 
application? Are there any risks that it poses to the system?

Explain in your own words the process of locating a file on your computer. Is there any difference 
between this and locating an application?

Compare the Windows Jump List and the Mac OS X Dock. How are these similar and how do they 
differ?

Why is the construction of appropriate folders necessary for organizing files on your computer? Give 
examples to explain your answer.

Explain the two most important elements of the desktop environment in either Windows or  
Mac OS X. What influenced your decision to choose these two?

Explain the purpose of changing the screen resolution on your computer for either a Windows PC or 
Mac.

1

2

3

4

5

6

7

8

9

10

MSOffice-Beyond-CH02.indd   46 6/9/2014   1:39:22 PM



Chapt er  2  — Navigat ing  and  Us ing   the  Comput er  Environment  — 47

PRACTICE EXERCISES
Think about a category of files you would like to organize on your computer’s hard drive or an 
external media device. It could be any set of files on your computer, such as digital images or 
documents. Plan and develop a filing system to help you organize these files. Write a short 
document that describes the folder and subfolder setup you would develop to organize files stored 
on your computer system. You can complete this assignment in either the Macintosh or Windows 
environment.

Use the Appearance and Personalization selection within the Control Panel to change your Windows 
desktop theme. If you are using the Mac use the System Preferences to modify your desktop. Briefly 
explain the process you used.

Conduct basic research on the different types of file extensions. Make a list of at least five different 
types of file extensions. Each file extension associates a stored file with a certain application. 
Construct a table that displays the types of file extensions you listed and their compatible 
applications.

1

2

3

CHALLENGE EXERCISES
Becoming Familiar with the Control Panel:

Fill In The Blank:

 A. The User Accounts and Family Safety settings can be used to set 
up  controls or add a new user to the computing 
environment.

 B. The  and Internet submenu is used to activate an 
Internet connection or add a computer to a network.

 C. The Programs submenu is used to  software 
applications on your computer.

 D. The Ease of Access submenu is used to optimize , 
system sounds, and your speech recognition capabilities.

 E. The Hardware and Sound option are used to view all of the devices on 
your computer. You may also  drivers to assure your 
devices work properly.  

1
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Define the following terms:

 A. Toolbar

 B. Dialog Box

 C. Desktop

 D. Menu

 E. Pane

 F. Window

 G. Icon

 H. GUI

Construct a Venn diagram that compares and contrasts the Macintosh and Windows interfaces. 
Next, write a brief paragraph explaining which interface you prefer for your daily use and why.

2

3
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CHAPTER  

3
Using the Internet

IN THIS CHAPTER

This chapter will teach you how to navigate the World Wide Web (often referred 

to simply as the Web). You will learn about the various aspects of the Web, 

including the differences between the Web and the Internet. You will also learn 

about navigating the environment using a Web browser and conducting effective 

searches on the Web. You will also learn about online privacy and the legal 

aspects and concepts of fair use. Once you have completed the chapter, you will 

be able to:

●	Describe and identify the background and historical 
context of the Internet and the Web

●	Discuss how the Internet and Web operate

●	Describe the types of available Internet connections

●	Demonstrate the use of different Web browsers to 
navigate the WebMicrosoft Office 

2013/365 and 
Beyond
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first proposed the idea of a network inter-

connected by hosts. Dr. Licklider did not 

develop the actual Internet (an abbreviation 

of interconnected network) that connected 

computers across the globe, but his ideas 

led to the development of ARPANET, which 

later led to the development of what today 

we call the Internet. ARPANET in those 

early days had been developed as a way to 

interconnect computers so that they could 

be used to support military command and 

BACKGROUND 
AND HISTORICAL 
CONTEXT OF 
THE WEB

Whether you are using a Mac or a 

Windows-based computer, you have the 

ability to access real-time information from 

a variety of sources. You need nothing more 

than an Internet connection and your com-

puter to access this world full of possibili-

ties. This is because Internet technologies 

open up a vast and global library full of 

information for anyone with access the Web. 

The Web is an application of the Internet. 

It is a powerful and evolving tool that can 

be used for the quick exchange of data and 

information. 

Before going any further, it is important 

to give you some background and historical 

information about the Web and Internet. 

You may have heard your friends or col-

leagues use these terms synonymously, yet 

the two entities actually have different 

roles. First, the Internet, also known as the 

information superhighway, was developed 

during the 1950s by an organization known 

as the Advanced Research Projects Agency 

(ARPA), which was created by the U.S. gov-

ernment to conduct research and develop-

ment in hopes of countering threats from 

the former Soviet Union. This endeavor was 

triggered by the Soviet Union’s launch of 

the first satellite into space, called Sputnik.

It was soon after, on April 23, 1963, 

that Dr. Joseph Carl Robnett Licklider, a 

computer scientist working on a command 

and control research project at ARPA, 

3.1 DATA is simply a collection of unpro-
cessed facts (such as the number 10 or the 
letter A or the number 3.2756).
INFORMATION is the association of 
data with the context of its meaning; it 
is typically in a form that has been pro-
cessed to a level where it becomes use-
ful to an individual or organization. An 
example of information is: The ratio of 
the length to width of a particular rect-
angle is 3.2756.

NETWORK is the term used to identify 
a situation where two or more computers 
connect to share resources.
The INTERNET is a global interconnec-
tion of networks made up of hardware 
devices, such as your personal computer, 
that supports communication between 
different computing devices using an 
addressing scheme known as Internet 
Protocol (IP). 
The WORLD WIDE WEB (or WEB) is a 
service that runs on the Internet to pro-
vide access to documents, audio, and video 
and allows for the interconnection of these 
documents through the use of hyperlinks.
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foundation for the modern-day Macintosh) 

running a computer programming lan-

guage called Objective-C® (which the 

Macintosh still uses to this day under the 

name Cocoa®). He developed the Hypertext 

Transfer Protocol (HTTP) that would essen-

tially allow a user to click on hyperlinks to 

easily navigate from one Website to the next 

using a Web browser; the early Web browser 

that he wrote was called WorldWideWeb. 

Essentially this required Websites to reside 

on a Web server to work properly. A Web 

server is a computer that manages HTTP 

connections to allow the hosting of files, 

Web applications, and Websites. 

Not long after Tim Berners-Lee’s efforts 

at CERN, when the Web had essentially 

been operational for some time within the 

confines of the organization, Web servers 

began to emerge at research facilities and 

universities. This interconnected network 

of Web servers that hosted Websites gave 

users the ability to quickly navigate from 

one Website to the next by simply clicking 

control operations in defense against what 

was seen as an emerging threat to national 

security at the time, specifically in the event 

of nuclear war.

For the purposes of this text, what you 

should know is that the development of 

ARPANET led to the development of the 

Internet, which is the fundamental infra-

structure used to support the Web. It was 

in the late 1980s that research support 

from ARPA (now known as DARPA, or 

the Defense Advanced Research Projects 

Agency) ended and the Internet became 

available to the public for the first time. 

The Internet then was nothing more than 

a high-tech superhighway used to trans-

fer data between universities and research 

centers by using complex techniques lever-

aging a unique addressing system known 

as Transfer Control Protocol and Internet 

Protocol, or TCP/IP.

The Internet was not known to the aver-

age computer user at the time and those that 

did know about it needed significant skills to 

conduct any type of data transfer. In 1989, 

Tim Berners-Lee, a physicist working as a 

contractor at CERN (Conseil Européen pour 

la Recherche Nucléaire, which translated 

from French means European Organization 

for Nuclear Research), developed what 

today we call the World Wide Web. 

Berners-Lee had a grand vision for a 

system that could link information through 

a web of interconnections between com-

puters using hyperlinks as a way of man-

aging and sharing information between 

individual nodes or machines. Berners-Lee 

used a NeXT™ computer (which was the 

A WEBSITE is a collection of Web pages, docu-
ments, audio, and video that is stored in a loca-
tion such as a Web server and can be accessed 
by a unique address determined by a Uniform 
Resource Locator (URL) value.
A WEB SERVER is a repository that contains all 
of the files and folders for a Website and provides 
remote access to them via various protocols such 
as HTTP and File Transfer Protocol (FTP) over 
the Internet.
A WEB BROWSER is a software application 
used to search, navigate, and retrieve informa-
tion and data from the Web.
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How the Web Works
Now that you have a basic understand-

ing of the differences between the Web and 

the Internet, you are in a better position to 

understand how it all works. Recall that a 

Website is a collection of files and Web pages 

that span across the globe; each of these 

Websites is stored on Web servers as a collec-

tion of documents called Web pages, along 

with the supporting media files that enrich 

the user experience. All of these documents 

are linked and transported using the HTTP 

protocol.

A Web page is a plain text document for-

matted using Hypertext Markup Language 

(HTML) and can be part of a larger Website. 

HTML is a formatting language that is used 

to organize and present text and multime-

dia files for presentation in a Web browser 

(note that this is not a traditional program-

ming language that issues logic arguments). 

A Web page can include embedded images, 

video, and audio to enhance the look and 

feel of the overall site. Now you might be 

wondering how the computer gets you to a 

Website or Web page on the Internet.

The steps that follow for this activity 

are some of the more complex actions that 

you have done on your machine so far. If you 

cannot understand all of the pieces here, it 

is okay to skip this. Familiarity with these 

topics will help you become more adept at 

using the Internet and the Web, but it is 

3.1.1

on a hyperlink using any of the available 

Web browsers. 

Popular Web browsers today include 

Microsoft Internet Explorer® (IE), Apple 

Safari®, and Mozilla® Firefox®. Web brows-

ers can be used to search the Web for infor-

mation relating to nearly any subject, access 

Web applications such as those used in bank-

ing, and purchase products from a variety of 

vendors. One of the earliest companies pro-

viding user access to the Web was Netscape®; 

its most popular browser was Netscape 

Navigator®. Netscape was purchased by 

AOL® in 1998, the same year Communicator 

was released as an open source product as 

part of a new Mozilla project. 

This source code has evolved into Firefox. 

Firefox is a popular, free Web browser avail-

able from Mozilla, which manages changes to 

this open standards-based browser. Mozilla 

is the open standards group that emerged 

when the browser technology was released 

to the public. Firefox is one of the browsers 

whose icons is shown in Figure 3.1.

Figure 3.1 shows three icons represent-

ing the three most common Web browsers in 

existence. Windows Internet Explorer is in 

its ninth version and is available for use on 

operating systems available from Microsoft. 

Both Apple Safari and Mozilla Firefox can be 

installed on a variety of operating systems. 

An OPEN SOURCE product is one where 
the creator freely distributes the source 
code to the public, allowing changes for 
improvement and customization.

 FIGURE 3.1
Icons for common Web browsers
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icon for a Command Prompt should appear 

in the list of apps available.

In the Command Prompt window, you 

can type the command IPCONFIG/ALL to 

view all of your network adapter properties. 

In the Command Prompt window shown in 

Figure 3.3, take specific notice of the IPv4 

(Internet Protocol version 4) address; the 

example here is 192.168.1.2. The address 

listed here is what your home network 

will use to keep track of your computer on 

the network and provide you with access 

to the Internet. The second setting you 

should notice is the DNS Servers address. A 

Domain Name Server (DNS) address is used 

for name resolution on the Internet. 

Every single computer on the Internet 

uses an IP address, but this simple numeri-

cal address makes it difficult to immediately 

recognize a Website you might want to visit. 

DNS servers help your computer translate 

humanly readable domain names used to 

identify Websites on the Web. A domain 

name (also known as a hostname) is used to 

identify a Website, such as www.cnn.com or 

www.401k.com. The Command Prompt in 

Figure 3.4 displays how this domain name 

to IP address translation actually occurs.

not required for basic 

proficiency in Internet 

literacy. 

Recall that the Internet works using 

an addressing scheme called TCP/IP. Every 

hardware device on the Internet has an 

IP address. Your computer uses a network 

adapter (called a Network Interface Card) to 

connect to the Internet using your IP address 

to manage data traffic. The network adapter 

on your computer can be either wireless or 

wired; both options typically come standard 

on modern machines. You can find the IP 

address on a Windows 7 machine by sim-

ply clicking the Start menu and then typing 

the command cmd in the search window, as 

shown in Figure 3.2. Once you hit the enter 

key, the Command Prompt window appears. 

In Windows 8, you can access a Command 

Prompt by swiping in from the right side of 

the screen and choosing Search. Type “com-

mand prompt” in the search box and the 

 FIGURE 3.2
Accessing the Command Prompt 
window

 FIGURE 3.3
Computer network 
adapter properties

Every hardware device connected to 
the Internet uses an IP address.

DNS server address tells the computer 
or hardware device where to go for a 

domain name to IP address translation.
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com is the domain name that is registered 

with the Internet Corporation for Assigned 

Names and Numbers (ICANN), but to actu-

ally navigate to that Website, you would 

type www.amazon.com (which is equivalent 

to the full address http://www.amazon.com 

that includes the name of the protocol). This 

is the site’s URL, which brings you to the 

site’s homepage. The homepage of a Website 

is the very first page you come to when you 

type the URL into your Web browser (the 

filename for this is typically index.htm or 

index.html). The prefix of the URL is the 

protocol that is used to access the site; in 

this instance, it is the HTTP protocol.

If you want to acquire a domain name 

for your own purposes, you can do so by reg-

istering the name with ICANN. However, 

you never directly contact ICANN; you must 

register your domain name by using a third-

party organization called an Internet Service 

Provider (ISP). ISPs are companies that 

lease service lines used to access the Internet 

to residential and business customers. ISPs 

also can also register domain names for cus-

tomers and can determine whether your 

chosen domain name is available for lease. 

If you were to type the 

Website address www.cnn.

com into your Web browser, 

the actions shown listed in Figure 3.4 are 

what really happens on your computer. The 

TRACERT command is used to see what 

route your computer is taking to reach the 

Website www.cnn.com. Every line in the fig-

ure represents a hardware device used for 

routing (called a router) that helps direct 

you to the CNN Website servers where the 

documents for the Website reside. In this 

instance, by using the TRACERT command 

you can see that the Web server address for 

the CNN site is actually 157.166.226.25.

It is important to realize that there are 

many types of networks (such as LAN and 

WAN) that can include business networks 

and home networks. The important point 

to remember is that all of these networks 

can connect to the Internet to share and dis-

seminate information using the Internet as 

the superhighway for navigation. The Web 

provides the service on top of this infra-

structure to enable you to view and navigate 

documents and media on the Websites you 

want to visit. 

Uniform Resource Locaters (URLs) are 

the addresses you type into your browser 

to connect and navigate to the Website you 

want to see. For example, www.amazon.

A LOCAL AREA NETWORK (LAN) is a 
local network limited to a small geograph-
ical area. Your home network or the net-
work at your workplace can be considered 
a LAN. 
A WIDE AREA NETWORK (WAN) is a 
network that can span to global propor-
tions. For example, an international ship-
per could use a WAN to manage shipments 
in multiple countries.

 FIGURE 3.4
Domain name translation
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several types of services offered by ISPs with 

which you should be familiar before signing 

any long-term agreements. Most ISPs will 

require a service agreement for a period 

of time, usually from 12 to 18 months. 

Research is essential because all of these 

factors can vary with time requirements 

and price of the connection. When you are 

investigating options, you should also con-

sider the connection speed, which includes a 

download speed and an upload speed.

The following are the different types of 

Internet connections:

•	Dial-up—This type of connection is an 
old technology that has been around 
for many years and uses an analog 
telephone connection to connect to 
the Internet. This connection operates 
at 56 Kbps (kilobits per second), is 
extremely slow, and requires that the 
user dial a phone number to access 
the Internet.

•	Cable high-speed Internet—In most 
instances, your cable TV company 
also can provide you with an Internet 
connection. The speed range depends 
on the price you are willing to pay. 

Connecting to 
the Internet 

ISPs are used to connect to the Internet. 

One of the first things you’ll want to do 

when you acquire your computer is connect 

to the Internet so you can utilize the Web. 

Your local ISP is usually the same company 

that provides access to cable TV or phone 

services in your local area. 

If you decide you would like to connect 

to the Internet, you need to know about the 

different services available. Most ISPs have 

service offerings that are significantly dif-

ferent from each other, so it is important to 

shop around to be sure you sign up for a ser-

vice that provides the features you desire. 

Some ISPs simply provide a cable router 

that provides high-speed access to the Web. 

Comcast and Verizon are the typical service 

companies available in the United States. 

Sometimes your service provider can also be 

your cell phone company.

The specifics to understand as a user 

are the speed of the services provided ver-

sus the cost of the service; a higher con-

nection speed is typically a more desirable 

scenario, but it also costs more. There are 

3.1.2

Digital phone service is usually in the form of 
VoIP (or Voice over IP), which is basically a 
communication service accessed using Internet 
infrastructure. VoIP uses servers and com-
puter systems to manage phone calls between 
users. The disadvantage to VoIP services is 
that they are susceptible to power outages 
and other types of computer system downtime 
issues. Analog telephone lines through your 
phone company are usually considered more 
reliable than VoIP lines.

The CONNECTION SPEED is the rate at which 
information is transmitted between your com-
puter and the network. Connection speeds are 
measured in the number of bits transmitted per 
second, particularly kilobits per second (thou-
sands of bits per second) or megabits per second 
(millions of bits per second). This is determined 
by two rates: download speed and upload speed.
The DOWNLOAD SPEED is the speed of data 
reaching your computer from the network.
The UPLOAD SPEED is the speed of informa-
tion reaching the network from your computer.
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sections will 

teach you the 

anatomy of a 

Web browser and expose you to three of the 

most common Web browsers available.

Addresses on the Web
Web resources are identified by a 

Uniform Resource Locator (URL). This is 

a pathway that establishes the server and 

file that the Web browser is attempting to 

access on behalf of the user. You can see an 

example breakdown of the pieces of a URL 

in Figure 3.6. The URL is entered into the 

address bar of the Web browser to establish 

a connection to the specified resource. URLs 

cannot include blank spaces (whenever you 

see a %20 in a URL it is the browser attempt-

ing to reconcile a blank space in the path).

The individual pieces of the URL http://

www.example.com/files/mypage.html are as 

follows:

•	First, http is the protocol. A protocol 
is a set of messages coupled together 

3.2.1

Some ISPs can provide speeds that 
promise 12 Mb (megabits per sec-
ond) of download speed and 1.5 Mb 
of upload speed. These speeds can 
be higher or lower, depending on the 
plans that are available for your area. 
Cable high-speed Internet is signifi-
cantly faster than dial-up.

•	DSL—Also known as a Digital 
Subscriber Line, these connections 
use copper wire provided by the phone 
company and are capable of speeds up 
to 128 Kbps; they can transmit voice 
and video at a relatively fast speed. 
They are considered slower than cable 
modem connections, yet faster than 
dial-up services.

•	Wireless 3G/4G networks—Your cell 
phone company can provide relatively 
fast service that enables a third-
generation (or 3G) speed around 800 
Kbps for uploads and 600 Kbps for 
downloads, depending on your geo-
graphical location. These speeds are 
faster than dial-up and DSL but sig-
nificantly slower than cable modems. 
Figure 3.5 shows a common portable 
3G device that plugs into your laptop 
using one of its USB ports. With this 
device, you can surf the Web on your 
laptop from any location. The next 
iteration of these standards, the 4G 
(fourth-generation) network is becom-
ing widely available through most 
cellular phone companies, allowing 
faster connection rates for a better 
experience on the Web.

USING A WEB 
BROWSER

Now that you understand how the Web 

and Internet work and how to acquire a con-

nection that suits your needs, it is time to 

go back to the topic of navigating the Web. 

You already know that you can navigate the 

Web by using a Web browser. The following 

3.2

 FIGURE 3.5
3G USB connection mini modem
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may precede the domain name which 
represent subdomains (such as videos.
example.com where videos would be 
the subdomain).

•	The text example.com is the domain 
name. This is uniquely bound to a 
preset folder on a Web server.

•	The text com is the Top-Level 
Domain (TLD). These are the top 
level in the domain hierarchy and 
assist in uniquely identifying server 
names. There are only a limited 
number of these in existence, though 
more are being created as the old ones 
are exhausted. Common TLD names 
include com (for commercial use), org 
(which is typically for nonprofit orga-
nizations), edu (for educational use), 
and gov (for government Websites).

•	The rest of the address is used to 
locate local resources on the specified 
Web server. The files portion of the 
address represents the file structure 
(called the file path) past the main 
folder of the Web server connected 
to the Web server identification. 
Multiple subfolders can be identified 
as part of the file path (such as media/
videos where videos is a subfolder of 
media and the media folder resides in 
the main folder identified for the Web 
server identification).

•	The final portion of the URL is the 
filename. In this case it is mypage.
html. This identifies the specific 
resource that the Web browser is 
requesting from the Web server. Most 
of these filenames will be HTML files 
with an extension of .htm or .html.

to transmit information in a way 
that both the sender and receiver 
can understand. The common pro-
tocols you may see for Web use are 
http (used for connecting to a Web 
resource), ftp (File Transfer Protocol 
for uploading and downloading files), 
and mailto (which is used to invoke 
the default email program).  You 
may also see https, which indicates a 
secure connection to a Web page.

•	Next, the colon (:) separates the pro-
tocol from the input command. The 
input command is the rest of the URL 
information after the colon.

•	The double slashes (//) signify 
that contact to a server should be 
established.

•	The next section is the Web server 
identification information (which is 
also called the hostname); in this case 
it is www.example.com. This speci-
fies a unique Web server to which the 
Web browser will submit a resource 
request. Alternately, you may see a 
set of numbers separated by period 
characters such as 128.163.1.1; this 
also uniquely identifies a server by its 
Internet Protocol (IP) address. The 
humanly readable text is a conve-
nience for users that connects to a 
numerical server address.

•	Inside of the Web server identifica-
tion, the www signifies the server 
that should be listening for a request 
from the protocol. The www can be 
omitted in almost all cases because it 
will be assumed by default. Other text 

 FIGURE 3.6
Example Breakdown of a URL

When there is no filename specified, the server will 
look for either index.htm or index.html. When you see 
only a domain name or folder, the site is using this fea-
ture to automatically find the page you are viewing.
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the link to download the software (in this 

case “Get Internet Explorer 10”).

Once you have downloaded and installed 

the browser, you can view any Web address 

using its interface. An overview of the ele-

ments of Internet Explorer is shown in 

Figure 3.8. Here you can see the address bar 

where you will enter the URL of the page 

you want to view. The window can have 

multiple tabs in it to switch quickly between 

pages. You can add tabs by pressing Ctrl+T 

or by clicking in the blank space to the right 

of the last tab in the window. To the left of 

the address bar are the Back button and 

Forward button to navigate through the his-

tory of the currently selected tab. You can 

also press the alt key to open a more detailed 

menu of options.

The Web browser itself has a signifi-

cant amount of functionality for managing 

sites that you use regularly. One basic func-

tion you should learn to use is the ability to 

save the addresses of the sites you visit on 

the Web. There are two common terms used 

to refer to this type of activity. On Internet 

Explorer, your favorite sites are referred 

to as favorites, and on Safari and Firefox 

Web browsers, these are called bookmarks. 

The selection for managing these favorites 

is shown on the right side of the interface. 

Clicking this icon will open a new window 

to navigate through your favorites or add 

the current page to your list of favorites. 

In Internet Explorer, the default view only 

shows you the Home button, Favorites but-

ton, and Tools button on the top-right side 

of the browser, as shown in Figure 3.8. 

Microsoft Internet 
Explorer

Microsoft provides Internet Explorer 

(IE) with all of the Windows operating sys-

tems it offers. In its tenth version, IE is very 

common and rather easy to use with some 

practice. The Web browser is what helps the 

user download files from the Web and access 

information on Websites and conduct secure 

e-commerce transactions.

The icon for Internet Explorer is shown 

in Figure 3.1. You should locate this icon 

on your Windows machine with an active 

Internet connection to launch the Web 

browser. If you do not have Internet Explorer 

installed or you do not have the latest ver-

sion of Internet Explorer (currently version 

10), you can download it from: http://win-

dows.microsoft.com/en-us/internet-explorer/

download-ie. You should see a screen similar 

to Figure 3.7. From here, you should click 

3.2.2

 FIGURE 3.7
Download page 
for Internet 
Explorer 10

E-COMMERCE (short for electronic commerce) 
is the act of purchasing and selling products 
using electronic transaction technologies over 
the Internet. There are a wide range of tech-
nologies available to safely conduct e-commerce 
transactions.
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selecting Download Manager. You can see 

the Download Manager in Figure 3.9. 

From the Download Manager, you can 

select a file to open or use the X icon to 

remove the file from the list. Note that this 

does not delete the file from your computer; 

instead it just eliminates it from the display. 

You can select Clear list to remove all files 

from this listing.

Activity 3.1—
URL Practice

Using the pre-installed browser 

on your computer, enter a URL in 

the address bar from an advertise-

ment or organization you trust. 

Document the different parts of the 

final address that appears in the 

browser’s address bar. Is the final 

address that appears when the page 

loads the same as the one you typed? 

If not, why might this be the case? 

What elements remain the same?

Internet Explorer also gives you the 

ability to monitor and manage downloads 

with the Download Manager. Any time you 

click on a file link in a Web page and choose 

the Save option, it will be added to your list 

of downloads. The Download Manager can 

be activated by either using the shortcut key 

(Ctrl+J) or pressing 

the Tools button and 

 FIGURE 3.8
Anatomy of 
Internet Explorer

 FIGURE 3.9
The Download Manager in 
Internet Explorer

Back button FavoritesAddress bar

SettingsToolbar
Home

Tabs

Add current page 
to Favorites
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located to the left of the address bar to navi-

gate through the history of the current tab.

To manage your downloaded files, 

Firefox has a Downloads window that you 

can access at any time by either using the 

Ctrl+J keyboard shortcut or simply select-

ing the Firefox button and then Downloads 

from the menu. The Downloads window, 

shown in Figure 3.10, helps you determine 

the status of any file you download to your 

computer.

In addition to keeping track of applica-

tion and file downloads, you can pause or 

cancel any of your downloads at any time. 

You can also open files or folders and save 

files to specific locations from the Downloads 

window. Once you have downloaded your 

file, you can remove the file from the list 

or retry a download from the Downloads 

window.

The configuration options 

are located within the Firefox 

menu, shown in Figure 3.11. 

This dropdown menu allows 

you to create a new window, 

set options for the browser, and 

even create a private window 

where your history and usage 

will not be recorded. This is 

an important tool for protect-

ing your privacy online. From 

here, you can also access your 

Mozilla Firefox
The next browser you will learn about is 

Mozilla Firefox. The Firefox browser origi-

nated from the early Netscape Navigator 

browser technology in the early 1990s. 

Firefox is a very popular browser that can be 

downloaded for free on either the Macintosh 

or Microsoft operating systems. You can 

download Mozilla Firefox from: http://www.

mozilla.org/en-US/firefox/new/. 

You can see the interface for Mozilla 

Firefox in Figure 3.10. The display is simi-

lar to Internet Explorer. Each window in 

the browser can contain multiple tabs for 

displaying Web pages. New tabs can be 

added by clicking the + icon to the right 

of the last tab within the window. The icon 

for accessing bookmarks is on the right side 

of the interface; from here you can add the 

current page as a bookmark or visit other 

saved pages. There is also a direct link to the 

file downloads you initiated from within the 

browser, also shown in Figure 3.10. Similar 

to Internet Explorer, the Back button is 

3.2.3

 FIGURE 3.10
Anatomy of Mozilla 
Firefox

Back button

Downloads

Address bar Favorites

Search

Home

Tabs

If you visit the homepage for Mozilla Firefox 
(at http://www.mozilla.org/en-US/firefox/new/), 
it will let you know if you are running the lat-
est version of the browser or if you need to 
update your software.
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Apple Safari
The final browser covered here is 

the Apple Safari Web browser. The Safari 

browser, shown in Figure 3.13, comes pre-

installed on all new Macintosh computers or 

can be downloaded from the Apple Website 

at www.apple.com/safari. You will notice 

that there is a lot of similarity in the basic 

elements of the interface in Safari. You can 

add tabs beneath the main address bar. 

The Back button and Forward button are 

located to the left of the address bar. The 

Bookmarks and History have their own ded-

icated menus in Safari. You can also see the 

downloaded files by selecting the View menu 

and then choosing Downloads.

Each browser has a variety of tools and 

options unique to it. Safari on Mac is a good 

choice because it has a minimal chance of 

infecting your machine. Firefox has a good 

set of tools for showing how secure a page is 

3.2.4

Bookmarks, History, and 

Downloads just as you can 

with the interface icons on 

the right side of the interface.

Setting your homepage on Firefox is a 

quick task. As shown in Figure 3.11, you can 

just click and drag the icon for the site you 

want to be your homepage over to the Home 

button—and that address is now set as your 

homepage whenever you open Firefox. You 

can also click on the Home button and you will 

immediately be redirected to your homepage.

Activity 3.2—Installing 
a Second Web Browser

Using the pre-installed browser on your 

computer, enter the URL listed in this chap-

ter for downloading Mozilla Firefox.  Follow 

the steps for accessing the file and install-

ing the software using this chapter and the 

general instructions in Chapter 2 as a guide. 

When you have completed the installation, 

open Mozilla Firefox on your computer to 

make sure the installation worked correctly.

 FIGURE 3.11
Firefox Menu

 FIGURE 3.12
Setting your homepage in the Firefox browser

 FIGURE 3.13
Anatomy of Apple 
Safari

Back button Address bar
Bookmarks

Tabs
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download and use it. Plug-ins can provide 

additional services or helper functionality, 

but they can also make your browser less 

safe or secure, such as with certain ActiveX 

libraries for use on Internet Explorer.

In Internet Explorer, you can select the 

Tools menu and choose Manage Add-ons. 

In Firefox, the Add-ons option is located 

under the Firefox menu. For Safari, you can 

select the Help menu and choose the default 

option of “Installed Plug-ins” to view them 

in the main window.

USING SEARCH 
ENGINES TO FIND 
INFORMATION 
ON THE WEB

Unless you already have the address 

of the site you want to visit, you may be at 

a loss for how to use the Web effectively to 

find information. A search engine can help 

you quickly navigate to a page that contains 

information relevant to your topic. Search 

engines like Google™ (www.google.com) and 

Bing™ (www.bing.com) can help you locate 

official Websites for companies and products 

as well as provide suggested resources for 

topics you want to explore.

A search engine is a software program 

that uses the text you enter into a search 

field to find matching keywords. The infor-

mation on the Web is not a database but 

rather a repository of semistructured data 

that does not have any real organization 

such as what you might find in a database. 

Most Websites are categorized by using a Web 

crawler service. A Web crawler service ranks 

Websites based on the frequency of searches 

3.4

that you are viewing, and Internet Explorer 

allows for the most functionality on a 

Windows machine due to its more robust 

integration with the core operating system.

USING WEB 
BROWSER PLUG-INS

A Web browser plug-in (sometimes 

called an add-on) is a special software pro-

gram that attaches to a Web browser and 

enhances its functionality; plug-ins are 

required to access certain content on the 

Web. For example, some sites include video 

clips. Many times these sites will ask you 

to install a plug-in, such as Adobe® Flash® 

Player. Flash Player (available from www.

adobe.com) is a browser plug-in that allows 

the browser to run dynamic video, image 

rendering, and quicker graphics while 

accessing Web content that is only obtain-

able through the use of this plug-in.

It is important to realize that there is 

a difference between plug-ins and media 

players. Media players can run specific 

video formats and work independently 

from the browser. Some examples of media 

players include Microsoft Media® Player, 

RealNetworks® RealPlayer®, and Apple 

QuickTime®. All of these can be used to play 

back video or music as long as the player 

supports the file format that the file was cre-

ated and stored in. 

You will typically be prompted to install 

plug-ins for your Web browser when you 

attempt to access certain content for the 

first time online. You should review the type 

of content that is being added to be sure 

you want it installed before you agree to 

3.3
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are hackers who 

will create fraudu-

lent Websites with 

names similar to 

well-known compa-

nies and products 

to entice unsus-

pecting computer 

users to quickly 

navigate to the 

site without realizing it is not valid. Privacy 

and security are a high concern on the Web 

and you should always be cautious of these 

aspects of information sharing.

PRIVACY AND 
SECURITY ON 
THE WEB

Searching the Internet can be an enjoy-

able experience, but it also can present some 

challenges if you do not carefully watch what 

you are doing. You should never just click on 

a Website simply because the link looks inter-

esting on the search engine you are using. 

One thing to remember is that all modern 

browsers will warn you if you are going to a 

Website that is not a trusted source. Never 

ignore the warnings issued by your browser. 

Many times the warnings are valid, and pro-

ceeding to an untrusted site could bring you 

to a site loaded with malware.

3.5

and indexes the 

sites for future 

searches. If you want your Website to appear 

on search engine results, you would need to 

register your site with a service.

Search engines typically have a simple 

interface with a search box for the text you 

want to find and a button to initiate the 

search. You can see an example of this in 

Figure 3.14. When reviewing the results 

provided by the search engine, it is impor-

tant to be sure that the site you are opening 

is a safe site or even the intended site.

Activity 3.3—Practicing 
Internet Searches

Using either the Google or Bing search 

engine, type keywords for a topic that interests 

you. Examine the results of the search. Open 

a new tab and navigate back to the homep-

age of the search engine you used for the first 

search. Enter the same keywords from your 

first search and add a few extra keywords on 

the topic. Does this narrow the focus of the 

results as compared to the first search? How 

do the results compare? Are any of them the 

same between the two searches?

Even if you recognize the site, be sure 

you are going to the correct address. There 

 FIGURE 3.14
Example search using Google

Not everything on the Internet and Web is true infor-
mation. It is very inexpensive to create and host a 
Website, so you need to be careful about what sites 
you visit and what information you trust. Consider 
the reputation and credibility of the source and the 
legitimacy of the domain you are visiting.
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based on your usage, especially through 

small apps called adware that load onto your 

machine as part of advertisements on differ-

ent Web pages. If you find your browser run-

ning slowly, it may have too much history 

stored along with temporary Internet files. 

All browsers allow you the option to clear 

your history.

For Internet Explorer, selecting the 

Tools button and then Internet Options 

lets you adjust a series of settings including 

deleting your browsing history and changing 

default options for deleting history automati-

cally. You can also change your default search 

settings and how Web pages appear in your 

browser, as demonstrated in Figure 3.15. 

The Internet Options dialog box gives you 

the ability to change 

many more settings 

You should be very careful to verify that 

a site is safe and valid before providing any 

information to the site, including your name, 

email address, and especially passwords, 

credit card information, or your social secu-

rity number. Unless you are required to use 

this for a government site (such as for pay-

ing taxes) and the site is secure, you should 

never give your social security number over 

the Internet.

Always search the Web for information 

that might give you warnings about a poten-

tial threat. It is important that you never 

give your privacy information to anyone. 

For example, many hackers use a scam in 

which they send you an email purporting 

to be from your bank that asks for personal 

information. Remember that no one in a 

banking institution will ever ask you for 

your passwords or other personal informa-

tion via an email message.

Browsing and 
Search History

Most browsers track your history of 

sites you have visited, and they store files 

and information about the sites so they can 

load them faster when they are sites you use 

often. Similar to bookmarked (or favorite) 

sites, you can view this history to quickly 

load a page you have already visited.

You should be aware that this informa-

tion can be used to track and profile you 

3.5.1

 FIGURE 3.15
Internet Options window in 
Internet Explorer

MALWARE is malicious code or scripts that can 
be used to acquire privacy information from your 
computer and make it available to a computer 
hacker who may use the information inappropri-
ately or resell it to someone who will.
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related to security, privacy, and other areas; 

these are accessed by using the tabs at the 

top of window. Advanced settings are not cov-

ered here, as the goal is to expose you to the 

basic settings that will help you search and 

navigate the Web at an introductory level.

A similar option is available in Firefox 

for configuring privacy and security. Use 

the Firefox menu, choose Options, and then 

select Options again. This allows you to 

modify settings for Firefox just like you did 

with Internet Explorer.

Activity 3.4—View 
your Browser History
Using the Web browser of your choice, 

follow the instructions for accessing the his-

tory stored for your browser. If you need help 

with this, feel free to consult the online help 

guides for the specific browser you are using. 

How are visited sites organized within the 

browser? How would you find the address of 

a specific site that you visited previously?

Secure Sites
Safe e-commerce transactions are con-

ducted using HTTPS. The easiest way to 

check to see if you are conducting a secure 

shopping transaction over the Web is to look 

at your Web browser URL window. If the URL 

is preceded by “https” in the address bar, your 

transaction is using the HTTP protocol with 

an encryption standard called Secure Sockets 

Layer (SSL) to protect your password and 

personal data while transmitting to and from 

your computer. Encryption is the use of an 

algorithm to change the text of your message 

to a code that is unreadable without the use of 

a special key to unlock the code. 

3.5.2

Notice the little lock that is highlighted 

in yellow at the top left of Figure 3.16. 

Clicking on the lock brings up a small win-

dow that provides further Website iden-

tification, such as any information about 

digital certificates and the valid dates for the 

certificates. The Website identification win-

dow also tells you whether the information 

transferred on the site is encrypted.

You have probably observed by now that 

most Websites use a lock symbol to indicate 

whether the site is using encryption, such 

as the one shown in Figure 3.16. There are 

actually three elements in Figure 3.16 that 

immediately let you know that the Website 

you are viewing is secure:

•	The site uses HTTPS in the address 
field.

•	There is a lock at the right side of the 
Smart Address (URL) field.

•	There is green text verifying the 
name of the company who owns the 
Website. Clicking on either the text 
or the lock lets you view the digital 
certificate that verifies the site, also 
shown in Figure 3.16.

Safe Sites
The picture in the dropdown box of 

Figure 3.16 shows the passport officer for 

Firefox in green. Passport officer icons pro-

vide information on Websites and notify the 

3.5.3

Digital certificates are used in the information tech-
nology field specifically to identify the identity of the 
transaction or email message. Digital certificates must 
be purchased from a trusted Certificate Authority 
(CA). A CA can be a private or public organization. 
One you may have heard of is VeriSign; you can read 
more about VeriSign at https://www.verisign.com.
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user whether a particular site is encrypted 

or unencrypted and whether it has a valid 

digital certificate guaranteeing the identity 

of the site owner. There are three color codes 

to help you identify the level of authenticity 

of a Website:

•	Green—The Website is completely 
verified and uses an Extended 
Validation (EV) key. An EV is a new 
type of digital certificate that requires 
the Website to go through a more 
rigorous process for identification.

•	Blue—The Website is identified and 
the connection is encrypted; it is safe 
from eavesdroppers who could be try-
ing to intercept privacy information.

•	Gray—The Website is not verified, not 
encrypted, and does not have a valid 
digital certificate.

You should never enter your personal 

information into any Website that does 

not have a valid identity or a secure con-

nection. These features can be identified 

in the address bar of all modern browsers. 

Similar security metrics like the lock icon 

and green text are used to identify trusted 

sites in other Web browsers as well. Internet 

Explorer uses a lock and color coding in the 

address bar background. Safari also uses the 

lock icon.

THE WEB AND 
FAIR USE

It is exceedingly important that you 

understand how to handle information 

you acquire from the Web while conduct-

ing academic research. Section II, “Word 

Processing and Microsoft Word,” will teach 

you how to determine the value of a source 

for research. Here, we want to specifically 

address how to handle information legally 

without violating copyright laws. You can-

not under any circumstances simply copy 

and paste material from the Web to use for 

your own work without providing the source 

from which you acquired the material. 

In some cases, you should acquire per-

mission from the owner of a publication 

prior to using it for your own work. In the 

academic field, you have some protections 

that are referred to as the Fair Use doctrine. 

Title 17 of the U.S. Code, Section 107 sets 

the following conditions for which a pub-

lished work may be considered fair use and 

used as part of your work as long as you cite 

the source appropriately:

•	Teaching

•	Scholarship

•	Research

•	News media

•	Criticism

It is also important that you find out 

what the proper writing style is for your 

school and acquire a good writing style 

manual that will help you to properly use 

3.6

 FIGURE 3.16
Using Secure 
Sockets Layer 
for an encrypted 
connection in 
Mozilla Firefox
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and cite sources in your papers. Common 

publication manuals include:

•	Publication Manual of the American 
Psychological Association, 6th ed.

•	The Chicago Manual of Style, 16th ed.

•	MLA Style Manual and Guide to 
Scholarly Publishing, 3rd ed.

When you begin using sources for 

research, you will likely find the prospect 

challenging. The most important part of 

all of this is to always remember to cite all 

of your sources properly by using the lat-

est edition of a writing manual approved by 

your educational institution. 

CHAPTER SUMMARY
The chapter provided an introduction to navigating the Web using the 

Internet to get you from one Website to the next. It covered the use of Web 

browsers, how to connect to the Internet, and how to conduct searches on the 

Web. It also covered the concepts of safety and security in your navigation of the 

Web. The next chapter will introduce you to the use of email and email clients, 

which are part of a group of applications known as productivity software.

CHAPTER KNOWLEDGE CHECK
Data is truly everywhere and can be identified most clearly as .

 A. Unprocessed facts

 B. Information

 C. Query result

 D. Both A and B

Information can be most clearly defined as data that has been .

 A. Processed

 B. Unprocessed

 C. Improved

 D. Deleted

1

2
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A Website is a collection of :

 A. Web pages

 B. Documents

 C. Folders

 D. Both a and b

 E. None of the above

The Internet is a global interconnection of hardware devices, such as your personal computer, that 
supports communication between different computing devices using an addressing scheme known 
as Internet Protocol version 4 (IPv4). 

 A. True

 B. False

The Web browser is the software application used to search, navigate, and retrieve information and 
data from the Web.

 A. True

 B. False

A Domain Name Server (DNS) address is used for name resolution on the Internet.

 A. True

 B. False

A  is the term used to identify a situation where two or more computers connect 
to share resources.

 A. Web pages

 B. Router

 C. Password

 D. My Documents

The TRACERT command is used to see what route your computer is taking to reach the host.

 A. True

 B. False

E-commerce is the act of purchasing and selling products using nonelectronic transaction 
technologies.

 A. True

 B. False

3

4

5

6

7

8

9
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Digital certificates must be purchased from a trusted . 

 A. Corporate authority

 B. Certificate Authority

 C. Retail outlet

 D. None of the above

10

CHAPTER REVIEW QUESTIONS
Describe the difference between the Internet and the World Wide Web. What is their relationship to 
one another?

What are the risks associated with e-commerce? What technologies are available to safely conduct 
e-commerce transactions as a customer? 

How does the process of academic research separate it from everyday Internet browsing? 

Are media players preferable to plug-ins? Why or why not? 

Why is it important to verify a Website’s authenticity? List steps you can take to verify its legitimacy.

Adobe Flash is one of the most popular plug-ins for Web browsers. What type of content does Flash 
allow on a Web browser that would not otherwise be possible? What are the limitations of Flash in 
terms of the type of browsers that support it?

Does the protocol https always mean that the connection is safe to use for personal information? 
Why or why not?

Document the steps necessary to set a homepage on one of the Web browsers covered in this 
chapter. What criteria should you use to decide on a homepage?

Define a set of general guidelines that would establish that a Website is safe to visit. Does this apply 
in all cases? Are there types of Websites that would require greater caution that what you have 
defined?

Does using a larger number of keywords always enhance the results of the Internet search you 
perform? Justify your answer with examples.
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PRACTICE EXERCISES
Match the terms from the following list to the corresponding definitions. Not every term will be used.   
Word bank: Data, Information, Network, Internet, World Wide, Web, Website, Web Server, Web 
Browser, Open Source, Local Area Network, Wide Area Network

 A. A network that can span to global proportions.  

 B. A collection of unprocessed facts.

 C. A repository that contains all of the files and folders for a Website and 
provides remote access to them via various protocols.

 D. A global interconnection of networks made up of hardware devices that 
support communication between different computing devices using an 
address scheme known as Internet Protocol.

 E. The act of purchasing and selling products using electronic transaction 
technologies over the Internet.  

Make a list of Websites that you visit on a weekly basis. If you do not normally use the Internet, 
search the World Wide Web to compile a list of sites that you think are interesting or helpful. Now 
bookmark the sites from your list. Practice making folders and subfolders to organize your sites so 
you can easily return to them when necessary. Choose one of these sites and assign it as your 
homepage. Make a list of the detailed steps you used to complete this assignment.     

Use the Internet to research the different companies that provide Internet connections for home use. 
Construct a table including four different service providers. You will want to include in the table the 
type of Internet connection they offer, the length of the service agreement and the connection speed 
(download and upload). Based on your table choose a service provider that best meets your needs. 
Explain your choice.  

Use your preferred Web browser to locate a Web browser plug-in and follow the instructions on the 
site to install the browser. Document your findings and steps you took to complete the assignment 
in a written format.

Practice adding bookmarks (or favorites depending upon the browser you use) to your Web browser 
from sites you use frequently. What are the advantages of using bookmarks? Why is it important to 
keep these organized?
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CHALLENGE EXERCISES
Choose one of the common publication manuals (APA, Chicago, or MLA). Choose a topic to research 
on the World Wide Web. To conduct your research you may use any one of the Web browsers and 
search engines. Formulate a 500-word paper about your chosen topic. Use your chosen (or 
assigned) publication manual style to properly give credit to the resources used in your paper. Then 
write a follow up paragraph that discusses why you chose your particular Web browser, search 
engine, and publication manual. 

Describe in your own words whether a single text box and search button is sufficient for returning 
search results from a search engine. Consider in your analysis whether any other options or 
refinements would assist in the search and whether those could be integrated into the keyword 
entry. Justify your answer with examples.

Use a Web search engine such as Google, Bing, or Yahoo! to find three Websites of your choice. 
Using the skills you learned in this chapter, determine whether a site is using encryption or a digital 
certificate for security. Describe all of the steps used to determine your findings in a written format.

Visit the homepage for VeriSign (www.verisign.com) and use the content provided to describe the 
benefits of having a certificate for a Website. What guarantee does this provide to the site visitors? 
What assurances does it provide to the site owners? Use a Web search to find other companies that 
offer similar certificates for the Web.

 Use a search engine to research how your computer can be infected by malicious software (called 
malware) when visiting Websites from a Web browser. List at least five things you can do to prevent 
this kind of infection. What can you do to make better choices on which sites to visit to reduce the 
chance of getting your computer infected online?
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CHAPTER  

4
Using Email and  
Email Clients

IN THIS CHAPTER

Electronic mail, commonly referred to as email, is one of the most essential 

tools for communication in the modern business environment. Learning to 

write email effectively is an essential skill for success in any organization. This 

involves the use of an email client to manage the incoming and outgoing mail 

for your account. Establishing a personal email account may also be necessary 

for communication outside of a business setting, such as with friends or family. 

Once you complete this chapter, you will be able to:

●	Describe how email clients are used to read and organize 
electronic mail

●	Set up and use a personal email account

●	Navigate and use email clients

●	Assess whether a message you write conforms to email 
etiquette practicesMicrosoft Office 

2013/365 and 
Beyond
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This is also called the store-and-forward 

model of information transmission because 

the message is saved on an email server for 

the recipient and can be retrieved at a later 

time.

EMAIL STRUCTURE
Each email message that is written 

(such as the one shown in Figure 4.1) is 

housed inside an electronic structure called 

the envelope. This envelope is typically 

used by the Simple Mail Transfer Protocol 

(SMTP) to direct the delivery of the message 

to the intended recipient. Like any other 

transmission over a network connection, it 

may experience multiple stops in the rout-

ing between the sender and the recipient (or 

recipients); these are handled by an initial 

Mail Submission Agent (MSA) and passed 

through Mail Transfer Agents (MTAs) until 

4.2

INTRODUCTION TO 
ELECTRONIC MAIL

Email is the digital equivalent of a 

letter or postcard and has become a pre-

ferred method for sharing information and 

resources in businesses and organizations. 

It is a fast and convenient form of communi-

cation that allows for quick transmission of 

information from one party to another. The 

benefits of email are its fast transmission 

speed, the ability to attach electronic files to 

a message, and the asynchronous nature of 

the communication.

Asynchronous communication means 

that both parties do not have to be online 

at the same time. Instead, the sending party 

connects at one time and the receiving party 

can connect at any time after the transmis-

sion has been sent to retrieve the message. 

4.1

 FIGURE 4.1
An example email 
message
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used for large groups to help protect 
email addresses and keep the message 
header size small.

•	Subject—This is a short description of 
the contents of the message; it should 
be a preview of what is contained in 
the message body.

The header may also optionally contain 

the following fields: In-Reply-To, Content-

Type, Received, References, and Reply-To.

The body of the message is where the 

relevant content is placed in an email mes-

sage. In the actual email message format, 

the body is separated from the header by a 

blank line. Most email clients separate these 

two items entirely when viewing the mes-

sage. The body contains the actual informa-

tion that you want to send to the recipients. 

Email was once limited to plain text input, 

but most email clients now allow you to 

enter HTML tags and formatting into the 

body of messages, meaning you can perform 

most of the formatting operations of word 

processing in an email message.

You can also add attachments to an 

email message. These are external files that 

are enclosed in the envelope of the message 

along with the header and the body. There is 

no intrinsic size limitation on an email mes-

sage, but the standard cutoff for most email 

clients is 25 MB per message including the 

it reaches the Mail Delivery Agent (MDA) of 

the recipient. The destination is controlled 

by the envelope as opposed to the contents, 

just as it would be with a letter that is sent 

through the postal service. The various 

agents in the system can be compared to the 

postal workers that deliver standard mail. 

Within the envelope, an email has two 

components: the header and the body. The 

header contains the subject and address-

ing information for both the sender and the 

recipients of the message. Unlike a real let-

ter, a single email can be sent to multiple 

recipients with ease; this is controlled by the 

information added to the header. The header 

commonly contains the following fields:

•	From—This is the address of the 
sender. In most email clients, this is 
not an editable field.

•	Date—This is the send date of the 
message. In most email clients, this is 
not an editable field and may not even 
be visible.

•	Message-ID—This is an automatically 
generated identification value that is 
used to identify the email message.

•	To—This field identifies the pri-
mary recipient or recipients of the 
email message; this field is composed 
of email addresses separated by a 
comma or semicolon.

•	CC—This stands for Carbon Copy; 
this field is used to send email to 
someone who is impacted by the cir-
cumstances described in the message 
body but who is not directly involved 
or does not need to take direct action.

•	BCC—This stands for Blind Carbon 
Copy; this will (in most email clients) 
hide the addresses of the person or 
persons listed in this field from other 
recipients. This option should be 

An EMAIL CLIENT is a software program on 
an end user’s machine that is used primarily 
to read and compose electronic mail messages. 
This is also called a Mail User Agent (MUA) in 
relation to the transmission of email messages to 
email servers that accept outgoing messages and 
deliver incoming messages.
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possible email addresses preclude blocking 

them all. It is therefore up to the spam fil-

ter of your email client to try to determine 

which messages are legitimate and wanted 

and which messages are unwanted.

EMAIL ADDRESSES
Each individual email is routed via an 

email address. This is a unique identifier 

for a single account. An example of an email 

address is officeandbeyond.richardson@

gmail.com. The information following the 

“@” symbol is the domain information; 

in this example, the host domain is gmail 

and the top-level domain name is com. The 

domain name in an email address must con-

form to the same rules as a hostname in a 

URL. The domain part of the email address 

is typically established by the organization 

hosting the email account and operating 

the MSA. Note that there can be only one 

@ symbol in an email address. The full stop 

character (also called a period or a dot) is 

used only to separate host domains in the 

domain part of an email address, but it 

can be used as a standard character (with 

or without repetition) in the left side of the 

address (which is the local part). 

The local part of the email address 

is defined either by the user creating the 

account or the business establishing the 

account on the user’s behalf, such as a work 

email account. The local part of the example 

email address is officeandbeyond.richard-

son. There are restrictions on the local part 

of the email address; this is particularly rele-

vant if you are creating a new email account 

for your personal use. The local part of an 

4.3

header, body, and attachments. This is actu-

ally a high limit considering the amount of 

traffic and documents that are passed via 

email in most organizations. Attachments 

are governed by the defined Multipurpose 

Internet Mail Extensions, commonly called 

MIME types. The MIME type is the format 

of the content that gives the information 

stored in the message context for interpre-

tation just like file formats in an operating 

system.

Email is considered a push technology, 

which means the sender controls the flow 

of information rather than the recipient. 

When you are using email, you are therefore 

subject to any messages that anyone wishes 

to send you. This is why unwanted messages 

(termed spam) are such an inconvenience; 

your inbox can be filled with these messages 

without your permission, and the range of 

You should never open an email message from a 
source you do not trust. If you have not requested 
the email and you do not know the sender from prior 
contact, you should not open the email message, no 
matter what the subject line states. There are profes-
sional scammers and attackers that excel at crafting 
subject lines to entice you to open harmful or deceit-
ful messages. Any attachment that is contained in an 
untrustworthy email should be deleted; attachments 
can contain malicious software that could compromise 
or destroy your machine. This is particularly true 
when the attachment is an executable file (one that 
has the extension .exe on a Windows machine); you 
should never open an executable file from an email 
message unless you have verified by outside contact 
with the sender that the file is legitimate. It is possible 
to send email falsely from another person’s account, 
so knowing the person from whom you received the 
email is not a guarantee that it is safe.
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two popular options that are discussed in 

this chapter are Microsoft Windows Live 

Hotmail (www.hotmail.com) and Gmail™ 

by Google (www.gmail.com).

In most circumstances, you will have 

the option of defining your own local part of 

the email address. While you can be creative 

with this choice, it is best to keep your email 

address at least semiprofessional in case you 

ever need to use it for professional opportu-

nities or include it in a resume. Your email 

address is an identifier that tells someone 

information about you, so you should con-

sider what the email address will tell them 

when they read it. You also need to keep the 

ease of remembering the address in mind 

in case you need to share it verbally. A good 

solution for both instances (though you do 

not have to do this) is to use your first name, 

then a dot or underscore character, and then 

your last name as the local part of an email 

address.

Email Account Types
There are different types of email 

accounts that vary based on storage and 

delivery. The common types of email 

accounts are POP (or POP3), IMAP, 

Webmail, and Microsoft Exchange accounts. 

4.4.1

email address is limited to 64 characters; 

the combined length of the local part of the 

address and the domain part cannot exceed 

253 characters. Additionally, the local part 

can only contain the following:

•	Letters from the English alphabet 
(both uppercase and lowercase letters 
are permitted)

•	Numbers from zero (0) to nine (9)

•	The full stop (.) character (also called 
the dot or the period)

•	The following special characters: ! # $ 
% & ' * + - / = ? ^ _ ` { | } ~ 

The local part of the address is case sen-

sitive, but the use of different cases to dis-

tinguish different accounts is discouraged. 

Most email providers disable this option by 

default. Some email providers restrict the 

special characters allowed as well. For exam-

ple, Microsoft Windows Live® Hotmail® only 

allows alphanumeric characters (upper-

case English letters, lowercase English let-

ters, and numbers), the underscore (_), the 

hyphen (-), and the dot (.).

CREATING A 
PERSONAL EMAIL 
ACCOUNT

Whether or not you have a professional 

email address, it is a good idea to have a 

separate personal email address for com-

munications outside of the professional 

environment. There are a number of email 

account providers that allow you to create a 

free account with a fixed amount of storage 

space. While there are a number of provid-

ers that offer such services, like AOL (www.

aol.com) and Yahoo! (www.yahoo.com), 

4.4

If you do not have a personal email account already 
and you are using a Windows machine, using Hotmail 
instead of Gmail is worth serious consideration. A 
Hotmail account will give you access to the Microsoft 
OneDrive (discussed in the next chapter) and serves 
as a Microsoft account which integrates into the 
Microsoft Office productivity suite. The Hotmail 
account also integrates into the login for Windows 8.

MSOffice-Beyond-CH04.indd   77 6/12/2014   2:41:33 PM



78 — Microso f t  Of f i ce  2013/365 and  Be yond

Webmail accounts may use either POP3 

or IMAP to provide you with access to your 

messages. Webmail service is typically pro-

vided by your email account provider and 

functions as a rudimentary client for read-

ing and writing email, allowing you the con-

venience of performing these tasks online 

without additional software beyond a Web 

browser. Webmail is typically limited in stor-

age space and provides you with advertise-

ments in exchange for using the account 

services free of charge.

Microsoft Windows 
Live Hotmail

Microsoft Windows Live Hotmail is 

one alternative for creating a free personal 

email account. For Windows users, it is also 

4.4.2

POP3 is the Post Office Protocol version 

three. With a POP3 account, your mes-

sages are stored on the email server of 

your domain until you access them. Once 

they are downloaded to your local machine, 

they are deleted from the server. This has 

the advantage of allowing you to read your 

mail when you are not connected to the 

email server. Some Webmail clients use the 

POP3 protocol to retrieve the messages but 

do not subsequently delete them; it is up to 

the individual ISP to determine this option. 

SMTP is used to send messages; the SMTP 

and POP3 servers are usually the same.

The Internet Message Access Protocol 

(IMAP) uses folders to store email on the 

email server and allows the user to access 

them on multiple machines. The typical 

means of accessing IMAP allows the user 

to view the header information for each 

email and then 

select the ones 

for which the 

content should 

be displayed. The 

drawback of this 

protocol is that 

it requires you to 

be connected to 

the mail server to 

read your email.

Port 25 is the standard port used for email traffic 
 outside of custom applications and services.

Microsoft Exchange accounts require a special 
server (a version of the Microsoft Exchange 
Server) and are typically only used by busi-
nesses. Exchange accounts specialize in 
collaborative communications across an 
organization.

 FIGURE 4.2
Hotmail login portal
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the domain to be outlook.com, live.com, 

or hotmail.com. All of these domains are 

accessed from the same portal; this choice 

only affects your resulting email address.

You need to create a password for your 

email account as well. The combination of 

the email address and the password you 

choose will be the information you need to 

access your account. Because your email 

address is public, you must carefully guard 

your password and with whom you share it. 

The registration form requires you to reen-

ter your password for verification. You will 

also need to either enter an existing email 

address (which should not be your work 

email address) or a mobile phone number 

as a security measure and backup contact in 

case you get locked out of your account.

The next few entries in the form are for 

your personal information including your 

first name, last name, country, state, and 

postal code. The first and last name you 

enter will be used as your display name in 

a convenient way to integrate with your 

system in terms of online access to Office 

documents and native Windows services. 

The homepage of Hotmail is www.hotmail.

com. When you enter this address in your 

browser, the screen shown in Figure 4.2 

appears. From here, you can either log in to 

an existing account or create a new account. 

To create a new account, click the Sign up 

now link.

Creating an Account

To create a new account with Hotmail, 

you will need to complete the registration 

form shown in Figure 4.3. Note that you 

will have to scroll down the page to enter all 

required information and submit the form. 

The first thing you need to determine is the 

local part of the email address that you want 

to use. Once you have entered it, you can 

click the Check Availability button; this step 

will let you know whether the name is avail-

able. You can also select whether you want 

4.4.2.1

 FIGURE 4.3
Hotmail 
registration form
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prompted to correct them. If there are no 

errors, you will be taken to the verification 

screen for your account. Here, you will ver-

ify an alternate contact that you entered for 

the account where you will receive a secu-

rity code which must be entered to activate 

the account. This is typically done via text 

message on your phone. Once you receive 

the code, you will enter it on the verification 

screen before your account can be accessed. 

You can bypass this step for seven days after 

you create the account, at which point it will 

be required to access your account again. It 

is best to complete this step immediately. 

Once your account is verified, you will be 

taken to the Outlook.com interface for your 

account. The first time you access your 

account, you will be prompted with a wel-

come message and an overview which you 

can review or dismiss.

Navigating and Opening Email 

When you are logged into your account, 

you will be taken to your account’s dash-

board by default. You can see how this looks 

in Figure 4.4. Your message inbox will be 

displayed by default, but if you navigate 

elsewhere, you can click the Inbox link on 

the left side of the screen. 

With your inbox open, you should see 

your email in the center of the window, as 

shown in Figure 4.4. Your folders are listed 

on the left side of the screen. To add a new 

folder to help you organize your emails, click 

the New Folder link and enter the required 

information. When you sign into Hotmail, 

you are automatically connected to the 

Microsoft Messenger service, a synchronous 

instant messaging service. You can click the 

4.4.2.2

both the account and email correspondence. 

You must then select a gender and enter a 

birth year. The registration form requires 

you to enter information in these fields, 

but you are not required to provide your 

full name in conjunction with the account 

if you are concerned about privacy. The sys-

tem will verify that the postal code is valid 

within the country and state you select.

The final text entry is for a captcha, 

which is an altered set of letters that can 

be read by a human but cannot be reason-

ably parsed by a computer. This is to prevent 

automated scripts from registering active 

email accounts within the system. You sim-

ply type the letters that are displayed in 

the image into the text box beneath it. The 

I Accept button at the bottom of the page 

will create the account; clicking this button 

means you agree to abide by the terms and 

conditions of use for Hotmail. You can read 

these terms and conditions by clicking on 

the links provided. Once you click this but-

ton, your account will be verified and cre-

ated if there are no issues with the data you 

entered. If there are any errors, you will be 

CREATING A PASSWORD
Choosing a password that is difficult to guess is incred-
ibly important to the security of your email account 
or any account that uses passwords as authentication 
mechanisms. Your password should not be too short 
(many sites require a six-character password) and 
it should contain a mix of lowercase and uppercase 
letters, numbers, and symbols. Any password that is 
easy to remember is likely easy to guess. To get around 
this, it is suggested you use a short sentence (called a 
passphrase) as a password. An example of this would 
be “Charlie is 2 awesome!” which is easy to remember 
and meets all of the criteria for a strong password.
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You can click the profile link, which 

appears as your name and picture, to open 

your profile settings. This allows you to 

change your account privacy settings and 

your contact information. Clicking the set-

tings link (which looks like a gear) and 

then selecting More mail settings opens 

the Options menu. Using this menu, you 

can select Safe and blocked senders under 

Preventing junk email to add senders you 

want to block or remove senders you previ-

ously blocked. You can change most of the 

account settings (other than your email 

address) using the Options menu.

The Drafts folder holds email messages 

that you have written but have not yet sent. 

icon that looks like a speech bubble with an 

emoticon in it to open the options for this 

service. Your service links are across the top 

of the window where you can view your cal-

endar or contacts as well as manage your 

account settings and sign out of Hotmail. 

For any folder, you can also delete, move, 

or print selected messages (where the box 

is checked to the left of the message). You 

can also arrange your email by date, subject, 

size, or sender using the Arrange by drop-

down menu.

You have the same options for naviga-

tion and email messages in each of your 

folders. When you delete an email message, 

it will be moved to the Deleted folder. To 

permanently remove the email, you must 

delete the message (a second time) from the 

Deleted folder itself. Clicking the Junk link 

with a message (or messages) selected will 

delete whatever is selected and block the 

sender, meaning you will not receive any 

future emails from that sender.

 FIGURE 4.4
Hotmail example 
interface

Compose  
new message

ProfileEmail list

Navigation pane

The added benefit of using Hotmail is the access to 
an online-only version of Microsoft Office called the 
Office Web Apps. You can create and edit documents 
online using the Web-based interface (called Microsoft 
OneDrive®). You can access these documents via a link 
that you can send to others for collaborative effort or 
for them to view what you have created.
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in the top line of the interface in Figure 4.5 

for more options), or declare this message 

as junk. The Junk and Sweep options allow 

you to manage unwanted email quickly.

Composing an Email

You can create a new email message 

from within any folder in your inbox by 

clicking the New link at the top of the email 

window. The new message editor will then 

appear in your browser window, as shown in 

Figure 4.6.

This window is where you enter the 

information in the header and compose your 

message. You should start with the header 

information. Your email address appears at 

the top; this is the From field. The To field 

is below your email address; you can type 

any address you want here and Hotmail will 

validate that it is in the correct format (this 

does not validate whether it is a legitimate 

recipient). Clicking on the To link opens a 

4.4.2.3

The drafts are stored on the email server 

and will remain with the account until they 

are sent. The Sent folder stores messages 

that were sent from your account. The sent 

items will remain with the account on the 

email server until they are deleted.

You can open an email message by click-

ing on either the name of the sender or the 

subject of the message. If you have just cre-

ated the account, you should see a welcome 

message from Microsoft with getting started 

hints. The message view, accessed by click-

ing on the subject, offers a list of options, 

including sending a reply to the message. At 

the left side of the window are links to take 

you to your inbox or let you access any fold-

ers you want to check. Clicking on a message 

will open it, as shown in Figure 4.5. Your 

message options are in line with the ser-

vice links. From these, you can delete, print 

(using the “…” icon shown beside Compose 

 FIGURE 4.5
Hotmail example 
email
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dialog box in the native Web browser, allow-

ing you to select the file that you want to 

include in the email.

Logging Out and Logging In

Whenever you are using a Web-based 

service, you should always log out when you 

are done with the tasks you needed to per-

form. To log out of Hotmail, use the profile 

(your name and image) on the right side of 

the browser and then choose Sign out on the 

menu that appears; you will then be auto-

matically redirected to the MSN homepage. 

Logging out will protect your account by 

preventing anyone else using the machine 

from artificially extending your session and 

accessing your email.

4.4.2.4

pop-up menu showing 

recent contacts and 

stored contacts so you 

can select them directly. 

As you type email 

addresses, if Hotmail 

recognizes a string of 

characters from your 

address book, it will 

provide a small pop-

up menu that allows 

you to click the name 

to enter the rest of the 

address for you. There 

is a Show Cc & Bcc link 

at the right side of the 

window that will make the CC and BCC 

header fields visible and usable.

Activity 4.1—
Sending an Email

Using the Webmail client for your email 

address, compose a new email and send it 

to your own account. Use the subject line 

“Hello, World!” and be sure your address is 

typed correctly. Send the message and verify 

that you received it.

You should always enter a subject line, 

and it should be descriptive of what the mes-

sage contains. The body of the message is an 

HTML-enabled text editor, meaning that 

the toolbar across the top can be used to 

format your text by changing the font, font 

size, style, color, and alignment. You can add 

attachments and images using the toolbar 

as well. Clicking the Attachments link opens 

a text box and activates a Browse button. 

The Browse button will open a File Upload 

 FIGURE 4.6
Hotmail new message editor 

Send Save Check spelling 
(in menu)

File attachment

Some files, such as Microsoft Office files, must be 
closed before they can be attached to an email mes-
sage. If a file is open in another program when you try 
to attach it, you will receive an error message and the 
file will not attach. 
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Creating an Account

To create a new Gmail account, click on 

the Create an account button at the upper-

right section of the Gmail homepage. This 

will open the account creation form shown in 

Figure 4.8. First, you must enter information 

in the first name and last name fields and 

determine the local part of the email account 

name. Again, you should keep the use of this 

account in mind when creating it. An easy 

way to create an email address is to use your 

first name followed by a dot or an underscore 

and then your last name; this creates a pro-

fessional, memorable address. You can deter-

mine if the account is available by clicking 

the button labeled check availability!

You must then create a password and 

retype it for verification. There is also a list 

of options with checkboxes that you can 

enable or disable. Next, you should enter 

a security question to assist you in recov-

ering a lost password and a backup email 

4.4.3.1When you want to log back in to read 

your email, you can go directly to the 

Hotmail Website (www.hotmail.com) and 

enter your username and password to access 

your account. If you forget your password, 

you can use the Can’t access your account? 

link, which will take you through a series of 

steps that will either prompt you to enter 

the answer to your security question or send 

a password recovery email or security code 

to an alternate account you specified when 

you registered.

Gmail by Google
Google offers its own free email service 

in the form of Gmail by Google. You can 

access Gmail from either the Google homep-

age (www.google.com) or the Gmail 

homepage (www.gmail.com). From the 

Gmail homepage, shown in Figure 4.7, you 

can either log in using an existing account or 

create a new Gmail account.

4.4.3

 FIGURE 4.7
Gmail homepage
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This window contains a navigation menu of 

Gmail account services across the top. The 

left-side navigation menu contains a view of 

your inbox folders, contacts that are online, 

and your connection to Google’s chat ser-

vice, Hangouts.

Above the list of email messages in 

your inbox is a set of options for organiz-

ing and managing your email. You can 

move or delete messages that are selected 

and you can refresh your inbox, download-

ing any new messages that have reached 

your account. You can also select from the 

available organization tabs across the inter-

face to organize your messages into basic 

categories.

Gmail also provides a task manager, 

which provides a simple interface allowing 

you to create a to-do list of items. From the 

service links at the top, you can access Google 

Drive (online document management and 

account to which a link to reset your pass-

word can be sent; you must also select your 

location from the drop-down list and enter 

your birthday (depending on your location). 

Finally, you will be prompted to enter a veri-

fication captcha (discussed in the earlier sec-

tion on Microsoft Windows Live Hotmail) 

and accept the terms and conditions of 

use for the account. You will be taken to 

your account overview once the form is 

error free and you click Next step. Follow 

the prompts given and you will be taken 

to the Gmail interface for your account. 

Similar to Hotmail, there is information to 

review about the features and options you 

have with your account when you login for 

the first time. You can review or skip this 

information.

Navigating and Opening Email 

When you log into your Gmail account, 

you will see a screen similar to Figure 4.9. 

4.4.3.2

 FIGURE 4.8
Gmail account 
creation page
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message, the mes-

sage will open in 

place of the Inbox 

display, allowing you to read the 

contents of the message, delete it, or 

archive it. The options to reply to the 

message, forward the message, and 

print the message are located above 

the message content. You can return 

to your inbox by selecting either 

the Inbox tag above the message or 

the Inbox link on the left side of the 

window.

Composing an Email 

To create a new email message in 

Gmail, click the Compose button on the 

main interface. This opens the email mes-

sage editing window, as shown in Figure 

4.10. The options presented here are simi-

lar to those in other Webmail clients. The 

header information is entered at the top of 

the message window. The To field and the 

Subject field are the two header fields that 

are initially visible. Click the Cc and Bcc 

links to add the respective header fields. 

Remember that your subject should be 

meaningful regarding the 

content of the email. As you 

type an email address in any 

of the recipient fields, Gmail 

will attempt to match it to 

your existing contacts; if it 

finds a match, you can click 

the address that appears 

beneath the address entry 

box to auto-fill the rest of the 

address. To the far right of 

the window is an expansion 

4.4.3.3creation software similar to the Microsoft 

OneDrive), a link to your personal calendar 

(which is part of the larger Google account) 

that you can use to keep track of appoint-

ments, and the common services offered by 

Google, including Google Maps, YouTube, 

and Google Search.

To open an email message in Gmail, you 

can click anywhere in the row displaying 

the message information. Messages that are 

displayed in bold are unread, and messages 

that display in standard text have already 

been opened. When you click on an email 

Compose new 
message

Profile

Email list

Navigation pane

 FIGURE 4.9
Gmail example 
inbox

 FIGURE 4.10
Gmail message 
editing window

Send

File 
attachment

Check spelling 
(in menu)

MSOffice-Beyond-CH04.indd   86 6/12/2014   2:41:35 PM



Chapt er  4  — Us ing  Emai l  and   Emai l  Cl i ent s  — 87

Logging Out and Logging In

As with any account, you should always 

make sure you log out when you are fin-

ished. This helps to prevent unauthorized 

access and use of your account. To sign out 

of Gmail, click the down arrow to the right 

of the account name at the top of the win-

dow; this opens a pop-up menu containing 

the Sign out link at the bottom. You will be 

returned to the Gmail homepage. Anytime 

you wish to sign back into your account, 

you can visit the homepage for Gmail, www.

gmail.com, and enter your email account 

and password. Because these are the only 

credentials needed to access your account, 

you should keep your password carefully 

guarded.

Activity 4.3—
Saving a Draft

Using the Webmail client for your email 

address, compose a new email with a sub-

ject line and body. Save the email as a draft 

and close the message composition window. 

Access your Drafts folder and open the email 

again. Did everything you added save cor-

rectly? When would it be useful to save an 

email for later?

EMAIL CLIENTS
Webmail functions as a limited email 

client. Some incarnations of Webmail are 

closer to the standalone email client appli-

cations than others. Email clients typi-

cally do not allow you to create an email 

account but instead serve to manage an 

existing email account through a range of 

supplemental services to manage tasks and 

4.4.3.4

4.5

icon; clicking this will open the message in 

the full window.

The body is where you enter the content 

of your email message; this is presented as 

a text area in the central part of the win-

dow. You can use HTML formatting in the 

content, but Gmail also presents you with 

a limited set of fonts and sizes from which 

you can choose. You can add bold, italic, and 

underline to the text as well as set the text 

alignment and add any bullets and number-

ing from the menus at the bottom of the 

message composition window. 

Activity 4.2—Adding 
Attachments

Using the Webmail client for your email 

address, compose a new email and use the 

attachment feature to add a file to your 

email address. Take note of the prompts and 

options that you have for adding a file from 

your email host. Send the message to your-

self and verify that you received it.

You can attach files to your email mes-

sage by clicking the icon that looks like a 

paperclip. This will open a set of options for 

different file types and sources to attach. 

When you are finished composing your 

email, click the Send button to send it or the 

trash can icon to delete it. Changes to the 

message are saved automatically and the 

message will be located in your Drafts folder 

until you send or delete it. You can use the 

expansion menu in the bottom right of the 

message composition window to select the 

option to check spelling before you send the 

message.
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the free Windows Live Essentials software 

package (available from windows.micro-

soft.com/en-us/windows-live/essentials) for 

Windows machines. You must download and 

install this software to use Windows Live 

Mail by navigating through the prompts 

for the software. This is a small application 

that allows for the management of multiple 

email accounts. It configures most accounts 

using just the email account name and pass-

word. The interface (shown in Figure 4.11) 

allows you to manage your email accounts, 

calendar, contacts, and newsfeeds. Windows 

Live Mail 2012 uses the ribbon interface that 

Microsoft has implemented in the Microsoft 

Office suite.

You can add an account using the Email 

icon on the Accounts ribbon. To change 

account settings, select the Properties icon 

from the Accounts ribbon. To remove an 

account, right-click the account name on 

the left side of the main interface and select 

Remove account, this procedure applies 

regardless of the current ribbon that is 

active.

Windows Live Mail allows you to man-

age your calendar and contacts as well as 

your email. You can sign into a Microsoft 

promote productivity. The main advantage 

of email clients over Webmail is the ability to 

save email messages externally on the local 

machine; this option is typically not avail-

able in Webmail. 

Most operating systems come installed 

with a small email client that allows for 

basic email creation and management. One 

of the free alternatives to the more robust 

Microsoft Outlook is Mozilla Thunderbird®, 

a companion program to Firefox that allows 

for simple account configuration, manage-

ment, and use. This can be a good alternative 

to the preinstalled options if you are looking 

for an email client to manage accounts on a 

home computer.

Microsoft Windows 
Live Mail

The free email client for a Windows 

machine is Microsoft Windows Live Mail; 

the 2012 update to this software is part of 

4.5.1

Microsoft Outlook is a professional email client that 
includes a calendar, task manager, and robust email 
capabilities and is widely used in businesses and 
organizations as a primary means of communication 
and productivity management. The full features of 
this product are covered in Chapter 6 as part of the 
Microsoft Office suite. 

Most email clients have automated protection against 
some untrustworthy sources and suspicious files. 
You should always pay attention to these warnings. 
You can see an example of this in Figure 4.11. These 
messages will allow you to decide how to handle the 
suspicious content. Be wary of accepting the content 
when it is flagged like this and be sure you can verify 
the source of the email before you accept it on your 
machine.

The RIBBON INTERFACE (also called 
the RIBBON USER INTERFACE) is a 
productivity-oriented GUI that contains 
larger icons than standard toolbars and 
emphasizes organizing related tasks into 
the same subset (a ribbon), which remains 
open and visible when selected, unlike a 
traditional menu.
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Email message creation in 

Windows Live Mail is similar 

to other Webmail clients with 

similar formatting options. 

The ribbon interface is slightly 

different, but it contains the 

same options; they are just in 

a different format. The mes-

sage creation window has its 

own ribbons. You can create a 

new email message by selecting 

the Email message icon on the 

Home ribbon with the Mail view 

selected in the lower right pane 

of the interface. The email creation win-

dow and its associated ribbons are shown in 

Figure 4.12.

account from the Home ribbon using the 

Sign in icon. From the Home ribbon with 

Contacts selected as the main view, you 

can email your contacts directly or you can 

instant message them through Windows 

Messenger.

Ribbon 
interface

Help

Account name

Email list

Navigation pane

Preview pane
Task pane

 FIGURE 4.11
Windows Live Mail 2011 interface and 
Accounts ribbon

 FIGURE 4.12
Windows Live Mail 
email creation 
window and 
ribbons

Save

Send
File attachment Check spelling

A Microsoft account and a Windows Live ID refer to 
the same credentials. These terms are used in vari-
ous locations in Microsoft products, but the same user 
name and password works for either.
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initially start the program, it will prompt 

you to enter a primary email account; Mail 

will automatically configure most accounts 

using just the email account and the pass-

word. The interface for Mail is shown in 

Figure 4.13.

Once you have configured an account, 

you can manage the account settings by 

selecting the Mail menu and then selecting 

Preferences. When the Preferences window 

opens, click Accounts to alter your settings 

and add or remove accounts. The Accounts 

interface is shown in Figure 4.14.

To save an email as a file in Mail, select 

the message you want to save, click the File 

menu, and then choose Save. You can save 

a message as a raw email file, a text file, or 

an RTF file. 

You can create a new message by click-

ing the Compose new message icon (which 

looks like an abstract pen on paper). This 

will open a new window for composing 

your message, as shown in Figure 4.15. The 

interface for creating new messages is lim-

ited because the messages are constructed 

The message header information and 

the message body are located beneath 

the ribbon interface. The Message ribbon 

allows you to format your email content 

using the Font panel and the Paragraph 

panel; these create the message using 

HTML enhancements. To add attach-

ments, images, hyperlinks, and emoti-

cons, use either the Insert panel of the 

Message ribbon or the Insert ribbon. You 

can check the spelling for your message 

using the Spelling icon. Delivery options 

can be set using the Delivery menu, but 

you should only use these options (like High 

Importance and Read Receipt) when it is 

absolutely necessary. The Options ribbon 

allows you to perform advanced tasks like 

encrypting the message, digitally signing 

the message, or delaying delivery. 

A message can be saved as a draft using 

the Save icon in the quick links at the top of 

the interface, which looks like an old fash-

ioned floppy disk. You can send the message 

using the Send icon next to the header infor-

mation for the message itself. To save an 

email as a file, select the message you want 

to save, click the Windows Live Mail menu 

(the blue menu on the far left of the ribbon 

names), select Save, and then select Save as 

file. The file can be saved as an email or text 

document or as HTML.

Macintosh Mail
The default email client installed on 

a Macintosh computer is Macintosh Mail. 

Similar to Windows Live Mail, it provides 

a simple interface that allows you to man-

age multiple email accounts. When you 

4.5.2

Compose new 
message

Help

Navigation

Preview pane

Email list

 FIGURE 4.13
Mail interface
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Mozilla Thunderbird
The Mozilla Foundation, the makers 

of the Firefox Web browser, offers a free 

email client for multiple platforms including 

Windows and Macintosh computers; this 

email client is called Mozilla Thunderbird. 

You can download Thunderbird from 

www.mozillamessaging.com/thunderbird. 

Thunderbird allows you to set up multiple 

email accounts and will configure most with 

just the email account and password. You 

will be prompted to add an account when 

you first start the software and will then be 

taken to the main Thunderbird interface, 

shown in Figure 4.16. 

Thunderbird provides a significant 

advantage over Webmail access with the 

ability to save email to a file on your local 

machine. To do this, select a message, then 

4.5.3as rich text (which is simple text with some 

formatting information) instead of HTML 

(which provides a richer formatting and 

media environment); in short, this means 

you are limited to changing the font and 

color settings of the text of the message. 

Other options let you add attachments and 

photos to your email message and save it as 

a draft. 

 FIGURE 4.14
Mail accounts preferences

 FIGURE 4.15
Mail message composition window

Send File attachment

While the basic tasks of email creation and 
management can be accomplished with the 
limited email clients that are installed with 
some operating systems, more robust features 
give a higher level of convenience for perform-
ing daily tasks and managing a large volume of 
email. The Mozilla Thunderbird option is pref-
erable to the more limited preinstalled clients 
in terms of productivity.
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To add more accounts or 

change account settings after 

you have configured your ini-

tial account, choose the Account 

Settings option under the Tools 

menu. From here, you can select 

the Account Actions menu to add 

or remove email accounts, as 

shown in Figure 4.17.

Email messages in any of 

your folders can be sorted by click-

ing the icons across the top that 

represent the field by which you 

want to sort (such as From or 

Subject). You can also switch to a threaded 

view, which will organize the messages by 

the inherent pattern of replies that they fol-

low. To help organize and filter your emails, 

you can mark them with symbols like a star 

select the File menu, Save As, and File (you 

can also do this with the Ctrl-S shortcut on 

a Windows machine and the Command-S 

shortcut on a Macintosh machine). You can 

choose whether to save the message as a 

mail document, HTML, or simple text file.

Compose mail

Email list

Help

Preview pane

Account name

Navigation pane

 FIGURE 4.17
Thunderbird 
account settings

 FIGURE 4.16
Thunderbird 
interface
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message as a draft, and send the email mes-

sage directly from this window. 

Activity 4.4—
Deleting Email

Using an email client on your computer, 

compose an email and send it to your own 

account. When you receive the email, delete 

it using the email client. Now, access the 

Webmail client for your account. Is the email 

still located in the Webmail client? Where 

else does the email appear in your folders?

Connecting to Your 
Email Remotely

Most mobile phones with Web access 

can receive email messages from existing 

accounts. Smartphones, like the iPhone® and 

Android™ phones, have utilities to configure 

your email. You can set up remote access to 

your email with either POP3 or IMAP and 

SMTP. Most mobile devices have their own 

version of an email client (or a small mobile 

application called an app) that can con-

figure a variety of accounts with the user-

name and password for the email account. 

Microsoft Windows Live Hotmail and Gmail 

4.5.4

or a tag. The search box at the 

top of the interface can help you 

search your email for a particu-

lar keyword or phrase. You can 

also apply a filter by keyword in 

the textbox below that.

There are several icons 

in the toolbar at the top of the 

interface. Get Mail lets you 

checks your account or accounts 

for any new mail that has been 

received, Address Book opens 

a new window that allows you to manage 

your contacts, and Tag places a color band 

on the selected message to draw attention 

to it and allow for easy sorting. Clicking the 

Write icon opens a new window (shown in 

Figure 4.18) where you can compose a new 

email message. 

You can choose which fields from the 

header you want to include and format your 

text with a range of HTML commands. The 

normal options of setting the font, size, and 

color are available, along with the ability to 

change the text alignment and add images, 

hyperlinks, and emoticons to the body of 

the text. You can add attachments, save the 

 FIGURE 4.18
Thunderbird 
email message 
composition 
window

One item worth noting is the Security fea-
ture in the message composition window of 
Thunderbird. This allows you to set up and 
use encryption to encrypt and decrypt mes-
sages; email is typically sent over the networks 
in plain text, so any information you send in 
an email message can be read by anyone who 
receives even a temporary copy of the packet 
on its way from the sender to the receiver. 
Windows Live Mail 2012 offers the ability to 
encrypt messages as well.

Send

Check spelling

Save
File attachment
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1. Always include a subject line and 
make sure it relates to the message 
contents. The subject line is a preview 
of the message contents; therefore, it 
should explain in brief to the recipi-
ent what is contained in the mes-
sage or what the message is about. 
A subject line should be short but 
descriptive.

2. Only include recipients to whom the 
message is significant. It is easy to 
get overburdened with the number 
of email messages that enter your 
account. You should consider this 
when you are sending an email and 
address it only to those individuals 
who are affected or would benefit 
from the message. If an individual 
is not involved in a situation, they 
should be left off of the communica-
tion. You should always avoid send-
ing junk mail and you should never 
forward spam.

3. Use To, CC, BCC, Forward, and Reply 
All properly. You should use the To 
field for individuals who need to read 
the message to gain information or 
take some action in response. The CC 
field should be used for individuals 
who are impacted by the situation 
but who do not need to take direct 
action; this may include a supervisor 
in a situation where he needs to be 
kept informed. The BCC field should 
be used when you are sending infor-
mation to a group; this is typically 
a hidden field so recipients will not 
see the email addresses of everyone 
in the group and they will not be 
bothered with a long list of recipients 
in the header of the message. You 
should only use the Forward function 
to send messages in which you have 
something to contribute or if a recipi-
ent was necessary but left off of the 
original distribution; the latter case 
will still require some explanation to 
the recipient. The Reply All function 
should only be used when you have 

by Google both have a mobile version avail-

able from the browser on your Web-enabled 

phone (regardless of the phone brand). Your 

email account provider can also give you 

the manual configuration details to set up 

remote email access on a mobile device. To 

set up a remote connection, you generally 

need the following information in addition 

to your email address and password:

•	Incoming mail server—This is 
typically a POP3 or IMAP server 
hostname.

•	Incoming mail port number—This is 
the port number on which the incom-
ing mail is received.

•	Incoming mail security settings—This 
can be set to no security, SSL, or TLS 
(Transport Layer Security); you may 
also have to set it to accept certificates 
for the connection.

•	Outgoing mail server—This is usually 
an SMTP server hostname.

•	Outgoing mail port number—This is 
the outgoing mail port, which is typi-
cally port 25.

•	Outgoing mail security settings—
These are the outgoing settings and 
may or may not be the same as the 
incoming security settings; options 
include SSL and TLS.

EMAIL ETIQUETTE
There are a multitude of thoughts on 

the Web about what constitutes proper email 

etiquette. You can conduct your own search 

to investigate this further, but there is a 

general consensus on some common tactics 

and practices that should be used in compos-

ing email messages. The following ten rules 

provide you with a suitable foundation for 

using email effectively and professionally:

4.6
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8. Check spelling in your email message 
before you send it. Most Web brows-
ers and email clients offer the option 
to check the spelling in any email 
message you are composing. You 
should be sure to take advantage of 
this to avoid any unnecessary typos 
that would diminish the profes-
sionalism of your communication. 
You should also make sure that you 
include proper punctuation to end 
sentences.

9. Use attachments sparingly. Large 
attachments can quickly fill an email 
inbox; typically, when an inbox is 
filled, it prevents the account owner 
from sending mail until the account 
is under the allowed limit again. This 
means you should be careful about 
sending a large attachment, especially 
when the recipient is not aware it is 
coming. It is considered a courtesy 
to send a short email notifying the 
recipient that a large attachment is on 
its way and asking if they are ready to 
receive it.

10. Use appropriate priorities and avoid 
overusing words like “urgent” and 
“important”. Some email clients allow 
you to set the priority of the mes-
sage. When doing so, you should not 
overuse the high priority setting if 
the actions needed are not actually 
urgent. Eventually, setting this prior-
ity flag to high will lose any meaning 
if you do it for most of your mes-
sages. You should also avoid words 
like “urgent” or “important” in the 
subject line. These detract from the 
overall content of the message and 
give no real preview of the subject. It 
is better to allow the content of the 
message to establish the urgency. In a 
real emergency situation, a phone call 
or in-person meeting is a much better 
option.

a significant contribution to share 
with the entire group; if this is not 
the case, individual replies are a much 
better alternative.

4. Keep your messages short and to the 
point. Email messages should not be 
used for lengthy explanations; those 
are better suited to phone calls or 
in-person meetings. Email messages 
are most effective when they are short 
and clear. If the recipient needs to 
take some action as a result of the 
email, it should be apparent. The 
recipient should never have to guess 
at the intention of your message or 
the next steps required.

5. Make sure you address all questions 
in your response and curtail further 
discussion. One approach to writing 
and responding to email is to have the 
goal of stopping the discussion with 
the current message. This means you 
should make sure any questions are 
addressed and any predictable ques-
tions are answered before you send 
the message. Failure to do this will 
slow down the communication and 
delay any outcome that is necessary 
from the communication.

6. Use clear writing and a neutral tone 
in your message. Your email mes-
sages should be clear; this means you 
should use proper sentence structure 
at all times and standard sentence 
casing. Changing the case in words 
makes the message more difficult 
to read. Because there is no tone in 
email, you should avoid irony and 
sarcasm; the context of the message 
and the tone with which you wrote it 
are lost, so your message should be 
neutral in tone with proper grammar 
and spelling.

7. Never type in all capital letters. Using 
all capital letters in an email message 
is the digital equivalent of shouting; 
it is considered rude to type in all 
capital letters. 
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CHAPTER KNOWLEDGE CHECK
The following are all examples of an email client except:

 A. Windows Live ID

 B. Microsoft Outlook

 C. Macintosh Mail

 D. Mozilla Thunderbird

A valid email address can contain all of the following characters:

 A. Uppercase letters

 B. Lowercase letters

 C. Numerical digits from zero to nine

 D. The underscore character

 E. All of the above

 F. None of the above

1

2

CHAPTER SUMMARY
This chapter covered the fundamentals of using email clients. Electronic 

mail is a convenient and efficient form of professional communication and it 

has become a standard for transmitting information in the modern business 

environment. If you do not have an email account, Gmail by Google and 

Microsoft Windows Live Hotmail are two alternatives for creating a free account 

to use for your communication needs. There are a variety of personal email 

clients available for use including those preinstalled on the computer for the 

operating system it uses. The ribbon interface described in this chapter for 

Microsoft Windows Live Mail will be seen throughout the rest of this book for 

the tools in the Microsoft Office suite of software programs, including the more 

robust Microsoft Outlook, which is an email client and productivity management 

software. The next few chapters of the book focus on the cloud computing and 

online file access as well as the first application in the Office suite, Microsoft 

Outlook.
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A valid email address can contain multiple full stop (or dot or period) characters.

 A. True

 B. False

A valid email address must contain at least one @ symbol and can contain more.

 A. True

 B. False

Most email clients provide the user with a built-in email account so there is no need to create a new 
account when you install an email client.

 A. True

 B. False

The following is a violation of the established rules for email etiquette:

 A. Using a descriptive and short subject line

 B. Using BCC for a large group email

 C. Typing a message or subject in all capital letters for emphasis

 D. Using Reply instead of Reply All for a large group email

 E. All of the above

 F. None of the above

A Webmail client typically offers all of the same features as a standalone email client installed on a 
computer.

 A. True

 B. False

Which of the following is true of all email clients and Webmail clients discussed in the chapter?

 A. They can send email from an existing account.

 B. They allow file attachments in an email.

 C. They allow HTML formatting for email content.

 D. All of the above

 E. Both A and B

 F. None of the above

Most email clients allow email messages in the following formats:

 A. Plain text

 B. Rich text (text with some formatting)

 C. HTML

3

4

5

6

7

8

9
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 D. All of the above

 E. None of the above

The following is a valid email address for Microsoft Windows Live Hotmail:

 A. mY_great_eMaIl@gmail.com

 B. hey!email-me!@hotmail.com

 C. my.great.email@live.com

 D. All of the above

 E. None of the above

10

CHAPTER REVIEW QUESTIONS
What are some examples of information that might be inappropriate to include in an email or might 
be unsafe to send via email?

What types of communication barriers exist in emails?

What are the differences in the construction and design of a personal email versus a professional 
email?

What are good practices for developing dynamic passwords?

Why is it considered unprofessional and inappropriate to type in all capital letters in email? Use the 
Web to research and support your answer.

Give an example of an emoticon and what it means. When would this type of inclusion be 
inappropriate in an email environment?

Describe in your own words how email has increased the efficiency of communication in either 
business or personal interaction.

Give an example of when you would use CC and BCC when sending an email. Briefly explain the 
difference between the two.

Give examples of the types of attachments you would include in an email to a friend. How would this 
differ from attachments you would include in a business email?

Why is it important for email to have the date and time the message was sent? When would this 
information be useful in a business setting?

1

2

3

4

5

6

7

8

9

10
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PRACTICE EXERCISES
Create a list of possible email address local parts that you could use as a personal account to 
register with a free Web email provider. Choose an email account provider and register one of the 
addresses from your list. Compose an email containing the possible local parts in your list and 
explain why you chose the particular address you did and the particular service. Send the email to 
your new account and save it to a local file using an email client. Make sure the message conforms 
to email etiquette practices, including the subject line.

Today many professionals and individuals alike access their email from a phone. Using a phone with 
Web access, setup remote email access on your mobile device. If you do not have access to a 
mobile device, simply choose a mobile device and research the instructions for setting up email. 
Using either method, write an email that describes the necessary steps for enabling email on a 
mobile device. In your email you will want to include the following: The incoming mail server, 
incoming mail port number, incoming mail security settings, outgoing mail server, outgoing mail port 
number, and outgoing mail security settings along with the email client and mobile device used.

Use the following terms to fill in the blanks below: Message-ID, BCC, From, Subject, To, Date, CC

 A.  This is the address of the sender. In most email clients, 
this is not an editable field.

 B.  This is the send date of the message. In most email 
clients, this is not an editable field.

 C.  This is an automatically generated identification value 
that is used to identify the email message.

 D.  This identifies the primary recipient or recipients of the 
email message; this field is composed of email addresses separated by 
a comma or semicolon.

 E.  This stands for Carbon Copy; this is used to send mail to 
someone involved in the circumstances described in the message body 
but who is not directly involved or does not need to take direct action.

 F.  This stands for Blind Carbon Copy; this will (in most 
email clients) hide the addresses of the person or persons listed in this 
field from other recipients. This should be used for large groups to help 
protect email addresses and keep the message header size small.

 G.  This is a short description of the contents of the message.

Compare a Webmail client to an email client installed on the computer. In general, what are the 
main features that differ between the two? Which one would be more useful at home or in the 
office? When would you use the Webmail client directly?

Compose an email to your instructor outlining the steps you took to register your email account. 
Include an appropriate subject, introduction, salutation, and signature. Copy yourself on the 
message via the CC field.

1

2

3

4

5
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CHALLENGE EXERCISES
Using your chosen email account, develop a signature that will be attached at the bottom of every 
email as your closing. It should include a salutation, your name, school name, area of study, and 
email address. You may include additional information, but be careful in sharing any additional, 
personal information over an email. Then, construct an email according to the proper format. Include 
the steps for creating a signature in the body of your email. Finally, insert your signature onto the 
developed email.

Use the calendar available in either your email client or your Webmail client to set an appointment to 
read the next chapter. Include any additional email accounts you use in the list of recipients. Include 
a description, location, and resources for the event. If you are using this book as part of a course, 
include your professor in the invitation list. Set a reminder for the event (if your email client supports 
them) for 15 minutes prior to your appointment.

Compose a new message and include your own address in both the CC and BCC fields. When you 
send it, you should receive two copies of the message. Compare the two copies to see if you can 
identify which one was sent to you via BCC. Based on your observations, what is the benefit of using 
BCC? Is there any way to detect when someone has been copied BCC on an email?

Using the Web and the contents of this chapter, explain when someone should be included in the 
CC field instead of the To field in an email message. Why does this distinction matter and what 
message does it send to the recipient when they are included in each category?

Describe the benefit of using a standalone mail client installed on the computer if you only have one 
email account to manage and it has a Webmail client. Using specific examples, identify the features 
that are available in the standalone email client that are not available in the Webmail client. Are 
there any features available in the Webmail client that are not included in the standalone client?

1

2

3

4

5
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CHAPTER  

5
Microsoft OneDrive and  
Cloud Computing

IN THIS CHAPTER

With the increasing power of the Internet and the decrease in cost of server 

space, a new paradigm for data storage has arisen in cloud computing. Cloud 

computing is a means to remotely store or process data on a server so you can 

access it anywhere you have a connection to the Internet. Microsoft’s cloud 

service, OneDrive, allows you to store your files remotely from your desktop 

or from any of the common Microsoft Office applications. This chapter covers 

the basics of creating an account in the cloud and using it to enhance your own 

productivity. Once you complete this chapter, you will be able to:

●	Create an account with Microsoft OneDrive

●	Store and retrieve files from your cloud storage location

●	Connect your desktop to your cloud storage

●	Integrate your OneDrive account with Microsoft OfficeMicrosoft Office 
2013/365 and 

Beyond
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you have higher needs than this. OneDrive 

also allows access to the Web app versions of 

Word, PowerPoint, and Excel.

This process is similar to creating a 

Microsoft Windows Live Hotmail account, 

in which you must create a username, pass-

word, and enter some identifying details like 

Creating a Microsoft 
Account

OneDrive can be accessed from the Web 

at www.OneDrive.com; this will reroute 

you to a custom URL where you can login 

or create an account. The interface for the 

OneDrive homepage is shown in Figure 

5.1. If you have a Microsoft account, you 

can login with it at this page to access the 

OneDrive without creating a new account.

If you do not have a Microsoft account, 

you can create one for using the OneDrive 

by clicking the Sign up now link at the bot-

tom of the screen. When you click this link, 

it will redirect you to the page where you 

can setup a Microsoft account. 

5.2.1

CLOUD COMPUTING
Cloud computing is the use of remote 

resources to process information or store 

files. The benefit of cloud storage is the abil-

ity to connect to these files and folders wher-

ever you are as long as you have a connection 

to the Internet. This frees you from using 

one machine or carrying the files on physical 

storage media from place to place. This can 

also be a beneficial backup for meetings or 

presentations where you may need to access 

a secondary copy of a file if the storage 

media fails or you do not have your original 

computer with you. As Internet connectivity 

becomes more advanced and storage space 

on servers becomes cheaper, cloud comput-

ing and cloud storage have become much 

more popular options for file management.

MICROSOFT 
ONEDRIVE

Microsoft OneDrive is a free cloud stor-

age service from Microsoft. It integrates 

with both the Windows and Macintosh desk-

top systems and allows for access on remote 

devices like smart phones and tablets. The 

free version of OneDrive comes with 7 GB 

of storage, but you can pay to upgrade this if 

5.1

5.2

Even though cloud computing is convenient, there is 
a security risk with storing your files outside of your 
computer. You should keep this in mind with the type 
of information and documents you place in your cloud 
storage system. Do not store anything containing per-
sonal information like your social security number or 
bank account information in the cloud; it is too easy 
for it to become compromised or to be intercepted over 
the network as you store or retrieve it.

If you have setup a Microsoft Windows Live 
Hotmail address, the login and password you 
use for that will serve as your account on 
OneDrive as well.

FROM SKYDRIVE TO ONEDRIVE
Microsoft’s cloud computing platform was pre-
viously called SkyDrive.  This is the same ser-
vice that is now called OneDrive; it has simply 
been rebranded.  You may encounter the term 
SkyDrive on platforms that have not been fully 
updated, but rest assured you are accessing 
the same system with all of your saved files.
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using the Web interface at www.OneDrive.

com. Explore the interface and identify the 

method for either creating a new file on the 

OneDrive from any of the Web apps avail-

able. You do not need experience with the 

Office applications to do this successfully; 

you only need to create and save the file as 

practice. When prompted, save the file as 

Activity5_1.

Uploading and 
Downloading Files

When you enter your Microsoft account 

email and your associated password after 

your account has been verified, you will 

see the homepage for your OneDrive. You 

can see an example of this in Figure 5.2. 

This interface allows you to upload new 

files, manage files stored on your OneDrive 

account, and download files to the machine 

you are using.

5.2.2

your address and an additional form of con-

tact that can be used to verify the account. 

Once you have completed this process, you 

can click the Create account link and you will 

be able to access your OneDrive account.

Activity 5.1—The 
OneDrive Interface

For this activity, you should create a 

Microsoft account if you have not yet done so. 

Using your account, login to the OneDrive 

 FIGURE 5.1
OneDrive 
homepage

The OneDrive is linked directly to the email 
associated with the Microsoft account and it 
requires only a password to access. You should 
consider this in both setting the level of secu-
rity on your password (i.e., the password com-
plexity and length) and the type of files that 
you add to your OneDrive because password 
security is relatively easy for attackers to 
bypass.
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using the right-click menu and choose Share 

or you can select Manage and then select the 

Share option in the pane that opens. The 

Share menu allows you to get a link to the 

item to distribute yourself or choose recipi-

ents for the file and OneDrive will email 

them a link to the item. You can set permis-

sions on the link for whether you want them 

to have editing capabilities or not. The file 

properties will show you the share settings 

for the file.

In order to upload a file, just select the 

Upload link at the top of the interface. This 

opens a standard file selection interface for 

your OS where you can select the file you 

want to store on your OneDrive. Once you 

have chosen a file, the upload will begin. The 

progress for this will be shown at the top of 

the interface, and an icon representing the 

file type (or a preview in the case of a photo-

graph) will appear in your file list. Clicking 

on this icon will allow you to manage the file. 

This opens a context-sensitive set of options 

along the top of the interface, as shown in 

Figure 5.3. You can also right-click the icon 

to open a menu of options as well, which is 

also shown in Figure 5.3.

You can download the file from either 

the top interface’s Download link or the 

right-click menu. You can share the file 

 FIGURE 5.2
OneDrive Web 
interface

You can also use the Create icon to access the 
Web app versions of Word, PowerPoint, and 
Excel. This will create a new document and 
save it to your OneDrive account for later use. 
The Web apps will be discussed later with the 
respective application, but in general they are 
more condensed versions of the standalone 
software with only the core functionality.
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INTEGRATING 
ONEDRIVE WITH 
THE DESKTOP

In addition to the Web application for 

OneDrive, you can integrate OneDrive into 

your OS desktop environment for easier 

interaction. This will allow you to place files 

to be uploaded into the OneDrive folder and 

it will synchronize the contents with your 

OneDrive account as you specify. The inte-

gration process is slightly different for each 

OS, as described in the following sections.

OneDrive on Windows 7
When you install Microsoft Office 2013 

on your Windows machine, it will install 

5.3

5.3.1

Activity 5.2—
Uploading Files

For this activity, you should login to the 

OneDrive using the Web interface at www.

OneDrive.com. You should then choose a 

file from your desktop to upload to your 

OneDrive. You should not choose anything 

that contains sensitive or personal informa-

tion. When you have selected the file, upload 

it to your OneDrive. Using the options avail-

able in the Share settings, create a link to the 

file. Paste the link in another tab or window 

in your Web browser. What happens when 

you visit the link? What options do you have 

to set the permissions on the file from your 

OneDrive interface?

 FIGURE 5.3
File management in OneDrive
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as your OneDrive password. It is safer not 

to enable this option, but it does provide a 

convenience if you do allow it.

OneDrive on Windows 8
In addition to the installed standalone 

application for OneDrive that is available 

on Windows 7, a Windows 8 app version of 

OneDrive is available for use as well. This 

can be downloaded from the Windows 8 

app store and it will appear in the Start 

screen. The interface for this app is shown 

in Figure 5.5. It functions similarly to the 

Web app version and allows you to directly 

upload and download files to and from your 

OneDrive and your computer.

5.3.2

OneDrive Pro 2013 which allows you to set 

the URL for your OneDrive library which 

will synchronize with the application. You 

can also install the Microsoft OneDrive 

application from http://windows.microsoft.

com/en-us/OneDrive/download#apps. This 

will allow you to use your OneDrive just like 

any other folder on your OS, as shown in 

Figure 5.4.

You can connect your OneDrive Web 

application to your PC to allow you to access 

any files from your PC as long as it is turned 

on and connected to the Internet. This is a 

risk depending upon the type of information 

that you store on your computer because the 

security of the connection is only as strong 

 FIGURE 5.4
OneDrive 
integration in 
Windows 7
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application will create a folder on your sys-

tem that is connected to your OneDrive. 

This folder acts like any other but it uploads 

the contents to your OneDrive account. You 

can see an example of the Dock icon and the 

OneDrive application in action on a Mac in 

Figure 5.6.

OneDrive on Mac OS X
OneDrive is also compatible with Mac 

OS X. To add OneDrive to your Mac, open 

the App Store and search for “OneDrive.” 

This will allow you to install the applica-

tion on your system and add an icon for 

managing the OneDrive to your Dock. The 

5.3.3

 FIGURE 5.6
Mac OS X 
OneDrive icon and 
connected folder

 FIGURE 5.5
Windows 8 
OneDrive app
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Microsoft account with any Office pro-

gram, the OneDrive becomes available as 

a storage location to open or save files from 

the File menu, just like any other folder 

on your machine. This is supported by 

all of the primary productivity programs: 

Word, Excel, and PowerPoint. When you 

sign into your Microsoft account on one 

of the Office programs, the account will 

be saved for the rest of the Office suite 

as well for whenever you open a different 

program.

To sign into a Microsoft account from a 

Microsoft Office application, such as Word, 

select the File menu and choose the Account 

option. This will open a screen similar to 

Figure 5.7. Choosing Sign In will prompt 

you to enter your Microsoft account email 

address and password.

When you have successfully signed into 

your Microsoft account, you can change the 

appearance of your programs, including the 

theme and background. You can also choose 

Activity 5.3—
Integrating OneDrive
For this activity, you should install 

OneDrive on your OS. Using a different 

file or the same file from the previous activ-

ity, you should place a file in the OneDrive 

folder that is now present in your OS. Revisit 

your OneDrive through the Web interface 

after a few moments (long enough for the file 

to upload). Does the file appear? How is it 

organized within your OneDrive account? 

Practice the process of downloading the file 

from the OneDrive Web interface to your 

desktop.

INTEGRATING 
ONEDRIVE WITH 
MICROSOFT  
OFFICE

Microsoft Office 2013 has direct inte-

gration with a Microsoft account and 

the OneDrive. When you sign into your 

5.4

 FIGURE 5.7
Account settings 
in Office 2013
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Activity 5.4—Saving a 
file to the OneDrive

Using the program that you opened to 

add your account, save the file you created 

to your preferred document location. Using 

either the integrated OneDrive location or 

the folder you established on your OS, save 

the file to your OneDrive. Connect to the 

OneDrive and open the file from the remote 

location. What options are provided to you 

the Add a service option to connect to your 

OneDrive to use it as a storage location 

directly from the File menu.

When you return to your document or 

file, you will see your name in the right cor-

ner of the interface. You can click on your 

name to open a dropdown box with account 

options as shown in Figure 5.9. This is pri-

marily cosmetic in appearance aside from 

the use of the OneDrive for storing and 

retrieving files.

 FIGURE 5.8
Account options in Office 
2013

 FIGURE 5.9
Account menu in Word 
2013
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software system and provides you with a 

Web app interface that should be familiar. 

Different companies have different benefits 

and services associated with their cloud stor-

age. Some cloud computing systems cost 

money to use but may provide a higher level 

of security or a higher storage capacity. Some 

of these charge on a monthly basis while 

others are free. The two alternatives that 

most closely reflect the purpose and use of 

OneDrive are Google Drive and iCloud by 

Apple.

Google Drive
Similar to the relationship between 

OneDrive and a Microsoft account, Google 

Drive is automatically enabled for free with a 

Google account. Google Drive provides 15 GB 

of free storage as well as separate access to 

the Google productivity apps for creating new 

word processing, spreadsheet, and presenta-

tion documents. Google Drive can be similarly 

integrated into most computing environ-

ments, but it is focused primarily on docu-

ment storage and transfer. Google Drive is not 

optimized for sharing photos and videos.

iCloud
iCloud is Apple’s cloud computing plat-

form. It is included in their OS by default. 

It allows for 5 GB of free storage for certain 

file types, like photographs. If you want to 

store additional file types, you need to pur-

chase other software like iWork. iCloud is 

accessible on PCs as well as remote devices 

through a control interface that allows for 

file upload and download, similar to other 

cloud services. Additional storage space is 

available for purchase.

5.6.1

5.6.2

for opening the document? Is there another 

way to open the document in the desktop 

application? How is this beneficial?

ACCESSING 
ONEDRIVE ON A 
REMOTE DEVICE

OneDrive is also available for iOS and 

Android mobile devices. It is located in the 

iTunes app store for iOS devices like the 

iPhone and iPad, and it can be found in the 

Google Play store for Android. In both cases, 

it can be found by searching for “OneDrive” 

in the search box. When installed, it allows 

you to access the features of OneDrive for 

managing and sharing your files. The login 

for this is the same as accessing the Web 

interface; you simply use your Microsoft 

account and the password you selected. 

The mobile versions are primarily for 

managing and viewing photos and videos, 

but you can download documents for use 

in other programs. The upload and shar-

ing features are optimized for the smaller 

screen in both of these versions so it will 

work efficiently with a smart phone.

ALTERNATE CLOUD 
COMPUTING 
PLATFORMS

Microsoft is not the only company that 

provides free cloud storage. However, if you 

use Office in any significant way, it does 

have the advantage of integrating with that 

5.5

5.6

OneDrive is the only common cloud service that is 
available to use on a Windows smart phone.
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CHAPTER KNOWLEDGE CHECK
Sharing a file from the OneDrive always allows anyone with a link to overwrite the file.

 A. True

 B. False

The Microsoft OneDrive can be accessed on .

 A. The Web

 B. A Windows desktop

 C. An iPad

 D. All of the above

 E. None of the above

 F. A and B

Files on the OneDrive can be unshared, meaning the account owner is the only one who can access 
the file.

 A. True

 B. False

A file uploaded to the OneDrive from a Mac will not be accessible on a Windows machine.

 A. True

 B. False

1

2

3

4

CHAPTER SUMMARY
This chapter covered the basics of cloud computing, primarily for storing 

and retrieving files remotely. Microsoft OneDrive was covered more extensively 

for its integration into the Microsoft Office suite and the access it provides 

to the Web app versions of the common Office productivity applications. 

OneDrive integrates directly with Office 2013 as a direct storage location and it 

is supported on Mac and Windows computers. The next chapter will begin the 

coverage of productivity software with Microsoft Outlook, which manages email 

and provides productivity aids like a calendar, contacts, and task list. 
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Only certain file types can be uploaded to the OneDrive.

 A. True

 B. False

Microsoft allows you to upgrade your storage size on the OneDrive for a cost.

 A. True

 B. False

The OneDrive provides  GB of storage space for free.

 A. 2

 B. 5

 C. 15

 D. None of the above

Connecting your Microsoft account to the Office applications allows you to .

 A. Customize the interface of the Office applications

 B. Save files to the OneDrive

 C. Store the Office application in the cloud so it can be used anywhere

 D. All of the above

 E. None of the above

 F. A and B

The OneDrive app on Android allows you to create new Office documents.

 A. True

 B. False

A Microsoft Windows Live Hotmail account is required to access the OneDrive.

 A. True

 B. False

5
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CHAPTER REVIEW QUESTIONS
Explain in your own words why cloud computing is beneficial in the modern world of 
interconnectivity. Give examples to support your conclusions.

Why is password security a risk for connecting to a cloud computing account? Give examples to 
support your conclusions.

What is the benefit of connecting to the cloud on a mobile device that does not have productivity 
software installed? Give two examples of when this would be useful.

Explain the benefit of using OneDrive to share a photograph instead of using social media like 
Facebook. Give examples to support your answer.

Explain a benefit of connecting a Microsoft account to the Microsoft Office programs other than 
storage on the OneDrive.

Explain why it is useful to connect the OneDrive to your computer when the Web interface is 
available on the same machine. Give examples to support your answer.

What other functionality would be useful in a cloud environment other than file storage and 
retrieval? Explain your answer.

Explain why it is useful to have access to the Web app versions of Microsoft Office in connection 
with the OneDrive. When would this be useful?

Explain the benefit of using one cloud storage service for all of your devices. Give examples to 
support your answer.

Give an example of a business file or folder that you would share in order to enhance productivity. 
Explain how sharing this would provide a better result than emailing the file.

1

2

3

4

5

6

7

8

9

10

MSOffice-Beyond-CH05.indd   113 6/9/2014   3:47:56 PM



114 — Microso f t  Of f i ce  2013/365 and  Be yond

PRACTICE EXERCISES
Use the Web interface for the OneDrive to create a new Word document. Save the file to your 
OneDrive using the menus available. Create a link to share the document. Explain the different 
options that you have for sharing the document. When would each one be used? Give examples to 
support your answer.

Upload a picture to your OneDrive and open it in the Web interface. If you do not have one of your 
own, you can use the Web to locate an image that you may use. What options are presented that 
are unique to images? In your own words, explain why the mobile versions of the OneDrive are 
optimized for image and video sharing.

Use the desktop version of OneDrive to upload a file to your account. Download the file using the 
Web interface. Explain the steps that it took to complete this cycle. Complete the process in reverse, 
uploading the file through the Web interface. Does the uploaded file appear in the OneDrive folder 
on your desktop? How does the process differ for this path?

1

2

3

CHALLENGE EXERCISES
The exercise requires access to at least two computers. Upload a file to the OneDrive and open it on 
another machine. How does the interface compare between the two versions of the OneDrive? Are 
there any differences in the file and how it appears on the two machines? If so, what would explain 
this?

Using the Web, explain briefly why passwords are not the highest level of security. How should this 
influence the material that you connect to your OneDrive? What consequences would arise if all of 
the files on your entire computer were accessible on your OneDrive account?

Microsoft and Apple are competitors. Explain why it is beneficial to Microsoft to support the use of 
their product on a Mac. Similarly, explain why Apple should support its cloud storage system on a 
PC. How is computing unique for this type of competition?

Create a Google account to access Google Drive. Compare the interface and options of Google Drive 
to the OneDrive. Which of these is a better system for cloud storage? Use specifics to justify your 
conclusion.

1

2

3

4
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CHAPTER  

6
Microsoft Outlook® and  
Productivity Management

IN THIS CHAPTER

Now that you have an understanding of electronic mail, or email, it is time 

to explore the first application in the Microsoft Office suite of productivity 

programs, Microsoft Outlook. Outlook is primarily an electronic mail client, but 

it also serves as a tool for productivity management, which includes additional 

tasks such as managing your calendar, maintaining your task list, and housing a 

contact list. Outlook is a common program in the workplace for communication 

and scheduling. Once you complete this chapter, you will be able to:

●	Manage email accounts in Microsoft Outlook

●	Manage calendar events such as meetings and 
appointments

●	Maintain a contact list

●	Add items to a list of tasks to manage and completeMicrosoft Office 
2013/365 and 

Beyond
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Anatomy of Microsoft 
Outlook 2013

The main interface of Microsoft Outlook 

2013 is shown in Figure 6.1. The ribbons 

along the top allow you to perform tasks 

specific to each of the elements with which 

you are working. These ribbons change to 

match the context of whatever you select as 

active on the left side of the window (called 

the Navigation pane), whether it is Mail, 

Calendar, Contacts, Tasks, or Notes. The 

second icon at the top left of the interface 

is Send/Receive All Folders; this option is 

also accessible from the Send/Receive ribbon 

or by pressing the F9 key. The Help icon is 

located on the far right of the interface and 

it is also accessible by pressing the F1 key.

The Send/Receive ribbon is constant, 

allowing you to get new mail for your con-

nected accounts and send mail that was 

written offline. You can also switch from 

working offline to working online by click-

ing the Work Offline icon (the state is deter-

mined by whether the icon is highlighted). 

When Mail is active in the Navigation pane, 

there are a few additional options on the 

Server panel in the Send/Receive ribbon 

that allow you to determine how you want 

to download information for the current 

email message or the current folder of email 

messages.

The File menu, located to the left of the 

ribbons, is shown in Figure 6.2. This is the 

menu you will use to adjust the settings on 

the default account that was set up when you 

started the software. To change any of the 

configured settings, click on Info in the left-

hand menu and select the Account Settings 

6.1.1MICROSOFT 
OUTLOOK

Microsoft Outlook is a professional 

email manager and productivity tool; it is a 

commercial version of an email client that 

adds functionality beyond just writing and 

managing email. Outlook allows you to not 

only manage your email (from one or mul-

tiple accounts) but also use a personalized 

calendar to keep track of events and meet-

ings, manage your contact list, keep track 

of your tasks (which functions just like a 

to-do list), and manage notes (which are the 

digital equivalent of sticky notes). Outlook 

is part of the Microsoft Office program suite 

and is included with both Microsoft Office 

2013 for Windows machines and Microsoft 

Office 2011 for Macintosh machines.

Outlook 2013 utilizes the ribbon inter-

face structure. When you first start the pro-

gram, it will prompt you to enter your email 

address and the password for that email 

account. Outlook will then attempt to auto-

matically configure the account, determin-

ing the servers and settings associated with 

the incoming and outgoing messages. Your 

account provider can give you this informa-

tion so you can enter it manually if Outlook 

cannot perform the configuration auto-

matically. You are then taken to the main 

interface of the Outlook software. While 

the functionality of the software is consis-

tent, the appearance of Outlook 2013 and 

Outlook 2011 are different. Both of these 

versions use the ribbon interface.

6.1
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Quick Access toolbar

Navigation pane

Account name

Preview pane

Show or  
hide ribbons

Email list

Help

View selection

Zoom setting

Ribbon interface

To-Do pane

 FIGURE 6.1
Microsoft Outlook 2013  
interface and ribbons

 FIGURE 6.2
Outlook 2013 File menu
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Anatomy of Microsoft 
Outlook 2011

Microsoft Outlook 2011 is very similar 

in functionality to Outlook 2013, although 

it has a different appearance, as you can see 

in Figure 6.3. The Macintosh version of the 

software uses a combined menu and ribbon 

interface. The menu bar is located along the 

top of the computer screen next to the Apple 

icon. The ribbon is located along the top of 

the application window, with quick link icons 

above it. These icons allow you to send and 

receive messages and access the help files.

The Tools ribbon allows you to import 

or export information from Outlook and set 

whether you want to work online or offline. 

6.1.2icon; this opens the Account Settings dia-

log box, which you can use to manage all 

of your connected accounts, contacts, and 

calendars. You can remove an account using 

the Account Settings dialog box by select-

ing that account in the Email tab and then 

clicking the Remove icon above the accounts 

listed. To add new accounts using the File 

menu, simply click on Info in the left-hand 

menu and then select Add Account under 

the Account Information display. You can 

save email to the local machine by using 

the File menu and selecting Save As; email 

can be saved as a text file, as a message, or 

in HTML format. To save a message to the 

local machine, click on the message and drag 

it to either the desktop or a folder.

 FIGURE 6.3
Outlook 2011 
interface and 
ribbons

Quick Access toolbar

Help

Menu interface

Navigation pane

Ribbon interface

Email list

Show or hide ribbons

Preview pane
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you can format email text using the mod-

ern HTML approach (the same language 

used for Web page creation that you learned 

about in Chapter 4) using a simple interface 

for common commands in text. Unlike word 

processing, formatting should be kept to a 

minimum to maintain quick readability. Not 

everyone will have an email client capable of 

viewing complex HTML information in an 

email format. If this occurs, most email cli-

ents that do not support HTML will display 

the text of the email as standard text and 

the HTML tags will be ignored.

Creating a New Email
You can create a new email message from 

the Home ribbon by selecting New E-mail 

(or E-mail). This opens a new window with 

its own ribbon interface. The options pre-

sented in Outlook 2013 are organized into 

multiple ribbons, while Outlook 2011 offers 

only two ribbons, as shown in Figure 6.4.

6.2.1

You can adjust the mode by moving the 

slider icon for Online Mode from Online to 

Offline (or Offline to Online). The Schedules 

icon in this ribbon can be used to send and 

receive mail, send mail only, or empty the 

Deleted Items folder.

You can manage your email accounts 

by selecting the Tools menu and choosing 

Accounts. This will open the Accounts dia-

log box where you can use the + or – icons to 

add or remove accounts. You can also select 

an account from the list to edit the account’s 

settings and save files to the local machine 

by clicking on the message and dragging it 

to the desktop or a folder.

MANAGING EMAIL 
IN OUTLOOK

Microsoft Outlook allows you to manage 

more than one email account, each of which 

has its own set of associated folders (such as 

Inbox and Deleted Items). Using Outlook, 

6.2

 FIGURE 6.4
Message creation 
window and 
ribbons in Outlook 
2013 (left) and 
Outlook 2011 
(right)

MSOffice-Beyond-CH06.indd   119 6/9/2014   4:42:27 PM



120 — Microso f t  Of f i ce  2013/365 and  Be yond

You can see the common formatting com-

mands in Figure 6.5.

As you become more familiar with pro-

ductivity software, you will see most of these 

elements repeat for formatting the appear-

ance of text. The “B” is for bold, which will 

create a thicker text that appears darker. 

This is one type of emphasis that preserves 

readability. The “I” is for italic emphasis, 

which slants the text. This can affect read-

ability in some cases. The “U” provides an 

underline to the text. The text itself is not 

changed in appearance, but the underline 

appears wherever this is selected. These 

icons work like a toggle, turning the modifi-

cation on or off as it is clicked. You can also 

select text in the message body and click one 

of these icons to apply the effect or get rid of 

it if it is applied already.

Activity 6.1—
Formatting Email

For this activity, you will create a new 

email message and practice with the for-

matting options available in your version of 

Outlook. Compose an email with at least two 

sentences. Choose two words to emphasize. 

Apply bold formatting to 

one of them and italic for-

matting to the other. What 

happens when you change 

the alignment? What hap-

pens when you click the 

icon to apply a bulleted list? 

When you are finished, add 

the subject line Activity6_1 

and send the email to 

yourself.

Most of the necessary email mes-

sage editing options are available in the 

Message ribbon. These include icons to 

change the font, color, size, and alignment 

of the text; you can also attach files and a 

signature from the Message ribbon. Images 

and hyperlinks can be added in Outlook 

2013 using the Insert ribbon; these options 

are available from the Message ribbon in 

Outlook 2011. The Options ribbon allows 

you to add the BCC field. To check spell-

ing, select the Spelling & Grammar icon 

under the Review ribbon in Outlook 2013 

or the Spelling icon in the Options ribbon 

in Outlook 2011.

Formatting Email  
Content

Most modern email clients, including 

Outlook, support the HTML format for 

email display. This allows you to set complex 

formatting such as bold text, italics, under-

lines, and different colors for your text. In 

Outlook, you can use the ribbon interface 

to format text whenever you are composing 

an email. This only applies to the text in the 

email body, not subject lines or addresses. 

6.2.2

Indent
Font Name

Common 
formatting 
commands

Common 
alignment 

commands

Font Size

Font Color

Bullets
Numbering

 FIGURE 6.5
Formatting 
commands in 
Outlook 2013
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they are more applicable. It is generally not 

a good idea to change fonts or font sizes in 

an email because email messages are meant 

to be read quickly. 

Managing Incoming  
Email

In Outlook, clicking on a folder within 

an account will open the view shown in 

Figure 6.6. This includes a list of every 

email that is currently part of that folder on 

the local machine. The Send/Receive icon 

initiates the process which will update this 

listing with any new mail that is received 

by the server that actually manages your 

email account. You can sort the email in a 

folder by date received, size, the category 

assigned, or even the contact information of 

the person who sent it. In Outlook 2013, this 

6.2.3

Bullets create an unordered list from 

multiple lines of text. Numbering provides 

the ability to order items, and you can switch 

the appearance with the dropdown menu to 

use either numbers or letters for your order-

ing. Indentation will add space before the 

word begins, providing the appearance of 

paragraphs that you would see in printed 

material. Font name and font size are dis-

cussed as part of word processing where 

 FIGURE 6.6
Inbox view in 
Outlook 2013

Some email clients allow RTF format instead 
of HTML. This format is discussed further in 
relation to word processing, but it allows for 
minor changes to text such as bold and italics 
for emphasis. HTML remains the most robust 
format for email construction to date.
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will create a calendar instance in response 

to an email. The Move icon lets you move 

your messages to another folder, and the 

Rules icon defines custom rules that deter-

mine automatic responses when you receive 

messages meeting specific criteria.

It is a good idea to clean out any 

unwanted messages so they do not clutter 

your email folders. You should also set up 

folders to house important email messages 

that you need to keep on the server. Any 

messages that you want to save but do not 

need to be kept active on the server should 

be archived to your local machine. To set up 

your email archive in Outlook 2013 on the 

local machine, click AutoArchive Settings 

in the Folder ribbon with Mail active in the 

Navigation pane. To archive items to your 

local machine in Outlook 2011, click the 

Export icon on the Tools ribbon. To create 

custom folders, select New Folder from the 

Folder ribbon in Outlook 2013, or select 

New and then New Folder from the Home 

ribbon in Outlook 2011.

MANAGING 
CALENDARS

An electronic calendar allows you to 

keep track of your schedule. Most email 

account providers, including Gmail and 

Hotmail, have some form of calendar. These 

calendars allow the creation of events, which 

6.3

is encapsulated as a dropdown list that by 

default shows the text “By Date” above the 

listing. Whatever email is currently selected 

will appear in the preview pane on the right 

side of the interface.

Email can also be saved or printed from 

Outlook. In Outlook 2013, the File menu 

can be used to save or print an email that is 

selected. You can also move email using the 

Move icon in the ribbon interface or by right-

clicking and selecting the Move option; this 

allows you to change the folder in which the 

email is housed. If you are moving email to 

the Deleted Items folder, remember that you 

need to delete them again from that folder 

to permanently remove them.

Responding to Email
Outlook allows you to perform all of the 

necessary tasks to create and manage email. 

The Home ribbons for both Outlook 2013 

and Outlook 2011 are shown in Figure 6.7. 

This ribbon allows you to select a mes-

sage and use Reply, Reply All, or Forward 

to respond. You can also choose advanced 

options such as Reply with Meeting, which 

6.2.4

 FIGURE 6.7
Home ribbon for 
email in Outlook 
2013 (top) and 
2011 (bottom)

Categories provide another way for you to organize 
your email. You can use the Categorize option and 
select a color to associate with an email. Sorting by 
category will then bring all of the similarly classified 
emails to the same grouping.
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Home ribbon of Outlook with the calendar 

active in the Navigation pane. The Home rib-

bon for the calendar is shown in Figure 6.8.

You should use an appointment for a 

personal event that involves you as the pri-

mary focus; you can still invite others to 

attend, such as an appointment to have cof-

fee with a friend. If you are using a calen-

dar on a work computer that is connected to 

others, you should set your appointments to 

private so others cannot see the details asso-

ciated with the event; instead, the calendar 

will just show you as busy during that time. 

To set an appointment as private, click the 

Private icon on the Appointment ribbon.

Activity 6.2—Adding 
a Meeting

For this activity, you will schedule a time 

to read the next chapter. Do this in Outlook 

are simply the details needed for you to be 

present for a certain occurrence at a cer-

tain time. For instance, if you needed to call 

your parents at 3:00 p.m. next Tuesday, you 

would need the phone number you are call-

ing, the time zone for the phone call, and the 

calendar date for next Tuesday. This is suf-

ficient information to include in the event 

details. Most events also have a time period 

associated with them, so if it is going to be a 

brief 15-minute call, you would schedule the 

event from 3:00 p.m. to 3:15 p.m.

Microsoft Outlook provides you with an 

internal calendar and the ability to include 

additional calendars (such as personal and 

professional calendars). Unlike most general 

calendars that allow you to create everything 

as an event, Outlook differentiates between 

appointments and meetings. You can create 

either an appointment or a meeting from the 

 FIGURE 6.8
Outlook 2013 
Calendar interface
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2011, Scheduling Assistant is a tab beside 

the Message tab beneath the header con-

taining the scheduling details.

MANAGING 
CONTACTS

Your contacts are people you interact 

with on a personal or professional level. 

Outlook allows you to manage individual 

contacts and groups easily and stores them 

in an Address Book that you can use to look 

them up later. To create a new individual 

contact, simply click the New Contact icon 

on the Home ribbon with Contacts active in 

the Navigation pane; for an individual, you 

can store address, phone number, and per-

sonal information. If you store an address, 

you can use the Map It icon to load a new 

Web browser window that will locate the 

address using the Bing search engine. You 

can also set the contact to private by select-

ing the Private icon; this hides the informa-

tion from others connected to your account, 

such as in an office or professional network 

environment. 

Activity 6.3—
Adding Contacts

For this activity, choose a friend or co-

worker and add their email and name as a 

contact in your Outlook contact manager. If 

you have additional information about that 

person, such as a phone number, add it as 

well. When you have finished adding the 

person to your contact list, compose a new 

email and start typing the person’s name. 

What happens when what you type matches 

part of the information stored for the contact? 

6.4

by creating a new meeting in the Calendar 

view. Explore the options that are provided 

and set this as a private time for yourself so 

that no one else can view the details. Name 

the appointment Activity6_2 and save it to 

your calendar. If you have an alternate email 

address, add that address as an attendee 

and send the invitation. What does the email 

look like when you receive it at your alternate 

account?

A meeting should be used for profes-

sional events. Meeting details may or may 

not remain public. You should include any 

resources in your meeting request that will 

be used in the meeting. Because meeting 

notices are sent via email, they will arrive 

in the same inbox with other email mes-

sages (though some email clients may not 

have the ability to transfer the meeting 

request to the recipient’s calendar). Meeting 

details should include any call-in numbers 

for remote attendees, the location for local 

attendees, and any Web resources (such as a 

Cisco® WebEx® meeting) the attendee needs 

to utilize. 

You can set how often meetings or 

appointments recur using the Recurrence 

icon when creating the initial event. 

Selecting the All Day Event checkbox clears 

your calendar for the day. The Scheduling 

Assistant will attempt to load calendars 

for any additional attendees that you have 

included in the meeting or appointment 

request. This will load your calendar in a 

row above the rest of the attendees so you 

can find a time when everyone is free. To 

access the Scheduling Assistant in Outlook 

2013, select the Scheduling icon; in Outlook 
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priority and a due date, and set reminders 

for when you need to follow up on it. A task 

entry is created using the New Task icon of 

the Home ribbon. When you are done with 

a task, you can select Mark Complete; this 

will remove the task from your active task 

list, but it will remain in Outlook so you can 

view your completed tasks later.

Activity 6.4—
Creating Tasks

For this activity, you will create a new 

task to complete the practice exercises for 

the chapter. Using the options available in 

Outlook, switch to the Task view and add a 

new task which details the exercises you need 

to complete and the deadline by which you 

need to complete them. You can use the cur-

rent date as the start date for the task. What 

other options are available when you con-

struct a new task? Save this task and mark 

it as completed when you have finished your 

work. What happens when you mark this as 

complete?

Notes are the digital equivalent of sticky 

paper notes that you would use to quickly 

jot down information. You can create notes 

and view existing notes by selecting Notes in 

the Navigation pane. Notes in Outlook just 

allow simple text entry, so you can write and 

save them quickly without any formatting. 

To create a note, click the New Note icon 

in the Home ribbon (or simply double-click 

inside the viewing pane in Outlook 2013).

How does this help productivity in compos-

ing emails?

For a group contact, you can store 

names and email addresses as a list. To 

create a new group contact, click the New 

Contact Group icon in the Home ribbon with 

Contacts active in the Navigation pane. In 

Outlook 2011, you can type the names and 

email addresses for the group directly and 

select the option for whether you want 

the addresses always included in the BCC 

header field to keep the addresses private. 

In Outlook 2013, you need to add the group 

members to your contacts before you can 

add them to a group.

When you have saved your contacts, 

Outlook allows you to look them up in your 

address book (or books if you have mul-

tiple accounts) rather than typing their 

email addresses. Outlook will also attempt 

to automatically complete any address that 

you start to type that matches the address 

of someone in your contact list. Click the 

Address Book icon in Outlook 2013 when-

ever you are creating a new email message 

or meeting to look up your contacts using a 

keyword search and choose the email header 

field in which you want the email address for 

your contact included. The address book is 

accessible in Outlook 2011 by selecting the 

icon that looks like an open address book 

(next to the address entry field).

TASKS AND NOTES
Outlook also allows you to use tasks and 

notes. Tasks are the digital equivalent of 

to-do lists that you would traditionally write 

by hand. You can create a task and give it a 

6.5

You can remove email messages, tasks, contacts, and 
notes in Outlook by clicking on the individual item 
you want to remove and hitting the Delete key.
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CHAPTER KNOWLEDGE CHECK
Microsoft Outlook provides the user with a built-in email account so there is no need to create an 
account after you install it.

 A. True

 B. False

The calendar system in Microsoft Outlook does not allow you to hide appointments, so you must 
only enter details you wish to make public.

 A. True

 B. False

The following event type should be used in Microsoft Outlook for having coffee with a friend:

 A. Meeting

 B. Appointment

1

2

3

CHAPTER SUMMARY
This chapter covered the fundamentals of using Microsoft Outlook for 

managing email and productivity. Outlook is similar to other email clients in 

its treatment of incoming email and its ability to format text in HTML format 

for delivery to other modern email clients. It also maintains a calendar, contact 

list, and task list to enhance your productivity and help maintain your schedule 

and workload on a day to day basis. Microsoft Outlook is a professional email 

client that is part of the Microsoft Office productivity suite of software available 

on Windows and Macintosh machines. The ribbon interface described in 

this chapter for Outlook will be seen throughout the rest of this book for the 

remaining tools in the Microsoft Office suite of software programs. The next 

section of the book focuses on the most common productivity task in modern 

organizations: word processing.
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Which of the following formats is the most advanced for formatting an email?

 A. Plain text

 B. Rich text (text with some formatting)

 C. HTML

 D. None of the above

Microsoft Outlook allows for the management of multiple email accounts at once.

 A. True

 B. False

Tasks in Outlook 2013 allow the user to enter .

 A. A start date for the task

 B. An end date for the task

 C. A name for the task (i.e. a subject)

 D. A description of the task

 E. All of the above

 F. None of the above

 G. B and C

It is not possible to mark a task as completed in Outlook, so it should just be deleted when it is 
finished.

 A. True

 B. False

Email in the Inbox of Outlook 2013 can be sorted by all of the following except:

 A. Date

 B. Size

 C. Category

 D. None of the above

Both a meeting and an appointment in Outlook can have invited attendees.

 A. True

 B. False

4

5

6

7

8

9
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Contacts stored in Outlook will automatically populate in an address field when the text you enter 
matches the  of the contact.

 A. Name

 B. Email

 C. All of the above

 D. None of the above

10

CHAPTER REVIEW QUESTIONS
Describe how categories can help organize email in a folder. Give examples to support your answer.

Give two examples of when you would use a meeting in Outlook and two examples of when you 
would use an appointment. In your own words, summarize the difference between the two and 
establish a rule for distinguishing them.

Why is it important to take advantage of spelling or spelling and grammar checks when composing 
an email? Give examples to support your conclusion.

When would you need to move an email from one folder to another? Is this a common practice? 
Give examples to explain your answer.

Explain in your own words why it is necessary to have a Deleted Items folder as part of an email 
account.

Explain in your own words the difference between a Deleted Items folder and a Junk folder. Why is it 
necessary to have both? What kind of email enters the Junk folder automatically? Give an example 
of this.

Choose two items on the Home ribbon in Outlook that were not covered in detail in this chapter. 
Explain the purpose of these items and when they would be useful.

Is it necessary to record every item that must be completed in a task in Outlook? If not, when would 
you add something as a task? Give examples to explain your answer.

What options are provided for responding to email in Microsoft Outlook? From your previous 
experience with email, explain when each of these would be used.

What options are available for creating calendar entries in Outlook? Choose two of these options 
and explain when and how they would be used.
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CHALLENGE EXERCISES
Using Outlook, create a new note. Would a note ever be more useful than either a task or a calendar 
entry? Give examples to explain your answer.  

Set a flag on an email in Outlook. Explain the process you would use to quickly identify an item that 
is flagged in one of your folders. When would the use of flags be more beneficial than categories?

The folders you create in Outlook do not correspond to folders in your actual email account. They 
exist only on your local machine. Define a rule for creating folders that would prevent the over-
complication of your email account (i.e., when the folders would become too much to manage your 
email effectively). Explain your answer with examples.

Practice deleting email from your Inbox and permanently deleting it from the Deleted Items folder. 
Explain why it is a good idea to delete email that is no longer needed, even if there is no size 
limitation on your email account. Give examples to explain your answer. 

PRACTICE EXERCISES
Add two contacts to your list in Outlook. Compose a new email and address it to one of your 
contacts. How much did you need to type before Outlook began matching the text you typed with 
the contact in your list? How does this speed up productivity? Is there a time when this would not be 
a convenience? Give examples to justify your answer.

Create a new folder under your email account in Outlook. Move at least one email into this folder 
and compare the view of that folder to your Inbox view. How does the ability to create folders help 
organize your email? Give at least three examples of folders that would make you more organized 
and explain your answer.

Create two tasks in Outlook. Make sure to include start and end dates for the task. Mark one of 
them as completed. How do the appearance of these differ? How would you know quickly if a task is 
complete? Is there a way to organize tasks that are completed and ones that are not? Explain your 
answer.

Add two contacts to your list in Outlook. These can be friends, family, or co-workers. What 
information about a person can be recorded in an Outlook contact? How much information is 
needed to make the contact useful in email exchange? Give examples to justify your answer.

1

2

3

4
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CHAPTER  

7
Introduction to Word and  
Word Processing

IN THIS CHAPTER

This chapter presents an overview of productivity software and an exploration 

of word processing, the most common productivity application used in today’s 

business environment. You will create your own word processing documents 

as you learn about the software, formatting text and utilizing templates. As an 

example project, you will also learn to create a resume and cover letter, which 

are fundamental tools for any job search. Once you complete the chapter, you 

will be able to:

●	Locate and use the File menu for most applications

●	Access the help files for an application

●	Construct a word processing document from a blank 
document or a template

●	Format and manipulate text in a document

●	Save and manage files within productivity software
Microsoft Office 

2013/365 and 
Beyond
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identical tasks. However, Office 2013 also 

includes Microsoft Access® (Chapter 16) for 

creating databases and Microsoft OneNote® 

(Appendix A, “Additional Productivity 

Software”) for compiling information into 

a digital notebook; these programs are not 

available in Office 2011. Office also includes 

an online app version of the software for use 

with a Windows Live account; this version 

does not require a license to use but it does 

not have the full functionality associated 

with the licensed version of the software.

For the most part, there is little differ-

ence in functionality between the Office 

2013 and Office 2011 versions of the pro-

grams. The differences are mainly in the 

placement of commands between the two 

versions, and these will be pointed out in the 

text as you follow along with the examples, 

just as they were for Outlook in the previous 

chapter. You access the programs that are 

part of Office on a Windows 7 machine by 

INTRODUCTION 
TO PRODUCTIVITY 
SOFTWARE

Microsoft Office is an example of a soft-

ware suite that is used for productivity. A 

software suite is a collection of individual 

programs that are used to perform related 

tasks; in the case of Office, this is the man-

agement of documents for word processing, 

presentations, spreadsheets, and email. You 

were introduced to Outlook in the previ-

ous chapter; Outlook is one of the software 

packages included in the Office suite, which 

itself is considered productivity software.

7.1

Office includes the following set of 

programs common to all of its versions: 

Outlook (covered in Chapter 6, “Microsoft 

Outlook and Email Clients”) for email and 

calendar management, Word (Chapters 

7 through 9) for word processing tasks, 

PowerPoint (Chapters 10 through 12) for 

professional presentations, and Excel® 

(Chapters 13 through 15) for spreadsheet 

creation and data management. Office has 

different versions depending on which oper-

ating system you have on your computer. 

Office 2013 is the most current version for 

a Windows machine, and Office 2011 is the 

most current version for a Macintosh. Both 

versions allow for the completion of nearly 

PRODUCTIVITY SOFTWARE is a program 
that assists you in performing tasks that are 
necessary for you to accomplish at home or in 
the workplace. Productivity is a measurement of 
how much you can accomplish in a given period 
of time.

If you do not already have Office installed on 
your machine, you can get a trial version of 
the 2013 software for Windows from the Office 
homepage at www.office.com. For the 2011 
version of the Office software for Macintosh, 
go to www.microsoft.com/mac.
Companies like JourneyEd (www.journeyed.
com) offer discounted professional software 
to students. If you are using another site to 
get a discount on your software, remember 
that whenever you purchase software from 
a source other than the official vendor, you 
should make sure the site is legitimate before 
you attempt to make a purchase or enter any 
personal information. This is part of being a 
responsible Web user.
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The File Menu
The File menu and the help files should 

be the first items you locate in any new soft-

ware system. The File menu exists in almost 

all software applications written today and 

enables you to perform the essential tasks 

of creating a new file, opening an existing 

file, saving a file, printing a file, and exiting 

the program. While there may be additional 

options available in the File menu, these 

basic tasks warrant further investigation. 

The File menu is typically located at the 

left side of the software interface. Figure 7.2 

shows the File menu for Word. In Word 

2013, the File menu (which is also called the 

Backstage view in the Office 2013 suite) is 

found to the far left on the ribbon interface. 

7.1.1

selecting the Start menu, 

choosing All Programs, and 

then choosing Microsoft 

Office 2013; you will then 

see a listing of programs 

from which to choose. 

For this chapter, choose 

Microsoft Word. If you are using Windows 

8, the start screen should contain an icon for 

Word once the program is installed. You can 

see the Word icon for Windows in Figure 7.1.

To access Office 2011 on the Macintosh, 

you may be able to click the icons installed on 

the Dock (when you installed the software, 

you probably had the option to place the 

shortcut icons there). If you do not have the 

icons on your Dock, you can access the pro-

grams in the Office 2011 suite by selecting 

Macintosh HD (or whatever name you have 

given your machine) from the desktop, open-

ing the Applications folder, and then open-

ing the Microsoft Office 2011 folder. Select 

Microsoft Word from the available programs.

 FIGURE 7.1
Word shortcut 
icon in Windows

New Document

Save

Save As

Microsoft Word 2013 Microsoft Word 2011

Whenever you activate one of the Office programs on 
a Macintosh, you will first be presented with a gallery 
of options for selecting templates or existing docu-
ments. You can simply select Cancel on this screen to 
get to the standard interface.

 FIGURE 7.2
File menu in Word
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the document. The first time you save 
the document after it is created, this 
command will typically function like 
the Save As command.

•	Open—The Open command is used to 
reopen existing documents. Selecting 
this command opens a dialog box 
that is similar to the one used to save 
documents and allows you to select a 
document from the current folder on 
the right-hand side of the dialog box. 
You can also type the name of the file 
you want to open in the File Name 
field, and any files that are a match to 
the partial string you have typed will 
appear in a box as options to select. 
Similar to the Save As functionality, 
Word 2013 will provide you with a list 
of commonly used folders where you 
can open your work as well as a list of 
recent files in the rightmost column; 
if you do not see the folder or file you 
wish to open, you can always click the 
Browse icon in the right column of 
the interface to select any location on 
your machine.

•	Print—This command allows you to 
send the current file to an installed 
printer. Printing requires additional 
hardware and a driver installation 
for that hardware to work. In Office 
2013, you are given a software-based 
print option of Send to OneNote 
2013 as a possible printer regard-
less of what other printers you have 
installed. If you have installed Adobe 
Acrobat® Professional, you will 
also get the software-based option 
of printing to a Portable Document 
Format (.pdf) file. Both of these print-
ing options are discussed further in 
Appendix A.

•	Exit or Close—Selecting this com-
mand will close the program. On a 
Macintosh, closing the windows of 
the program will not exit the program 
entirely; you must select the File 
menu and choose Exit to fully close 
the program. On Windows, selecting 

In Word 2011, it is located beside the Apple 

menu at the top of the computer screen.

There are several essential commands 

found within the File menu with which you 

should become familiar:

•	New—The New command is used to 
create a new file of the type associ-
ated with the program. In the case of 
Word, this file is a word processing 
document. The New command may 
present you with several alternatives 
if the program supports different 
document types or document creation 
options.

•	Save As—This command opens a 
dialog box to allow you to select the 
name, file type, and location to which 
you would like your file stored; this 
operates on the file that is currently 
active in the program. If you have 
already saved your document and 
want to save a copy or save it with a 
different name, you can do so with 
this option. For Word, the default file 
type is Word Document (.docx), but 
there are several alternative file types 
available when saving a document 
including Portable Document Format 
(.pdf). It is important to use Save As 
to save a new file you have created so 
your work will not be lost if there is 
a problem with the software system 
or you close it by accident. The Save 
As dialog box for Word is shown in 
Figure 7.3. Word 2013 will provide 
you with a list of commonly used fold-
ers where you can store your work; if 
you do not see the folder where you 
wish to store your file, you can always 
click the Browse icon in the right 
column of the interface to select any 
location on your machine.

•	Save—The Save command allows 
you to save the file that you currently 
have open within the software appli-
cation; this is useful for making sure 
your recent changes are retained in 
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application closes when you close these files, 

as in the case of the Windows version which 

closes when there are no open documents, 

you should start it again from the operat-

ing system. By the end of this activity, you 

should have both MyNewDocument and 

Activity7_1 open again.

Document Management
Whenever you are working on a project, 

it is important to manage the files associated 

with that project. You have already learned 

about using folders in previous chapters. 

Throughout the rest of this text, you will be 

creating projects in every chapter. You should 

be sure to keep your work organized—not 

just for the purposes of learning but also for 

the general management of productivity. 

If you already have a designated folder for 

your projects, you should create a new folder 

within it and title the folder Documents. You 

can similarly create other folders for the rest 

of the productivity software packages and 

7.1.2

Close will terminate the program 
unless there are other instances of 
it open for other documents. In this 
case, all document windows must be 
closed to fully exit the program.

Activity 7.1—Saving 
and Opening Files

You should practice saving and opening 

documents to see how the word processing 

software interacts with the file system of the 

operating system. If you have not done so, 

you should create a folder called Activities 

somewhere on your computer (this should be 

located somewhere in your document librar-

ies or inside your My Documents folder 

where you can locate it easily). You should 

already have your initial file (that opened 

by default when you started the program) 

which you should save as MyNewDocument. 

Create a new document and save it (using 

the default file extension selected in the dia-

log box) as Activity7_1. Close these two files 

and then open them again. If your software 

 FIGURE 7.3
Save As dialog 
box in Word
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Save As dialog box in both Word 2013 
and Word 2011. The most common 
application for viewing PDF files is 
the Adobe Reader, which is available 
in a free version from www.adobe.
com (by typing “Adobe Reader” in the 
search box).

•	The XML Paper Specification (XPS) 
format is the Microsoft version of 
a PDF; this type of file requires a 
special viewer for the application 
type but it has the same fixed display 
property of the PDF document. The 
document extension for this type of 
file is .xps.

•	The Web Page format saves the docu-
ment in HyperText Markup Language 
(HTML) for use in Web browsers and 
storage on Web servers for remote 
access. HTML is an interpreted 
display, so it will look different in dif-
ferent Web browsers. Word does not 
create clean code for the Web, so you 
should not use it as a primary Web 
development tool. The file extension 
for this is .htm or .html.

•	Rich Text Format (RTF) was invented 
by Microsoft in 1987; it is a common 
format for word processing that can be 
used by multiple, cross-platform word 
processing applications for document 
exchange. This is a safe alternative file 
format if the destination of the file is 
not another Word product but it will 
disable the advanced display features 
and text modifications available in 
Word and retain only basic formatting 
such as bold and italic text. The file 
extension for RTF is .rtf.

•	Plain text will save the contents of 
the document without any format-
ting effects or modifiers. This type of 
document format can be read by basic 
text applications like Notepad and 
Notepad++ which do not allow for-
matting alterations for text content. 
The document extension for this type 
of file is .txt.

title them Presentations, Spreadsheets, and 

Databases. It is a good idea to create folders 

to manage your different responsibilities so 

you can find items when you need them; the 

same rules that apply to filing and sorting 

paper documents also apply to organizing 

electronic documents.

There are several options for saving your 

files from Word. The default file type for the 

Word application is Word Document which 

has a file extension of .docx. This is selected 

by default when you save the document. 

You can also use the compatibility format 

for Word documents so that the documents 

you create can be viewed in older versions of 

Word without issues; this document format 

is called Word 97-03 and has the document 

extension .doc. Using the .doc file format 

disables the new features of Word but pre-

serves backward compatibility with prior 

versions; the need for this is becoming less 

common since the 2007 and 2008 versions 

of Word also used the new .docx format and 

features. In addition to these options, you 

can also save your document from the Word 

application in other file formats:

•	A Portable Document Format (PDF) 
file (which uses a .pdf extension) is 
constructed from printing commands 
and it produces a static document 
that cannot be edited or reformatted 
without specialized software. Unlike 
the native Word file format, which 
can change depending on the software 
version and installed fonts, there is no 
variance in the display of a PDF file 
(a format that was invented by the 
Adobe company). This means it will 
display for the viewer exactly as you 
intend it to be seen. You can create a 
PDF file of your Word document by 
selecting PDF as the file type in the 
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performing common tasks and trouble-

shooting. On a Windows machine, pressing 

the F1 key will activate the Help interface 

for whatever program you currently have 

selected (if you are using the operating sys-

tem when you press F1, you will open the 

help interface for the operating system). On 

a Macintosh, the Help interface is available 

by selecting the Help menu at the top of the 

screen; this will be context-sensitive for the 

program you have active. The Word Help 

interface is shown in Figure 7.4. Most help 

files, including those in Office, allow you to 

search for entries using a keyword search.

Productivity Shortcuts
Productivity shortcuts are keyboard 

commands that can be entered quickly to 

save you the time of having to open a menu 

or ribbon to find the command you wish 

to use. These exist for the most common 

actions you perform in a software system 

and are common to most software programs 

that utilize individual documents or files to 

store and organize information. 

7.1.4

•	OpenDocument Format is an open 
standard for word processing that 
is compatible with the Apache 
OpenOffice application suite. Not all 
of the features available in Word have 
an equivalent in this format, so the 
document may not display accurately 
in this file format. You can find more 
information on the use of Apache 
OpenOffice as an alternate word 
processing software solution in the 
appendices of this book.

Activity 7.2—File Types
Now that you have an understanding 

of the different types of file formats that are 

available for saving a document from Word, 

you should create a new document and save 

it using the default file format as Activity7_2. 

You should add a line of text to the document 

such as “This is my new application docu-

ment.” Now, save the document in the folder 

for this chapter with each of the following 

file formats: PDF, XPS, RTF, Web Page, and 

Plain Text. Depending on the type of file for-

mat you select, you may need to re-open the 

original document to save it in a new format. 

What are the application icons for each of 

these formats that appear as 

the default program to open 

them (such as the system’s 

default Web browser for the 

Web page version of the file)?

Help Files
Help files are almost 

always included in a soft-

ware system. These files 

allow you to get definitions 

of elements in the software 

system and obtain help in 

7.1.3

Microsoft Word  
2013

Microsoft Word  
2011

 FIGURE 7.4
Word Help 
interface in Word
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•	Redo Last Action (Ctrl-Y or 
Command-Y)—This will reverse 
the effects of the Undo command; 
not all actions that are undone can 
be reversed by the Redo command. 
Again, there are some programs that 
will maintain a buffer of commands 
and changes, allowing you to redo 
multiple actions that were reversed by 
the Undo command.

•	Select All Content (Ctrl-A or 
Command-A)—This command will 
select all of the content in the cur-
rent document or document element 
(like a table cell) that is allowed to be 
selected. This is a useful command 
if you want to perform actions like 
applying formatting to everything in 
your document.

•	Quit (Ctrl-Q or Command-Q)—This 
command will attempt to exit the cur-
rently active program.

There are additional shortcuts that are 

used often to utilize the system clipboard for 

transferring information quickly and easily 

from one document or location to another. 

These are valuable to learn and will save you 

a considerable amount of time when you are 

typing. There are also shortcuts to common 

formatting changes that will be discussed 

later in this chapter as you start your first 

project in word processing. Additionally, 

specific programs may have a unique set of 

shortcut commands in addition to or instead 

of the ones covered here.

The System Clipboard
The system clipboard is temporary 

storage for anything you copy from a docu-

ment or folder that allows you to use it 

again elsewhere. When you copy an object 

or a grouping of text to the clipboard, all 

of its formatting and content are retained. 

7.1.5

You activate a shortcut command by 

holding down the Ctrl key on a Windows 

machine and typing the letter correspond-

ing to the shortcut while the Ctrl key is held 

down. These shortcuts work on a Macintosh 

machine as well, except the Command key is 

used to activate the shortcut instead of the 

Ctrl key. The most common shortcuts with 

which you should be familiar are as follows:

•	New Document (Ctrl-N on Windows 
machines or Command-N on 
Macintosh machines)—This command 
opens a new blank document in the 
active program.

•	Open Document (Ctrl-O or 
Command-O)—This is used to open 
an existing file. It will open a dialog 
box that allows you to choose the file 
you wish to open.

•	Save Document (Ctrl-S or 
Command-S)—This is the same as 
selecting the Save command; it will 
save any progress in an open docu-
ment that has already been saved. If 
the document has not yet been saved, 
it will act like the Save As command.

•	Print Document (Ctrl-P or 
Command-P)—This command 
initiates the printing process. If the 
software allows you to set options 
before you print, it will open a dialog 
box; otherwise, it will attempt to use 
the default printer to initiate a print 
command.

•	Undo Last Action (Ctrl-Z or 
Command-Z)—This will attempt to 
undo the last action you performed 
in the open document; not all actions 
can be undone with this command. 
Some programs maintain a buffer of 
actions, allowing you to undo mul-
tiple changes that you made to the 
document.
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documents in other documents). The 
shortcut for Paste is Ctrl-V on Windows 
and Command-V on Macintosh.

In Word, you are given a choice of 

options when you paste something from 

the clipboard. This appears as a clipboard 

icon, which opens to a menu when you 

place an object from the clipboard, as shown 

in Figure 7.5. Typically, these options are 

whether you want to keep the formatting 

from the source, whether you want to match 

the formatting to that of the document 

where you are placing the text (called Merge 

Formatting in Word 2013), or whether you 

want to retain the text without the format-

ting. These options vary from program to 

program. Try this functionality yourself 

by typing a simple sentence in your open 

document, selecting it, cutting it from the 

document, and pasting it back into the doc-

ument. If you open the clipboard icon, you 

will see the available paste options.

The copied material can then be pasted in 

another location in any of the productivity 

software programs. For instance, you can 

copy formatted text from Word and paste it 

into PowerPoint and it will retain any for-

matting that was applied to it. Similarly, you 

can copy a chart from Excel and paste it into 

a Word document. This interoperability and 

the ease of use of the clipboard make it a 

valuable tool for productivity.

The three commands that apply to the 

clipboard are:

•	Copy—The Copy command is used to 
make a duplicate of selected text or 
objects in a document. Copy will leave 
the original source of the material 
intact in the document and make a 
duplicate on the clipboard. The Copy 
icon looks like two sheets of paper 
overlapping each other. The shortcut 
for the Copy command is Ctrl-C on a 
Windows machine and Command-C 
on a Macintosh machine.

•	Cut—The Cut command functions like 
Copy except it removes the original 
source material from the document 
(whether it is text or an object) and 
places it on the clipboard. The Cut 
icon is traditionally a pair of scissors; 
the shortcut for the Cut command 
is Ctrl-X on a Windows machine and 
Command-X on a Macintosh machine.

•	Paste—The Paste command is used 
to place the contents of the clipboard 
at the active cursor location within a 
selected document. Whether 
the contents are then removed 
from the clipboard depends on 
the specific program; in Word, 
they are not removed and can 
be pasted multiple times. The 
Paste icon looks like either a 
clipboard or a bottle of rubber 
cement (which was tradition-
ally used to place clippings of 

If you copy formatted text from one document and paste 
it into a document location that does not allow format-
ting, such as Notepad on a Windows machine, the text 
will be pasted and the formatting will be removed. The 
spacing of the letters (such as blank space characters 
created using the spacebar or tab indents from the Tab 
key) will be retained to match the way the keys and 
spacing are defined in the target document. This can 
actually be helpful for removing unwanted formatting 
from Web documents or PDF files.

 FIGURE 7.5
Paste Options 
menu in Word

Microsoft Word 2013 Microsoft Word 2011
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ANATOMY OF 
MICROSOFT WORD

Word is one of the more popular software 

applications for word processing. Whenever 

you open Word from either a desktop icon 

or the Start menu of a Windows machine, 

it will open with a new blank document 

(which defaults to the name Document1). 

You can save this document with a name of 

your choosing using the Save As command 

in the File menu (the File menu is shown in 

Figure 7.2). 

When you select the Save As command, 

it will open a Save As dialog box, as shown in 

Figure 7.3. This allows you to select the loca-

tion where you want to store your file. You 

can select the folder you want to use from 

the left-hand Navigation pane. The contents 

of the active folder are shown at the right 

side of the Navigation pane. You can select 

the New Folder icon to create a new folder 

to use inside the current folder. Finally, you 

can type a name for your file and select 

the file type you want for your document. 

The default file type for Microsoft Word is 

Word Document (.docx). Save your docu-

ment in a Projects folder with the filename 

MyCoverLetter.

7.3INTRODUCTION TO 
WORD PROCESSING 
SOFTWARE

Word processing is the most common 

task in any modern business environment. 

Word processing software is the digital 

equivalent of letter writing. Word proces-

sors have their origin in typesetting and the 

manual typewriter, which used an ink rib-

bon and a striking wheel to pound individ-

ual letters from the wheel onto the ribbon, 

imprinting the letter on the paper. If any 

mistakes were made, you had to either use a 

strikethrough character to alert the reader 

or use correction fluid to cover up the error. 

Early electronic word processors 

allowed a user to enter a line of text and, 

when the user hit the return carriage key 

(the equivalent of the Enter key), would 

mechanically type the letters one by one 

onto the paper using the striking wheel; this 

allowed the user to avoid most typos with a 

quick read-through of the line before hitting 

the return carriage. Now word processing 

is almost universally done on a computer, 

allowing an enormous level of convenience 

and collaboration for creating and utilizing 

documents.

7.2

WORD PROCESSING in modern terms is the 
use of a computer system to create, manipulate, 
and share text. The traditional means of word 
processing is through the use of the keyboard and 
mouse, though modern speech recognition pro-
grams allow you to create text from audio input.

Whenever you are working on a document, you 
should save it often. Your software could quit 
because of a machine error or a glitch and any 
unsaved progress on your work could be lost. 
You could also accidentally delete a portion of 
your work or make a change that the Undo 
command cannot correct; if you have saved 
your document before these changes, you can 
close the current document and open the saved 
version to get back to where you were. 
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through all of the contents of the active 

folder. Word 2013 for Windows and Word 

2011 for Macintosh allow you to perform the 

same functions to create a document; how-

ever, the interface for these two applications 

is different. You can jump to the section of 

the text that applies to the version you have. 

Microsoft Word 2013
Figure 7.7 shows an example of the 

standard interface for Word 2013. Across the 

top of the window for each open document 

is the Quick Access toolbar, which contains 

shortcuts to commonly used commands. By 

default, Save, Undo, and Redo are included 

as direct links. The arrow beside the Undo 

command contains a buffer list of prior 

actions that can be undone; all of the actions 

after the one selected will be undone if this 

list is used. The Microsoft Word icon in the 

far-left corner contains commands for mov-

ing and resizing the window. The far right of 

the interface contains icons to activate help, 

minimize the window (which removes the 

7.3.1

To open an existing document in Word, 

select the File menu and then choose 

Open. This will display an Open dialog 

box, as shown in Figure 7.6. The left-side 

Navigation pane is similar to the Save As 

dialog box where you can navigate to the 

folder you want to open. The right side of 

the dialog box lists the contents of the cur-

rent folder. You can select any of the files 

with file types that can be opened in Word; 

the name of the file will display in the File 

Name field and you can click the Open but-

ton (or simply double-click the name of the 

file). 

You can also start typing the name of 

the file you want to open in the File Name 

field of the Open dialog box. A drop-down 

menu will appear from the File Name field, 

displaying all of the filenames within the 

active folder that match the partial string 

of characters you have typed. You can then 

select an item from the list instead of typ-

ing the entire filename or manually sorting 

 FIGURE 7.6
Open dialog box in 
Word 2013
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contains common formatting commands for 

your document. You can also manage styles 

from this ribbon, which you will learn about 

in the next chapter. The other commands 

here to note 

are the Find, 

Replace, Copy, 

Cut, and Paste 

icons. You will 

use these extensively in creating documents.

The Insert ribbon, shown in Figure 7.9, 

is used to add special content to your doc-

ument; this 

includes tables, 

images, draw-

ing objects, and 

clip art. There 

are special document elements available in 

this ribbon as well, particularly the Header, 

document from the screen while keeping it 

open), maximize the window (to take up the 

full available space of the computer screen), 

or close the document and the window.

The ribbon interface for Word 2013 is 

beneath the toolbar. The File menu can be 

found to the left of the ribbons that are avail-

able. The Home ribbon is the first ribbon you 

will see. This ribbon, shown in Figure 7.8, 

 FIGURE 7.7
Anatomy of Word 
2013

 FIGURE 7.8
Home ribbon in 
Word 2013

 FIGURE 7.9
Insert ribbon in 
Word 2013
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for letters to multiple recipients. This is one 

of the more advanced features of Microsoft 

Word. 

The next ribbon of interest is the Review 

ribbon, shown in Figure 7.11. This ribbon 

contains the icon for Spelling & Grammar, 

which should be used to review any docu-

ment prior to submitting it; clicking this icon 

will start parsing your document for known 

spelling and grammar errors and prompt 

you to correct them. Additional research 

tools like the Thesaurus and Word Count 

are also located here, as well as the ability to 

turn on Track Changes and add and remove 

comments, which are useful when working 

on a collaborative document.

The View ribbon is the last standard 

ribbon and is shown in Figure 7.12. You can 

change the view of the document in this rib-

bon. Unlike some of the other programs in 

the Office suite, there is not usually a reason 

to deviate from the Print Layout for most 

documents; this view shows the text broken 

up into pages where the editable regions 

are bright white and anything not on the 

printed page is shown as a gray background. 

Read Mode shows the document with the 

maximum amount of screen space devoted 

to the content. Arrows at each side allow you 

to move from one screen to another, either 

forward or backward in the document. Web 

Footer, Cover Page, Blank Page, and Page 

Break (which immediately pushes subse-

quent content to the next page regardless 

of whether there is room left on the current 

page). Other formatting options include 

Drop Cap, Symbols, and Hyperlinks. You 

can add a hyperlink to an external document 

or Web page, or link to a section within the 

current document (defined as a bookmark).

The Design ribbon is a new addition to 

Word 2013. It contains options for setting 

the overall look and feel of your document. 

From here, you can set a style for all of your 

document graphics or add a background 

watermark image to your pages, in case 

you need to mark them as Confidential. You 

can also set the page border here for quick 

graphic effects for flyers. You can see the 

Design ribbon in Figure 7.10.

The Page Layout ribbon is the next one 

in line. This ribbon allows you to control the 

size of the document, document orientation 

for printing, indents, spacing, and align-

ment. This ribbon is discussed in Chapter 

8, “Developing and Editing Documents.” 

The References ribbon is used for docu-

ments that require citations, endnotes, and 

footnotes; this ribbon is also covered in the 

next chapter. The Mailings ribbon is used to 

construct documents such as envelopes and 

labels and individualize mailing documents 

 FIGURE 7.10
Design ribbon in 
Word 2013

 FIGURE 7.11
Review ribbon in 
Word 2013
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The bottom of the standard interface 

contains page information, word count, a 

proofing error indicator, and View and Zoom 

settings. You can see the current page in 

which you are working and the total number 

of pages in the document. The word count 

defaults to the total number of words in the 

document; if you have some text selected, 

the words in that selection are displayed as 

a fraction of the total word count. The View 

settings are shortcuts to the different views 

available. To change the zoom percentage, 

you can use the slider or the + and – but-

tons. The zoom percentage is how much the 

document is magnified from standard print/

screen size. A zoom of 100% is the actual 

size of the document.

Microsoft Word 2011
The main difference you may notice 

between Word 2013 and Word 2011 is the 

inclusion of the menu bar in Word 2011. The 

menu bar is standard with any Macintosh 

software application, and it contains a lot of 

the functionality of the ribbon interface plus 

some convenient shortcuts that are not eas-

ily accessible from the ribbon. The menu bar 

is located beside the Apple menu at the top 

of the computer screen; the menu choices 

begin with the Word menu and include the 

File menu and Help menu. In the document 

window itself (shown in Figure 7.13) are 

the icons to close the document, minimize 

it, or maximize it on the screen. Beneath 

those are the Quick Access toolbar icons. 

7.3.2

Layout shows the contents of the page as 

they would look if the page were converted 

to an HTML document. Outline view shows 

the levels of the document and is similar to 

an outline of content; you can promote or 

demote content using this view and select 

how many levels of headings you want to 

see. Draft view works like Print Layout view 

but without showing the text as it would 

appear on the printed page. One item to 

note here is the Navigation Pane checkbox; 

this will show or hide the Navigation pane, 

which provides you with an outline or pre-

view of your document in a separate, mobile 

pop-up window. Make sure this checkbox is 

selected.

The Navigation pane has three tabs. 

The first tab (which looks like a small doc-

ument with outline format) is a display of 

the document outline by heading; you can 

adjust the number of levels of the document 

outline to display by right-clicking on a 

heading and choosing Show Heading Levels 

and the level you want to show. The Pages 

tab displays a thumbnail view of the pages 

of your document so you can jump quickly to 

a page by clicking its thumbnail. Finally, the 

Results tab shows the results of a keyword 

search of the document using any keywords 

entered in the text box above the tabs.

 FIGURE 7.12
View ribbon in 
Word 2013

In Word 2013, you can click the page count at the 
lower-left corner of the interface to show or hide the 
Navigation pane.
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and press Enter or click on the magnifying 

glass icon to perform the search. The ribbon 

interface is beneath this toolbar. 

The Home ribbon for Word 2011, shown 

in Figure 7.14, contains the tools you will need 

to format your text. This includes the Font 

and Paragraph panels for altering various 

settings that affect how your text will display. 

You also have access to the available styles 

in this ribbon, which are covered in the next 

chapter. In Word 2011, you can also insert pic-

tures and shapes from the Home ribbon.

By default, there are more of these icons 

in Word 2011 than there are in Word 2013; 

these include shortcuts to the standard File 

menu commands (such as New, Open, Save, 

and Print), along with Cut, Copy, Paste, 

Undo, Redo, and Format Painter.

The Quick Access toolbar also contains 

an icon to open the Help interface; this 

appears as a circle with a question mark 

inside of it. Beside the Quick Access toolbar 

is a text box for searching the document; 

you simply type a keyword into the box 

Menu bar

Document pane

Document 
filename

Visible 
document area 

(Print view)

Quick Access 
toolbar

View selection

Help

Spelling and 
grammar check

Show or hide 
ribbons

Zoom setting

Ribbon 
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Document Map/
Outline pane

Settings

 FIGURE 7.13
Anatomy of Word 
2011

 FIGURE 7.14
Home ribbon in 
Word 2011
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to click on them to see what they contain, 

but they are not used in this chapter. The 

Review ribbon is used primarily for editing 

collaborative documents for which you want 

to track changes and for sharing documents 

with others. Some of the features in this rib-

bon are discussed later in this chapter.

The Document Map pane lets you see 

an outline of your document, similar to the 

Navigation pane in Word 2013. To do this, 

select the View menu, choose Sidebar, and 

then choose Document Pane. The four tabs 

across the top of the Document pane cor-

respond to Thumbnails, Document Map, 

Reviewing, and Find and Replace. The 

Thumbnail pane shows a miniature ver-

sion of the pages of your document as they 

appear when printed. The Document Map 

pane shows the outline of the document 

arranged according to the document head-

ers. The Reviewing pane identifies com-

ments and tracked document changes. The 

Find and Replace pane will locate instances 

of the text you enter in the Find text box 

and allow you to select options for replacing 

that text with what you enter in the Replace 

text box. The Document pane is useful for 

jumping quickly through your document 

and seeing an outline of the text you are 

constructing.

The bottom of the interface includes 

shortcuts for changing the view of the 

The Layout ribbon, shown in Figure 7.15, 

contains all of the tools for setting up the 

pages of your document. These include set-

ting whether you want your document lay-

out to be Portrait (the standard printed page 

with the longer side having the vertical mea-

surement) or Landscape (where the shorter 

side is the vertical measurement). You can 

also set your margins from this ribbon. The 

margin is the amount of white space between 

the edge of the printed page and the begin-

ning of your content; these typically default 

to 1” on each side. This ribbon allows you to 

add page breaks, set the number of columns 

in your document, and use advanced func-

tionality, such as adding a watermark to the 

document or changing the background color 

of the page.

The Document Elements ribbon, shown 

in Figure 7.16, allows you to add common 

items to your page. These include a cover 

page, a blank page, and various types of page 

breaks. You can add a Table of Contents, 

Header, and Footer to your document from 

this ribbon using the predefined formats. 

This ribbon also includes tools for using ref-

erences and citations; this is covered in the 

next chapter.

The Tables, Charts, and SmartArt rib-

bons are used to add advanced features to 

your document. These ribbons are covered in 

later sections of this book. You are welcome 

 FIGURE 7.15
Layout ribbon in 
Word 2011

 FIGURE 7.16
Document 
Elements ribbon in 
Word 2011
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page number you are cur-

rently on out of the total 

page count. You will also 

see your current word 

count; if some text is 

selected, you will see the 

word count of the selected 

text out of the total word 

count. There is also an 

indicator for spelling and 

grammar errors; a green 

check mark means there 

are currently no mistakes 

in the document and a 

red X indicates that there 

are errors according to 

the spelling and gram-

mar rules of Word 2011. 

Finally, at the far right of the bottom inter-

face is the current zoom percentage (this is 

a percentage of actual document size, which 

is 100%); you can adjust the slider setting to 

change the zoom.

Microsoft Word Web App
As part of the Windows Live account, 

the OneDrive cloud storage system allows 

for users to create new Word, Excel, and 

PowerPoint documents which can be stored 

and shared online or downloaded to a local 

computer. The app versions of these Office 

programs are not as robust as the standalone 

versions you install on your computer, but 

they do allow you to perform basic tasks from 

any computer connected to the Internet. 

From the homepage of the OneDrive (as cov-

ered in Chapter 5, “Microsoft OneDrive and 

Cloud Computing”) select Create and then 

7.3.3

document. The views included here are 

Draft, Outline, Publishing, Print, Notebook, 

and Full Screen. Draft view shows your doc-

ument without the page formatting. Outline 

view shows the contents of your document 

arranged as an outline where you can see 

higher level headings for text farther to the 

left. Full Screen view is a special mode that 

shows your document on the full screen 

without any desktop interface, as shown in 

Figure 7.17; when you are in this view, you 

have access to just a subset of the normal 

formatting commands. Select Exit to return 

to the standard Print view. Publishing view 

and Notebook view are special formats for 

text documents that require your docu-

ment to be created or converted to the for-

mat for use; Notebook Layout view is similar 

to Office OneNote 2013 and is covered in 

Appendix A. 

In addition to the view selection, the 

bottom of the interface has several other 

convenient data points. You will see the 

 FIGURE 7.17
Full Screen view in 
Word 2011

MSOffice-Beyond-CH07.indd   147 6/12/2014   5:12:12 PM



148 — Microso f t  Of f i ce  2013/365 and  Be yond

Figure 7.20, only allows you to add tables, 

hyperlinks (connections to other docu-

ments or resources), images, and Microsoft 

ClipArt. The Page Layout ribbon allows 

you to set margins, page orientation, docu-

ment size, indentation, and paragraph spac-

ing. The View ribbon allows you to select 

between Editing View, which shows the full 

interface and serves as the default setting, 

and Reading View, which hides the interface 

and allows you to view just the document 

content. The Review ribbon allows you to 

check spelling in the document and add and 

edit comments.

There are two additional options in the 

ribbon interface: Open in Word and Share. 

Open in Word allows you to open the docu-

ment using your local copy of Microsoft 

Word. This will only work if you have Word 

installed on your machine 

or if you are download-

ing a temporary copy as 

choose Word Document. You will be taken to 

your new file, where you can name your doc-

ument by clicking on the text “Document 1” 

as shown in Figure 7.18 or by using the Save 

As function in the File menu. For this exam-

ple, you can use the name MyCoverLetter.

The interface of the Word Web app 

should be familiar if you have seen Word 

2013. You can see this interface in Figure 

7.19. There are fewer ribbons on this inter-

face and fewer options available. The Home 

ribbon (also shown in Figure 7.19) allows 

access to the system clipboard, provides the 

standard options for font and paragraph 

adjustments, manages the document styles, 

and contains the functionality for checking 

the document spelling. You may also notice 

that the bottom of the interface contains 

only an estimate of the total word count.

The remaining ribbons are also lim-

ited in functionality from the other ver-

sions of Word. The Insert ribbon, shown in 

 FIGURE 7.18
Creating a new 
Word file from the 
OneDrive

 FIGURE 7.19
The Word Web app 
interface

 FIGURE 7.20
Ribbons in the Word 
Web app interface
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used to create these documents. You will be 

creating two documents for this project, one 

from a blank document and one from a tem-

plate. You can use the blank document you 

already created to start your cover letter. Be 

sure to clear out any contents of the docu-

ment you may have entered while exploring 

the program by using the shortcut to select 

all (Ctrl-A or Command-A depending on the 

operating system) and pressing the Delete 

key. Save the file as MyCoverLetter.

Writing a Cover Letter
A cover letter is a type of formal busi-

ness letter that typically accompanies a 

resume in response to a job posting. While 

the resume is a bullet-point account of edu-

cation, experience, and skills, the cover let-

ter is a paragraph account of the significant 

points on the resume that apply to the spe-

cific job for which you are applying. One way 

to look at a cover letter is to think of it as a 

tour guide of the resume for a particular job. 

7.4.1

part of the Office 365 subscription service. 

The Share option, as shown in Figure 7.21, 

allows you to email the document to other 

recipients, post it to social media outlets like 

Facebook and Twitter, or get a link which 

you can send to others that will allow them 

to access the document on your OneDrive. 

You can choose whether the recipients are 

allowed to edit the document or not.

DIVING INTO WORD 
PROCESSING

A resume and a cover letter are two doc-

uments that everyone needs to prepare when 

applying for jobs in the professional world. 

These documents are designed to showcase 

your abilities and experience. Because these 

two documents are almost universally nec-

essary, they are used as a first step into the 

world of word processing. Even if you are 

not currently looking for a job, it is always 

beneficial to remain proficient in the skills 

7.4

 FIGURE 7.21
Sharing a Word 
document in 
OneDrive
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why you are 

seeking the job 

(this is espe-

cially important 

if you currently 

have a job).

The sec-

ond paragraph 

should high-

light your quali-

fications. You 

should have 

three to four 

relevant accom-

plishments or 

demonstrable 

skills (with 

A cover letter should be short and tailored 

to the specific job, highlighting the relevant 

skills and experience that make you a suit-

able candidate for that position. 

To get started, research a job on Monster 

(www.monster.com) that you would like to 

have; this will be the job for which you cus-

tomize your resume and cover letter for the 

project in this chapter. Because this is a for-

mal business letter, there is a specific format 

that should be followed. These formatting 

instructions and the required number of 

blank lines between each section are shown 

in Figure 7.22. You should include all of the 

information on this outline that you can and 

prepare to write the text of your letter.

A cover letter should consist of three 

paragraphs of text with a total word count 

of 150 to 250 words. The first paragraph 

should describe how you found the job post-

ing, why you are qualified for the job, and 

some sort of supporting documentation 

or recommendation to back up the claim) 

that you want to highlight in the second 

paragraph of the letter. The final section of 

the letter should indicate follow-up actions 

like when you will contact the potential 

employer for any next steps on your end.

The company Palladian International, 

LLC, conducted a study called “Cover Letter 

Best Practices” that outlined how managers 

actually use cover letters in the hiring pro-

cess. The following are their recommenda-

tions for creating a more successful cover 

letter:

 FIGURE 7.22
Example 
formatting for a 
cover letter

You can see the word count of your document 
in the lower-left corner of the interface beside 
the page number in Word 2013; it is located 
more to the center of the bottom of the inter-
face in Word 2011. This is indicated by the 
word Words: next to the value.
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remainder of the project will concentrate on 

formatting, reviewing, and managing the 

document.

Formatting Text
Text entry can be done in simpler pro-

grams like Notepad, as the real benefit 

of word processing software is the ability 

to format and change the appearance of 

text. The ability to design the appearance 

of your text, add additional media to your 

documents, and share your documents in 

multiple formats is where word processing 

stands out against simple text editors. Word 

has all of these features available to turn the 

plain text you added to your document into 

a professional-looking cover letter.

7.4.2

•	Personalize the cover letter to the 
specific position.

•	Give a reason why you should be 
hired.

•	Identify why you are seeking the 
position.

•	Keep your letter brief.

•	Make it easy for the viewer to see the 
relevant points.

Several other important steps to take 

are to proofread your document before you 

submit it and to make sure your document 

is in the correct format the organization 

wants for submission. You should also avoid 

cliché opening lines in your letter; these may 

get you disregarded entirely so it is better to 

open with accomplishments relevant to the 

available position. A completed example of 

a cover letter is shown in Figure 

7.23. This is the model you should 

follow in constructing your letter 

(though you will need to add your 

own text that is specific for the 

position you selected).

After you have entered your 

text (as plain text entry), you 

will need to format your letter. 

You should have your return 

address, the recipient address, 

greeting, first paragraph, bullet-

point accomplishments, third 

paragraph, salutation, and name 

entered in plain text (format-

ted from the default text entry 

settings of the program) at this 

point. Because the text of your 

document will vary greatly 

from position to position, the 

 FIGURE 7.23
Cover letter 
example
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with the text immediately before it in the 

document.

You can change the size of your text 

(called the font size) in a number of ways: by 

selecting a preset value from the drop-down 

Font Size field, typing a number manually 

in the Font Size field, or using the Grow 

Font and Shrink Font icons to increment 

or decrement the size of the font. Select all 

of your text and change the font size to 12. 

Font sizes are set in point values; a point is 

the smallest unit of measure in typography. 

There are 72 points per inch. An intermedi-

ate value called a pica is the equivalent of 

12 points (so there are 6 picas per inch).

You should not add text effects to a cover 

letter. Readability and clarity are essen-

tial for this type of document. However, 

you should take note of the styles that 

you can apply 

to your text in 

the Font panel. 

Bold, Italic, and 

Underline are 

all means of 

adding empha-

sis to your text. 

Bold will make 

the text thicker 

The Font Panel

The Font panel is common to most of 

the Office programs. This panel, located on 

the Home ribbon, contains the formatting 

commands for changing the font, size, style, 

and color of your text. The default font for a 

new document is Calibri (Body) on Windows 

and Cambria (Body) on the Macintosh. 

Select all of the text in your letter by using 

the Select All shortcut (Ctrl-A on Windows 

and Command-A on the Macintosh) and 

select Times New Roman. 

The Font panel is shown in Figure 7.24. 

Remember that changes to the Font panel 

settings apply only to text that is selected 

when the changes are made. If no text is 

selected, the settings will be changed for 

text that is added at the current cursor loca-

tion until another section of formatted text 

is encountered. By default, the format of 

new text that you enter will be consistent 

7.4.2.1

A FONT is a complete set of keyboard characters 
in one particular style (the style is the name of 
the font). Most fonts support standard sizes as 
well as bold and italic variants.

 FIGURE 7.24
Word Font panel in 
the Home ribbon Font Name

Text Effects

Font Size

Highlight
Common formatting 

commands Font Color

There are several keyboard shortcuts for the 
common formatting enhancements. To bold 
text, use Ctrl-B (or Command-B on the Mac); 
to italicize text, use Ctrl-I (or Command-I); and 
to underline text, use Ctrl-U (or Command-U). 
These act as a toggle, so repeating the com-
mand will turn off the effect.
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allows you to configure the font, size, effects, 

and enhancements for your text in a single 

interface. Of particular note is the ability to 

change the underline style of your text from 

the default thin solid line to a preset number 

of selections included a dotted line, broken 

line, wavy line, and double line.

Activity 7.3—
Clipboard Options

For this activity, you will explore the 

different options for preserving formatting 

in text. You should create a new document 

and save it using the default file format as 

Activity7_3. You should add a line of text to 

the document such as “This is my new for-

matting document.” Use formatting com-

mands to alter the line of text, including 

the font, size, and style. Copy the text of the 

line and begin pasting it below the original 

line, separating each line with a blank line 

and darker, Italic will slant the text, and 

Underline will add a line under the text. 

Strikethrough retains the text but crosses it 

out; this is used to show completed tasks in 

a list of tasks. The strikethrough used to be 

an indicator of an error correction in type-

written documents, but there is no need for 

this use in modern word processing software 

except in tracking changes for collaboration.

You can use the Text Highlight Color 

option to highlight your text; this is simi-

lar to using a highlighter marker on paper. 

The text will remain visible, but it will be 

emphasized so it can be quickly found later. 

The color of the highlighter can be changed, 

allowing you to color-code text. To get rid of 

an existing highlight, select the highlighted 

text, click the drop-down arrow under the 

Text Highlight Color icon, and choose No 

Color.

To change the color of the text itself, 

you use the Font Color icon. Clicking on the 

drop-down arrow opens a menu from which 

you can select any of the colors of the cur-

rent theme setting and standard colors. You 

can also utilize custom colors or a gradient 

by selecting these options from the menu. 

Finally, using the Clear Formatting icon 

(which looks like an eraser) will remove any 

changes you have made to the formatting of 

the selected text and reset it to the default 

font settings for the document.

In Word 2013, the expansion icon in the 

lower-right corner of the Font panel opens 

the Font dialog box. In Word 2011, you open 

the Font dialog box by selecting the Format 

menu and choosing Font. The Font dialog 

box is shown in Figure 7.25. This dialog box 

 FIGURE 7.25
Font dialog box in 
Word 2013
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1.15 lines of space per line in the menu); this 

spacing is based on the font size of the text, 

so double spacing (two lines of space per line 

of text) for a 12 pt font will be equal to 24 

pts of space, but for an 18 pt font will be 36 

pts of space. There are also a few options 

for paragraph spacing. The Paragraph dia-

log box offers a more detailed selection of 

options for line spacing.

In Word 2013, click the expansion icon 

in the lower-right corner of the Paragraph 

panel to open the Paragraph dialog box. In 

Word 2011, you activate the Paragraph dia-

log box by selecting the Format menu and 

choosing Paragraph. When you open the 

dialog box, it should default to the Indents 

and Spacing tab, which is where you change 

the settings for the line spacing.

In the Spacing area, select At Least 

under the Line Spacing entry, and in the At 

field, enter 16 pt. This will add some addi-

tional space to each line and make your text 

more readable without wasting too much 

space. The preset Single and Double val-

ues are also commonly used for formatting, 

using either one or two times the font size of 

the line as the vertical space between lines 

of text.

Format Painter

It is important to give any document 

you create a consistent look and feel. 

You will learn about managing styles in 

the coming chapters, but one way to pro-

vide consistency is to use format paint-

ing. This process takes the formatting 

modifications from the currently selected 

text and applies them to any text that is 

highlighted after you click the Format 

7.4.2.3

(from the enter key) and selecting the differ-

ent options that appear in the dropdown list. 

How does the formatting differ in each case?

The Paragraph Panel

The Paragraph panel is located beside 

the Font panel on the Home ribbon and is 

shown in Figure 7.26. This panel provides 

options for bullets and numbering, out-

line formatting, text indent (to increase or 

decrease indent), text alignment, and spac-

ing between lines. Text alignment will be a 

bigger concern when you start adding com-

plex visual elements to your word processing 

documents (and presentation documents). 

For now, though, use the Align Text Right 

icon to align the date and return address to 

the right margin of your cover letter (the 

margins should be set at the default let-

ter size for now, meaning your text will be 

1” from the right edge of the paper when 

printed). To do this, select the date and 

return address (your address) within the 

document and click Align Text Right. You 

will notice that the default setting is for text 

to be aligned to the left.

The Line Spacing icon allows you to 

select the number of lines of space given for 

each line of text (by default, this is set at 

7.4.2.2

Bullets

Common alignment 
commands

Numbering

Line Spacing

Indent

 FIGURE 7.26
Word Paragraph 
panel in the Home 
ribbon
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Though you are not 

using it for this proj-

ect, there are similar 

options available from 

the Numbering icon’s 

drop-down arrow menu 

(shown in Figure 7.28). 

The significant differ-

ence between number-

ing and bullets is the 

inclusion of ordering in 

a numbered list. The 

numbering options 

available include letters, 

numerals, and Roman 

numerals (a system 

that uses specific letters 

to represent numeric 

values such as I for 

one and V for five); you 

can choose from the predefined set or you 

can choose Define New Number Format to 

 create  custom styles. 

Document Review
One of the biggest mistakes you can 

make with a cover letter, resume, or any 

other professional document is not check-

ing the spelling and grammar of the work 

before you submit it. Word has some excel-

lent tools for checking spelling and gram-

mar, but there are errors that it will not 

catch; for instance, typing the word “an” 

when you mean to type “and” may not reg-

ister as a grammatical error and will not be 

flagged as a spelling error as it is a correctly 

spelled word. Because of this, it is a good 

idea to have someone else review your cover 

letter and resume before you submit them.

7.4.4

Painter icon. This icon, which looks like a 

paintbrush, is located in the Home ribbon in 

Word 2013 and in the Quick Access toolbar 

in Word 2011. 

Bullets and Numbering
It is time to add bullet points to the 

three or four key items that you highlighted 

in your cover letter. Select the lines of text 

for your primary points and then click the 

Bullets icon in the Paragraph panel of the 

Home ribbon. This will automatically con-

vert your items to an unordered list of ele-

ments. You can change the style of the bullet 

point by selecting from among the avail-

able options in the drop-down arrow menu 

for the Bullets icon, shown in Figure 7.27. 

You can also define a custom bullet style by 

selecting Define New Bullet. This will open 

a dialog box allowing you to select a symbol, 

image, or letter from a particular 

font (like Wingdings or Webdings) 

for your bullet point.

7.4.3

 FIGURE 7.27
Bullet Library in 
Word

 FIGURE 7.28
Numbering Library 
in Word
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Spelling & Grammar icon 

initiates an automated 

review of your document. In 

Word 2013, it is located in 

the Review ribbon. In Word 

2011, select the Tools menu 

and then choose Spelling 

and Grammar. You will be 

prompted with any correc-

tion issues that the software 

locates.

An example correction prompt is shown 

in Figure 7.30. Any suggested alternatives 

are listed beneath the text field identify-

ing the surrounding text in the document 

where the error was found. You can choose 

Ignore to retain what Word perceives as an 

error, Ignore All to ignore all equivalent per-

ceived errors, and, if it is a spelling issue, 

Add to force Word to accept the word as a 

correct spelling now and in the future. If you 

wish to follow the suggestions for changing 

the perceived error, you can select Change to 

correct the highlighted instance and Change 

All to change all instances of the same type 

in the document. Note the location of the 

prompt on the right side of the interface 

in Word 2013. This is a common location 

for dialog boxes of this type to occur in the 

Office 2013 suite. The X icon at the far right 

will close this dialog.

In addition to the manual tools for 

checking spelling and grammar, Word has 

several AutoCorrect features that will 

attempt to replace words as you type to cor-

rect common misspellings and to replace 

certain text entries with symbols. 

You can configure the AutoCorrect 

options if you want to add any additional 

rules or turn off any existing rules. To 

reach the AutoCorrect preferences in Word 

2013, select the File menu and then choose 

Options. This will open the Word Options 

dialog box. From here, click Proofing in the 

menu on the left and select the AutoCorrect 

Options button. In Word 2011, select the 

Tools menu and AutoCorrect. The existing 

rules are displayed in a list at the bottom of 

the dialog box; you can add a rule by typing 

the misspelled word in the Replace field fol-

lowed by the correct word in the With field 

and choosing Add. These dialog boxes are 

shown in Figure 7.29.

Spelling and Grammar

The spelling and grammar check will 

locate and alert you to any issues that it 

finds within your document. Clicking the 

7.4.4.1

 FIGURE 7.29
AutoCorrect 
options in Word 
2013

All of the Office programs have a spelling 
check option. It is always a good idea to use 
the Spelling or Spelling & Grammar option 
to review your work before you submit it or 
share it.
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audience from getting 

bored of the repetition; 

if this happens, the audi-

ence may start to skim 

your writing instead of 

reading every word of it.

You can access the 

Thesaurus in Word 2013 

by opening the Review 

ribbon and choosing 

Thesaurus. This will 

open the pane on the 

right of the interface 

where you can type 

the word you want to 

replace and then click 

the magnifying glass icon to conduct the 

search. You can activate this search on a 

highlighted term in your text by just select-

ing the Thesaurus icon in the Review rib-

bon. An example is shown in Figure 7.31.

In Word 2011, select the Tools menu and 

choose Thesaurus. This will open a Research 

pane to the right side of your document. 

Type the word for which you want synonyms 

Word is not perfect when it comes to 

document proofreading and corrections. It 

may highlight items that are actually cor-

rect (called a false positive) and it will miss 

items that are grammatically correct and 

spelled correctly even if the word usage is 

wrong (called a false negative). You should 

always use the automated tool for proofing 

your document in case you do have easy cor-

rections to make that you may not catch just 

by reading it, but you also need to make sure 

you (and possibly also a friend or colleague) 

review the document as well.

Thesaurus

A thesaurus is a tool for find-

ing words with a similar meaning 

(called synonyms) as a word you 

want to replace. This is a useful 

tool if you find you are using a 

word too much in your writing 

and want to vary it throughout. 

If you find that you have used the 

same term too often in your cover 

letter, you probably need to find 

an alternative word to keep your 

7.4.4.2

 FIGURE 7.30
Spelling and Grammar 
check example in 
Word 2013

 FIGURE 7.31
Thesaurus 
example in Word 
2013
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search box using the shortcut Command-F. 

This will highlight all instances of the key-

word (or words) in your document.

To replace the keyword with which you 

searched the document with another term, 

you use the Replace command. In Word 

2013, this is located on the Home ribbon; 

when activated, it will open a Find and 

Replace dialog box where you can navigate 

instance by instance through the docu-

ment (with the Find Next button) or simply 

replace every instance of the keyword with 

the text you enter in the Replace field. The 

Find and Replace dialog box is shown in 

Figure 7.32. In Word 2013, you can activate 

the Replace command using the shortcut 

Ctrl-H. To open this same dialog box in Word 

2011, select the Edit menu, select 

Find, and then choose Advanced 

Find and Replace.

in the Search for field and select the cor-

rect Thesaurus from the drop-down menu. 

Hitting the Enter key (or pressing the Start 

searching icon) will populate the text area 

beneath it with potential replacement terms. 

If you are unsure of the exact meaning 

of the word you are substituting into your 

document, it is always a good idea to look 

it up and make sure you are using it cor-

rectly. You can use online dictionaries like 

Dictionary.com (www.dictionary.com) to 

do this or you can use any built-in diction-

aries like the one accessible in Word 2011 

(by selecting the Tools menu and choosing 

Dictionary). In Word 2013, you can also 

search for the definition of a term using the 

Define icon on the Review ribbon. This will 

open a new dialog where you can select your 

dictionary and, once it is installed, you can 

search for the term you want to find.

Find and Replace

An additional tool that can help you 

with searching for repetitive terms or find-

ing a particular word in your document is 

the Find command. This allows you to per-

form a simple keyword search of your docu-

ment. In Word 2013, the Find icon is located 

on the Home ribbon; you can also access 

the Find command on a Windows machine 

using the shortcut Ctrl-F. 

In Word 2011, there is 

an existing search box in 

the top-right corner of 

the open document win-

dow that will allow you to 

enter text for a keyword 

search of your document; 

you can highlight this 

7.4.4.3

The keyword entry for the Find command in 
Word 2013 is located on the Navigation pane. 
If the Navigation pane is closed when you 
select the Find command (by icon or by using 
the shortcut, the Navigation pane will be 
 displayed on the Browse Results tab. This tab 
will show all instances of the keyword in the 
document, and you can jump to a particular 
location by clicking on a result.

 FIGURE 7.32
Find and Replace 
dialog box in Word 
2013
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using the predefined areas where you can 

add objects and text, knowing what it will 

look like when you are finished. It is pos-

sible to modify templates just like any 

other document (you can even create cus-

tom templates), but templates save you 

work in formatting the document yourself 

or formatting the same document again. 

Document templates are a great way to get 

started with formatting if you are unsure of 

what your document should look like.

In Word 2013, you can create a new 

 document from a template by selecting the 

File menu and choosing New. Beneath the 

blank document types that you can select are 

the template selections. In this case, you will 

select Resumes from the suggested search 

options and then choose one of the options 

from the window shown in Figure 7.34. 

You can use the search box to find almost 

any kind document template you need. 

Remember that an effective resume is clear 

and simple.

In Word 2011, 

you can also use the 

Search pane to per-

form the Find and 

Replace functional-

ity. To activate the 

Search pane, select 

the View menu, 

choose Sidebar, and 

then choose Search 

Pane. This will open 

the side navigation 

pane if it is not already open; you can then 

utilize the Find functionality by itself or in 

conjunction with the Replace functionality. 

The Search pane is shown in Figure 7.33.

Using Document 
Templates

The next document you will create is 

a resume. Unlike cover letters, there is no 

standard format-

ting for a resume. 

Fortunately, you 

can get an idea of 

how to format a 

resume using the 

templates avail-

able in Word. A 

template is a pre-

formatted place-

holder document 

for your content; 

you can build your 

own instance of 

the document 

7.4.5

 FIGURE 7.33
Search pane in Word 2011

 FIGURE 7.34
Template selection 
in Word 2013
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all of these may apply to every job to which 

you may be applying.

Writing a Resume
A resume is an advertisement of you 

and your skills. The ultimate purpose of a 

resume is to get you an interview where you 

can showcase your skills on the phone or 

in person. It is difficult for a written docu-

ment to accurately portray the abilities and 

experience you have to offer, so you have to 

be careful in constructing it. Your resume 

should be personalized to the job to which 

you are applying. You can maintain a com-

prehensive document for your own refer-

ence, but you should pick and choose which 

elements you want to include in the resume 

you actually submit. The resume you sub-

mit with your cover letter should not be a 

complete history of your entire life and expe-

rience but a showcase of what you have done 

7.4.6

In Word 2011, you can create a new 

document from a template either by select-

ing the File menu and choosing New from 

Template or by clicking the New from 

Template icon in the Quick Access toolbar. 

This will open the Word Document Gallery 

shown in Figure 7.35. From this interface, 

select Resumes and choose one of the tem-

plates. You can select whichever one you 

want, but the Blocks Resume is a versatile 

option.

Regardless of the version you are using, 

your new document will open in a new 

window of Word. Save the document as 

MyResumeTemplate in the Projects folder 

you created for your documents earlier. 

Note that all of the stylistic elements and 

categories of information that are necessary 

for a resume are included in the template. It 

is important to remember, though, that not 

 FIGURE 7.35
Template selection 
in Word 2011
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statement in a single sentence, it is too 

vague for you to use in your resume. 

The body of the resume will generally 

consist of any relevant positions you have 

held, the degrees or certifications you have 

completed, and the awards or recognition 

you have received that are relevant to the 

position. It should be a showcase of your 

talents and abilities instead of just a list of 

what you have done. For any job you have 

listed, be sure to lead the bulleted list of 

accomplishments with the most impressive 

achievement or responsibility that you had 

in that position. Your bullet points should 

be brief and easy to scan. They should also 

be formatted to demonstrate a problem 

that existed, your actions, and the outcome 

that resulted. According to Resume-Help.

org, you should be sure to include numbers, 

percentages, and currency figures wherever 

possible. An example of a resume using 

these suggestions is shown in Figure 7.36.

There are a lot of resources available on 

the Web if you search for “resume tips” or 

“resume help”; these tips can assist you in 

modifying the language of your resume to fit 

what the employer wants to see. For exam-

ple, Resume-Help.org (www.resume-help.

org) has a number of sample resumes for 

different positions and suggested wording 

and tips for creating professional resumes. 

that is most relevant to the job for which 

you are applying.

The general guideline is that your 

resume should fit on a single page; you 

should only use a second page if you have 

more than 10 years of experience or an 

advanced degree in the relevant field. Your 

resume should have all of your current 

contact information at the top of the docu-

ment. Any outdated information should 

be removed (such as an email account you 

rarely check); if the potential employer 

chooses to use any of the information at 

the top of the resume to contact you, they 

should be able to reach you quickly. 

You should include an objective state-

ment that addresses in brief what you want 

from the potential employer and what you 

can offer them in return; you should not 

include a specific title in this statement 

unless the title is relevant and clearly stated 

in the job description. According to JobStar 

Central, if you cannot deliver your objective 

You can use the format of the template as an 
example, but be aware that many companies 
use scanners that perform optical recognition 
of words and characters; this means that your 
template-driven resume will not scan as well 
as one that is written with simplified head-
ings, bullet points, and spacing. This actually 
makes the document easier to construct in 
terms of formatting; it just becomes a mat-
ter of knowing what to include. Because the 
document is being scanned for keywords, you 
should try to use the job posting to identify 
as many of the keywords as possible that the 
employer wants to see and use them where 
they are applicable in describing yourself and 
your accomplishments.

An employer spends on average between 10 and 30 
seconds looking at a resume, so you need to make sure 
your text is concise and the person reviewing it can 
grasp the main topics in that amount of time; if they 
become interested in that time frame, they are likely 
to read more of it.
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Font panel and Paragraph panel to format 

your text appropriately. When you are fin-

ished, be sure to use the automated tools 

to check spelling and grammar. Always 

remember to save your work.

Using Headers 
and Footers

Headers and footers are often used in 

word processing documents. These allow 

you to maintain consistent elements on all 

pages of your document. A header, for exam-

ple, may contain the title of the document. 

The footer may contain the page number or 

copyright information. For the purpose of 

the resume, you will use the header to enter 

your name and contact information. This is 

not a requirement, but it will allow you to 

format the body of your resume more con-

sistently while keeping your contact infor-

mation fixed.

You can activate the header of a docu-

ment by double-clicking at the top of the 

visible document page. Similarly, you can 

double-click the bottom of the visible doc-

ument page to activate the footer. When 

you do, you will get a context-sensitive 

Header & Footer Tools ribbon, as shown 

in Figure 7.37. From here, you can add 

7.4.7

Remember that you want to perform some 

research on the company or organization 

to which you are applying so that you can 

tailor your resume to match what they are 

seeking. 

Whether or not you are actually going 

to apply for the job you found earlier for 

this project it is good practice to tailor your 

resume to the specifics of that job. Enter 

your information and practice using the 

 FIGURE 7.36
Resume example

 FIGURE 7.37
Header & Footer 
Tools ribbon and 
example in Word 
2013
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no variance in the display of a PDF file. 

This means it will display for the viewer 

exactly as you intend it to be seen. You 

can create a PDF file of your Word docu-

ment by selecting PDF as the file type in 

the Save As dialog box in both Word 2013 

and Word 2011.

Activity 7.4— 
Using the  

OneDrive to Store  
Documents

For this activity, you will add your 

resume and cover letter to your OneDrive 

account. Use a Web browser of your choice 

and login to your Windows Live account. 

Select the OneDrive and choose the Upload 

option. Select both files to upload to your 

account. You should not set sharing on these 

files at this time. Where do these files appear 

on the main page of your OneDrive account 

online? What options are you given when 

you select one of them?

common elements like the page number. 

You can also select predefined headers 

and footers from the respective Header 

and Footer icons. In Word 2013, these 

icons are also available in the Insert rib-

bon. In Word 2011, these are located in 

the Document Elements ribbon; you can 

also use the View menu and select Header 

and Footer to activate the header and 

footer for the document.

For your resume, make sure you promi-

nently include your name, your email 

address, and your phone number. Additional 

information is at your discretion. You want 

to make sure a potential employer has the 

right information to contact you quickly. 

There is usually no need for a footer on a 

resume; even the header is optional (as long 

as your contact information is included 

elsewhere).

Document  
Types

There are several options for saving 

your files. You should pay close atten-

tion to the format in which the potential 

employer wants the document submitted 

and comply with that. Some employers 

may want the document in the native 

Word format. However, if there is no 

specification, a safe alternative is to use 

a PDF. A PDF file is constructed from 

printing commands and it produces a 

static document that cannot be edited 

or reformatted without specialized soft-

ware. Unlike the native Word format, 

which can change depending on the soft-

ware version and installed fonts, there is 

7.4.8

Sometimes a potential employer will request that 
you send your resume via email. If you are includ-
ing it as an attachment, you are safe using a PDF 
file. If you are including it only as text, you should 
strip out the formatting and use only standard text 
with bold and italic emphasis only (if these do not 
go through, your formatting will not suffer). One 
important aspect of this type of formatting is to 
replace any bullet points with the asterisk (*) char-
acter and change numbered lists to manually typed 
numbers; the formatting for bullets and numbering 
varies depending on the email program used and you 
want to retain as much control as possible over the 
display of your document.
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CHAPTER KNOWLEDGE CHECK
All of the following are operations that can typically be performed from the File menu in an 
application except:

 A. Opening a file

 B. Creating a new file

 C. Undoing the last command

 D. Saving a file

The following are all examples of productivity software except:

 A. Word processing

 B. Spreadsheet software

 C. Email management software

 D. Presentation software

 E. All of the above

 F. None of the above

The following are valid formatting shortcuts for a Windows machine except:

 A. Ctrl-B

 B. Ctrl-I

 C. Ctrl-S

 D. Ctrl-U

 E. All of the above

 F. None of the above

1

2

3

CHAPTER SUMMARY
This chapter introduced you to the fundamental concepts and operations 

for creating simple word processing documents. This is the most common 

productivity application in businesses and organizations. In addition, this 

chapter covered the use of common File menu commands for most software 

applications, keyboard productivity shortcuts, and file and file type management. 

The next chapter expands on the use of word processing software to create more 

advanced documents and give you exposure to the more complex formatting 

available in document creation. The menus and tasks introduced in this chapter 

will carry forward into the other productivity tools covered in this text.
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The following operation is used to create a duplicate of selected text or objects on the system 
clipboard and remove the original:

 A. Copy

 B. Paste

 C. Format Painter

 D. Cut

Automated spelling and grammar checks will catch every spelling mistake possible in the language 
that is selected.

 A. True

 B. False

The following is not a characteristic of a bulleted list:

 A. You can select different symbols to display as the bullet point.

 B. The order of the items in the list is significant.

 C. You can have multiple levels of bullet points in an outline format.

 D. All of the above

 E. None of the above

A resume and cover letter should be individualized for the job to which the applicant is applying.

 A. True

 B. False

The following document type is designed to display the same regardless of operating system or 
software application:

 A. Word Document

 B. ODF Text Document

 C. PDF Document

 D. Document Template

The system clipboard retains any formatting for text that is selected and copied to it.

 A. True

 B. False

Spelling and grammar checks should be performed for every document you create.

 A. True

 B. False

4

5

6

7

8

9

10
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CHAPTER REVIEW QUESTIONS
Briefly explain the relationship between word processing and productivity software.  
What are some other examples of productivity software that complement word processing  
in business?

What is the importance of document management? What strategy or approach do you use for 
organizing projects, files, and folders?

How is a cover letter different than a resume? What information should be included in a resume that 
is not included in a cover letter?

How can Format Painter be used to increase productivity, efficiency, and consistency?  

What is the advantage of using a PDF? Are there certain scenarios where you would not want to use 
a PDF file or could not use a PDF file?

How are headers and footers different from the body of a document? What makes these two 
elements useful and when are they most suitable for use?

Describe a situation in which the application of a thesaurus or dictionary would be helpful within a 
document. What alternatives would there be to get this information and why is it more convenient to 
have them as part of the word processing software itself?

Describe an instance in which a template would be beneficial for composing a Word document. Are 
there circumstances in which a template should not be used? Why or why not?

Why is it a best practice when using Replace to look at each instance rather than selecting  
the Replace All option? Is there a situation in which you could use the Replace All option 
with certainty?

Based upon your own exploration, determine if the Format Painter can be used to remove formatting 
from a document so it is left as plain text. If so, how was this accomplished? If not, what formatting 
elements were retained after Format Painter was applied?
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PRACTICE EXERCISES
Select an additional job to which you would like to apply that has significantly different qualifications 
than the one you used for the example project. Revamp your resume and compose a new cover 
letter for this specific position. Reflect on the key changes you made and which elements of your 
qualifications applied to both jobs.

1

1
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Compose a simple word processing document describing yourself in about 200 words. Format the 
document using text effects, bullet points, and different font sizes for emphasis. Use a header for 
your name.

Compose a formal business letter to a company of your choice. This can be a letter asking for 
information or a letter to customer service to express a compliment or complaint. Make sure the 
formatting is correct and the tone is professional. You should include the reason you are writing and 
any outcome you desire from the letter.

You should have already created a personal email account earlier in this text. You will now use this 
email account to mail your resume and cover letter to your instructor as though your instructor was 
a potential employer. Place your cover letter and resume in two separate attachments labeled 
accordingly. Create an appropriate subject heading and develop a body paragraph stating who you 
are, what you are seeking, and where you discovered the job listing. 

Choose a Microsoft Word feature with which you are unfamiliar. Use the Help files to get more 
information about using your selected feature. If you need to do some additional research, you can 
use the World Wide Web. Then create a Word document explaining the feature you chose. 
Additionally, add a paragraph on how you used the Help Files to become more familiar with 
Microsoft Word.

2

4

5

CHALLENGE EXERCISES
For your first exercise, open the Word application and use the New command to start a new 
document. Once you have opened the new document, enter a description of the process by which a 
file is created, saved, closed, and re-opened. Return to the File menu and select the Save As 
command. Use the Save As command to save the new file to the My Documents folder and select a 
name that will accurately describe the contents of the file. Close and re-open the file to verify that 
you included the correct instructions.

Open a new document from the Word application file menu. For this exercise you will learn to work 
with file types. The Word application allows you to save your document in a variety of file types. 
These file types can easily be recognized by looking at the three or four characters after the period 
contained in the file name you have chosen. A Word file extension is .docx. Save your new file with 
an easily identifiable name as you did in exercise 1, except this time when the Save As dialog 
window appears select a name and then select the Save as Type drop-down menu box and select a 
PDF type. Saving your file in this fashion will create a protected document that other users can open 
using a PDF reader such as Adobe Acrobat Reader. Add a brief summary of the benefits of PDF files 
to the contents of the Word file and resave the PDF file.

For this exercise you will learn how to apply templates within the Word application. Select the File 
menu and then select the New command. Search the available templates for a business letter 
template. Open the desired template and save the file to an appropriate location, such as to the My 
Documents locations on your computer. Be sure to name your file in a meaningful way.

1
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Developing professional documents can be a time intensive process. This requires that you be sure 
you do everything possible to preserve your original documents. The Word application has several 
features that will help you safely recover your files from accidental deletions and even power 
outages. One of these features is the automatic save which is set to automatically save your 
documents every 10 minutes. For this exercise select the Options command from the File menu 
which results in the window displayed in Figure 7.38. Next you should be sure the AutoRecover 
information every selection has a checkmark in the check box and finally adjust the minutes to five 
so that your work is automatically saved every five minutes. To show your instructor you have 
completed this exercise, simply press the Print Screen key to copy your screen and then left click in 
a Word document at the position where you would like to paste your screen shot, press the shortcut 
command to paste the image, and your image will appear.

If you’re using a Macintosh computer, then you can complete the same exercise with the exception 
of a couple of different steps as shown in Figure 7.39 below. On the Mac you will need to open the 
File menu and select Save as. When the Save as dialogue window opens you will notice that on the 
bottom left side of the window there is an Options button. Select the Options button and the Save 
options window opens. Be sure to select the Save AutoRecover information every check box if it is 
already not checked and change your minutes to 5. To show your instructor you have completed 
this exercise, simply press the Command + Shift + 3 keys to copy your screen, which will be saved 
as a PNG file on your desktop. You can paste this image into a Word document that will show your 
instructor you completed the exercise. 

4

 FIGURE 7.38
Save options in Word 2013
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Organizations today constantly struggle to protect their intellectual capital. Intellectual capital is an 
organization’s “know how” skills they develop over time. For this assignment, suppose you are 
working on an important memorandum that contains confidential information relating to a new fuel 
formula that helps vehicles run more efficiently. Create a new Word file and name it 
NewFuelforAmerica.docx and save it to your favorite location. With the document open, you will 
encrypt and password protect the document. (Note: The encryption option is not available for Word 
2011.) Open the File menu and press the Info command and select the Protect Document as shown 
in Figure 7.40. For this assignment, select the Encrypt with Password option and select a password 
with no more that fifteen characters using a combination of numbers, letters, and characters.

5

 FIGURE 7.39
Save as options on a Macintosh

Be sure to place 
check mark on the 
Save AutoRecover 

info every selection. 
Change your minutes 
to 5 rather than the 

system default of 10.

 FIGURE 7.40
Encrypt with Password options
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If you are using a Macintosh computer with Word 2011 then you can complete the same exercise 
with the exception of a couple of different steps. Microsoft Word 2011 allows you to protect your 
document but does not use encryption, so this means you must also rely on keeping your files safe 
in a secure location. It is also important that you do not exceed fifteen characters or you will not 
be able to open the document on a Windows version of Word. To password protect the document, 
open Word 2011 and select Preferences, Personal Settings, and Security. Performing these steps 
produce a window as shown in Figure 7.41. There are three options to protect your document that 
include:

•	 Require a password to open

•	 Require a password to edit

•	 Suggest read-only mode

Make the changes, press OK, and re-enter your password in the confirm dialogue. To show your 
instructor you have completed this exercise, simply press the Command+Shift+3 keys to copy your 
screen, which will be saved as an image file (in PNG format) on your desktop. You can copy and 
paste this image into a Word document to show your instructor you completed the exercise. 

 FIGURE 7.41
Word 2011 document password options
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CHAPTER  

8
Developing and Editing 
Documents

IN THIS CHAPTER

This chapter covers the construction of more involved and complex word 

processing documents. The example for this chapter is a research article, which 

introduces the concepts of style management, document elements like a table 

of contents and cover page, and the inclusion of graphic elements. You will also 

learn to use and manage references and external sources in your work. At the 

completion of this chapter, you will be able to:

●	Apply, manage, and edit styles in your document

●	Manage references and sources and insert document 
citations

●	Customize the page layout 

●	Insert images and adjust their placement in your 
document

●	Add document elements such as a bibliography, table of 
contents, and page breaks 

Microsoft Office 
2013/365 and 

Beyond
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A typeface is a collection of symbols that 

form an alphabet; each typeface has its own 

unique style of display, such as the typefaces 

Times New Roman and Arial, two common 

typefaces installed on most machines. It is 

very likely that you will see the typeface con-

fused with the term font (as in the case of 

Word) because they are almost synonymous. 

A font is actually a combination of a typeface 

and a size, so 10-point Arial would be a font. 

With the advent of digital typography, such 

as that used in Microsoft Word, the font 

selection is typically separate from the siz-

ing, making the choice of typeface and font 

virtually indistinguishable. Now, you would 

simply select Arial as your font and set the 

size of the type separately.

There are two major classifications of 

fonts: serif and sans-serif. A serif is a text 

decoration added to letters of the font, such 

as you would find in Times New Roman. 

Sans-serif means a font without these text 

decorations present. You can see examples 

of both types of fonts in Figure 8.1.

The font is also determined by the size 

of the text. Most modern fonts accommodate 

multiple sizes with the same display. A pixel 

TYPOGRAPHY
Typography is the process of arranging 

letters in a specific arrangement to make 

language readable from the outcome. This 

was once a specialized occupation, but with 

the advent of personal computing, typog-

raphy is something in which everyone who 

types a document participates. The type-

face, size, and spacing of the letters are all 

contributing factors to typography; these 

are all choices that are made in composing 

any document you write. 

8.1

TYPOGRAPHY is the process of arranging let-
ters and punctuation to create a readable out-
come in any document. Most typography is done 
for artistic reasons, but readability and clarity 
should be primary concerns in any typography 
effort.
A TYPEFACE is a complete set of keyboard char-
acters in one particular style (the style is the name 
of the typeface). Most typefaces support standard 
sizes as well as bold and italic variants.
A FONT is a typeface combined with a set size, 
such as 10pt Arial. In most modern computing 
systems, fonts support use with size modifica-
tions, so the terms typeface and font are becom-
ing synonymous.
A SERIF is a decoration on a letter of text. 
This is a nonessential element that graphically 
enhances a character without adding any new 
information; these are mostly used to enhance 
readability by distinguishing the letters from 
each other and for artistic effect.
MONOSPACING in terms of typing is the char-
acteristics of all letters typed occupying the same 
horizontal space regardless of the inherent letter 
size.  FIGURE 8.1

Examples of serif and sans-serif fonts
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the Home ribbon and type one sentence in 

each font. Identify each font as either serif or 

sans-serif and then identify whether it is a 

monospaced font or a proportional font.

The choice of font for a project var-

ies greatly. When you are creating printed 

material, serif fonts are generally accepted 

as the standard. In digital display, such as 

PowerPoint slides, sans-serif is considered 

the better option. With the variety of fonts 

available from which to choose, it is a matter 

of creative choice. However, as a general rule 

of design, you should have no more than two 

fonts occupying the same document. More 

than this makes the arrangement look hap-

hazard and poorly planned.

There are a variety of typefaces or fonts 

that come installed on any modern com-

puter system, but it is possible to add new 

typefaces or fonts and install your own. The 

most common type of font that works on 

almost all systems is a TrueType font; this 

is a font that contains additional display 

information so it accommodates multiple 

size settings beyond the standard set com-

mon to most fonts. These are also noted 

for nearly identical display across different 

operating systems. A TrueType font file will 

have the extension .ttf; when you find a font 

file like this (whether you download it from 

the Web or get it from someone else) on a 

Windows machine you can double-click the 

file for a preview window like the one shown 

in Figure 8.2. This shows the font display for 

all of the available characters in the avail-

able common sizes.

is the smallest unit of display on your com-

puter monitor; the standard resolution for a 

computer is 72 pixels per inch. In the world 

of typesetting, there are 72 points per inch, 

meaning that a point is roughly equiva-

lent to a pixel on the screen.  Therefore, 

a 12-point (abbreviated 12pt) font would 

occupy roughly 12 pixels of space on a digi-

tal display. A less common measurement 

you may see is a pica; a pica is equivalent to 

12 points. Pica rulers are most common in 

desktop publishing applications.

There are two types of spacing avail-

able in the design of fonts: monospacing and 

proportional spacing. Monospacing is when 

all of the characters in the font occupy the 

same horizontal width when typed; this was 

the common case for most fonts in mechani-

cal typewriters because the motion of the 

typing carriage was fixed. Proportional 

spacing on the other hand allows letters to 

occupy only the space each one needs to dis-

play. The spacing between adjacent letters 

in a font is also established by default, but 

you can adjust this manually; this process of 

adjustment is called kerning. Adjusting the 

spacing between words is called tracking. 

The spacing between lines (which is typi-

cally part of paragraph formatting) is called 

leading.

Activity 8.1—Typing 
Practice with Fonts

In this activity, you should create a new 

document called Activity8_1 and save it in 

the Activities folder. Next, you will select 10 

different fonts installed on your computer 

from the dropdown list in the Font panel of 
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purpose of word processing software is 

to create the digital equivalent of a print 

medium. Whatever the purpose you may 

have in mind for your individual software, 

whether it is writing a novel or using it in the 

context of a business, the tools available are 

the same, and they provide a robust inter-

face for creating professional documents.

For the purpose of this chapter, the pro-

cess of creating a research report is used 

to explore common word processing tasks. 

If you are using your software for a report, 

whether for a class or for an organization, 

there are several considerations you should 

keep in mind:

•	Remember your point and do not 
deviate too far from it. Your audi-
ence is reading your document to get 
information on one particular topic, 
so be sure you keep that topic in mind 
when you construct your document 
and make it as easy as possible for 
them to get that information. It is dif-
ficult for the human mind to maintain 
too many concurrent points when 
committing information to memory, 
so allowing your reader to identify 
a single overall message and then 
adding information to that message 
will maximize the impact of your 
document.

•	Adhere to any page or word limits. 
Having a page or word limit conveys 
an expectation from the person who 
receives your work. You should try to 
get as close as possible to that value. 
Word allows you to easily view your 
word and page count at the bottom 
of the interface so you can remain on 
track. If you have a lower and upper 
bound for your document, you should 
not go below the lower limit or above 
the upper limit without a definitive 
need or the permission of the person 
to whom you are submitting the work. 

The button that says Install can be used to 

automatically add the font to the computer 

so it becomes available for use in any 

program that supports the use of fonts, like 

Word. You may need to restart the program 

in which you want to use the font after it is 

installed.

To install a typeface or font on a Mac OS 

X machine, you should start by double click-

ing the file. This will open a preview win-

dow showing examples of the text in specific 

sizes. At the bottom of the window is a but-

ton that says Install Font. If you click this, 

the typeface will be added to your machine 

as a choice in any program that supports the 

use of fonts.

Font selection for a project is important. 

For the example in this chapter, you will be 

creating a research paper, so you should tend 

toward serif fonts for printed documents. As 

part of this chapter, you will focus on apply-

ing styles in Word. A style is a consistent 

way to apply formatting to text, including 

the typeface, size, and any additional for-

matting such as bold or italics.

WRITING A 
RESEARCH ARTICLE

Word processing has a myriad of uses 

from constructing research reports to writ-

ing rules and regulations. The primary 

8.2

 FIGURE 8.2
Windows 7 font 
preview
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and properly create citations. You 
should also try to make sure you use 
credible sources for your information, 
such as published text in books or 
articles. When you are using informa-
tion from the Web, you should evalu-
ate the authorship and how reliable 
the information is.

•	Reference any material that is not 
your own. If you are using some-
one else’s idea or work, you need to 
include that in the list of references 
for your document. Claiming any 
material as your own that you did not 
create or develop may be a violation 
of copyright laws. It is better to take a 
cautious approach and make sure that 
you reference any sources you used to 
construct the document. Any signifi-
cant facts that you present that you 
had to research should have a citation 
to accompany them.

•	Check the availability for use of 
images that you did not create. Using 
images can be a great way to convey 
information, but the use of images 
is also subject to copyright law. You 
cannot use an image you did not cre-
ate without written permission from 
the author allowing you to use it; this 
permission can be stated in terms on 
a Website (where it may specify use 
or identify the image as royalty free) 
or via email from the author. This 
rule applies to all media, but its most 
common use in a printed document is 
for images.

If you are not given a page limit, 
try to remain thorough but concise 
with your document; saying more in 
less space is almost always a better 
approach.

•	Communicate your ideas clearly and 
efficiently. Even if you are not a pro-
fessional writer, you should strive to 
communicate clearly in your written 
work. Part of this is making sure what 
you write conveys what you want it 
to convey. You can enlist help from 
a friend or colleague if necessary to 
make sure your document is clear. No 
amount of fancy formatting will make 
up for a lack of clarity in the work. 
You should also try not to spend too 
long elaborating a single point of data 
or fact; your communication should 
continue to move forward from one 
point to another.

•	Set the necessary tone for the 
document. The way in which your 
document will be used should be 
considered in your language choice. 
Informal elements like contractions 
should be omitted from professional 
documents. Use of any slang should 
also be restricted in a business set-
ting. A document lacks personal 
interaction so there is no ability to 
explain yourself if your document is 
misunderstood. This also applies to 
making sure you distinguish fact from 
opinion in your text; your text can 
contain opinions, but they should be 
presented clearly as such.

When you are conducting any kind of 

research or using sources other than your-

self, it is imperative to also observe the 

following to assist you in managing copy-

righted material effectively.

•	Keep track of your sources and evalu-
ate material. It is important that you 
have access to your reference material 
and know where certain information 
was found so you can access it later 

Copyright law is a very serious matter. Violations can 
get you fined or expelled from academic institutions. 
Copying someone else’s work and claiming it as your 
own is never permissible. In order to use someone 
else’s work, you must always give the original author 
credit; other elements such as royalties on profits may 
also come into play depending on the use. Copyright 
laws of the United States can be reviewed at www.
copyright.gov/title17.

MSOffice-Beyond-CH08.indd   175 5/19/2014   4:09:53 PM



176 — Microso f t  Of f i ce  2013/365 and  Be yond

conclusion are included in the outline for 

the text.

You are free to choose your own histori-

cal figure to follow along with the instruc-

tions. Once you have decided on your topic 

and what you want to convey, you should 

start gathering reference material for your 

subject. Remember that you need to evalu-

ate the credibility of your sources before you 

use them; an important question to ask is 

“How do I know I can trust what this author 

has to say?” Make sure you are answering 

that question with a reason more substan-

tial than its existence on the Internet.

Using and Managing 
Styles

Once you have established your out-

line, you need to add titles to each of your 

sections. For the example, the titles are 

The Legend of Jean Lafitte, The King of 

Barataria Bay, The Hero of the Battle of 

New Orleans, and Later Years and Legacy. 

Begin creating your document by opening a 

new document and saving it in your Projects 

folder as MyReport. Type the headers you 

will use into the word processing document. 

To assist in the outlining process, you can 

also apply styles to the text. 

For these titles, you will use the style 

Heading 1 from the Styles panel of the Home 

8.2.2

Outlining the Document
Every document you create will have 

some purpose, even if it is just for your 

own reference or use. Before writing your 

document, it is important to know what you 

want to convey with the text. You should 

be able to summarize the document in one 

to two sentences; the rest of the document 

should just be an explanation and expansion 

of that. If you cannot summarize your docu-

ment, you may need to narrow your focus 

or consult with the person to whom you are 

submitting the document. Even technical 

guidelines have an overall purpose, no mat-

ter how long they are. The summary goal for 

the example in this chapter is to convey back-

ground information and instruction on the 

use of productivity software to increase the 

productivity and proficiency of the reader. 

The rest of the text is a fulfillment of that 

purpose.

Once you have established your docu-

ment’s purpose, you will expand on it with 

particular topics to include. This is a pro-

cess called outlining; it is the establishment 

of the major topics of the document. The 

example project in this chapter is a short 

report on a historical figure: Jean Lafitte, 

a renowned pirate and hero of the Battle of 

New Orleans in the War of 1812 between the 

United States and Britain. The report is lim-

ited to 1.5 pages in length, so there will not 

be a large number of topics to discuss. The 

two elements chosen were the beginning of 

Lafitte’s piracy operation in Barataria Bay 

and the Battle of New Orleans. Therefore, 

an introduction, these two topics, and a 

8.2.1

A STYLE is a collection of formatting 
effects and enhancements used to mod-
ify text in a consistent manner. Applying 
a style to a selection of text will add all 
of the defined formatting effects and 
enhancements of that style without the 
need to individually recreate them.
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Click the expansion icon of the Styles 

panel to open the Styles pane in Word 2013. 

This is accessible in Word 2011 by selecting 

the Manage styles icon. The Styles pane is a 

listing of the current styles available in the 

document. An example of the Styles pane is 

shown in Figure 8.4. 

Select a style to apply it to selected text 

or use the drop-down arrow for the style 

and select Modify to adjust individual ele-

ments of the style, similar to how you used 

the Font dialog box in the previous chapter. 

You can create a new style using the New 

Style icon.

To duplicate styles from another docu-

ment in Word 2013, click on the Manage 

Styles icon of the Styles pane. This will open 

the Manage Styles dialog box; click on the 

Import/Export button at the bottom of this 

dialog. To access this in Word 2011, select 

the Format menu and choose Style. When 

the dialog box opens, click the Organize 

button.

You will now see style listings for two 

files. The file you are developing is on the 

left and by default the global template 

Normal.dotm is on the right. You can close 

the Normal.dotm file (using the Close File 

button) and select the file whose styles you 

ribbon. Notice that there are six heading 

styles already defined for you to use; each 

of these will appear in the document outline 

when used. Heading 1 is the highest level 

and Heading 6 is the lowest level above plain 

text. You can add additional heading levels 

to create a more complex outline of your 

document.

In Word 2013, you can select the Design 

ribbon to set the overall look of the page. 

For example, you can choose the Font icon 

and select from a number of paired choices 

for heading and text fonts from the drop-

down list. You can see an example of this in 

Figure 8.3. In Word 2011, the equivalent to 

change the style settings for the document 

is the Change Quick Styles settings icon, 

from which you can also choose one of many 

options.

The default style for any Word document is 
Normal. This is a predefined style that defaults 
to whatever setting is established at installa-
tion. You can edit the Normal style just as you 
can any other style, and all of the text that has 
Normal as a style will update to reflect the 
changes. The ability to update all of the text 
formatted with a style at once is one of the ben-
efits of using styles in a document.

 FIGURE 8.3
Design ribbon and Font icon selection in Word 2013

 FIGURE 8.4
Styles pane in Word
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You can navigate quickly through your docu-

ment by clicking on any of the headings that 

appear; this will jump your position in the 

document to the location where the heading 

appears. The second tab in the Navigation 

pane is a page-by-page preview of your docu-

ment; you can once again navigate quickly 

through it by clicking on the thumbnail pre-

view image of the page. The last tab of the 

Navigation pane shows the results of any 

search you have performed.

The equivalent of the Navigation pane 

in Word 2011 is the Document Map pane. 

Access the Document Map pane by select-

ing the View menu, choosing Sidebar, and 

selecting Document Map. This will open the 

Document Map pane on the left side of the 

interface. You will see your headings and 

subheadings here, and you can navigate to 

want to duplicate using the Open File but-

ton. Once you have the document open, you 

can use the mouse to select the styles you 

want to add to your current document and 

then use the Copy button (which will have 

a directional arrow showing you where the 

copies will be placed) to move them over to 

the current file.

Activity 8.2—Using Styles
For this activity, you should create a 

new Activity8_2 document and enter sev-

eral lines of text. Apply a style to each line 

of text and modify the styles after you have 

applied them. What happens to the affected 

text? What are some of the options in the style 

modification dialog? Be sure to save your 

work in the Activities folder.

Using the Navigation 
Pane and Document 
Map Pane

The Navigation pane in Word 2013 and 

the Document Map pane in Word 2011 allow 

you to see the evolving outline of your docu-

ment as you add headings and subhead-

ings to it. Activate the Navigation pane in 

Word 2013 by selecting the View ribbon and 

checking the box beside Navigation Pane. 

You should see it appear on the left side of 

the interface; it will contain the headings 

you added to your document. An example is 

shown in Figure 8.5.

The default view in the Navigation pane 

is the headings for your document. You can 

set the level of headings you wish to appear 

by right-clicking any of the headings, select-

ing Show Heading Levels, and choosing the 

lowest level of heading you want to appear. 

8.2.3

 FIGURE 8.5
Navigation pane in Word 2013 with Show Heading Levels 
active
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established. It is very important to keep 

track of your citations as you construct your 

document. A citation should be added when-

ever you are either using another source 

to provide information that is not common 

knowledge or drawing your own conclu-

sions. It is necessary to manage your sources 

so you can include citations easily.

Word makes this task easier by giv-

ing you the ability to add and store refer-

ences in conjunction with your document. 

The functionality for this is located in the 

References ribbon of Word 2010, as shown 

in Figure 8.7. 

To add new sources or edit existing ones, 

open the Source Manager (shown in Figure 

8.8) by clicking the Manage Sources icon. 

From this dialog box, you can add new 

citations by clicking New. This opens the 

Create Source dialog box, where you can 

select the source type from the drop-down 

list; this will adjust the fields needed to 

accurately cite the source. You should try to 

complete as many of these fields as you can 

to give the most complete citation possible.

In Word 2011, you access your sources 

and add new sources by clicking on the 

Manage icon of the References panel on 

the Document Elements ribbon. This will 

open a new Citations window, as shown in 

Figure 8.9. To create a new citation entry, 

select the + icon in the lower-left corner and 

them quickly in your document by clicking 

on any one of them. You can also right-click 

on any of the headings to select the lowest 

heading level you wish to display. An exam-

ple of the Document Map pane is shown in 

Figure 8.6.

The Document Map pane is the sec-

ond tab on the pane. The first tab is the 

Thumbnail pane, which displays a page-by-

page preview of your document as thumbnail 

images; you can jump to any page by click-

ing on the thumbnail image representing 

it. The third tab is the Review pane, which 

is used in document correction and review. 

The final tab is the Search pane where you 

can perform find and replace operations in 

the document.

MANAGING 
CITATIONS

You should now be adding the content 

of your report for each of the headings you 

8.3

 FIGURE 8.6
Document Map pane in Word 2011 with the right-click 
menu active

A CITATION is a reference to an external source 
you used to gather information, text, or other 
content for your work.

 FIGURE 8.7
References ribbon 
in Word 2013
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then select the type of source to adjust the 

fields necessary for the citation. Clicking on 

the settings icon in the lower-right  corner 

allows you to edit a citation or open the 

Citation Source Manager, which is similar in 

 FIGURE 8.8
References ribbon 
in Word 2013

It is always important to evaluate the credibility of a 
source you are using for your work. Textbooks, confer-
ence papers, and journals often go through rigorous 
peer review and technical editing, so they tend to be 
more trustworthy sources than something published 
only online. You can find reviews of the textbook, 

conference, or journal to evaluate whether it 
meets these criteria. Anything you find on the 
Web is a different matter; it is easy to create 
a personal Website and post any information 
you want, whether or not it is true. Whenever 
you encounter an online source, there are 
some things you should consider when decid-
ing whether you can trust it. Here are a few 
questions to ask of a potential Website source 
before you use it:
Who is the author of the site? If the author is 
a reputable organization or an individual with 
expertise in the area, it is more likely to be a 
credible source.
What are the site extension and the domain 
name of the site? Once again, a company or 
organization site is generally more credible 
than an individual unless that individual is an 
expert in the field. A professional versus an 
unprofessional domain name can also indicate 
the level of trust that should be placed in the 
source. The site extension is also telling; for 
example, the site extension of .gov indicates a 
government publication.
Does the site use references and cite other 
sources? This can indicate whether the author 
has researched the subject sufficiently. Looking 
at any references used and evaluating them 
will help determine if the page is credible.
Is the site up to date? You should be able to 
check the date it was last updated to deter-
mine whether the document is current.
Is the site objective with its information or is 
there another motivation? You should try to 
use objective sources in your work and evalu-
ate the reliability of the source; the author may 
have created the document with a particular 
motivation in mind to influence the reader.

 FIGURE 8.9
Citations window 
in Word 2011
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interrupting the flow of the text. Whether 

to use footnotes or endnotes is a stylistic 

choice. The main difference between them 

is their placement within the text. 

A footnote will be placed on the page to 

which the notation is added; the text will 

have a superscript number placed beside it 

and the footnote explanation will be placed 

in a separate section at the end of the page. 

To place a footnote in Word 2013, click on 

the References ribbon and choose Insert 

Footnote; your cursor should be placed 

beside the text you are annotating with the 

footnote. To add a footnote in Word 2011, 

select the Document Elements ribbon and 

choose the Footnote icon with the cursor in 

the location you want to annotate.

The current number of the footnote for 

that page (beginning with the number 1) 

will be added at the current cursor location 

and you will be taken to the section at the 

bottom-left corner of the page where you can 

add the footnote text. An example is shown 

appearance to the Source Manager in Word 

2013.

Once you have entered your sources, 

you can insert in your text a citation to any 

of the existing sources. These citations are 

linked to the original citation entry, so edit-

ing the source information will update any 

citations in the document. To add a citation 

in your document in Word 2013, select the 

References ribbon, choose the style for the 

citation (APA was used in the example), 

click the Insert Citation icon, and then select 

the source you want to use. The reference to 

the source in the correct format for the cita-

tion style will be added to your document. 

To add a citation to your document in 

Word 2011, select the citation style (in this 

case APA) in either the Document Elements 

ribbon or the Citations window. Then right-

click (or double-click) the source you want 

to reference; the reference will be added to 

your document at the current location of the 

text cursor (where the last text was entered 

in the document). There are three main 

citation styles that are used in most publica-

tions, though other styles do exist. The fol-

lowing is a list of the common styles and a 

source to get more information on its use for 

manuscript production:

•	American Psychological Association 
(APA) style—www.apastyle.org

•	Modern Language Association (MLA) 
style—www.mla.org/style

•	The Chicago Manual of Style—www.
chicagomanualofstyle.org 

Footnotes and Endnotes
Footnotes are used to add explana-

tion to an element of a document without 

8.3.1

A FOOTNOTE is an additional comment aside 
from the main point of the text that is placed at 
the bottom of the page and indicated by a refer-
ence mark in the main text. This is typically used 
to clarify a point or provide an explanation that 
would detract from the content of the document 
if left in line with the main text. An ENDNOTE 
is the same thing as a footnote except it is placed 
at the end of the document instead of on the same 
page with the reference mark.

 FIGURE 8.10
Footnote 
placement in Word 
2013
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Creating a Bibliography
In the new versions of Word, adding ele-

ments like an index, table of contents, and 

bibliography is almost a one-click action. If 

you have prepared your references correctly 

and added them to the Source Manager cor-

rectly, you can click on the Bibliography 

icon in the References ribbon in Word 2013 

and insert a fully formatted bibliography 

(with the predefined options of using either 

Bibliography or Works Cited as the head-

ing). This will add the references formatted 

according to the citation style you selected in 

the formatting defined for your document. A 

completed example and the selection menu 

are shown in Figure 8.12.

In Word 2011, the Bibliography icon 

is located in the References panel of the 

Document Elements ribbon. Clicking on 

8.3.2

in Figure 8.10. The numbering for the foot-

notes will be adjusted as text is moved; a 

link exists within the document connecting 

the mark in the text and the note.

An endnote is placed at the end of the 

entire document. By default, endnotes start 

with Roman numerals (beginning with low-

ercase i) and accumulate throughout the 

text. Adding an endnote is similar to adding 

a footnote. The annotation will be placed 

where the cursor is located in the document 

and you will be taken to the endnote section 

to enter the text describing the annotation. 

To add an endnote in Word 2013, select 

the References ribbon and choose Insert 

Endnote; in Word 2011, you add an end-

note by selecting the Document Elements 

ribbon and choosing Endnote. While the 

default properties are sufficient for most 

documents, you can customize characteris-

tics of your footnotes and endnotes in the 

Footnote and Endnote dialog box shown in 

Figure 8.11.

To access the advanced properties for 

footnotes and endnotes shown in Figure 

8.11, select the expansion icon on the 

Footnotes panel of the References ribbon in 

Word 2013. This dialog box allows you to 

change the settings for both footnotes and 

endnotes, including placement of the notes, 

the starting value for the annotations, and 

the numbering format used. To access these 

advanced properties for inserting custom 

footnotes and endnotes in Word 2011, select 

the Insert menu and choose Footnote.

 FIGURE 8.11
Footnote and Endnote dialog box in Word 2013
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an existing size or customize your own. In 

Word 2011, the Size icon is located in the 

Layout ribbon.

You can change other properties of your 

document as well. As mentioned previously, 

you have the ability to change your docu-

ment from the default Portrait layout to the 

wide Landscape layout; this is accomplished 

using the Orientation icon in the Page 

Layout ribbon (or the Layout ribbon in Word 

2011). The Margins icon is another useful 

tool and is found on the same panel with 

the Orientation and Size icons. Your report 

should use the Normal margin setting of 1” 

on all sides.

You can see the exact size of your docu-

ment and the position of elements in your 

text using the rulers and gridlines built into 

Word. The ruler gives you the spacing of 

the text compared to real inches and cen-

timeters on the printed document. This is 

helpful if you need to place elements within 

a certain range or in a confined area for 

printing (such as printing labels or enve-

lopes). Gridlines give you a cross section of 

the ruler lines so you can position elements 

more precisely within the document; this is 

similar to using graph paper for a visual lay-

out. The default gridlines are 1/8” apart. 

In Word 2013, you can activate or deac-

tivate these options using the checkboxes 

next to the Ruler and Gridlines text entries 

on the Show panel of the View ribbon. 

The ruler in Word 2011 can be activated 

the Bibliography icon opens a drop-down 

menu showing a preview of the built-in 

Bibliography and Works Cited options; you 

can click on either of these to insert the for-

matted result (arranged in the citation style 

you selected beside the icon; APA is used in 

the example) in your document wherever 

your cursor is placed. For the example proj-

ect, the Bibliography entry was chosen and 

placed at the very end of the document.

SETTING A 
PAGE LAYOUT

At this point, you should have all of the 

text added to your document, so it is time 

to format the page for a more professional 

presentation. You have the flexibility in 

word processing documents to choose the 

size of your pages. While most home and 

office printers only accommodate 8 ½” by 

11” paper, you can customize the document 

to whatever dimensions you need up to 22” 

by 22”. There are predefined sizes for enve-

lopes and legal documents as well. Select 

the page size in Word 2013 by activating the 

Page Layout ribbon and choosing the Size 

icon; this opens a menu for you to select 

8.4

 FIGURE 8.12
Example bibliography and selection menu in Word 2013

If you want to make a document that is poster sized, 
PowerPoint is a better software package to use. It is 
covered in Chapters 10 through 12.
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Choose any of the predefined options 

in the Columns dialog box or create your 

own columns with customized widths. You 

can also choose whether you want to apply 

the column formatting to the entire docu-

ment or just from that point forward. For 

the example report, you should estimate 

the amount of text you want to convert to 

the two-column first page. The rest of the 

document (which should amount to about 

half a page) will be formatted as a single col-

umn spanning the whole document width. 

You can convert the text back and forth as 

needed by highlighting what you want to 

change and by selecting the number of col-

umns from the Columns icon. You will be 

adding an image to your document, so you 

will likely have to alter the columns again 

once the image is in place.

Adding Graphic 
Elements and Captions

To insert an image into your document, 

you must first have the image saved on 

your local machine. Typical image file for-

mats are JPEG (Joint Photographic Experts 

Group) File Interchange Format, Graphics 

Interchange Format (GIF), Bitmap, Portable 

Network Graphic (PNG), and Tag Image 

8.4.2

or deactivated by selecting the View menu 

and choosing Ruler. In Word 2011, the grid-

lines options are activated by selecting the 

Gridlines checkbox in the Layout ribbon. 

The gridlines will appear when you select 

an object that can be repositioned on the 

document. You can activate these elements 

for planning your document and then deac-

tivate them later as needed.

Activity 8.3—Modifying 
Page Sizes

For this activity, you should create a new 

Activity8_3 document. Using the options 

for page size, try to make your document as 

small as you can make it. What is the mini-

mum size you can use for page dimensions 

in Word? Is there any application for a docu-

ment this small? What would happen if you 

tried to print this document? Save your work 

in the Activities folder you created.

Formatting Columns
While the format of the reports you cre-

ate will vary, the example uses a two-column 

format for the first page. To change the 

number of columns for your document, sim-

ply select the text you want to change and 

choose the Columns icon. This is located on 

the Page Layout ribbon in Word 2013 and the 

Layout ribbon in Word 2011. You can select 

from any of the predefined column divisions 

for the selected text or you can select the 

More Columns option from the drop-down 

list to access more advanced options (this is 

labeled simply Columns in Word 2011). An 

example of the advanced menu and the two-

column result of the report text are shown 

in Figure 8.13.

8.4.1

 FIGURE 8.13
Advanced column configuration options and two-
column formatting of text

MSOffice-Beyond-CH08.indd   184 5/19/2014   4:09:55 PM



Chapt er  8  — Deve lop ing  and  Edi t ing  Documents  — 185

The different text wrap options are 

square (where the image is given a padded 

rectangle to occupy and the text will sur-

round it), tight (which acts like the square 

setting without the padding on the rect-

angle), through (where the text will come 

as close as possible to the outline of the 

shape itself), top and bottom (which clears 

the horizontal space of the entire column of 

text around the image), behind text (which 

places the image on the layer of the docu-

ment beneath the text so the text overlaps 

the image), and in front of text (which places 

the image on a layer of the document above 

the text, obscuring any text behind the 

image without displacing it). The use of the 

square setting tends to be the most legible 

in printed documents; this is the setting 

used in the example. You can set the text 

wrap options in Word 2013 by selecting the 

image, activating the Page Layout ribbon, 

and choosing the Wrap Text icon. In Word 

2011, you can change these settings by acti-

vating the context-sensitive Format Picture 

ribbon with the image selected and choosing 

Wrap Text. A completed example is shown in 

Figure 8.14.

To insert a caption for the image, right-

click on the image and choose Insert Caption 

from the menu that appears. This will open 

the Insert Caption dialog box shown in 

File Format (TIFF); any of these types of 

files can be inserted into a document. To 

insert an image into your word processing 

document in Word 2013, select the Insert 

ribbon and choose Pictures. This will open 

the Insert Picture dialog box where you can 

select the image you want to insert. 

In Word 2011, you can insert 

an image from the Home rib-

bon by choosing the Picture icon 

and then choosing Picture from File. As 

with any content, you must make sure 

you have adequate permission to use an 

image file if you have not created it your-

self. If you do not have an image to use as 

an example in your report, you can use 

the MySampleImage file, which is a pho-

tograph of Pirates Alley in New Orleans, 

Louisiana. You can resize the image using 

any of the grip points that appear around 

its edge when it is selected. The midpoint 

grip points change only one dimension at 

a time. The corner grip points change the 

two sides they connect at once. You can use 

the context-sensitive Format ribbon for 

Picture Tools to set the size of the image 

directly; this ribbon contains a large num-

ber of other features that will be more 

fully explored in Section III, “Presentation 

Software and Microsoft PowerPoint.”

By default, the image will be placed in 

line with your text, expanding the current 

line size to fit the image; the image will act 

like another character in the text of the doc-

ument in this format. You can click and drag 

it as you can with any other selected text. 

You can change how the image behaves by 

changing its text wrapping properties. 

TEXT WRAPPING, or text flow, is the setting in 
a document or Web page that determines how text 
behaves around an object. An example of this is 
how much space is left blank around the perim-
eter of the object and whether the object is treated 
as a character in the text or as a separate entity.

on the dvd
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to altering the Word Wrap properties, you 

can select the positioning of the image at 

predefined places on the page; when you 

use this option, it defaults to wrapping the 

text around the image instead of keeping 

the image in line with the text. You can use 

the Align menu to change the alignment of 

the image to the page or to other elements 

in the page. You can also send the image 

forward or backward on the layers of the 

document (similar to stacking paper clip-

pings where the topmost element is visible 

in front). This type of image manipulation 

is covered more extensively in the chapters 

on presentation software. You can access 

these advanced image options from the 

Page Layout ribbon in Word 2013 and from 

the context-sensitive Format Picture ribbon 

in Word 2011.

Activity 8.4—
Graphics Practice

For this activity, you should create a new 

Activity8_4 document and enter several lines 

of text. Add a graphic to the page and explore 

the different options for text wrapping. How 

does this alter the behavior of the graphic 

within the page? Add a caption to the image 

and repeat the process. How does the caption 

move with the image? Save your work in the 

Activities folder.  

ADDITIONAL 
DOCUMENT 
ELEMENTS

There are a number of additional docu-

ment elements you may need to include. 

Some of these relate more to larger 

8.5

Figure 8.15. You can add 

the caption text you want 

to display and specify how 

you want it labeled in the document (Figure 

should be the choice for this example). 

The text added here was “Pirates Alley in 

New Orleans.” You can add a figure num-

ber (such as “Figure 1:”) to the caption as 

well; this is recommended if there is more 

than one image in your document or if it is a 

more formal submission. It is also helpful to 

reference your figure by number in the text 

of the document and identify the enhance-

ment to the text it provides.

There are a number of other format-

ting options for images in Word. In addition 

 FIGURE 8.14
Image in Word with square text wrapping 
and visible grip points

 FIGURE 8.15
Caption dialog box in Word 2013
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•	Blank Pages—Sometimes it is nec-
essary to add a blank page to your 
document; this is commonly found 
behind the title page of a lengthy 
report. To create a blank page in 
Word 2013, select the Insert ribbon 
and choose Blank Page. In Word 2011, 
select the Document Elements ribbon 
and choose Blank in the Insert Pages 
panel.

•	Page Breaks—A page break ends 
the current page regardless of any 
remaining space on the page and 
starts a new page. This is useful if 
you do not want chapters or sections 
of a document to run together. In 
Word 2013, you can select Page Break 
from the Insert ribbon. In Word 2011, 
select the Document Elements ribbon, 
choose the Break icon, and then select 
Page. 

There are a number of additional media 

elements that can be added to a word pro-

cessing document to enhance its visual dis-

play. These are covered in the next chapter 

as well as in Section III, which provides 

more detail on adding and using visual 

enhancements.

Adding a Cover Page 
An optional but commonly used docu-

ment element is a cover page. A cover page 

provides the title and author information for 

a document. A title page can also provide an 

abstract for the document; an abstract is a 

short paragraph or a few sentences summa-

rizing the document contents or new ideas 

presented in the work. There are a variety 

of predefined cover pages available in Word.

To add a cover page to your report in 

Word 2013, choose Cover Page in the Insert 

ribbon. This will open a menu to select the 

cover page style you want to use. You can 

8.5.1

publications and larger organizations, but it 

is beneficial to know where to access these 

items if you need them. These optional 

document elements include an index, water-

marks, borders, cover pages, blank pages, 

and a table of contents.

Some common elements you may want 

to use to enhance your document are the 

following:

•	Watermarks—A watermark is a 
visual element on the pages of your 
document to signify either owner-
ship or a certain classification for the 
document (such as Confidential or 
Do Not Copy). You can create your 
own watermark or use an existing 
logo for an organization or business 
so that any document created with 
the watermark will be imprinted with 
the logo, identifying ownership. To 
add a watermark to your document in 
Word 2013, select the Design ribbon 
and choose Watermark; from here you 
can select a predefined watermark 
or select Custom Watermark to build 
your own. In Word 2011, you can add 
a watermark by selecting the Insert 
menu and choosing Watermark.

•	Borders—Adding a page border may 
be useful depending on the type of 
document you are creating. Page bor-
ders are most often seen on fliers and 
personal memos; they are not gener-
ally used in professional publications 
unless they are highlighting a particu-
lar element of text like an abstract for 
the document. To add a border to your 
page in Word 2013, select the Design 
ribbon and choose Page Borders. This 
will open a dialog box that allows you 
to select the type of border you want 
for your page and choose the width 
and style for it. To add a page bor-
der in Word 2011, select the Format 
menu, choose Borders and Shading, 
and then select the Page Border tab 
on the dialog box that opens.
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a demonstration, but a short report like the 

one presented here would be better served 

with a header on the first page rather than 

a cover page.

Adding a Table 
of Contents

Another common element to include in 

your document is a table of contents. This is 

not necessary for the short example report, 

but it is helpful for quick reference in longer 

documents. The table of contents is created 

automatically in Word based on the use of 

the header styles mentioned earlier.

To insert a table of contents into your 

document, you must first highlight where 

you want it in your document. A table of 

contents is typically located before any of 

the actual document content between the 

cover page and the first section of the mate-

rial. In Word 2013, you insert a table of con-

tents by selecting the References ribbon and 

choosing the Table of Contents icon. This 

opens a drop-down menu of predefined 

options for your table of contents; you can 

also select Custom Table of Contents at the 

bottom of this menu to access the dialog 

box shown in Figure 8.17. This dialog box 

allows you to set up the number of head-

ing levels you want to include and to adjust 

certain visual elements, such as the char-

acter used to link the section heading and 

8.5.2

also use this menu to delete the current 

cover page. In Word 2011, you insert a cover 

page by selecting Cover in the Document 

Elements ribbon. When you add a cover page 

in Word 2011, a small menu icon is placed 

on the page to allow you to click and select 

Remove Cover Page. An example cover page 

with this icon active is shown in Figure 8.16.

Once you have selected the cover page 

you want to use, you can start entering infor-

mation in the predefined text boxes. This 

is similar to completing the resume from a 

document template in the previous chapter. 

You should at minimum include a title and 

the document ownership, whether it is an 

individual author or the company that owns 

the document material. Remember that a 

cover page should only be used when neces-

sary. It is included in the example report as 

 FIGURE 8.16
Example cover page with Word 2011 Cover Page 
menu active

A TABLE OF CONTENTS is a list of 
chapter headings or major content divi-
sions and the page numbers on which they 
are located. This allows for quick navi-
gation of large documents to find desired 
elements and sections.
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document. You add an entry to the 
index in Word 2013 by selecting the 
Mark Entry icon on the References 
ribbon. You then click Insert Index to 
access the Index tab of the dialog box 
shown in Figure 8.17 to customize 
the index display in the text. To add 
an entry to the index in Word 2011, 
select the Insert menu, choose Index 
and Tables, and select the Index tab 
in the open dialog box; you can then 
click the Mark Entry button to enter 
the index entry information. You can 
add your index to the document from 
this same dialog box.

•	Table of Figures—The table of figures 
is based on the captions that you 
add to your document. This works 
similarly to the table of contents by 
automatically determining the page 
number on which the captions reside. 
To insert a table of figures in Word 
2013, select Insert Table of Figures 
on the References ribbon. You can 
update an existing table of figures by 
selecting the Update Table icon on the 
Captions panel in the References rib-
bon. In Word 2011, you add a table of 
figures by choosing the Insert menu, 
selecting Index and Tables, and choos-
ing the Table of Figures tab in the 
dialog box. The table can be updated 
if new captions are added by selecting 
the table, pressing the Control key, 
and choosing the Update option.

•	Table of Authorities—A table of 
authorities is a list of references in a 
legal document. For most works, you 
will not need to create one of these, 
but the option is available in Word. 
To add a citation in Word 2013, you 
can use the Mark Citation icon on 
the Table of Authorities panel of the 
References ribbon. To insert the table 
of authorities, use the Insert Table 
of Authorities icon on the References 
ribbon. The Update Table icon in 
the Table of Authorities panel can be 
used to update the table later as the 

the page number. The predefined options 

for the table of contents in Word 2011 are 

available from the Document Elements rib-

bon or you can click the Options icon on 

the same panel to open the dialog box for 

customizing your own style. You can also 

open this dialog box by selecting the Insert 

menu, choosing Index and Tables, and then 

selecting the Table of Contents tab in the 

dialog box that appears.

If you continue to edit or develop your 

document after you have added the table 

of contents, you can update it to reflect the 

current headings included in the text or to 

adjust the page numbers. In Word 2013, 

select the Update Table icon on the Table of 

Contents panel of the References ribbon to 

perform this task. In Word 2011, select the 

Update icon located on the Table of Contents 

panel of the Document Elements ribbon.

In addition to the table of contents, 

there are three other document elements 

of note that are similar. All of these are 

optional and may or may not be necessary 

for your document:

•	Index—An index is a listing of key 
terms and concepts and where 
they are located throughout your 

 FIGURE 8.17
Table of Contents dialog box in Word 2013
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CHAPTER SUMMARY
This chapter covered the common use of word processing software 

for constructing reports and articles. The document elements covered 

in this chapter are used in a variety of other publications including guidelines, 

policies, and reports for companies and organizations. You should now be 

familiar with most of the functions of the word processing software you are 

using. This includes the use of external references, formatting styles, and the 

handling of images within your document. The next chapter will cover advanced 

features of the software and the handling of additional media elements including 

equations and symbols. An example of the completed report for the chapter is 

shown in Figure 8.18. You can also view the report by opening the MyReport 

document. 

document is edited. In Word 2011, 
select the Insert menu, select Index 
and Tables, and then choose the Table 
of Authorities tab in the dialog box. 
The options to mark a citation and 

insert the table are in this dialog. You 
can update the table by selecting the 
table, pressing the Control key, and 
choosing the Update option.

 FIGURE 8.18
Completed example report

on the dvd
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CHAPTER KNOWLEDGE CHECK
It is only important to evaluate sources from the Web; any printed source can be trusted.

 A. True

 B. False

Every document you create should have a table of contents.

 A. True

 B. False

The following document elements support automatic updates of their content to account for 
document changes in Word except:

 A. Table of contents

 B. Index

 C. Cover page

 D. Table of figures

 E. All of the above

 F. None of the above

The only difference between footnotes and endnotes is their placement within the document.

 A. True

 B. False

The following are common citation styles for a manuscript except:

 A. MLA

 B. Chicago

 C. ABA

 D. All of the above

 E. None of the above

A source should be cited whenever it is used for an idea even if the source is not directly quoted in 
the text of the document.

 A. True

 B. False

1

2

3

4

5

6
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The following are possible values for text wrapping around an image:

 A. In line with text

 B. In front of text

 C. Behind text

 D. All of the above

 E. None of the above

To add an item to the index of a document, you must manually add it as an entry; the index is not 
constructed automatically from the text.

 A. True

 B. False

You can edit existing styles and create new styles for formatting text beyond what is predefined in 
the word processing program.

 A. True

 B. False

Headings are used to construct the table of contents for a document and can be used to jump 
quickly to a section of the document in the Navigation pane.

 A. True

 B. False

7

8

9

10

CHAPTER REVIEW QUESTIONS
Define and contrast a typeface and a font.

Explain the difference between text effects and styles. How can these be used to create a 
professional document?

How do you add a new style to Microsoft Word? Explain the steps used to perform the action.

Define and explain the term typography in your own words. How is typography used to change the 
appearance of a document? (Please be sure to use the terminology used throughout the chapter).

Define and compare the difference between setting a layout and margins within a Word document.

1

2

3

4

5
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Please list the steps needed to access the page layout options in Word 2013 or Word 2011. When 
would you need to access this option?

List the steps needed to insert a cover page into your document. When is this item necessary to 
include?

Discuss and explain the differences between a Table of Contents and a List of Figures. List the 
situations when each might be used.

Define and explain the idea of a Watermark. What are the steps necessary to insert one into your 
document and what are situations that could warrant the use of this feature?

Provide examples of when you might use page breaks in a document and describe how they relate 
to the Table of Contents feature.

6

7

8

9

10

PRACTICE EXERCISES
Use word processing software to construct a two- to three-page report on evaluating sources. Make 
sure you add citations for the sources you use to gather your information and include a bibliography 
in your document.

Construct an outline for a research project of your choice. The document should have at least four 
level one headings with two to three subheadings each. Add a cover page to the document with a 
title, a blank page separating the cover from the document content, and a table of contents for the 
document. Add a page break after the table of contents so the actual content starts on a new page.

Draft a one page report on the history of either the typewriter or the QWERTY keyboard. Each 
paragraph should detail the significant developments and increase in mechanization or evolution to 
the computer environment. Add a header with your last name and format the report with 1.5” 
margins on the left, right, and bottom of the page.

Create a document with two column format and 2” margins on each side of the page. Add a header 
to the document with your name and the date the document was created. Now use the entire 
alphabet to create sentences with proper punctuation in your document. The text should be in 
complete sentences, but the sentences do not have to relate to each other. The key element is that 
you use each letter at least once in your document within a word used properly in a sentence.

Create a title page for a marketing proposal for a new product you want to sell to a large business. 
The target audience is upper management in a large organization, so it will be necessary to place an 
executive summary on the title page itself so the group can understand what is being covered in the 
report. Choosing the right kind of layout and presenting your content to your intended audience on the 
cover page should be the primary focus of this exercise even above the product you are proposing.

1

2

3

4

5
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CHALLENGE EXERCISES
You were already asked to choose a research topic and construct an outline. Using this same topic, 
begin searching the World Wide Web for sources. Compile a list of 5–6 references and assess the 
validity of those selected sources. Using an outline document answer the following questions for 
each reference: Who is the author of the site? What are some of the author/organization’s other 
publications? What is the site extension and domain name of the site? Does the site use references 
and cite other sources? If so, what are they? When was the site last updated, and what was the 
original publication date? Does the site provide objective information?  

Locate an article using your school’s online library or find one from the World Wide Web. Print off 
the article and label each Microsoft Word feature that the article used. Then write a 500-word report 
on how the author improved his article using any number of the Word features. Additionally, make 
recommendations on what features the author could have included. Make sure to explain the 
feature’s function, how to use it, and how it would enhance his article.  

Choose a three to five page article that does not already include a table of contents. (If your article 
from the previous exercise does not already have a table of contents. you may reuse it for this 
exercise). Read through the article, and then use Microsoft Word to construct a table of contents 
and index appropriate for your selected article. Then, write a short 150-word document explaining 
what a table of contents and index are, and how they can be constructed.

Construct a brief summary of the qualities of a credible source for a document. In your review, 
consider how the date of the publication affects the quality of the information in the source. What 
are the qualities the author should possess to be taken as credible? How does professionalism 
affect credibility? How do these considerations apply to developing a research document?

Create a new document to answer the following questions. How can columns be used to present 
information more effectively or more efficiently? How should you decide when to apply columns to a 
document? Are they only reserved for certain types of information or documents? When might a 
Landscape layout be utilized in a document? When would you change the size of the document to 
something other than the standard 8.5” by 11” size?

1

2

3

4

5
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CHAPTER  

9
Advanced Features of 
Word Processing

IN THIS CHAPTER

This chapter covers the use of more advanced features of word processing 

documents. Most of these have specific applications depending upon the 

nature and format of the document you are constructing, but it is beneficial 

to understand how they work and where they can be found regardless of your 

primary use of word processing software. You will learn about advanced features 

such as Mail Merge, additional document elements, and document editing and 

review. At the completion of this chapter, you will be able to:

●	Complete a mail merge

●	Construct equations using the equation editor

●	Insert and manage tables in a document

●	Add symbols and shapes

●	Use the tracking and review options for document 
editing

Microsoft Office 
2013/365 and 

Beyond
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are called MyMergeDocument 

and MyMergeList, respectively. 

As a first step in the process, you 

should open MyMergeDocument in your 

word processing software and change the 

generic contact information at the top and 

after the signature line to reflect the busi-

ness venture you want to advertise. Do not 

add any contact information for the recipi-

ent; this will be done via the list of recipi-

ents in the companion spreadsheet. You do 

not need to open the spreadsheet document; 

it will automatically be referenced by the 

wizard used to complete the project. Even 

though the results are the same, the func-

tionality for performing a mail merge is sig-

nificantly different in Word 2013 and Word 

2011, so feel free to choose the section that 

applies to you.

Mail Merge in 
Microsoft Word 2013

In Word 2013, all of the functionality 

for performing a mail merge is found in the 

Mailings ribbon shown in Figure 9.2. This 

ribbon provides you the ability to create 

new documents for the mail merge and to 

select recipients. You can also edit the merge 

9.1.1

MAIL MERGE
One of the tasks for which you will need 

word processing software is a Mail Merge. In 

business, you will often encounter the situa-

tion in which you want to send personalized 

copies of the same letter to a large number 

of recipients. The Mail Merge functionality 

in word processing allows you to perform 

this task with just a few steps. You should 

first create the document you wish to send 

to your recipients and then organize the 

list of contacts to which you want the doc-

ument sent. Mail Merge is capable of con-

structing documents you can print directly 

and either printing labels for use on special 

paper to adhere to envelopes or printing the 

envelopes themselves. Most word process-

ing applications have a wizard to guide you 

through this process.

For this chapter, you will use an exist-

ing set of contacts to construct a mail merge 

inviting potential investors to a big presen-

tation for your new company. The example 

letter and the list of recipients are shown in 

Figure 9.1. These two files are included with 

the companion resources for this text; they 

9.1

MAIL MERGE is a function in word processing 
software that allows you to construct form let-
ters, identical documents that are personalized 
to individual contacts for fast mass mailing or 
printing. 
A WIZARD in software is a form of assistant 
added to a software program to guide you through 
a complicated process by asking for small ele-
ments of input at a time; this typically breaks 
down larger tasks into manageable step-by-step 
instructions.

on the dvd
 

 FIGURE 9.1
Example letter and recipient list for Mail Merge
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document in the Projects folder; then choose 

Use the current document and select Next: 

Select Recipients.

In the next step, you will select recipi-

ents for your document. You can create a 

new list of recipients, choose from your con-

tacts in Outlook, or select recipients from a 

file or database. In this case, select Use an 

existing list and choose the Browse icon to 

navigate to the MyMergeList spreadsheet 

document. When you have opened this docu-

ment (and selected the only sheet in the doc-

ument as the data source), you can choose 

the option to Edit recipient list to select the 

contacts from the list you want to include in 

the merge. The Mail Merge Recipients dia-

log box is shown in Figure 9.4. You can select 

the Name field and sort them in ascending 

(A to Z) order; you should retain all of the 

recipients in the list for this example, but 

result after the merge is complete. For this 

example, open the MyMergeDocument file, 

open the Mailings ribbon, select Start Mail 

Merge, and choose Step by Step Mail Merge 

Wizard.

When you activate this command, a 

Mail Merge pane will appear on the right 

side of your interface as shown in Figure 

9.3. There are six steps to the Mail Merge in 

Word 2013. The first is choosing the docu-

ment type you want to create; in this case, 

you want to select Letters. You should, how-

ever, take note of the other options avail-

able. For business mailings, it is common 

to need both letters and either envelopes or 

labels to accompany them. When you have 

made your selection, choose Next: Starting 

Document.

The options for selecting your starting 

document include the document in which you 

are currently working (which is the option 

used here), a new document from a tem-

plate, or an existing document. You should 

be working within the MyMergeDocument 

file. Remember to save the changes to your 

 FIGURE 9.2
Mailings ribbon in Word 2013

 FIGURE 9.3
Mail Merge pane in Word 2013

Notice that you have the option within the wizard to 
navigate to the next step or the previous one. If you 
make a mistake, you can always go backward in the 
wizard to correct it before the final step.

 FIGURE 9.4
Mail Merge 
Recipients dialog 
box in Word 2013
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<<AddressBlock>> in your document; this 

is a merge field and it will change based on 

the information obtained from each record 

in your recipient list. Next, add a greeting 

line to your document. In Word 2013, the 

greeting line will replace the entire line, 

so you should remove the existing “Dear,” 

from your document and place the greeting 

line entry there. 

If you want to add any additional 

fields to your document from the recipient 

list (such as an account number or email 

address), you can select them individually 

by choosing the More items link. To add spe-

cific fields from your recipient list, use the 

Insert Merge Field icon from the Mailings 

ribbon. You can also add electronic postage 

to your envelopes or labels if you have the 

proper software and accounts set up from 

this step in the wizard. When you have 

finished adding fields to your document, 

choose the Next: Preview your letters link in 

the Mail Merge pane.

you can uncheck the selection box next to 

recipients you do not want to include in a 

real situation. Select Next: Write your letter.

Step 4 of the process is to edit your docu-

ment by adding the merge fields. You should 

start by inserting an address block beneath 

the date entry in your document and place 

it all the way to the left above the greeting 

line. You can add an address block by select-

ing the Address block link, which will open 

the Insert Address Block dialog box in which 

you can select how you want your recipient’s 

address to appear. This dialog box is shown 

in Figure 9.5.

When you have chosen your for-

matting options, you will see the text 

 FIGURE 9.5
Insert Address 
Block dialog box in 
Word 2013

You will need to use the Match Fields button to get 
your names to display correctly. Select Name as the 
value for the First Name in order to get the automatic 
completion to work. You will know it is working cor-
rectly when you see one of your recipient’s names in 
the preview display on the dialog box.
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•	Edit Individual Letters—This lets 
you edit letters. For example, if you 
wanted to include specific information 
for one or more of the recipients that 
was not in the list from which you 
selected the merge information, you 
could add it manually in the docu-
ment and print the result when you 
are finished. You can also use this fea-
ture to save a copy of the personalized 
mailings as a record of what exactly 
was sent.

Electing to edit individual letters will 

create a new document with the fields com-

pleted. The fields will no longer register as 

merge fields but instead will act as static 

text. You can still save the document with 

the merge fields for later use. In this case, 

save it as MyMergeDocumentCompleted. 

You can use the Mailings ribbon in this doc-

ument to adjust the properties of your merge 

fields, preview the results for recipients, or 

output a new merge result. An example of 

Step 5 provides a preview of your let-

ters. You can use the left and right arrows 

to see how your results will look for each of 

the recipients in your list. You can go back-

ward in the process to correct any errors. 

Formatting changes will apply to the merge 

fields just as they will to any other document 

element, so you can adjust the formatting as 

necessary. Note that the separator between 

the lines in the address block will always be 

a paragraph return. When you are satisfied 

with the results, choose the Next: Complete 

the merge link.

The final step of the Mail Merge wizard, 

Step 6, allows you to complete the merge 

and utilize the results. The options provided 

include the following:

•	Print—This prints all of the letters 
with addresses selected from the data 
list you created earlier.

 FIGURE 9.6
Completed Mail 
Merge example
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arrange the next line so it contains City, 

a comma, State_or_Country, a space, and 

then Postal_Code. Notice that the fields you 

drag into the document are surrounded by 

less-than and greater-than signs (such as 

<<Name>>); these indicate the fields are 

the completed document for the first recipi-

ent in the list is shown in Figure 9.6.

Mail Merge in 
Microsoft Word 2011

In Word 2011, the Mail Merge Manager 

is the tool you use to complete a Mail Merge. 

You activate this by selecting the Tools 

menu and choosing Mail Merge Manager, 

which will open the dialog box shown in 

Figure 9.7. There are six steps to complet-

ing a Mail Merge in Word 2011. The first 

is to select the document type you want to 

create. In the example, Form Letters was 

selected; this uses the current document 

as a template for the merge, which should 

be the MyMergeDocument file. You can also 

select Labels or Envelopes if you need to cre-

ate accompanying material for a business 

mailing.

The second step is to select your recipi-

ents. You can create a new list or use an 

existing document or contact list (such as 

an Office Address Book or Apple Address 

Book) as a base for your recipients. Choose 

Get List, select Open Data Source, select 

the file MyMergeList, and then choose 

Entire Worksheet to include all of the data 

it contains.

Unlike Word 2013, the manner of add-

ing merge fields to your document in Word 

2011 is to click on the field you want to add 

and drag it to the desired location in the 

document. To create the proper address 

block, drag the fields Name, Address, City, 

State_or_Country, and Postal_Code into 

your document. Name and Address should 

each occupy their own line. You should then 
 FIGURE 9.8

Merge fields added to document in Word 2011

 FIGURE 9.7
Mail Merge Manager in Word 2011

9.1.2
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ADDITIONAL 
DOCUMENT 
ELEMENTS 

Word processing documents can include 

a number of visual elements beyond the 

typical text and images. There are several 

quick enhancements you can add to your 

document to adjust its visual style or utilize 

callouts within the main text. These include:

•	Text Boxes—A text box in Word is a 
standalone object containing keyboard 
entered text; it behaves inside the 
document similarly to the images you 
previously inserted. You can set the 
text box to have the same text wrap-
ping properties as an image, which 
is helpful if you want to add a quote 
or other note to your text to call it to 
the attention of your reader; these 
can enhance the visual style of the 
document without the use of graphics. 
Word 2013 has several options for text 
boxes that are available by choosing 
the Text Box icon on the Insert ribbon; 
you can choose a standard text box 
and format it yourself or use one of 
the predefined options available in the 
list. In Word 2011, you can add either 
a (horizontal) Text Box or a Vertical 
Text Box to your document from the 
Text Box icon on the Home ribbon. 
You can apply whatever formatting 
you like to the resulting text box, but 
there are no predefined options as 
there are in Word 2013.

•	Drop Cap—This is a visual enhance-
ment to a paragraph of text that can 
apply to the heading or first line of a 
paragraph. It sets the first letter of 
the text as an independent text box 
with a large print size that can be 
resized and formatted independently 
of the rest of the text. It is used to 
call attention to the paragraph and 
attract the eye of the viewer. This 

9.2merge fields that will be replaced with the 

text from the recipient list. You should then 

drag the Name field into the greeting line 

(to the right of Dear but before the comma). 

When you have finished adding the merge 

fields to your document, your result should 

be similar to Figure 9.8.

Step 4 is Filter Recipients, which allows 

you to define criteria to include or exclude 

certain recipients in the list. None of the 

recipients should be excluded in the exam-

ple, but this is helpful if you are using a large 

list from your contacts and wish to specify 

criteria for who should be included in the 

mailing. Step 5 is Preview Results. Click the 

View Merged Data icon to toggle whether 

the current record is shown in the docu-

ment or the generic merge field references 

are displayed. You can use the arrows here 

to scroll through the recipients to preview 

each of them in the document itself.

Step 6 is Complete Merge. This step 

allows you to send your results to the 

printer by using the Merge to Printer selec-

tion or to create a new document with all of 

the records appended for individual editing 

by using the Merge to New Document selec-

tion. You can choose whether you want to 

include all of the recipients or define a range 

of records you wish to use in the result. 

Defining a range can be helpful if you share 

printing resources and have hundreds of 

recipient letters to print.
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keyboard. Examples include foreign cur-

rency symbols, copyright symbols, and 

mathematical symbols. To insert a symbol 

in Word 2013, select the Insert ribbon and 

click the Symbol icon. A list of common sym-

bols will appear. You can select the More 

Symbols option to access a dialog box which 

allows you to select symbols from different 

languages. An example of this dialog box 

being used to insert the symbol for British 

pounds into the report on Jean Lafitte is 

shown in Figure 9.9.

In addition to currency symbols and let-

ters from other alphabets, there are a few 

unique fonts that contain symbol librar-

ies instead of text characters. These fonts 

include Wingdings and Webdings. You can 

use the Font selection box to choose these 

symbols to see what is available. You can 

also select the Subset selection box to choose 

technical symbols or foreign alphabets that 

do not have representation on your own 

keyboard. When you have selected the sym-

bol you want, click the Insert button to place 

it in line with your text.

is sometimes used in newspaper or 
magazine articles as a style choice. To 
activate this in Word 2013, select the 
text you want to enhance and choose 
the Drop Cap icon on the Insert rib-
bon and select whether you want it 
dropped into the paragraph of the text 
or into the margin. In Word 2011, you 
add a drop cap by highlighting the 
text to which you want the effect to 
apply, selecting the Format menu, and 
choosing Drop Cap.

Some of the more advanced examples of 

visual enhancements are SmartArt in Word 

and charts. SmartArt is a great way to con-

struct professional-quality graphics quickly 

using a bulleted list; because this is primar-

ily for a more encapsulated visual medium 

of presentation, the full description of con-

structing SmartArt can be found in Section 

12.2.4, “SmartArt.” Charts are visual pre-

sentations of data that must be created from 

a data source. In Office, the program that 

manages that data is Excel, so you should 

reference Section IV, “Spreadsheet Software 

and Microsoft Excel,” for a better under-

standing of how to construct charts. If you 

want to see how to create and insert a sim-

ple chart, see Section 12.2.3, “Charts.”

There are four remaining areas of 

visual enhancement for creating effective 

word processing documents. It is common 

to include symbols, equations, tables, and 

drawing objects in your document to vary 

the visual style and present your informa-

tion clearly. Each of these topics is described 

in the sections that follow.

Adding Symbols
Symbols are substitutions for a text 

character that cannot be found on a regular 

9.2.1

 FIGURE 9.9
Symbol selection in Word 2013
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When you click on any of these icons, a 

drop-down list will appear from which you 

can select the elements and formatting you 

need for your equation. The structures that 

you can select from these lists contain small 

boxes surrounded by dotted lines; these are 

the building blocks of your equation and you 

can think of the box as containing a set of 

parentheses in mathematics. Whatever you 

type inside of the box will become part of 

the structure. You can also nest structures 

within each other, which will be demon-

strated in the example. 

The other feature of the ribbon you 

should note is the ability to switch your 

equation from Professional to Linear for-

mat. Professional is the actual arrangement 

of symbols that you would see in a math-

ematics textbook; Linear is the arrange-

ment of the symbols and elements in a 

Editing Equations 
Word has a library of symbols that 

allows you to construct equations within 

your document. To add an equation in 

Word 2013, select the Insert ribbon and 

choose the Equation icon; in Word 2011, 

select the Equation icon in the Document 

Elements ribbon. When you choose the 

Equation icon, a drop-down list will appear 

with several common equations that you 

can insert and modify or you can choose 

Insert New Equation to create your own. 

For this example, you will construct the 

equation for finding the root of the qua-

dratic equation; this is commonly called 

the quadratic formula. When you insert 

an equation in Word and click within it, 

a context-sensitive ribbon will appear to 

help you construct and edit equations. 

In Word 2013, this is the Design ribbon 

for Equation Tools; in Word 2011, it is 

the Equation Tools ribbon, which chains 

off of the Document Elements ribbon. 

An example of the ribbon, the quadratic 

equation, and the completed solution for 

adding the quadratic formula is shown in 

Figure 9.10.

Equations are treated as unique objects 

in your document just like citations; by 

default, the equation is given its own line in 

the document. The context-sensitive ribbon 

for equations contains all of the common 

mathematical symbols, which you can sim-

ply click to insert. It also contains a variety 

of structures that can be used to format your 

equation such as Fraction, Script, Radical, 

Integral, etc. 

9.2.2

 FIGURE 9.10
Equation example in Word 2013

 FIGURE 9.11
Linear formatting for quadratic formula

To end equation entry, you must click outside of the 
equation box. Pressing the Enter key gives you a new 
equation line in the same formatting box.
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6. Beneath the radical symbol, type b – 
4ac in the formatting box.

7. Use the Script option Superscript to 
turn the b coefficient from the previ-
ous entry into b squared (this is the 
same procedure you used in the qua-
dratic equation).

Adding Tables
A table is a great tool to manage 

information in your document. Tables do 

not have the computational power of the 

spreadsheets found in Excel, but they can 

be effective for presenting a lot of infor-

mation in a small space. For instance, you 

can use a table to present a list of values or 

results, such as the comparison of different 

currencies shown in Figure 9.12. To insert a 

similar table in Word 2013, select the Insert 

ribbon and choose the Table icon; this will 

allow you to select the number of rows and 

columns you want the table to have. You can 

also select the Insert Table option from the 

submenu to access a dialog box that allows 

you to enter the number or rows and col-

umns you wish to include. Word 2011 has a 

separate Tables ribbon that you use to add 

tables to your document; click the New icon 

to select the number of rows and columns or 

select the Insert Table option to define the 

table parameters manually.

When you add a table to your document 

in Word 2013, two context-sensitive ribbons 

will help you format your table; these are 

9.2.3

single line. The Linear format automati-

cally adds parentheses to separate elements 

of the equation that are implied by the 

structures in the Professional display. The 

Linear format for the quadratic formula is 

shown in Figure 9.11. When you click the 

outer box around an equation, you will get a 

drop-down list that allows you to select the 

formatting.

The steps to construct the generic qua-

dratic equation are as follows:

1. Start the linear portion of the equa-
tion by typing a + bx + c = 0 in the 
equation editing box.

2. Add the exponent to the a coefficient 
by placing the cursor beside and to 
the right of the a and selecting Script 
and then Superscript. This will insert 
two formatting boxes into your equa-
tion. Type x in the base box and 2 in 
the exponent box.

The steps to construct the root solution 

equation are as follows:

1. After you insert a new equation, type 
x = in the equation entry box.

2. Choose Fractions and select Stacked 
Fraction from the list. 

3. Type 2a in the bottom box of the frac-
tion formatting.

4. Type –b in the top of the fraction 
formatting and insert the stacked +/– 
symbol from the available symbols.

5. Paste the symbol you inserted, 
choose Radical, and then select 
Square Root.

 FIGURE 9.12
Example table showing currency comparison

The equation editor in Word is for formatting and dis-
playing equations only. It cannot be used to compute 
or solve formulas.
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navigate by using the tab key? What happens 

when you press the tab key at the end of the 

table? Expand the table to accommodate the 

numbers from 1 to 15. Save your work.

Adding Shapes
In Word, you can add simple shapes 

to your document and format them as you 

would an image. These shapes are treated as 

objects within your document for which you 

can set the color and formatting as well as 

the placement and text wrap properties. To 

insert a shape in Word 2012, select the Insert 

ribbon and choose the Shapes icon. In Word 

2011, you add a shape to your document by 

selecting the Shape icon on the Home rib-

bon. The menu that appears is organized 

into categories rather than displaying all of 

the options at once. The list of these avail-

able shapes is shown in Figure 9.14.

When you insert a shape, a context-

sensitive Format ribbon allows you to adjust 

its format and properties, including the fill, 

9.2.4
the Design ribbon and 

the Layout ribbon for 

Table Tools shown in 

Figure 9.13. You can select a style to format 

your table and choose whether you want to 

include elements like a header row from the 

Design ribbon. The Layout ribbon allows 

you to format the alignment of the text 

within each cell and add or remove rows. 

Word 2011 contains most of the formatting 

options on the existing Tables ribbon; when 

you add a table to your document, however, 

the context-sensitive Table Layout ribbon 

appears, which contains commands for table 

cell management and alignment.

In the example in Figure 9.12, a header 

row is included and the table is formatted 

with the Light Shading option. Internal bor-

ders have also been added (via the Borders 

icon) to show the delineation between table 

cells. For an additional example of using 

tables for visual presentation, see Section 

12.2.2, “Tables.” The commands for adding 

borders and shading in Word 2011 are found 

on the Tables ribbon.

Activity 9.1—
Typing Tables

Create a new document called 

Activity9_1 and save it in the Activities 

folder. Add a table to your document with 

three rows and three columns. Enter the val-

ues 1 through 9 by entering one value in each 

table cell. Use the tab key to move from cell to 

cell. What is the sequence of cells when you 

 FIGURE 9.13
Context-sensitive Table 
ribbons in Word 2013

 FIGURE 9.14
Shapes menu in Word 2013

MSOffice-Beyond-CH09.indd   205 6/24/2014   9:57:16 AM



206 — Microso f t  Of f i ce  2013/365 and  Be yond

object) or by dragging the mouse from one 

end of the objects you wish to group to the 

other (only objects entirely within the drag 

area will be selected). When you have selected 

all of the objects you wish to group, you can 

activate the Page Layout ribbon, select the 

Group menu icon on the Arrange panel, and 

choose Group. You can now manipulate the 

entire set of objects as a single element. The 

objects within the group can still be individu-

ally edited by clicking directly on the object 

you wish to alter. You can see an example 

of object grouping in Figure 9.15. In Word 

2011, to create a group you can select multi-

ple objects in a document (when they are not 

part of the text layer) and open the context-

sensitive Format ribbon which expands off of 

the Home ribbon. The Group menu is located 

on the Arrange panel of the Format ribbon.

Documents in Word are organized by 

layers. You can visualize this by imagining a 

stack of paper clippings containing your ele-

ments that must be arranged so you can look 

down on the stack and see the visualization 

line, and other effects. By default, the shape 

is set to layer above the text of your docu-

ment, but you can adjust this property as 

well. Formatting shapes is covered in more 

detail in Chapter 10. In Word 2013, you can 

also use the Shapes menu to insert a draw-

ing canvas, which is configured as a docu-

ment object in line with your text where you 

can place multiple shapes; the entire canvas 

is treated as a single object.

Activity 9.2—Adding and 
Formatting Shapes

For this activity, you will add three cir-

cles to a document using the Shapes menu. 

You should format these so they are in front 

of the text in terms of layout, and they should 

fit inside of each other so that the largest is 

behind the middle size and the middle size 

is behind the smallest circle. Use the format-

ting ribbon for the shape objects and apply 

a different style to each one from the preset 

options. Save your work as Activity9_2 in 

the Activities folder you created.

ARRANGING 
AND GROUPING 
ELEMENTS

One of the tools for managing document 

content is the ability to group objects in a 

document and format them as a group. This 

will only apply to objects that are not in line 

with the document text; anything with a 

Text Wrap setting of In Line with Text can-

not be combined with other elements.  

You can select multiple objects by hold-

ing down the shift key and clicking each of 

them (clicking them again will deselect the 

9.3

 FIGURE 9.15
Example object grouping
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the elements in your document. You can see 

an example of this in Figure 9.16.

Under the Bring Forward icon, you can 

choose to move the object or group a single 

layer forward (which will by default move 

it past the next object above it in the stack) 

or to move it to the front, which places it 

on the top layer of the document (which 

can be seen as closest to the viewer). The 

Send Backward icon gives you the option to 

send the object or group back one layer in 

the document or send it to the back of the 

document (farthest away from the viewer). 

Office 2011 has a great visualization tool 

that demonstrates this concept visually as 

shown in Figure 9.16.

The other way you can change the posi-

tioning of an object or group (in addition to 

dragging it) is by changing the alignment of 

it. In Word 2013, you can select a predefined 

position from the Position menu icon from 

the Arrange panel of the Page Layout rib-

bon. You can also select one of the options 

of the elements you desire. The standard 

text layer can be considered the default mid-

dle of the stack.  

Activity 9.3—Layers 
and Groups

Create a new document and save it as 

Activity9_3 in the Activities folder. Use the 

Shape menu to recreate the object grouping in 

Figure 9.15. Use the formatting commands 

to style each circle you add. When you have 

recreated the group, add another circle and 

place it behind the group and add another 

circle and place it in front of the group. Now 

group all five circles at once. What happens 

when you dissolve the group by using the 

Ungroup function? What happens to the new 

circles if you send the group of three circles 

to the back of the document? Ungroup all of 

the elements and create a single group of five 

circles in your document. Save your work.

When you change the Text Wrap set-

ting on an object, you move it to a different 

layer within the document, whether that is 

in front of the text or behind it. There are 

two options on the Page Layout ribbon in 

the Arrange panel that allow you to change 

the layer on which your object or group 

resides; these are the Bring Forward and 

Send Backward icons.  

In Word 2011, you can reorder the lay-

ers of objects in your document by using 

the Reorder menu on the Arrange panel 

of the context-sensitive Format ribbon. 

In Publishing Layout View, the Reorder 

Objects menu selection opens a layer by 

layer view of your document which allows 

you to click and drag the layers to rearrange 

 FIGURE 9.16
Layer visualization in Word 2011

ALIGNMENT in terms of layout is the relative 
placement of an object with respect to the overall 
environment, which in this case is the slide.
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toolbar; select the Styles tab to view the 

styles used in the current document. You 

can even color-code where the styles are 

applied by selecting the Show Styles Guides 

checkbox. You can apply styles directly from 

this panel or simply review the existing 

formatting.

Document Comparison
If you have multiple versions of a docu-

ment that you need to integrate, you can 

perform a document comparison to view 

the changes and decide whether you want 

to keep them. These versions do not have to 

have the same author so you can perform a 

comparison after you have sent your docu-

ment to someone else for editing 

whether or not they have tracked 

their changes. As an example, you 

can use the MyReport document and the 

MyReportVersion2 document to perform an 

example comparison. 

To perform a document comparison in 

Word 2013, select the Review ribbon and 

choose Compare. There are two options 

available here: Compare and Combine. Both 

of these will create a new document that 

merges the two versions together. Compare 

is used to show the differences between 

versions from the same author whereas 

Combine is intended for documents from 

multiple authors. In Word 2011, you can per-

form a document comparison by selecting 

9.4.1

from the Align menu and choose whether 

you want it to align to the page or align to 

the margin. Align to Page aligns the element 

to the entire page size regardless of the mar-

gin settings for the page. Align to Margin 

realigns the object to the orientation of the 

page within the margin settings.

EDITING EXISTING 
DOCUMENTS

As mentioned earlier, you can use the 

File menu to open existing documents. 

This includes not only the documents you 

construct but also any documents on your 

computer that come from someone else. The 

Open command launches a dialog box that 

allows you to select the document you want 

to review or edit. Word has some excellent 

tools in the Review ribbon, shown in Figure 

9.17, that are used to edit and review docu-

ments. This ribbon exists in both Word 2013 

and Word 2011, although the commands 

available differ slightly.

Word 2013 and Word 2011 have different 

options for reviewing the formatting that is 

applied in your document. In Word 2013, you 

can show or hide formatting marks by click-

ing the Show/Hide Paragraph icon on the 

Paragraph panel of the Home ribbon. In Word 

2011, you can use the Reveal Formatting tool 

available from the View menu to click inside 

the document and view the formatting that 

is applied at that location. 

Word 2011 also allows you to manage 

the styles used in the document with the 

Toolbox available from the Quick Access 

9.4

 FIGURE 9.17
Review ribbon in 
Word 2013

 FIGURE 9.18
Compare Documents dialog box in Word 2013

on the dvd
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documents will be tracked as changes that 

must be either accepted or rejected, no mat-

ter which version you use. This is the topic 

of the next section where you will learn to 

manage tracked changes in a document.

Track Changes
When you use Track Changes on a 

document, every change you make will be 

registered in a different colored (tradition-

ally red) markup. Words or characters that 

you delete will traditionally have a striketh-

rough effect and new words will be shown in 

the different color with an underline. This 

allows you to monitor changes or record 

them for someone else to review. If you are 

editing someone else’s document, it is a 

courtesy to track changes so they can iden-

tify your edits.

To enable Track Changes in Word 2013, 

select the Review ribbon and choose the 

Track Changes icon; this is a toggle so it is 

active when it is highlighted. In Word 2013, 

9.4.29.4.2

the Tools menu, choosing Track Changes, 

and then choosing Compare Documents. 

The interface for choosing the documents is 

shown in Figure 9.18. This process will cre-

ate a new document as a result, so neither of 

the files needs to be open.

In Word 2013, the result of the com-

parison will display in a Reviewing pane 

that includes a top and bottom comparison 

of the documents beside the new merged 

document as shown in Figure 9.19. You can 

toggle the Reviewing pane from the Review 

ribbon, and you can manually close the ver-

sion documents in the comparison. If you 

wish to retain the older versions, save your 

file with a new document name.

Word 2011 simply creates a new docu-

ment based off of the original document 

where the updates in the revised version 

are tracked as changes. The Sidebar will dis-

play the Reviewing pane, which gives you a 

list of the changes that are included in the 

document. The differences between the two 

 FIGURE 9.19
Document 
comparison in 
Word 2013
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the markup will only be indicated on the left 

side of the document by default, allowing you 

to see the contents of the document clearly 

without the clutter of the strikethrough, 

color, and underline notations. You can use 

the submenu to customize options for track-

ing the document changes or edit the name 

you wish to use for the change tracking. In 

Word 2011, you can enable Track Changes 

on the Review ribbon by moving the slide 

bar from OFF to ON. You can slide it back 

to OFF to disable Track Changes.

You can navigate from one tracked 

change to another using the Next and 

Previous icons on the Changes panel of the 

Review ribbon. If you want to keep the cur-

rently active change, select the Accept icon. 

If you want to remove the change, select 

the Reject icon. These icons also have sub-

menus attached that will allow you to accept 

or reject all of the changes in the document 

without going through them one by one. 

Word 2011 has these options on the Changes 

panel of the Review ribbon, along with a tog-

gle icon for displaying the Review pane.

 FIGURE 9.20
Example comment 
in Word 2013

Examine the document that was cre-

ated from merging the two versions of the 

report. Practice reviewing changes by navi-

gating through the document and deciding 

whether you want to accept or reject the 

changes as appropriate. You should keep 

any beneficial change and reject any that 

are not wanted. Be sure to retain the con-

cluding paragraph in the document.

Comments
Another way to mark a document for 

potential change when editing is to use com-

ments. A comment in word processing is 

a note about the document that is written 

to the author or the editor of a document. 

You can use comments to identify areas of 

the document that may need to be changed 

or clarified. Comments identify the person 

who created them either by name or by ini-

tials, so multiple people can add comments 

to the same document and you can still iden-

tify the source of the comment. Comments 

are a helpful tool for collaboration and ver-

sioning in a document. They appear in the 

document margin to the right so they do 

not impede the visibility of the main text. 

Unlike Track Changes, you do not accept or 

reject comments; instead you simply add or 

remove them.

In Word 2013 and Word 2011, you add a 

new comment by selecting the text on which 

you want to comment, activating the Review 

9.4.3

Enabling or disabling Track Changes does not affect 
any prior changes. If you were tracking changes and 
turned the function off, you will still need to accept or 
reject the changes that were tracked. Similarly, if you 
were not tracking changes, turning the functionality 
on will not affect prior alterations that were made 
without Track Changes active.
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ribbon, and choosing New Comment (or New 

on the Comments panel in Word 2011). The 

Next and Previous icons in the Comments 

panel allow you to move from one comment 

to another. To delete a comment, click on the 

comment you want to remove and select the 

Delete icon; the submenu of the Delete icon 

also allows you to delete all of the comments 

in the document, which should only be done 

once they have been reviewed. An example 

of a comment is shown in Figure 9.20. 

You should practice adding comments 

to and deleting comments from the report 

document that resulted from the document 

comparison process. In Word 2013, when 

you activate the Reviewing pane you can see 

the comments included in the document. 

You can also select Show Comments from 

the Comments pane on the Review ribbon. 

In Word 2011, the comments added to the 

document will appear in the Review pane 

whenever it is active.

Activity 9.4—Comments
Create a new document called Activity9_4 

and save it in the Activities folder. Enter 

at least eight lines of text. Select two words 

from your document and add a comment to 

them. You can type random text in the com-

ment. What elements are contained in the 

comment? How can you show and hide the 

comment within the document and what text 

is highlighted for the comment? Now select 

a new location in the document and click the 

mouse to place the cursor without adding 

text. Add another comment to your document 

without any text selected. What text is high-

lighted for the new comment? Use the com-

ment navigation tools on the ribbon interface 

to navigate between the two comments and 

then delete the second comment. Save your 

work.

CHAPTER SUMMARY
This chapter covered some of the more advanced features you can use in word process-

ing documents. Word processing is the primary means of creating print documents in the 

workplace. Part of the business practice may be to send out periodic mailings for which Mail 

Merge can provide a tremendous shortcut. There is a lot of overlap between word processing 

and presentations because both are primarily visual media; however, one of the key differ-

ences is the interactive nature of presentations and the static nature of printed documents. 

Establishing visual appeal and clarity is necessary in both, but generating visual interest and 

document flow in word processing is much more important because you must convey your 

ideas solely through what is presented on the page. The next section of the text focuses on 

constructing presentations; you should notice the common elements between the two pro-

ductivity applications.

Comments attach to a particular selection of 
text in the document. You can select the text 
to which you want the comment to apply, but if 
you do not select the text, it will attach to the 
last word before the current cursor location.
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CHAPTER KNOWLEDGE CHECK
When selecting recipients for a Mail Merge, you must only include the fields for recipient information 
you will use in your document; any additional fields will cause errors in the merge process.

 A. True

 B. False

You cannot personalize individual documents in a Mail Merge; the results of the merge can only be 
sent directly to the printer or to email.

 A. True

 B. False

Special fonts exist that allow you to substitute symbols for the letters on your keyboard.

 A. True

 B. False

The following applications are capable of including formulas formatted in traditional mathematic 
notation:

 A. Microsoft Word 2013

 B. Microsoft Word 2011

 C. Microsoft Word Web App

 D. All of the above

 E. Both A and B

 F. None of the above

Text wrapping can apply to objects other than images.

 A. True

 B. False

Comments added to a document will not be retained when the document is sent to another 
recipient; they are strictly for your own use.

 A. True

 B. False

Changes made to a document while Track Changes (or Record Changes) was not active will not be 
retained for later acceptance or rejection.

 A. True

 B. False

1

2

3

4

5

6

7
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Activating Track Changes (or Record Changes) will affect all changes made to the document, 
including changes made before Track Changes was activated.

 A. True

 B. False

The standard options for resolving a tracked or recorded change to a document are as follows:

 A. Accept the change

 B. Reject the change

 C. Move the change to a comment

 D. All of the above

 E. Both A and B

 F. None of the above

Symbols (or special characters) are treated as images in your word processing document.

 A. True

 B. False

8

9

10

CHAPTER REVIEW QUESTIONS
Give an example where a table would summarize data better than using a text explanation other 
than the ones presented in the chapter. Would this data also lend itself to being displayed in a 
chart? Which one is a better data display and why?

Word allows you to include a special Object in your document (from the Insert menu in Word 2013), 
which is either an included file or a reference to another file. These files can contain any file from 
your operating system’s file structure. When would it be a good idea to include such objects in your 
document? When would it be a bad idea to include them? What precautions should you take before 
opening a file included in a document as an object from an unknown source?

The productivity software PowerPoint that is part of the Microsoft Office suite allows you to add 
video and sound to your documents but Word does not support this inclusion (other than Word’s 
Object inclusion which shows only an icon and name). Why would these types of media be excluded 
from a Word document?

Drop Cap is a type of emphasis that was placed on the first letter of an article in a newspaper, but it 
is largely unused today. What is the history and proper usage of the Drop Cap emphasis?

2

3

4

1
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What are the benefits and dangers of using specific fonts as substitutions for symbols (such 
as Webdings or Wingdings) in a document? What are the alternatives for creating symbols in a 
document?

Tracking changes and using comments are two common ways in which collaboration is handled in 
word processing documents. Are either of these sufficient by themselves or do the two techniques 
complement each other in use? Justify your answer with examples.

Give at least three examples of documents used in business or education where you would need to 
collaborate among different authors. What would you suggest as a strategy for sharing the 
document and keeping control of the versioning among authors making changes to the document?

In addition to just tracking changes in the text of a document, Word also tracks changes to 
formatting and other modifications to the document. You must accept or reject these changes as 
well. What are the different areas of document modification which can be tracked in Word (you can 
find these under the Show Markup menu on the Review ribbon) and why would each of them be 
useful?

What are the benefits and drawbacks of the Accept All Changes and Reject All Changes options for 
resolving different versions of a document? Justify your answer with examples.

Word 2013 allows you to add Ink Comments (drawn with the mouse as shapes over your document) 
to your document as well as the standard comments described in the chapter. What is the benefit of 
using ink comments in a document? Would this type of comment be useful for utilizing handwritten 
proofreading symbols? Justify your answer with examples.

6

7

8

9

10

PRACTICE EXERCISES
Construct a set of mailing labels or envelopes to accompany the letters you have constructed in this 
chapter. You can use the MyMergeList file, but you should include both the recipient address and 
the return address. Make sure your page layout is formatted correctly for the type of document you 
want to print.

Make at least five changes to either the report you constructed in Chapter 8 or the resume you 
constructed in Chapter 7. Use a document comparison to view the changes. Add at least two 
comments to the document as well. Save the file with the markup.

Create a table within a document to track the temperature high and low for five days (you can get 
this information from a weather service). Format the table with a header row containing the city 
name and the days of the week for which the temperature is tracked and choose a table style. Add 
the weather information for another city to your table. Merge the cells so that the city name spans 
both the temperature high and low for each city. What types of data are suited for display in a table?

2

3

5

1
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Create a new document and add a table to it with 7 rows and three columns. The columns should 
be: Symbol, Name, and Meaning. Now add one symbol to each row using the Symbol insertion 
ability in Word. For the name entry for each symbol, give the text description of the symbol name. 
For the meaning entry, describe its usage. Format the table using the table styles formatting 
commands. Add a header to the document and save your work.

Activate Track Changes in your document and enter at least six lines of type. Deactivate Track 
Changes and type another six lines. Activate Track Changes again and review the document 
changes using the navigation. Is there any way to detect the changes made when the Track 
Changes was off? How does this affect collaborative documents?

4

CHALLENGE EXERCISES
Use the equation editor in Word to construct Einstein’s equation for relating matter and energy 
(E=mc2). Use the building blocks to create the equation and display it in both Professional and 
Linear format. What is the difference between the two display modes? Explain the tools you used to 
construct the equation.

Arrows are a kind of shape that behaves differently from most. With an arrow, you can attach one or 
both ends of the arrow shape to one of the grab points around the edge of the shape (that can 
typically be used to modify the shape). When it is attached, the grab point to which it is attached will 
run red and moving the shape will move the arrow with it. Create three circles in a document and 
attach one of the arrow types to link each of the circles to the other circles. Spread them out in a 
triangle formation on the document while the arrows are attached. How do the arrows behave when 
one end of the arrow is disconnected from the shape and the attached shape is moved? Compare 
the behavior of the three types of arrows.

Create two documents and type entirely different text in each of them. Now use the document 
comparison functionality in Word to merge the two documents into one. Because the content is 
different, one of the documents will appear as new text and the other will register as removed text. 
Which document appeared as which type of text? Resolve the document changes to retain the 
maximum amount of text in the resulting document. What steps did you take for the resolution?

WordArt is a special type of display for creating unique text effects in a document. Prior to the 
extensive Text Effects menu for formatting text, using WordArt was the only way to create 
professional text effects in a document. Create a document heading using the WordArt menu. Try to 
recreate it using the Styles menu and Text Effects menus available for standard text. Are the results 
the same? Which of the processes is easier or are the two processes equivalent?

Create a new document in Word and save it to your computer as MyObject. Add content to your 
MyObject document and save it. Using Word’s Object insertion (on the Insert ribbon in Word 2013 
and the Insert menu and Object choice in Word 2011) add the MyObject object to your document. 
How is the content added to the new document? When would this functionality be useful?

1

2

3

4

5

5
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CHAPTER  

10
Introduction to PowerPoint  
and Presentation Software

IN THIS CHAPTER

This chapter is an introduction to presentation software and basic elements of 

constructing a presentation. You will create, edit, and save a simple presentation 

while learning to use the common tools required for developing professional 

presentations. Once you have completed the chapter, you will be able to:

●	Create and save a new presentation document

●	Insert and format text and text boxes in a presentation 
document

●	Insert drawing shapes, clip art, and stored images into a 
presentation document

●	Rearrange slides in a presentation document

●	Add slide transitions to a presentation document

Microsoft Office 
2013/365 and 

Beyond
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that belongs in word processing software. 

Any text contained in a presentation should 

be short and to the point (the power point, 

if you will). 

ANATOMY OF 
MICROSOFT 
POWERPOINT

Whenever you open PowerPoint from 

a menu or from a desktop icon, a new 

presentation document (typically named 

Presentation1) will open. Once you have 

opened PowerPoint, take a look at the File 

menu; this is the orange square at the top-

left side of the interface in Office 2013 and 

the first menu in the list beside the apple 

symbol and the word PowerPoint in Office 

2011. The File menu options are shown in 

Figure 10.1. This view is called the Backstage 

view in Office 2013. The detailed options 

here will be explored later and should be 

somewhat familiar to you already from your 

use of Word, but for now you should focus on 

the process of creating and saving a presen-

tation document.

To create a new document in PowerPoint 

2013, select the File menu and then select 

New. A list of document templates from 

which you can create your presentation will 

appear. Select Blank Presentation and either 

10.2

INTRODUCTION 
TO PRESENTATION 
SOFTWARE

In the past, lecturers, business leaders, 

researchers, teachers, and anyone wishing 

to present an idea had to construct their own 

visual aids on paper or chalkboards to sup-

plement their oral presentations. This was 

time consuming and generally was not easily 

transferrable to another venue. Technology 

like slide projectors and overhead projectors 

made this process easier, but it still carried 

a significant development requirement to 

produce the slides or the overhead sheets. 

Presentation software is the digital equiva-

lent to these analog technologies and lowers 

the barrier to creating effective visual sup-

plements to any presentation.

An example of presentation software 

is Microsoft PowerPoint, which comes with 

the Microsoft Office suite. The native for-

mat for this software is the presentation 

document, and it takes the form of a slide 

show. Presentation documents are primarily 

a visual supplement to an oral presentation, 

although they can also be used as a stand-

alone slide show playing in the background 

of an event or as a demonstration that can be 

shared or posted on the Web. A critical thing 

to remember is that presentation software is 

not useful for a large volume of written text; 

10.1

PRESENTATION SOFTWARE is a computer 
program that typically runs on a personal com-
puter and allows the user to create visual aids, 
handouts, and graphics that may include sound 
and animation.

Remember that Microsoft Office 2013 (includ-
ing PowerPoint 2013) is the latest version 
available for the Windows operating system. 
Microsoft Office 2011 (including PowerPoint 
2011) is the latest version available for the 
Macintosh operating system. These versions 
are both included in the Office 365 subscrip-
tion service.
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in Word, Save As prompts you for a location 

and filename to store the file. For a refresher 

on how this works, you can revisit Section 

7.1.1, “The File Menu.” Go ahead and save 

your presentation as MyPowerPoint; the 

native file type is PowerPoint Presentation 

(.pptx).

Now you should be at the main slide of 

your new presentation. PowerPoint has an 

interface that is very similar to Word. A few 

of the ribbons contain almost identical tools. 

PowerPoint is designed for visualization, so 

the ability to format text and insert media 

quickly is the essential element that dis-

tinguishes PowerPoint from the rest of the 

Office suite. When you look at the default 

interface, you will see the initial title slide 

and the available ribbons and commands. A 

quick tour of the interface is provided first 

and then you will learn the steps to creat-

ing a successful presentation. The interfaces 

for PowerPoint 2013 and PowerPoint 2011 

double-click the icon or click the Create but-

ton. You can also use the Ctrl-N shortcut to 

create a new presentation with the default 

settings.

In PowerPoint 2011, select the File 

menu and then choose New Presentation, 

or use the shortcut Command-N. You can 

also create a new presentation from an 

existing template under the File menu, but 

for now you should just create a new blank 

presentation.

Whenever you are working on a docu-

ment, it is imperative to save often. You 

should always start saving when the 

document is first created. With your new 

Presentation1 (the default file) open, click 

File to open the interface for the file options. 

On the main list in the open menu, you have 

the Save and Save As options. Save will 

attempt to save the document to an existing 

location, but if you have not yet saved the 

document, it will act like Save As. Just as 

 FIGURE 10.1
File menu for 
PowerPoint 2013 
and PowerPoint 
2011

New Presentation

Save

Save As

PowerPoint 2013 PowerPoint 2011
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saved your document it will act as the Save 

As command). 

By default, the Quick Access toolbar also 

has the Undo command to erase the effects 

of your last action as though it had never 

happened; the drop-down arrow beside the 

icon opens a menu of several prior actions 

and lets you select how many of them you 

want to undo. The Redo command allows 

you to redo what you undid. These two icons 

allow you to step forward and backward 

through your changes in case you made a 

mistake along the way. 

On the right side at the top of the inter-

face are icons to minimize, maximize, and 

close your presentation (make sure you save 

before you click this button) and an icon to 

access the help files. Beneath these icons, 

there is an arrow to show or hide your rib-

bons. The first ribbon beside the File but-

ton is the Home ribbon. From here, you 

can insert new slides, modify text, insert 

are slightly different, so feel free to jump 

to the section that is relevant to you. The 

Microsoft PowerPoint Web App is also avail-

able for anyone with a OneDrive account. 

Just like the other app versions of the Office 

programs, the PowerPoint Web App is lim-

ited in functionality compared to the full 

installation versions.

Microsoft 
PowerPoint 2013

Along the top of the PowerPoint 2013 

interface (which is shown in Figure 10.2) 

is a series of icons that act as quick com-

mands; this is the Quick Access toolbar. The 

PowerPoint icon itself contains a short list 

of commands that allow you to move and 

change the size of your interface window. 

Clicking the icon that looks like a floppy 

disk lets you save your document quickly 

after you have made changes (it acts like 

the Save command, but if you have never 

10.2.1

 FIGURE 10.2
Anatomy of 
PowerPoint 2013

QuickAccess toolbar Presentation filename

Ribbon Interface

Help

Show or hide ribbons 

Placeholder textboxDesign pane

Slide preview

Slides/Outline 
pane

Visible slide area
Spelling and 

grammer check
View selection

Zoom setting
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shapes that you did not modify. Each theme 

has a set color scheme and font choice, but 

you can change these using the Colors and 

Fonts menus; each of these has a drop-down 

list of predefined selections from which you 

can choose. You can also change the default 

effects that are applied to shapes within 

the presentation by clicking on Effects. The 

Background panel lets you change a number 

of settings, but for now select how you want 

your background to appear from a preset 

drop-down list of options under Background 

Styles. These will change based on the over-

all theme you have selected. Your presenta-

tion is starting to look fancy already!

The next ribbon to consider at this 

point is the Slide Show ribbon, shown 

in Figure 10.5. (The Transitions ribbon 

is discussed later in this chapter, and the 

Animations ribbon is covered in Chapter 

12, “Advanced Features of Presentation 

Software.”) The Slide Show ribbon is use-

ful for previewing how your slide show will 

look when it is presented. On the Start Slide 

Show panel, you can select either From 

Beginning or From Current Slide to start 

your show. Select From Beginning. You can 

also start your slide show from the begin-

ning by pressing F5 on your keyboard.

You should now be in the Slide Show 

view; this is the view you will use whenever 

you are presenting. It resets your slides 

to the full size of the screen and hides the 

design interface of the software. You can 

move forward in your slides by clicking the 

quick drawing elements, arrange items, and 

find and replace text in the presentation 

document.

The main departure from Word you 

will encounter here is that PowerPoint is 

arranged into slides and sections instead of 

pages. To insert a slide, either click the New 

Slide command on the Home ribbon or right-

click the Slides/Outline pane on the left side 

of the interface. When you select the New 

Slide command, you can choose the type of 

layout you want for the slide you are insert-

ing. If you use the right-click option, you will 

get a new slide with the default layout. 

The Insert ribbon, shown in Figure 10.3, 

is the next one in line. You will visit this 

ribbon a lot if you plan to work frequently 

with media, which is really the main pur-

pose of using PowerPoint. From this ribbon, 

you can insert just about anything you can 

imagine, from text boxes and pictures to clip 

art and equations, not to mention sounds 

and videos. You can try it out by clicking 

Shapes in the Illustrations panel. Select a 

shape you like and place it into your slide. 

If you select a shape and just click on the 

slide, a predefined instance of the shape will 

be stamped into the slide. You can also click 

and drag to set the size of the shape yourself. 

The next ribbon is the Design ribbon, 

shown in Figure 10.4; this is where you 

can select how you want your presenta-

tion to look. Go ahead and select something 

from the Themes panel. Notice how doing 

so reformats your text and recolors any 

 FIGURE 10.3
Insert ribbon in 
PowerPoint 2013
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yet typed content into the slides! To run a 

check of spelling at any time, you can press 

the Spelling & Grammar Check icon at the 

bottom of the interface; the icon status will 

indicate if errors are found (an X will appear 

in this case).

The View ribbon, shown in Figure 10.7, 

is where you customize the user interface for 

PowerPoint and format your slides. You can 

also select your view and arrange your slides 

from this ribbon and edit the Slide Master 

for your presentation. The Slide Master is a 

parent of all of the individual slides in your 

presentation. Formatting changes made 

to the Slide Master will affect all of the 

existing and future slides in your presen-

tation. (This tool is covered in Chapter 11, 

“Creating Effective Presentations”).

There is also an Add-Ins ribbon on your 

interface for any software that interacts with 

the Office suite. If you have Adobe Acrobat 

mouse, pressing the spacebar, the enter key, 

or using the right arrow key. You can move 

backward through your presentation by 

using the left arrow key. When you get to the 

end of your show, moving the presentation 

forward will display a black screen that says 

“End of slide show. Click to exit.” Moving 

the presentation forward from this slide will 

take you out of the presentation mode and 

back into the Normal view you use for cre-

ation. You can also end the slide show at any 

time by pressing the Escape (ESC) key.

The Review ribbon, shown in 

Figure 10.6, is similar to the one found in 

Word. You can use the Proofing panel to 

check spelling for your entire presentation, 

find research references, and use the the-

saurus to find alternate words. You can also 

set your language preferences from this rib-

bon. Go ahead and click the Spelling icon. 

You should have no errors if you have not 

 FIGURE 10.4
Design ribbon in 
PowerPoint 2013

 FIGURE 10.5
Slide Show ribbon 
in PowerPoint 
2013

 FIGURE 10.6
Review ribbon in 
PowerPoint 2013

 FIGURE 10.7
View ribbon in 
PowerPoint 2013
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Show view for watching and presenting 

your slide show. Finally, you can shift the 

zoom percentage by moving the slide bar or 

fit your slide to the current window size by 

clicking the icon in the far-right corner. It is 

now time to go deeper into the software and 

start creating your first presentation.

Microsoft 
PowerPoint 2011

PowerPoint 2011 has a concise interface, 

shown in Figure 10.8, which is very similar 

to its PowerPoint 2013 counterpart. Aside 

from some placement differences for cer-

tain tools, almost all of the functionality of 

PowerPoint 2013 is mirrored in PowerPoint 

2011 and vice versa. The main menu of the 

software contains the File menu and a series 

of additional menus that provide shortcuts 

10.2.2

installed on your computer, you may also see 

a ribbon for that (called the Acrobat ribbon); 

this is an example of other programs that 

interoperate with the Office suite. 

The largest portion of the interface is 

devoted to the current slide view. The left 

side of the interface contains the Slides/

Outline pane, which allows you to preview 

your slides and navigate between them 

quickly. The bottom of the interface dis-

plays the slide count and several valuable 

quick links. You can toggle the display of the 

Notes pane from the bottom of the interface 

as well; these are notes that accompany the 

slide but do not display in the presentation. 

You can select the view you want by 

clicking one of the view icons; this includes 

the Normal view for design, the Slide Sorter 

view for arranging your slides, and the Slide 

Menu bar

Design pane
Placeholder 

textbox Settings

Slides/
Outline pane

Visible slide 
area

Notes pane
View 

selection

Zoom setting

Help
Quick 

Access 
toolbar

Ribbon 
interface

Show or 
hide ribbons

Presentation 
filename

 FIGURE 10.8
Anatomy of 
PowerPoint 2011
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is the Home ribbon, which contains tools to 

modify text, change fonts, and insert new 

elements into your slides. PowerPoint 2011 

combines most of the functionality of the 

Home ribbon and the Insert ribbon from 

PowerPoint 2013 into its Home ribbon. The 

New Slide icon is at the far left of the Home 

ribbon; this is used to add slides to your pre-

sentation. The Home ribbon also contains 

the Arrange icon, which is used to arrange 

elements in your presentation; this will be 

visited often in the course of developing 

your presentation. 

The next ribbon of interest is the 

Themes ribbon, shown in Figure 10.9. This 

is where you set the look and feel of your 

presentation. There are a number of pre-

set options from which you can select. Go 

ahead and choose one that you like and click 

on your selection to apply it to the presen-

tation. The new theme will set defaults for 

the color, font, and background settings of 

your slides. You can make changes to these 

defaults at any time using the Colors, Fonts, 

and Background icons. There is a large selec-

tion of preset color schemes and font styles 

available; you can also use these menus to 

define your own.

The next several ribbons are used for 

more advanced functionality, so skip to the 

Slide Show ribbon, shown in Figure 10.10. 

This is used to set up your presentation 

views and timing for when you are present-

ing your slide show. Go ahead and click the 

From Start icon. This will put you into the 

to commonly used tools, such as the Insert 

menu and the Arrange menu. The ribbons 

contain these functions as well, so it is up 

to you to decide your preferred method of 

accessing them. 

The common icons to close, minimize, 

or maximize the presentation are directly 

beneath the main menu at the top of the 

free-floating window containing your pre-

sentation. As in all Mac software, clicking 

the close icon will exit your current presen-

tation, but it will not quit the software; to do 

this, you must select the PowerPoint menu 

and then select Quit PowerPoint.

The Quick Access toolbar for PowerPoint 

2011 contains icons to allow you to save your 

work quickly, print your presentation, cre-

ate a new presentation, open a presentation, 

and access help. There is also the Undo icon 

to allow you to undo any actions you made 

and the Redo icon to put back any changes 

you made with Undo. At the far right side 

of the interface is a text box to search your 

presentation for any keywords you enter.

The ribbon interface is directly beneath 

the Quick Access toolbar. The default ribbon 

A SLIDE was originally a small color transpar-
ency that was intended to be projected to a larger 
surface to assist in visualization. This term has 
been carried over to digital presentation software 
as the unit of the presentation, similar to a page 
in a text document.

 FIGURE 10.9
Themes ribbon in 
PowerPoint 2011
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interface, you can start using the tools to 

construct your first presentation.

Microsoft PowerPoint 
Web App

Just like Word, PowerPoint is also avail-

able as a Web app on the OneDrive. From 

the homepage of OneDrive, click Create 

and then choose PowerPoint presentation. 

You will be prompted to choose the type 

of presentation you want (selecting “New 

blank presentation” is a good place to start 

for any presentation). The interface for 

the PowerPoint Web App is similar to the 

PowerPoint 2013 interface with less options 

and a fewer number of ribbons. You can see 

the interface for the PowerPoint Web App in 

Figure 10.12.

The Home ribbon for the PowerPoint 

Web app contains the formatting commands 

for text as well as a set of drawing objects 

that can be added to your presentation 

quickly. The Insert ribbon, which is shown 

in Figure 10.13, allows you to add images, 

clip art, and the same illustration objects 

available from the Home ribbon. You can 

also add comments to a selected element 

from the Insert ribbon.

The Design ribbon allows you to select 

the theme you want for your presentation. 

10.2.3

Slide Show view, which is the view you 

will use to present your document to an 

audience. You can move your presentation 

forward by using the spacebar or the right 

arrow key and backward by using the left 

arrow key. To get out of Slide Show view 

and back to the Normal view used to design 

your slides, press the Escape (ESC) key.

The Review ribbon, shown in 

Figure 10.11, contains the functionality to 

compare versions of your presentation. It 

also allows you to add and delete comments 

in your slides and to set permissions for the 

presentation. Beneath the ribbon interface 

to the left is the Slides/Outline pane, which 

allows you to preview and quickly navigate 

to your slides by clicking on them. The main 

pane of the interface window is the Slide 

Design pane. This contains the editable copy 

of your slide. 

At the bottom of the interface, you 

can select your view via quick links; these 

include the Normal view for editing, the 

Slide Sorter view for arranging your slides, 

and the Slide Show view for watching or 

presenting your slide show. You can also 

adjust the zoom of your slides by changing 

the slide bar at the lower-right corner. Now 

that you have taken the tour of the software 

 FIGURE 10.10
Slide Show 
ribbon in 
PowerPoint 2011

 FIGURE 10.11
Review ribbon in 
PowerPoint 2011
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Normal View shows the design interface, 

and the Slide Show View starts the slide 

show on your computer in full screen mode. 

You can see the View ribbon in Figure 10.16.

Note that there is no Save icon on 

the interface for the PowerPoint Web App 

because changes are saved as soon as an 

action is completed. The bottom of the inter-

face has the toggle for opening and closing 

the Notes section and a selection of views. 

The ribbon interface also has the option to 

open the presentation in an installed ver-

sion of PowerPoint on the host computer 

and the option to share your presentation 

using the Share icon.

You can also select variants from the theme 

for changing specific colors or other appear-

ance elements once you have selected a 

theme. You can see the Design ribbon in 

Figure 10.14.

The Animations ribbon and Transitions 

ribbon control the more advanced function-

ality of PowerPoint. The Transitions ribbon 

will be covered later in this chapter, but ani-

mation is a more advanced topic. You can 

see these ribbons in Figure 10.15 for later 

reference.

The View ribbon allows you to change 

the view and to show or hide comments 

and the Notes pane for adding notes to your 

slides for presenters or audience handouts. 

The Reading View shows only the content 

of the slide in the Internet browser, the 

Visible 
slide area

Slides/
Outline pane

Placeholder 
textbox

Show or hide 
ribbons

View selection

Ribbon interface
HelpPresentation filename

Slide preview

Design pane

 FIGURE 10.12
Anatomy of the 
PowerPoint Web 
App

 FIGURE 10.13
Insert ribbon in the 
PowerPoint Web 
App
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On the first slide, the title slide, you will see 

two placeholder text boxes. These text boxes 

contain text such as “Click to add …” that 

will disappear the instant you start typing 

in one of them. An example of the title slide 

is shown in Figure 10.17. Go ahead and type 

your name in the title placeholder.

Activity 10.2—Themes
Save the presentation Activity10_1 in 

the Activities folder as Activity10_2. Next, 

you will apply a theme to your presentation. 

You can choose from any of the preset options. 

Now, alter the theme using the available 

tools. You can adjust colors and fonts as well 

as the background. Be sure to remember the 

Activity 10.1—
Adding Slides

Create a new presentation and save it as 

Activity10_1 in the Activities folder you cre-

ated. Practice adding slides to your presen-

tation. What are the different layout options 

for the slides that you add? What do each of 

these have in common and what is different 

for the layouts? Save your work.

DIVING INTO 
PRESENTATIONS

For your first foray into the media 

aspects of PowerPoint, you will construct a 

presentation on a very familiar subject: you! 

10.3

 FIGURE 10.14
Design ribbon in 
the PowerPoint 
Web App

 FIGURE 10.15
Transitions and 
Animations ribbons 
in the PowerPoint 
Web App

 FIGURE 10.16
View ribbon in the 
PowerPoint Web 
App
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Increase Font Size icon. Note that you must 

select either the box surrounding the text 

or all of the text to apply your font changes 

to everything in the box; otherwise the 

changes will affect only the word in which 

the cursor is placed. You can change the size 

to a specific value with the drop-down box; 

this will accept a number (with or without a 

decimal point) as input, so you can define a 

size that is not part of the predefined selec-

tion options. Increase the font until the text 

covers most of the slide.

If you have a long name, it may split 

into two lines. To keep your first name and 

last name on the same line, you can widen 

the placeholder box by clicking on one of the 

square selection points around the perim-

eter of the text box, as shown in Figure 

10.19. The left square selection point will 

only move the left edge of the box, and the 

right square selection point will only move 

the right edge of the box. Picking one of 

the round corner selection points lets you 

process you used because this will be a com-

mon activity when you are creating presenta-

tions. The theme options available may differ 

depending upon the version of PowerPoint 

you are using. Be sure to save your work.

Text Formatting
After you have entered your name, 

you will add some text formatting to make 

it look spectacular. PowerPoint offers most 

of the same text effects as Word. The dif-

ferences are that there is no highlighting 

in PowerPoint and the Text Effects fea-

ture in PowerPoint 2013 is located on a 

separate, context-sensitive Format ribbon. 

Right-clicking on a text box activates a for-

matting menu with common links for text 

modification. You can see both of these in  

Figure 10.18.

Change the font of the text to something 

suitable and stylish and change the text to 

bold by clicking the Bold icon or pressing 

the Ctrl-B keys at the same time. Increase 

the font size by a single increment using the 

 FIGURE 10.17
Example title slide

10.3.1
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Now your name is starting to show 

some pizzazz, but you should give it more 

flair by adding text effects. The various text 

effects are in the Format ribbon for Drawing 

Tools, which is context sensitive and 

appears whenever you click in a text box. 

Text effects are another type of formatting 

change both the width and height at the 

same time.

Switch the text alignment to the left 

by selecting the Align Text Left icon (or by 

pressing Ctrl-L) or to the right by selecting 

the Align Text Right icon (Ctrl-R). This is 

helpful to remember when you need to line 

up headings and text with one edge or the 

other. Titles, however, look better centered, 

so put your name back where it was by click-

ing the Align Text Center icon (Ctrl-E).

 FIGURE 10.18
Format ribbon and 
right-click menu 
for text boxes 

 FIGURE 10.19
Selection points 
on a text box

If you are using a Mac, the Control (Ctrl) key shortcuts 
all work the same way, but they use the Command (or 
Apple) key instead of the Control key.
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also set the perspective of the shadow (the 

angle of the implied light source) by select-

ing one of the options at the end of the drop-

down menu. Clicking Shadow Options will 

allow you to fine-tune the parameters to get 

your shadow effect just right. The Distance 

parameter, for example, will determine how 

far away the shadow is from your object. 

Now cancel the shadow by selecting Text 

Effects, then Shadow, and No Shadow. Save 

your work and test these steps on other text 

effects to see how they vary and what stays 

the same.

Click on the subtitle placeholder. Rather 

than enter text here, click on the outer 

perimeter of the subtitle placeholder box 

and get rid of it by pressing the Delete key or 

the Backspace key. You can do this to remove 

any placeholders that you do not want or to 

remove any objects you have added that you 

no longer like. You should now see a slide 

similar to Figure 10.20 except with your 

name in the box and the background style 

that you chose earlier.

Inserting and 
Formatting Shapes

Now you are going to show everyone 

what a superstar you are. If you are using 

PowerPoint 2013, switch over to the Insert 

ribbon and select the Shapes icon; if you are 

using PowerPoint 2011, the Shape icon is 

on the Home ribbon. Pick a star from the 

drop-down list and click inside the slide. 

This should stamp an instance of the shape 

wherever you click. 

You can format the star by using the 

right-click menu or the familiar Format 

10.3.2

that adds elements like shadow, glow, reflec-

tion, and outlines to the letters in the text 

box. To apply an effect, you must select the 

text to which you want the effect to apply. 

To apply the effect to all of the text in the 

box, you can select the box surrounding the 

text. Some text effects, like 3-D Rotation 

and Transform, apply to the entire content 

of the text box and cannot be applied to indi-

vidual letters or words. 

You can select a predefined overall 

style from the Word Art Styles panel of the 

context-sensitive Format ribbon or you can 

change elements individually. Too many 

text effects at once can ruin the appeal of 

your display. To test these on plain text, 

select Text Effects, then Reflection, and 

choose a reflection variation you like. Keep 

the reflection effect for this project, but to 

cancel it, select the No Reflection option in 

the drop-down menu. You can also fine-tune 

the reflection by selecting Reflection Options 

just as you did for the shadow effect.

Activity 10.3—
Text Effects

Using the presentation you are construct-

ing for the lesson project, save a copy of it as 

Activity10_3. Give your name depth by add-

ing a shadow. To do so, click the Text Effects 

icon, select Shadow from the drop-down list, 

and then select the one you want. You can 

PowerPoint 2011 places a Text Effects icon on the 
lower-right corner of the Font panel of the Home 
ribbon. 
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Figure 10.21. Note that 

it appears as a dialog 

box in PowerPoint 2011 

and as a new pane in 

PowerPoint 2013.

First, change the 

star’s outline to some-

thing thick. Select Line 

Style in PowerPoint 

2013; select Line, then 

Weights & Arrows, then Style in PowerPoint 

2011. Increase the Width to 3 pt. This should 

make the outline nice and bold. The Dash 

Type (or Dashed) setting determines how 

the line appears, whether you want a solid 

line or a dotted line that implies the shape. 

In PowerPoint 2013, click on the Line 

Color item in the menu. You have a choice 

of No Line, Solid Line, or Gradient Line. 

ribbon that appears whenever you click 

on a shape. This time it will be the Shape 

Styles panel in which you will find what you 

need. With the shape selected, right-clicking 

and selecting Format Shape will open a dia-

log box that lets you alter the properties of 

your star (this is the same dialog box that 

you get by selecting the expansion icon on 

the Shape Styles panel in PowerPoint 2013). 

The Format Shape dialog box is shown in 

 FIGURE 10.20
Completed 
example

 FIGURE 10.21
Format Shape dialog box for 
line settings

PowerPoint 2011
PowerPoint 2013
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determines whether the gradient is created 

based on the orientation of the slide or the 

orientation of the shape itself.

When you are done setting the color, 

click Close (or OK) to exit the dialog box in 

PowerPoint 2011 or click the X at the right 

of the pane in PowerPoint 2013. You can 

now resize the star based on just how big of a 

superstar you are. Use either the round cor-

ner grab points or the square midpoint grab 

points to change the size of the shape. The 

circle at the top of the shape (which looks 

like an arrow turning in PowerPoint 2013) 

can be used to rotate the shape. Simply click 

and hold the circle and give your shape a 

spin. You may see one or more small yellow 

diamonds or circle inside your shape. These 

control internal parameters of the shape; for 

instance, this will set how fat or skinny the 

triangular legs of your star become.

Finally, make that star shine. Click on 

the star and select the Format rib-

bon. Click the Shape Effects icon, 

select Glow, and pick a glow that 

fits your star. You can also set the 

color of the glow by selecting More 

Glow Colors (or Glow Options in 

PowerPoint 2011) from the menu. 

This will open a color picker from 

which you can choose the color 

you want your star to shine. When 

you are done, you should have a 

shining star beneath your name 

as in Figure 10.23.

Having no line would defeat the purpose of 

making it thicker, so opt for Solid Line. In 

PowerPoint 2011, select either the Solid or 

Gradient tab of the Line menu to change 

these settings; select Solid, and you should 

see the Color setting. Next, you need to 

choose a color that will work with your back-

ground but make the star stand out all the 

same; choose whatever color you like.

On the Fill menu, shown in Figure 10.22, 

you are going to make your star stand out by 

selecting a Gradient option. This menu will 

allow you to select from a set number of dif-

ferent gradients; if you are using PowerPoint 

2013, you can pick one of the predefined gra-

dients from the Preset Colors list. 

You can set Type to Linear if you want 

the gradient to go from left to right or top to 

bottom or to Radial if you want it to start 

in the center and work its way around a 

curve. The stops of the gradient are shown 

on the bar beneath these settings. You can 

add or delete stops, but the program will 

interpolate the color from one stop to the 

next. Click on any of the stops to change the 

color yourself. The Rotate with shape option 

 FIGURE 10.22
Format Shape 
dialog box for 
gradient fill 
settings

PowerPoint 2011
PowerPoint 2013

Shortcuts to the Line and Fill menu options 
are available on the Format ribbon.
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then select Transform. 

Pick a transformation 

for your text. Now go 

back to the Home rib-

bon and change the 

font color or the font. 

The transformation 

and overall formatting 

that was defined should 

remain intact. Small 

pink diamonds in your 

text box will control properties like the angle 

of the text slant when you click on them and 

slide them in one direction or another.

Maybe you are more of a rockstar than 

a superstar. It is easy enough to change the 

text to represent that. Just double-click the 

text box to select it and all of its contents. 

Now type Rock in the box. There you go! 

Now you have instant “Rockstar” status, 

and you are just getting started! Compare 

your rockstar results to Figure 10.24, which 

shows the elements you should have when 

you are finished.

Now you need to add 

the “Super” to your star. 

To do this in PowerPoint 

2013, select the Insert ribbon and pick the 

WordArt icon; in PowerPoint 2011, select 

WordArt from the drop-down list under Text 

on the Home ribbon. This works similarly to 

using the predefined styles for text format-

ting on the Format ribbon. In PowerPoint 

2013, choose a style from the menu that 

appears.

This action will create a text box in your 

slide. Change the text inside to Super and 

position it where you want it on the slide. 

This works just like 

any other text box 

with some of the set-

tings completed for 

you. You can still 

change the font and 

the size, along with 

any other properties. 

Click on your new 

text box and go to the 

Format ribbon that 

appears. Select the 

Text Effects icon and 

 FIGURE 10.23
Completed 
example

 FIGURE 10.24
Completed 
example
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replace the placeholder text box entirely. Go 

ahead and give your slide a title and make 

sure it is appropriate for what the slide con-

tains. Quickly practice your text modifica-

tion techniques and create a style to make 

your title stand out from the background.

Now click back on the image you just 

inserted. You will see a new ribbon along 

the top of the interface. This is the Format 

ribbon for Picture Tools (the Format Picture 

ribbon in PowerPoint 2011). As you can see 

from Figure 10.26, this ribbon contains a lot 

of tools for making your picture look superb.

On the Picture Styles panel, select one 

of the predefined styles that will make the 

image look like an old printout from a hand-

held instant camera. Something with a nice 

thick white border will be perfect. On the 

Adjust panel, select the Corrections icon; 

this allows you to increase or decrease the 

brightness, contrast, and sharpness of the 

image. The original image will appear in 

the center of the options, and you can adjust 

it by clicking one of the options around it. 

Increase the contrast slightly to give your 

photo a richer tone.

Inserting, Manipulating, 
and Cropping Images

It is time to show your smiling face to 

the world. Go to the second slide in your 

presentation. If you have not added a second 

slide yet, simply right-click in the Slides/

Outline pane and select New Slide. This sec-

ond slide should have the default layout for 

a slide, which consists of a slide title place-

holder text box and a single box for content, 

as shown in Figure 10.25. You are going to 

add a picture here, so you may want to pick 

a nice image of yourself. For those of you 

who are camera shy, you can use an image of 

a monkey making a silly face instead.

Before you start typing in the content 

box, which will eliminate the quick links, 

select the Insert Picture from File icon 

on the slide. This is the same as selecting 

Picture on the Insert ribbon (Picture is on 

the Home ribbon in PowerPoint 2011); it 

just saves you a few clicks of the mouse. 

Using the quick link allows you to select the 

image and then insert and center it under 

the title of the slide. Notice that this will 

10.3.3

 FIGURE 10.25
New slide with the 
default layout

MSOffice-Beyond-CH10.indd   234 6/24/2014   10:13:10 AM



Chapt er  10  — Introduct ion  t o  PowerPoint   and  Present at ion  Sof tware  — 235

to select the color saturation, color tone, 

and recolor options. Under Recolor, select 

Grayscale. The Adjust panel has some other 

useful items as well. Along the right side of 

the Adjust panel are the following options: 

•	Compress Picture will reduce the file 
size of the PowerPoint file by sam-
pling the picture to the necessary 
resolution for the screen.

•	Reset Picture will undo all of the for-
matting you added since inserting the 
image at the beginning.

The next thing you need to do is crop the 

image so that it focuses better on the subject. 

Cropping allows you to remove parts from 

the top, bottom, left, or right of the image 

that you do not want to display. Click on the 

image and then select Crop on the (Picture) 

Format ribbon. Now you can use any of the 

grab points on the image and move them in 

toward the center to cut off portions of the 

image you do not want instead of just resiz-

ing the image in place. This process is shown 

in Figure 10.27. 

The Crop icon has some other useful 

options. For instance, you can crop your 

image to a drawing shape. Selecting any 

of these options will override your manual 

Now turn your photo to grayscale. You 

can do this by selecting the Color icon in 

the Adjust panel (this is called Recolor in 

PowerPoint 2011). This gives you options 

 FIGURE 10.26
Format ribbon 
for Picture Tools 
in PowerPoint 
2013 and Format 
Picture ribbon in 
PowerPoint 2011

There are a number of settings that can be 
used to correct a picture that is inserted into 
PowerPoint. There is a preview visualization 
of the effect whenever a transformation is 
selected, but the following list will help you 
understand these transformation terms:

•	Color Saturation—This is the term for 
how pure the color is; the higher the satu-
ration, the purer the color. The primary 
colors red, blue, and green are the purest 
(and most saturated) colors.

•	Color Tone—The color tone is how light or 
dark the color is. Each color can produce a 
spectrum of tones. The tone value is rela-
tive, so the surrounding colors will affect 
the perception of the tone.

•	Sharpen and Soften—This setting will vary 
how clear the differentiation is between 
neighboring pixels of the image. Sharpen 
will increase the differentiation by more 
strongly defining boundaries in the image. 
Soften will decrease the differentiation by 
blending together the colors of the image.

•	Brightness and Contrast—Brightness is the 
threshold for the color level that registers 
as black; higher brightness means there are 
more colors allowed between pure white 
and pure black. Contrast is a measure of 
the spectrum of colors between pure white 
and pure black; higher contrast will gener-
ally show more granular detail of the image.

CROPPING is the act of cutting off outer por-
tions of an image or object. This is the digital 
equivalent of using scissors to cut off pieces of an 
image on paper.
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image. This not only looks bad, but it will 

also grab the attention of your audience in 

a negative way because their eyes will be 

drawn to the distortion instead of what you 

want them to see. 

Arranging, Linking, and 
Grouping Elements

The old saying is that a picture is worth 

a thousand words. Well, you are going to 

add a few more for your picture. Before you 

get to that, though, you need to move the 

image back into alignment after it has been 

cropped. The image was originally centered 

in the placeholder, but the changes made to 

it have altered its position on the slide. 

The alignment commands are under 

the Arrange icon in the Home ribbon. Click 

on Arrange and scroll down to Align; you 

should see all of the options for orienting 

your picture around the screen. The full 

path is shown in Figure 10.28. These align-

ment commands work on any element you 

insert into your presentation. You can also 

find a shortcut to the alignment options 

(as an Align icon) on the context-sensitive 

Format ribbons that appear.

Make sure the Align to Slide box has 

a check mark beside it. This will make all 

of your alignment adjustments relative to 

the slide itself. If this is not checked, the 

10.3.4

cropping. There are two more predefined 

options that you may find useful:

•	Crop to Fill causes the entire image to 
be forced to the area defined by crop-
ping. This will fill the cropped space 
with as much of the image as possible, 
cutting off only what is necessary to 
preserve the defined space.

•	Crop to Fit causes the image to be 
forced in its entirety to the defined 
space. This may cause gaps in the 
display if no image information is 
available to match the space defined.

You can click and drag the image you 

have inserted to resize it just like any other 

drawing or graphic object inserted into your 

slides. The one thing you must remember 

with pictures is that you should always 

maintain the original aspect ratio of the 

image. Otherwise, faces and bodies will look 

stretched or pinched when you distort the 

 FIGURE 10.27
Cropping an image

ASPECT RATIO is the longer dimension of an 
object divided by the shorter dimension. This is 
the ratio that should be preserved whenever any 
changes are made to an object to avoid  distortion. 
The aspect ratio of a standard 5 × 3 photograph 
is 5:3.

ALIGNMENT in terms of layout is the 
relative placement of an object with 
respect to the overall environment, which 
in this case is the slide.

MSOffice-Beyond-CH10.indd   236 6/24/2014   10:13:10 AM



Chapt er  10  — Introduct ion  t o  PowerPoint   and  Present at ion  Sof tware  — 237

Ctrl-V on the keyboard, which will give you 

the default paste settings. In PowerPoint 

2011, selecting Paste from the right-click 

menu or pressing the shortcut keys to paste 

will result in a copy placed on top of the origi-

nal but slightly to the right and down.

Click on one of the rectangles and 

start typing. Type a descriptive word for 

the image, such as Charming, and notice 

how the shape automatically accepts the 

text. Now add two more descriptive words 

to the other rectangles; you could try Witty 

and Slobbery, for instance. Almost all of the 

drawing shapes allow you to directly insert 

text into them; the area of the shape allo-

cated for text will vary, so the length of text 

may be limited depending on the shape you 

choose. You can format these shapes just 

as you did the star in the previous exam-

ple, and you can format the text inside the 

shapes as well.

There is a special kind of shape that can 

connect two elements in your slide. These 

elements will align relative to each other. 

Click the Align Center item in the menu to 

line up your photo to the center of the slide. 

Click on the photo and press the up or down 

arrow keys to move it to the center of the 

lower portion of the slide beneath the title. 

You can hold down the Control (Ctrl) key on 

your keyboard and press the arrows to move 

it a smaller distance for each arrow press.

Now you are going to revisit the Shapes 

icon and select a rectangle. You can just pick 

one and click in your slide to stamp it down, 

or you can make your selection and click and 

drag on the slide to set the size yourself. Click 

on your new rectangle and copy it. You can 

do this by right-clicking on the object and 

selecting Copy or you can press Ctrl-C on the 

keyboard with the object selected. Now paste 

two more rectangles into your slide. 

In PowerPoint 2013, you can do this by 

right-clicking where you want the rectangle 

to appear and selecting Picture under the 

Paste Options. You can also do this by pressing 

 FIGURE 10.28
Menu path to 
alignment options
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contains the arrow settings in the panel 

under Line Styles (you need to select Line 

and then Weights & Arrows in PowerPoint 

2011). Here you can change the Begin Type 

(Begin Style) or End Type (Begin Style) for 

the arrow (which affects either the initial or 

final point of the arrow, respectively) and set 

the size you want for each; this is shown in 

Figure 10.29.

Link the rest of your rectangles to your 

photo with arrows. Format the arrows so 

they are clearly visible on the slide. You may 

notice that the arrows you place are on top 

of the rectangles; this is because any new 

element added to your slide automatically 

gets placed in the highest layer available. 

You will want to put your rectangles on top 

of the arrows to make the slide look more 

presentable. To do this, you will need to 

change the layer on which these elements 

reside. Think of these items like sheets of 

paper in a stack. To move an element to 

the top of the stack, you need to bring it 

forward. To move it to the 

bottom of the stack, you 

are found under the Line (or Lines and 

Connectors) heading in the Shapes menu. 

Click on an arrow that you like and your 

cursor will change to a crosshair. Whenever 

you roll your mouse over an element, you 

will see small red squares appear; these are 

linking points for the shape. You can con-

nect a line from one of these linking points 

to another or draw a line without linking 

it. For this example, you will place one end 

of the line on the rectangles containing the 

descriptive words and link the other end to 

the picture. 

If you connect an endpoint of your line 

to an element, the line will stay connected 

even if that element is moved. An uncon-

nected end will not stay where it is placed 

when an object to which it is connected is 

moved; it will move around with the rest of 

the object to which it is 

connected. If neither end 

is connected, the object 

will have to be moved 

manually just like any 

other object.

To format the ends 

of your arrows and 

change how they are dis-

played, you can use both 

the usual tools for for-

matting and the Format 

Shape dialog box, which 

In PowerPoint 2013, you can hold down the Alt key to 
allow you to freely move the line’s endpoint when you 
are dragging an arrow; otherwise, the endpoint will 
align to the closest internal grid point available.

 FIGURE 10.29
Arrow settings

PowerPoint 2011
PowerPoint 2013
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You can still select individual objects 

from the group by clicking on any one of 

them (as in Figure 10.31). If you decide 

these objects need to be separated, click 

on the whole group, right-click, and 

select Ungroup (this is also available as 

an option under the Arrange icon on the 

Home ribbon). If they need to be put back 

together, select Regroup and the old group 

will be back together again.

need to send it back. You can think of the 

slide background as the table on which this 

stack is sitting; nothing can be sent behind 

the slide itself.

There are two ways to change the layer 

of an element. You can right-click the ele-

ment and choose either Bring to Front or 

Send to Back (to put it on the very top or 

bottom, respectively) or use Bring Forward 

or Send Backward to change the layer by 

one position at a time. You can also select 

the element and click the Arrange icon. In 

PowerPoint 2013, Order Objects is the first 

heading you will see on this menu, and it 

contains all of your options for adjusting the 

layer. Select each rectangle and choose Bring 

to Front.

Now that you have a nice arrangement 

for your elements (you should have all of the 

same elements as in Figure 10.31), you do 

not want anyone to accidentally move some-

thing around if they edit your presentation. 

A good solution to this is to create a group 

for these objects so they all act like a single 

element in the slide. 

To create a group, click outside of the 

group and hold down the mouse button 

while you drag your cursor over all of the 

items you want to group. Then you can 

either right-click within the group and 

select Group or you can go to the Home 

ribbon, select the Arrange icon, and select 

Group. You can also hold down the Shift 

key while clicking on each object you want 

to group and then follow the steps to create 

the group.

PowerPoint 2011 has a great feature to visualize the 
layers on the slide and allow you to rearrange them. 
Under the Arrange icon, you can select Reorder 
Objects or Reorder Overlapping Objects. This launches 
a visual display of the layers in your slide that you can 
click and drag to reorder as shown in Figure 10.30. 
This is also a great visualization of the layers to deter-
mine what is visible to the viewer.

Note that if an object is inserted into a placeholder, 
it cannot be included in a group. To get around this, 
copy the element, paste the copy, and delete the origi-
nal and the placeholder. The copy can then be included 
in the group.

 FIGURE 10.30
Visualizing layers in PowerPoint 2011
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to explore some of the tools for adding 

and modifying text in a PowerPoint slide. 

You can choose here whether you want to 

include a list of foods you like to eat or a list 

of hobbies you enjoy; both of these would 

help describe you and are a good fit for a 

casual presentation like this. Whichever 

you choose, go ahead and type a title for 

your slide. Practice your formatting skills 

by making sure it matches the appear-

ance of the title text on the slide with your 

photo on it.

Now choose four or five items to sup-

port your title. The example in Figure 10.32 

shows five things to eat that begin with the 

letter P. Click in the placeholder text box 

of the slide (with a default layout) and type 

your items in a similar manner. You should 

notice that these are formatted as a list; this 

is the default format and it makes it easy to 

distinguish your points. In a presentation, 

the text does not have to be in complete 

sentences; the essential thing is to get your 

points across in as clear and concise a man-

ner as possible.

Adding Text and 
Hyperlinks

Now it is time to start adding text to 

the PowerPoint presentation. Before you 

use PowerPoint to write that novel you have 

been planning, there are some things you 

should know about what PowerPoint should 

and should not be. First of all, there are two 

main reasons to construct a PowerPoint 

document: to create a visual supplement to a 

presentation and to create a small multime-

dia presentation for sharing on a computer. 

PowerPoint text should be brief and easy to 

read, no matter what purpose the presenta-

tion has. You should always keep your bullet 

points short and meaningful. Presentation 

software is excellent at showcasing informa-

tion when it is used in this manner. If you 

are giving your PowerPoint presentation to 

an audience, you have to keep readability in 

mind. Small fonts and changing styles on 

the same slide are difficult to read.

Add a third slide for your presenta-

tion about yourself. Here you are going 

10.3.5

 FIGURE 10.31
Completed 
example with 
grouping
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of the text and 

hit the Enter 

key. 

You should 

see a new line 

beneath your 

text with a new 

bullet beside 

it that looks 

grayed out as if it is not completely there. If 

you start typing now, you will enter text at 

the same level (level 1) as the original item, 

so press the Tab key to turn this line into 

subtext for the line above it. Now you should 

see the bullet type change and the text cur-

sor indent farther into the page to the right. 

Your text will now be smaller and it will be 

formatted as the next level down (level 2) 

in terms of your outline. You can see this in 

action in Figure 10.33.

You can modify your text using the 

Paragraph panel of the Home ribbon. This 

You should also notice how you have a 

lot of space left over on this slide. You can 

either add subtext to each bullet or increase 

the font size to take up more space. If this 

is being used for a visual presentation on a 

projector or screen behind you, make sure 

you change the font to a sans serif font 

(such as Arial or Calibri). All those text 

decorations (the serifs) make the text more 

difficult to read on a projection. If the pre-

sentation is being shared by computer, serif 

fonts are fine because it is closer to print 

media format.

Expand your list a little bit by choos-

ing a topic for which you 

want to add subtext. Note 

that you should only add 

subtext if you have at least 

two things to say about a 

topic. A single element of 

subtext looks messy and 

unorganized; it is also a 

violation of the rules of out-

lining. Click on the line for 

which you want to add text; 

place your cursor at the end 

 FIGURE 10.32
Bulleted list in 
the default slide 
arrangement

 FIGURE 10.33
Two-level bullet list
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an email address that you don’t mind being 

seen (and used) by the public, you can add 

those here. When you type any text into 

PowerPoint that matches the format for a 

Website or email address, PowerPoint will 

automatically convert the text into a hyper-

link. Just like a hyperlink on the Web, when 

you click on this text, it will either take you 

to the location specified or open your email 

account so you can send a message to this 

address.

Unless you have multiple links or 

addresses, you probably do not need a bullet 

point for this slide. To get rid of bullet points 

on this or any slide, just click at the begin-

ning of the text and press the Backspace key 

(or the Delete key for PowerPoint 2011). The 

bullet point will disappear and your text will 

no longer be in outline format. With just one 

item on the page, there is a lot of empty space 

that can make your slide look bad, even if 

you increase the font size dramatically.

To correct this, move your link to the 

horizontal center of the slide by selecting the 

Center icon to center the text (which you can 

find under the Paragraph panel of the Home 

ribbon). You can also move your text to the 

vertical center of the text box by selecting 

the Middle item in the Align Text menu that 

opens; this icon is in the same panel as the 

horizontal text alignment options. Your text 

should now be centered within the text box; 

note that this does not center it on the slide 

or center the text box itself.

Now you can use the font tools to 

increase the size of the link so it takes up 

more space. Remember that readability is 

crucial for a presentation, so you may want 

is where you can change the bullet styles for 

your slide or even change them to numbers 

if you need your list to be in a specific order. 

Unless you make the change in the Slide 

Master, this only changes the bullet style for 

the current slide in which you are working 

and only for the bullet points that you have 

highlighted when you click the icon.

You can set a number of other useful 

properties with the Paragraph panel, includ-

ing changing the direction of your text, the 

number of columns, or the text alignment 

inside the text box. You can adjust the line 

spacing and indentation of the text as well.

Now create a new slide (this should be 

the fourth slide of your presentation); this 

is where you are going to add some contact 

information so all of your fans can reach you 

once they see how great you are. For the title 

of the slide, add the text How to Reach Me 

and make sure you format it to match the 

titles of the rest of your slides. This is good 

practice and it keeps your slides from look-

ing out of place when you click from one to 

the next.

Consider carefully what you want to 

add to this page. You probably do not want 

to give out your home address or personal 

phone number on a slide that can be seen 

by anyone. If you have a Facebook page or 

In PowerPoint 2013, if you type too much text for one 
slide, a little box will pop up to give you options on 
what to do. You can choose to change your slide lay-
out or split the content of the text box between two 
slides. You should always take note when this box 
appears because it means your slide is starting to get 
too crowded.
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updated to the new color. PowerPoint treats 

your hyperlink colors as all or nothing, so 

you should be sure that the color you choose 

works on all of your slides. Note that you can 

give a name to your custom color scheme in 

this dialog box as well if you want to use it 

later. If you do not, it will still appear with 

the default name Custom1 in this presenta-

tion because it is now in use.

If you want your text to display some-

thing other than an email address or the 

URL to which you are linking, you can use 

the Hyperlink icon. In PowerPoint 2013, 

you will find this under the Links panel of 

the Insert ribbon; in PowerPoint 2011, you 

will find the Hyperlink icon as an entry in 

the Text icon menu on the Home ribbon. 

Clicking this icon will open a dialog box in 

which you can select another document, 

enter a URL for a Website, or enter an email 

address. You can change the text that will be 

visible on the document for the link in the 

Text to display (or Display) box. You can also 

click on the ScreenTip button to enter text 

that will appear if the mouse hovers over the 

link. If you are not using the address of the 

link itself, you may want to add the address 

to the ScreenTip 

text so a user will 

know where they are 

headed when they 

click the hyperlink. 

The ScreenTip will 

only display in the 

Slide Show view, as 

to stretch your text box so you can increase 

the size of the hyperlink beyond the origi-

nal box size to make it easier to see. If you 

change the width of the text box, make sure 

you use the selections in the Arrange icon to 

align it back to the horizontal center of your 

slide. You can change the font, text effects, 

and style just like you would any other text 

in your presentation. The exception to this 

is the color of the hyperlink text.

To give the color of the link a higher level 

of contrast to the background, you must set 

the Hyperlink color in the theme color set-

tings. In PowerPoint 2013, you access this 

setting in the Design ribbon by selecting the 

dropdown icon of the Variants panel and 

selecting Colors and then Customize Colors. 

In PowerPoint 2011, you access this setting 

by selecting the Themes ribbon, selecting 

Colors, and then selecting Create Theme 

Colors. A dialog box like the one in Figure 

10.34 will open and you can select the color 

you want for your link by using the color 

picker for Hyperlink.

Once you click Save (or Apply to All in 

PowerPoint 2011) in this dialog box, all of 

the hyperlinks in your presentation will be 

 FIGURE 10.34
Create New Theme Colors 
dialog box in PowerPoint 
2013
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Clip Art in Office 2011

PowerPoint 2011 has two options for 

directly inserting clip art into your presenta-

tion. The first is called the Clip Art Browser 

(which is shown in Figure 10.38); you can 

access this by clicking on the Picture icon on 

the Home ribbon to open the menu where 

10.3.6.2

Select the slide with the list of items you cre-

ated. If you have been following along, this 

should be Slide 3. You are going to add an 

element of clip art to this page to enhance 

your presentation. The handling of clip art 

is significantly different in PowerPoint 2013 

and PowerPoint 2011, so separate sections 

have been provided to guide you on how to 

get the same results in either program.

Clip Art in Office 2013

Adding clip art is fully integrated into 

the PowerPoint 2013 and Word 2013 envi-

ronments. Go to the Images panel in the 

Insert ribbon and select Online Pictures. A 

dialog box will open, allowing you to select 

the source of the media you want, as shown 

in Figure 10.36. This contains a search box 

for your selection. In this case, you will 

select Office.com Clip Art. 

When you press enter, the search will 

begin and a new screen will appear to dis-

play the results of the search. You can select 

one or more items from the list that appears 

and then choose Insert to add them to your 

slide. You can see an example of this in 

Figure 10.37. If you select more than one 

item, you should take note that they will all 

be added to the active slide.

10.3.6.1

shown in Figure 10.35. It will not appear 

in the Normal view as you are editing the 

document.

If you add a hyperlink that you later 

decide you do not want, you can select any 

part of the text that contains the hyperlink, 

right-click, and select Remove Hyperlink 

in PowerPoint 2013 or you can click on 

the Hyperlink icon and click Remove Link 

on the open Edit Hyperlink dialog box. In 

PowerPoint 2011, right-click the link, select 

Hyperlink, then Edit Hyperlink, and then 

click Remove Hyperlink on the dialog box 

that opens. Another way to remove the link 

in either version is to place your cursor just 

past the last letter of the hyperlink. Click 

Backspace (or Delete in PowerPoint 2011) on 

the keyboard and you should see the under-

line disappear; now your link is gone. 

Clip Art and Screenshots
Because presentation software is a 

visual medium for expression, it makes sense 

to add some visual elements to your last 

two slides. The most common of these ele-

ments by far is clip art. Microsoft maintains 

an enormous repository of clip art images 

for you to use to enhance your documents. 

10.3.6

 FIGURE 10.35
ScreenTip in Slide 
Show view

If you have typed a URL or email address, pressing the 
spacebar after the address will create an automatic 
link, no matter how many times you have removed it!
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you can select Clip Art Browser. This will 

open a panel of locally stored and indexed 

clip art images. If you want to place one of 

these images in the slide, just click on the 

image and drag it to the slide. You will see 

a small green plus sign on the image when 

you are over an area where it can be placed.

Clip Art in Office 2011

PowerPoint 2011 has two options for 

directly inserting clip art into your presenta-

tion. The first is called the Clip Art Browser 

(which is shown in Figure 10.38); you can 

access this by clicking on the Picture icon on 

the Home ribbon to open the menu where 

10.3.6.2

 FIGURE 10.36
Online picture 
selection in 
PowerPoint 2013

 FIGURE 10.37
Office.com Clip Art 
search results in 
PowerPoint 2013
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you can use the naviga-

tion pane on the left side 

to change the category or 

find results from all categories. If you visit 

the site using Microsoft Internet Explorer, 

the ActiveX® tools allow you to copy the 

image directly from the site to your system 

clipboard, as shown in Figure 10.40. You 

can then simply use the Paste function (or 

Ctrl+P) to paste the item into your slides.

If you visit Office.com with an Internet 

browser other than Internet Explorer, you 

can still use the clip art that is offered, but 

you have to download it to a local folder 

on your machine to make use of it. You do 

this by clicking on the clip art graphic you 

want and selecting Download. You can add 

this image into your clip art repository by 

importing it into your media manager for 

Office 2011 or using the Insert ribbon and 

choosing Pictures to browse to its location 

on your machine for PowerPoint 2013.

Handling Clip Art

Once you have inserted the clip art 

image you want into your slide, you can 

manipulate it just like any other image, 

10.3.6.4

The second option is to select Clip Art 

Gallery, which is also found on the menu 

under Picture in the Home ribbon. This 

option will launch a standalone applica-

tion called Microsoft Clip Gallery, shown 

in Figure 10.39. Here you can search for a 

specific item you want or select categories. 

You can also configure your clip art catego-

ries, image classifications, and image tags 

and add new media to your collection using 

the Import button. To add one of the clip art 

items to your slide, select the graphic you 

want and click the Insert button.

Getting Clip Art from Office.com

Whether you are using PowerPoint or 

alternative software, you can download clips 

from Office.com (www.office.com) to add to 

your presentation or document. Simply go 

to the Office.com site and select the Images 

tab. You will then be able to select a cate-

gory and perform a search on existing clip 

art within the Office.com repository. If you 

do not find what you want in that category, 

10.3.6.3

 FIGURE 10.38
Clip Art Browser in 
PowerPoint 2011

 FIGURE 10.39
Microsoft Clip Art 
Gallery
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an @ symbol on top of it. You can use the 

keyword “email” to find clip art appropriate 

for your page. Select an image you like that 

fits with the style of your presentation, and 

add this to the slide with the email contact 

address. Resize it to appear beneath your 

email address as shown in Figure 10.42.

You will probably find that there is not 

enough space at the bottom of your slide 

for both of these elements. You can move 

your email address up without changing 

its alignment or you can use the alignment 

tools again to reset the alignment you want. 

Align your clip art image to the center of 

your slide.

Now you are going to add an action to 

the clip art so that clicking on the envelope 

opens an email client with the address you 

have listed as the recipient. This is essen-

tially the same behavior as the hyperlink 

itself, but it allows the image to act as a but-

ton. Adding an action to an object in your 

including recoloring it, adding shadows and 

effects, or reorienting it to suit your needs. 

You can open the Rotate (or Rotate and 

Flip) menu item in the Arrange icon menu 

to select common adjustments like Flip 

Horizontal.

You should take note that visual ele-

ments added to your page will make it more 

visually interesting, but they will distract 

the viewer from the text itself. The eye will 

focus on the location with the most visual 

information, which will typically be the 

image; this means your audience will see a 

picture before they see the text that goes 

with it. Too much of a good thing can turn 

bad when it comes to clip art. Limit your 

slides to a single clip art image unless you 

have a specific point that you are making 

with the visual component.

Now it is time to make the same 

enhancements to the contact page. Select a 

clip art graphic that signifies an email. This 

is typically an envelope, sometimes with 

 FIGURE 10.40
Clip Art options 
from Office.com 
using Internet 
Explorer
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your address in the text box. This alerts 

PowerPoint that it needs to launch the mail 

client on the system showing the presenta-

tion and create an email to the address that 

follows “mailto:” as the intended recipient. 

You can see an example of these action set-

tings in Figure 10.41. 

You can edit this action at any time by 

selecting the image and using the Action (or 

Action Settings) icon that you used to start 

the process. Just like the hyperlink you 

added earlier, the action will not occur in 

Normal view. It will only work in the Slide 

Show view, which is shown in Figure 10.42. 

Actions are primarily used to open Web 

pages, move to other slides, or open docu-

ments or programs from within PowerPoint. 

This latter action is one of the reasons you 

should be sure you know the source before 

opening a PowerPoint file someone else has 

made.

Activity 10.4—
Using Clip Art

Save a copy of your example presenta-

tion for the chapter project as Activity10_4 

in the Activities folder you created. You are 

going to add and format a clip art graphic 

for the slide containing the foods you like to 

eat. Select one of the terms and perform a 

search for clip art that represents this food. 

Be sure to note the categories and options 

you needed to use in order to find suitable 

results. Once the image is added to your 

slide, practice using the formatting tools to 

alter the color and image effects applied to 

the clip art image. Be sure to save your work.

presentation allows you to do all sorts of 

advanced things on your PowerPoint slides. 

In PowerPoint 2013, you can find 

the Action icon on the Insert ribbon. In 

PowerPoint 2011, Action Settings is part of 

the right-click menu; it can also be found as 

an icon on the Slide Show ribbon. It is not 

the best tool to use if you are giving a lin-

ear presentation to an audience, but if you 

are sharing the presentation on a computer, 

this allows you to link up different slides and 

presentations and lets you run programs 

from within PowerPoint. 

For now, you are going to select the 

Hyperlink to: radio button and choose URL. 

This will prompt you for an address that you 

want to activate with the action. If you are 

using an email address, add mailto: before 

 FIGURE 10.41
Example Action 
Settings dialog 
box

Adding an action will automatically add a ScreenTip 
containing the address to which it is connected.
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reorganize your slides to move the new slide 

you just created to position it before the con-

tact slide. You can do this in one of two ways:

•	Click on the Slide Sorter View icon 
at the bottom of the interface. Once 
this view is open, all of your slides will 
display on a grid as shown in Figure 
10.43. You can simply click and hold 

Sorting Slides
As a final slide for your presentation 

on yourself, you are going to show every-

one what it looks like when you are hard at 

work. Insert a new slide after the contact 

slide. You will want your contact informa-

tion to be at the very end, so you will have to 

10.3.7

 FIGURE 10.42
Contact slide with 
action enabled 
clip art

 FIGURE 10.43
Slide Sorter view
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the Screen Clipping option from this menu 

and select an area of the screen you want 

to copy into an image. This is an incredibly 

useful tool for describing and displaying 

applications or showing an example Website 

in a presentation without having to leave 

PowerPoint. 

If you are using PowerPoint 2011, this 

option is not available to you, but you can 

create a screen capture by holding down 

Shift+Command+3. This will place an 

image of your current computer screen 

on your computer desktop. You will hear 

a camera clicking sound if you do this cor-

rectly. You can now insert this image into 

your presentation just as you would any 

other image stored on your computer. 

Holding down Shift+Command+4 lets you 

select an area of the screen to capture using 

the mouse. If you hold down the Control 

key along with either sequence (such as 

Control+Shift+Command+3), you will 

copy the image to your system clipboard so 

you can paste it directly into your slides.

You can generally save a screenshot on a 

Windows machine using keyboard shortcuts. 

This is typically done by pressing the Print 

Screen button, typically abbreviated Prt Scn 

or Prt Sc. This procedure will vary from com-

puter to computer based on the keyboard 

layout, so you may have to look up how to do 

this on your individual machine if you do not 

have a single button for this. This procedure 

will copy your current desktop image to the 

clipboard of the system as a graphic. 

Once the screenshot is inserted, you 

can work with it just like any other image 

you have included in your slides. You can 

your mouse on the last slide and drag 
it to where you want it to appear (in 
this case, immediately before the con-
tact slide). Click on the Normal View 
icon in the same location to get back 
to your slide design in Normal view. 
You can also double-click on a slide 
in the Slide Sorter view to open the 
Normal view on that particular slide.

•	You can also reorder slides in the 
Slides/Outline pane on the left of the 
interface. To do this, just click and 
hold the slide you want to move and 
drag it to the position you want it to 
occupy.

Inserting Screenshots
Once you have your newest slide in the 

proper place, click in the title placeholder and 

type This Is What My Work Looks Like and 

format the text appropriately to match the 

rest of your slides. You may need to widen the 

placeholder to keep all of this text on a single 

line. Remember to align the placeholder to 

the center of the slide if you change its width 

so it is not off-center from the rest of your 

slide titles. Aligning the text box is separate 

from aligning the text. You are going to show 

everyone what your computer looks like 

when you are hard at work. Make sure you 

have a program open that you use frequently.

Now click the placeholder in the lower 

part of the slide. If you are using PowerPoint 

2013, you can just go to the Insert ribbon and 

select Screenshot from the Images panel. 

This is an easy way to capture what is hap-

pening in a live application on your machine. 

The menu that appears will show each open 

application (other than PowerPoint) and 

allow you to insert an image capture of that 

program into your slide. You can also select 

10.3.8
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default, the slides will just change without 

any transition animation whatsoever. This 

may be suitable for a business presenta-

tion, but you may find instances in which 

you want a little style in your slide transi-

tions. PowerPoint does not lack for transi-

tion options, which range from simple wipe 

effects to full-fledged animations of your 

slide being dissolved into a honeycomb and 

reassembled as the next slide. When adding 

transitions, make sure the animation does 

not overshadow the purpose of your presen-

tation. Your audience did not come to see the 

animations you have constructed for your 

slide transitions.

With that said, you can use this presenta-

tion to experiment with elaborate transitions. 

You will find them all on the Transitions rib-

bon, shown in Figure 10.45. The Transition 

to This Slide panel has a selection of anima-

tions from which you can choose. The Effect 

add effects to it or crop it to suit your needs. 

Just remember that it is likely that the con-

tent of the inserted image will be difficult 

for an audience to read, so once again you 

should be sure that the point you are try-

ing to make is apparent and that you are not 

giving your audience an eye exam by forcing 

them to read text that is too small to see. An 

example of the completed slide can be seen 

in Figure 10.44.

Transitions
To complete your masterpiece, you 

should add transitions to your slides. By 

10.3.9

Whenever you are using a screen capture 
tool, make sure you are not exposing private 
or confidential information from you or your 
organization. It is your responsibility to make 
sure whatever is included in that screenshot, 
regardless of its size or readability, is allowed 
to be used and shared publicly.

 FIGURE 10.44
Completed 
example 
with inserted 
screenshot
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CHAPTER SUMMARY
This chapter provided an introduction to presentation software. As the world 

of business becomes more technology-based, the ability to use presentation 

software proficiently will become more of a necessity to communicate ideas 

clearly and effectively. It is therefore essential that you understand how to 

construct a presentation document to share your ideas and contributions. 

This chapter gave you an overview of the fundamental tools you need to build 

exciting and engaging presentations, but these are just the beginning when it 

comes to making your presentations work. The next chapter focuses on how to 

create and present your presentation effectively. You will get an idea of how to 

format your presentation to suit your purpose and audience, as well as gain an 

understanding of the most efficient and effective ways to showcase your ideas.

transitions, if you want any at all. You can 

also add sound to your transition by select-

ing one of the preset sound effects from the 

Sound menu. Sound that is used to excess is 

very annoying to an audience, and it can be 

very distracting if you have it playing over 

narration.

In this case, though, give yourself some 

applause on your introduction slide. You’ve 

earned it! To do this, select the drop-down 

list next to the word Sound and select 

Applause. Press F5 to play your slide show 

in Slide Show view. Take a bow because you 

have just completed your first media rich 

PowerPoint presentation!

Options icon will change depending on the 

transition that you select. For the introduc-

tion slide, something simple like a fade should 

be used. Click the Apply to All (or Apply to 

All Slides in PowerPoint 2011) icon on the 

Transition ribbon to apply the effect you have 

configured to every one of your slides. Once 

you have selected a transition for a slide, you 

will notice that a small icon appears next to 

your slide in the Slides/Outline pane on the 

left side of the interface. Click this icon to pre-

view the attached animation.

The Duration setting determines how 

long the transition takes. If you are using 

your slide show as a visual supplement for a 

live presentation, you probably want short 

 FIGURE 10.45
Transitions ribbon 
in PowerPoint 
2013 and 
PowerPoint 2011
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CHAPTER KNOWLEDGE CHECK
What is the purpose for using the PowerPoint application?

 A. Create a visual supplement 

 B. Create a multimedia presentation

 C. Create short video clips

 D. Both A and B

The View ribbon is where you customize the user interface for PowerPoint and format your slides.

 A. True

 B. False

If you want to change the bullet styles for your slide or even change them to numbers, you would 
select the  panel on the Home ribbon.

 A. Ribbon

 B. Insert

 C. Review

 D. Paragraph

The  resets your slides to the full size of the screen and hides the design 
interface of the software. You can move forward in your slides by clicking the mouse, pressing the 
spacebar, or using the right arrow key.

 A. Slide Show view

 B. Panel view

 C. Normal view

 D. None of the above

The Print Screen button on a PC, typically abbreviated Prt Scn or Prt Scr, can be used to copy your 
current desktop image to the clipboard of the system as a graphic. 

 A. True

 B. False

Selecting the  in PowerPoint 2011 launches a visual display of the layers in 
your slide, which you can click and drag to reorder.

 A. Review ribbon

 B. Layer icon

 C. Animations ribbon

 D. Reorder Objects menu item

1

2

3

4

5

6
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CHAPTER REVIEW QUESTIONS

What are placeholders in Microsoft PowerPoint? How are they helpful for adding content to a slide?

Why would it be helpful to visualize layers on a slide? Give examples to explain your answer.

How could PowerPoint be used as a study tool?

What is the role of text in a presentation document? Why should it be limited in volume in a 

presentation?

1

2

3

4

Clip art can be retrieved and inserted into a presentation document using .

 A. PowerPoint 2013

 B. PowerPoint 2011

 C. Office.com

 D. All of the above

 E. None of the above

 F. Both A and B

The native format for a PowerPoint presentation is:

 A. ODF presentation (.odp)

 B. PowerPoint Presentation (.pptx)

 C. OST presentation (.ost)

 D. Both A and C

You can add a link to an email address or URL manually by selecting the . 

 A. Format icon

 B. Hyperlink icon

 C. Color icon

 D. None of the above

The keyboard shortcut on a Windows PC that copies an object on the screen is , 
and  can be used to paste the copied object.

 A. Ctrl-C, Ctrl-V

 B. Ctrl-V, Ctrl-X

 C. Ctrl-X, Ctrl-C

 D. Both A and B

7

8

9

10
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At this point in the text, what are the various considerations you should make when developing a 
presentation document? How are these considerations different than the ones you would make with 
a word processing document?

Choose one of the text or shape effect choices and explore its options. How could this be used to 
add emphasis to an element of your presentation?

Explain the role of themes in PowerPoint. Why are these useful and what options are available for 
customizing them for your own use?

Identify at least three different professions that would use PowerPoint frequently to enhance their 
effectiveness. How do these professions differ and what do they have in common?

Explore the Crop to Shape option for editing images. How is this feature applied and when would 
this be applicable to a presentation? 

Based on a review of PowerPoint presentations you have seen or ones you can find online, identify 
how much media on a slide is too much. Give examples to explain your answer. Is this consistent or 
does it depend upon the subject and the type of presentation?

5

6

7

8

9

10

PRACTICE EXERCISES
Begin by thinking about a hobby you enjoy where construction of some sort is involved. Using the 
Web, find additional research supporting facts about your hobby and then prepare a 10-slide 
presentation describing the steps you would take to build or assemble some aspect concerning your 
hobby. For example, you might like building model cars or assembling gift baskets. If you are not 
able to think of a personal hobby, then use the Web to develop step-by-step instructions on building 
or installing an object of your choice.

Using the Web, research a current legal issue affecting your community. For example, you might 
research a new law that is difficult to understand. Use your research to develop a 10-slide 
presentation to clarify what the law means. Make sure you add transitions, images, and hyperlinks 
to the presentation.

Using the presentation software of your choice, develop an outline that explains the steps used to 
cite sources in either the writing style of your choice or one used at your educational institution. 
Examples of these styles include APA and MLA format. 

Develop a presentation that incorporates transitions and photographs to create a digital photo 
album. The focus of this exercise is to use the formatting ribbons and menus to edit, crop, and 
format photographs of your choice. Develop a minimum of five slides for this presentation.

1

2

3

4
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Using the template options available in PowerPoint, create a calendar. Add clip art and text to the 
dates of importance. How easy is this to read? How easy would it be for an audience to read? When 
would this type of template be useful?

CHALLENGE EXERCISES
Search the Internet for examples of PowerPoint presentations. Write a 500-word report on what 
made the presentations effective and the needed areas of improvement. You might want to include 
a description of the elements within the presentation that worked well and elements that could be 
added to enhance the presentation. Be sure to discuss how each element functions and is inserted 
into a slide. Then develop a presentation that demonstrates your working knowledge of the elements 
you discussed in your report. 

Use the word list below to identify the following definitions in letters a through j :  
Alignment, Color Saturation, Cropping, Aspect Ratio, Color Tone, Brightness, Sharpen and Soften, 
Presentation Software, Contrast, Slide

 A. The longer dimension of an object divided by the shorter dimension.

 B. Allows the user to create visual aids, handouts, and graphics.

 C. The unit of the presentation.

 D. A setting that varies how clear the differentiation is between 
neighboring pixels of the image.

 E. The relative placement of an object with respect to the overall 
environment.

 F. How light or dark the color is.

 G. The threshold for the color level that registers as black.  

 H. A measure of the spectrum of colors between pure white and pure 
black.

 I. The act of cutting off outer portions of an image or object.

 J. How pure the color is.  

Create a presentation using every available slide layout. Compare the layout options and, for each 
layout, identify an ideal situation in which they would convey information in the best way. Use the 
presentation to construct these examples (the data included can be fictitious as long as the layout 
and form are correct). 

3

5

1

2
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Create a presentation and apply a theme. Modify the theme’s colors and font selection. Now change 
the background option for the theme. What are the limitations on the degree of control you have 
over the look of the slides once a theme is applied? Does this still allow for enough customization? 
Give examples to support your answer.

Create a presentation and add 5 slides that all include the same image. Use the image formatting 
tools and make a different change to each slide’s copy of the image. Briefly explain the application 
of each tool you selected. How can these effects be used to enhance the presentation of an image 
in a presentation? What tools did you not select for this activity?

4

5
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CHAPTER  

11
Creating Effective  
Presentations

IN THIS CHAPTER

Now that you have some familiarity with the tools available in presentation 

software, this chapter focuses on teaching you to use those tools effectively to 

create a meaningful presentation that can truly make a lasting impression on 

your audience. You will design, format, and share an example presentation to 

demonstrate these best practices. Once you complete the chapter, you will be 

able to:

●	Format the Slide Master for your presentation to assign 
a theme, color scheme, and font set

●	Outline an effective presentation using the Notes section 
of your presentation

●	Structure your slides in a logical and complete manner 
to support the topic on which you are presenting

●	Present or share your completed presentation documentMicrosoft Office 
2013/365 and 

Beyond
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ESTABLISHING A 
VISUAL STYLE

Part of making your presentation 

effective is presenting a clear visual style 

to which the audience can quickly become 

accustomed; this will allow the audience to 

recognize the style as you proceed and focus 

on the content instead of the background. 

This means choosing an effective style and 

adhering to that style throughout the pre-

sentation. Changing color schemes and 

backgrounds is distracting; it draws atten-

tion to the change instead of what you are 

trying to highlight. This chapter will guide 

you through the creation of an effective pre-

sentation, no matter what your underlying 

purpose is. One way to keep your presenta-

tion consistent is to use the Slide Master to 

format your presentation. 

Any changes made to the Slide Master 

will affect all of the slides in the presenta-

tion. Using the Slide Master to define your 

theme, fonts, and colors will give your pre-

sentation consistency throughout and will 

allow you to focus your time and attention 

on presenting the information rather than 

on formatting it. 

11.2WRITING 
YOUR VALUE 
PROPOSITION

Almost every presentation document in 

existence is a form of sales pitch. Whether 

it is a research presentation, a marketing 

proposal, or a presentation about yourself 

like the one you constructed in the previ-

ous chapter, there is some fundamental 

point that you are trying to convey and you 

want your audience to agree with what you 

are saying or at least understand your per-

spective. The key to constructing a success-

ful presentation is to remember your value 

proposition or value statement.

Your value proposition is what you have 

to offer to whoever is viewing your slides or 

listening to your presentation. This should 

guide what you include in every slide you 

create. In fact, you can even state your value 

proposition in the first slide after the title 

slide for everyone to see. It should be concise 

and clear (two sentences at most) so you can 

easily evaluate each subsequent slide for rel-

evance to that overall message. The differ-

ence between an effective presentation and 

an ineffective presentation is typically deter-

mined by the clarity of the message and the 

quality of the visual display.

11.1

A VALUE PROPOSITION is a concise state-
ment (most commonly associated with business) 
of the benefits offered by the product or idea 
under discussion.

A SLIDE MASTER is a template for all 
slides within a presentation document. 
Changes made to a Slide Master will affect 
all of the slides in the presentation built 
from that master. Any slide constructed 
from a Slide Master is considered a child 
slide to the Slide Master.
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for each layout available). Changing any of 

the layout slide masters changes each indi-

vidual slide in your presentation with that 

particular layout.

You will see several placeholder text 

boxes along the bottom of your Slide Master 

that typically do not appear in a new slide. 

These include predefined places to add the 

date, footer text, and the slide number. 

Note that in PowerPoint 2013, when the 

Slide Master ribbon is open, the Design rib-

bon disappears; this is because most of the 

design options that you can apply on a slide-

by-slide basis from the Design ribbon can be 

selected and applied on the Slide Master rib-

bon. In PowerPoint 2011, these options are 

all available on the Themes ribbon, which 

will remain visible whether or not the Slide 

Master is open.

Activity 11.1—Master 
Slide Layouts

Create a new presentation and save it as 

Activity11_1 in the Activities folder. With the 

Slide Master View active, you may notice that 

you have options for inserting either a new 

Layout or a new Slide Master. Use each com-

mand and compare the resulting insertion 

into the presentation. When would you use 

a new Slide Master? When would you use a 

new Layout? Research this further using the 

Web if you are not sure. Save your work.

Modifying the 
Slide Master

The great thing about using the Slide 

Master is that it allows you to set up your 

initial presentation style once and forget 

about it. All of the other slides that you 

create within your presentation will be 

copies of the Slide Master. Create a new 

presentation in PowerPoint and save it 

as MySalesPitch.pptx. To access the Slide 

Master in PowerPoint 2013, go to the View 

ribbon and click on Slide Master under the 

Master Views panel. In PowerPoint 2011, 

select the View menu and choose Master; 

then choose Slide Master on the menu that 

appears.

This opens a new context-sensitive Slide 

Master ribbon, shown in Figure 11.1. The 

design pane will show a parent slide for all of 

the different layout options you can choose. 

Changing the Slide Master will change all of 

the layout slide masters, which are the chil-

dren you see in the Slides/Outline pane (one 

11.2.1

ESTABLISHING A 
VISUAL STYLE

Part of making your presentation 

effective is presenting a clear visual style 

to which the audience can quickly become 

accustomed; this will allow the audience to 

recognize the style as you proceed and focus 

on the content instead of the background. 

This means choosing an effective style and 

adhering to that style throughout the pre-

sentation. Changing color schemes and 

backgrounds is distracting; it draws atten-

tion to the change instead of what you are 

trying to highlight. This chapter will guide 

you through the creation of an effective pre-

sentation, no matter what your underlying 

purpose is. One way to keep your presenta-

tion consistent is to use the Slide Master to 

format your presentation. 

Any changes made to the Slide Master 

will affect all of the slides in the presenta-

tion. Using the Slide Master to define your 

theme, fonts, and colors will give your pre-

sentation consistency throughout and will 

allow you to focus your time and attention 

on presenting the information rather than 

on formatting it. 

11.2

 FIGURE 11.1
Slide Master 
ribbon

Once you become more familiar with 
PowerPoint, you may want to stop using the 
Slide Master and change the theme, font, and 
color scheme directly in the presentation. Even 
if you end up using it only occasionally, an 
understanding of the techniques for working 
with the Slide Master is useful in constructing 
an effective presentation.
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You should take your audience into con-

sideration when planning both your design 

style and your overall purpose. Putting your 

ideas in a context that is suited to your audi-

ence will help them understand the message 

you are trying to convey. The background, 

culture, and experience of your audience 

will affect their perception of your presenta-

tion. Identifying as much information about 

your audience as possible is critical to suc-

cessfully delivering your intended message. 

The setting in which the audience will 

experience the presentation will also impact 

their receptiveness to it. If the occasion is 

formal, you do not want to select a theme 

that is juvenile. If it is a casual setting, you 

do not want your theme to be too rigid and 

formal. Consider who will be viewing your 

slides, as well as the message you want to 

convey. As an example of this, Figure 11.2 

shows two versions of the same slide; these 

have the same content but different styles 

attached to them. The first would be suited 

to a more formal occasion but the second 

would not.

Assigning a Theme
The first step of formatting your master 

slide is selecting a theme. In PowerPoint, the 

Theme setting determines the default Font, 

Color, and Effects settings. In PowerPoint 

2013, you select an appropriate theme by 

clicking the Themes icon in the Edit Theme 

panel of the Slide Master ribbon and then 

clicking on one of the preview icons that is 

displayed. In PowerPoint 2011, these set-

tings are all on the Themes ribbon, where 

11.2.3

Planning Your  
Design

Start your presentation with your overall 

idea and value proposition in mind. The visual 

style you present in your document will have a 

big impact on the perception of your idea. You 

should choose a visual style that supports the 

message you are delivering and is appropriate 

for the audience to whom you are presenting. 

For example, a casual, flashy style with a lot 

of superfluous animation is not suited to a 

research presentation because it will give your 

audience the impression that your graphics 

are more important than what you have to 

say. Conversely, a presentation designed for 

children needs to contain a lot of bright col-

ors or they will quickly become bored and lose 

interest in what you have to say.

The example project in this chapter is 

a professional sales pitch. For this type of 

presentation, you should have a basic idea 

that you want to convey, which should be 

supported by all of the slides you add. In this 

example, the message is simple: “Hot dogs 

should be the next gourmet food fad.” Once 

you have established the overall message for 

the presentation, you need to establish the 

audience for the presentation. 

11.2.2

The visual design of a presentation has a large 
impact on the perceived credibility of the content of 
the design. In a study about Websites conducted at 
Stanford University to determine the factors that 
affect consumer trust, visual appeal was the most 
often cited reason for whether a site was considered 
reputable and trusted. The visual clarity of your slides 
and the visual appeal of the information you present 
will impact whether your audience trusts what you 
have to say. 
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Slides/Outline pane reset to the theme 

you have chosen, as shown in Figure 11.3. 

If you do not like the result, you can sim-

ply choose another theme. 

Activity 11.2—
Theme Choices

Create a new presentation and save it as 

Activity11_2 in the Activities folder. Apply a 

new theme for your presentation where your 

business is designer cupcakes rather than 

the gourmet hot dogs used for the example 

in this chapter. How does the choice of theme 

change in this case? How does the color pal-

ette change? Is your target audience different 

in this case? Save your work.

Colors, Fonts,  
and Effects

The next step after choosing a theme is 

to pick your color scheme. PowerPoint has a 

significant number of preset color schemes 

from which you can choose; once you choose 

a theme, this setting will default to the 

color scheme that matches that theme. In 

PowerPoint 2013, you can select any of the 

preset options from the Colors icon (to the 

right of the Themes icon) in the Background 

panel of the Slide Master ribbon. The Colors 

11.2.4

you can define the Colors and Fonts set-

tings; there is no equivalent Effects setting.

For the example presentation, you 

want a style that is going to fit the topic 

appropriately, so it needs to be something 

modern that will fit with the business ele-

ment you are trying to convince to invest 

in your proposal; it should also not be too 

formal or it will detract from the spirit of 

the idea. When you click on a theme, you 

will see each of the slide templates in the 

 FIGURE 11.2
Alternate designs  
for the same  
content

SELECTING THE RIGHT THEME FOR 
THE VENUE 
When you are choosing a color scheme for 
your presentation, you need to consider how 
the presentation will be viewed. If you are 
showing it on a large screen to an audience, 
you should consider a color scheme that puts 
light-colored text over a darker background. A 
bright background with dark text works well in 
print, but it can be too harsh to view in a dim 
room. Similarly, if your presentation is going to 
be viewed on an individual computer monitor, 
you should choose a theme that is more akin to 
text publications. This will also affect your font 
choices and color scheme, but in PowerPoint 
these are derived initially from the theme.
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You should also choose a font set that is 

suitable for your presentation; you select a 

font by clicking on the Font icon and select-

ing one of the options presented. As a gen-

eral rule, you should never use more than 

two fonts on a presentation: one for the 

title to grab attention and one for the rest 

of the text in the body of your slides. The 

two fonts should complement each other 

well, meaning they should not visually clash 

in style. Readability should be the highest 

menu for PowerPoint 2011 is located in the 

Themes ribbon on the Theme Options panel.

You can also define a custom color 

scheme by selecting Customize Colors… 

in PowerPoint 2013 or Create New Theme 

Colors in PowerPoint 2011 at the bottom of 

the list. This process will start with the col-

ors that you have already chosen and allow 

you to modify them individually; you should 

be familiar with this menu if you changed 

the hyperlink color in your presentation in 

the previous chapter. You can give your new 

color scheme a name if you want to use it 

later or save it with the default name (which 

begins with Custom 1). Any custom color 

schemes you define will appear at the top of 

the list in the drop-down Color menu. You 

can edit or delete them by right-clicking on 

the name of the custom color scheme.

 FIGURE 11.3
Theme selection  
in PowerPoint  
2013

You can set the Theme, Color, Font, and Effects set-
tings on the Design ribbon if you are not using the 
Slide Master to format your presentation.

Not everyone has the talent to be a professional 
graphic designer, but there are a few steps 
you can take to make sure your color scheme 
works for a presentation. A general guideline 
is to have two main colors and an accent color. 
You can use different shades of the main col-
ors, and the two main colors should blend well 
together. The accent color should be used spar-
ingly and should provide enough contrast to be 
readable over both of the main colors. You can 
see a map of complementary and analogous 
colors on the color wheel in Figure 11.4. 
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There are an almost endless number of usable 
color combinations, but using two analogous col-
ors and a complementary (or split complemen-
tary) color is usually a safe way to construct your 
palette. Make sure that any text you include 
is readable above all else and that the tension 
between the colors does not draw attention away 
from the content; you can lighten or darken any 
of the colors to increase or decrease the contrast 
presented. Remember, the more contrast you 
have between your text and the background, the 
clearer your text will be. One color you should 
avoid is pure red; it is incredibly difficult for a 
person to look at pure red on a computer or pro-
jector screen for any sustained period of time.

The fonts in your slides have to be com-

fortable for people at the back of a room to 

read if you are going to do a live presenta-

tion. A live presentation also means you 

should stay away from serif fonts. The extra 

text decorations make it more difficult to 

read what is on the screen. However, if your 

presentation is destined for sharing on an 

individual computer screen, a serif font will 

work just fine. You can present more styl-

ized text in a presentation for an individual 

computer screen, but you should never sac-

rifice clarity and readability.

When you select one of the background 

styles from the menu on the Background 

panel of the Slide Master ribbon while 

you have the default Slide Master (Slide 1) 

selected, the background choice will be 

applied to each of the layout slide masters 

that are linked to it. Most of the layouts will 

have different elements in the slide than the 

default blank layout, so it is typically bet-

ter to select the setting for the background 

styles in each of the different layout slide 

masters if you wish to make changes to the 

default. Each theme will have its own back-

ground styles menu choices available. If 

there is a slide layout for which you do not 

want the background effects to appear, sim-

ply check the box next to Hide Background 

Graphics (or Hide Graphics in PowerPoint 

2011).

consideration when you are choosing which 

fonts to use, followed by aesthetic coherence 

with the overall presentation. Just like with 

the themes and colors, there are a variety 

of predefined sets of fonts from which to 

choose. You can also define your own font 

set and save it for later use, just as you can 

with the color scheme.

Analogous Colors

Complementary 
Colors

 FIGURE 11.4
The color wheel with complementary and analogous colors

In PowerPoint 2013, you can set the default style for 
any graphics added to your presentation using the 
Effects icon on the Theme panel as well. 
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Numbering or Bullets icon, respectively. 

You can choose the style for each layer by 

highlighting the text at the level you want to 

change and selecting the style for that level.

To open the Bullets and Numbering 

dialog box (shown in Figure 11.5) to make 

more specific changes, select Bullets and 

Numbering on the right-click menu or select 

the customization option from the drop-

down menu of either the Bullets icon or the 

Numbering icon. Here you can change the 

size relative to the text, the color of the bul-

lets, and the style of the bullets under the 

Bulleted (or Bullets) tab. You can also add a 

picture of your choosing from a file (or from 

the built-in set of images) as your bullet 

point by selecting the Picture button or you 

can use one of the special character sym-

bols by clicking the Customize button; these 

options are both under the Custom bullet 

drop-down menu in PowerPoint 2011. On 

the Numbered (or Numbering) tab, you can 

select the outline style you want for the text 

level and set the starting number or letter 

by selecting it from the Starts at box.

When you are defining the style of your 

outline for your presenta-

tion, you should always 

keep it as simple and clear 

Bullets and Numbering 
in the Slide Master

Despite the ease of use for bulleted lists 

in presentation software, bullet points must 

be used with care. According to Richard 

Mayer, a leading researcher in educational 

psychology, the improper use of bullet points 

can actually cause learning to cease; bullet 

points can overload the cognitive systems 

of the brain that normally allow a person 

to perceive the information with which 

they are being presented. Because bullet 

points have no inherent order by definition, 

the human brain can get lost in them and 

stop mapping the information. There is no 

definitive answer on the maximum num-

ber of bullet points that should be used in 

a slide, but the consensus of the research is 

that three bullet points on a slide does not 

inhibit understanding if they present clear 

information.

If you are going to use bulleted or num-

bered lists in any of your slides, you should 

set the styles for those in the Slide Master 

and use them throughout your presenta-

tion. Click on the placeholder text box on 

the Slide Master containing the sample out-

line text. The styles for the various outline 

levels will be preset from the theme you 

selected. You can 

select whether they 

should be ordered 

(using numbers or 

letters) or unor-

dered (using bullet 

points) for each level 

of organization by 

clicking either the 

11.2.5

 FIGURE 11.5
Bullets and  
Numbering dialog  
boxes
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In fact, any text that is not assisting the pre-

senter (by displaying the slide number, for 

instance) or needed for copyright informa-

tion or references should be omitted.

To make sure no one takes your presen-

tation and uses it as their own, you can add 

a small copyright notice to your footer. To 

do this, just type (c) into the box; notice that 

it automatically converts to the copyright 

symbol (©). Follow this with your name 

and format the text however you would like 

it to appear. Remember that this is part of 

the footer, so it should be small but clear. A 

font size of 10 to 12 pt is sufficient for the 

footer but would be otherwise unreadable 

on a slide; your audience probably will not 

be able to discern this text.

Add the slide number to the placeholder 

on the righthand side of the slide for your 

reference while you are presenting. You may 

already have a text box with the # symbol; 

this is the allocated space for the slide num-

ber. In PowerPoint 2013, you can insert the 

slide number manually if it is not already 

present by placing the cursor in a text box 

and clicking on the Insert ribbon; you will 

find the Slide Number icon on the Text 

panel. You can now format the slide number 

text to appear the same as the rest of your 

footer text. The actual number in this place-

holder will not be visible until you are in 

Normal view for your presentation; on the 

Slide Master, it will appear as <#>. 

In PowerPoint 2011, you can add any 

of the footer elements that you may have 

removed by selecting the Insert menu, click-

ing on Master Placeholders, and choosing 

the item you want to add. Only the items 

as possible. For an unordered list, the text 

indents should be enough to distinguish the 

different levels, so you should never need 

more than one type of bullet. In fact, if you 

have more than two levels in an unordered 

list on your slide, the text will become dif-

ficult to read. Selecting an image as your 

bullet point may be novel, but you should 

only do so if it is not too distracting and it 

fits with the color scheme and style of the 

overall presentation. Keep your bullets or 

numbers the same color within each slide 

and throughout the entire presentation; 

changing styles or colors in the same slide 

just leads to confusion.

Adding and Formatting 
Slide Footers

Unlike word processing documents, 

presentations do not contain true head-

ers. The visual impact needs to start at the 

upper-left corner of the slide. This is where 

the eye begins viewing the image, so you 

cannot waste that prime visual space with 

slide numbers and copyright information. 

In fact, the only safe place to add this type 

of information to a slide without causing it 

to distract the viewer is at the very bottom. 

The footer is the only area of the slide for 

which you do not have to worry as much 

about readability. This is mostly information 

for the presenter and for later distribution. 

11.2.6

If no information is added to the footer place-
holders, they will appear as placeholder text 
boxes in the regular slide design view for your 
presentation. You can edit the footer informa-
tion on each slide by clicking on the text just 
like any other text box.
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are writing your presentation content. This 

not only saves you effort, it also allows you 

to focus on the content of each slide rather 

than on formatting.

Center your title and add a shadow to 

it on the main Slide Master. You should see 

your changes propagate all the way through 

the rest of the layout slide masters. To 

configure the text shadow, select Shadow 

Options from the menu beneath the preset 

options. This allows you to set how dramatic 

the shadow effect is. The Distance element 

sets how far away the shadow is from the 

text, which determines the perceived height 

of the text over the background.

PowerPoint offers a few text options 

that are similar to what is available in Word 

but with a different layout; you can view 

these in Figure 11.7. One of these options 

is the Change Case icon; this allows you 

to capitalize the first letter of each word 

(which is very useful for a title), toggle the 

case of each letter, or convert all of the let-

ters to either upper- or lower-case. Another 

tool available here is the Text Shadow icon, 

which lets you add a shadow from the Font 

panel of the Home ribbon instead of using 

that are not already included will be avail-

able to select. Changing these text boxes 

does not set the footer on the slides to be 

visible in your presentation. You can man-

age the header and footer elements included 

by selecting the Header & Footer icon in the 

Insert ribbon, as shown in Figure 11.6.

To make the footer visible in PowerPoint 

2013, you must select the Header & Footer 

icon on the Text panel of the Insert rib-

bon. Select the checkboxes that you wish 

to enable in the Header and Footer dialog 

box that appears, as shown in Figure 11.6. If 

you want to hide the footer on the title slide 

of your presentation, check the box next to 

Don’t show on title slide. You can reach the 

Header and Footer dialog box in PowerPoint 

2011 by selecting the View menu and click-

ing on Header and Footer.

Formatting Text on 
the Slide Master

Any text formatting done to the Master 

Slide placeholder text boxes will be car-

ried over to the rest of your presentation. 

Formatting text now in the Master Slide 

will save you the effort of repeatedly for-

matting the same elements later when you 

11.2.7

 FIGURE 11.6
Header and Footer  
dialog boxes

MSOffice-Beyond-CH11.indd   268 6/10/2014   10:44:51 AM



Chapt er  11  — Creat ing  Ef fec t ive   Present at ions  — 269

Slide Master from which the layout slide 

masters are created.

Branding Your Slides
If you have a logo for your company or 

organization, you may want to add it to your 

slides. You do not want to have to do this for 

every slide you create, however, and it is best 

if, once placed, the logo does not change loca-

tion from slide to slide. Consistency is impor-

tant to a good presentation, so you should 

minimize the amount of visual change and 

misalignment from slide to slide. Slide tran-

sitions may mask these changes, but that is 

not an effective solution to the problem.

You may already have a logo in mind for 

your presentation, but for the sake of becom-

ing more proficient with the presentation 

software, you will create one for this project. 

While the process of creating a logo usually 

involves hiring an outside expert or going to 

your organization’s graphic designer, here 

you will use clip art and text boxes to create a 

sample logo. For a review of how to insert clip 

art into your slides, refer to Section 10.3.6. 

Pick a graphic that you like and insert it into 

the Slide Master parent (Slide 1). 

11.2.8

the Text Effects icon in the Format ribbon. 

There is no icon for superscript or subscript 

in PowerPoint 2013 as there is in Word. For 

these effects, you must open the Font dia-

log box by clicking the expansion icon in the 

lower-right corner of the Font panel.

PowerPoint 2011 gives you a larger 

selection of options in the Font panel of 

the Home ribbon. These include all of the 

options available in PowerPoint 2013, along 

with a few additions. You can add or edit all 

of the available text effects from the Home 

ribbon, including superscript, subscript, and 

strikethrough text.

Once you have made the changes to the 

Slide Master, you should go through each of 

the layout slides that you are going to use 

and make any formatting modifications to 

those that are specific to the layout you need. 

Unlike the Slide Master parent, anything 

that you change in a layout slide master will 

change only the slides built from that lay-

out. This means that changing the format 

of text in a layout slide master will not make 

the change in the other layout slide masters. 

For this reason, it is best to keep any signifi-

cant text and font style changes to the main 

 FIGURE 11.7
Font options in 
PowerPoint
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one end to the other. Once you have the 

text looking the way you want, click and 

drag to select both the clip art image and 

the text and create a group of these two 

objects. A completed example is shown in 

Figure 11.8. 

Unfortunately, you cannot just leave 

your logo sitting in the middle of the slide; 

it will attract too much of the audience’s 

attention and detract from the content 

you are going to add. You need to fade it 

into the background so that it can still 

be seen but everything else on your slide 

gets more of the attention. Keep a copy 

of the full-color logo for your title slide; 

that is one location where it should be 

allowed to attract attention. If your logo 

is new, like the one you just created, this 

gives your presentation a new identity or 

branding. If your logo already exists in 

You can now format the graphic with 

whatever effects you like. Try adding an 

inner shadow so that the graphic appears to 

be cut out from the slide background itself. 

Add a new text box in PowerPoint 2013 by 

clicking on the Text Box icon on the Text 

panel of the Insert ribbon. In PowerPoint 

2011, you add a text box by selecting the 

Text icon on the Home ribbon and choos-

ing Text Box. You will need to click and drag 

your cursor to set the size of this or the 

active selection will default to the nearest 

placeholder text box or your newly inserted 

graphic.

Add whatever name you want for your 

proposed company. The example here 

uses “Good Dog Dogs.” You can now apply 

text transformations to make your new 

company name look more stylized. Try 

wrapping it in a circle or arching it from 

 FIGURE 11.8
Example logo
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each slide so it does not change locations as 

you click through your slides.

Now you need to alter the text of your 

logo to fade it into the background along 

with your graphic. You make these changes 

using either the Font panel of the Home rib-

bon or the options available from the Format 

ribbon. Change any part of your text that is 

too distracting from the background color 

to something more appropriate. Anything 

that creates too much contrast with the 

background will draw too much attention. 

You can use the defined colors for your color 

scheme to help fade the text more effec-

tively. You can generally use the same offset 

color that you used for the graphic to fade 

your text. The color names are located along 

the top row in the Theme Colors area on the 

drop-down menu of either the Font Color 

icon or the Text Fill icon; you can select the 

an organization, you are associating your 

presentation content with the culture of 

that organization.

Copy and paste your full-color logo to 

the Title Slide layout slide master. Once 

you have your color copy in place, go back 

to the Slide Master parent and click on 

the clip art graphic of your logo. Select the 

Format ribbon (or the Format Picture rib-

bon in PowerPoint 2011). Go to the Color 

(or Recolor) icon on the 

Adjust panel and select a 

color adjustment that suf-

ficiently blends the image 

into your background. 

You can see an example 

of the completed blend-

ing in Figure 11.9. If you 

are using multiple back-

ground colors on the lay-

outs for your presentation, 

you may wish to do this 

on each of the layout slide 

masters instead of the 

Slide Master parent. Just 

remember to keep the logo 

in the same location on 

If you want a more advanced logo, you can add 
multiple layers to it using different pieces of 
clip art. You can even select certain pieces and 
use the picture formatting tools to remove the 
background of the image to make it align with 
the color of the background beneath it. You can 
also add drawing elements to your logo, such as 
the smiley face added to the logo in the example. 
Whenever you add drawing elements, you must 
set the color options manually; for instance, 
there is no single filter that you can apply for a 
grayscale version.

 FIGURE 11.9
Blended logo
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of the slide; this is where it will receive 

the most attention, but it also means you 

will be distracting your audience from the 

content that is on the slide. Having a suf-

ficiently faded logo in the center of the slide 

is another possibility, but you have to make 

sure it does not take away the attention that 

fade intensity from the column beneath the 

color name, as shown in Figure 11.10.

Resize your logo to a reasonable size 

and adjust the font size of the text to main-

tain the look that you established when you 

initially created the logo. One possible loca-

tion for your logo is at the upper-left corner 

 FIGURE 11.10
Using theme  
colors to  
blend text

If your logo contains too much contrast to filter out using a fade effect, you 
can add a drawing object rectangle to the slide and set its color and trans-
parency to match the slide background and place it on a layer above the logo 
but behind the slide content. This will lower the contrast produced by the 
logo without disrupting the look of the slide. You can see the effect of this in  
Figure 11.11, which shows the logo with and without the rectangle in place.

 FIGURE 11.11
Effects of a 
transparent  
rectangle (shown 
in the  
right image) on  
reducing contrast
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stop is the Title Slide layout slide master. 

Because you should now have both a full-

color logo and a faded logo on this slide, 

you will want to remove the faded copy. 

To do this, just check the box next to Hide 

Background Graphics (or Hide Graphics) 

on the Slide Master ribbon; your faded logo 

should disappear. 

Click the Save icon to save your work 

if you have not already done so. Then click 

the Close Master View icon to get back to the 

regular design view. Now you 

are ready to start creating your 

presentation! 

Activity 11.3—
Creating 

Templates
If you have put sufficient 

effort into the formatting of 

your Slide Master and you wish 

to use your design later, you can 

save your presentation as a tem-

plate file. To do so, click on the 

File menu just as if you were 

belongs on the content of the individual 

slide.

Now select the entirety of your logo (the 

group you made), line it up where you want 

it on the slide, and send it to the back layer 

of the slide (Send to Back) using the Arrange 

icon. You can also do this using the right-click 

menu. You should see the placeholder text in 

front of your faded logo if you have done this 

correctly, as shown in Figure 11.12. Readers’ 

eyes are naturally drawn to the area of high-

est contrast in an image, so make sure the 

text in your text boxes is formatted so it 

stands out over the logo. 

Next you will need to go through each 

layout of your presentation and choose 

where the logo belongs and where it does 

not; this is a yes or no decision because 

your only option in each of these slides is 

to select or deselect the Hide Background 

Graphics checkbox (this is found under 

the Background menu 

in the Themes ribbon for 

PowerPoint 2011). The first 

 FIGURE 11.12
Completed slide 
branding

You can remove background graphics in the regular 
design view for your presentation as well, so you will 
always have the opportunity to remove your logo from 
the background if it is too distracting; this option is 
found in the Design ribbon for PowerPoint 2013 when 
you are not viewing the Slide Master. Choose Format 
Background and then check the box to hide the back-
ground graphics in the pane that appears. Note that 
this will also remove the added slide decorations that 
are added by default to the theme. In PowerPoint 
2011, this option is found on the Themes ribbon under 
the Background icon.
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Outlining
You should always create an outline for 

your presentation before you start adding 

your content. PowerPoint is flexible enough 

to allow you to move slides and add slides 

as needed, but you need to make sure your 

message is delivered successfully through-

out your presentation. Your goal in any 

presentation should be cognitive guidance 

rather than just information presentation. 

Without this higher level of information 

presentation, your audience is unlikely to 

retain for very long anything that you have 

shown them. 

Create a rough draft of your outline on 

paper. You should focus more on the main 

topics that you want to present as opposed 

to the specific slides that you are going to 

include. You may have only a short time to 

present, so make sure you list out the main 

topics you absolutely must cover first. These 

topics should all contribute to the overall 

purpose of the presentation or they should 

be removed. 

Repeat this process with secondary 

topics and so forth until you have all of the 

material listed that you are going to cover. 

Each time you add a new topic, you should 

evaluate the relevance to your overall 

11.3.1saving the presentation normally. Use the 

example presentation for this chapter to cre-

ate a template. Save your file Activity11_3 

and choose PowerPoint Template as the 

document type. Whenever you open a tem-

plate file such as this one, a new presenta-

tion will open based on this style. Give it a 

try to test the results.

CONSTRUCTING 
AN EFFECTIVE 
PRESENTATION

Remember the value proposition you 

constructed earlier in the chapter? Now it 

is time to put it into action! You will create 

your title slide now and then build your pre-

sentation from there.

If you have been following along with 

the example, your title slide should now con-

tain your new logo. Notice that you cannot 

edit it from here; it is fixed in place from the 

Slide Master so you have to change it there 

if you need to alter its placement. Add a suit-

able title to your presentation; note that this 

is not your value statement. The title slide 

should be a quick placeholder to display as a 

short introduction to what you have to say, 

with your name or your organization name 

as a possible subtitle. The title of your pre-

sentation should draw interest as the audi-

ence gathers if you are using this for a live 

presentation; it should give some idea about 

the topic of the presentation, but it should 

do so succinctly. Whether or not you have a 

subtitle is up to you.

11.3

COGNITIVE GUIDANCE is the presen-
tation of information in a manner that 
does not overburden the cognitive load (or 
mental processing capacity) of the viewer 
or recipient while preserving the mean-
ing of the information; this is a preferable 
way to share information, as it leads to 
increased retention and understanding.
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presentation on your computer; keep that in 

mind when you outline your topics.

Best Practices for Outlining

There are a few guidelines you should 

always observe in constructing an outline 

or a map of your presentation. First, you 

should always get the attention of the audi-

ence with the first slide you present; this 

will be the second slide of your overall pre-

sentation. This slide is where the audience 

will determine how important your topic is 

to them and whether they will give you their 

full attention.

Your first slide should capture the 

attention of the audience and interest them 

in what you have to say. It should be rele-

vant to your presentation, but it should not 

give away everything you have to say. Give 

your audience a quick preview of what you 

11.3.1.2

purpose and contribution. If it is not essen-

tial or meaningful to your presentation as a 

whole, it should be removed. You can now 

use this topic list to structure your presen-

tation by constructing a meaningful map of 

these topics.

Adding Slide Notes

You can start to map your presenta-

tion from the rough outline that you have 

just constructed. Add a slide for each topic 

that you need to cover. You are not going to 

construct the actual slides at this point; you 

will save that for the second pass through 

your presentation. Instead, you are going to 

use the Notes pane that is visible across the 

bottom of the interface in Normal view to 

add an outline for what you want to cover 

in each slide. This is the one area where you 

can use as many bullet points as needed. You 

can use the tools available in the Font and 

Paragraph panels of the Home ribbon to for-

mat the text in this area, but you cannot add 

graphic elements like clip art. PowerPoint 

does not allow you to change the font color 

here or use text effects, either.

You should use the Notes pane for each 

slide and make an outline of what you want 

to present. You should not write out every-

thing you are going to say word for word. 

These should be notes to guide you through 

your content instead of a set script to follow. 

If you notice your content for one slide get-

ting too long, you should add a second slide 

for the topic and split the content between 

the two. Remember that while your notes 

will not be visible to the audience when you 

present, others will be able to view what 

you have written here when you share the 

11.3.1.1

To help you outline and organize your presentation, 
PowerPoint 2013 allows you to add section names to 
your slides to organize them into logical groups. This 
allows you to make changes to a specific set of slides 
for one part of your presentation. Your audience can-
not see these section names and they do not appear 
in your outline, so this tool is strictly for your con-
venience and organization. You can add a section by 
using the right-click menu or by selecting the Section 
icon on the Home ribbon. You can use either the right-
click menu or the Section icon to change or remove 
these sections later. In PowerPoint 2011, use the 
right-click menu or select the Insert menu and then 
choose Section.

Your title slide should just be a placeholder before 
you begin; you can think of it as the curtain that rises 
before a theater performance. The second slide in 
your presentation is actually the first slide that you 
should showcase.
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understanding of your audience to help 

determine how much information you need 

to present to them to make it as coherent as 

possible.

When you have demonstrated the main 

contribution of your presentation, you 

should emphasize your main point. After 

all, this is what you came to say, so you need 

to make sure your audience realizes it. Once 

you have given your main contribution, you 

should add any action items that you want 

the audience to take with them. If they are 

responsible for some outcome from your pre-

sentation, you should deliver your charge to 

them at this point in your presentation.

Finally, you will add your summary and 

conclusion. Your summary should be brief 

and it should state your main contribution 

for the third time. A single slide should 

typically be sufficient for a summary; the 

audience has just experienced your entire 

presentation, so you should keep the sum-

mary short. If you have time for questions, 

you can add a slide to prompt the audience. 

A better practice, though, is to transition to 

a slide with your contact information or the 

contact information for your organization so 

people can follow up on their own and then 

simply ask if they have any questions.

are going to show them with your presen-

tation, but do not give them a step-by-step 

breakdown; you want to emphasize the end 

goal with this slide. You need to present your 

main point to the audience three times; this 

repetition will increase the probability of 

cognitive recognition in the audience, which 

will insert the idea into memory. The first 

occurrence should be at the beginning of 

your presentation. The second should be as 

you walk the audience through the problem 

or opportunity on which your contribution 

is built. The last iteration of the main idea 

should be as a summary statement at the 

end of your presentation.

You need to guide your audience to an 

understanding of your perspective and show 

them the value of your main contribution. 

What you have to say is already important 

to you, but you need to frame it in such a 

way that the audience feels it is important 

to them as well. For example, in a research 

presentation, you should provide the back-

ground on the research problem for which 

you are presenting a solution; this will allow 

the audience to see the significance of the 

research that you have done.

Once you have given the audience your 

perspective, you should spend the majority 

of your time presenting what you have to 

offer. This should be done in a clear manner 

that the audience can follow from one step 

or slide to the next. Remember that they are 

building a cognitive map of this information 

as you present it, so jumping unexpectedly 

from a particular topic to something that is 

unrelated or inconsistent will disrupt that 

mapping process. Consider the level of prior 

THE 10-MINUTE MARK 
Humans have a short attention span. Steve 
Jobs suggests that 10 minutes into your pre-
sentation, you need to do something different 
to focus attention back on yourself and what 
you have to say. You can provide handouts at 
this point, show a video, or otherwise get the 
audience to react to you and reengage.
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enough with the color scheme you have 

chosen. If the contrast is not sufficient to 

showcase your text, you can change the 

background style to correct the issue. On 

any slide in Normal view, you can select the 

Format Background icon on the Customize 

panel of the Design ribbon to change your 

options based on the theme you have 

selected; this is found under the Background 

icon in the Themes ribbon in PowerPoint 

2011. Unlike a change in the layout slide 

masters, a change here will change all of the 

background styles for the entire presenta-

tion. If you need to make this adjustment, 

you may want to open your Slide Master 

view and make the design change there 

instead. Make sure your footer appears cor-

rectly on this slide as well. You can see an 

example of an opening slide in Figure 11.13.

Build the Need for 
Your Presentation

No matter what type of presentation 

you are developing, the next step is to give 

the audience the background of why they 

should care about the problem or opportu-

nity you are attempting to solve or exploit 

with your presentation. This is true of 

research presentations, marketing presen-

tations, and simple information presenta-

tions. You cannot fully deliver the value of 

what you are offering if your audience does 

not share a similar perspective on the situa-

tion to which your solution or contribution 

operates. You have to build the problem 

statement for them in language they under-

stand so they will at least have enough 

11.3.3

Grabbing Attention 
in Your First Slide

The first slide of your actual presen-

tation is where you need to grab the audi-

ence’s attention. If this is a sales pitch and 

you fail to capture them at the beginning, 

the likelihood that they will tune in later 

is slim. There are a lot of different ways to 

accomplish this. If this is a research pre-

sentation, you can build a mystery with an 

image or a result that the audience wants 

to see unfolded. With a sales pitch like the 

one in this chapter, a clear value statement 

is one way to begin effectively. You should 

refrain from adding fancy graphics to a text 

statement here because you do not want to 

give the impression that you are trying to 

distract the audience from your main idea.

On the design side, you should evalu-

ate whether your statement stands out well 

11.3.2

Video can be a great tool to assist a presenta-
tion, but it needs to be short and relevant. If 
you are nervous presenting in front of a crowd, 
you can include a short video in your first slide 
to allow you time to calm yourself before you 
have to start presenting in earnest. You can 
insert a video in PowerPoint from a file or 
from a Website. To add a video in PowerPoint 
2013, click the Video icon in the Insert ribbon 
and select the option you want; in PowerPoint 
2011, select the Media icon on the Home rib-
bon. The next chapter will give you more 
specific guidance on including videos in your 
presentation and formatting and editing them 
appropriately. If you are constructing a sales 
pitch, a short video of interviews showing the 
market need or demonstrating your product is 
a great way to grab attention at the outset of 
your presentation.
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and the locations where they 

are most consumed to support 

the establishment of a market 

for the product being offered. 

To turn this into a meaningful 

part of the presentation, you 

need to pull some impressive 

data from this and engage the 

audience with some fun facts. 

The text of your slides should 

be easy to read and interesting 

for your audience, even if they 

do not have the slightest inter-

est in hot dogs!

Your text size should never 

fall below 24 pt font for anything 

your audience is expected to 

read. When you have a few key facts to pres-

ent but they all have a significant amount 

of text, you can choose a two-column layout 

to keep the font size high and keep the text 

on one slide, as shown in Figure 11.14. You 

can change the layout of the slide by click-

ing on the Layout icon on the Slides panel 

of the Home ribbon. In general, you should 

not use more than two columns for any pre-

sentation because it becomes too difficult for 

the audience to read when there is too much 

visual information to absorb at once.

buy-in to listen to your proposed solution or 

product.

Always remember who your audience 

is. Do not waste their time or yours telling 

them what they already know. Similarly, do 

not give them a reading assignment with all 

of the text on your slides, especially if you 

are presenting in person. The problem for-

mulation should be succinct but clear. The 

level of detail you add should be determined 

by the expected audience.

For the example presentation here, it is 

necessary to build the case for the existence 

of a market for a new product. Some quick 

research using the Internet will assist with 

this, though as always you must evaluate the 

legitimacy and credibility of any source on 

the Web. For this example, the Website of the 

National Hot Dog & Sausage Council (www.

hot-dog.org) provides statistics regarding 

the average annual consumption of hot dogs 

 FIGURE 11.13
Example opening  
slide

Never forget to cite the source of your facts in 
your presentation. One way to do this is by 
using the footer; always be sure to give proper 
credit for any text or facts that are not your 
own. At the very least, you should have the full 
citation of the source in the Notes section of 
the slide on which you use that information.

MSOffice-Beyond-CH11.indd   278 6/10/2014   10:44:52 AM



Chapt er  11  — Creat ing  Ef fec t ive   Present at ions  — 279

a substantial market for your product. You 

should try to quickly build suspense with 

the audience so they are interested in the 

solution and your contribution. Too much 

background will overshadow what you have 

to offer and will usually cause the audience 

to disengage from what you are presenting.

Present Your Main 
Contribution

The bulk of your presentation should 

focus on what you have to offer. It should 

again be clear and concise. It should show-

case how you plan to solve the problem at 

hand or capitalize on the opportunity you 

just presented. Your audience can usu-

ally tell when you are stretching content 

or wasting time, just as you can tell when 

someone else is doing it to you, which means 

you need to keep them engaged while you 

present what you have to offer.

11.3.4

Guidelines vary, but the general consen-

sus seems to be a target of three and a limit 

of five facts or bullet points per slide for a live 

presentation. Some professional designers, 

such as Trine Falbe, even argue that each 

slide should have its own point and more 

slides are better than cluttered slides; she 

argues against the use of any bullet points 

at all. More than numerical restrictions, the 

clarity and readability of the slide are the 

most essential qualities. Keep it clear and 

keep it concise. Your audience needs to be 

able to digest any text that you have on your 

slide while listening to what you have to say.

You can be more liberal with the amount 

of text you include in a standalone presenta-

tion, but you must remember that slides are 

not pages of text. Focus on how to effectively 

frame the problem that you want to solve 

or the opportunity you want to exploit. In 

the example, you want to show that there is 

 FIGURE 11.14
Example of two-
column slide layout
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your words will be attached to the image you 

present in the mind of your viewer. Bullet 

points and lengthy text do not form a con-

cise image in the mind, meaning this reten-

tion will not occur if you oversaturate your 

slides.

The Notes section can contain as much 

text as you like, but each slide should pres-

ent only what is absolutely essential. If you 

can present the same idea with an image or 

graph, it is better to do so. You should not 

use the text on your slides as a crutch for 

your presentation; you should rehearse your 

presentation well enough that you recognize 

the points you have to make based on the 

visual information of the slide. Find the lay-

out that supports the information you are 

presenting and tie all of the information on 

the slide together into a single message as 

much as possible. If you cannot pull all of 

the information in your slide into a single 

coherent thought, you need to split the 

information into multiple slides.

Modifying Layouts

You can change the layout of your slide 

to any of the preset options by selecting the 

Layout icon on the Home ribbon and then 

selecting which option you want to use. How 

the information is presented is as impor-

tant as what information is presented; you 

can see an example of this in Figure 11.15 

where the same information is presented 

in two different ways. Chapter 12 contains 

more advanced analysis and instructions for 

including some additional visual elements in 

your presentation to make it more exciting 

and interesting.

11.3.4.2

Keep your slides visually interesting 

by switching between the different layout 

options periodically without overwhelm-

ing your audience with the change. You can 

change the layout of the current slide by 

clicking the Layout icon on the Home rib-

bon and selecting one of the options. If you 

have constructed your Slide Master well 

at the beginning, you should only need to 

make minimal changes to the existing lay-

out slides, which will go a long way toward 

providing consistency and identity to your 

presentation.

In this example, additional slides have 

been added to showcase the planned idea 

and business model. This type of content 

should be the bulk of your presentation and 

should be clear to the audience. Experiment 

with the different layouts to find what works 

best for your business case.

Effective Visualization

Research has shown that the most 

effective way for people to retain an idea is 

for them to experience it visually while it is 

explained to them. This process is termed 

dual-channels. A person has two separate 

concurrent brain processes that take in 

information during a presentation: one 

is the verbal component and the other is 

the visual component. This same research 

has concluded that the visual component 

is superior (termed the picture superiority 

effect), but the best retention comes from 

the visual component supporting the ver-

bal component. What this means for your 

presentation is that you need to make sure 

your visuals supplement what you are say-

ing instead of substituting for it. In essence, 

11.3.4.1
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Summarize and Conclude
Your summary and conclusion should 

reemphasize your value statement and your 

contribution without repeating it word for 

word. It should be the final bit of informa-

tion that you leave with your audience for 

them to consider. One or two slides should 

be the maximum for your summary and 

conclusion; you should not be introducing 

new information here and you do not want 

to repeat the entire presentation since the 

audience has just experienced it. The main 

purpose of the summary and conclusion sec-

tion is to provide a third repetition of the 

main point you want to convey.

Your final slide should contain your con-

tact information for anyone who wishes to 

follow up with you. If you are part of a team, 

you should include the contact information 

for all the team members and the areas for 

which each person is responsible. Make sure 

your contact information is displayed long 

enough for anyone in the audience to copy 

it down if they wish to follow up on your 

presentation. 

11.3.5Tips for Success 

Keep the following tips for a successful 

presentation in mind:

•	Make your font large enough to read. 
When in doubt, walk six feet away 
from your screen and try to read your 
slide.

•	Use bold formatting or an increase 
in word size to emphasize words 
and terms in your presentation, but 
use these sparingly. Italics typically 
make the text harder to read from a 
distance, so it should be avoided.

•	Never change the font color for 
emphasis. Too many colors distract 
the audience and keep the eye from 
focusing on any one area, making it 
difficult for the viewer to read the 
text cohesively.

•	If you have different colors of text 
(such as a hyperlink), keep them 
within the color scheme chosen for 
the overall theme.

•	Keep your content brief and to the 
point. You are creating your presenta-
tion to engage the audience.

•	Create a presentation you would 
want to see. If it looks bad to you, 
it will probably look bad to your 
audience!

11.3.4.3

 FIGURE 11.15
The same  
content in two 
formats
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correct. Misalignment can be distracting to 

your audience and can ruin the impact your 

graphic would have otherwise had; an exam-

ple of the effect alignment has on a graphic 

is shown in Figure 11.16. Your design work 

may be complete, but there are several 

things you still need to do before your new 

masterpiece is ready for public consump-

tion. If you are giving a live presentation, 

you will need to prepare your timings and 

rehearse. If you are sharing your presenta-

tion via the Web or another mechanism to 

present on an individual computer, you can 

either record your narration or set up your 

presentation so it plays automatically with 

the timings that you have defined.

It is common to include a slide seeking 

questions from the audience. Your venue 

should dictate whether this is allowed or 

feasible. If you decide to include such a slide, 

you may want it as a precursor to your con-

tact information or concurrently with your 

contact information. The slide containing 

your contact information is the one that 

should linger on the screen for a live presen-

tation while you field questions because it 

will allow audience members to copy down 

your information if they do not wish to ask 

questions in public or if there is not enough 

time to get to them.

Now that you have completed your 

presentation, you should view it to make 

sure it is coherent and presents the mes-

sage you want with the clarity it needs. You 

also need to check the alignment of your 

images and drawings to make sure they are 

There are some great SmartArt graphics that allow 
you to format contact information for multiple con-
tacts clearly and effectively. The topic of inserting and 
formatting SmartArt is covered in Chapter 12.

If you are sharing a presentation document as 
a supplement after you have presented it, you 
should adjust the slide for questions to direct 
the viewer to the person who can answer 
them. For instance, you would want to change 
the text “Questions?” to something like “If 
you have questions, you can contact…” This 
small change will increase the professionalism 
of the result.

 FIGURE 11.16
The effect of 
alignment  
on a graphic
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the slides to them, so you should have an 

idea of what you are saying without using 

the written text on the slide as a script. You 

should know your presentation well enough 

that you recognize the topics you need to 

cover on a particular slide based on the slide 

graphics alone. 

You can practice your slide timing using 

the Rehearse Timings icon on the Slide 

Show ribbon. This will start your presenta-

tion in Slide Show view with a clock and a 

small interface for moving your slide show 

forward or repeating the current slide, as 

shown in Figure 11.17. PowerPoint 2011 

gives you a larger interface called Presenter 

view (also shown in Figure 11.17), where 

you can see your notes as well. This will tell 

you how long you are spending on each of 

your slides, which is helpful information if 

you need to present within a fixed time limit. 

When you are finished with your rehearsal, 

you will be prompted to save your slide tim-

ings. If you choose this option, your slide 

show will stay on each of the slides for the 

set amount of time that you took to cover 

the material and will switch to the next slide 

automatically when that amount of time 

has passed.

If you have multiple monitors attached 

to your computer, such as the regular display 

monitor and a digital projector, you can select 

Use Presenter View on the Slide Show rib-

bon when you wish to present. This option 

allows you to select which monitor will dis-

play the show in Slide Show view and which 

monitor will show the special Presenter 

view, which contains the slide show and your 

Notes section for the current slide. Using the 

PRESENTING YOUR 
MASTERPIECE

Your presentation is a performance 

piece. Like any theater performance, you 

need to make sure you rehearse what you 

have to say so you can present it coherently 

and with authority. This applies whether 

you are in front of a live audience or record-

ing your narration. You should never find 

yourself in a situation where you are read-

ing the slide contents to the audience; doing 

so will cause them to disengage from what 

you have to say and will give you the appear-

ance of being unprepared. Whether or not 

you like being in front of an audience, you 

should just be yourself. You do not need to 

pretend to be more serious than you are. 

You, not the slides you are presenting, 

will engage the audience. You should not 

be afraid to make them smile and you do 

not have to be perfect; in fact, the audience 

will accept you better if you come to them 

prepared but present as yourself. Most pre-

sentation software gives you a variety of 

options for practicing your slide timing, and 

PowerPoint gives you the option of directly 

recording narration for your slides. You can 

also broadcast your presentation live and 

even save it as a video to share if you are 

using PowerPoint.

Live Presentations
You should go through your notes 

enough times to be familiar with the content 

you are presenting. This is true whether you 

have created the presentation or you are just 

presenting it on someone else’s behalf. Your 

audience will disengage if you start reading 

11.4

11.4.1
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however, when you hold down the Control 

(Ctrl) key and left-click the mouse, the cur-

sor will appear as a laser point on the screen 

for as long as you hold the left button down. 

You can record this mouse movement dur-

ing the default recording process that is 

explained in the next section. The color of 

the laser pointer cursor can be set in the dia-

log box that appears when you click the Set 

Up Slide Show icon in the Slide Show rib-

bon. Figure 11.18 shows the dialog box and 

the pointer in action.

If you need to mark up your slides to 

highlight information, both PowerPoint 

2013 and PowerPoint 2011 give you the 

option to change your mouse cursor to a 

pen. To access this, simply right-click on 

Presenter view can be helpful when you are 

making your presentation, especially if you 

encounter a particularly difficult topic and 

want to make sure you present the correct 

details. However, you should not rely on the 

Notes section of your presentation to speak 

to your audience. It is always better if you 

know your presentation well enough to talk 

to the audience without continually refer-

ring to your notes or your slides.

When you are in Slide Show view 

(or the local Reading view equivalent) in 

PowerPoint 2013, you can use your mouse 

as a laser pointer on the slide to highlight 

information. The default behavior of the 

mouse in this view is to advance the slide 

just like the spacebar or the right arrow key; 

 FIGURE 11.17
Rehearse Timings 
interface

 FIGURE 11.18
Using the mouse  
as a laser pointer
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play by default when the slide is reached 

in Slide Show view. If you do not want to 

keep a particular narration in PowerPoint 

2013, select Clear from the drop-down 

options under the Record Slide Show icon. 

In PowerPoint 2011, you can record the pre-

sentation again to save over the previous 

narration.

Sharing Your 
Presentation

You can share your presentation docu-

ment just like any other file. It can be 

emailed or placed on transferrable media 

to share. Be aware, however, that you must 

include any linked media along with the 

native presentation document or the media 

will not be transferred. 

In PowerPoint, you have the option 

to save your presentation document as a 

PowerPoint Show. To do this, use the Save 

As function and select the document type 

PowerPoint Show (.ppsx). If you save your 

document in this manner, it will open in 

Slide Show view whenever a user clicks on 

its icon. The presentation cannot be modi-

fied in this format, but the viewer does 

not have to have PowerPoint installed to 

view the show; the presentation uses the 

Microsoft PowerPoint Viewer software 

instead. This document type is a good choice 

if you do not want anyone to see the notes 

you have attached and you want the viewer 

11.4.3

your slides in Slide Show view and select 

the Pen option. This will change your mouse 

to a pen for the current slide. You will have 

to advance the slide using the spacebar or 

arrow key, but the default mouse behavior 

will be restored on the next slide.

Recording Narration
If you are sharing your presentation on 

an individual computer screen, you may find 

it beneficial to record narration instead of 

just sharing the slides themselves. In fact, if 

you have constructed the slides successfully, 

you will need narration to support them. In 

PowerPoint, you can easily record narration 

using the Record Slide Show icon. This will 

prompt you for preferences and allow you 

to select whether you want to record your 

narration from the beginning of the presen-

tation or from the current slide. After you 

have set your options, you will be presented 

with an interface that looks just like the 

rehearsal interface except it includes an icon 

to pause and resume the recording.

When you have completed your record-

ing, you can review the narration by select-

ing the Slide Show view (you can do this 

quickly by pressing F5). The narration will 

play just like the animation and transitions 

in the preview mode. The individual narra-

tions will appear as a small audio icon in the 

lower-right corner of the slide and they will 

11.4.2

In order to record sound on your machine, 
you must have a sound card and a microphone 
connected to the audio input line of your com-
puter. Most computers have a default internal 
microphone that you can use automatically, 
but not all of them do!

LINKED MEDIA is any file that has been added 
to the presentation by reference that is not embed-
ded into the presentation document itself. An 
example of this is a file that opens as a result of 
an action being activated.
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require third-party software to display. You 

must also update linked media from any 

Office 2007 (or prior) content that is still 

included in the presentation for it to be 

included in the video.

PowerPoint 2011 offers you the ability 

to save your presentation as a Movie (.mov) 

through the regular Save As function. You 

can adjust the settings for your movie by 

clicking the Options icon on the Save As dia-

log box with Movie selected in the Format 

box.

PowerPoint also offers you the option of 

broadcasting your presentation in a live syn-

chronous environment. This service is avail-

able for all PowerPoint 2013 and PowerPoint 

2011 users, but it does require you to have 

a Windows ID. Clicking the Present Online 

icon in PowerPoint 2013 or the Broadcast 

Slide Show icon in PowerPoint 2011 on the 

Slide Show ribbon will prompt you to log 

in using your Windows ID and password 

(if you are not already connected to your 

account in PowerPoint 2013). The software 

will then generate a public link you can 

to experience the presentation as you have 

scripted it. The drawback of this format is 

that included elements like video are depen-

dent on the properties of the host machine 

the viewer is using and may not work as you 

intended.

The latest versions of PowerPoint have 

overcome this limitation by providing the 

ability to save your presentation as a video. 

In PowerPoint 2013, you can save your 

presentation as a video by clicking on the 

File menu and selecting  Export and then 

Create a Video. This will open a new menu 

of options where you can select the video 

resolution you want, whether you want to 

use recorded narration and timings, and if 

you want to spend only a set amount of time 

on each slide. Once you have selected your 

options, click the Create Video icon beneath 

the settings, as shown in Figure 11.19. This 

will open the Save As dialog box where you 

can save the presentation as a Windows 

Media Video (.wmv). This format will 

include all of your content in the video except 

Apple QuickTime movies and elements that 

 FIGURE 11.19
Create a Video option 
in PowerPoint 2013
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this format is what is recorded within the 

presentation.

Activity 11.4—Exporting 
Your Presentation

Using the presentation you constructed 

in this chapter, you will export it as a video. 

Follow the instructions given for your ver-

sion of PowerPoint and note the options that 

are available for the video settings. Save your 

video as Activity11_4 in the Activities folder 

you created. Play back your video to see the 

end result.

share that can be used by up to 50 view-

ers to access your presentation live over 

the Internet whether or not they have 

PowerPoint installed. This will play your 

presentation in a special Broadcast view, 

which allows you to control your presenta-

tion as you would in a live setting. Once you 

have finished your presentation, click End 

Broadcast; this will terminate any viewer 

connections to your presentation and the 

link will no longer be valid. You should note 

that the only audio that will be shared in 

 FIGURE 11.20
Completed chapter 
example slides

CHAPTER SUMMARY
This chapter focused on the effective use of presentation software to impact your audi-

ence and assist you in presenting what you have to say in the best possible manner. Using 

a Slide Master and predefined formatting options, you can quickly create the design of your 

presentation to allow you to focus on the content, which is by far the most important aspect 

of any presentation. You should also now have an understanding of how to share and present 

your new slide show. You can see the completed slides for the chapter example in Figure 11.20. 

This should give you a comparison for the structure and presentation of your own work. The 

next chapter will focus on additional graphic enhancements and media you can add to enliven 

your presentation even more.
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CHAPTER KNOWLEDGE CHECK
A  is what you have to offer to whoever is viewing your slides or listening to 
your presentation. 

 A. Value proposition

 B. Brief summary

 C. Value add

 D. Proposal

The  is the option that allows you to set up your initial presentation style.

 A. Slide list

 B. Content

 C. Slide Master

 D. Theme menu

Readability should be the highest consideration when you are choosing which fonts to use in your 
presentation, followed by aesthetic coherence with the overall presentation.

 A. True

 B. False

PowerPoint has a number of preset color schemes from which you can choose; once you choose a 
theme, this setting will default to the color scheme that matches that theme.

 A. True

 B. False

You should start your presentation with your overall  and your 
 proposition in mind. 

 A. Idea, value

 B. Value, business intelligence

 C. Idea, proposal

 D. Idea, simple

To configure a text shadow, select  from the menu beneath the preset options.

 A. Design

 B. Transitions

 C. Shadow Options

 D. Slide Orientation

1

2

3

4

5

6
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Three points to keep in mind toward the development of a successful presentation are the following:

 A. Idea, value proposition, consistency

 B. Proposal value, idea, consideration

 C. Idea, value, reliability

 D. None of the above

Creating too much contrast with the background will draw too much visual attention.

 A. True

 B. False

On the Master Slide view, you can select the Background Styles icon on the Background panel of 
the Design ribbon to change your options based on the theme you have selected.

 A. True

 B. False

You can practice your slide timing using the  icon on the Slide Show ribbon. 

 A. Rehearse Timings

 B. Animation Timing

 C. Duration

 D. Advanced Slide Timing

CHAPTER REVIEW QUESTIONS
Why might this chapter suggest that advanced users should manually stylize slides rather than 
using the slide master? How would this be beneficial?

What is the importance of the value proposition? How does it serve to guide the rest of the 
presentation?

When including a PowerPoint as a part of an overall marketing campaign, what factors should be 
considered to promote clarity, consistency, and cohesion?  

How do you make audiences believe in what you are presenting to them? What are some strategies 
you can use to create a need for your presentation?  

Is there an advantage to sharing your presentation in person versus sharing your presentation 
through various media technologies such as the Web?

1

2

3

4

5

7

8

9

10
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Describe the benefits of using the practice mode to time your slides before presenting. How else 
can you prepare for a live presentation of your PowerPoint slides?

When would it be beneficial to construct a PowerPoint to be turned into a video? How could this be 
applied for sharing information? When would this be useful considering there is dedicated video 
editing software available?

Compare two different venues that would have different requirements for a presentation. 
Describe the venues and the effect it would have on the choices of font and color in a PowerPoint 
presentation.

Explain why it would be better to adjust the font, bullets and numbering, and color of text in a slide 
master instead of in the presentation itself. Give an example of when you would want to change this 
in an individual slide instead of a slide master.

Explore the slide master to determine whether you can apply formatting and effects to placeholders 
for media other than text (such as charts or images). State what changes can be made for these 
elements, if any. What would be the benefit of being able to adjust these properties in the slide 
master?  

7

6

8

9

10

PRACTICE EXERCISES
Using the skills learned in this chapter, develop a 10-slide presentation on a topic of your choice 
using all three of the important considerations provided: the idea, value proposition, and consistency. 
Use the Slide Master to develop a consistent presentation by using a built-in theme and choosing 
formatting and colors that provide aesthetic coherence.

Develop a 10-slide presentation that explains a fictional business plan for an idea that you have for 
a new venture. Imagine that you are presenting to a group of potential investors who may finance 
your business idea. The investors have contacted you and advised that they are unable to visit you 
onsite and have requested that you share the presentation with them using narration. Integrate 
voice narration and timing into your presentation and prepare the file for sharing as explained in this 
chapter.

Using a fictional business, create a value proposition for a product you are launching.  This should 
be a statement of no more than two sentences that outlines the benefits offered by your business’ 
product or service. Create three alternate slides to present this information. Which of these is most 
effective? Why is this the case?  

Use a value proposition to help you create a PowerPoint presentation for your grand opening. Design 
a presentation that will let the attendees know about your new business and what it offers that your 
competitors do not offer. Make sure to establish the presentation’s visual style using a slide master. 
Write a summary of your theme choices. Make sure to include the elements that will affect where 

1

2

3

4
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and how you will be presenting your PowerPoint presentation. For instance, you might want to 
discuss your chosen venue’s lighting and acoustic setup which will inevitably determine any 
constraints.  

To ensure that you maintain your audience’s focus, develop your 10-minute plan. If your 
presentation you created for your business is shorter than ten minutes, use the midway mark. 
Devise a plan to regain or refocus your audience’s attention during your presentation. Describe your 
plan and develop any additional materials needed.  

5

CHALLENGE EXERCISES
You will want to create a recognizable logo for your business. Using the tools available to you design 
a personalized company logo that you will place on each slide of your presentation. Include it in an 
appropriate place on your slides, and make sure to use a fade effect to make it more subtle. Then 
explain all of the visual elements you used to formulate your logo in a word document. Additionally, 
use the Word templates available to create a business card with that same logo. 

Use the slide master to edit the properties for a blank presentation. Include either a logo or an image 
in the background and add a new layout type to the available slides. Save your work as a template 
and then create a new presentation based on the template. How do design changes in the new 
presentation affect the choices made in the template? What aspects of a template can be overruled 
without using the slide master?

Create a 5 slide presentation and prepare narration for each slide. Create a recording of your 
presentation and save it as a PowerPoint show. When would this type of media presentation be 
useful? How would you distribute a media presentation like this?

Select a layout in Slide Master View for a presentation that includes a specialized placeholder for 
either an image or a table. Format this placeholder using the various tools and then switch back to 
the normal view and create a slide using the layout you altered. What formatting elements are 
retained when you populate the placeholder with content? 

Create a new presentation and determine whether it is possible to apply themes, color changes, and 
formatting only to select slides in a presentation. What changes in a presentation are global? What 
changes to a slide are local to that slide only?

1

2

3

4

5
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CHAPTER  

12
Advanced Features  
of Presentation Software

IN THIS CHAPTER

Now that you are familiar with the concepts of creating presentation documents, 

you can improve the impact you have on your audience with the use of advanced 

media. This chapter covers how to add more complex media elements into your 

slides and where and how to use them effectively. You will also learn how to 

create handouts to support your presentation and configure more advanced 

elements of your presentation content. When you have completed the chapter, 

you will be able to:

●	Format and create handout pages to accompany your 
presentation

●	Add advanced media to your presentation, including 
sound, video, tables, charts, and graphs

●	Create animation within your slides and change the 
timing and start conditions for your animation effects

●	Configure slide properties and define custom sizes and 
layouts

●	Export your slides as image files

Microsoft Office 
2013/365 and 

Beyond
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notes in notes pages. You can also print the 

slides themselves at one slide per page or 

print just an outline of your presentation, 

which contains only the text elements of your 

slides without the theme and background 

design or formatting and effects. You can 

preview this outline at any time by selecting 

the Outline tab in the Slides/Outline pane. 

The options for printing any of the hand-

out types are available from the Print icon 

under the File menu in PowerPoint 2013, as 

shown in Figure 12.1. In PowerPoint 2011, 

you select the type of handout you want to 

print in the Print What entry of the stan-

dard Print dialog box (accessed by selecting 

Print from the File menu).

Modifying the 
Handout Master

The Handout Master will be used as 

a template automatically in PowerPoint 

whenever you are printing multiple slides 

per page. In PowerPoint 2013, you can 

12.1.1

CREATING 
HANDOUTS

When you create a presentation, partic-

ularly one that is being presented live, you 

may want to also create handouts that you 

can distribute to your audience. You should 

make sure that any handouts you provide 

continue the narrative of the presentation in 

a way that enhances the audience’s under-

standing. You should also be careful not to 

give out your handouts too soon, especially 

not before you present or as you begin your 

presentation. Your audience is always going 

to be more apt to pay attention to what is in 

their hands than what they are being shown 

or told.

There are two main types of handouts 

commonly distributed with a presentation; 

these are either miniature versions of the 

slides themselves as handout pages or a com-

bination of the slide and the accompanying 

12.1

 FIGURE 12.1
Print options for 
PowerPoint 2013
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The text boxes in this master can accept 

text effects just like text boxes in any other 

slide. This means you can change the font, 

add effects, and change the font color and 

size. It is usually a good idea to at least 

change the font to match the rest of the pre-

sentation. When you are creating handouts, 

you are changing your presentation from a 

primarily visual medium to a printed one, 

so you need to keep the consistency of the 

entire package in mind. The font and color 

selections for the Handout Master affect 

this page only (and the printed pages that 

are based on it) and will not alter the design 

of the slides themselves.

Modifying the 
Notes Master

If you followed along with the example 

project in Chapter 11, you should have sub-

stantial outline notes in your sales pitch pre-

sentation. If that is the case, you can simply 

open your MySalesPitch file and work from 

12.1.2

customize the Handout Master by select-

ing the View ribbon and selecting Handout 

Master. This will open a context-sensitive 

Handout Master ribbon, shown in Figure 

12.2. The Design ribbon will once again dis-

appear until you close the Handout Master 

by clicking the Close Master View icon. To 

access the Handout Master in PowerPoint 

2011, select the Themes ribbon, choose Edit 

Master, and then select Handout Master.

The options in the Handout Master rib-

bon allow you to make any of the four text 

boxes in the header and footer of the docu-

ment visible or invisible. You can edit the 

contents of these text boxes in the preview 

document where you ordinarily see the slide 

you are creating. The default number of 

slides per page can be set in this ribbon, but 

you can alter that setting when you print 

the document. You will not see a preview 

of your slides on this page, and you cannot 

edit the slide contents while the Handout 

Master is open.

 FIGURE 12.2
Handout Master 
interface in 
PowerPoint 2013
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color scheme of the text; if you are printing 

in grayscale, using a lot of color in the text 

boxes or for the background is not a good 

idea.

The notes that have been written in the 

slides themselves will be formatted using the 

options you set in the placeholder text box 

for the notes in this view; this is where you 

can add effects such as shadows and reflec-

tions to your notes. However, you should 

make sure the effects fit with the theme of 

the presentation and the notes are readable 

in print format. You do not have the restric-

tions of screen projection to consider with 

the notes formatting, but the notes should 

it. If you want to use an existing example to 

see how the Notes function works, you can 

open the MySalesPitchNotes presentation 

from the companion resources.

With your presentation open in 

PowerPoint 2013, click on the View ribbon 

and select Notes Master. This will open the 

Notes Master view, which has its own con-

text-sensitive Notes Master ribbon, as shown 

in Figure 12.3. To access the Notes Master 

in PowerPoint 2011, select the Themes rib-

bon, choose Edit Master, and then select 

Notes Master.

You can format any of the header and 

footer placeholders in this view using text 

effects and the font and paragraph settings. 

You also have the option of setting a back-

ground style for the pages, but remember 

that the text elements need to be legible 

in print and any background you add will 

increase ink consumption. Be sure to also 

consider the quality of the handouts you 

will be printing when choosing to alter the 

 FIGURE 12.3
Notes Master 
interface in 
PowerPoint 2013

While background options are not included 
in the main ribbon interface, you can format 
the background in PowerPoint 2011 by using 
the right-click menu. Just right-click inside of 
the page and select Format Background; this 
will allow you to alter the background as you 
would any other object.
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to your slide, the video should stand alone. 

If you have a table, it will be difficult enough 

for your audience to read, so you can add 

slight graphic enhancements to emphasize 

your point, but you should stay away from 

clip art on the same slide. Keep visibility and 

focus in mind for your audience. 

If you are distributing your presentation 

on the Web or presenting it on a machine 

that is not your own, you want to keep the 

file size of the presentation document in 

mind as well. Large files will not download 

as quickly and cannot be as easily shared; 

your audience may not have the patience 

to download a large file from a Website if 

they are only casually interested in a sub-

ject, which means they will not even give 

your presentation a chance if it is too big. By 

default, video and sound take up more file 

space than images and static text. Text and 

drawing objects do not require a lot of mem-

ory to store. Make sure the media you add 

is necessary or serves a purpose; otherwise, 

it should be removed. There is no absolute 

maximum size, but you should take care not 

to go too far over 2 MB for a casual presenta-

tion shared on the Internet. Most Internet 

connections can handle that amount of 

information in a short enough time that the 

user will not become frustrated while the 

presentation downloads.

Sound and Video
PowerPoint offers a lot of options for 

inserting sound and video into your pre-

sentation. Any sound that you add should 

be minimal, however. Harsh sound is dis-

rupting to a viewer, especially when fade-in 

12.2.1

be treated the same as any printed docu-

ment. The outline levels in the notes text 

box of the Notes Master view can be format-

ted the same way as the outline levels of the 

Slide Master in the Slide Master view. You 

can alter the position of any of the text boxes 

on this screen as well, but the default lay-

out is optimal for printing. Double-clicking 

the preview of the slide will open the Slide 

Master view and allow you to edit the Slide 

Master.

Activity 12.1—The 
Notes Master

Using the presentation for this chap-

ter, modify the Notes Master to change the 

display of the slides in this view. Do these 

changes carry over to the normal view of 

the slides? When would you want to make 

changes to the slide display in this view 

instead of the Normal View? What options 

are available for formatting the text within 

the slide compared to the text of the notes 

themselves? Explore these options and save 

your presentation as Activity12_1 in the 

Activities folder.

ADDING ADVANCED 
MEDIA

A plethora of media options can be 

embedded into presentation software 

beyond the images and clip art that have 

been discussed so far. The key to using 

media effectively in your presentations is to 

make sure you are using it with the purpose 

and audience in mind. It is easy to overdo 

the amount of media in presentations, so 

you should restrict the media elements on 

each slide. For instance, if you add a video 

12.2

MSOffice-Beyond-CH12.indd   297 6/10/2014   10:54:16 AM



298 — Microso f t  Of f i ce  2013/365 and  Be yond

an audio interruption in a formal setting. 

You can find a suitable audio clip using the 

Office.com Clip Art window in PowerPoint 

2013 and entering the keyword fanfare in the 

Search for box. Once you have selected your 

sound (you can preview sounds by holding 

your mouse cursor over each sound icon), 

you will see an icon that looks like a speaker 

appear in your slide. This is the action icon 

for the sound. When you select the action 

icon for an audio file in PowerPoint 2013, 

two context-sensitive Audio Tools ribbons 

appear, as shown in Figure 12.4. The two 

ribbons are the Format ribbon (which con-

tains the familiar formatting tools you have 

seen used for images) and the Playback rib-

bon. PowerPoint 2011 has only the Audio 

Format ribbon, which combines the for-

matting options with a small number of 

effects are not used. Other than narrat-

ing the slides in a saved presentation, you 

should use sound only when it makes a 

strong point that a visual element cannot 

make. To add audio to your presentation 

in PowerPoint 2013, click the Insert ribbon 

and then the Audio icon; from here you can 

select Online Audio to access the Office.com 

library. To add audio in PowerPoint 2011, 

click the Media icon on the Home ribbon 

and select Audio from File. You can choose 

an audio file either from a file on your local 

machine or from the clip art collection. 

A fanfare is a single-use audio file for a 

slide with a big reveal, such as the venue for 

your first business location. You should only 

use it once to get the attention of your audi-

ence and it should be short. This only works 

in a more casual setting; you should not use 

 FIGURE 12.4
Audio icon and 
Audio Tools 
ribbons in 
PowerPoint 2013
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to apply the trim. This process does not 

remove the trimmed ends from the file, so 

you can go back into the Trim Audio dialog 

box to make changes later.

You use the Playback ribbon in 

PowerPoint 2013 to set the start trigger, or 

what causes the audio to begin; this can be 

when the slide appears or it can be triggered 

manually. Setting the Start option to Play 

Across Slides means the audio will continue 

even after the slide on which it was started 

is changed in Slide Show view. You can also 

set a duration for the Fade In and Fade Out 

options, which determines how long it takes 

the sound to start playing from zero vol-

ume to its set level or from its set level to 

zero volume, respectively. PowerPoint 2011 

allows you to set the start trigger in the 

Audio Format ribbon by setting a value in 

the Start field.

Now it is time to add a video to the pre-

sentation. The video is going to be on the 

additional features from the equivalent 

Playback ribbon in PowerPoint 2013; the 

audio editing options in PowerPoint 2013 

are not available in PowerPoint 2011. When 

you select the action icon for the audio file in 

your slide, a pop-up interface appears that 

lets you preview the file using the play but-

ton and set the volume. 

The Playback ribbon (which is only 

available in PowerPoint 2013) has a num-

ber of useful features. The Set Bookmark 

feature lets you set where you want to start 

the audio clip or where you want to stop it 

if it should play from the beginning. You 

can then use the Trim Audio icon to access 

the Trim Audio dialog box, shown in Figure 

12.5, in which you can cut off excess parts of 

the sound file that you do not want to play. 

You can click and drag the green start 

slider and the red end slider to whatever sec-

tion of the audio you want to keep. Having 

the bookmark in place will simply let you 

slide directly to that mark. You can also pre-

view the audio in the Trim Audio dialog box, 

so it is possible to complete the same task 

without using bookmarks as you gain more 

experience. Click OK when you are finished 

 FIGURE 12.5
Trim Audio dialog 
box in PowerPoint 
2013

You can alter the volume setting for the clip, but be 
aware that this will be a relative value to the over-
all volume setting of the machine on which the slide 
show is being presented.
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Clip Art library has some options available, 

but they probably are not worth using in 

the first 30 seconds of your presentation. 

You should ideally have a specific video in 

mind for this first slide. For this example, 

use the file MySalesPitchVideo. Once you 

have chosen your file, you will see the two 

context-sensitive Video Tools ribbons shown 

in Figure 12.6. The two ribbons include a 

Format ribbon, which is the same for audio 

and images, and a Playback ribbon that is 

almost identical to the audio equivalent. 

PowerPoint 2011 allows you to add a video 

from the Media menu in the Home ribbon; 

this provides you with the context-sensitive 

Format Movie ribbon, which has all of the 

formatting commands and a subset of the 

Playback ribbon options in PowerPoint 

2013. When you select a video image in 

PowerPoint, you will see a small pop-up 

menu that allows you to play the file, adjust 

the audio, and move among any chapters 

that exist in the file.

attention-grabbing first slide even before 

the value statement that you constructed. 

As this presentation is your first introduc-

tion to the audience, it should be something 

that gets their attention and introduces the 

subject of the presentation. Insert a new 

slide after the title slide with the default lay-

out; this is where you will insert your video.

To insert a video in PowerPoint 2013, 

select the Insert ribbon and then choose the 

Video icon. You can also insert a video from 

a file using the Insert Media Clip quick link 

in a placeholder text box for content. The 

PowerPoint offers the ability to insert a movie from 
the embed code of a Website in HTML format. Doing 
so does not give you the full options for video edit-
ing and will instead import the player that is used on 
the Website to display the content. It is usually a bet-
ter choice to use a downloaded video in PowerPoint 
because you have more control over how it looks and 
how it plays. There are also a lot of copyright issues 
you need to consider with the use of any media file 
taken from the Web.

 FIGURE 12.6
Video Tools 
Playback ribbon 
and pop-up 
Video menu in 
PowerPoint 2013
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by selecting a unique look for the player. An 

example of this is shown in Figure 12.7.

Tables
Just as in word processing software, 

tables are a great way to provide visual 

organization for information. The difference 

between the use of tables in word process-

ing documents and in presentations is the 

readability of the information in a table. In 

a written document, it is easy for the viewer 

to absorb the information and identify the 

relevant elements. This is not the case with 

a presentation. Anytime you use a table, you 

should either limit the text so the audience 

can read the entire table quickly or highlight 

a certain element of the table with addi-

tional visual notation so the audience knows 

where to look. Adding too many rows and 

12.2.2

Most of the configuration options for 

video are the same as they are for audio. 

PowerPoint 2013 allows you to configure 

Fade In and Fade Out effects. Whenever 

you use a Fade In effect, though, the video 

screen will fade from solid black and zero 

volume; similarly, a Fade Out effect will fade 

to a solid black screen and zero volume. The 

Trim Video interface (again available only 

in PowerPoint 2013) has the same func-

tionality as the Trim Audio interface, but it 

includes a preview of the video as well as the 

sound. 

Whenever you are showing a video, it 

should take up as much of the screen as it 

reasonably can within your theming. You 

can remove the placeholder text box for a 

title to increase the screen size of the video 

and make the slide more visually interesting 

 FIGURE 12.7
Formatted 
example of a 
video within a 
slide
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Table icon. This opens a pop-up menu that 

allows you to highlight the number of rows 

and columns you want your table to have, 

as shown in Figure 12.9. You can access the 

same Insert Table dialog box from this menu 

that you could from the quick links on the 

placeholder text box. In PowerPoint 2011, 

you can add a table from the quick links or 

by selecting the Table ribbon and choosing 

the New icon; this will open the same pop-up 

menu where you can choose the number of 

rows and columns for your table.

The table in this example has four rows 

and three columns. Once you have selected 

the number of rows and columns for the 

table, you can start to format the table itself. 

Clicking and dragging any of the corner grab 

points or the midpoint grab points resizes 

the entire table. Clicking and dragging any 

columns turns the table into an eye chart 

for the audience at the back of the room. 

Remember that when an audience is read-

ing, they are not listening to the speaker.

The next element to add to the sales 

pitch presentation is a short version of the 

menu. Add a new slide to your presenta-

tion after the slide that shows a graphic of 

a sample product. There are several ways 

to insert tables into a slide. The first is to 

use the quick links from one of the content 

placeholder text boxes. When you click the 

table icon, a small Insert Table dialog box 

appears, as shown in Figure 12.8, in which 

you can select the number of rows and col-

umns you want for your table. When you 

have set these values, click OK.

Another alternative in PowerPoint 

2013 is to use the Insert ribbon and click the 

 FIGURE 12.8
Insert Table dialog 
box from quick 
links in PowerPoint 
2013
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PowerPoint 2011. Checkboxes let you spec-

ify whether you want particular rows high-

lighted in a different color than the rest. The 

example uses the Header Row and Banded 

Rows options to increase the distinction 

between the elements of the table. You can 

select any of the predefined styles from the 

Table Styles panel, and you can also set the 

Shading color, Borders, and Effects options 

for the cell you currently have selected. The 

Draw Borders panel lets you define the 

of the vertical or horizontal lines within 

the table resizes the table cells. When you 

select a table in PowerPoint 2013, two con-

text-sensitive Table Tools ribbons appear, as 

shown in Figure 12.10. The Tables ribbon 

is always present in PowerPoint 2011, but 

when you select a table, the Table Layout 

ribbon appears.

The Design ribbon for the Table Tools 

in PowerPoint 2013 allows you to set up how 

your overall table will look; these options 

are found on the standard Tables ribbon in 

 FIGURE 12.9
Table menu from 
the Insert ribbon in 
PowerPoint 2013

 FIGURE 12.10
Table Tools 
ribbons in 
PowerPoint
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particular cell or result you want to high-

light, you can modify the look of that cell so 

it draws more attention. You can also add a 

drawing object like a circle to emphasize to 

your audience that they should pay atten-

tion to that particular element of the table. 

Long tables can interrupt the flow of a pre-

sentation just like a long list of bullet points, 

so make sure you use tables sparingly.

Charts
Charts are another great way to pres-

ent data quickly. A chart can display a lot 

of complex data in a single visualization 

that may take a significant amount of text 

to explain. In PowerPoint, charts are built 

from Excel spreadsheet documents. Do 

not be intimidated if you have never used 

Excel before, as the example here just uses 

12.2.3

thickness and color of the borders for the 

currently selected cell (or cells).

The Layout ribbon for the Table Tools 

(or the Table Layout ribbon in PowerPoint 

2011) allows you to modify the size of the 

selected cells, the size of the overall table, 

and the placement of text within the cells, 

as well as add or remove rows and columns. 

You can also use Merge Cells to merge mul-

tiple neighboring cells into a single cell of 

the table or Split Cells to split a single cell 

into multiple cells. The Distribute Rows and 

Distribute Columns icons will attempt to 

give each of the cells in your table an equal 

division of the height or width of the table, 

respectively. A completed example for the 

menu table is shown in Figure 12.11.

Remember that your table needs to 

be readable above all else, so if there is a 

 FIGURE 12.11
 Completed table 
example

MSOffice-Beyond-CH12.indd   304 6/10/2014   10:54:17 AM



Chapt er  12  — A dvanced  Features   o f  Present at ion  Sof tware  — 305

dragging the blue indicator in Excel that 

encloses the data used by the chart. 

Since the summer months see the larg-

est sales for hot dogs, the business will 

launch in June. Therefore, enter June, 

July, and August for the Category names 

in Column A of the spreadsheet. Then add 

the word Sales in place of “Series 1.” For the 

data values, June will have 1 sale (cell B:2), 

July will have 250 (cell B:3), and August 

basic information. (You will learn about 

Excel in Section IV, “Spreadsheet Software 

and Microsoft Excel”). To insert a chart in 

PowerPoint 2013, use the Insert ribbon and 

select Chart. In PowerPoint 2011, select the 

Charts ribbon and choose the type of chart 

you want to insert. You can also add a chart 

from the quick links Insert Chart icon from 

any content placeholder text box. This opens 

the Insert Chart dialog box for PowerPoint 

2013, shown in Figure 12.12; in PowerPoint 

2011, this just activates the Charts ribbon. 

(You will learn more about creating charts 

in Chapters 13–15). 

For now, select a simple Line Chart from 

the list and click OK. This will open a small 

Excel window within PowerPoint, as shown 

in Figure 12.13. The data that will be used 

to construct your line graph is displayed 

in the spreadsheet in Excel. This example 

will show a simple line indicating projected 

sales for the first three months of operation. 

You can resize the data used in the chart by 

 FIGURE 12.12
Insert Chart dialog 
box in PowerPoint 
2013

 FIGURE 12.13
Completed chart 
data entry
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and styles that you can select to display your 

data from the Chart Layouts panel and the 

Chart Styles panel. You can also use the Edit 

Data icon (Edit in PowerPoint 2011) on the 

Data panel to open the Excel spreadsheet to 

make any changes to the data on which the 

chart is based.

The Layout ribbon for Chart Tools (or 

the Chart Layout ribbon in PowerPoint 

2011) allows you to change the display ele-

ments of the chart. You can primarily change 

how much visual information is displayed 

on the chart using this ribbon. The options 

on this ribbon differ for PowerPoint 2013 

and PowerPoint 2011. Some of the function-

ality for the PowerPoint 2011 ribbon is part 

of the menus beside the chart in the slide 

itself in PowerPoint 2013.

For the example, select the Data Labels 

icon and choose Above; you can find this 

option in the Design ribbon for Chart Tools 

in PowerPoint 2013 under the Add Chart 

Elements icon. You should now see the pro-

jected sales figures for each data point of the 

chart corresponding to the months. Select 

will have 5000 (cell B:4). The completed 

data entry and the proper position for the 

blue indicator point are shown in Figure 

12.13. Once you have completed the data 

entry, close Excel. You can reopen it from 

the Design ribbon for Chart Tools by select-

ing the Edit Data icon, which will allow you 

to either open the small window within 

PowerPoint or open Excel fully.

PowerPoint should now return to its 

former window size and you can see the 

three context-sensitive Chart Tools ribbons 

that appear as shown in Figure 12.14. The 

Format ribbon that appears here should be 

familiar to you by now; this allows you to set 

the text effects and shape effects of the dif-

ferent chart elements. For instance, you can 

add a shadow to the sales line you have cre-

ated or add text effects to the chart informa-

tion, but you should not sacrifice clarity and 

readability to add effects. 

The Design ribbon for Chart Tools (the 

standard Charts ribbon in PowerPoint 2011) 

allows you to set the look and feel of the 

chart. There are a number of preset layouts 

 FIGURE 12.14
Context-sensitive 
Chart Tools 
ribbons
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particular data points rather than adding 

any text comments.

SmartArt
SmartArt is a tool that is available in 

most of the Office applications; it converts 

bulleted text (typically with two outline 

levels) into a professional-looking graphic 

image. The styles and format for SmartArt 

are all predefined, but you can alter the 

color scheme to match your presentation 

and change certain style attributes. 

One possible use of SmartArt is to cre-

ate a graphic for contact information that 

can include text and images for multiple 

people, such as if there is more than one 

author of the presentation or if multiple 

people or groups should be listed for pos-

sible follow-up after the presentation. For 

12.2.4

the Legend icon and choose None to remove 

the series name from the chart; this is not 

necessary when you have only one vari-

able that you are tracking as in this exam-

ple. Since there is a slide title, you can also 

remove the chart title by selecting Chart 

Title and choosing None. The completed 

chart is shown in Figure 12.15.

You can alter the font size for any of 

the text elements of the chart using the 

Home ribbon. You can also change the size 

of the chart manually by dragging the grip 

points on the corners and midpoints just as 

you can for any other object in PowerPoint. 

When you use a chart, it should take up the 

majority of the slide or it will likely not be 

readable to the audience. If you have specific 

points you want to make about the chart, 

you can add drawing objects to highlight 

 FIGURE 12.15
Completed chart 
example
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on your previous contact page). To insert a 

SmartArt graphic in PowerPoint 2013, select 

the Insert ribbon and choose SmartArt; you 

can also use the SmartArt quick link within 

the content placeholder text box. This will 

open the Choose a SmartArt Graphic dialog 

box shown in Figure 12.16. From here, you 

the sales pitch example, you are going to 

use SmartArt to replace the existing contact 

information slide (which was created in the 

example project in Chapter 11).

Create a new slide at the end of the pre-

sentation with the default layout and add a 

title (you can use Questions? just like you did 

 FIGURE 12.16
Choose a 
SmartArt Graphic 
dialog box in 
PowerPoint 2013

 FIGURE 12.17
Example SmartArt text entry box and SmartArt Tools Design ribbon in PowerPoint 2013
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In the Layouts panel, you can change the 

SmartArt graphic within the same style as 

the current graphic; if you need to change 

the entire category, you must create a new 

SmartArt graphic. 

The Colors icon lets you adjust the color 

scheme of the graphic, and the SmartArt 

Styles panel allows you to make changes 

to the look and feel of the entire graphic at 

once. Reset Graphic sets the style back to 

the default settings. Finally, the Convert icon 

allows you to change the SmartArt graphic 

into regular drawing objects and text. The 

new slide with the SmartArt graphic will be 

used as your new contact slide, but do not 

delete the old contact slide yet; you will use 

it in a later section of this chapter. 

These functions are all available in 

PowerPoint 2011, but their locations are 

split between the SmartArt ribbon and the 

Text pane. The promotion, demotion, and 

ordering icons are on the Text pane, while 

the formatting and style options remain on 

the SmartArt ribbon, where you can change 

the layout of your graphic as well. The Text 

pane will appear as a small clickable icon 

beside the graphic when it is hidden so you 

can reactivate it from there.

Activity 12.2—SmartArt
Create a new presentation and save 

it as Activity12_2 in the Activities folder. 

can select the type of graphic you want to 

create. In PowerPoint 2011, you can open 

the SmartArt ribbon and choose the graphic 

type you want to use. For the example, 

choose Vertical Curved List from the List 

category. When you insert and select a 

SmartArt graphic, a small window appears 

in which you type the text of your graphic 

in bulleted outline form. The outline level of 

the text determines where it is placed on the 

graphic.

When you select the SmartArt graphic, 

you will also see two context-sensitive 

SmartArt tools ribbons; these are the Design 

ribbon and the Format ribbon. The Format 

ribbon is similar to the other formatting rib-

bons you have already seen; you can change 

the style of the drawing object within the 

SmartArt graphic selected and you can 

change the text formatting for any selected 

text. An example of the active Design ribbon 

is shown in Figure 12.17 (along with the 

SmartArt text entry box for the example).

The Design ribbon in PowerPoint 2013 

contains several tools specific to SmartArt. 

The Create Graphic panel provides you 

with tools to add to your graphic or rear-

range elements. The Add Shape icon allows 

you to insert new graphic objects for your 

SmartArt and select their placement (rela-

tive to the currently active bullet point or 

object). You can also show or hide the Text 

pane using the Text Pane icon. The Promote 

and Demote icons allow you to change the 

outline level of the selected bulleted text, 

and Move Up and Move Down allow you 

to adjust the order of the objects (you can 

use these within the Text pane as well). 

Some SmartArt graphics will have placeholder ele-
ments to add a picture. To add pictures, click the pic-
ture icon in the graphic or the picture icon next to the 
text in the Text pane. You can edit the image and its 
properties with the same Picture Tools Format ribbon 
that you use for any other image.
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its placement location; the animation will 

end with the element in the location where 

it was initially placed before any anima-

tion effects. Emphasis animations start and 

end with the object in the same location in 

which it started; this is used to highlight 

an object for attention. Exit animations 

are used to remove objects from the slide; 

these will begin with the object in its origi-

nal place and end with the object no longer 

visible on the slide. Motion effects move an 

object from one position to another; the path 

for this motion and the beginning and end 

points can be changed. 

To emphasize the hot dog character in 

the example, apply an emphasis effect like 

Teeter to it. To fly in the second step of cre-

ating the product, set the text box to Fly 

In. The arrow should simply fade into exis-

tence once the text box is in place, so a Fade 

effect is appropriate. You can customize any 

effects using the Effect Options icon; this will 

change to give you the options available for 

the current animation you have applied. It is 

possible to apply multiple animation effects 

to a single object as long as they do not con-

flict in motion (so you can use an emphasis 

effect with an entrance effect but not an 

entrance effect with an exit effect). You can 

preview your animation sequence from the 

Animations ribbon by clicking the Preview 

icon in PowerPoint 2013 and the Play icon 

in PowerPoint 2011. A completed example 

Add two slides to the presentation using the 

Default layout. For the first slide, choose 

the SmartArt icon from within the content 

placeholder. Choose one of the graphics and 

add text to complete it. For the second slide, 

use the Insert menu to add SmartArt and 

choose a different type of graphic. Add text 

to complete this graphic. How did the pro-

cess differ for the two examples of SmartArt 

that you added? How does the text map to 

the SmartArt elements in each example you 

chose? Be sure to save your work.

Animations
Animations are one way to call atten-

tion to a particular object or group in 

PowerPoint. These can be triggered either 

by advancing the slide or through timing to 

play automatically. Animations can help you 

emphasize a point or call out a particular 

visual element, but they can also be easily 

overused. The animations that you add to 

your presentation should be short and rel-

evant. All of the settings for animations are 

housed in the Animations ribbon, shown in 

Figure 12.18.

To illustrate the concepts and mechan-

ics of animation, you will add animation 

to the product demonstration slide in the 

MySalesPitchNotes project. The general cat-

egories of animation effects are Entrance, 

Emphasis, Exit, and Motion. Entrance 

effects are used to start an object (or group) 

off of the visible slide and transition it into 

12.2.5

 FIGURE 12.18
Animations ribbons 
in PowerPoint
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item within the Animation pane to change 

its position within the animation order.

The Start condition is the action that 

starts the animation sequence. By default, 

this is set to On Click, which is the same as 

a slide advance operationally. If you do not 

want to have to click for each animation to 

begin, you can change the trigger to With 

Previous or After Previous. Setting the ani-

mation to With Previous starts the selected 

animation as soon as the previous anima-

tion begins; setting the animation to After 

Previous will start the animation sequence 

after the previous animation sequence has 

in Normal view is shown in Figure 12.19. 

This demonstrates the numbering shown 

for each sequence to let you know in which 

order the effects will play; numbers that are 

the same are part of the same sequence.

After you have added your animations, 

you can adjust their start condition, trig-

gers, sequencing, and timing. If you added 

the animation effects in the order you want 

them to display, you do not need to rear-

range them. However, if you want to change 

the order, open the Animation pane by click-

ing its icon from the Animations ribbon in 

PowerPoint 2013; to open the equivalent 

Custom Animation pane in PowerPoint 2011, 

click the Reorder icon in the Animations rib-

bon. With the Animation pane open, use the 

Move Earlier and Move Later icons on the 

Animations ribbon in PowerPoint 2013 (or 

the up and down arrows at the bottom of the 

Animation pane in either PowerPoint 2013 

or PowerPoint 2011) to reorder your anima-

tion sequence. You can also click and drag an 

 FIGURE 12.19
Complex animation 
sequence in 
Normal view in 
PowerPoint 2013

When you are sharing your presentation for viewing 
on a personal computer, you should avoid using the 
On Click start condition for animation. It is annoy-
ing to a viewer to have to repeatedly click just to get 
access to the information a slide has to offer. The On 
Click start condition may assist you in presenting, 
but you should change it to After Previous before you 
share your slides for individual use later.
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set how you want your text animated, either 

by word or by letter, and the delay between 

text sequences in the animation. The text 

settings can be changed using Effect Options 

in PowerPoint 2013 and the separate foldout 

Text Animations panel in PowerPoint 2011.

EDITING 
PRESENTATIONS

You may not always be working on a 

presentation document that you create 

yourself. You also may not be able to create 

the entire project at once, so it is important 

to be able to open and edit existing presen-

tation documents. You can change most of 

the properties of a PowerPoint presentation 

while it is open, regardless of when it was 

created or by whom. 

If you download a presentation or open 

it from an email message, PowerPoint will 

restrict the editing options of the document, 

allowing you to read it without running any 

additional scripts attached to the document 

(called macros) and without activating any 

of the ribbons to alter the content. Once 

you click the Enable Editing button on the 

warning that appears, you will be able to 

manipulate and edit the document as usual.

Opening and Editing 
Existing Presentations

You can open presentations from the 

File menu by selecting the Open option; 

use this to open the MyBrokenRobot file 

from the companion resources for 

this text. This file has only one 

slide with a robot whose arms have 

fallen off of its body. It is your task to repo-

sition and reattach them. Notice that when 

12.3

12.3.1

completed. You can change this setting in 

the Animations ribbon or the Animation 

pane for the currently selected animation.

The Timing panel contains the dura-

tion and delay settings for each animation 

sequence. The Timing panel is part of the 

Animations ribbon in PowerPoint 2013 but 

is located on the Custom Animation pane in 

PowerPoint 2011. The duration is how long 

the animation sequence takes to complete; 

most animations should occur quickly so 

they do not waste any significant time in the 

presentation (the preset selections for tim-

ing have a minimum of 0.5 seconds and a 

maximum of 5 seconds). The delay is how 

long the sequence will pause before start-

ing when the start condition is reached; you 

should use delays sparingly and only when 

necessary for presenting the content.

You can optionally add sounds to your 

animation sequences from the Animation 

pane (or Custom Animation pane) using 

the Effect Options selection. You can access 

Effect Options from the drop-down menu 

for the sequence entry in PowerPoint 2013; 

this is a foldout panel for the animation 

sequence in PowerPoint 2011. You can also 

If you do not want your animation to play as part of 

the normal slide progression in PowerPoint 2013, you can 

change the Trigger attribute. The trigger attribute is what 

causes the animation to start; by default it is set to take 

input from the presentation timing and standard presen-

tation advances. However, you can change the trigger to a 

click of any object within the current slide; this will func-

tion like an action setting to start the animation sequence.

on the dvd
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connector lines you added to the back of the 

slide layering so they do not appear above 

the animation of the robot. A completed 

example is shown in Figure 12.20.

You can also change the theme and the 

colors of this presentation to better suit 

your preferences. The colors will automati-

cally adapt when you change the theme in 

PowerPoint, but you can change your color 

you open a presentation document, any pre-

sentation documents that are already open 

will remain open in separate windows.

Use your mouse cursor to select each 

arm and position it on the slide where it can 

reasonably connect to the shoulder socket 

of the robot; do not overlap the shapes 

because you are going to use connector lines 

to attach the arms. Now use the rotation 

option to rotate the arm back into position. 

Add a drawing object connector line from 

the arm to the shoulder socket. 

Repeat the steps for the other arm. 

Change the robot’s frown to a smile using 

the yellow diamond controller for the mouth 

setting. Finally, change the title of the pre-

sentation: Use the strikethrough format-

ting on the word “Broken” and add the 

word Fixed beside it. Remember to send the 

 FIGURE 12.20
Completed 
example

Any animation applied to objects that are connected 
by a connecting line will not animate the connecting 
line itself. Instead, the line will remain in the initial 
fixed position for both objects, ignoring any animation 
movements unless they are part of a group to which 
animation is applied. If both objects are not part of the 
same group, the connecting line will ignore the object 
that is not part of the group in terms of positioning 
and movement.
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ratio is the best option for standard use. 

(Although PowerPoint can be used to cre-

ate brochures and other publications, this 

is not its primary use). For this example, 

select a slide size that is equivalent to stan-

dard paper printouts. To change the slide 

size, click the Slide Size icon on the Design 

ribbon in PowerPoint 2013. This will open 

the Page Setup dialog box shown in Figure 

12.21. In PowerPoint 2011, you can change 

the slide size by selecting Slide Size from the 

Themes ribbon or by selecting the File menu 

and choosing Page Setup.

In this dialog box, you can set your 

slide size to any of the predefined standard 

sizes or a custom size. It is possible to use 

PowerPoint to create a poster image (such as 

those needed for professional research con-

ference presentations), but the maximum 

size setting of a slide for either the height 

or the width is 56 inches. That means the 

largest poster you can create is 56” by 56”. 

preference after selecting the theme. Save 

the completed project as MyFixedRobot.

Activity 12.3—Animation
Using the MyBrokenRobot presenta-

tion, use animation to repair the robot follow-

ing the steps outlined in this section. Keep in 

mind the different actions that you can take 

with animation and the different changes 

and effects that can be applied. Play your 

animation to test the results, which should 

show the robot being repaired. How does the 

resulting slide appear in the normal view for 

designing your slides? Save your presenta-

tion as Activity12_3 in the Activities folder.

Slide Setup and 
Slide Orientation

You can set the size of your slides and 

the slide orientation. If you are presenting 

your slides on a normal screen or standard 

projector, you do not need to change the slide 

size from the default. The default aspect 

12.3.2

 FIGURE 12.21
Slide Size dialog 
box in PowerPoint 
2013
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starting number of the slides in this dialog 

box; it defaults to starting at one for the first 

slide of the presentation.

Creating a Custom 
Layout

If you find that you need slides with a 

particular arrangement of elements that is 

not provided in any of the default layouts, you 

can create a custom layout in PowerPoint. 

To do this, open the Slide Master view and 

find the Insert Layout icon (or New Layout 

icon in PowerPoint 2011) on the Slide 

Master ribbon. Clicking this icon creates a 

new child layout slide from the main Slide 

Master. This new slide will initially contain 

only a title and footer placeholders. You can 

add additional placeholders to the new lay-

out slide by clicking the Insert Placeholder 

icon to open the menu that allows you to 

choose the content type for the placeholder. 

The default Content placeholder includes 

12.3.3

If your planned project fits within that size 

limitation, your only concern is how to get it 

printed. Once you export your poster image 

from PowerPoint to a Portable Document 

Format (PDF) file, most professional print 

shops will accept that format.

The Slide Size dialog box also allows 

you to set your slide orientation; that is, 

whether you want it to display in land-

scape layout (the default where the width is 

greater than the height) or portrait layout 

(the standard layout for text documents and 

printing). You can change this setting for 

the slides and any printed handout sepa-

rately. In PowerPoint 2013, you can set the 

 FIGURE 12.22
Custom layout 
creation and Insert 
Placeholder menu 
in PowerPoint 
2013

Changing the aspect ratio with content in your 
slide will change the aspect ratio of the con-
tent as well, which may distort images and 
drawing objects already in your presentation. 
Therefore, you should try to set the slide size 
before you start creating the content for your 
presentation.
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indicate it is hidden. You can still continue 

to edit the slide, but it will not display dur-

ing your presentation.

If you need to access a hidden slide 

during your presentation, select the slide 

manually by right-clicking within the pre-

sentation while Slide Show view is active, 

choosing Go to Slide, and then selecting the 

slide number and title you want to display. 

You can also create an action object to point 

directly to the hidden slide; if you need to 

view the slide during the presentation, click 

the action object and the slide will display. 

To practice this, go to the 

MySalesPitchNotes project and hide the 

slide for questions that displayed only a sin-

gle contact email address (this was replaced 

by a SmartArt version in Section 12.2.4). 

Activity 12.4—Actions 
and Hidden Slides

Using the active presentation for the 

project for this chapter, select one of the 

objects within the SmartArt graphic to link 

to the previous (and now hidden) contact 

slide. Add an action to the object, choose 

Slide as the Link to value, and select the hid-

den slide. Save your presentation as Activity 

12_4 and test your presentation to make sure 

it works.

quick links to all of the available media ele-

ments, while the other options allow spe-

cific media and text. The Insert Placeholder 

drop-down menu is shown in Figure 12.22.

When you have finished creating your 

new layout, click the Rename icon to name 

your new layout for use in the presentation. 

When you save the presentation and close 

the Slide Master view, the new layout you 

created will be available as a selection in the 

Layout icon menu of the Home ribbon. The 

name that displays for the layout will reflect 

what you renamed it; if you did not perform 

this step, the name will default to “Custom 

Layout.” This custom layout will exist only 

in the presentation in which you created it; 

it will not be available for use in other pre-

sentation documents.

Hiding and 
Showing Slides

If you need to shorten your presenta-

tion to fit a specific time slot or you need to 

slightly tailor the same presentation for dif-

ferent audiences, you may have some slides 

that you do not need but that you do not 

want to delete. For instance, you may have 

a slide with background information that is 

not necessary for the general audience, but 

you may need it if someone asks a particular 

question. To keep a slide in your presenta-

tion without including it in the normal Slide 

Show view, you can utilize the option to hide 

the slide.

To hide a slide, select the slide you want 

hidden and open the Slide Show ribbon. 

Click the Hide Slide icon. This will gray 

out the slide in the Slides/Outline pane to 

12.3.4

The Hide Slide icon is a toggle. When it is 
highlighted, the slide is hidden. When you 
click the icon again, the slide will be visible 
in the presentation. A hidden slide retains its 
slide number, so if you have slide numbers vis-
ible, the presentation will skip the number of 
the hidden slide.
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can also set whether you want the cropped 

areas of the image removed and whether 

you want to apply these settings to all of the 

images in the document or just the one you 

have selected (deselecting the Apply only to 

this picture checkbox in PowerPoint 2013 

will apply the setting to all images in the 

presentation document).

Your presentation slides can be exported 

as images from PowerPoint. To do this, sim-

ply open the File menu and choose Save As. 

The common formats for images are GIF 

Graphics Interchange Format, JPEG File 

Interchange Format, TIFF Tag Image File 

Format, PNG Portable Network Graphics 

Format, and Device Independent Bitmap. 

Select the format in which you wish to save 

your slides; you will be asked whether you 

want to save the current slide only or every 

slide in the chosen format. With PowerPoint 

2011, it is better to use the Save as Pictures 

command from the File menu; this allows 

you to open an Options dialog box in which 

you can specify more detailed image options 

for the format.

Optimizing and Exporting 
Images from Slides

Adding a large amount of media to your 

presentation may cause some issues with the 

file size of the document. If you are emailing 

the document or presenting it on another 

machine, you have to consider how easy it 

is to transfer it from one location to another. 

Depending on how you are using the docu-

ment, you can perform some tasks to com-

press the file size of your presentation while 

retaining all of the media you have added. If 

the presentation document is just for use on 

a computer screen, compressing the images 

will reduce the file size without sacrificing 

the media quality. If you are printing your 

slides on a high-quality printer, compressing 

them may not be the best choice.

To compress your images, select an 

image in your presentation and open the 

Format ribbon for Picture Tools. Select 

the Compress Pictures icon (or Compress 

in PowerPoint 2011). This will open the 

Compress Pictures dialog box shown in 

Figure 12.23. From here, you can select the 

resolution you want for your image. You 

12.3.5

 FIGURE 12.23
Compress Pictures dialog box in 
PowerPoint 2013
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CHAPTER KNOWLEDGE CHECK
Once you have added animation effects to a slide, you cannot change the order in which they occur.

 A. True

 B. False

You cannot add multiple animations to the same group or object in a slide.

 A. True

 B. False

Hidden slides are not assigned a number in the slide show. When they are shown again, they 
change the numbering of the slides that follow them in the presentation.

 A. True

 B. False

The following type of media requires support from a spreadsheet to calculate the display:

 A. Table

 B. Chart

 C. Animation

 D. All of the above

 E. None of the above

1

2

3

4

CHAPTER SUMMARY
This chapter covered the more advanced media elements that you can 

include in your slide show presentations. You must always keep your audience 

and the method of delivery in mind when creating your slides so that they 

deliver the maximum impact to your audience instead of just providing 

information. Presentation software can also allow you to create customized 

images at different sizes, which is a useful feature if you need to create graphics 

quickly and do not have an advanced graphics editing program available. The 

next section of the text covers spreadsheet software, which is an excellent tool 

for managing large amounts of data and performing advanced calculations.
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The following type of animation begins with the object or group on the visible slide and ends with it 
removed from sight:

 A. Entrance effect

 B. Emphasis effect

 C. Exit effect

 D. Explosion effect

In general, audio and video increase the file size of a presentation more drastically than other media 
elements.

 A. True

 B. False

Using multiple forms of complex media in the same slide is a good way to present information 
clearly.

 A. True

 B. False

Tables are a good form of media to use when presenting a large volume of information (at least 10 
rows by 6 columns) because they are clear to the audience at the back of the room.

 A. True

 B. False

SmartArt is a tool that allows for quick creation of professional-looking graphics, but SmartArt 
graphics can be adequately created using drawing objects and text boxes.

 A. True

 B. False

The following is an image format that is common for exporting presentation slides:

 A. GIF

 B. TIFF

 C. JPEG

 D. All of the above

 E. None of the above

5

6

7

8

9

10
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PRACTICE EXERCISES
Research a topic in computing and create a 10-slide presentation explaining the topic. Include at 
least three of the media types in your presentation to assist in your explanation. In a separate word 
processing document of at least 200 words, evaluate whether or not the media elements made it 
easier to describe a concept and why this was the case.

1

CHAPTER REVIEW QUESTIONS
How can SmartArt be used to enhance a presentation? Give at least two uses of this that would be 
most beneficial.

Why would you want to hide a slide in a PowerPoint presentation? Give an example of when this 
would be beneficial.

What are some examples of objects that could benefit from animation in a PowerPoint presentation?

In your current or desired profession, what advanced functionality in PowerPoint would you use 
most often when developing presentations? Why?

How do handouts support PowerPoint presentations? Give two examples of when you might use 
handouts along with a presentation. 

Give a brief description of when video would be appropriate for a presentation and what is added by 
including this type of media element. How does this differ from using sound?

Give a brief description of when audio would be appropriate for a presentation and what is added by 
including this type of media element. How does this differ from using video?

Compare two different types of charts that you could add to a presentation. Give an example of the 
type of information that would be presented best in each chart and why the other chart type you 
selected would not work as well for showing the data.

Give a brief description of when and why you would optimize your slides. Support your argument 
with specific examples.

Describe the process of creating and organizing a complex animation in PowerPoint in your own 
words. What considerations should you have for the type of movement and order of movement for 
different elements on the slide?

1

2

3

4

5

6

7

8

9

10
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For this exercise you will use the PowerPoint presentation you developed in Chapter 11. You will 
open the presentation and begin editing it according to the following instructions: make your logo 
include at least two animations, add some type of background music to your presentation, include a 
graphic using SmartArt, and include an applicable video clip that you either found on the Internet or 
developed yourself.  

In this exercise, you will choose a topic or feature from this chapter and present it using a 
PowerPoint slideshow. You may choose, for example, to explain custom layouts. Include examples 
from the Internet, your textbook, and other resources. Include a reference slide to properly cite all of 
your sources. You may choose to include a tutorial that you found on a Website or that you 
developed yourself.

Return back to the grand opening PowerPoint presentation you modified. You will now need to go 
back and develop an appropriate outline. Use this outline to create handouts and notes to have at 
the grand opening. This will give your audience something tangible to walk away with, helping you 
and your company to stay fresh in their mind.  

Create a new PowerPoint presentation and add a title slide and two table slides to it. Add one table 
that is 3 rows and 3 columns. Add data to the table including a header row; this data can be 
fictional. Now in the second table slide, add a table that is 6 rows by 6 columns. Add data to this 
table as well. Compare the display of both of these tables in Slide Show View. Which of them is 
more legible to an audience? In your opinion based on these results, how many rows and columns 
should be allowed as a maximum limit for a PowerPoint presentation?

2

3

4

5

CHALLENGE EXERCISES
Using the MyFixedRobot project you created in this chapter, change the slide size to a poster size of 
24” by 36” and add captions and a logo to the slide so it looks like an advertisement poster. Save 
your document as HugeFixedRobot and export it as an image file using both the GIF and JPEG 
formats. In a separate word processing document of at least 200 words, compare the two images 
that were produced in terms of image quality, text quality, color, and file size.

Create notes for each slide in the presentation which you have modified throughout this chapter. Be 
sure they are detailed and describe the contents of the slide and what you want to say about each 
slide. How can these be used to help you prepare to present your presentation live in front of an 
audience? When would these be suitable for handouts? Explore the formatting options for handouts 
and describe the strategy for complementing your presentation with the text you add in this format. 

Create two different charts in a PowerPoint presentation. Be sure they contain different data and 
they are appropriate for the type of data being displayed. Compare the two charts to determine 
which one is easier to explain to an audience and what information each one conveys that the data 
itself would not readily show.

1

2

3
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Create a presentation with six slides and practice adding content to each slide. Hide the even 
numbered slides and create an Action on each odd slide to show the hidden even slide immediately 
after it. Start the presentation from the beginning in Slide Show View. Run the show once without 
clicking any of the Action items you added. Next, run it again and click each action item as you 
encounter the slides. How does the presentation behave differently in each run (with and without 
using the Actions)? When would this be beneficial to apply in a presentation? Explain your answer 
with examples.

Create and save a new PowerPoint presentation. Using either your own video or Clip Art from Office.
com, add and modify a video in a slide. Test the video within your presentation by viewing it in Slide 
Show View. Next, format the video with effects. View the presentation in Slide Show View and 
activate the video again. How does the display change when you apply the formatting? In what 
circumstance would you want the effects added to a video to enhance its presentation to the 
audience? Is there a risk of distracting the audience from the video content with this approach? 
Explain your answer with examples.

4

5
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CHAPTER  

13
Introduction to Excel and  
Spreadsheet Software

IN THIS CHAPTER

This chapter presents an introduction to spreadsheet software. Through the 

creation of a simple budget, features of the software package such as formatting 

and formulas will be explored. You will also learn to add charts to your document 

to visualize the information contained in the spreadsheet. Once you have 

completed the chapter, you will be able to:

●	Navigate the spreadsheet software interface

●	Add and format text and numerical data in a spreadsheet

●	Use cell naming and cell formatting to organize 
information

●	Add simple formulas to a worksheet

●	Add charts to a worksheet

Microsoft Office 
2013/365 and 

Beyond
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print; the maximum size of a worksheet in 

Excel contains rows up to row 1048576 and 

columns up to column XFD.

Cells are not intended for large amounts 

of text; you should ideally include one piece 

of data or information per cell. Spreadsheets 

are best for organizing data and calculating 

results. If you want the results to accom-

pany text, you should produce your results 

in a spreadsheet and export the relevant 

data to a word processing document. There 

are an enormous number of applications 

for spreadsheets across disciplines such as 

accounting and mathematics. The coming 

chapters provide an introduction to spread-

sheet software and its functionality, but the 

practical applications of this technology 

go far beyond the scope of this text. Some 

general uses that you may find for spread-

sheet software are formatting information 

in large tables, creating charts to display a 

visualization of data, and performing com-

plex mathematical calculations.

The spreadsheet software application 

in Microsoft Office is called Excel. The first 

task you will complete using the spread-

sheet software program is the creation of 

a personal budget. First, open the software 

and use the File menu to save your new 

open document as MyBudget in the Projects 

folder you created. The native file type in 

Excel is Excel Workbook (.xlsx).

ANATOMY OF EXCEL
Excel uses the ribbon interface with 

which you should now be familiar. Beneath 

the ribbon interface is the Formula Bar, 

which is used for naming cells and defining 

13.2

INTRODUCTION 
TO SPREADSHEET 
SOFTWARE

Spreadsheet software is used to man-

age and process large amounts of data. A 

spreadsheet is organized into a grid of rows 

(indicated by number) and columns (indi-

cated by letter). The intersection of these 

rows and columns is called a cell; a cell is 

identified by letter and number, so A1 would 

be the first cell of the spreadsheet. A spread-

sheet document is not delimited by printed 

pages or slides as you have previously seen 

in other software packages. Instead, it is 

organized as individual spreadsheets or 

worksheets (identified by the tabs at the 

bottom of the interface in the common 

spreadsheet applications); the entire file is 

called a workbook. A worksheet can contain 

many printed pages worth of material. In 

fact, a worksheet can contain thousands of 

rows or columns that would be infeasible to 

13.1

A ROW in spreadsheet software is the horizon-
tal grouping of data that is divided by columns; 
rows are signified by numbers.
A COLUMN in spreadsheet software is the ver-
tical grouping of data that is divided by rows; 
columns are signified by letters.
A CELL in spreadsheet software is the intersec-
tion of a row and a column, containing a single 
piece of data, which can be text, a number, a for-
mula, or an object; cells are signified by the let-
ter of the column and the number of the row.
A FORMULA in spreadsheet software is a math-
ematical calculation that results in a data value; 
the value is displayed in the cell in which the 
formula is typed.
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identify any possible errors in your formula 

construction.

You may notice that there is a signifi-

cant departure in the construction and navi-

gation of the document pane of the interface. 

The document is divided into cells. You can 

use the arrow keys to navigate from one 

cell to the next or you can click on a cell 

to activate it. The current cell is called the 

active cell and the row and column in which 

it resides will also be highlighted for you to 

identify them quickly. Hold the Shift key to 

select multiple cells. Each cell acts like a text 

box in which you can type information.

The bottom of the interface has a set of 

tabs, each of which identifies an individual 

spreadsheet within the overall workbook 

(the file itself). You can navigate to these 

spreadsheets by clicking on the tabs or by 

using the directional arrows to the right of 

the tabs. The bottom of the interface also 

contains the view options, which allow you 

to see the page breaks in your document in 

either a Page Layout view or a Page Break 

Preview; the Normal view tends to be the 

most helpful for 

document cre-

ation. When you 

have numeric 

values selected, 

the bottom of the 

interface will also 

display an auto-

matic calculation 

of the average of 

the values, the 

calculations. The main pane of the docu-

ment window looks very different from the 

applications you have seen so far; it displays 

the rows, columns, and cells of the docu-

ment. The bottom of the interface contains 

tabs for you to select the worksheet that is 

active in the document pane. Depending on 

the version of Excel you are using, the rib-

bons and shortcuts available will be slightly 

different. You can jump to the section that is 

relevant to you.

Microsoft Excel 2013
The interface for Excel 2013 has the 

same ribbon structure and general layout 

with which you should be familiar from 

the other Office applications. You can see 

an example of the interface for Excel 2013 

in Figure 13.1. The Formula Bar, located 

beneath the ribbon interface, identifies 

the current cell that you have selected and 

displays the contents of the cell. When you 

begin using functions, the Formula Bar will 

become much more relevant. It allows you 

to perform a formula lookup and will help 

13.2.1

Quick Access 
toolbar

Ribbon 
interface

Row labels

Spreadsheet 
tabs

Active cell

Formula bar
Column labels

Show or hide 
ribbons

Document 
pane

View selection
Zoom setting

Document 
filename Help

 FIGURE 13.1
Anatomy of Excel 
2013
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keep your document confined within the 

desired page delineations.

The Formulas ribbon contains catego-

ries of formulas from which you can select 

to insert into your document. This rib-

bon also contains the functionality to trace 

dependencies among cells in your spread-

sheet and provides manual links to set cal-

culation options for your spreadsheet; by 

default, all calculations are updated imme-

diately when a value on which they depend 

is changed. The Formulas ribbon is shown 

in Figure 13.4.

The Data ribbon, shown in Figure 13.5, 

contains several useful commands, includ-

ing the Remove Duplicates command to 

make sure no identical values are repeated 

in your list and the Text to Columns com-

mand to convert continuous text into multi-

ple columns based on a delimiter character. 

This ribbon also contains commands to 

manage external sources, perform a What-If 

Analysis (for goal seeking), validate data, 

and perform advanced filtering for lists.

The Review ribbon gives you the abil-

ity to add comments to your spreadsheet. 

Unlike Word, Excel places comments in a 

triangle icon in the upper-right corner of the 

cell to which they are attached. The Review 

ribbon also gives you options for protecting 

sum of the values, and the number of values 

you have selected (omitting white space). 

This is a nice feature for quickly assessing 

statistics on a list.

The available ribbons and functions are 

quite different from the interface for Word 

and PowerPoint. The Home ribbon contains 

the Number panel for formatting numeric 

values (either as direct text input or as the 

result of formula calculations), as well as 

commands for style formatting and for add-

ing and deleting cells. Of particular note 

are the Fill icon, which is used to replicate 

values or predict entries in a series, and the 

Sort & Filter icon, which will be used for list 

management in Chapter 14, “Developing 

Worksheets and Graphic Representations.” 

The Insert ribbon, shown in Figure 13.2, 

contains several entries of note, particularly 

the Chart creation functionality, single-cell 

charts called Sparklines, and the icon to cre-

ate a PivotTable, which is one of the more 

advanced features of Excel.

The Page Layout ribbon, shown in 

Figure 13.3, is used to manage the spread-

sheet into printable regions. You can add 

a background, insert manual page breaks, 

and set the printable region size for your 

spreadsheet. If printing is a concern, it may 

be helpful to preview the print regions to 

 FIGURE 13.2
Insert ribbon in 
Excel 2013

 FIGURE 13.3
Page Layout ribbon in Excel 2013
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Split function lets you set up multiple view-

ing panes of your document so you can view 

disjoined elements side by side. You can also 

use the Save Workspace icon to store the 

configuration of multiple document win-

dows. The View Side by Side icon allows you 

to look at two workbooks at the same time. 

You can set synchronous scrolling for these 

so they move in the same direction at the 

same time.

Microsoft Excel 2011
The interface for Excel 2011, shown 

in Figure 13.8, is very similar to what you 

have encountered with the other Office 

applications for Macintosh computers. The 

interface contains the standard menu and 

ribbons where most of your functionality 

is located. In addition, you have a Formula 

Bar that is used to construct calculations in 

the spreadsheet and edit information in the 

cells of the document. The main document 

13.2.2

your document from changes or sharing 

your document on a network location for 

others to edit. You 

can also select the Start Inking icon to 

use your mouse as a pen to mark up your 

document. The Review ribbon is shown in 

Figure 13.6.

The View ribbon, shown in Figure 13.7, 

allows you to change the view of the docu-

ment as usual, but it also allows you to man-

age your workspace. The views in Excel are 

primarily the Normal view and views to pre-

view page layouts for printing, such as Page 

Break Preview. The Page Layout view is not 

recommended for constructing or working 

with your document. You can show or hide 

various document elements from this rib-

bon as well, such as the gridlines and the 

Formula Bar. The Freeze Panes function-

ality allows you to preserve your headings 

as you scroll through your document. The 

 FIGURE 13.4
Formulas ribbon in 
Excel 2013

 FIGURE 13.5
Data ribbon in Excel 2013

 FIGURE 13.6
Review ribbon 
in Excel 2013

 FIGURE 13.7
View ribbon in 
Excel 2013
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preview of the page breaks in your docu-

ment for printing.

The Home ribbon contains the standard 

text formatting options, along with a panel 

for formatting numeric values. This is neces-

sary for effectively managing and displaying 

data in the spreadsheets. The Home ribbon 

also contains icons for inserting and delet-

ing rows and columns and for using special 

preset formatting options.

The Layout ribbon, shown in 

Figure 13.9, contains view settings and print 

options and is primarily used for establish-

ing print regions and previewing the print 

area. This ribbon can also be used to set up 

a workspace where you can open multiple 

workbook documents on the screen for use 

at the same time. 

The Tables ribbon is used to format cells 

in the document as a table; this is useful for 

is divided into cells, which can be navigated 

with the arrow keys on the keyboard. The 

columns are labeled by letters across the 

top, and the rows are labeled with numbers 

down the left side. The tabs at the bottom 

are the individual spreadsheets within the 

workbook (the overall document). 

Clicking with the mouse on a cell in the 

document makes that cell the active cell; 

this action outlines the cell in a thick border 

and highlights the row and column labels 

for quick reference. The cell reference will 

also appear on the left side of the Formula 

Bar. Options in the Quick Access toolbar 

include a toggle that allows you to show or 

hide the Formula Bar and links to common 

functions like SUM (which is discussed later 

in this chapter). The bottom of the interface 

contains the view selection where you can 

alternate between the Normal view and a 

Menu bar

Help

Show or 
hide ribbons

Settings
Ribbon 

interface

View 
selection

Row labels

Formula bar

Quick Access 
toolbar

Column labels

Active cell

Document pane

Spreadsheet tabs

 FIGURE 13.8
Anatomy of 
Excel 2011
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your calculations. The Formulas ribbon is 

shown in Figure 13.11.

The Data ribbon, shown in Figure 13.12, 

contains the functionality for managing 

information in your spreadsheet. You can 

sort and filter data from this ribbon, man-

age external data sources, remove duplicate 

values in a list, and convert the existing text 

into separate columns. Data validation and 

grouping is also performed from this ribbon.

The Review ribbon, shown in 

Figure 13.13, is primarily used for docu-

ment collaboration and markup. You can 

add or address comments from this ribbon, 

and also share your document or set docu-

ment protection so it cannot be altered.

Microsoft Excel Web App
From your OneDrive account, you can 

also create a new Excel workbook or edit 

an existing workbook in your online stor-

age using the Microsoft Excel Web App. You 

can see the interface of the Excel Web App 

in Figure 13.14. Similar to the other Web 

13.3.3

managing and maintaining lists of informa-

tion. This ribbon also lets you select whether 

you want to include specific elements in 

your table formatting, such as a header row. 

The Charts ribbon is where you create a 

visual data representation to include in your 

spreadsheet. There are a number of chart 

types available for different types of data 

and different presentations of information. 

The SmartArt ribbon is similar to what is 

found in Word and PowerPoint; you can use 

this ribbon to add graphics to your docu-

ment to convey information visually. These 

three ribbons are shown in Figure 13.10.

The Formulas ribbon is where you can 

access the available formula library in Excel. 

This ribbon contains an icon for quick access 

to formulas for summations and averaging, 

as well as the Formula Builder icon for cre-

ating more advanced calculations. You can 

also control the recalculation options for 

your formulas from this ribbon (by default, 

the recalculation is immediate whenever a 

value is changed) and trace the cells used in 

 FIGURE 13.9
Layout ribbon 
in Excel 2011

 FIGURE 13.10
Tables, Charts, 
and SmartArt 
ribbons in Excel 
2011

 FIGURE 13.11
Formulas ribbon in 
Excel 2011
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toolbar because changes are saved as soon 

as any action in the document is completed.

The Home ribbon, also shown in 

Figure 13.14, contains formatting com-

mands for text and numerical values. The 

number formatting options are collapsed 

in this version into a dropdown list under 

Number Format as well as the ability to add 

or reduce significant digits. Most of the com-

mands on this ribbon should be familiar to 

you from the use of other Office software.

The Insert ribbon, shown in Figure 13.15, 

provides options for adding charts and for-

mulas to your document. You can also add 

versions of the Office software you have 

seen so far, the Excel Web App has a lim-

ited subset of the functionality of the Excel 

program along with the ability to open the 

document in the full version installed on the 

computer and the ability to share the docu-

ment via the Share option found in line with 

the other ribbons. The basic organization 

of the interface is very similar to the 2013 

version of Excel. Note the inclusion of the 

collaboration information at the bottom of 

the interface, indicating how many people 

are concurrently working on the document. 

There is no Save icon in the Quick Access 

 FIGURE 13.12
Data ribbon in 
Excel 2011

 FIGURE 13.13
Review ribbon in 
Excel 2011

 FIGURE 13.14
Anatomy of the Excel Web App

 FIGURE 13.14
Anatomy of the 
Excel Web App
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Adding and 
Formatting Text

Column A will be used to store the line 

items you are going to account for in your 

budget. In cell A1, type the words Monthly 

Budget; you can format text in Excel just as 

you can in other Office products using the 

formatting commands on the Home ribbon. 

Bold your text to signify its importance as 

a heading. Because this is not a print docu-

ment, you can use the sans serif default font 

for readability. The unformatted text in the 

cell will appear in the Formula Bar. 

Skip over rows 2 and 3 for now; format-

ting and additional row headings will be added 

later. Note that skipping rows between major 

headings is helpful in organizing your infor-

mation. In cell A4 (where column A intersects 

row 4), add the heading Income; this is where 

you will track your monthly income from 

which you will deduct your expenses using a 

formula. You should bold category headings 

and include subheadings in the same column 

as normal text; in column A beneath the 

Income heading, add the following categories:

•	Household Expenses

•	Rent/Mortgage

13.3.1

hyperlinks and 

tables from this rib-

bon. The Data rib-

bon contains the 

Calculate Workbook 

command to refresh 

the calculations in 

the workbook as 

well as the options 

for sorting by col-

umn. You can see 

the Data ribbon in Figure 13.15 as well. The 

View ribbon, also shown in Figure 13.15, 

contains only the option to hide the interface 

in Reading View or show the interface in the 

standard Editing View. Most of the functions 

you will need in Excel are limited to the 

standalone versions installed on the com-

puter, though the Web version can be used 

for quick edits and computations when you 

are away from your home or work computer.

DIVING INTO 
SPREADSHEETS

Now that you are familiar with the 

interface of the software, the next step is to 

start creating the budget document used as 

a project for this chapter. You are going to 

establish a projected budget and fill in cells 

with the actual amounts on a month-by-

month basis. When you have completed this 

project, you can use the document to assist 

with your own financial planning. Select 

the first tab (labeled Sheet1) at the bottom 

of the interface, right-click on it, and select 

Rename from the menu. Rename the work-

sheet Monthly Budget. Be sure to save your 

work after you have made changes.

13.3

 FIGURE 13.15
The Insert ribbon, 
Data ribbon, and 
View ribbon in the 
Excel Web App
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budget tracking, or you 

can follow along exactly 

with the example to 

become familiar with 

the functionality of the 

application and then 

later adjust what you 

have entered as a test 

of your understanding.

If you need more 

room in a column 

for the text you have 

entered, you can resize 

its width by select-

ing the line separat-

ing it from the next 

column and dragging 

it to expand or shrink 

the column width; for 

example, select the line 

dividing column A from 

column B and drag it 

to the right to expand 

column A. You can also 

select the cells you want 

to modify and choose 

the Wrap Text icon to dis-

play the text of the cell on 

multiple lines; this is found 

in the Alignment panel of the Home ribbon.

Column B will be used to project 

the monthly estimate of your household 

income and the cost of each category. In 

cell B3, enter the text Budgeted Amount; 

use the Wrap Text command along with 

the alignment commands to display the 

text in the vertical and horizontal center of 

the cell.

•	Phone

•	Cable

•	Groceries

•	Utilities

•	Electric

•	Gas

•	Water

•	Car

•	Payment

•	Gas

•	Insurance

•	Pets

•	Food

•	Miscellaneous (abbreviated  
Misc.)

•	Recreational

•	Clothing

•	Dining Out

•	Entertainment

•	Savings

In the line under Savings, enter the per-

centage of your monthly income you would 

like to save each month; for the example, 

this is 10%. The final two categories for col-

umn A are Total Expense and Net Income. 

Skip a row above each of these category 

names. A completed example is shown in 

Figure 13.16. You can modify the categories 

and headings to meet your own needs for 

 FIGURE 13.16
Completed budget 
headings in Excel 
2013

You can use the mouse to click the different cells in 
which you want to enter data, or you can use the 
Enter key to get to the next cell beneath the one cur-
rently selected. Press Enter twice to add a blank row 
between categories.
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choose More Number Formats from the 

Number Format selection box to customize 

your own number formatting style. This will 

open the Number tab of the Format Cells dia-

log box, which is also shown in Figure 13.17. 

In Excel 2013, you can also open this dialog 

box by selecting the expansion icon on the 

Number panel.

The additional commands avail-

able from the Number panel include 

the Accounting Number Format (which 

defaults to the symbol $, a United States 

dollar sign) for currency values; this con-

tains a drop-down list of common world cur-

rencies. You can also use the Percent Style 

and Comma Style formats to adjust the 

cells quickly; apply the Percent Style to the 

number you chose for your monthly savings 

(in column A). The Increase Decimal and 

Decrease Decimal icons are used to increase 

or decrease the number of significant digits 

displayed for the value; this does not affect 

the value itself that is stored in the cell, just 

the manner in which that value appears. 

Once you have entered your 

monthly budget values in column B up 

to the value for Savings (you will com-

pute Savings, Total Expenses, and Net 

Income as formulas), 

select the Accounting 

style for the values 

Formatting Values
In column B, you are going to assign 

your budgeted values for the respective cat-

egories in column A. Do not add values for 

the main headings, like Recreational; focus 

instead on the values for the subheadings, 

like Clothing and Entertainment. You will 

use formulas to calculate the values of the 

overall categories. You may notice as you 

add numbers to your spreadsheet that they 

will align to the right of the cell by default; 

text, on the other hand, aligns to the left. 

The text formatting commands are all avail-

able for use on numeric values as well.

An additional set of formatting com-

mands is available for numbers in the 

Number panel of the Home ribbon. These 

commands are shown in Figure 13.17. You 

can select the formatting you want to use 

from the predefined list, including Currency, 

Percentage, and Scientific. You can also 

13.3.2

You can apply formatting to an entire row or 
column by clicking on the row or column label, 
respectively, and then selecting the format-
ting commands you wish to apply. If you want 
to apply the formatting to the entire spread-
sheet, select the small unlabeled area to the 
left of column A and above row 1 and select the 
formatting commands.

 FIGURE 13.17
Number panel 
and Format Cells 
dialog box in Excel 
2013

Check the result of the formatting change to 
Percentage on your values to make sure you have 
the number you intended; this formatting converts 
the value 1.00 to 100%, so you may need to convert 
the formatting for the cell and retype the percentage 
you want. 
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completed series 

are shown in 

Figure 13.19.

You can use 

the automatic 

series generator 

in Excel to cre-

ate headings for 

months, days, or 

years and to create 

an index for data 

values. The series 

can be extended 

vertically or hori-

zontally, but the 

direction depends 

on the adjacency 

of the example 

cells you select; 

you can continue 

the sequence only in that direction. Excel will 

attempt to predict the sequence as an addi-

tive series; you must be sure the pattern you 

are attempting to have Excel predict is simple 

and you must verify that the values you get in 

response are correct. If you have only a single 

value highlighted, Excel will repeat that value 

in the adjacent cells.

(which differs from the Currency format in 

the placement of the symbol identifying the 

currency, such as $). Now use the Decrease 

Decimal command to remove the decimal 

points so the numerical values are displayed 

as whole currency. A completed example 

is shown in Figure 13.18. Feel free to use 

your own values rather than those in the 

example.

Activity 13.1—
Formatting Values

For this activity, you will create a 

new spreadsheet document and save it as 

Activity13_1 in the Activities folder. In col-

umn A, place the number 1 in cells A1 to 

A10. Use a different numerical format from 

the dropdown list on each cell. What is the 

result of each formatting type? When would 

you use each of these formats? Save your 

work.

Using Sequences
Excel can use two cells to predict simple 

series like counting numbers, days of the 

week, and months of the year. You are going 

to create a yearly budget plan for this exam-

ple, so enter January in cell C3 and February 

in cell D3. When you select both cells with 

your cursor, you will see them surrounded by 

a thick border with a grip point at the lower-

right corner of the selection; click and 

drag this grip point in the direction of 

the series entry (in this case horizon-

tally) to extend the sequence. Click 

the grip point and drag it out until you 

have a complete cycle of months from 

January to December. 

The grip point and the 

13.3.3

 FIGURE 13.18
Example monthly 
budget values in 
Excel 2013

 FIGURE 13.19
Series example 
in Excel 2013
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only to the cells that are highlighted when 

you choose the various options.

To continue building your budget, add 

the heading Annual Amount to cell O3. You 

should use the same formatting as you did 

for cell B3, including enabling Wrap Text. 

Select cells B3 through O3 and choose a 

light green fill for the background (you can 

choose another color if you like as long as 

the text is still visible) using the Fill Color 

command.

Now select cells B3 through O36 (this 

should be the last cell corresponding to 

the intersection of the column containing 

Annual Amount and the row containing 

Net Income). Select the More Borders option 

from the Borders menu. In the dialog box 

that appears, enable the middle vertical 

border and the right border, as shown in 

Figure 13.20, and click OK. 

Next, select the cells in the row where 

you have the value for your savings amount 

beginning with column B and extending 

through column O. (If you have followed 

the example, this will be cells B32 through 

O32.) Select the Bottom Border option from 

the Border menu for these cells; you should 

notice that the formatting you have already 

applied to the cells is still active. Finally, 

select the cells in the row corresponding 

to the Net Income entry from column B 

through column O (this will be cells B36 to 

Formatting Cells
Now that you have the headings for the 

vertical and horizontal entries in your bud-

get, you want to focus on formatting them 

to make your budget more readable. Start 

by setting a column width for the monthly 

entries you have added. To do this, select 

the column headings from column C (which 

should contain your January entry) to col-

umn N (which should contain December). 

With all of these columns selected, drag the 

line separating column C from column D to 

set a common width for all of the columns 

you have highlighted. You should set a width 

that is sufficient to read the month value for 

each column. You can also set a specific value 

for the column width using the Format com-

mand on the Home ribbon with the columns 

selected; select Column Width from the 

drop-down list that appears and choose 9.5 

as the value for the width.

You can add formatting to the cells by 

using the Fill Color menu and the Border 

menu on the Home ribbon. The Fill Color 

icon gives you the standard selection of 

theme colors (which can be selected from 

the Page Layout ribbon in Excel 2013 and 

from the Home ribbon in Excel 2011) and 

standard colors. The Border menu allows 

you to add specific borders (such as a 

Bottom Border or Outside Borders) from 

the default selections. You can also select the 

line styles from this menu in Excel 2013 or 

choose More Borders to access the advanced 

options for customizing the border; the 

advanced options are available in Excel 2011 

by choosing Border Options from the Border 

menu. The selections you make will apply 

13.3.4

You can access all of these options from the Format 
Cells selection on the right-click menu. You must first 
select all of the cells to which you want the format-
ting to apply, right-click, select Format Cells, and then 
choose the tabs for Fill or Border as necessary.
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Freezing Panes
Using the Freeze Panes 

option allows you to keep your 

headings visible on the page no 

matter where you scroll within 

your spreadsheet. You can choose 

to freeze columns, rows, or both. 

The only caveat as to what can be 

frozen is that you must freeze the 

contents of the upper-left corner 

of the spreadsheet to the cell you 

choose for enabling the freeze. 

The cell you highlight when you 

choose the Freeze Panes option 

will define the border of what is frozen; any 

cells above and to the left of the selection 

(but not including the selected cell itself) will 

remain in place as you scroll the document.

13.3.5

O36 if you are following the example). Add 

a Top Border and Bottom Double Border 

to the highlighted cells. An example of the 

completed steps is shown 

in Figure 13.21.

 FIGURE 13.20
Border tab of 
Format Cells dialog 
box in Excel 2013

 FIGURE 13.21
Completed cell 
formatting example
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B7+B8+B9+B10. You will see your entry 

in the Formula Bar along with two new 

symbols for Enter and Cancel; you can use 

these to finish your formula or you can press 

the Enter key. When you complete your for-

mula, the value will display in cell B6; you 

can add any formatting to the cell that you 

want applied to the value. The example for-

mula is shown in Figure 13.23.

Mathematical Calculations

You can perform standard mathematical 

calculations in Excel in addition to entering 

formulas. The order of operations hierarchy 

in mathematics is upheld in Excel, where 

division and multiplication are ranked above 

addition and subtraction in performance 

order. Using parentheses will supersede any 

13.3.6.1

In Excel 2013, the 

Freeze Panes icon is on the 

View ribbon; in Excel 2011, 

the Freeze Panes icon is on 

the Layout ribbon. For 

the example, click cell C4 

and select Freeze Panes to 

lock your headings and esti-

mated budget in place while 

allowing the rest of your 

entries to scroll. The correct 

cell you need for the example is highlighted in 

Figure 13.22. Move the scrollbars after this 

step has been completed to see its effect on 

your document. To remove the Freeze Pane 

effect, select the Freeze Panes icon again and 

choose Unfreeze Panes.

Adding Basic Formulas
Formulas are an excellent way to per-

form calculations on the data within your 

spreadsheet. In fact, a large portion of the 

power of using spreadsheets is the ability to 

automate complex calculations. The formu-

las in your spreadsheet will 

operate just like equations, 

with the cells occupying 

the position of variables. 

For instance, to calcu-

late the total of the entire 

Household Expenses cat-

egory, select the cell in col-

umn B beside the category 

name and type the equals 

symbol (=), which signifies 

a calculation. Next, you can 

use the cell names as val-

ues; for the example, type 

13.3.6

 FIGURE 13.22
Example cell 
selection for 
Freeze Panes 
effect

 FIGURE 13.23
Example formula 
in Excel 2013
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As an example of this, consider the 

following:

•	$B4 will preserve the column refer-
ence as column B when copied but 
will allow the row reference (row 4) to 
change.

•	B$4 will preserve the row reference to 
row 4 but will allow the column refer-
ence, currently column B, to change.

•	$B$4 will preserve the exact refer-
ence to column B and row 4, retaining 
this fixed value no matter where the 
formula is copied and placed.

You will use this ability to freeze cell val-

ues to construct the formula for the Savings 

value. To do this, select the cell in column 

B beside the percentage value you selected 

for savings in column A (for the example, 

this is cell B32). Multiply the percentage 

value by the income for the budget. When 

operation such that 

whatever is added 

inside of the parenthe-

ses will be performed 

first in the operation order. Practice 

creating simple formulas to add the ele-

ments of each category up to the Savings 

category. Apply bold formatting to the 

category sums (as well as the income 

entry if you have not done so already).

Once you have the category sums 

calculated, you are going to enter the 

equation for Total Expenses; to do this, 

simply add together the cells contain-

ing each category sum. You can see 

the formula for the example budget in 

Figure 13.24. If you have followed along 

with the example, your result should be 

$2,750. The final equation you will add 

in this step is for Net Income; this is the 

income value (cell B4 in the example) minus 

the Total Expenses value (cell B34 in the 

example). If you have followed the example, 

the result should be $550.

Freezing Cells in  
Formulas

When you copy and paste cells or when 

you duplicate cells as you will in the next 

steps for constructing a budget, the cell val-

ues will automatically update based on the 

position of the formula. For instance, if you 

copy the example formula for Net Income in 

cell B36 to cell C36, the cell references that 

previously included cells in column B (cells 

B4 and B34) will now refer to the equivalent 

cells in column C (cells C4 and C34). To pre-

vent this type of update, use the dollar sign 

in your formula to fix a certain value.

13.3.6.2

 FIGURE 13.24
Example total 
expenses 
calculation in Excel 
2013
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A5, add the formula =$A$2. Use the Fill 

functionality to copy this formula into cells 

B5 and C5. What values are displayed in 

each of the cells? Save your work.

The SUM Function

In addition to standard mathematical 

operations, Excel has a library of existing 

formulas that you can use to perform com-

plex calculations within your spreadsheet. 

One of the common formulas is SUM, 

which computes the numeric sum of the 

cells listed as its argument. An example 

of using SUM would be to replace the for-

mula for calculating the total Recreational 

expenses (=B27+B28+B29 from the 

example) with the SUM formula operating 

on those cells; the formula would then be 

=SUM(B27,B28,B29). The term SUM is the 

name of the formula and the entries in the 

parentheses are the arguments, or values on 

which the formula is operating. The result of 

both of these calculations would be the same. 

You can use the colon symbol (:) as a 

shortcut to include adjacent cells in an argu-

ment of a formula. Entering B27:B29 in a 

formula means all of the cells from cells B27 

through B29, inclusive. The SUM function 

in the example can therefore be rewritten as 

=SUM(B27:B29) to produce the same result. 

You can only use the shortcut if you want to 

include all of the cells in an adjacent range. 

Practice using the SUM formula by replac-

ing the formulas you constructed for calcu-

lating the total expense for each category. An 

example of this is shown in Figure 13.26.

13.3.6.3

you duplicate this formula, 

you want it to be based on 

the monthly income, but 

you want the percentage 

to remain the same. Therefore, you will 

freeze the reference to the percentage by 

entering =B4*$A$32 as the cell data; this 

preserves the reference to cell A32 for the 

percentage value and updates the income 

reference wherever the formula is copied. 

Figure 13.25 shows the example.

Activity 13.2—Cell 
References

For this activity, you will create a 

new spreadsheet document and save it as 

Activity13_2 in the Activities folder. In col-

umn A you will add the numbers 1 through 

3 in cells A1 to A3. Place the numbers 4 

through 6 in cells B1 to B3 and then place 

the numbers 7 through 9 in cells C1 through 

C3. In cell A4, you should add the formula 

=A$1, and use the Fill functionality to copy 

this formula into cells B4 and C4. What 

values are displayed as a result? In cell 

 FIGURE 13.25
Example formula 
with fixed/frozen 
cell reference

 FIGURE 13.26
Example use of 
the SUM formula
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To complete this task for the Household 

Expenses category, select cell B6 and highlight 

all of the cells in that row through column N 

(which should contain the December heading). 

With all of these cells highlighted, select the 

Fill menu from the icon on the Home ribbon 

and choose Right. You can perform this same 

task by clicking the cell you want to duplicate 

and using the grab point in the lower-right cor-

ner to drag the contents to the adjacent cells 

into which you want to copy the value. Repeat 

this task from column B to column N for all of 

the rows containing category headings as well 

as the percentage entry for Savings (which has 

the reference to the percentage frozen), the 

row containing Total Expenses, and the row 

containing Net Income.

The final column for Annual Amounts 

also needs to be completed before your bud-

get is done. This column is a sum of the 

yearly expenses and income and a report 

of the annual differences and net income 

for the year. Therefore, each of the column 

entries will be a summation of the respec-

tive values from January to December. You 

can use the Fill command to make short 

work of compiling this information. In cell 

O4 (if you have followed the example), enter 

the text =SUM(C4:N4) to calculate the net 

income for the year.

Activity 13.3—
Using Formulas

For this activity, you will create a 

new spreadsheet document and save it as 

Activity13_3 in the Activities folder. In col-

umn A you will add the numbers 1 through 

3 in cells A1 to A3. Place the numbers 4 

through 6 in cells B1 to B3 and then place 

the numbers 7 through 9 in cells C1 through 

C3. Now, you will add formulas to calculate 

sums in column D and row 4. In cell A4, you 

should add the formula =A1+A2+A3. Now 

repeat the pattern in cells B4 and C4. Do the 

same in column D to calculate the sums of 

the row entries. As a final step, in cell D4, 

you should calculate the sum of all of the 

cells from A1 to C3. Save your work.

Using Directional Fill
When you want to duplicate a value or 

repeat a formula in a spreadsheet, you select 

the value you want to repeat, highlight the 

direction in the spreadsheet to which you 

want to repeat the value, and use the Fill 

menu to repeat it. The Fill menu, found on 

the Home ribbon, contains entries for the four 

primary directions. For example, Fill Right 

will select the leftmost value (which should 

be the one you want to repeat in the adjacent 

cells) and copy it to all of the highlighted cells 

to the right. You are going to practice using 

the Fill command to duplicate the formulas 

you constructed for your budget to the cells 

for the months. Obviously you need to enter 

the actual monthly values in each of the sub-

categories and in the cell representing Income, 

but the calculations will remain the same.

13.3.7

You may get an error message (which appears 
as a small green triangle in the upper-left cor-
ner of the cell in Excel 2013) when you enter 
this formula, saying you have omitted adjacent 
cells in your formula. You should ignore this 
error since the adjacent cells are the budget 
value and do not represent the real value of 
any particular month.
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directions. You can also hold down the Shift 

key to select the cells between your starting 

location and where you end (if you move 

your cursor in two directions, it will select 

the rectangular set of cells between the 

starting location and the ending location 

just as it does when you click and drag the 

cursor).

The shortcut commands on the key-

board that are coupled with the Control 

(Ctrl) key can be used for quick naviga-

tion as follows (the Command key on a 

Macintosh is substituted in these examples 

for the Control key on a Windows machine):

•	Ctrl-a directional arrow—This will 
jump the cursor to the last entry in 
the direction of the arrow key before a 
blank space in the current selection; if 
the cursor is already at a blank space, 
it will jump to the next location in line 
with content or, if there is no content, 
the cursor will jump to the end of the 
spreadsheet.

Select cell O4 and highlight the adjacent 

cells all the way to the row containing the 

Net Income entry (cell O36 in the example). 

Choose the Fill Down command to duplicate 

the formula for every cell in the column. 

Now format the cells using the Accounting 

style with no digits after the decimal point. 

Click any filled cells in column O that corre-

spond to intentionally blank rows and press 

the Delete key to remove the contents. When 

you are finished, you will have a functional 

budget sheet to track your annual expenses. 

Your result should be similar to what is 

shown in Figure 13.27.

Navigating the 
Spreadsheet

There are several shortcut commands 

on the keyboard that will allow you to move 

through your spreadsheet quickly. The 

arrow keys can be used to move one step 

for each keypress in any of the cardinal 

13.3.8

 FIGURE 13.27
Completed budget 
example
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Excel is the program that actually manages 

chart data whenever you add a chart to any 

Office document. For this example, you are 

going to create a line graph to view your 

monthly income and your overall monthly 

expenses.

Chart Data
To create a chart in Excel, select the data 

range you want to include in the chart. In 

this case, you will select the row containing 

Income (row 4 in the example) from column 

A (where the heading is located) to column 

N (representing the December entry). With 

these cells selected, choose the chart type 

you want to insert. In Excel 2013, you can 

add a chart to your document by selecting 

the type of chart on the Insert ribbon; in 

this case, select the Line icon and choose 

Line beneath the 2-D Line heading. In Excel 

2011, you can find this option in the Charts 

ribbon. A chart will be added to your docu-

ment. Enter values for your income over the 

months to see the effect it has on the chart 

display. To preserve your blank chart for 

your own use, you can save this workbook as 

MyBudgetChart so you can enter informa-

tion needed for the chart to display correctly.

You may notice that your chart includes 

the column for your budget estimate, which 

you want to remove to get a clear picture of 

your income over the year. To do this, you 

need to edit the chart data. In Excel 2013, 

you can find the Select Data icon in the con-

text-sensitive Design ribbon for Chart Tools; 

in Excel 2011, the Select icon is located on the 

Charts ribbon. When you click this icon, a dia-

log box will appear from which you can edit 

13.4.1

•	Ctrl-Shift-a directional arrow—This 
has the same effect of moving the 
cursor as the shortcut command for 
Ctrl-a directional arrow, but it also 
highlights/selects the cells between 
the starting and ending location.

•	Ctrl-Home—This returns the cursor 
to cell A1 regardless of the current 
cursor location.

•	Ctrl-End—This sends the cursor to 
the farthest cell to the right and down 
on the spreadsheet where content has 
been added.

•	Ctrl-Page Down (PGDN)—This com-
mand advances to the next worksheet 
in the workbook (just like clicking 
the tab to the right of the current 
worksheet).

•	Ctrl-Page Up (PGUP)—This com-
mand opens the previous worksheet 
in the workbook (just like clicking 
the tab to the left of the current 
worksheet).

•	Ctrl-A—The Select All command in 
Excel will select only the cells that 
contain information that are adjacent 
to the current cell. Pressing Ctrl-A 
again with the adjacent informa-
tion selected will select the entire 
worksheet.

ADDING CHARTS
Charts are great tools for visualizing 

information. Because human beings are 

generally able to process visual information 

more quickly than text, charts are a great 

way to express the overall idea or trend of 

data in a single image rather than either a 

lengthy text explanation or large amounts of 

data that must be read. If you have followed 

along with the text so far, you should have 

some idea of how charts work by inserting 

them into your PowerPoint presentations; 

13.4
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the Income series. This time, choose the 

Add button to create a new series. The cor-

rect data selection is shown in Figure 13.29. 

The series name should be the cell con-

taining the text “Total Expenses,” which 

is cell A34. The series values should be the 

cells corresponding to January through 

December in the row for Total Expenses 

(row 34).

As a final step for the chart creation, 

move your chart to another worksheet 

in your workbook. Click on the tab titled 

Sheet 2 and rename it Budget Chart; click 

the chart you created, cut it from the docu-

ment, select the new Budget Chart tab, and 

paste the chart into the worksheet. Delete 

any additional worksheets and save your 

workbook.

Activity 13.4—
Exploring Charts

For this activity, you will create a 

new spreadsheet document and save it as 

Activity13_4 in the Activities folder. Copy 

the contents of your budget file into your 

the cell locations that determine the chart. 

In Excel 2013, click on the Income series and 

choose Edit to open a dialog box where you 

can select your data. In Excel 2011, simply 

click on the Income series and the fields will 

display on the right side of the pane. 

The series name is correct, but the 

series values should begin at cell C4 and run 

through cell N4 if you have followed along 

with the example. You can either enter the 

information as you normally would for a for-

mula, or you can click the data selection icon 

and use your mouse to highlight the correct 

cells in the document (press the Enter key 

when you have selected the 

correct cells). The result of 

this data selection change 

is shown in Figure 13.28.  

The next step is to 

add a new series to track 

the total expenses for each 

month as a comparison 

against the Income series 

you already have in the 

chart. To do this, activate 

the data selection dialog 

box just as you did to edit 

In Excel 2013, you can also use the Quick 
Layout menu on the context-sensitive Design 
ribbon for Chart Tools to adjust the layout of 
your chart and the various elements that will 
be included in its display. Figure 13.28 also 
shows the Chart Elements menu in Excel 2013. 
You can use this to decide which elements to 
show or hide. The paintbrush icon beneath 
it can be used to make quick style changes to 
preset styles for the chart as well.

 FIGURE 13.28
Example line chart 
for income
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Elements. In Excel 2011, select the Chart 

Title icon on the context-sensitive Chart 

Layout ribbon. Clicking the icon will add a 

default chart title that you can rename by 

clicking inside the text box and typing; for 

the example, enter Income Analysis.

Next, you will add a forecast trend 

line to predict both your income and your 

expenses. In Excel 2013, the trend line 

commands are located in the Add Chart 

Elements menu on the context-sensitive 

Design ribbon. You should select Trendline 

and then Linear Forecast. You will then be 

prompted to select the series for which to 

add the trend line. You should add one for 

both the Income series and the Expenses 

series. These trend lines can be used to pre-

dict the value of the series past the allocated 

data.

In Excel 2011, these are found on the 

Chart Layout ribbon. To add a trend line, 

select the Trendline icon and choose Linear 

Forecast Trendline. In the dialog box that 

workbook (you can select the empty cell to 

the left of A and above 1 to select your entire 

sheet and then press the shortcut command 

to copy the page. Click the same cell in a sheet 

in your new workbook and paste the copied 

contents. Create a different chart out of the 

data, and compare this chart to the line chart 

in terms of effectively displaying the data 

you want to review (in this case Income and 

Expenses). Which chart is more effective, and 

why is this the case? Save your work.

Formatting Charts
The next step is to format the chart so 

it is more readable and representative of 

its contents. You can start this process by 

adding a chart title. In Excel 2013, the Add 

Chart Element and Quick Layout menus 

can be used to add elements to your chart 

or change the chart appearance. There 

are also several preset styles from which 

you can choose for your chart in the Chart 

Styles pane of the Design ribbon for Chart 

13.4.2

 FIGURE 13.29
Chart data 
selection for Total 
Expenses
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Horizontal (Category) Axis Labels; in Excel 

2011, the series data for this is called 

Category (x) axis labels, which allows you to 

type a direct reference or use the selection 

icon to choose the cells you want to use. Now 

that your chart is on a new spreadsheet, you 

will need to click the Monthly Budget tab to 

get back to the correct data; select the cells 

containing the names of the month from 

January to December. Compare your result 

with the completed chart in Figure 13.30.

opens, select Income as the series to predict 

the income trend past the current cycle. 

Repeat the process to predict the expenses 

past the current cycle. This will show you if 

your expenses are approaching your income 

level, which is an undesirable situation that 

should guide you to reevaluate your budget.

As a final formatting step, adjust the 

labels of your horizontal axis to read the 

months of the year. To do this, activate the 

data selection dialog box for your chart. In 

Excel 2013, select the Edit button beneath 

 FIGURE 13.30
Completed chart 
example

CHAPTER SUMMARY
This chapter introduced the basic functionality of spreadsheet software. 

You learned how to add and format data, whether it is text or numeric values, 

as well as how to utilize that data in basic calculations. Formulas, charts, and 

organization of information represent the real power and utility of spreadsheets. 

Now that you have a basic idea of the interface and the navigation of the 

spreadsheet environment, it is time to turn to the next chapter where you will 

construct more involved spreadsheets that demonstrate the more powerful 

aspects of this type of application.
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CHAPTER KNOWLEDGE CHECK
The intersection of column B and row 4 is denoted in a cell reference as:

 A. 4B

 B. B:4

 C. B4

 D. None of the above

Rows in a spreadsheet are labeled with letters, and columns in a spreadsheet are labeled with 
numbers.

 A. True

 B. False

Formatting can be applied to cell contents whether it is a fixed value or a formula calculation result.

 A. True

 B. False

The number of digits to the right of the decimal point that are visually displayed for a value is 
independent of the accuracy of the value stored in the cell.

 A. True

 B. False

A formula begins with the symbol:

 A. %

 B. =

 C. $

 D. None of the above

To fix a reference to the column but not the row of cell A6, the correct cell reference in a formula 
would be:

 A. $A$6

 B. $A6

 C. A$6

 D. A6

You can use the Fill command only on numeric values.

 A. True

 B. False

1

2

3

4

5

6

7
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The SUM function takes cell references as an argument and calculates their total numerical value.

 A. True

 B. False

The following is the correct use of the SUM function in a cell:

 A. =SUM(A4:A6)

 B. =SUM(A4, A5, A7)

 C. =SUM(A4+A6)

 D. Both A and B.

 E. Both A and C.

A data series in a chart must be contained in a continuous set of cells (or a single cell) in either the 
same row or the same column.

 A. True

 B. False

8

9

10

CHAPTER REVIEW QUESTIONS
What are the main differences between using a table in a word processing document and using a 
spreadsheet document for organizing information? List at least six tools available with spreadsheets 
that are not available in tables.

Give two examples of when you would need to use a fixed cell reference in a spreadsheet. Give a 
brief explanation in your own words on how to freeze a cell reference.

SUM is just one example of a formula that is commonly used in Excel. Find at least two more 
formulas from the list and explain in your own words how to use them and give an example of their 
use (you do not have to have actual data used in the examples).

Choose three of the number formatting styles available in Excel; write a short description of how 
they format the data and when they would be used.

What is the difference between using series prediction and the Fill command in Excel? Give two 
examples where each of these functions would be used.

Choose two of the chart categories available in Excel and identify an example of a data series that 
would work well when displayed in that type of chart. What makes that data set ideal for the chart 
type and what visual information does the chart convey which would take a lot of text to explain?

1

2

3

4

5

6
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PRACTICE EXERCISES
Using the budget example as a basis, create a new spreadsheet page to track your bank account for 
one week. Categorize the expenses into various categories (you should create a Category column) and 
add any account credits to the Income category in a separate column from the debits of the account. 
Use the SUM function and compare the expenses to the credits. You do not have to enter specific 
information for the purchases, but you should name them so you can recognize what they represent.

Using the data from your budget, add a series to the chart for each category of expenses. Format 
the chart so it is still readable. Is this the correct type of chart to use for this additional information? 
Do the additional series entries contribute to or detract from the clarity of the visual presentation?

Add a new column to your budget document to calculate the average amount per month that is 
spent on each category and subcategory in your document. You can calculate this value using a 
direct formula or a calculation from existing data in the document.

Construct a budget for a fictional business based on the example you constructed in 
the chapter. What categories of expenses would you have to add to accommodate 
the operation of the business? What subcategories would comprise the income?

Use the data example in Figure 13.31 to 
construct an example account management 
spreadsheet. You should apply the formatting 
techniques you have learned for spreadsheet 
data to format the amount column as numbers 
and format the transaction date column as 
date values. Make sure to mark debits as 
negative numbers and credits as positive 
numbers. Calculate the value for the total 
using the SUM formula.

1

2

3

What considerations should you have when printing an Excel spreadsheet to include with a business 
report? Include elements like the paper size as well as considerations of the data being presented.

Excel documents allow for the use of headers and footers in the document; give at least two 
reasons why these would be necessary. Cite examples in your analysis. Why would this information 
be placed in a header and not in an existing row in the document?

Media elements like images and SmartArt can be placed in Excel spreadsheets as well. Why would 
this be an option for inclusion and when would you suggest using such elements in your document?

Conditional Formatting is a function that will analyze the data range on which it is applied and will 
format the cells differently depending on their value. When would this be useful in a spreadsheet 
and what visual information does it provide? Give at least three examples in your explanation.

7

8

9

10

4

5

 FIGURE 13.31
Example account 
spreadsheet
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CHALLENGE EXERCISES
Explore the template options available in Excel and compare them to the types of template 
documents that are available from Word. What do the template documents reveal about the purpose 
of each software program? Write a comparison document in Word with at least three template 
examples supporting each software package.

Fill in the blank:

 A.  is the horizontal grouping of data in a spreadsheet. 

 B.  is the vertical grouping of data in a spreadsheet.  

 C.  is the intersection of a row and a column in a 
spreadsheet.

 D. The  is the mathematical calculation that results in a 
data value in a spreadsheet.

 E.  allows you to keep your headings visible on the page 
no matter where you scroll within the spreadsheet.

 F.  computes the numeric sum of the cells listed as its 
argument.

In this exercise, we will test your working knowledge of freezing cells in formulas. You will be given a 
description of a row or column reference. You must decide how it should be labeled in a formula, 
making sure to place the dollar sign in its correct position.

•	The row reference is preserved to row 4 but will allow the column reference 
(currently column F) to change.

•	The reference is preserved to column C row 83.

•	The column reference is preserved to column H but will allow the row refer-
ence (currently row 13) to change.  

•	The reference is preserved to column A row 16

•	The column is preserved to B but the row reference (currently row 15) is 
allowed to change.

Explore the different formatting options available for numbers. Create a sample spreadsheet based 
on Figure 13.31, and test each number format. Describe briefly how each of these formats differs. 
What is the effect of adding or removing a significant digit from each format type? What element or 
elements of the value remain constant?

Use a different chart in your budget to represent the Income and Expenses series. What other charts 
accurately convey the monetary values over time? Which chart types are not a good representation 
of this type of data? Explain your answer.

1

2

3

4

5
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CHAPTER  

14
Developing Worksheets and  
Graphic Representations

IN THIS CHAPTER

Now that you have a basic understanding of spreadsheet software and how 

the data in these documents is arranged, it is time to explore some of the 

options available for data management and visualization. These include the 

ability to manipulate cells, format them conditionally, and reference them on 

other worksheets, as well as selecting the correct type of chart to showcase the 

information you want to convey. When you have completed this chapter, you will 

be able to:

●	Manipulate cells, rows, and columns for information 
presentation

●	Use Filter and Sort functionality on your spreadsheets

●	Reference cells across spreadsheets

●	Use formatting as a visual indicator of data in your 
spreadsheets

●	Select the correct type of chart to convey the needed 
information

Microsoft Office 
2013/365 and 

Beyond
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in the spreadsheet currently so this should not 

disrupt any existing data. In Excel 2013, you can 

merge cells by selecting the Home ribbon and 

clicking on the Merge & Center icon; in Excel 

2011, this icon is simply called Merge. Selecting 

Merge & Center from the drop-down arrow 

combines the contents of the cells and centers 

the result; this is useful for creating headings 

that span multiple columns in a document. The 

other available options are Merge Across, which 

creates merged cells for each row but not across 

rows; Merge Cells, which combines the cells 

without adjusting the formatting; and Unmerge 

Cells, which is used to undo the process of merg-

ing the cells. You can see the result of merging 

cells in Figure 14.1.

The opposite of merging cells is split-

ting cells. You can generally only split cells 

that have already been merged; this pro-

cess is also called unmerging cells. (If you 

need to add cells to your document, you can 

add rows or columns in the current loca-

tion.) The Unmerge Cells option in Excel is 

located in the same menu you used to merge 

the cells.

Adding and Deleting 
Rows and Columns

You can insert new rows or columns 

anywhere in the document where you need 

to add additional information. Keep in mind 

that inserting a row adds it across the entire 

document. Similarly, inserting a column 

14.1.2

CONSTRUCTING 
A WORKSHEET

There are a variety of applications for 

spreadsheet software across multiple disci-

plines from office management to account-

ing. While spreadsheets are commonly 

associated with calculations and charts (for 

which they are excellent tools), they can also 

be used to manage lists and provide more 

exact formatting for lists. Regardless of the 

application for which they are used, under-

standing how to adjust and manipulate 

the layout of the spreadsheet is essential. 

Though spreadsheets are primarily used for 

calculation, considering how to present the 

results of your calculations is also impor-

tant. Open a new spreadsheet document to 

experiment with these options.

Merging and 
Splitting Cells

You can merge two or more cells 

together to act as a single cell in your docu-

ment. This can be useful if you have a head-

ing that spans more than one column (such 

as a Name heading over a column contain-

ing first names and a column containing 

last names). You can merge cells in multiple 

directions, but the result must be a square 

selection within the document. For example, 

you cannot merge cells A1, A2, and B1 into a 

single cell without including cell B2.

To practice merging 

cells, select cells A2 through 

C2 in your open docu-

ment; there 

should be 

no content 

14.1

14.1.1

 FIGURE 14.1
Example of a 
merged cell
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When you remove a cell from the docu-

ment, the rest of the cells around that cell 

need to move to accommodate the deletion. 

You can move all of the contents beneath 

the cell in the column upward or move all 

of the cells that are to the right in the row 

leftward to fill the gap. You can also choose 

to remove the entire row or column from the 

document.

Hiding Rows and 
Columns

Sometimes you may want to retain data 

in your spreadsheet without visually refer-

encing it. In these circumstances, you can 

hide columns or rows in the spreadsheet. 

The data that is contained in the hidden rows 

or columns is still present in the document 

and can be referenced just like any other cell 

(with a direct reference at least); it is simply 

hidden from view. You can hide or unhide any 

columns or rows that you wish. Figure 14.3 

shows the result of hiding column B and row 

3. Notice that if you hide a row or column 

that is part of a merged cell, the contents will 

display in the remaining cells.

14.1.3

adds it all the way from the first row of the 

document to the last. To add a column in 

either Excel 2013 or Excel 2011, right-click 

the column label to the right of where you 

want to add it (new columns are added to 

the left) and select Insert. Similarly, you can 

click a row label, use the right-click menu, 

and select Insert to add new rows; these are 

added above the selected row. You can also 

add rows and columns via the drop-down 

menu of the Insert icon on the Home ribbon.

Existing columns and rows can be 

removed as well. Doing so will remove the 

contents of the cells in the column and/

or row and move all of the content in the 

spreadsheet to the left (for a column dele-

tion) or upward (for a row deletion). The 

letters and numbers will adjust to accommo-

date the removal, but the complete alpha-

betic or numeric ordering will be retained 

(there will be no gaps in column letters or 

row numbers, so, for example, removing 

column B turns the previous column C into 

the new column B). To remove columns or 

rows in Excel 2013 or Excel 2011, select the 

elements you want to remove, right-click, 

and select Delete. You can also perform this 

action from the Delete icon on the Home 

ribbon.

You can empty the contents of a cell by 

selecting it and pressing the Delete key, but 

you cannot remove an individual cell from 

a document. When you right-click on a cell, 

select the Delete option; this opens a dialog 

box that allows you to select how you want 

to resolve the deletion. The Delete dialog 

box is shown in Figure 14.2. 

 FIGURE 14.2
Deletion resolution 
dialog box
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for complex reporting or information man-

agement. It is typically a good approach to 

reference values rather than retype them. 

This keeps data consistent across the 

spreadsheets in your workbook and allows 

you to perform the necessary update in one 

location rather than many locations, which 

helps decrease the potential for human error 

in entering the information. If you want to 

perform a cell reference across spreadsheets, 

type the name of the spreadsheet you want 

to reference in single quotes, add an excla-

mation point, and then type the cell refer-

ence. This can be either a fixed, or absolute, 

reference (using dollar signs to keep the row 

or column reference constant) or a standard 

reference. 

For example, if you open the MySupplies 

document, you can use the blank Sheet1 to 

reference a cell on the Supply List spread-

sheet. To do this, type =‘Supply 

List’!A4 or =‘Supply List’!$A$4; 

if you have typed this correctly, you should 

get the value “Funtime Fishery” in the 

cell when you press Enter to activate the 

formula. A reference to a cell on another 

spreadsheet is typically a fixed reference 

using the dollar sign format, but it will work 

either way. 

LIST MANAGEMENT
List management is one of the tasks for 

which spreadsheet software is an excellent 

tool. This primarily applies when you have 

a fixed list that you are using to construct 

derivative data, such as a list of unique 

values or a sort or filter of that data. Most 

of the tools for managing data apply to 

14.2

To hide rows or columns in Excel, sim-

ply select the labels for the columns or rows 

that you want to hide, right-click, and then 

select Hide from the menu. You can also hide 

rows or columns (or entire spreadsheets) in 

your Excel 2013 document by selecting what 

you want to hide (any cell within the sheet 

will suffice for hiding the spreadsheet itself), 

selecting the Format icon in the Home rib-

bon, and choosing the Hide & Unhide 

option; you can then select the action you 

would like to perform from the submenu. In 

Excel 2011, the options to hide and unhide 

rows and columns are all accessed directly 

from the Format icon in the Home ribbon.

If you want to unhide a row or column 

that you have hidden in Excel 2013 or Excel 

2011, select the labels before and after the 

hidden selection, right-click, and select 

Unhide from the menu. You can also do this 

from the Format icon on the Home ribbon. 

If you want to unhide everything in the 

spreadsheet, click the box above row 1 and 

to the left of column A to select the entire 

worksheet before performing the Unhide 

operation.

Advanced Cell 
Referencing

You can reference information across 

spreadsheets in the same workbook; this 

is a helpful feature if you are using differ-

ent spreadsheets in the same workbook 

14.1.4

 FIGURE 14.3
Hidden row and 
hidden column in a 
spreadsheet

on the dvd
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The contents of an entire worksheet can 

be pasted only into cell A1. However, you will 

create a new header line in addition to what 

is already there, so you should paste the cells 

(the type of paste option you select does not 

matter because there are currently no cal-

culated values in the spreadsheet) and then 

insert a new row above the entries you just 

added. Save your document as MySuppliers. 

Because this is a list of suppliers and not the 

supplies you purchased, you should delete 

the contents of the columns containing the 

Product, Price, and Quantity information 

and rename the tab for the spreadsheet 

Suppliers.

numeric values as well as text. In fact, it is 

often necessary to give the numeric values 

context with at least header information, if 

not further text descriptions. These do not 

have to be paragraphs of text to be effective; 

a simple example is a customer and an asso-

ciated account number. You probably have 

several accounts of your own where you 

must maintain some sort of record of your 

account number and a username.

The example project in this chapter is 

management of a list of suppliers. Your busi-

ness proposal from Chapters 11 and 12 went 

so well that your company has multiple 

locations, and it is your task to manage the 

contact information for your suppliers. To 

begin, open the MySupplies document if you 

do not already have it open, and then open 

the Supply List spreadsheet on the second 

tab of the document. Select all of the infor-

mation on the spreadsheet and copy it to the 

clipboard.

Excel 2013 offers a variety of options 

for pasting your data. To see the available 

options, you can right-click in the top-left 

cell where you want your data to begin; this 

will open a menu where you can expand 

the Paste Options selection. One particu-

lar option to note is the Paste Values selec-

tions; these allow you to paste the actual 

calculated contents of any formulas instead 

of the formulas themselves. The available 

paste options for Excel 2013 are shown in 

Figure 14.4. In Excel 2011, you can use 

the Paste Special command in the right-

click menu to access the available options 

for pasting contents into your document, 

including the Values selection.

 FIGURE 14.4
Paste options in 
Excel 2013
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In Excel 2013, you can apply your fil-

ter by selecting the Sort & Filter icon on 

the Home ribbon and choosing the Filter 

option on the menu. This will add a drop-

down arrow to each of the cells containing 

your heading information. Select the drop-

down arrow next to the cell containing the 

heading “Company” and choose Sort A to Z. 

The result is shown in Figure 14.5. In Excel 

2011, the Filter icon is located in the Quick 

Access toolbar and on the Data ribbon; the 

Sort command is located beside the Filter 

command in both locations.

There are a variety of options avail-

able for use in a filter, including the ability 

to apply individual filters to each column 

heading to further refine the data. You can 

select only one column at a time for alpha-

betic sorting; selecting a new column to sort 

alphabetically will undo the previous sort. 

In addition to alphabetic sorting (either 

ascending or descending), you can filter by 

color or select the values you want to retain 

(any item that is checked will display in the 

filtered list). 

The Text Filters option on the drop-

down menu for the filter performs a keyword 

search on the elements and selects what you 

want to display; you can set up the filter so 

it omits keyword matches, retains keyword 

matches, keeps elements that begin with the 

keyword, keeps elements that end with the 

keyword, or only retains exact matches. You 

can use the Custom Filter option to define 

your own criteria for what to retain. This is 

particularly helpful if you are looking for a 

data range as a subset of the values in the 

spreadsheet.

Using Sorting and Filters
The process of sorting can be per-

formed on any column in your spreadsheet. 

However, each column is treated as inde-

pendent data, so be aware that if you have 

an association between columns (such as a 

name and address), they will be sorted inde-

pendently if you directly apply the sort func-

tionality. To avoid this circumstance, you can 

apply a filter to the connected data to retain 

its association. This allows you to set criteria 

of what you want to view as well as coupling 

the data in the filtered rows and columns so 

each row is treated as a line item.

You can apply a filter to any selection of 

cells in your spreadsheet. When you apply 

the filter, the software will assume that the 

first row of the filter contains column head-

ings, so you should include a blank row if 

you do not have headings entered already. 

Otherwise, the first data element in your list 

will be used as heading information and will 

not be part of the filtered content. Select all 

of the data that was added to your Suppliers 

spreadsheet (in this case, cells A2 to I27); 

this is the data to which you will apply your 

filter. Note that row 2 contains your heading 

information, so the headings will not pres-

ent an issue.

14.2.1

A FILTER is a mechanism in spreadsheet soft-
ware that allows only list elements that meet 
defined criteria to be displayed for the selection 
to which it is applied. This is a way to show only 
the relevant data from a large list. Filtering also 
facilitates other functionality such as alphanu-
meric sorting.
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want duplicates removed; in the example, 

this is cells A2 through I27. 

In Excel 2013, open the Data ribbon and 

click on the Remove Duplicates icon. You will 

be prompted to select the columns you want 

to include in the search and whether your 

data has headers; leave the header check-

box activated and check all of the columns. 

Click OK to process the removal. The result 

should resemble Figure 14.6.

Removing Duplicates
There are cases where you may need to 

retain duplicate values in your document, 

such as when you want to track a count of 

occurrences. However, it is often beneficial 

to be able to remove duplicate values. In 

the example project, you are building a list 

of supplier contacts, so you want to have a 

single entry for each supplier. To remove the 

duplicates, highlight the cells for which you 

14.2.2

 FIGURE 14.5
Filter and sort 
example in Excel 
2013

 FIGURE 14.6
Figure 14.6 Result 
of removing 
duplicates in Excel 
2013
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delimiter, creating a new column whenever 

there is a break in the text.

For the example project, you are going 

to split the first name and the last name 

of the Contact person for the supplier. To 

begin, insert a blank column to the left of 

the Address label. The prior Contact col-

umn will become Contact First Name and 

the new blank column will become Contact 

Last Name.

To split the text of the Contact column 

in Excel, select the values and click the Text 

to Columns icon in the Data ribbon. This 

will open the Convert Text to Columns 

Wizard, as shown in Figure 14.7. There are 

three steps to this process; the first is to 

In Excel 2011, with the data range 

selected, you can use the Remove Duplicates 

icon on the Data ribbon. Make sure that the 

items are filtered if you want to treat each 

row as a single entry in the list. The removal 

will occur regardless of the number of dupli-

cates present.

Text to Columns
Most spreadsheet software applica-

tions allow you to convert delimited text to 

columns. Delimited text is separated by a 

specific character such as a comma (called a 

delimiter); when this process is performed, 

whatever is to the left of the delimiter will be 

in one column and whatever is to the right 

will be in another column. The delimiter 

character itself is typically consumed in the 

process and will not appear in the results. You 

can also convert text to columns based on the 

number of characters you want to include in 

each column, or you can use whitespace as a 

14.2.3

A delimiter is a character that signifies a 
break in a continuous value. In spreadsheet 
software, this is used to define the end of 
data for one cell and the start of a new cell. 
Common delimiters are commas, semico-
lons, and whitespace.

 FIGURE 14.7
Convert Text to 
Columns Wizard 
Step 1 in Excel 
2013
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case because there is no numeric data in the 

selection. 

When you are finished with your for-

matting selection, click the Finish button 

to complete the process. You should note 

that any columns created will overwrite 

the existing contents that exist in those col-

umns. This is why you created the blank 

column beside the Address label to accom-

modate the new column creation. Rename 

the column headings for the two columns 

that were split from the Contact column and 

save your work.

Activity 14.1—Text to 
Columns Practice

Create a new spreadsheet and save it 

as Activity14_1 and save it in the Activities 

folder. Add text to cells A1 to A5 that contains 

at least one comma and one semicolon in 

each cell. Perform the Text to Columns func-

tion and observe the results as you change 

choose whether your text is separated by a 

delimiter or whether you want to define a 

fixed width for your new columns. For the 

example, choose Delimited and click the 

Next button.

Step 2 allows you to choose your delim-

iting character. In the example, select the 

Space character as a delimiter and keep 

the Treat consecutive delimiters as one box 

selected to keep from creating blank col-

umns. A preview of the new columns the 

process will create appears at the bottom 

of the dialog box. You should have a display 

similar to Figure 14.8. When you are ready, 

click the Next button. 

Step 3, shown in Figure 14.9, allows you 

to select the formatting for each column you 

will create. You select a column by clicking on 

it. The format for both of the new columns 

you are creating should be either General or 

Text, which will have the same effect in this 

 FIGURE 14.8
Convert Text to 
Columns Wizard 
Step 2 in Excel 
2013
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the range of cells you want to format (in the 

example, this is cells A2 to J13) and select 

the Format as Table icon on the Home rib-

bon. From here, you can choose the style 

that you want to apply. An example is shown 

in Figure 14.10. In Excel 2011, the table for-

matting options are available on the Tables 

ribbon. Simply select the range of cells to 

which you want the formatting to apply and 

choose the style from the available list.

The formatting used for the example is 

Table Style Medium 1. You can also define 

a custom table style by selecting the New 

Table Style option at the bottom of the drop-

down menu. You can format any range of 

delimiters and apply fixed width. What hap-

pens when the text length in one cell is less 

than the width specified? When would you 

need to use this type of functionality other 

than separating first and last names?

Table Formatting
You can select a range of cells and format 

them as a table. This allows you to enhance 

the visual presentation and organization of 

your spreadsheet, as well as copy and paste 

both the cells and formatting to export to 

other productivity software applications 

(such as Word and PowerPoint in Office). To 

perform this operation in Excel 2013, select 

14.2.4

 FIGURE 14.9
Convert Text to 
Columns Wizard 
Step 2 in Excel 
2013

 FIGURE 14.10
Format as Table 
example in Excel 
2013
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emphasis to a particular piece of informa-

tion. These are accessible in Excel 2013 by 

selecting the Cell Styles icon on the Home 

ribbon; in Excel 2011, these styles are dis-

played as previews in the Format panel of 

the Home ribbon.

There are some final finishing 

touches you should make to the spread-

sheet to practice what you have learned 

about manipulating spreadsheets. First, 

hide the columns related to the physical 

address of the company; you do not want 

to remove this information, but it is not 

used very often, so it should not impede 

the vital information on the spreadsheet. 

You should also merge cells B1 and C1 

and enter the heading Contact in the new 

cell; format the heading to match the 

headings in the rest of the table. Remove 

the word “Contact” from the headings 

for the first and last name of the contact 

person, enter the text Suppliers in cell 

A1, and change the default color of the 

email addresses to black text. The table 

within your spreadsheet should look like 

Figure 14.11.

cells as a table no matter where it is located 

in your document. If a selection is format-

ted as a table, the formatting will readjust 

to accommodate any filter settings that 

are applied. You can see this if you deselect 

Custom Carts from the Company filter selec-

tion. Select the grab point at the lower-right 

corner of the table formatting and drag it 

to extend the formatting over additional 

rows and columns. In Excel 2013, adding 

table formatting to your spreadsheet will 

cause the context-sensitive Design ribbon 

for Table Tools to appear so you can adjust 

the formatting you selected and refresh the 

contents.

ADDITIONAL 
FORMATTING 
ELEMENTS

Visual enhancement is typically the key 

to a readable spreadsheet. It is beneficial to 

be able to quickly determine which values 

in a spreadsheet are important. Borders, 

shading, and font choices help with this 

visual distinction, but there are a variety 

of other formatting options you can use 

to enhance your spreadsheet. Excel, for 

instance, comes with a predefined set of cell 

formatting styles that you can use to add 

14.3

 FIGURE 14.11
Completed 
spreadsheet 
example
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number 4 in red. To do this in Excel, highlight 

the cells containing the account numbers. 

Select the Conditional Formatting icon on 

the Home ribbon, choose the Highlight Cell 

Rules entry, and then select Greater Than. 

You should see the dialog box in Figure 14.12.

Set the minimum value to 7000000 so 

all account numbers beginning with 7 will be 

formatted and set this to green text. You can 

apply multiple formatting rules to the same 

set of cells. With the account number cells 

still selected, choose the Less Than option 

for conditional formatting, enter 4999999, 

and set the formatting to red. A completed 

example is shown in Figure 14.13.

Conditional formatting allows you to 

select a variety of options such as value 

ranges, keyword matches, and dates. You 

can use the formatting options to display 

Conditional Formatting
Sometimes it is helpful to have a visual 

reference for your information without 

having to read each entry. For instance, in 

a financial worksheet you may want any 

value less than zero to appear red so you can 

recognize it in a list. To accomplish this, you 

use conditional formatting. This applies a 

rule to the contents of the cell to determine 

how it should appear visually. The display 

has no effect on the actual data stored in the 

cell, just on the resulting visualization.

For the example project, the starting 

value of the account numbers differenti-

ates the type of account. You want to create 

conditional formatting that will display the 

accounts beginning with the number 7 in 

green and the accounts beginning with the 

 FIGURE 14.13
Completed 
example of 
conditional 
formatting

 FIGURE 14.12
Conditional 
formatting 
example dialog 
box

14.3.1
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Comments
You can add comments to your spread-

sheet to identify values that need to be 

reexamined or to provide descriptions of 

a particular cell’s contents. Comments in 

spreadsheet software appear as small icons 

in the upper-left corner of the cell; by default, 

the comment itself will appear when the cell 

is selected. For the sample project, add com-

ments for changes to the supplier contact 

information; for instance, Custom Carts is 

undergoing a change in leadership as the 

business is passed from father to son, so it is 

worth making a comment in your document 

to remember that this change is coming and 

to get the new owner’s contact information 

updated as necessary. 

To add a comment to your document in 

Excel 2013, select the cell in which you want 

the comment to reside, open the Review 

ribbon, and select New Comment. This will 

open the comment text box in which you 

can enter the information you want to add. 

Other tools in the Comments panel of the 

Review ribbon help you navigate through 

the comments in the document, delete com-

ments, or toggle their display. The completed 

comment example is shown in Figure 14.14. 

14.3.3color gradients for the range of values where 

they get darker as the numbers get smaller 

or larger, depending on the condition, and 

apply data bars to track relative values, 

which is helpful when you are ranking 

numeric values or currency.

Activity 14.2—
Conditional Formatting

Create a new spreadsheet and save it as 

Activity14_2. Add the numbers 1 to 10 in 

column A from A1 to A10. Apply conditional 

formatting to display a range of colors based 

upon the value of the cell. Describe the pro-

cess that was used to apply this formatting 

and identify when you may use it on a real 

data set. Be sure to save your work.

Tab Color
Spreadsheet programs allow you to 

change the tab color that identifies your 

spreadsheets within the overall workbook. 

This helps provide a visual reference for 

either the purpose of different sheets or the 

department to which the tabs apply. Apply a 

green color to the Suppliers tab in your proj-

ect by right-clicking on the tab and selecting 

the Tab Color option. You can then select a 

color from the submenu that appears.

14.3.2

 FIGURE 14.14
Comment 
example in Excel 
2013

Theodor Richardson: 
The business is being 
passed to Cal’s son; 

new contact information 
will be needed soon.
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an example text box added to the project in 

Figure 14.15.

To insert a text box in Excel 2013, open 

the Insert ribbon and select Text Box. You 

can resize the text box by using the outer 

grab points just as you can in the other 

Office programs. The text box can be moved 

around the spreadsheet independently and 

will cover the cells behind it. Selecting the 

text box will also activate the context-sen-

sitive Format ribbon for Drawing Tools. In 

Excel 2011, you can insert a text box by 

selecting the Insert menu and choosing Text 

Box; you can then draw the text box in the 

location you desire.

Activity 14.3—
Media Elements

Create a new spreadsheet and save it 

as Activity14_3 and save it in the Activities 

folder. Use the ribbon interface to add an 

image to your Excel worksheet. When would 

this functionality be necessary or beneficial 

in a business environment? 

Now add an element of 

SmartArt to your document. 

In Excel 2011, the comment commands are 

also located on the Review ribbon; to view 

a comment in the document, however, you 

have to hover your mouse over the icon rep-

resenting it.

You can adjust the text as necessary 

and add other comments to your document 

as practice. The text of the comment may 

vary, but you can copy the example shown 

in Figure 14.14. In Excel 2013, the New 

Comment icon will change to Edit Comment 

when you already have a comment added 

to the cell; you can use this icon to edit the 

comment contents. In Excel 2011, the New 

command remains the same, but you can 

use it to edit an existing comment if the cell 

that contains it is active.

Text Boxes
A text box in a spreadsheet behaves as 

an independent object just as it does in word 

processing software and presentation soft-

ware. It will occupy the layer above the cells 

of the spreadsheet by default and will not be 

affected by resizing elements of the docu-

ment. Text 

boxes in 

s p r e a d -

sheets can 

be useful 

for provid-

ing instruc-

tions or 

e x p l a n a -

tions of the 

document 

as a whole. 

You can see 

14.3.4

 FIGURE 14.15
Text box added 
to a spreadsheet
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For this project, open a new spreadsheet 

document and save it as MyChartExamples. 

Create a spreadsheet tab for each of the 

main types of charts discussed here: 

Column, Line, Pie, Bar, Area, and Scatter. 

Use the data provided for each of the follow-

ing examples and create the charts yourself 

to investigate the variances in construction 

of the different chart types. You should be 

familiar with the process of creating a chart 

by now, so the details will be omitted unless 

there is a departure from the standard 

procedure. For a review of how to insert a 

chart into your document, you can review 

Section 13.4.

Column
A column chart is primarily used for 

comparisons, such as changes over time or a 

comparison of regions or countries. The best 

use of a column chart is when the highest 

column represents the optimal condition. 

When there are multiple columns coupled 

together, it is typically to show a com-

parison of parts of the same overall whole. 

Figure 14.16 shows an example of a column 

chart and the accompanying data to repro-

duce it.

Line
A line chart is used to track data over 

set intervals. In most cases, the data in each 

series has an existing (primarily linear) 

relationship and the points of data are con-

nected. A line chart is a basic graphing tool 

that can be used to demonstrate a variety of 

data in a variety of circumstances; multiple 

series represent independent sets of obser-

vations that may or may not be interrelated. 

14.4.1

14.4.2

What type of information can this graphic 

provide better than a chart? What are some 

examples of when this would be a useful 

inclusion in a worksheet? Be sure to save 

your work.

CHART TYPES
Charts can take a wide variety of forms, 

and different chart types are useful for rep-

resenting different types of information. The 

common types of charts you will encounter 

in spreadsheet software include column, 

line, pie, area, and scatter charts; all of these 

types are constructed from underlying data 

of some form, although not all data can sup-

port all chart types. When choosing a chart 

type, you need to consider what information 

you want to present and how you want to 

present it. There are other forms of charts 

available for you to construct from your 

data, but those typically require an area of 

expertise beyond general use. The follow-

ing sections provide a further explanation of 

some common chart types, along with exam-

ples of their usage so you can determine 

which charts are best for your own use.

14.4

Sparklines (a term originally proposed by 
Edward Tufte) are small, highly dense graphs 
intended to be placed where they make an 
impact in a document rather than occupying 
a large amount of space on a separate page 
or sheet like a traditional chart. These occupy 
a single cell in Excel. Sparklines can be used 
to emphasize a particular goal or main point; 
there is no significant detail or axes in these, 
but you can easily see a trend or outcome. 
These can be inserted in Excel 2013 from 
the Insert ribbon or in Excel 2011 from the 
Charts ribbon. 
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item. An example of a pie chart is shown in 

Figure 14.18.

Bar
A bar graph shows comparisons among 

individual items for a single observation. The 

stacked version of the bar graph compares 

elements that comprise a whole within each 

individual item. A representation of sales by 

region for a single quarter would be appro-

priate for a bar graph. Figure 14.19 shows 

an example bar graph and the data used to 

construct it.

14.4.4

An example of a line chart is shown in 

Figure 14.17.

Pie
A pie chart is a representation of the 

elements that comprise a total value. The 

visual display is a circle comparing the rela-

tive values of the components, typically as 

a percentage of the whole. A pie chart is 

best used when you want to showcase the 

proportional contribution of one element of 

the whole, such as the number of answers 

selected in a multiple-choice question. Pie 

charts are best used to illustrate a single 

14.4.3

 FIGURE 14.16
Column chart 
example

 FIGURE 14.17
Line chart 
example
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Scatter
A scatter chart is best used to show data 

clustering or alignment between multiple 

series of data; it consists of points plotted on 

multiple axes without connections (or with 

14.4.6

Area
An area chart 

demonstrates how 

pieces contribute to 

a total value through 

multiple observations. 

Each piece in each 

observation should 

represent a piece of a 

total value. The area 

chart should demon-

strate relative contri-

butions and trends over time along with 

the overall trend of the total data mea-

sured. You can see an example of an area 

chart in Figure 14.20.

14.4.5

 FIGURE 14.18
Pie chart example

 FIGURE 14.19
Bar chart example

 FIGURE 14.20
Area chart 
example
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CHAPTER SUMMARY
This chapter presented more advanced concepts for navigating, formatting, and manipu-

lating cells in a spreadsheet document. One of the common functions of a spreadsheet is to 

manage a list of information, which includes filtering and sorting data; the necessary pro-

cedures for these tasks were covered here. Additional formatting tools like table formatting 

and tab coloring for easy identification were also described. Finally, various common types 

of charts that can be produced were explained with examples. The next chapter focuses on 

the advanced use of formulas for calculation in spreadsheets and describes some of the tools 

for automatically associating and calculating results; these include the use of data tracing, 

subtotals, and PivotTables.

Activity 14.4—Chart 
Modification

Create a new spreadsheet and save it 

as Activity14_4 and save it in the Activities 

folder. Add data to replicate one of the chart 

types presented in this chapter. Use the con-

text-sensitive chart tools to add all possible 

chart elements. Change the display style of 

your chart using the available formatting 

tools. What options are provided for altering 

the appearance of your chart? When would 

this be beneficial in business and how does it 

help you convey information? Be sure to save 

your work.

nonlinear connections) between either the 

series or the consecutive points in the series. 

It assumes there is no defined relationship 

between points in the data series or at least 

significant enough variation that a linear 

connection would be inaccurate. An exam-

ple of this type of chart would be a map of 

predictions versus observations in an area 

where the relationship is not linear, such 

as observed temperatures. An example of a 

scatter chart is shown in Figure 14.21.

 FIGURE 14.21
Scatter chart 
example
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CHAPTER KNOWLEDGE CHECK
You can sort multiple columns in the same filter at the same time.

 A. True

 B. False

You can apply multiple conditional formatting rules to the same cell at the same time.

 A. True

 B. False

You can unmerge cells that have not been merged to add columns or rows to your spreadsheet.

 A. True

 B. False

Hiding one of the columns of a merged cell also hides the contents of the merged cell.

 A. True

 B. False

The Values selection of the Paste Special option removes formulas from the copied cells and retains 
only the data calculated by the formulas.

 A. True

 B. False

The following is a valid cell reference for a workbook containing Sheet1 and Sheet2.

 A. ‘Sheet2’!6B

 B. Sheet2.B4

 C. ‘Sheet2’A3

 D. All of the above

 E. Both A and B

 F. None of the above

The following type of chart assumes no clear relationship between the entries in a series:

 A. Column

 B. Line

 C. Scatter

 D. All of the above

 E. None of the above

1

2

3

4

5

6

7
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CHAPTER REVIEW QUESTIONS
How could Excel be used to benefit you in your daily life? Give specific examples as part of your 
answer.

Other than accountants, who are some professionals that might use Excel? What types of data 
would they want to enter into a spreadsheet? 

How does formatting cells help to better interpret data? What kind of formatting is available in Excel 
to make interpretation easier?

What would be a reason to have multiple worksheets within one workbook? Why not make each 
worksheet its own workbook? Explain your answer.

How does merging cells affect data presentation? How would a merged cell be applied in a formula 
calculation?

Why might there be unwanted duplicate values in a spreadsheet? Give examples to explain your 
answer.

1

2

3

4

5

6

A pie chart is primarily useful for displaying:

 A. Changes over time

 B. Contributions to a total value

 C. Nonlinear relationships

 D. All of the above

 E. None of the above

The following is an option for converting text to columns:

 A. Adding a column break where there is whitespace

 B. Using a delimiter such as a comma or semicolon

 C. Establishing a fixed width for each column

 D. All of the above

 E. None of the above

Hidden values cannot be used in formula calculations.

 A. True

 B. False

8

9

10
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When would you want to convert text to columns? Give examples to support your answer.

Considering the types of data you encounter on a daily basis, whether it is currency data, 
percentages, or various other types of values: what chart type would be most helpful in interpreting 
and/or displaying this data? Explain your answer.

How can sorting and filtering be used to manage large amounts of data? Justify your answer with 
examples.

Explore the options for inserting media elements into an Excel document. Why are fewer options 
available for including media in Excel than there are in Word and PowerPoint?

7

8

9

10

PRACTICE EXERCISES
Using the MySuppliers example you constructed in this chapter, provide more complete management 
of the Supply List data. Because data should not be repeated in multiple lists, remove the values in 
the Supply List sheet other than the company and account number that do not pertain to the order. 
Add a column to calculate the cost of the order using a formula (Cost = Price * Quantity). Filter and 
sort the list so all of the orders from a particular company are listed together. Format the list as a 
table and change the tab color. Apply conditional formatting to show the most expensive orders in 
the list. Use data bars to assist in the visualization if your software application supports them.

Add an additional data series to each of the chart examples you constructed and save your work as 
a new file. How does this affect the display? Which charts should allow additional data series and 
which should not? Add a text box to your spreadsheet to answer these questions.

Using Figure 14.22 as a guide, construct a balance spreadsheet for a checking account. Use the 
Conditional Formatting function in Excel to define a rule for how positive numbers (credits) and 
negative numbers (debits) display in the amount column. You should format the debit values in red 
and the credit values in green.

Use the list example in Figure 14.3 as a guide to construct an 
address list in Excel with your own data (either real or fictional). 
Add headers to your data and format the result as a table using 
one of the preset table styles available in Excel. How do these 
styles differ from the styles used in Word?

Using Figure 14.3 as an example, construct an address list in 
Excel using your own data (real or fictional). Add a row of headers 
to your data. Use the Filter function available for formatting lists in 
Excel; select only the rows and columns you want to include in 
the result before applying the filter. Define a custom rule for the 
state/country value to narrow down the entries to a single state.

1

2

3

4

5

 FIGURE 14.22
Example account 
spreadsheet
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CHALLENGE EXERCISES

Fill in the blank with the appropriate type of chart:

 A.  charts are used to represent elements that comprise 

a total value.

 B.  charts are used to show data clustering or alignment 

between multiple series of data.

 C.  charts are used to track data over set intervals.

 D.  charts are used to show comparisons among 

individual items for a single observation.  

 E.  charts are used to demonstrate how pieces 

contribute to a total value through multiple observations.

 F.  charts are used for comparisons, such as changes 

over time or a comparison of regions or countries.

Using Microsoft PowerPoint, develop an Excel worksheet tutorial. Use screenshots when explaining 

the following concepts: merging, column manipulation, cell referencing, list management, and tab 

colors. Make sure to develop an outline for your presentation.

Use Microsoft Excel to detail your personal finances. Construct a worksheet that calculates your 

monthly expenses and income. Use the formatting tools you learned in this chapter as well as 

Chapter 13. Then use a pie chart to show where the majority of your money is being spent for that 

month. Make sure to use the formatting elements you have learned in this chapter. If you need to 

turn this in to your instructor, feel free to use imaginary values.

Write a summary of the different categories of charts available in Excel (this is best suited to a Word 

document). Describe one example of the type of dataset that would be best represented by each 

specific chart type.

Create a pie chart like the one shown in Figure 14.18, but change the data set type to multiple 

choice results where the total is a number instead of a percentage. When you have placed it in your 

document, add additional data to the data set. What happens to the chart when you expand the data 

set? What steps do you have to take to refresh of reset the chart data?

1

2

3

4

5
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CHAPTER  

15
Advanced Features of  
Spreadsheet Software

IN THIS CHAPTER

Spreadsheet software is a great tool for managing lists and visualizing 

information, but it is most commonly used for the advanced analysis and 

management of data. To that extent, this chapter focuses on the advanced tools 

of spreadsheet software such as the use of complex formulas, data validation, 

and variable tracing to equip you to use your spreadsheet software for financial, 

business, or personal data management. Additional features, including pivot 

tables, subtotals, variable tracing, and external data management, are also 

covered to give you a better understanding of the power of this type of software 

application. At the completion of this chapter, you will be able to: 

●	Use common functions in your spreadsheet document

●	Use IF statements to conditionally evaluate data

●	Trace variables through a complex spreadsheet application

●	Construct pivot tables and subtotals as additional 
evaluation methods

●	Perform goal seeking and evaluate what if scenarios on 
numeric data

Microsoft Office 
2013/365 and 

Beyond
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BUSINESS 
APPLICATIONS

Spreadsheet software has a variety of 

uses, but it is most prevalent in account-

ing and other business applications. For 

the example project in this chapter, you 

will manage the financial information for 

the company that was proposed back in 

Chapters 11 and 12. The business has gone 

exceedingly well while you were reading the 

intervening chapters and your first monthly 

financial analysis has come due. While this 

is decidedly business oriented (and primar-

ily financial), as that is the general setting in 

which most people encounter spreadsheets, 

you should note that there are a variety of 

formula types to accommodate complex 

mathematics, statistics, and engineering 

applications. Data analysis and calculation 

belongs almost exclusively to spreadsheet 

software in terms of the productivity appli-

cations in common use.

The project file you will use in this chap-

ter is MyBusinessWorkbook, which is avail-

able as part of the companion resources for 

this text. The workbook contains a 

number of spreadsheets within it 

that you will utilize and manipulate. Since 

you are working on the financial informa-

tion for January and you want to keep the 

original file as a clean copy in case you need 

to correct anything, you should save the file 

as MyJanuaryRevenue.

The first sheet in the workbook is 

January Commissions; this is a blank work-

sheet where you will calculate the commis-

sions for your sales team as the chapter 

15.1

on the dvd
 

SPREADSHEETS VERSUS DATABASES
Spreadsheet software and database software 
both excel at managing information. The major 
difference between the two is the relational 
aspect of the database, which minimizes data 
duplication errors, and the calculation abili-
ties of the spreadsheet software. The choice 
of which to use should ultimately be driven by 
the purpose of the document you are construct-
ing and the reuse of the information in that 
document. 
For instance, you can manage a list in a 
spreadsheet with ease, and as long as you do 
not have multiple copies of the list in exis-
tence, the data should be consistent; using 
a database ensures the list is consistent, but 
it would probably be a more involved pro-
cess to initially create the list and to main-
tain and access it. Similarly, databases can 
manage information well, but they are not 
useful for calculation; to perform analysis 
on the data beyond filters and reports, you 
will likely need the power of a spreadsheet 
application. Fortunately, part of the func-
tionality of a spreadsheet program is to con-
nect with a database; this means if you are 
willing to expend the effort to construct and 
manage the database, you can use it to store 
your information and use the spreadsheet to 
access it and perform the necessary analysis.
While there is no complete list of criteria 
for this decision, a database is probably nec-
essary for storing your information if any 
of the following are true in the particular 
circumstance:

•	The data is subject to numerous changes 
by multiple people.

•	Changing information in one spread-
sheet requires updating multiple other 
spreadsheets.

•	The information has permanence to the 
organization and cannot afford to be lost.

•	The amount of data makes it unmanage-
able in a single spreadsheet document.
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to the SUM function in Chapter 13; this is 

one of many common functions that you 

will encounter with even basic analysis in a 

spreadsheet document.

Common Functions
As you may already know, all of the com-

mon mathematical operations of addition 

(+), subtraction (-), multiplication (*), and 

division (/) can be used in the construction of 

formulas in spreadsheet software. Whenever 

mathematical operations are used, they will 

follow the defined order of operations, calcu-

lating whatever is inside parentheses first, 

then completing formulas, and finally per-

forming division, multiplication, subtrac-

tion, and addition. The cell references act 

as the variables in the calculations, but the 

actual data in the cell is used as the value 

wherever the cell is referenced. For the most 

part, functions operate on numeric values; 

there are some functions, though, that per-

form operations on text as well.

You can identify a range of values by 

separating the cell references with a colon 

(:), so the reference value A1:A4 would 

indicate cells A1 to A4 inclusive of the cells 

between them. When using a range of cells 

as input, you can use a comma to skip val-

ues, so the reference value for the familiar 

SUM function of SUM(A1:A4,A6) would 

include cells A1 through A4, skip cell A5, 

and include cell A6. The comma can be 

used to skip any number of cells horizon-

tally or vertically; you can view this as sep-

arating the sequence of input. You should 

be aware that not all formulas will allow 

interrupted input.

15.2.1

progresses. The second sheet is January 

Sales, which is a list of the total sales num-

bers for the month for all of the companies 

purchasing your products for use in their 

venue; some of these are franchises of your 

original business and others are external 

companies. The third sheet is called January 

Supply List; this is a record of the supplies 

that were ordered to fulfill your customers’ 

orders for the month. You should recognize 

the companies and products from the con-

struction of the supplier list in the previous 

chapter. The fourth tab is for the Customer 

List spreadsheet. This sheet is a mapping 

between the customers and the sales repre-

sentative handling the account. Fifth in the 

list is the chart of Sales Representatives; this 

details the sales personnel, their commis-

sion rate on sales, the threshold for them to 

qualify for a bonus, and the bonus amount 

they are awarded if they meet their goals. 

The final tab is for the Suppliers; this should 

be almost identical to the results you have 

from the project in the previous chapter.

USING FUNCTIONS
One of the most powerful components 

of spreadsheet software is the ability to 

evaluate complex mathematical formulas 

and trace numeric data through multiple 

iterations of calculation. There are an enor-

mous number of functions available for use 

in spreadsheet calculations; this chapter will 

cover the fundamentals and common func-

tions you will likely encounter and give you 

guidance on where to look up information 

on the rest of the functions that exist if you 

need to utilize them. You were introduced 

15.2
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highest single value for sales in 
January; this should be 24,000.

•	MIN returns a single minimum 
value from the set of cells given as 
input arguments; it takes the form 
MIN(…) and accepts all lists of cells 
or cell ranges with or without comma 
separators. The formula to return 
the minimum single value for sales 
in January is =MIN(B2:B13) on 
the January Sales sheet. The value 
returned should be 400.

•	ROUND takes two arguments, a 
value on which to operate and a whole 
number representing the number 
of digits to the right of the decimal 
point to include; this takes the form 
ROUND(A single numeric value, 
Integer number of significant digits). 
Unlike changes that simply modify 
the display, using the ROUND func-
tion will actually alter the value in 
the cell itself. Apply the ROUND 
function to the AVERAGE calcula-
tion you used earlier and use two 
decimal places for the cents compo-
nent of the currency. The adjusted 
formula for the average should be 
=ROUND(AVERAGE(B2:B13),2) and 
the return value should be 8614.17.

Notice the nesting of functions in the 

last example. Nesting functions is common 

in spreadsheet software to calculate complex 

values; whatever is located in the innermost 

parentheses or functions will be calculated 

first. In this case, the AVERAGE is computed 

and used as the input value in the ROUND 

function, which is calculated to two significant 

digits. Take this opportunity to further prac-

tice applying formatting to your spreadsheet 

by formatting all of the numeric values as 

currency except for the total number of sales 

in column B. A completed example of the for-

matted spreadsheet is shown in Figure 15.1.

Some of the common functions you will 

encounter in addition to the SUM function 

(which simply adds the value of every cell 

given as input) are AVERAGE, COUNT, 

MAX, MIN, and ROUND. The parentheses 

after the function name hold the arguments 

(or parameters) of the function; these are 

the values on which the function operates. 

Some functions use a specific set of values 

and others allow any input (represented 

here by an ellipsis). The details of these 

functions are as follows:

•	AVERAGE calculates the total value 
divided by the number of inputs 
given for the formula. The format is 
AVERAGE(…) and it will accept any 
number of cells either in range format 
or individually separated by comma. 
You will use this to calculate the aver-
age sales value for a customer in the 
list for January on the January Sales 
sheet. To calculate this value, enter 
=AVERAGE(B2:B13) in cell B15. 
If you have done this correctly, you 
should get the value 8,614 as the whole 
number component (the digits to the 
right of the decimal point will vary 
based on the number of decimal digits 
your formatting is set to display).

•	COUNT returns the number of 
entries in a list of cells; the format is 
COUNT(…), and it will accept cells, 
cell ranges, and comma-separated 
entries. Add an entry for the count of 
the total number of sales for the month 
using the formula =COUNT(B2:B13) 
in the same January Sales sheet. You 
should get the value 12.

•	MAX returns the single maximum 
value from the set of cells given as 
input arguments; it takes the form 
MAX(…) and accepts any list of 
cells or cell ranges with or without 
comma separators. Use the formula 
=MAX(B2:B13) to determine the 
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Text Functions
There are a number of functions that 

apply to the manipulation of text as opposed 

to numeric values. For the most part, these 

are useful for converting text values that are 

imported from another data source. Some of 

the most common functions for manipulat-

ing text are as follows:

•	CONCATENATE is used to join the 
contents of two or more cells contain-
ing text into the same text result. 
CONCATENATE can accept multiple 
arguments, whether they are individ-
ual cells, cell ranges, or cells sepa-
rated by a comma. The format of the 
function is CONCATENATE(…), and 
it returns a text result. An example 
is CONCATENATE(A2,A3), which 
would return the text of both cells 
joined without spaces in the order 
specified. 

•	LEFT takes the form LEFT(A single 
cell containing text, A whole number 
value of characters) and returns the 
specified number of leftmost charac-
ters of its first argument. An example 
is LEFT(A4, 2), which would return 
the two leftmost characters of cell A4. 
This can be helpful when you need a 
subset of information to display, such 
as a piece of an account number. You 
can use LEFT inside of other func-
tions; it returns a text result but can 
be applied to numbers or text cell 
contents.

•	RIGHT works in exactly the same way 
as LEFT except it takes the number 
of rightmost characters specified in 
the second argument. An example is 
RIGHT(B4, 2), which would return the 
two rightmost characters in cell B4.

•	UPPER converts its argument to 
all uppercase text; this can allow for 
more accurate searching if casing is 
an issue. It can also help to display 

15.2.2

Activity 15.1—
Numerical Functions
Create a new spreadsheet and save it 

as Activity15_1 and save it in the Activities 

folder. Add numeric values to cells A1 

through A10. Explore the calculation func-

tions you have learned in the chapter by 

creating a table similar to the one in Figure 

15.2 except using calculations instead of text. 

Explore one additional calculation function 

in Excel. What is the result of using this 

function? When would this be useful? Be 

sure to save your work.

 FIGURE 15.1
Calculation results for January Sales spreadsheet
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(“”). This can be used to include a keyword 

in a search formula you are constructing 

or to simply represent a display condition 

such as “Yes” or “No” in a cell based on an 

IF condition (as covered in a later section of 

this chapter). The text concatenation opera-

tor is the ampersand (&); this is a short-

hand way to invoke the same result as the 

CONCATENATE function. The results of 

“=CONCATENATE(A2,A3)” are the same 

as “=A2&A3” in terms of return value and 

display. One use of both concatenation and 

literal strings is adding a space between first 

and last names; if they were contained in 

columns A and B, respectively, the formula 

would be A3&“ ”&B3 to return the contents 

of cell A3, a space, and the contents of cell B3 

as a single text result. While they should not 

be a part of your final document, Figure 15.2 

shows the results of the example functions 

described earlier as applied to the January 

Sales spreadsheet.

Activity 15.2—
Text Functions

Create a new spreadsheet and save it 

as Activity15_2 and save it in the Activities 

folder. Add text to cells A1 through A10. 

Explore the text functions you have learned 

in the chapter by creating a table similar to 

the one in Figure 15.2. Explore one addi-

tional text function in Excel. What is the 

result of using this function? When would 

this be useful? Be sure to save your work.

Value Lookup
The ability to look up data in one spread-

sheet or section from another is vital in 

most complicated projects. Using the lookup 

15.2.3

entities of importance if coupled 
with an IF condition, as discussed 
later in this chapter. An example use 
of UPPER is UPPER(A3), which 
would return the text of cell A3 in 
uppercase.

•	LOWER converts its argument to all 
lowercase text; this works in the same 
manner as UPPER and has the same 
format. An example use of LOWER 
is LOWER(A4), which would return 
the contents of cell A4 in all lowercase 
letters.

•	VALUE evaluates the text in the 
cell entered as an argument into a 
numeric value; this is particularly 
helpful if the data is from an external 
source such as a text file or database 
that lacks the capacity to convert it 
to a number implicitly. The VALUE 
function takes the form VALUE(A 
single cell containing a text repre-
sentation of a number) with only one 
argument referencing a cell contain-
ing text. An example of the use of 
VALUE is VALUE(B4), which would 
return the numeric value equivalent 
of the text contents of cell B4. The 
result can be used in other formulas. 
This can often help to correct data 
reading errors if they are present 
when the formula is otherwise cor-
rect, particularly when the data being 
used is imported.

You can represent a literal text string by 

surrounding it in double quotation marks 

If you are importing text and you are not getting the 
correct results in your formulas, you can use the Text 
to Columns conversion to format the text into the 
format expected by your spreadsheet software. You 
can do this without constructing multiple columns by 
choosing the delimited option and selecting a charac-
ter that does not appear in the text as the delimiter. 
The preview at the bottom of the dialog box should 
let you know if you have set it up correctly because it 
should display only a single column.
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the range for the value specified in the first 

argument. The third argument is the offset 

value of the column of information you want 

to return if a match is found; the column in 

which the information is found is considered 

column 1, so a value of 2 in this argument 

would indicate the column immediately to 

the right of the column being searched. The 

final argument is a TRUE or FALSE value; 

these are literal values representing a condi-

tion case of true or false, which can also be 

equated to yes or no and 1 or 0 for binary 

values. In this case, FALSE represents the 

case where you want the search to return an 

exact match for the item for which you are 

searching and TRUE represents the allow-

ance of partial matching for identifying a 

value to return.

To use this function in practice, you 

will place the sales representative for the 

customer in your January Sales sheet in 

features also reduces the manual duplica-

tion of values, which will help reduce the 

overall errors in the spreadsheet document. 

There are two primary functions that can 

be used to perform a value lookup in your 

workbook: VLOOKUP and HLOOKUP.

VLOOKUP is a function for performing 

a vertical lookup of information in a spread-

sheet. The format is VLOOKUP(Item to 

find, Range of cells in which to look, Offset 

value of column to return, Exact match or 

approximate match). While it may seem 

complicated, as you become familiar with 

the function, you will gain an understand-

ing of the arguments. The first argument is 

simply the text to locate; this can take the 

form of a literal text string (enclosed in dou-

ble quotation marks) or a cell reference. The 

second argument is the list of cells in which 

to look for the text; the VLOOKUP function 

will search the first column identified in 

 FIGURE 15.2
Text functions 
applied to the 
January Sales 
spreadsheet
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search column is to the right of the value 

you want to return. A completed example of 

this lookup is shown in Figure 15.3; use this 

to compare your results.

There is an equivalent horizontal lookup 

function called HLOOKUP that searches 

the first row of the cell range instead of the 

first column. It assumes the return data is 

located in the same column but in a row 

beneath the one being searched. The param-

eters and usage are otherwise identical. 

If you are using a specific cell range to 

search for values repeatedly, you can actu-

ally name the range of cells and use the 

name to reference the range instead of 

retyping the reference. You can add a name 

to a range of cells using the name box to the 

left of the Formula Bar on the spreadsheet 

application where the cell reference typi-

cally appears. For instance, select the range 

of cells for the customers and the assigned 

representatives in the Customer List sheet 

and name it CustomerReps as shown in 

Figure 15.4. You can now substitute the 

column C. The column heading should be 

Sales Representative and the formula in cell 

C2 should be =VLOOKUP(A2,‘Customer 

List’!$A$1:$B$14,2,FALSE), where A2 is 

the cell whose contents you want to find in 

the Customer List spreadsheet in the range 

of cells A1 to B14; these cell references need 

to be absolute (using the dollar sign for both 

the row and column) in order to repeat this 

function for the rest of the column without 

changing your search range. For this func-

tion to work properly, you should make sure 

the value you are trying to find will occur 

exactly once in the cell range you are search-

ing. The third argument specifies that the 

return value is the content of the cell imme-

diately to the right of the matched item, 

where the search column is considered col-

umn 1 and the return value would be the 2 

value specified. The FALSE argument indi-

cates only an exact match should be consid-

ered. This function works only for returning 

values to the right of the matched column, so 

you may need to rearrange your data if your 

 FIGURE 15.3
VLOOKUP example 
results
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the relative value of the arguments on both 

sides and return whether the condition is 

true. For example, in the conditional state-

ment B2>B3, if the value of cell B2 is larger 

than the value of cell B3, the result will be 

TRUE; otherwise it will be FALSE. There 

are six logical operators you can use: less 

than (<), less than or equal to (<=), equal 

(=), not equal (<>), greater than (>), and 

greater than or equal to (>=). 

There are also three functions that can 

assist in developing a logical evaluation—

NOT, OR, and AND. 

•	The NOT function simply negates 
its argument, returning TRUE if the 
argument is FALSE and vice versa. 
For example, NOT(F8) would return 
FALSE if F8 is TRUE; NOT will only 
accept as input logical values that will 
return TRUE or FALSE. 

•	The OR function accepts any num-
ber of inputs as long as they return 
logical values of TRUE or FALSE; it 
will return TRUE if any individual 
argument it is given is TRUE and 
will return FALSE only if all of the 
arguments given are FALSE. An 
example is OR(F5,F6) where F5 and 
F6 are cells containing either TRUE 
or FALSE values. 

•	The AND function takes input argu-
ments in the same format as OR. 
The main difference is that AND 
will return TRUE only if all of the 
input arguments are TRUE and will 
return FALSE if any of the input 
arguments are FALSE. An example 
is AND(F6,F7) where F6 and F7 are 
cells containing logical values.

You should include an IF statement in 

column D of your January Sales spread-

sheet to evaluate whether the sales for 

that customer are greater than the average 

name tag CustomerReps 

to reference these cells on 

any of the spreadsheets 

within your workbook. You use the Name 

Manager icon on the Formulas ribbon in 

Excel 2013 to add or edit the labels for these 

selected cell ranges; in Excel 2011, use the 

Insert Name icon on the Formulas ribbon to 

add defined names.

IF Statements and Logic
The IF function evaluates a condition to 

either true or false and then returns a differ-

ent value based on the outcome. The format 

is IF(Condition, Result if TRUE, Result if 

FALSE). The result of the condition needs 

to be either the literal TRUE or the literal 

FALSE; you must make sure the proper logic 

is applied to return one of these conditions.

To do this, you typically need to use 

logical operators. Logical operators evaluate 

15.2.4

 FIGURE 15.4
Naming a cell range
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learned in the chapter by creating a table 

similar to the one in Figure 15.5. Create a 

complex IF statement to produce a different 

calculation depending upon whether the con-

dition is true or false rather than just print-

ing a different text response. When would 

this type of IF statement be useful? Be sure to 

save your work.

Function Wizard
There are a large number of functions 

available for use in spreadsheet calcula-

tion. Those introduced so far are common 

functions and operators that you will likely 

encounter with even casual use of the soft-

ware. You can look up the functions your-

self if you want to use them or you can use 

the Function Wizard to help you identify 

and construct the function you want. The 

Function Wizard is available in both Excel 

2013 and Excel 2011; you can activate it from 

the Insert Function icon on the Formula Bar. 

15.2.5

value; this may be superfluous at this point, 

but it would help to identify the largest cus-

tomers for a business. The formula for cell 

D2 should be IF(B2>=$B$15,“Yes”,“No”); 

this will be the basis for the column, so make 

sure you use an absolute reference to cell 

B15, which contains the average value you 

calculated for the monthly sales. This for-

mula will display the text “Yes” if the value 

of the individual sale is greater than or equal 

to the average sale value or “No” if it is less 

than the average sale value. Fill the column 

with this formula. The results of this calcula-

tion along with the logic examples provided 

earlier are shown in Figure 15.5.

Activity 15.3—Logic 
and IF Statements

Create a new spreadsheet and save it 

as Activity15_3 and save it in the Activities 

folder. Add values to cells A1 through A10. 

Explore the logic comparators you have 

 FIGURE 15.5
Logical function 
evaluations
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a formula result is changed. You can control 

this behavior, however, if you want to delay 

the update operation. If you choose to change 

this setting in Excel 2013, select the Formulas 

ribbon and change the Calculation Options 

menu settings from Automatic to Manual. 

You can then use either of the icons to the side; 

Calculate Now will manually recalculate the 

entire workbook and Calculate Sheet will cal-

culate only the current spreadsheet. In Excel 

2011, the settings for manual and automatic 

calculation are found under the Settings icon 

on the Calculation panel of the Formula rib-

bon; this ribbon also has icons to Recalculate 

All and Recalculate Sheet manually. 

Tracing Variables
You can visually trace the variables 

used in the construction of your formulas in 

spreadsheet software; this can be a helpful 

when you are updating data and want to see 

how the update will affect your work. You 

can trace both the dependents and the prec-

edents of your formula; these operations are 

only valid on formula data. Dependents show 

the connections to cells that are affected by 

a change to the selected formula. Precedents 

show the cells that contribute values to the 

current formula, such as cells referenced by 

the formula for calculation. 

In Excel 2013 and Excel 2011, you can 

activate the arrows displaying the depen-

dents of a cell by activating a cell containing a 

formula calculation, selecting the Formulas 

ribbon, and clicking the Trace Dependents 

icon. An example of the visual result for per-

forming this action on cell B15 is shown in 

Figure 15.7.

15.2.7

The Function Wizard first prompts you 

to look up the formula or function you want 

to include in your calculation. When you have 

selected it, you can then add each argument 

separately in the dialog box that opens. You 

can see an example of the Function Wizard 

for Excel 2013 in Figure 15.6. In Excel, 

the Function Wizard (or Formula Builder) 

allows you to type keywords associated with 

the function to help you look up the correct 

function or formula 

you want to use.

In Excel 2011, the Function Wizard is called 
the Formula Builder; it has the same function-
ality, but it appears in a toolbox outside of the 
main interface.

 FIGURE 15.6
Function Wizard example

Calculation Options
You can force a manual recalculation of 

your workbook by pressing the F9 key on 

the keyboard. By default, all calculations are 

updated as soon as one of the cells that affects 

15.2.6
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To remove the traces 

in Excel, select the Remove 

Arrows icon with the cell 

selected; this is also located in 

the Formulas ribbon. In Excel 

2013, the panel that contains 

this functionality also allows 

you to toggle between the 

display of calculated values 

and the formulas themselves 

by using the Show Formulas 

icon. You can also select the 

Evaluate icon to open a dia-

log box that will progress 

through the formula step by 

step to allow you to examine 

the results at each stage. In 

Excel 2011, you can display 

the formulas instead of the 
You can also acti-

vate the visual arrows 

for precedents of a 

formula. It is possible 

to have both of these 

traces active at the same 

time. To activate the 

tracing for precedents 

in Excel, select the cell 

containing the formula 

you want to trace, 

activate the Formulas 

ribbon, and click the 

Trace Precedents icon. 

An example of tracing 

precedents on cell D13 

is shown in Figure 15.8.

 FIGURE 15.7
Trace Dependents 
example

 FIGURE 15.8
Trace Precedents 
example
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about the allowed values. You can also use 

the Error Alert tab to define what will occur 

when invalid data is entered.

SUBTOTALS
Subtotals are a tool in spreadsheet soft-

ware that allows you to select the granularity 

with which you want to view the elements 

that contribute to an overall summation. 

Using subtotals is one application of group-

ing in a spreadsheet. Grouping cells in a 

spreadsheet couples the display of the cells so 

either all are showing or none are showing; 

you can group cells by rows or by columns. 

Grouping Cells
When you group cells in a spreadsheet, 

they can be hidden or shown as a group with 

the use of a toggle icon. To group a set of 

rows or a set of columns in Excel, select the 

row or column labels you want to include 

and select the Group icon from the Data rib-

bon. An example of grouping rows on the 

15.3

15.3.1

calculated results by checking the Show 

Formulas option under the Show icon on the 

Formulas ribbon.

Data Validation
Data validation can be used to monitor 

specific cells for a range of valid input. This is 

useful if you are using complex formulas that 

accept only certain data types or values. For 

instance, you can apply data validation to the 

cells containing sales amounts in column B 

of the January Sales spreadsheet so they will 

only accept positive decimal values. To apply 

data validation in Excel, select the cell or 

cells to which you want the data validation to 

apply, open the Data ribbon, and select Data 

Validation. The Data Validation dialog box 

that appears is shown in Figure 15.9.

You can set the criteria from the vari-

ous drop-down lists. In the example, set 

the allowed type to Decimal and configure 

the allowed data so it only accepts values 

greater than zero. You can use the Input 

Message tab to give your users a text prompt 

15.2.8

 FIGURE 15.9
Data validation 
example
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for the inclusion of incremental totaling 

for groupings of similar content. To con-

struct a subtotal example on the January 

Supply List spreadsheet, add a column 

after the existing data for calculating the 

cost (which should be the price times the 

quantity). Subtotals work on filtered data 

for automatically coupling information into 

subgroups, so you should filter the data and 

sort it by Account Number. This will place 

all of the orders from the specific accounts 

in the same location. You should remove any 

formatting and filters because the Subtotal 

command will only operate on regular cells. 

To construct this example in Excel 2013, 

select all of the rows in the January Supply 

List spreadsheet (after you have filtered 

and sorted the data) and then select the 

Subtotal icon on the Data ribbon. In Excel 

2011, this option is available by selecting 

the Data menu and choosing Subtotals. This 

will open a dialog box where you can select 

the settings for your subtotal results. In the 

example, you should subtotal at changes in 

Account Number, use the SUM function, 

and add totals to the Cost value. Make sure 

the Summary below data option is checked. 

The Subtotal dialog box and results are 

shown in Figure 15.11.

January Supply List spreadsheet is shown 

in Figure 15.10.

When you have grouped the rows or 

columns, you will see an additional space to 

the left of the row labels or above the column 

labels. This shows you where your groups are 

and the current status of their display; when 

a group is displayed, you will see a line bound-

ing the range of cells included in the group 

and an icon for a minus sign (-). Clicking this 

icon will hide the group and turn the icon into 

a plus sign (+), which can be used to show the 

hidden group. This is helpful if you have infor-

mation that you do not always want displayed 

but is necessary to keep. This is also an alter-

native to hiding individual rows and columns.

Grouping items at multiple levels allows 

the formation of subgroups. You remove a 

group in Excel by selecting the group and 

clicking on the Ungroup icon on the Data 

ribbon. You can also use the Show Detail 

and Hide Detail icons to show or hide the 

group without using the plus or minus icons 

in the margin. For the example, remove the 

grouping since this data set will be used for 

the construction of a subtotal example.

Constructing Subtotals
Subtotals are an offshoot of the group-

ing functionality in spreadsheets that allow 

15.3.2

 FIGURE 15.10
Group example
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to spreadsheet infor-

mation, and you can 

even reference the 

automatic calculations for your own 

use in other areas of your document.

Constructing a 
Pivot Table

To construct a pivot table in 

Excel, first select the data range you 

want to incorporate into the table and 

then click the PivotTable icon on the Insert 

ribbon in Excel 2013; in Excel 2011, the 

PivotTable command is an option under the 

Data menu. In the example, the data range 

is the sales information in the January Sales 

spreadsheet. When you click the PivotTable 

icon, the Create PivotTable dialog box, 

shown in Figure 15.12, will appear. You will 

be prompted to select the range of cells you 

want to include and where you want your 

table located; for the example, choose cell 

I2 (the intervening columns containing the 

formula examples have been hidden). 

When you click OK, the PivotTable 

Field List will appear as a pane on the side of 

15.4.1

When you have finished, you can format 

the result as a table; you are free to show 

and hide individual elements by grouping. 

This allows you to view the details of the 

orders or just the total cost of the order per 

account. You can also hide all of the infor-

mation except for the final total cost of all 

orders.

PIVOT TABLES
A pivot table is a tool for visualizing 

complex data that allows you to select the 

granularity with which you want to see 

the information presented. These can also 

perform limited automatic data calculation 

such as averages, summations, and counts. 

Pivot tables can be used as a supplement 

15.4

 FIGURE 15.11
Subtotal dialog 
box and results

 FIGURE 15.12
Create PivotTable 
dialog box
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column header for Sum of Revenue. You can 

change the formula used for computing val-

ues by selecting the Value Field settings on 

the menu of options for the Sum of Revenue 

entry (this is the i icon beside the field name 

in Excel 2011); this will open a dialog box 

where you can alter your choices for report-

ing information as necessary. There is a 

much larger range of functions that can be 

performed with pivot tables, but these are 

beyond the scope of this text.

Using Pivot Table 
Values in Formulas

Now you can calculate the commissions 

for the sales team and determine the overall 

net profit or loss for the month of January. 

To do this, you will first need to set up your 

spreadsheet on the January Commissions 

tab. The categories for this spreadsheet 

should be Sales Representative, Revenue, 

Commission Rate, Commission, Qualify for 

Bonus, Bonus Amount, and Total Payout. 

15.4.2

the interface (this is the PivotTable Builder 

window in Excel 2011) along with a place-

holder in your document that the result-

ing pivot table will occupy. Notice there are 

four categories in the lower portion of the 

PivotTable Field List; you can drag and drop 

the category information into each of these 

areas to arrange your pivot table informa-

tion, as shown in Figure 15.13.

Each heading can only occupy a single 

field. The options for selection are Row 

Labels, Column Labels, Values, and Report 

Filter. The row and column labels provide 

organization to the table; you can stack 

multiple values in these categories to create 

subgroups of data. In this case, add Sales 

Representative as the first row label entry 

and Client Company as the second row label 

entry; this arranges the data by representa-

tive and creates a subgroup of companies 

beneath the representative’s name. Drag 

Revenue to Values to create an automatic 

 FIGURE 15.13
Pivot table 
example
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and functional, use the fill down command 

to duplicate them to the cells below.

The function you will use to access the 

pivot table data is GETPIVOTDATA. It 

has the format GETPIVOTDATA(Return 

value category, Pivot Table location, 

Search category, Search value). In the 

example, you want to look up the rev-

enue value for the sales representa-

tive, so the formula for looking up the 

first sales representative would be 

GETPIVOTDATA(“Revenue”,‘January 

Sales’!$I$2,“Sales Representative”,A2). If 

you have followed along with the example, 

your result should look like Figure 15.14.

You should now calculate the total pay-

out for commissions. You will use this and 

the total payout for supplies to compare 

against the total income from sales. This 

will give you an idea of your net revenue for 

the month of January.

WHAT IF ANALYSIS
The tools for conducting a “what if” 

type of analysis in spreadsheet software 

include the ability to perform goal seeking 

on a value in a formula. Goal Seek will solve 

15.5

Copy and paste the names of the sales repre-

sentatives into the first column. You should 

then use VLOOKUP and IF statements 

to construct everything but the Revenue 

amount. The formulas for the first entry in 

each of these are as follows:

•	Commission Rate for the first 
sales representative in cell A2 is 
VLOOKUP(A2,‘Sales Representatives’
!$A$1:$D$7,2,FALSE).

•	Commission for the first sales repre-
sentative is B2*C2.

•	Qualify for Bonus for the 
first sales representative is 
IF(B2>=VLOOKUP(A2,’Sales Repres
entatives’!$A$1:$D$7,3,FALSE),“Yes”,
“No”),

•	Bonus Amount for the 
first sales representative is 

IF(E2=“Yes”,VLOOKUP(A2,‘Sales Rep
resentatives’!$A$1:$D$7,4,FALSE),0).

•	Total Payout for the first sales repre-
sentative is D2+F2.

These formulas are just more complex 

examples of what you have already prac-

ticed. By using VLOOKUP, you can base 

everything off of the sales representative 

name and avoid unnecessary duplication. 

Once you have all of these values in place 

 FIGURE 15.14
Commission 
calculation 
example
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interest rate you will need to match your 

expected payoff.

Goal Seek takes three values: a formula 

to optimize, the formula result desired, and 

a parameter to tune to achieve the desired 

result. To activate Goal Seek in Excel, open 

the Data ribbon, and choose What-If Analysis 

and then Goal Seek. You will be prompted 

with a dialog box as shown in Figure 15.15.

For this example, use the formula for the 

monthly payment as the formula to optimize. 

You should set the ideal value to -50,000; this 

is negative because it represents a payment 

and not a gain. Set the interest rate as the 

parameter to tune. When you click OK, the 

formula will be optimized to show the maxi-

mum interest rate you can have to pay off 

the loan in the specified amount of time with 

a monthly payment of $50,000.

Activity 15.4—
What-If Analysis

Create a new spreadsheet and save it 

as Activity15_4 and save it in the Activities 

folder. Add content to the cells similar to the 

calculations for the interest rate in Figure 

15.15. What other values can be determined 

using Goal Seek? What other options are 

available for What-If Analysis in Excel? 

When would this type of analysis be useful? 

What type of problems could not be solved 

using these tools?

a formula to find a single optimum value by 

varying one of the input arguments. 

To prepare the final financial informa-

tion for January, you should import the cost 

of supplies and the cost of payouts to your 

sales team and subtract them from the sales 

revenue. This will give you your net profit 

or loss for the month. Since you have a sub-

stantial loss when you compute this value, 

you will need to calculate the payoff of a 

business loan to cover the amount. If you 

have completed the example correctly, the 

amount to be borrowed should be $698,907.

Prepare a new section of your spread-

sheet to calculate the monthly payment to 

pay off this loan in 24 months. You will use 

Goal Seek to determine the interest rate 

you need to negotiate to make that happen. 

The values you will need are the total loan 

amount (which should be the negative of the 

loss amount for the month), the interest rate 

(you can start with 5 percent), the number 

of months to pay off the debt (24), and the 

payment amount per month; use the PMT 

function to calculate the monthly payment 

based on the other entries. This function 

has the format PMT(Interest rate, Months 

to pay, Amount to pay) and it returns the 

expected monthly payment. Divide your 

interest rate by 12 since it is an annual inter-

est rate and you want a monthly payment 

result. You can 

now use Goal 

Seek to deter-

mine the ideal 

 FIGURE 15.15
Goal Seek dialog 
box
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You can also connect your spreadsheet 

to a database, Web location (via URL), or 

text file. The database connection options 

include SQL Server and the alternate con-

nections include XML data. You can also 

click the Existing Connections icon to man-

age the connected data and use the Refresh 

icon to access options to update the data in 

your spreadsheet to match the most current 

information from the data source.

Exporting Data
Spreadsheet software has a variety of 

export options available from the Save As 

command. The most common exports for 

spreadsheet data are XML, HTML, and 

text. XML (eXtensible Markup Language) is 

a special kind of markup language similar 

in origin to HTML that provides a defined 

formatting style command based on the tag 

information provided. XML is commonly 

used for data formatting and is increas-

ingly used to pass data from one database 

to another. The XML option allows data-

bases to easily pick up the spreadsheet data. 

HTML is the common language of the Web 

and it contains predefined tags for table 

elements; you can export data from spread-

sheet software directly to HTML where it 

can be used online or interpreted by other 

programs. Text export is another option; 

the two common varieties of text export are 

tab-delimited and comma-delimited text 

information, where each line in the text 

document equates to a row. The columns are 

determined by the delimiter character. 

15.6.2

EXTERNAL DATA 
MANAGEMENT

Spreadsheet software has the ability to 

import and export data for use across mul-

tiple applications. This is especially useful 

if you want to analyze information from a 

database source or convert exported text to 

a spreadsheet for analysis. The common for-

mat for a text document that can be opened 

in spreadsheet software is a comma-sepa-

rated values (CSV) file, which simply uses 

commas as delimiters for the text and treats 

each new line as a new row. You can import 

or export this type of information.

External Data Sources
You can import data into your spread-

sheet from a variety of external sources. In 

business, it is most likely the data is from 

a database, which you will learn about in 

Section V, “Database Software and Microsoft 

Access.” You can connect to several data 

sources from your spreadsheet software 

including delimited text files, database con-

nections, and other spreadsheet documents. 

As an example, you can create a new spread-

sheet in your workbook and name it February 

Sales and then import the MyFebruarySales 

text file into the spreadsheet as an example. 

To do this in Excel, select the From 

Text icon (simply called Text in 

Excel 2011) on the Data ribbon and follow 

the prompts for formatting your text; this is 

similar to the Text to Columns functionality. 

An example dialog box for this formatting 

option is shown in Figure 15.16. Because 

the data includes commas in this case, the 

delimiter used is a semicolon (;).

15.6

15.6.1

on the dvd
 

MSOffice-Beyond-CH15.indd   391 5/19/2014   7:13:07 PM



392 — Microso f t  Of f i ce  2013/365 and  Be yond

to place your Excel windows in a practical 

arrangement. You can also use the Save 

Workspace command (called Save Layout 

in Excel 2011) to retain this arrangement 

for future use.

If you want to view multiple areas of 

the same spreadsheet, you can use the Split 

command on the current view of your docu-

ment. This separates your document pane 

into four separate panes with scrollbars to 

manipulate pieces of them independently 

and allows you to view different areas of a 

complex sheet at the same time. This icon 

acts as a toggle, so you can deactivate it to 

return to the standard view.

ARRANGING THE 
WORKSPACE

Excel gives you a number of options 

for managing your workspace. These 

options are located on the View ribbon 

in Excel 2013 and on the Layout ribbon 

in Excel 2011. You can select the New 

Window icon (which is just labeled New on 

the Window panel in Excel 2011) to open 

a new window with a view of the current 

document; this allows you to view mul-

tiple spreadsheets in the same document 

simultaneously. You can then arrange the 

windows in a manner that lets you manip-

ulate your spreadsheet best. Commands 

like Cascade and Side by Side allow you 

15.7

 FIGURE 15.16
Text Import Wizard
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CHAPTER SUMMARY
Spreadsheet software provides powerful tools for data management, analysis, 

and visualization. It is capable of effectively managing lists and organizing 

information. You can create complex formulas that span multiple spreadsheets 

of data and multiple subformulas. The disadvantage of spreadsheet software 

is the need to maintain the consistency of data and the potential for errors in 

duplicating values in multiple locations. You can control this to an extent if you 

use lookups to keep your spreadsheets as consistent as possible with a piece 

of data existing in only one location, but the potential for error, especially in 

collaborative efforts, is high. You can address this disadvantage with the use of 

database software, which is the focus of the next section of this text. Database 

software allows you to manage information via relationships so data is gathered 

by lookup of a value and by reference, minimizing the potential for unwanted 

duplication and reducing consistency errors. Spreadsheet software also possesses 

the ability to access external data from database connections, so you can 

use both tools to manage your data for consistency and perform the analysis 

you need.

CHAPTER KNOWLEDGE CHECK
The VALUE function will return a numeric equivalent to text even if the text on which it is operating is 
not a number.

 A. True

 B. False

The following function would be the most likely to require the use of ROUND to limit the digits 
following the decimal point:

 A. MIN

 B. LEFT

 C. AVERAGE

 D. SUM

1

2
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The AND function will accept any number of logical input arguments and return TRUE if any of the 
arguments are TRUE.

 A. True

 B. False

You can nest functions within each other to calculate a complex result.

 A. True

 B. False

The following is true of VLOOKUP:

 A. It searches a column for values that match the search criteria.

 B. It allows for exact matches or partial matches.

 C. It can return values only to the right of the search column.

 D. All of the above.

 E. None of the above.

Goal Seek can optimize values for only a single parameter.

 A. True

 B. False

You can name a range of cells and use the name to identify the range in a formula.

 A. True

 B. False

The Split function separates your view window into different sections so you can view different 
spreadsheets at the same time in a single window.

 A. True

 B. False

You can create subgroups of rows or columns that will be hidden or shown as a single element.

 A. True

 B. False

The Goal Seek function can optimize up to two parameters at the same time.

 A. True

 B. False

3
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CHAPTER REVIEW QUESTIONS
How are IF statements used to evaluate data? Give at least two examples of where this would be 
useful in evaluating data.

How could data validation be useful in calculating your course grades? What rules should be added 
to the values for grades?

Why are recalculations necessary? When would you switch between automatic and manual 
calculation?

What types of spreadsheets might require text functions? What type of business setting do you think 
would require this most often?

Explain the steps for applying a function in Excel (assuming you are not typing the function directly). 
What are some alternate ways of adding a function to your worksheet?

By now you should be very familiar with the common Microsoft Applications. Consider your daily 
activities, personal, academic, and professional. What documents will be most useful for increasing 
your productivity? How will these help you?

Choose a function for manipulating text in Excel. Describe the result of applying the function and 
give a correct example of the function. When would this be useful in practice?

Choose a function for performing numerical calculations in Excel. Describe the result of applying the 
function and give a correct example of the function. When would this be useful in practice?

Choose one of the basic logic comparators available in Excel. Describe the result of applying the 
function implementing this logic and give a correct example of the function. When would this be 
useful in practice?

Compare the VLOOKUP and HLOOKUP functions. What is the primary difference between these 
functions and how they work? When would each be useful in practice? What is the limitation on 
both of these functions?

1
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PRACTICE EXERCISES
Using the data from the MyFebruarySales file and the completed example you produced in the 
chapter for January, construct sheets in your business document for February Sales, February 
Supplies, and February Commissions. The sales figures should be derived from the 
MyFebruarySales document and you can assume a reorder of all of the supplies from January 
except the one-time items associated with the business startup; these are any items in the supply 
list that have 4 as the total number ordered. Perform all of the steps on the February data that you 
did for completing the tasks for January. You should also use formulas to determine whether sales 
are improving or declining for each of the customers. Analyze which products from the supply list 
are too costly to continue to use based on the sales amounts and whether the business can remain 
viable if the sales trends and supply costs continue. You can provide your analysis on a separate 
Outcome spreadsheet using text boxes with support from the numbers within the spreadsheet.

Use the features discussed in Chapters 14 and 15 to develop a workbook that details your grades 
for this semester. Use a separate worksheet for each course you are enrolled in. List all of the 
assignments, the total points possible, and the points awarded. Develop a line graph with this data 
that tracks your progress in each course. Use a single line graph with multiple lines representing 
each course.  

Now, using the spreadsheet you just created to monitor your grades, evaluate your performance 
using the functions available in Excel. Determine your highest, lowest, and average grade for each 
course. Then use Goal Seek to determine the grade you need on your final to receive your desired 
grade in the course. 

Identify the following Text Functions:

 A. Used to join the contents of two or more cells containing text into the 
same text result.

 B. Converts its argument to all lowercase text.

 C. Coverts its argument to all uppercase text

 D. Returns the specified number of leftmost characters of its first 
argument.  

 E. Returns the specified number of rightmost characters specified in the 
second argument.

 F. Evaluates the text in the cell entered as an argument into a numeric 
value.

1

2

3

4
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Identify the following Numeric Functions:

 A. Returns a single minimum value from the set of cells given as input 
arguments.

 B. Calculates the total value divided by the number of inputs given for the 
formula.

 C. Returns the number of entries in a list of cells.

 D. A value on which to operate and a whole number representing the 
number of digits to the right of the decimal point to include (requires 
two arguments).

 E. Returns the single maximum value from the set of cells given as input 
arguments. 

5

CHALLENGE EXERCISES
Using one of the worksheets from the sample files or one that you developed for this chapter, create 
a new Pivot Table. What does the Pivot Table you created show about the data? What options are 
available to manipulate the data or show different calculations? Give a brief summary of the purpose 
of Pivot Tables and at least two examples of their application in practice.

Explain the primary difference between groupings and subtotals in Excel. What is the benefit of 
being able to group columns and rows? Is it possible to group a cell into both a column group and a 
row group? What are the other options available for subtotals in Excel? Choose two of these options 
and describe when they would be useful in practice.

When importing text to Excel to be converted to columns, what would happen if a delimiter was not 
in the correct place in the text? What steps would have to be taken to correct the data after it has 
been imported into Excel? Give an example of when you may want to select multiple delimiters to 
expand the text data into columns.

Experiment with data and using Goal Seek in What-If Analysis to find a problem it cannot solve. 
What are the conditions that caused the Goal Seek to fail? Is this a solvable problem numerically? 
Are there other conditions in the problem setup that could be changed to find a solution?

Use the Side by Side view in Excel for two of the business documents on which you worked in this 
chapter. Toggle them to move in step with each other as you scroll. When would this be a useful 
feature in practice? What conditions would there be on the data to make this useful? When would 
the functionality to arrange windows be more suitable for working on multiple files at once? Give 
examples to support your answer.
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CHAPTER  

16
Introduction to Access and  
Database Software

IN THIS CHAPTER

This chapter covers database development and management using the Microsoft 

Access data management platform. You will learn basic database concepts and 

how to gather business requirements to develop a functional database. You will 

also learn how to navigate the Access interface and develop strong database 

management practices that promote security and data integrity. The real 

power of a relational database system comes with its ability to link tables using 

relationships, which is a great tool for querying and reporting based on related 

data within your database schema that will lead to the production of useful 

information. At the completion of this chapter, you will be able to: 

●	Create a table using database software

●	Develop and link related tables of data

●	Develop a simple query with the Query Wizard

●	Develop simple forms
Microsoft Office 

2013/365 and 
Beyond
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“What is the difference between Access and 

the Excel application?” This question is a 

common one because Excel also stores and 

organizes records.

Imagine you work at a local police 

department that has a serious problem with 

evidence management. In the department’s 

early years, there were fewer crimes and a 

small amount of items in the evidence room. 

The evidence room is the location where 

police agencies store items used in a crime 

for later use in prosecution. Evidence rooms 

might also store items that have been found 

and are awaiting recovery by their rightful 

owner. Matthew, the administrative officer, 

is quite handy at working with Microsoft 

applications and decides to use Excel to 

manage the inventory in the evidence room.

Matthew knows that Access is a superior 

application for this task but at the time did 

not have Access available. As the years go by, 

the evidence list log continues to grow, and 

Matthew begins to struggle to keep up with 

the log he maintains in the Excel file. Every 

time officers add new items, he must make 

changes to the file, which can be a tedious 

process. The other compounding problem 

is that much of the evidence must leave 

the evidence room temporarily at times to 

be sent to the crime lab or court and accu-

rate records of each of these transactions 

must be kept. Using the Excel spreadsheet 

requires a manual search using filtering 

to search through the records. This is why 

many refer to Excel as a flat file database 

system. The disadvantage to using Excel for 

a project such as managing inventory is that 

INTRODUCTION 
TO ACCESS

The Access database application is a 

Relational Database Management System 

(RDBMS) that is primarily designed to 

meet the data management needs of small 

to medium businesses. Access can store all 

types of data to include text, numbers, and 

pictures. You can even import Excel data 

that can then be queried to produce useful 

information. Access also has the ability to 

be used as a single desktop instance or be 

shared within an organization’s network. 

One of the nicest enhancements is the abil-

ity to upgrade a database to the industrial-

strength Microsoft SQL Server® platform. 

You can also use Access as the front end to 

an SQL Server engine, which means you 

can develop the user interface using Access 

and have SQL Server on the back end.

You might be wondering what exactly 

an RDBMS is. A relational database man-

agement system is a database management 

platform based on the relational theory 

formulated by E.F. Codd in the 1970s. E.F. 

Codd established the theoretical foundation 

of developing relationships between tables 

in a database using algebraic set theory. A 

database is simply a collection of data struc-

tures that are organized to serve the par-

ticular needs of an organization or person. 

The RDBMS can have more than one data-

base instance open at once. For example, 

you might have an inventory database and 

a customer contacts database that use the 

same RDBMS. One of the first questions 

a student might ask in an Access course is 

16.1
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a listing of all applications available for use. 

Find and click Microsoft Office 2013; all of 

the programs available appear as shown in 

Figure 16.1. 

Now simply click on Microsoft Access 

2013 to open the user interface, shown in 

Figure 16.2.

The Access interface opens to the File 

menu, which is also called the Backstage 

view and is designed as a place to handle 

all of your background processes. From the 

Backstage view, you can complete a series of 

tasks that include opening a database, creat-

ing a database, changing settings, publish-

ing your database to a SharePoint® server 

there are no relationships between data and 

no ability to query the data.

In Matthew’s case, on the most recent 

check the evidence inventory had grown to 

more than 10,000 items and he was begin-

ning to think that maybe he truly needed a 

database management system. A relational 

database management system would give 

Matthew a more user-friendly interface in 

which to enter and remove pieces of evi-

dence from the system and the ability to 

pull detailed reports on evidence availabil-

ity and inventory levels. It is also possible to 

query the dataset on specific criteria, such 

as a case number, and produce within sec-

onds the exact location of the item, 

important dates, names of indi-

viduals handling the evidence, and 

detailed item descriptions. 

WORKING WITH 
THE INTERFACE

The Access 2013 user interface 

is quite user friendly; even though 

it is packed with many options, 

you can easily master the applica-

tion with patience and practice. To 

start Access, you must first make 

sure you have the correct version 

of Microsoft Office Suite.

Note that Access is not avail-

able in the Office 2011 suite for the 

Macintosh operating system.

Starting Access is as easy as 

clicking the Start menu button 

and selecting All Programs. Once 

you have made this selection, you 

will notice a program menu with 

16.2

 FIGURE 16.1
Starting the 
Access application
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•	Create—Creates database objects in 
your database environment.

•	External Data—Imports data from other 
sources, such as an Excel file that has data 
you want to use in your database.

•	Database Tools—Provides tools to help 
migrate your Access database to SQL 
Server and to analyze your database.

Creating a Database
There are many details to implementing 

a good database design. Planning your new 

business database offers many benefits, but 

there are unfortunately many bad outcomes 

from bad design. One of the most important 

concepts to grasp is the gathering of busi-

ness rules. Business rules are the rules that 

govern an organization and are engrained 

in daily processes. All business rules must 

be documented to be implemented into the 

database design. It is important to develop 

16.2.1

or the Web, repairing your database, and 

even encrypting your database. You can cre-

ate a series of databases and they will all be 

listed in the Backstage view. You can open a 

database file and simply click File to return 

to the Backstage view at any time.

The Home ribbon, shown in Figure 16.3, 

is the easily recognizable toolbar used in all 

Office applications. This ribbon has differ-

ent options that you will become familiar 

with as you continue to work through the 

Access chapter of this text. 

There are several ribbon tabs, some of 

which are visible only at certain times. The 

four main ribbons you will see when you 

first open a database are the following:

•	Home—Provides similar functionality 
to what you might be used to seeing in 
other Office applications; used to check 
spelling and format text.

 FIGURE 16.2
Access interface 
on startup 
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appears where you can begin developing your 

first table. Notice at the center of the window 

in Figure 16.4 that there is a series of tem-

plates you can use to create a database. Many 

templates are available online, but be sure that 

any templates you download are coming from 

a trusted source. Recall from earlier chapters 

that accepting any file from an unknown 

source should be carefully deliberated.

Creating a 
Database Table

So you might be asking, what exactly is 

a table? A table is an object within a database 

used to store individual sets of related data. 

For example, you might start off with an 

employee table that stores employee records 

for the inventory database. Each table has 

fields to store related pieces of data, so for 

the employee table you might have fields 

16.2.2

the conceptual design before building any 

type of database. Before getting too much 

further into the design process, however, 

you need to learn how to create your first 

database and then you can move toward the 

development of a fully functional database 

design. If you have been following along, you 

probably already have Access open on your 

screen and you can see the Backstage view. 

If not, follow the procedures outlined at the 

beginning of the chapter and start Access. 

From the Backstage view, select New and 

then Blank database, as shown in Figure 16.4. 

You must then select a name for your new 

database; for this example, enter the name 

JPDEvidenceInvenDB. The final step is to 

click on the Create button on the lower-right 

side of the screen. Once the new database is 

created, Access creates your database file 

in the location you selected and a datasheet 

 FIGURE 16.3
Access ribbon
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being built. Before you can add any data into 

a field, you must specify the type of data the 

field will hold. There are a couple of ways 

to add or modify a data type while build-

ing your table. One way to do so is from the 

Datasheet view. You can see in Figure 16.5 

that the fourth field has a drop-down menu, 

called Data Type Parts.

As you build your table from the 

Datasheet view, you can use the Data Type 

Parts to correctly configure and name your 

fields. For more data type choices, select the 

More Fields icon in the Fields ribbon, and 

that describe the employee’s name, address, 

and phone number. 

If you still have your database open 

with the database you created, then you 

are at the Datasheet view with an empty 

table ready to be developed. If not, reopen 

the database, select the Create tab, and then 

select the Table button. You should know 

that developing a database table is a struc-

tured process. The first step is to build the 

fields you will use in your first table. Every 

database table field has what is known as a 

data type. There are some schools of thought 

that would start by simply creating a table, 

populating the table with data, and work-

ing backward by adding the data types later. 

That is not the process used here.

You will notice in the Datasheet view 

in Figure 16.5 that there are four fields: 

ID, F_NAME, L_NAME, and a field that is 

 FIGURE 16.4
Creating a new 
database

APPLICATION PARTS is a feature 
within Access that provides a complete set 
of common tables that can be customized 
to suit your needs. DATA TYPE PARTS 
are a feature designed to help you quickly 
develop tables and field data types.
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•	Tasks—Tracks projects in an 
organization.

•	Users—Tracks users for your data-
base. The tables and forms can be 
used to hold basic user information.

When you click on one of the Application 

Parts, you can add all objects and table struc-

tures associated with the chosen Application 

Part. What happens if the table fields do not 

quite match what you need? This is no prob-

lem at all, as you can modify these objects 

and tables to meet your needs. 

Working with 
Design View

Building tables using Data Type Parts 

and Application Parts might work for some 

projects, but true professionals develop their 

tables using Design view. You could proba-

bly round up enough parts from Application 

Parts to build the JPDEvidenceInvenDB 

database discussed earlier with some 

modification, but you can also develop the 

tables from scratch. The nice thing about 

16.2.3

choose from among the data type options in 

the drop-down menu, shown in Figure 16.6. 

Note that the Fields ribbon is active when 

you are editing a field within your table.

An alternative way to build database 

objects is to use Application Parts, as shown 

in Figure 16.7. You can simply close the table 

that opened up when you started the new 

database, select the Create ribbon, and then 

select Application Parts. Application Parts 

provides the following five common objects 

found in databases that you can implement 

to develop your own database:

•	Comments—Tracks comments on an 
issue along with dates. For example, 
you might be developing a database 
that tracks comments on papers sub-
mitted to a database by students.

•	Contacts—Tracks contact information 
for your customers.

•	Issues—Tracks issues in an organi-
zation. For example, you might be 
developing a database that tracks 
work orders at a help desk.

 FIGURE 16.5
Database instance 
in Datasheet view
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unique for every employee, as this identifier 

will be used to identify the employee not just 

in this table but throughout the entire data-

base. This will be the primary key for the 

employee table, and every table you develop 

should have one.

Primary Keys
A primary key is a unique identifier that 

is used to identify each table in your overall 

database schema design. Each of your tables 

will have a primary key that will help to 

make each record unique; this feature will 

16.2.4

Application Parts is that you have forms, 

reports, and tables already available.

With Design view, you have to develop 

all of the objects on your own, preferably by 

following a plan you created before begin-

ning the project. 

Notice in Figure 16.8 that there are 

three columns to enter a name, data type, 

and description for each field. Because you 

are building the table from scratch, you will 

need to develop all of the fields. As this is 

a table of employees, make the first field 

EMPLOYEE ID. This number should be 

 FIGURE 16.6
Extended data 
types
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social security numbers, is subject to privacy 

laws, and proper security measures must be 

taken.

Highlight the EMPLOYEE ID field 

and select the Primary Key button on 

the left side of the Design ribbon to make 

this field the primary key for the table. 

Notice in Figure 16.10 the icon to the left 

of the EMPLOYEE ID field; this indi-

cates the field is the primary key. After 

making this change, it is a good idea to 

save the table.

You can save your table in one of two 

ways. First, select the File menu, then 

select Save Object As; when the Save As 

dialog box appears, name your object, fill 

in the As box with Table, as this is a table, 

and click OK; this process is shown in 

Figure 16.11.

A quicker method to save a table is to 

right-click on the Table1 tab within the 

help prevent the duplication of records in 

your database. A primary key can be com-

posed of one field or a combination of mul-

tiple fields. Notice in Figure 16.9 that the 

first field in the database has been created 

and named EMPLOYEE ID. 

Note that the first field in every table 

will be the primary key in this example. 

Now that you have named the first field, 

you have two options for creating the 

unique identifier for the primary key: cre-

ate a unique ID for the employees that will 

be different each time a record is entered or 

have Access develop unique identifiers by 

selecting AutoNumber from the drop-down 

menu in the Data Type column. It is impor-

tant to keep in mind that there are other 

numbers that are unique and widely avail-

able, such as a driver’s license number or a 

social security number, although you should 

keep in mind that some information, such as 

 FIGURE 16.7
Application Parts 
accessed from the 
Create ribbon
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gives you the option to name the table prior 

to executing a save.

Design view and select Save, as shown in 

Figure 16.12. A dialog box will appear that 

 FIGURE 16.8
Design view in 
Access

 FIGURE 16.9
Creating a field in Design view
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•	Text—Lets you enter numbers, letters, 
and symbols up to 255 characters.

•	Memo—Similar to Text but lets you 
store much more unformatted text. 
This is a good data type for possibly 
long reports in a database.

More on Data Types
A data type lets Access know what type 

of data you will store in a field. Setting spe-

cific data types from within Design view 

allows you to adjust the field properties to 

set not only the type of data but also the 

number of characters you will allow in a 

given field. In a small database, the num-

ber of characters might not make a differ-

ence, but as the database grows, you want 

all of your transactions to run optimally. It 

is important to plan out your design so that 

performance is optimal. Access has several 

different data types available; the more 

commonly used ones are the following:

16.2.5

 FIGURE 16.10
Selecting the primary key

 FIGURE 16.11
Saving a table

 FIGURE 16.12
Saving a table 
from Design vew

Select the File 
menu, then Save 

Object As, and finally 
name your table.
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field such as a date of birth 

(DOB) field, as shown in 

Figure 16.16. You might 

a situation where you have a table that 

tracks comments and times; this would 

require a General Date format (shown in 

the Field Properties window at the bottom 

of Figure 16.14). It is extremely important 

for both performance and ease of operation 

that you make sure all fields are given the 

exact name you need as well as the appropri-

ate data type and character length to ensure 

you do not have any problems.

•	Number—Used for all sorts of 
numbers.

•	Currency—Similar to Number but 
used specifically for monetary values.

•	Date/Time—Used specifically for 
calendar dates.

•	Yes/No—These are similar to true and 
false values.

•	Hyperlinks—Used for fields that store 
URLs.

•	Attachment—Used to store a variety 
of files in the database.

•	AutoNumber—Generates automatic 
unique identifier.

•	Calculated—Generates values based 
on particular expressions the user 
supplies.

Some things you should remember 

about data types include the importance of 

choosing the correct data type when devel-

oping your database. If you must change a 

data type, you can do so from Design view. 

This is a risky step as sometimes problems 

can occur. If you have already populated 

your tables with data, making a change can 

sometimes result in data being lost during 

the conversion process. Thus, it is best to 

change a data type when the table is empty.

Once you have your new field and 

data type implemented, you must adjust 

the character length for your field. The 

default setting is 255 for the Text data 

type. When setting up the F_NAME field, 

you might want to reserve 255 characters 

so that you have enough space for longer 

names, as shown in Figure 16.13.

You can select a custom date and time 

format if you have to create a custom date 

 FIGURE 16.13
Adjusting data type 
character length

Once you add the 
data type, you 
can adjust your 
character length
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use the AutoNumber data type and make 

it the primary key field, you have already 

started the process of assuring data integ-

rity. Developing tables with primary keys 

and later establishing relationships will 

assure that every record in your database is 

unique. You will learn more about database 

relationships in the upcoming sections.

Validation in your database is important 

as well. Allowing all sorts of date and time 

formats in your fields gives your database a 

lack of consistency. Access makes it easy to 

implement field validation with the Input 

Mask Wizard, shown in Figure 16.16. In this 

case, the wizard is being applied to the field 

titled DOB. To store the date of birth of every 

active employee, you might select Short Date.

DATA INTEGRITY, 
VALIDATION, AND 
GOOD DESIGN 
PRACTICES

Now that you are beginning to under-

stand how to build tables using Design view, 

it is important that you understand that 

one of the benefits of developing a database 

is to assure data integrity. Data integrity is 

ensuring that the information in a database 

is correct and has not become corrupted; 

this is achieved in a variety of ways. The 

important point to remember to help assure 

your data is correct is to have a primary 

key with a unique number. If you develop 

an ID field in every table you create and 

16.3  FIGURE 16.14
Custom date 
formats

MSOffice-Beyond-CH16.indd   411 6/10/2014   11:44:59 AM



412 — Microso f t  Of f i ce  2013/365 and  Be yond

prevented if you want to make sure a user 

enters data into the field. 

In Figure 16.16, notice the Allow Zero 

Length value in the Field Properties win-

dow. To avoid empty values, simply select 

No for this value from the drop-down menu 

at the right side of the window. Selecting Yes 

to the Required field and selecting No to the 

Allow Zero Length field resolves the issue by 

requiring the user to enter a valid value into 

the field.

Indexing is another form of data integ-

rity used in the database to prevent data 

duplication and speed up transactions. 

Without an index, Access must search an 

entire table for required data in a query, 

Say you want to create a field to track 

the employee’s social security number and 

you want this field to be a required field. In 

Design view, simply highlight the SOCIAL 

SECURITY field, select the drop-down 

menu to the right of the Required option in 

the Field Properties window, and select Yes, 

as shown in Figure 16.16. You should under-

stand that Access has blank fields and empty 

text. A blank field or null value means there 

no information was entered. An empty field 

means a value was supplied, but it is an 

empty value. An example of an empty value 

would be pressing the spacebar a couple of 

times in the field; this is technically a value 

but an empty one. Both conditions can be 

 FIGURE 16.15
Input Mask Wizard
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of conceptualizing your initial design can-

not be emphasized enough. It will take time 

and practice for you to be able to develop a 

perfect database, but quality will come with 

testing and developing multiple databases 

over time. Keep the following in mind when 

designing a database:

•	Gather your business rules—Your 
business rules are all the standards 
and practices that drive your orga-
nization. For example, every sales 
transaction must be logged by the 
salesperson. This would be a process 
you might want to see as part of a 
database.

but with an index, you can quickly find the 

specific records you are looking for. Say you 

want to make the SOCIAL SECURITY field 

an indexed field. Notice there is a selection 

for Indexed in the Field Properties window 

of Figure 16.16. Select the drop-down menu 

to the right side of the window and select 

Yes. If you have already entered data into 

your table at the time you create an index 

and duplicate data exists, you will receive an 

error at the time of implementation. 

All of these basic skills require good 

database design planning. The importance 

 FIGURE 16.16
Selecting a 
required field

0.0
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you can quickly recover 

and resume database 

usage. To create a data-

base backup, select Save Database As. Keep 

in mind that Access will close the database 

and save all objects. Once all objects and the 

database are closed, a copy is created in the 

location you chose to store the file.

Compressing and 
Repairing the Database

The Compact & Repair Database feature 

available in Access helps you improve data-

base performance. At some point after you 

have created your database and are using it, 

you may notice that it is slowing down. 

To compress or repair a database, 

simply select the File menu, as shown in 

Figure 16.18. Select Info and then click the 

Compact & Repair Database button. In a 

new database with few records, the process 

to compact the database is rather quick. In a 

larger database, this will take more time; the 

benefits are well worth the wait, however, as 

the overall size of the database will decrease.

16.3.2

•	Normalize your database—
Normalizing a database is an 
advanced topic, but at this level you 
should focus on assuring you develop 
the data sets you will use in your 
database while avoiding the collection 
of duplicate data.

•	Avoid redundancy—Redundant infor-
mation that shows up in other tables. 
Be sure to break down your tables to 
ensure you are not acquiring redun-
dant data in your database.

•	Create a primary key—Every table 
must have a primary key, which 
provides the ability to connect your 
tables using relationships and offers a 
mode of data integrity.

Database Backups 
You have already learned how to manu-

ally save your objects as you complete your 

work either from the File menu or from the 

table tab by right-clicking on it and select-

ing Save. Saving records actually occurs 

automatically in Access. Anytime you are 

working with your files and entering or 

modifying records, the database engine 

saves all of your work.

Notice in Figure 16.17 that the File 

menu offers two save options. The Save 

Object As option is used to save objects with 

which you are working; you have already 

used this option. The Save Database As 

option is used to save a copy of the database. 

Make sure you save a copy of your database 

frequently so you do not lose your data. It 

makes sense to keep a copy of your database 

at an alternate safe location if you are using 

the data for an organization and loss of data 

might cause work stoppages or slowdowns. 

A backup copy of your database will ensure 

16.3.1
 FIGURE 16.17

Saving the 
database
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how to establish a relationship and deter-

mine which types of relationships to develop 

and how to develop them. An example of the 

database in which you will create these rela-

tionships is shown in Figure 16.19.

Notice that the JPDEvidenceInvenDB 

file that you created in the previous sections 

now has three tables. If you would like to 

follow along, you can use your own project 

from the last section or use the database file 

titled JPDEvidenceInvenDB.accdb 

available on the companion DVD. 

The Show Table dialog box 

appears automatically the first time you 

open the Relationships window and can be 

WORKING WITH 
RELATIONSHIPS IN 
MICROSOFT ACCESS

Recall that in the previous sections 

you developed single tables that had all of 

the elements needed to populate them with 

data. You created a table that contained 

a primary key, field names, and character 

lengths, along with required fields. You also 

learned that primary keys help develop rela-

tionships and that every primary key should 

have a unique identifier.

You will now begin to learn about the 

real power of an RDBMS. You will find out 

16.4  FIGURE 16.18
Compact & Repair 
Database option

 FIGURE 16.19
JPDEvidenceInven 
DB database 
tables

on the dvd
 

Notice there are three tables 
for the JPDEvidencelnven 
DB databases you have 

been developing.

Although the databases have 
complete tables, there are still 
no relationships established.

MSOffice-Beyond-CH16.indd   415 6/10/2014   11:44:59 AM



416 — Microso f t  Of f i ce  2013/365 and  Be yond

authorized to check out evidence. An autho-

rized person in the EMPLOYEES table 

could conduct many evidence transactions, 

but you could not have multiple employees 

involved in duplicate transactions concern-

ing the same evidence item in question. 

Creating a one-to-many relationship here 

assures that tight controls are kept on evi-

dence transactions. In legal matters, there is 

a term called “chain of custody.” A person 

could easily make a mistake while keeping 

track of a chain of custody log in which every 

transaction is maintained manually. Using 

the database and establishing the correct 

relationships decrease the chances of losing 

chain of custody. Establishing this relation-

ship will assure that only one person pro-

cesses a single evidence transaction at a time 

but allows many items to be processed dur-

ing the single transaction, 

as shown in Figure 16.20. 

used to establish relationships between your 

database tables.

There  are three tables for the data-

base named EMPLOYEE, EVIDENCE_ 

I N V E N T O RY,    a n d    E V I D E N C E _

TRANSACTIONS. You will develop relation-

ships between all three of these tables. There  

are three types of relationships that are available:

•	One-to-one

•	One-to-many 

•	Many-to-many

A one-to-one relationship is rarely used 

because all of the information in the rela-

tionship would be in one table. A unique 

circumstance where you have to divide a 

table with too many columns might be a cir-

cumstance in which you would use such a 

relationship. In any case, it is not considered 

good development practice to use this type 

of relationship. 

The one-to-many rela-

tionship is the most com-

mon relationship. This 

relationship allows a row to 

be related to many rows in 

another table. For the exam-

ple, you need to establish 

the relationships involved in 

the JPDEvidenceInvenDB 

file. You have three tables: 

EMPLOYEE, EVIDENCE_

TRANSACTIONS, and 

EVIDENCE_INVENTORY. 

EMPLOYEE could contain 

the information for an evi-

dence technician, a police 

officer, or another person 
One-to-many relationship

 FIGURE 16.20
One-to-many 
relationship
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relationship in Access, you must use what 

Microsoft calls a junction table. A junction 

table is a table made up of a combination 

of the primary keys of both of the tables 

involved in the relationship. Figure 16.21 

shows how the many-to-many relationship 

is established between the EVIDENCE_

INVENTORY and EMPLOYEE tables. 

This is because many employees can handle 

many inventory items and vice versa. For 

example, you might have to pull a report 

that details how many employees handled 

an evidence item in inventory. The same 

inventory item might have been handled 

by several different employees. You might 

also have several employees handle several 

The many-to-many relationship is 

the most complex relationship available 

in Access. New users sometimes struggle 

to develop these relationships, but this is 

important to understand because such a 

relationship must be developed so that the 

JDPEvidenceInvenDB database works as 

designed. 

A many-to-many relationship occurs 

when many rows are related between any two 

tables A and B so that neither provides a unique 

record in the other table when associated. In 

the JPDEvidenceInvenDB, you have already 

established the one-to-many relationship 

between the EMPLOYEE and EVIDENCE_

TRANSACTIONS tables. The issue to resolve, 

however, is the type of relationship that must 

exist between the EVIDENCE_INVENTORY 

and EMPLOYEE tables.

Recall that you started with three 

tables. In order to establish a many-to-many 

CHAIN OF CUSTODY is keeping tight 
control of who handles evidence collected 
at a crime scene each and every time it is 
handled without losing track of who had 
it last.

 FIGURE 16.21
Creating a 
many-to-many 
relationship

You can actually 
add as many fields 

as you need, 
including a data/
time field since 

every transaction 
will require one.

For a many-to-many 
relationship, you must 
actually create another 
table with primary keys 
from the two tables that 
make up the relationship.
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to establish a one-to-many relationship and 

a many-to-many relationship. Begin with 

the many-to-many relationship because you 

will need to create a new table as the junc-

tion point for this relationship. To create the 

fourth table that will link the EMPLOYEE 

and EVIDENCE_INVENTORY tables, 

open Design view and create a table named 

EVIDENCE_PROCESSING. Use the pri-

mary keys from the two tables combined; 

these will act as the primary key for the new 

junction table. You can also simply create a 

field titled ID and identify it as the primary 

key, as shown in Figure 16.22. 

You should develop two fields in the 

new table that have matching data types 

identical to the data types used in the pri-

mary key fields from the tables you are try-

ing to link. The data types should be set to 

Number for the EVIDENCE_CASE# field 

since AutoNumber is already set in the 

different inventory items. This complex 

situation affects both tables, which is why a 

many-to-many relationship is needed.

Using the diagram in Figure 16.21, 

you can see that the junction table is called 

EVIDENCE_PROCESSING. This table will 

act as a junction point where a one-to-many 

relationship exists and uses the primary key 

from each table. 

Defining Relationships
Now that you have learned about 

relationships and why they are used, you 

will learn how to build them in Access. To 

begin building your relationships for the 

JPDEvidenceInvenDB file, open the database 

file named JPDEvidenceInvenDB available 

on the companion DVD. This is the 

base database with the EMPLOYEE, 

EVIDENCE_INVENTORY, and 

EVIDENCE_TRANSACTIONS tables. As 

you learned in the previous section, you need 

16.4.1

 FIGURE 16.22
Junction 
table for 
many-to-many 
relationship

on the dvd
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The date/time stamp field has 

been inserted into the EVIDENCE_

PROCESSING table. The next step is 

to open the Relationships tool, which is 

located in the Database Tools ribbon, by 

pressing the Relationships button, shown 

in Figure 16.24. This tool will open a new 

window that will help you lay out all of the 

tables and visually assist you in establishing 

all of the required relationships discussed so 

far in this chapter.

Once you have selected the Relationships 

tool, the Show Table dialog box appears 

over your Relationships window work area. 

Here you are able to add the tables you 

want to link with relationships, as shown in 

Figure 16.25. You want to add all four tables 

in this case because you will be linking all 

of them to establish the one-to-many rela-

tionships and many-to-many relationships 

discussed in this chapter.

primary tables. The 

EMPLOYEE_ID 

field is manu-

ally generated, so 

you would just match this field to 

the one that already exists in the 

EMPLOYEE table. If you decide 

to create a combined primary key, 

make both of the fields a combined 

primary key. You convert these by 

holding down the Control key and 

clicking on the row selector for both 

fields. You can then leave the table 

as is or you can add as many fields as needed. 

In this case, this table will just be used as a 

junction table with no other fields. You can 

create a third field titled TRANSACTION 

DATE/TIME and select a data type of DATE/

TIME; this will produce a timestamp every 

time you submit a new record into the data-

base. It is important that you also apply appro-

priate settings to your field properties. The 

TRANSACTION DATE/TIME field should 

be a required field, as shown in Figure 16.23. 

This is actually a business rule because an 

evidence chain of custody log requires that 

dates and times be kept for every transac-

tion. Although the database can work with-

out the date/time settings for test purposes, 

you can adjust the field properties so that the 

database automatically produces a date/time 

stamp by taking the following steps:

1. Select the time format from the 
Format settings.

2. Enter NOW() as the Default 
Value.

3. Select Never from the Show 
Date Picker.

 FIGURE 16.23
Setting field 
properties for 
TRANSACTION 
DATE/TIME 

Select the data/time format 
you would like to use.

Typing Now() automatically 
provides a data/time stamp.

Select Never.

 FIGURE 16.24
Accessing the 
Relationships 
tool
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The first thing to do is to drag the primary 

key field from EVIDENCE_INVENTORY 

to the EVIDENCE_PROCESSING/

EVIDENCE_CASE# field. In essence, you 

are matching the same fields from both 

tables using a one-to-many relationship. 

When you do this, the Edit Relationships 

dialog box opens as seen in Figure 16.26. 

Check the Enforce Referential Integrity 

box, but do not check either of the cascading 

options because some of the relationships 

use AutoNumber data types and you cannot 

Once you have added the tables to your 

workspace, you can hold and drag the tables 

to arrange them in a way that will best depict 

the relationships you intend to build. You can 

also hold your pointer on the edge of the table 

windows to widen or enlarge them to show 

all of the fields that are within each table. 

Begin by establishing the many-to-many 

relationships between the EVIDENCE_

INVENTORY and EMPLOYEE tables 

using the junction table called EVIDENCE_

PROCESSING, as shown in Figure 16.26.

Remember that the many-to-many rela-

tionship will be developed by creating two 

one-to-many relationships between the pri-

mary keys in the EVIDENCE_INVENTORY 

and EMPLOYEE tables. You will notice the 

three tables have been arranged to make it 

easier for others to understand the relation-

ships that are being prepared.

 FIGURE 16.25
Show Table 
dialog box used 
to add tables

In the Edit Relationships dialog box, you can 
check the Cascade Update or Cascade Delete 
box to perform cascade updates or cascade 
deletes. If you were to use AutoNumber fields 
in the many-to-many relationship, you would 
not be able to use the Cascade Update setting 
because you cannot change AutoNumber fields. 
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you have taken these steps, you will notice 

you have one more relationship to establish 

since you are now finished with the many-

to-many relationships.

The final step is to establish the one-to-

many relationship using the EMPLOYEE_

ID and TRANSFERRED fields from 

the EMPLOYEE and EVIDENCE_

TRANSACTIONS tables, respectively, as 

shown in Figure 16.27. The TRANSFERRED 

field is related to EMPLOYEE_ID because 

this field tracks who made the transaction. 

update or modify AutoNumber fields. Do 

the same thing for the EMPLOYEE and 

EVIDENCE_PROCESSING tables. Once 

 FIGURE 16.26
Edit Relationships 
dialog box

REFERENTIAL INTEGRITY is designed 
to validate data in your database and to assure 
you do not delete or modify data in records that 
are established in the relationship. Selecting 
Cascade Updates means that all related records 
are updated when changes are made. Choosing 
Cascade Deletes means that all related records 
are deleted when changes are made. These two 
options help maintain referential integrity.

MSOffice-Beyond-CH16.indd   421 6/10/2014   11:45:00 AM



422 — Microso f t  Of f i ce  2013/365 and  Be yond

might be easy to discover this problem early 

on, but if a few years go by and there are 

several thousand transactions stored in the 

database, it would be really difficult to detect 

inconsistent data and thus your reports 

based on queries would ultimately be inac-

curate. Notice in Figure 16.28 that the 

EVIDENCE_TRANSACTIONS table has a 

field named TRANSFERRED. This field’s 

sole purpose is to keep track of employees 

who were named in a particular transaction.

You can use the Lookup Wizard, shown 

in Figure 16.29, to create a list from exist-

ing values in a table field. In this example, 

you would have a drop-down menu that 

allows you to pick an employee from a list 

of employees authorized to make transac-

tions. Select Lookup Wizard as the data type 

for the Transferred field to 

create a lookup field. The 

You will enforce referential integ-

rity, but you will not use any of the 

cascading functions due to the data 

types used. Once you have estab-

lished these relationships, the back 

end of your new evidence inventory 

database is ready to be populated 

with data that will be used for con-

ducting queries and reports.

There are a few points to 

remember about a feature called 

the Lookup Wizard. For example, 

say you were looking to query data 

with a particular officer’s name, but 

due to data entry errors you dis-

covered it had been spelled several 

different ways in the database. It 

 FIGURE 16.27
Setting a one-to-
many relationship 

 FIGURE 16.28
Selecting the 
Lookup Wizard 
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to Yes so that you can modify any list you 

develop for any of your tables. A lookup list 

helps the database maintain consistent data.

Notice the cutaway section of what a 

lookup list will look like in the Datasheet 

view. The small icon below the list appears 

every time you activate the list to search 

for a value. This icon allows you to change 

or add values to your list, but keep in mind 

that you must have the Allow Value List 

Edits option in the Lookup field properties 

set to Yes.

lookup field can be either 

a list you create or a list 

extracted from another 

table or query. Remember 

that choosing a field from another table 

automatically creates a relationship.

If you develop your own list, you do not 

have to worry about any additional relation-

ships between tables. You must make an 

adjustment to ensure you can add new values 

to your list. In Figure 16.30, you can see the 

Field Properties window with the Lookup tab 

properties visible. Set Allow Value List Edits 

 FIGURE 16.29
Creating a lookup 
field based on 
values you create 
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Using the database you have been 

working on, you can now conduct queries 

that will help you find specific items located 

in specified locations throughout your ware-

house; better yet, you can have a date/time 

stamp with a record of every transaction 

made related to evidence. You can certainly 

develop attractive forms that provide a 

beautiful user interface at this point, only to 

find that you can only display information 

contained in the tables. In order to manipu-

late and display data from more than one 

table, you have to develop queries.

DATA 
MANIPULATION 
USING QUERIES

The ability to conduct queries in an 

Access database provides a wonderful way 

to manipulate data to produce useful infor-

mation. Take the JPDEvidenceInvenDB 

database you have been working with in this 

chapter; imagine being the officer that runs 

the evidence room and has to use a manual 

sign-out log or an Excel spreadsheet to keep 

track of inventory and location throughout 

the facility. 

16.5

A sample of what 
the completed list 
looks like in the 
Datasheet view.

To create a lookup list 
for the STATE field, for 

example, select the 
second option where 
you enter your own 

values.

Click on the Lookup tab 
in the Field Properties 

window to make 
adjustments to your list. 
Make sure Allow Value 
List Edits is enabled.

If you have 
enabled 

Allow Value 
List Edits, an 
icon appears 
whenever you 

use the list 
and allows you 
to update the 
list with new 

values.
 FIGURE 16.30

Lookup Wizard and completed list snippet
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manipulation. To begin using the Query 

Wizard, which is shown in Figure 16.31, 

select the Create ribbon and click the Query 

Wizard button to begin building a very basic 

query. The wizard will guide you through a 

series of questions to arrive at a basic query. 

You can then use Query Design view to tune 

your end result.

Using Query Design 
to Develop Queries

The preferred way to begin building 

your queries is with the Query Design view 

rather than the wizard since you will be 

using this option anyway. Before running 

any queries, populate each of the tables in 

the JPDEvidenceInvenDB file with a few 

16.5.2

Basic Queries
The following three methods can be 

used to conduct queries in the Access data-

base management system:

•	Query Wizard—The easiest way to 
create a basic query, although it has 
some limitations.

•	Design view—Allows you to graphi-
cally develop queries and gives you 
more control over the data than when 
using the Query Wizard.

•	SQL view—Lets you create queries 
using the SQL language.

The basic query can be created using the 

Query Wizard, although it usually will need 

some tuning in Query Design view to arrive 

at the best outcome for successful data 

16.5.1  FIGURE 16.31
Query Wizard
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results, save your query by right-clicking 

on the Query1 tab and selecting a name for 

your new query; saving the query adds it to 

the left pane of your database window. At the 

bottom of the interface in Figure 16.33, you 

will notice that there are additional options 

to refine your query results, including sort-

ing in either an ascending or descending 

order. You can also hide one or more of the 

tables and add additional criteria.

Imagine you have 30 records in the 

database and you need to view just the 

records relating to transactions submitted 

by an employee with ID number 104. You 

might use the Expression Builder to request 

the records relating to 104, which would 

produce only the records from a specific 

employee.

By right-clicking on the criteria and 

selecting the Build option as shown in 

records so that you actually have a return on 

your queries. You do not need to populate the 

junction table EVIDENCE_PROCESSING 

with any data. Once you have entered a few 

records, remember to save all of the tables 

even though the database automatically 

does this for you. 

The next step is to start the Query 

Design view from the Create ribbon. Starting 

the Query Design view brings up the Show 

Table dialog box, which allows you to select 

the tables you want to produce data based 

on the fields you choose. Once you select the 

table that you need from the Show Table dia-

log box, you must select the fields that you 

want to appear in the results of the query. 

This process is shown in Figure 16.32.

Once you have selected your fields, click 

the Run button to execute the query and 

view the results. If you are satisfied with the 

The Show Table dialog box, which 
allows you to add the tables that will 
be used in your query, appears when 

you start the Query Design view.

The fields will appear in the field 
list, where you can add the criteria 

required for the query.

Click to add the fields you 
want to use.

 FIGURE 16.32
Query Design view
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in the criteria to produce just those records. 

The final step is to save your query by right-

clicking the Query1 tab, entering a name for 

your query, and then selecting Save.

Figure 16.34, you can customize the query 

to give you specific results. If you wanted 

to find all records written by an employee 

with ID 104, you could simply enter =104 

 FIGURE 16.33
Executing 
Completed Query 

Clicking the Run 
button executes 
the query and 
produces the 

results.

When you start a new 
query, the Design ribbon 

appears.

In Query Design view, 
you can right-click on the 
tab to save your query or 
select from a number of 

options.

Three fields in this case 
have been selected for the 

query.
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SQL View or by selecting SQL View from 

the Views panel of the Home ribbon.

Implementing Inner 
and Outer Joins

Conducting a query from a single table 

really is of little value to you or an organiza-

tion. Developing inner and outer joins gives 

you the power to harness the true ability of 

using a relational database system. An inner 

join is a join in which there are two linked 

tables (an existing relationship) that are used 

to join specific fields within the two tables to 

produce the desired results. If you do not 

have a relationship established, Access auto-

matically helps you develop this relationship. 

Figure 16.35 shows two linked 

tables composed of the EMPLOYEE and 

EVIDENCE_TRANSACTION tables. The 

figure also provides a snippet of the results 

that appear after you press the Run button 

on the ribbon. You should note that only the 

fields needed to produce the desired results 

are selected.

16.5.4

Working with SQL View
If you are wondering what is happening 

in the background of your query, then SQL 

view is the place to look. Structured Query 

Language (SQL) runs in the background 

of every relational database management 

system. Every professional database admin-

istrator knows this language and uses it to 

build databases and develop queries of all 

kinds. Because this is an introductory text, 

SQL language is not discussed in detail, but 

you should understand what it does. You 

can access the SQL View anytime by simply 

right-clicking on the Query tab and selecting 

16.5.3

 FIGURE 16.34
Accessing 
Expression Builder

If you want to link the unmatched records, 
you could actually do so using SQL, which is 
beyond the scope of an introductory text. You 
could use the EMPLOYEE parent table and 
create a larger child table that would be the 
EVIDENCE_INVENTORY table. This would 
take a small adjustment with your relation-
ships and the eradication of one table, but it 
could be done this way. Once you have learned 
more about SQL, you could come back and 
use the same schema modifying the UNION 
statement to link the transactions to the 
EVIDENCE_INVENTORY table.
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of the unmatching records in the database. 

Notice that there is an important filter added 

An outer join is one in which you have 

two directly unrelated tables. You learned 

previously that an inner 

join basically joins related 

tables. The inner join 

shows only records that 

are contained in both 

linked tables.

The outer join can be 

configured to show every-

thing you would pull from 

an inner join, along with 

any unlinked records. 

Outer joins can help you 

locate unmatched records. 

Figure 16.36 shows all 

Selecting Run from the 
ribbon produces the 
desired results in the 

Datasheet view.

An inner join uses two 
related tables.

 FIGURE 16.35
Inner join in Query 
Design view and 
results

 FIGURE 16.36
Outer join using Query Design 
view to show unmatched 
records
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LEARNING TO 
DEVELOP REPORTS

You have learned how to work with 

and develop tables, relationships, and que-

ries. Simply looking at your information in 

Datasheet view is not very feasible for shar-

ing. If you are planning on providing a copy 

of your data to the executive staff at your 

organization, you might want your data 

to look a little more presentable. You could 

print the data from your tables, but this 

does not look very professional. Developing a 

16.6to the criteria as “Is Null,” which forces the 

table to produce the transaction dates that 

are not linked.

There are also multiple joins that 

you can use when more than one table is 

involved. Remember the many-to-many 

relationships using a junction table. The 

database schema has been modified to show 

how you can conduct a multiple join. In 

Figure 16.37, the modified schema describes 

how you might conduct a multiple join when 

there is a many-to-many relationship. 

 FIGURE 16.37
Outer join using 
a many-to-many 
relationship
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you simply answer the initial questions the 

application runs you through and it creates 

a basic report with just the fields that you 

require. Once the report is developed, you 

can modify and adjust the overall look in 

Design view. 

Once your basic form is complete, you 

can see what the document will look like 

before printing to paper by selecting the File 

button, and selecting Print. A menu will 

appear that gives you the option to preview 

your form; select Print Preview to see your 

document, as shown in Figure 16.39. If you 

are satisfied, you can simply press the Print 

button on the far-left side of the ribbon. 

This is just an introduction to Access 

reports; there are a significant amount 

of features available that allow the user 

and Access database developer to modify 

simple report can be done easily using one of 

the wizards or the Layout view. If you are fol-

lowing along with the example, open 

the JPDEvidenceDBFORMS file. 

One of the easiest ways to create a report 

is from the Create tab within the Access rib-

bon. Simply select the Create tab and click 

the Report button. Figure 16.38 shows a 

very basic form that this action produces. 

Developing a report in this manner selects 

all the fields, and as you can see it does not 

provide an attractive report. Notice at the 

top of the figure you can see some options 

titled Report Layout Tools. These options let 

you change the layout to make it more aes-

thetically pleasing.

The Report Wizard is another easy way 

for beginners to create a simple report. The 

nice thing about the Report Wizard is that 

 FIGURE 16.38
Report Layout 
Tools

on the dvd
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view, you would have to work with three dif-

ferent tables, which can become confusing 

and cumbersome for inexperienced users.

Access forms also support controls such 

as drop-down menu selections, customized 

buttons, lists, and checkboxes. Say an orga-

nization requires the ability to print out an 

employee’s contact information and photo-

graph. You can easily customize a control 

to bring up a custom form with the employ-

ee’s data and photograph and quickly send 

the information to a printer. The form in 

Figure 16.40 was created using just one 

table; it displays text boxes, a checkbox, and 

record numbers and can be used to enter 

additional new records.

Creating a simple form is an easy pro-

cess that can be accomplished using either 

the Layout view or the Form Wizard. You 

can use a table or a query to generate the 

desired results. Follow these steps to create 

a simple form in Layout view:

1. Highlight the table or query you 
would like to use for your form from 
the navigation pane on the left side 
of the Access window and select the 
Create ribbon. 

reports, include tables and fields from other 

tables, and change the overall appearance of 

the database.

DEVELOPING A 
SIMPLE FORM

Once you have completed your data-

base, you will need to maintain, update, and 

occasionally modify data for a variety of rea-

sons. Imagine having to open up the data-

base backend each and every time to enter 

data into each individual datasheet. You 

can easily update and add records into one 

location using a custom form in an attrac-

tive user interface. Using forms also makes 

it easier for other users, such as employees 

or customers, to access the database in a 

format that is consistent with the organiza-

tion’s business rules.

A form has many advantages over work-

ing within the Datasheet view. Imagine having 

to update two or three tables in an inven-

tory database. You can develop a single form 

that easily allows entering data into all three 

tables with total transparency to the user. If 

you were entering the data from Datasheet 

16.7

 FIGURE 16.39
Viewing a report in 
Print Preview

MSOffice-Beyond-CH16.indd   432 6/10/2014   11:45:03 AM



Chapt er  16  — Introduct ion  t o  Acces s  and   Dat abase  So f tware  — 433

size within the form. Remember that 
you built tables and set properties 
that included data types and the num-
ber of characters allowed per field. 
When you build your forms using this 
method, your text boxes may appear 
too large. To correct this issue, you 
can adjust the width in Layout view 
by highlighting the text field you want 
to change and adjusting the width or 
height by grabbing the edge of the 
text box and pulling it in the needed 
direction, as shown in Figure 16.42.

5. Finally, you can adjust your field 
names on the form by double-clicking 
on them and changing the text to 
your desired title. You can also adjust 
colors by using the options available 
in the Format ribbon. Once you are 
satisfied with the overall look and feel 
of your form, save the form by select-
ing File and then Save. If you forget 
to do this, you can be assured that the 
application will ask you to save before 
closing.

2. In the Create ribbon, select Form. A 
new form will appear in Layout view, 
as shown in Figure 16.40. Notice that 
all of the fields in the table you select 
appear on the new form in the same 
order in which you selected them. 
Your fields might also appear large or 
small, depending on the field size you 
established when you developed the 
table.

3. From the Layout view, you can rear-
range your fields in any manner you 
desire. If you have too many fields 
showing, you can simply select the 
underlying table (MATERIALS in this 
case) from the Datasheet view tab as 
shown in Figure 16.41 and right-click 
on the unneeded column to choose the 
option to hide it. 

4. It is important to remember that 
there are two separate field size 
adjustments. You can modify your 
field size from the table’s properties 
or you can manually adjust your field 

 FIGURE 16.40
Example Form 
view

This simple form uses 
test boxes and a 

checkbox, and displays 
AutoNumbers. This form 

was created using a single 
table.
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 FIGURE 16.41
Using the MATERIALS table to develop a new form  FIGURE 16.42

Adjusting width and height of textboxes

Notice that you 
can see the form 
in Layout view and 
a cutout overlay 

of the MATERIALS 
tab, which gives 
you a view of the 

MATERIALS table in 
Datasheet view.

If your text fields are 
too small or large or 
there are too many 
fields showing, you 

can modify the fields 
or hide them by 

selecting the column, 
right-clicking, and 

choosing the desired 
option from the 
Datasheet view.
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CHAPTER SUMMARY
Database software provides powerful tools for data manipulation and 

management. It is important to realize that modern organizations excel when 

they add value by successfully converting data into useful information. A 

database management system provides data integrity and, when developed 

properly, eradicates the possibility of data duplication. A spreadsheet is 

considered a flat file database system because there is no ability to query data or 

form any type of relationship between the data sets, except through sorting and 

filtering. A modern relational database management system uses relationships 

that allow a user to query the data to produce useful reports on trends and other 

market factors that can help an organization flourish. 

This chapter was designed to give the new computer user a jump start 

on developing relationships, queries, and reports in Access. You have learned 

that you can complete each task related to queries and reports using different 

methods, depending on your level of training and how much time and effort you 

would like to contribute to a project. You should now be able to plan, design, and 

develop very basic database applications. Your next step to learn more might 

be to take an intermediate or advanced course on Access. Congratulations on 

completing this text! You should now have the skills you need to manage your 

productivity at home or at the office.

CHAPTER KNOWLEDGE CHECK
The Access database application is a Relational Database Management System (RDBMS) that is 
primarily designed to meet the data management needs of small to medium businesses.

 A. True

 B. False

1
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A database is simply a  of data structures that are organized to serve the 
particular needs of an organization or person.

 A. Collection

 B. Menu

 C. Algorithm

 D. Flat file system

An organization’s  are the rules that govern an organization and are engrained 
in daily processes.

 A. Theft problems

 B. Session rules

 C. Business rules

 D. None of the above

Every database table field must have what is known as a data type.

 A. True

 B. False

Indexing is another form of  used in the database to prevent data duplication 
and speed up transactions.

 A. Data cleansing

 B. Data scrubbing

 C. Data integrity

 D. None of the above

What are the three types of relationships used in database work?

 A. One-to-one, many-to-many, one-to-many

 B. One-to-one, many-to-one, one-to-three

 C. Many-to-one, one-to-one, three-to-one

 D. One-to-one, many-to-many, many-to-none

The  allows you to graphically develop queries and gives you more control over 
the data than when using the Query Wizard.

 A. Design View

 B. Simple view

 C. Query view

 D. None of the above

2

3

4

5

6

7
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 is designed to validate data in your database and to assure you do not delete 
or modify data in records that are established in the relationship. 

 A. Table relationship

 B. Data integrity

 C. Referential integrity

 D. None of the above

The Report Wizard is an easy way for beginners to create a simple report. 

 A. True

 B. False

Developing a simple report can be done easily using one of the wizards or the Database Backup view.

 A. True

 B. False

8

9

10

CHAPTER REVIEW QUESTIONS
What is the importance of a primary key?

How do you implement field validation in Access? 

What is a Database? What is its function within an organization?

What is the function of a data type?

Why might professionals prefer to develop their tables in Design view? 

How are relationships defined in Access?

How is referential integrity different from validation? What is the importance of each?

What are queries and where are they developed?

How can you present data to those who do not readily understand Access and datasheets? 

What is the purpose of manipulating data? 

1

2

3

4

5

6

7

8

9

10
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What is the function of a form? 

What should you take into account when you are sharing your Access database with others?

What are some necessary steps for the maintenance of a database?

What advantage does Access have over Excel?

How is filtering in Excel different than in Access?

11

12

13

14

15

PRACTICE EXERCISES
Think of a fictional business and formulate the data needs for the organization. The business should 
be small enough that you are able to manage it properly. (If it gets too big, you might struggle to 
complete the assignment.) Develop the data requirements and reporting requirements for the 
business. Write out the business concept on paper and prepare to discuss.

Using the database platform of your choice, develop one complete table that includes a primary key, 
data types, field names, and all validation requirements such as required fields and input masks. 
Use Design view to complete the assignment.

Using Access, develop three queries based on the tables in the JPDEvidenceInvenDB file that you 
feel would meet the needs of the organization. One of your queries should involve an outer join used 
to locate unmatched fields. Remember to populate your database with a few files to help you see 
the results of your database system.

1

2

3
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CHALLENGE EXERCISES
Open the Access database file that already has the relationships built using the Design view and 
develop basic reports to meet what you feel are the needs of the organization.

Conduct basic research on Microsoft Access. Find three to five local companies that use Access to 
manage their business. You may need to do some field research for this exercise. Discuss how 
these companies use Access to meet their needs. Interview different employees to uncover a user’s 
understanding of Access’ functionality. Write up a one-page report on your findings. 

Below are descriptions of query methods and relationships in Access. Correctly identify each of the 
following:

 A. The easiest way to create a basic query.

 B. Allows you to create queries using the SQL language.

 C. The most common type of relationship between tables.

 D. Allows you to graphically develop queries.

 E. The most complex relationship available in Access.

 F. Considered poor development practice to use this type of relationship.  

1

2

3
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APPENDIX  

A
Additional Productivity  
Software

IN THIS CHAPTER

ADOBE READER
While a number of common productivity tools have been covered in this text, there are a few 

additional resources that are helpful to office and personal productivity. Adobe Reader is a free appli-

cation available for both Windows and Macintosh that reads Portable Document Format (PDF) files; 

in fact, it was Adobe that invented the format. There are a number of other utilities that can perform 

this task, such as the native Preview application which comes preinstalled for a Macintosh computer. 

However, Adobe Reader has a number of useful tools that make it worthwhile to have installed even 

if you primarily use another application to read PDF documents.

You can download the latest version of Adobe Reader from www.adobe.com/downloads regardless 

of the operating system you have. Once you have the program installed, you can open it to see the 

different tools and utilities available. Of note are the Snapshot Tool and the Loupe Tool. You can see 

an example of the Adobe Reader interface for Windows in Figure A.1.

There are additional services and tasks that can be performed with the paid versions of Adobe 

Acrobat. The commercial version of Adobe Acrobat installs plug-ins for the Microsoft Office applica-

tions to create customized PDF files in addition to the standard PDF export that is included with the 

Office software. You can also use Adobe PDF as a print option for any application when you have the 

commercial Adobe Acrobat installed; this works similarly to printing to Microsoft Office OneNote 

which will be covered in the following section of this appendix. You can also subscribe to paid services 

at www.acrobat.com to create and share PDF files online. These online services are accessible from 

within Adobe Reader if you have an account. The account creation process for the Adobe Website 

(www.adobe.com) and Adobe Acrobat (www.acrobat.com) is free.

A.1

Microsoft Office 
2013/365 and 

Beyond
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the potential employer does not specify a 

document type for submission. PDF is com-

mon enough that you can send the docu-

ment with relative assurance that anyone 

can read it. You should make sure that you 

have some means of reading this document 

type as well, whether you use the official 

reader from Adobe or not.

PDF files can also be used as forms with 

predefined areas that are editable. Creating 

these forms requires the commercial version 

of the software, but you may encounter PDF 

forms for work or personal use. To complete 

a PDF form, simply click into the editable 

area and type as you normally would on the 

keyboard; the text will appear in a predeter-

mined font and size and it will appear only 

in the areas that are specified for comple-

tion. When you are done, you can use the 

Save As (or Save a Copy) function and select 

PDF as the file type. You cannot save certain 

modifications or enhancements without the 

commercial version of the software.

Portable Document 
Format (PDF)

The Portable Document Format was 

invented by Adobe Systems in 1993; it is an 

open standard (ISO32000) for use in captur-

ing rich media in an application-indepen-

dent, exchangeable file format. This allows 

it to be used on any operating system and 

version without altering its appearance. The 

standard now also incorporates support for 

live hyperlinks within the document, so it 

has become one of the preferred formats for 

distributing documents on the Web. Control 

over the final layout and format of the media 

in the production of a PDF has been one of 

the factors influencing its adoption.

If you are going to use the Internet to 

gather information or research, you are 

likely to encounter PDF files. They are also 

a good format for transmitting files to recipi-

ents with unknown software and operating 

systems, such as resume submission when 

A.1.1

 FIGURE A.1
Adobe Reader X 
for Windows
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by double-clicking the icon for the comment 

within the document. You can move the 

comment by clicking on the icon once and 

dragging it. You can select the Edit menu 

and choose Find to perform a standard 

keyword search on the document. You can 

also select the View menu then Read Out 

Loud and Activate Read Out Loud to have 

an automated reader speak the line of text 

on which you click. This requires the default 

selection tool to be active. To deactivate the 

service, select the View menu, choose Read 

Out Loud, and then choose Deactivate Read 

Out Loud.

Adobe Reader X has a few other tools 

that are of use. Under the Edit menu, you 

can select Copy File to Clipboard; this will 

copy the entire file contents to the sys-

tem clipboard. You can also select Take a 

Snapshot from the Edit menu; this allows 

you to click and drag across an area of the 

document that you want to copy to the 

system clipboard as an image. If you sim-

ply click in the document, any area that is 

visible will be copied to the clipboard as an 

image. You must select another tool to dis-

able the Snapshot tool once it is active.

You can add additional tools to the stan-

dard toolbar by choosing the View menu and 

then selecting Show/Hide and then Toolbar 

Items. The submenu here has several options 

for tools that you may find useful. The 

default tool that is active is the Select Tool; 

this is available under the Select & Zoom 

submenu. This tool allows you to select text 

and copy it to the system clipboard. Under 

the Rotate View submenu, you will find the 

Clockwise and Counterclockwise commands 

Adobe Reader Tools
In addition to linking to the services of 

www.acrobat.com, the current versions of 

Adobe Reader have a number of useful tools 

for viewing PDF documents. You can easily 

set your zoom percentage to display the doc-

ument at the size you want. Jumping from 

page to page is also an easy task using the 

standard toolbar at the top of the interface. 

The two versions available have some differ-

ences in functionality, so you should select 

the section that is applicable to you.

Adobe Reader X 
for Windows

The Windows version of Adobe Reader 

allows you to add highlights and comments 

to the document. The benefit of marking up 

a PDF file is that the markup does not affect 

the original document, so it can be added 

to and removed from the file easily without 

concern for formatting or damage. It should 

be noted that these marks are typically not 

suitable for printing, so they would just be 

for the sake of document review, personal 

notes, and collaboration. You can also save 

your document as unformatted text using 

the File menu and choosing Save As and 

then Text.

In Adobe Reader X for Windows, the 

Highlight tool for marking text is located 

in the standard toolbar across the top of the 

interface. The Comment tool is located there 

as well. If you want to make a comment, you 

can click where you want it within the docu-

ment and a smaller window will appear for 

you to add your text. You can close this win-

dow when you are finished and open it again 

A.1.2

A.1.2.1
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the professional version of Adobe Acrobat, 

you can create PDF forms that only allow 

another user to edit specified fields. These 

forms can be completed using Adobe Reader 

and you can sign any PDF with the tools 

available under the Sign menu on the right 

side of the main interface. This is also shown 

in Figure A.1.

Adobe Reader XI 
for Macintosh

The functionality and tools available 

for Adobe Reader on the Macintosh are 

very similar to those found on the Windows 

equivalent. You can see an example of the 

interface of Adobe Reader XI for Macintosh 

in Figure A.2. Like its counterpart in 

Windows, Adobe Reader XI allows you to add 

comments or highlights to 

the text. You can also take 

advantage of several of the 

unique tools that Adobe 

Reader has to offer. You 

can also use Adobe Reader 

to export the text of your 

document (without any 

formatting) by selecting 

the File menu and choos-

ing Save as Other… and 

then choosing Text…. You 

can also export your PDF 

contents to Word of Excel.

Under the View 

menu, you can select 

Read Out Loud and then 

choose Activate Read Out 

Loud to enable the auto-

mated reader to speak 

A.1.2.2

which can be used to rotate a page that is 

not oriented properly on your screen. Under 

the Select & Zoom submenu, the Hand Tool 

is useful for scrolling the document quickly 

on the visible window; clicking selects the 

document and moving the mouse reposi-

tions the document within the window. Also 

under the Select & Zoom submenu is the 

Loupe Tool; this tool creates a new window 

that enhances the magnification of a small 

selection of the document wherever the 

mouse is clicked, allowing you to magnify a 

portion of the text for closer examination. 

This is shown in Figure A.1. This is particu-

larly useful for examining images.

Another important feature of Adobe 

Reader X for Windows is the ability to 

complete forms and sign documents. With 

 FIGURE A.2
Adobe Reader XI 
for Macintosh

 FIGURE A.2
Adobe Reader XI 
for Macintosh
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Anatomy of Microsoft 
OneNote 2013

You can see an example of the interface 

for Microsoft OneNote 2013 in Figure A.3. 

This displays the Quick Access Toolbar, the 

ribbon interface, and the different levels 

of organization available in OneNote. You 

should notice that the Quick Access Toolbar 

contains an icon called Dock to Desktop. 

This allows you to switch between the two 

primary operating modes on OneNote. 

Dock to Desktop fixes OneNote to the side 

of your screen and allows you to take Linked 

Notes, which are described in Section A.2.3. 

The standard icon to maximize the applica-

tion on the screen is used to return to the 

standard mode of operation. You do not 

have a traditional Save icon in either the 

Quick Access Toolbar or in the File menu in 

OneNote because it will automatically save 

changes to your document.

The Home ribbon (also shown in 

Figure A.3) contains the formatting com-

mands and styles that can be applied to the 

text of your notes page. This ribbon also 

contains the available tags for notes; these 

are annotations to the content of your docu-

ment that identify different characteristics 

for the individual note such as Question, 

Contact, and Critical. You can see the 

expanded list of available tags in Figure A.3; 

these tags appear as small icons next to the 

text or as a highlight color over the text. You 

can use Find Tags to locate all of the tags 

in the current page of notes. The Home rib-

bon also contains the links to the function-

ality integration with Microsoft Outlook; 

you can email a page from your notebook, 

A.2.1the selected line of text. You must have the 

default Selection tool active for the cursor 

for this to work correctly. You can turn off 

the automated reader by selecting the View 

menu, Read Out Loud, and then Deactivate 

Read Out Loud.

The main menu across the top of the 

interface contains several tools of interest. 

The Sign tool allows you to digitally sign 

a document, which is becoming an accept-

able substitution for a physical signature. 

You must setup a signature and password in 

order to use this functionality. You can also 

print, share, and resize your document from 

this menu. The right side of the interface 

contains the Comment menu, which allows 

you to add markup to the document, includ-

ing highlights, comments, and stamps.

MICROSOFT 
ONENOTE FOR 
WINDOWS

Microsoft OneNote is a Windows exclu-

sive program that acts like a digital note-

book. It is part of the Office 2013 productivity 

suite. It can be used to manage personal and 

work files in separate notebooks. You can 

use it to take notes with ease and link notes 

to other documents. You can also use it as 

a printer to store any printed information 

you want to keep and you can store each 

file on its own page for easy organization. 

The drag-and-drop functionality and the 

ability to dock the program beside another 

Microsoft Office application make it a useful 

note-taking and organization application.

A.2
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functions to convert your ink markup to 

text or equations.

The Review ribbon contains the spelling 

and grammar checks as well as the research 

and translation options. The View ribbon, 

shown in Figure A.6, allows you to change 

the modality of operation from Dock to 

Desktop to Full Page View or Normal View. 

You can also customize the appearance of 

your notebook from this ribbon.

Adding and Organizing 
Media and Notes

Microsoft OneNote supports a variety of 

note-taking options. You can click anywhere 

on the page and start typing to create a new 

note. You can also add any form of media 

from images to video to audio; in fact, you can 

A.2.2

set an outlook task, or interface with your 

meetings.

The Insert ribbon shown in Figure A.4 

can be used to add additional media con-

tent to your notes page, such as images and 

external files. This is also where you can 

initiate the process to add an audio or video 

note to your page using the Record Audio 

and Record Video icons respectively. You can 

also add screen clippings and file printouts 

to your document from the Insert ribbon.

The Draw ribbon, shown in Figure A.5, 

contains the functionality for using your 

mouse as a pen on the document. This is 

particularly helpful with a tablet PC which 

uses a stylus. You can also use the automated 

Quick Access 
Toolbar

Notebook 
Selection

Visible 
Document Area

Ribbon 
Interface

Page Name

Help

Show or Hide 
Ribbons

Tags Menu

Page Selection

Tab Selection

 FIGURE A.3
Anatomy of 
Microsoft OneNote 
2013

 FIGURE A.4
Insert Ribbon in 
Microsoft OneNote 
2013
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active document in any other Microsoft 

Office product beside which OneNote is 

docked. These Linked Notes are stan-

dard text notes or snippets of content that 

include a link to the document on which you 

were working when the note was created. 

For instance, if you copy or cut content from 

a document in any other Microsoft Office 

product, you can paste it into OneNote to 

retain it and OneNote will automatically 

create a link to the original document. You 

can also click in the open docked notebook 

for OneNote and start typing a note; this 

will also activate a document link which will 

appear beside the content. If you want to 

access the source of the clipping or open the 

document to which the note applies, you can 

do so by double-clicking the icon represent-

ing the linked program.

If you copy content or notes from a 

Website, OneNote will automatically add 

the source to the end of the clipping. This 

allows you to better maintain any citations 

you need to add for an article or paper and 

it also allows you to revisit the source of the 

information later. You cannot copy images 

directly to OneNote from a Website source; 

if you try to drag an image into OneNote, 

you will only get a citation of the source. 

Images can be added to OneNote from other 

sources such as other Office documents or 

through the use of the Send to OneNote 

easily record audio and video notes if your 

computer is equipped with a microphone or 

Webcam. You can select the Draw ribbon 

to turn your mouse cursor into a pen tip or 

highlighter to write text into your notebook; 

you can even use automated text recogni-

tion inside OneNote to convert your written 

notes into typed text or equations. OneNote 

has a number of context-sensitive ribbons to 

support modification of the media elements 

within the document, including the Playback 

ribbon for Audio & Video from which you can 

review your recordings or media elements 

and record new audio and video notes.

You can have multiple individual note-

books within the OneNote file. Each of these 

notebooks is divided into sections located in 

the tab names across the top of the docu-

ment window for the open notebook. Each 

of the sections has associated pages located 

on the right side of the open document; 

you can add a new page by selecting the + 

icon in the page list. You can click and drag 

to rearrange the order of any of these ele-

ments, including the notebooks. This level 

of organization allows you to manage your 

notes effectively.

Linked Notes
OneNote can also be used to take what 

are called Linked Notes. These are context-

sensitive notes that include a link to the 

A.2.3

 FIGURE A.5
Draw Ribbon in 
Microsoft OneNote 
2013

 FIGURE A.6
View Ribbon in 
Microsoft OneNote 
2010
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print dialog. You can see an example of the 

process in Figure A.8.  

Once you have chosen OneNote as the 

destination, you will be prompted to select 

a location for your printout within your 

existing notebooks for OneNote. When you 

select a destination, it will create a new page 

in that section with the print results; it will 

initially be called Untitled Page and you can 

enter a title in the area noted by the dotted 

line. This will give a title to the page on the 

right navigation as well as display it in the 

title section.

Saving and Sharing 
Notebooks

You can save OneNote notebooks to 

your SkyDrive using your Windows Live 

ID, which serves as an online storage loca-

tion that is free to use. Details of construct-

ing a Windows Live ID (whether you use 

a Windows machine or a Macintosh) are 

found in Chapter 5. To share one of your 

OneNote notebooks, you can select the File 

menu and choose Share.  

You should make sure 

that you are placing the 

notebook in a location 

that is secure enough for 

the information contained 

within it. If you have any 

personal information in the 

notebook, you should be 

cautious of saving it to any 

network resource that can 

be accessed by others. The 

SkyDrive is at least pass-

word protected and allows 

A.2.5

2013 functionality which acts like a stan-

dard document printer.

To dock OneNote to the Desktop to 

allow you to take Linked Notes for your 

other applications, you can select the Dock 

to Desktop icon. This will move your applica-

tion to the right side of the screen and open 

Page View which hides most of the inter-

face while you work. Linked Notes will be 

active by default. You can turn the linking 

on and off using the icon menu that looks 

like a chain link. To return to the Normal 

View, you can use the standard maximize 

icon in the right side of the interface when it 

is shown, press the F11 key, or click Normal 

View in the View ribbon. You can see an 

example of the docking and Linked Notes in 

Figure A.7.

Printing to OneNote
When you install Microsoft OneNote 

on your machine, you will have the abil-

ity to use a special printer called Send to 

OneNote 2013 from any other program on 

your machine. This works like any other 

A.2.4

 FIGURE A.7
Docked View and 
Linked Notes in 
Microsoft OneNote 
2013

MSOffice-Beyond-CH17-Appendix-A.indd   448 6/10/2014   11:58:28 AM



Appendix  A — A ddi t ional  Product iv i ty   So f tware  — 449

SkyDrive account can access the file via 

the online link.

MICROSOFT 
WORD NOTEBOOK 
LAYOUT VIEW FOR 
MACINTOSH

While the Macintosh version of Microsoft 

Office does not have Microsoft OneNote 

included in the 2011 suite, Microsoft Word 

2011 comes with a special view called 

Notebook View which allows some of the 

functionality of OneNote on the Macintosh. 

This is a tool for taking notes and organizing 

them into pages 

and sections. The 

note-taking func-

tionality is not 

as extensive as 

OneNote, but it 

does allow for the 

addition of text 

notes, using the 

mouse as a pen 

on the document, 

and adding audio 

notes to your 

text.

Notebook Layout View
When you click on Notebook Layout 

View in Word 2011, you will be prompted 

to create a new document or convert your 

existing document. This is a special version 

of a Word document with its own unique 

properties and interface. The purpose of this 

interface is to allow you to manage notes 

and add quick audio notes. You can see the 

A.3

A.3.1

you to select the persons with whom you 

want to share the document. If you are 

not already connected to your Windows 

Live account, you must provide your cre-

dentials for either your SkyDrive or the 

network location.  

Once the upload is successful to 

the SkyDrive, you can also get a link to 

share the notebook via email. Only peo-

ple to whom you give permission on your 

 FIGURE A.8
Print Dialog for Send to 
OneNote 2013

 FIGURE A.9
Steps to Share a Notebook 
in OneNote 2013
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create an Outlook task from the Home rib-

bon or insert a table.  

The Appearance ribbon shown in 

Figure A.11 allows you to customize the 

design of your notebook. You can change the 

background pattern, style of the tabs, and 

change the spacing on the rule lines (or get 

rid of them). You can also rename the tabs 

of your notebook, change the tab colors, or 

remove them using this ribbon.

Adding and  
Organizing Media 
and Notes

You can enter notes in your document 

just as you would in any other Word docu-

ment. The page is divided into individual 

A.3.2

interface for the Notebook Layout View for 

Word 2011 in Figure A.10.

The Home ribbon contains the format-

ting commands for the notes. You can use 

the note levels to organize your document 

into an outline and rearrange elements 

within it. You can also change the list for-

matting and list styles. There is a Scribble 

Panel that allows you to use your mouse as 

a pen tool on the document to add written 

notes; this is most beneficial when using a 

tablet computer with a stylus interface. The 

Note Flags Panel can be used to add anno-

tations to your notes, such as High Priority 

or a colored checkbox that can be used to 

create tasks in your document. You can also 

Menu Bar

Quick Access 
Toolbar

Document Pane

Visible Document 
Area

Section Tabs

View Selection

Document File Name

Ribbon Interface

 FIGURE A.10
Anatomy of 
Notebook Layout 
View in Microsoft 
Word 2011
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wrapping that are available in standard 

word processing documents.

One additional feature of the Notebook 

Layout View is the ability to add audio notes 

to your document. These will appear as an 

audio icon in the margin of the page. The 

Audio Notes ribbon shown in Figure A.12 

allows you to record and playback the audio 

notes. Adding new notes will continue 

recording where the last note ended if you 

add them to the same line. You can also 

export these notes to the MP4 file format.

lines and you can skip to whatever line 

you want to use just by clicking inside of 

it. You will recognize the active line by the 

small dot in the margin. This is also where 

the annotations appear for any flags that 

you have added. You can add any media to 

your notes that is available from the Media 

Browser or any other source that works 

for other Word documents. These will all 

have the usual context-sensitive ribbons to 

handle the media as necessary. Images and 

other objects will have the settings for text 

 FIGURE A.11
Appearance ribbon 
in Microsoft Word 
2011 Notebook 
Layout View

 FIGURE A.12
Audio Notes 
ribbon in Microsoft 
Word 2011 
Notebook Layout 
View
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APPENDIX  

B
Alternate Productivity  
Software

IN THIS CHAPTER

APACHE OPENOFFICE SOFTWARE
There is a free alternative to Office that was developed as part of the open source software ini-

tiative. Apache OpenOffice has counterpart programs for most of the Office suite, including word 

processing software, presentation software, spreadsheet software, and database software. These 

alternatives will be introduced in the following sections; you will be given the instructions to com-

plete most of the tasks with OpenOffice wherever it is possible to do so. If you are using OpenOffice 

to complete the exercises in the book, you will still benefit greatly from reading the text outlining the 

tasks and operations given for the Office program. In most cases, the difference in functionality may 

be a simple placement issue. The OpenOffice equivalent to Word is OpenOffice Writer.

OpenOffice Writer
If you are using OpenOffice as an alternative productivity software suite, Writer is the program 

that is used for word processing. Once you have downloaded and installed OpenOffice, it will be avail-

able in the Start menu on a Windows machine (or within the apps listing in Windows 8) or from the 

Applications folder on a Macintosh. Unlike the new versions of Word, Writer uses the more traditional 

menu and toolbar interface. The approach taken in this text is to include the major content and the 

description of the project in the section detailing the OpenOffice product that is equivalent to the 

Microsoft Office product.

B.1

Microsoft Office 
2013/365 and 

Beyond

You can download the full version of Apache OpenOffice from www.openoffice.org. This 
site services all operating systems for which the software is available. 

B.1.1
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to access the help interface for OpenOffice if 

it is the currently active application.

There are a number of toolbars avail-

able that will provide shortcuts to common 

commands. By default, the Standard tool-

bar, Find toolbar, and Format toolbar are 

enabled. The Standard toolbar gives you 

access to file commands (like New, Open, 

Save, and Print), along with Cut, Copy, 

Paste, Undo, Redo, and Help. This toolbar 

also contains several commands that you 

will use for the projects like the Format 

Paintbrush, the Spelling and Grammar 

check, and the Navigator. 

The Find toolbar allows you to per-

form a keyword search and move through 

the results that are found. The Format 

toolbar is where you will find shortcuts for 

formatting commands like Bold, Italic, and 

Underline; this is also where you can change 

the text size and font selection. The bot-

tom of the interface beneath the document 

Anatomy of Writer

Go ahead and open a new document in 

Writer if you have not already done so. You 

should see the blank document interface 

shown in Figure B.1. There is a list of menus 

across the top of the interface, along with 

toolbars that provide a shortcut to some of 

the more common commands available in 

the menus. Open the File menu as a first 

stop. 

The File menu is shown in Figure B.2. 

As with most File menus for software 

applications, this is where you can access 

commands to manage your files, including 

New, Save, Save As, Open, and Print. You 

should note that unlike Office, you can open 

a new file from any of the applications in the 

OpenOffice suite by selecting the File menu 

and New. The Help menu gives you access 

to the OpenOffice help interface. On a 

Windows machine, you can press the F1 key 

B.1.1.1

Presentation 
filename Toolbars

Help
Editable document 

section

Document pane

Visible 
document area 
(Normal view) View selection

Zoom setting

Main 
menu

 FIGURE B.1
Anatomy of Writer
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Writer, select all of the text (using the Ctrl-A 

shortcut on Windows or the Command-A 

shortcut on Mac) and choose the Font Name 

drop-down menu; select Times New Roman 

if it is not already selected. Beside the Font 

Name drop-down menu, you will see the 

Font Size drop-down menu; use the drop-

down box to choose a common size or enter 

a numeric value in this box. Set your text 

size to 12. Beside this menu box, you will 

see the icons for Bold, Italic, and Underline; 

these commands can also be activated by the 

shortcut keys for each command that were 

described for Word. You can also select the 

Format menu and choose Character to set 

font effects in a single dialog box. For a cover 

letter, however, you should keep the plain 

formatting for your text.

To set the line spacing for your docu-

ment, select the Format menu and choose 

Paragraph. The Indents and Spacing tab 

should be active by default. This is where 

you will find the Line Spacing values. Select 

At Least for the Line Spacing selection from 

the menu and type 16pt as the value in the 

number entry box. If you click in another 

box, you will see that the 16pt value converts 

to 0.22” for the final spacing value. Click OK 

when you are finished.

To apply bullet points to the accom-

plishments you want to highlight in your 

cover letter, select the text you want to 

convert to bullet points and then click the 

Bullets On/Off icon on the Format toolbar. 

contains the current 

page number out of the 

total number of pages, 

the language in use, 

the page layout (which 

can be changed by 

selecting the icon you 

want to use), and the 

current Zoom setting 

(remember that 100% 

is the actual size of the 

document). 

The native file type 

for a word processing 

document in Writer is 

ODF Text Document 

(.odt). It is possible to 

save the word process-

ing document in the 

native Office format 

but only up to the Word 

format used in the 

1997 to 2003 editions of the software using 

the .doc extension. This document will still 

open in newer versions of Word without any 

difficulty. There is an icon in the Standard 

toolbar labeled Export Directly to PDF, 

which will allow you to save your document 

in the platform- and software-independent 

Portable Document Format (.pdf).

Completing the Cover Letter in 
Writer

You should first save your open blank 

document as MyCoverLetter. Enter the text 

you want to include as described in the exam-

ple project in Chapter 7. To change the font in 

B.1.1.2

 FIGURE B.2
File menu in Writer

You will also find the icon to highlight text in the 
Format toolbar; you can use the drop-down arrow 
beside the icon to select the highlight color. 
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the scan of your document is located in the 

Standard toolbar. 

The icon beside it is the AutoSpellcheck 

icon; this is a toggle that turns the auto-

matic corrections on or off. To change any 

of the AutoCorrect rules in the OpenOffice 

suite, choose the Tools menu and select 

AutoCorrect Options. This will open the 

AutoCorrect dialog box where you can 

remove existing rules or add new ones by 

completing the Replace and With fields and 

selecting the New button.

You can also use the Thesaurus by high-

lighting the word you want to replace, choos-

ing the Tools menu, selecting Language, 

and then choosing Thesaurus. To perform a 

search on a keyword from the Find toolbar, 

enter the keyword in the Find Text field, 

press Enter, and use the arrows to move 

through the results in your document. To 

perform a find and replace operation on the 

document, click the icon that looks like a 

pair of binoculars in the Standard toolbar; 

this will open the Find & Replace dialog 

box. From here you can set the keyword you 

want to find and the text with which you 

want to replace it; you can select the appro-

priate buttons to find the next instance, 

replace the current instance, or replace all 

instances in the current document.

This will open the context-sensitive Bullets 

and Numbering toolbar shown at the top of 

Figure B.3. 

To select the bullet style you want to 

use, click the Bullets and Numbering icon 

at the far right of the toolbar to open the 

Bullets and Numbering dialog box (also 

shown in Figure B.3). This toolbar is also 

used for numbered lists, and you can use the 

icons on the toolbar to switch between bul-

lets and numbers. From here, you can pro-

mote and demote items in the list to create 

a more complex outline; for the cover letter, 

you just want a single level of bullets.

When you have finished entering and 

formatting text for your document, you 

should use the automated spelling and 

grammar check within Writer to detect any 

errors that the system recognizes as com-

mon. Again, this is no substitute for having 

someone else check your document before 

you submit it to a potential employer. The 

Spelling & Grammar icon used to initiate 

 FIGURE B.3
Bullets and 
Numbering toolbar 
and dialog box in 
Writer

Pressing the Enter key inside a list adds a 
new item to the list at the same outline level. 
Pressing the Enter key a second time within 
the blank list item will move to the next layer 
up (to the left) in the outline; if there are no 
layers up, it will exit the list formatting and 
return to the standard text.
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using the keyword search; when you find 

the one you want to use, click the Use It icon 

to open an instance of that document locally. 

Save your file as MyResumeTemplate.

To add a header or footer to your docu-

ment, select Header or Footer from the Insert 

menu. Default is the only available choice 

from the pop-up menu on these selections. 

You can also insert these elements from the 

Navigator (which you can open from the 

Standard toolbar). If you choose a header a 

new document section will be added to your 

file at the top of the page; this allows you to 

enter your own text, and the size will expand 

to fit the contents. You can adjust properties 

for the header (or the footer) by selecting the 

Format menu and choosing Page. You can 

then select the tab for Header to get addi-

tional formatting options; the footer works 

the same way. Review your document just 

Completing the Resume  
in Writer

The next document you will create is a 

resume; you can review the instructions for 

creating a resume in Chapter 7. Writer does 

not come preloaded with a large amount of 

templates; however, there are a significant 

number of them available online. To cre-

ate a document from a template in Writer, 

select the File menu, select New, and choose 

Templates and Documents. This will open a 

dialog box that allows you to navigate to the 

template you wish to use. The Templates 

and Documents dialog box is shown in 

Figure B.4. If you cannot find a template you 

want, click on the Get more templates online 

link. This will open a new browser window 

(for whichever browser you have set as the 

default) and bring up the template browser 

online. You can search for a resume template 

B.1.1.3

 FIGURE B.4
Templates and 
Documents dialog 
box in Writer

MSOffice-Beyond-CH18-Appendix-B.indd   457 6/10/2014   12:13:35 PM



458 — Microso f t  Of f i ce  2013/365 and  Be yond

select the Tools menu and choose Mail 

Merge Wizard. In the first step, select the 

current document in order to proceed. You 

can also use an existing document or a docu-

ment template to complete the Mail Merge. 

Press the Next button to continue. Notice 

that you have the option to go back to previ-

ous steps before completing the final merge, 

so you can make changes if you wish.

as you did with the cover letter; you can use 

the same formatting tools and commands to 

add more emphasis to your resume than you 

had for the cover letter.

Mail Merge in OpenOffice  
Writer

There are eight steps in the Mail 

Merge Wizard for Writer. Begin with the 

MyMergeDocument file open, and then 

B.1.1.4

The Format Paintbrush icon in Writer works just like 
its counterpart in Word. To apply the formatting, 
highlight the text with the formatting you want to 
copy, click the icon, and highlight the text you want to 
be formatted. When the Format Paintbrush is active, 
your cursor will look like a paint bucket.

OPEN OFFICE These notes will be 
used throughout the text to highlight 
how to perform the same activities 

described in Office using the OpenOffice equivalent. 
In this case, you will learn how to apply and manage 
styles in Writer. The predefined styles are available 
to apply to selected text from the Formatting toolbar 
using the Apply Style menu. Select the icon to the left 
of the style selection called Styles and Formatting to 
open the Styles and Formatting pane, which lists the 
available styles; you can also open this pane by press-
ing the F11 key. 
The Styles and Formatting pane is used to apply 
styles; right-clicking on a style and selecting Modify 
allows you to make adjustments to it. You can also add 
new styles to the list by using the right-click menu 
and choosing New. The New Style from Selection 
option in the upper-right corner of the pane allows 
you to create a new style from the formatting of the 
selected text in the document. The heading options 
will be used to construct the table of contents for the 
document just as it is in Word.

OPEN OFFICE In Writer, 
you access the Navigator pane 
by pressing the F5 key on the 

keyboard or by selecting the View menu and 
choosing Navigator. The headings of the docu-
ment will display in the pane just as they do 
in Word. You can click on any of the headings 
to jump to that section of the text. To select 
the deepest level of heading to display, click on 
the Heading Levels Shown icon and choose a 
numeric value. Using the Promote Level and 
Demote Level icons increases or decreases the 
heading level of the selected item.

OPEN OFFICE In Writer, 
you can format the page size, 
orientation, and document 

margins by selecting the Format menu and 
choosing Page; this opens the Page Style dialog 
box from which you should select the Page tab 
to access and change these settings. To acti-
vate or deactivate the rulers, click the View 
menu and choose Ruler to toggle the setting.

OPEN OFFICE To change 
 the column formatting in 
Writer, select the text you 

want to adjust, choose the Format menu, and 
select Columns. In the dialog box that opens, 
select the number of columns you want to 
apply to the text selection. For the example, 
use two columns for the first page.
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In the second step, you will choose 

whether to create email messages or letters. 

For the example, choose Letter and click the 

Next button. Step 3 is to choose the recipient 

OPEN OFFICE To insert a table 
of contents in a Writer document, 
select the Insert menu, choose 

Indexes and Tables, and then choose Indexes and 
Tables on the submenu that appears. This will open 
the Insert Index/Table dialog box. On the Index/Table 
tab, select Table of Contents in the Type category. You 
can use the remaining tabs to establish the format for 
the inserted text. This process can also be used to add 
an alphabetical index of key terms or an illustration 
index based on the captions inserted in the document; 
you can rename these as needed in the Title field. To 
update the automated tables or indexes, select the 
Tools menu, choose Update, and then choose Update 
All.

OPEN OFFICE To insert an 
image in Writer, select the Insert 
menu, choose Picture, and then 

select From File. This opens a dialog box from 
which you can select your image file. You can 
add a caption to the image either by right-
clicking the image and choosing Caption or by 
selecting the image, choosing the Insert menu, 
and then choosing Caption. The dialog box 
that opens lets you adjust the caption proper-
ties, including the text. To adjust the text wrap 
properties, right-click on the image, choose 
Wrap, and select one of the options from the 
menu that appears.

OPEN OFFICE References and 
sources in OpenOffice are all main-
tained in a global Bibliography 

Database. You can access this from Writer by selecting 
the Tools menu and choosing Bibliography Database; 
this will open in a new window. To add a source, click 
on the Insert menu and choose Record. To add a cita-
tion to your text, place the cursor in your document 
where you want the citation and select the Insert 
menu, choose Indexes and Tables, and then choose 
Bibliography Entry.

OPEN OFFICE To add a footnote 
or endnote in Writer, select the loca-
tion in the text where you want the 

reference mark to be placed and then choose the Insert 
menu and select Footnote/Endnote. This will open a 
dialog box where you can choose whether you want 
the entry to be a footnote or endnote and whether you 
want to continue the automatic numbering or select 
a unique reference mark from the available symbols.

OPEN OFFICE In Writer, 
you can apply a watermark as 
a background graphic. To do 

this, select the Format menu and choose Page. 
In the Page Style dialog box that appears, 
select the Background tab and choose Graphic 
as the type (beside the As text); you can 
then browse for the image you want to use. 
Similarly, the Border tab in the Page Style dia-
log box can be used to add and customize the 
page border. To insert a page break in the text, 
choose the Insert menu, select Manual Break, 
and then choose Page Break in the dialog box 
that opens. You can use a page break on an 
empty page with a single line to create a blank 
page in your document.

OPEN OFFICE There is 
no automatic cover page cre-
ation in Writer. You can cre-

ate a cover page, but you have to format it 
yourself and arrange the text as you want it to 
display. You can still use images and borders 
to establish the same effect as the automatic 
cover pages in Word.
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Name in your recipient list, Address Line 1 

should match Address, City should match 

City, State should match State_or_Country, 

and ZIP should match Postal Code. You can 

match the values for the phone number and 

email address as practice, but these are not 

needed for the example. Click OK when you 

are finished. You cannot proceed to the next 

step if there are unmatched fields.

To complete the example, you will need 

to use the More button next to the entry for 

the address block format. In the dialog box 

that opens, add First Name, Address Line 

1, City, State, and ZIP. You should arrange 

First Name and Address Line 1 on their own 

lines and the last three fields in sequence on 

the third line. When you have finished this, 

click the OK button. You can now select Next 

to proceed to the next step in the wizard.

The next step is to add a salutation. You 

will once again need to match fields for this 

to work correctly. You can equate Last Name 

with the Name value in your 

recipient list since you custom-

ized your own address block. 

This would ordinarily be a bad 

idea, though, as ideally you would 

open the list in a spreadsheet 

program and separate the names 

into First Name and Last Name 

fields; once you master that type 

of software later in the text, this 

would be a worthwhile exercise. 

When you see the preview panel 

working correctly for the recipi-

ents, select the Next button.

The fifth step allows you 

to adjust the placement of the 

list and format the address block. Click the 

button to select an address list. In the dia-

log box that opens, click the Add button and 

select the MyMergeList document as your 

source. Click OK to return to the wizard. If 

you want to include an address block in your 

document (which you do for this example), 

keep the checkbox activated. The next step 

is to click the Match Fields button. This will 

open the dialog box shown in Figure B.5.

To complete the example Mail Merge, 

you should equate the following fields: First 

Name in the merge fields should match 

OPEN OFFICE To add a bibliogra-
phy to your document in Writer, select 
the Insert menu, choose Indexes and 

Tables, and then choose Indexes and Tables again. In 
the Insert Index/Table dialog box that opens, select 
the Index/Table tab and choose Bibliography for the 
Type. You can change the Title to Bibliography or 
Works Cited as needed. You can also set the bracket 
type for your citations from this dialog box.

 FIGURE B.5
Match Fields 
dialog box in 
Writer
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the merged doc-

ument to the 

printer, or send 

the merged 

document as 

an email. When 

you select the 

print option, 

you can also 

select the set 

of records you 

want to print 

(if you want 

to break up a 

print job into multiple smaller print jobs). 

If you choose email as your option, you will 

need a field that matches the email address 

of the recipients.

Advanced Features of Writer

To add a text box to your document in 

Writer, you need to activate the Drawing 

toolbar by selecting the View menu, choos-

ing Toolbars, and then selecting Drawing. 

From this toolbar, you can select the Text 

icon to draw a text box in the document; 

you will need to apply formatting so it 

displays the way you want it to. You can 

add drop caps to your text by selecting the 

Format menu and choosing Paragraph. 

In the dialog box that appears, select the 

Drop Caps tab and adjust the settings as 

desired.

To add symbols to your Writer docu-

ment, select the Insert menu and choose 

Special Character. Adding special characters 

B.1.1.5

address block and the salutation line. This 

placement is based on your margins, but the 

salutation line should be directly beneath 

the address block as shown in Figure B.6. 

The next step allows you to preview or edit 

the document. Ideally, you would already 

have done this, but you can select a record 

at random and choose Edit Document; this 

will allow you to make any corrections to 

the document to accommodate the merged 

fields. When you are ready to return to 

the wizard to complete the process, select 

Return to Mail Merge Wizard from the float-

ing toolbar that appears.

Step 7 allows you to select and personal-

ize individual documents within the recipi-

ent list. You can use the Find functionality to 

perform a search on your recipients in case 

you want to add individual customization to 

a particular letter. The final step in the pro-

cess, Step 8, allows you to save the original 

document, save the merged document, send 

 FIGURE B.6
Address block and 
salutation placement 
in Writer
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looks like a paragraph mark in the Standard 

toolbar called Nonprinting Characters. This 

icon acts as a toggle that will alternately 

display or hide the hidden characters in the 

document.

With the original document open in 

Writer, you perform a document compari-

son by selecting the Edit menu and choos-

ing Compare Document. This will open a 

dialog box in which you can select the alter-

nate version of the document. The result 

will be tracked changes of both versions of 

the document. In Writer, the changes must 

be accepted or rejected from the list inter-

face that appears when the comparison is 

complete. The formatting in the document 

indicating the changes is similar to what is 

available in Word.

OpenOffice Impress
OpenOffice has its own presentation 

software, called Impress. The interface for 

Impress looks quite different from the new 

versions of Microsoft Office PowerPoint. If 

you have experience with older versions of 

PowerPoint, Impress is vaguely reminiscent 

of the Office 97 version. 

When you open up Impress, the 

Presentation Wizard appears. For this 

B.1.2

or symbols in your document in Writer can 

also be accomplished by the use of specific 

fonts such as Wingdings or Webdings.

In OpenOffice, you can insert a formula 

into your document using a special program 

called OpenOffice Math. It is possible to cre-

ate a new Math document as well as use its 

functionality within the other applications 

in the OpenOffice suite. You can add a for-

mula within Writer by selecting the Insert 

menu, choosing Object, and then choosing 

Formula. A floating Elements toolbar lets 

you select the pieces to form your formula or 

equation, and a separate pane in the bottom 

of the interface will display the formula as 

you are editing it. Each selection in the top 

part of the Elements toolbar opens a subset 

at the bottom of the toolbar from which you 

can choose the formatting you want to use.

In Writer, you add a table to your doc-

ument by selecting the Insert menu and 

choosing Table. From here you can enter the 

number of rows and columns you want to 

include. You can also select the AutoFormat 

button to select from a predefined set 

of table layouts and color schemes simi-

lar to the formatting options available in 

Microsoft Word.

The Drawing toolbar in Writer is where 

you will find the various shapes that you 

can insert into your document. To activate 

the Drawing toolbar, select the View menu, 

choose Toolbars, and then select Drawing. 

The toolbar is arranged into categories of 

shapes, and you can select any one of them 

to open a submenu of shape options.

You can display the nonprinting char-

acters in Writer by selecting the icon that 

Microsoft has delivered a great pedigree of 
presentation software with PowerPoint. The 
OpenOffice version, Impress, will serve as an 
effective alternative, but it does not have the 
amount of features included in its commercial 
counterpart. PowerPoint lets you deliver a pol-
ished and professional presentation relatively 
quickly, but Impress will likely require you to 
work much harder at achieving the results you 
need.
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just like PowerPoint. The middle pane is a 

display of the current slide that you can edit. 

The right pane contains a lot of functional-

ity that PowerPoint places in the ribbon 

interface across the top. This is where you 

can access the Slide Master pages, change 

your layouts, and set your slide transitions.

To create a new Impress document, 

select the File menu in OpenOffice and 

select New and then Presentation. Whenever 

you create a new document in Impress, 

the Presentation Wizard is launched. You 

can skip the steps of the wizard by click-

ing the Create button at any time. This 

will bring you to the Normal view for your 

presentation.

Your first step should always be to save 

your file. You can do this by selecting the File 

menu and then choosing Save or Save As or by 

clicking the icon that looks like a floppy disk. 

This will open the Save As dialog box. The 

native format for 

Impress docu-

ments is ODF 

Presentat ion 

(.odp). You will 

n o t i c e   t h a t 

Impress can save 

documents in the 

Microsoft Office 

PowerPoint for-

mat, but only the 

97 version; you 

can still open 

these documents 

example, select Empty presentation. Now 

the wizard will prompt you to select a slide 

design from the list of options. A preview of 

what this will look like displays in the panel 

on the right side. Finally, the wizard will ask 

you to select a slide transition for each slide. 

You can alter each of these properties later, 

so just select No Effect for now. Now you are 

ready to click Create. The steps of this pro-

cess are shown in Figure B.7.

Anatomy of OpenOffice  
Impress

The interface for Impress can be seen in 

Figure B.8. The main menu across the top 

has most of the tools you will need. The tool-

bar beneath it has the common functions 

to create your presentation, and a context-

sensitive toolbar beneath that will change 

depending on the element you have selected. 

The left pane of the main window has the 

slide preview and organization information, 

B.1.2.1

 FIGURE B.7
Presentation Wizard 
steps in OpenOffice 
Impress
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choose Slide Show. From here, you can 

move your presentation forward using the 

spacebar or right arrow key and move your 

presentation backward using the left arrow 

key. You can exit Slide Show view by press-

ing the Escape key.

Completing the Projects 
in Impress

The placeholder text boxes in Impress 

work just like they do in PowerPoint. To 

create your first slide, enter your name in 

the slide title placeholder. You can change 

the font using the context-sensitive font 

toolbar that appears beneath the main tool-

bar whenever you click on a text box. Add a 

shadow and change your font to something 

impressive. Click on the remaining place-

holder and delete it by clicking on the Delete 

key since you will not be adding a subtitle. 

Use your mouse to move the text box 

containing your name lower in the page 

B.1.2.2

in PowerPoint 2010/2011 without any dif-

ficulty. Name your presentation MyImpress 

and save it using the default format of ODF 

Presentation.

You can insert new slides in Impress by 

right-clicking in the Slides pane and select-

ing New Slide. You can also insert new slides 

from the Slide icon in the main toolbar at the 

top. The drop-down list that appears allows 

you to select the specific layout you want for 

your new slide. Add a few slides to get started.

Now click on the Master Pages tab on 

the right pane. This is where you will select 

and apply the style you want for your pre-

sentation. Select one of the options that you 

like and click on your selection. This will 

update all of the slides in your presentation 

with the new layout and style of the Master 

Slide that you have selected.

Press the F5 key to enter Slide Show 

view or select the View menu and then 

 FIGURE B.8
Anatomy of 
Impress

Presentation 
filename

Main menu
Toolbars

Task pane

HelpPlaceholder 
textboxView 

selection

Design pane

Slides pane

Visible 
slides area

Zoom setting

Drawing and 
insert toolbar
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Gallery icon on the toolbar at the bottom of 

the interface and you will be prompted to 

select a style for your Fontwork. This will 

stamp a placeholder for the Fontwork in 

your slide, as shown in Figure B.10. You can 

then double-click the placeholder and enter 

the text you want. Type Rock in the text box 

and click outside of the text box. You can 

edit your text later by double-clicking inside 

the object. Clicking on the Fontwork object 

opens a pop-up toolbar specific to Fontwork 

settings and another toolbar that lets you 

alter the 3D properties of the Fontwork dis-

play. You can also set the gradient and line 

for the Fontwork object using the text for-

matting toolbar that appears.

Hold the Shift key and select both the 

Fontwork object and the star. Group these 

objects together by right-clicking on them 

while they are selected and choosing Group 

from the menu. You can now use the align-

ment tool from the bottom toolbar to align 

this group to the horizontal center of the slide. 

Add a new slide to your presentation 

by either right-clicking in the slide panel on 

the left side and choosing New Slide or by 

and use the 

Alignment icon 

on the toolbar at 

the bottom of the 

interface to align 

the text box to 

the horizontal center of the slide. You can see 

the Alignment icon menu in Figure B.9; this 

menu has only icons to represent the differ-

ent alignment options you have, but these 

are supplemented by tooltips that appear 

when you place your mouse over them.

The shapes for drawing are all located 

along the toolbar at the bottom of the inter-

face. Select a star shape you like and insert 

it into your slide; you can do this by select-

ing the shape menu for the star and picking 

a specific star you like. Unlike PowerPoint, 

you cannot just click to stamp shapes; 

instead, you must click and drag to set the 

size of your shape in the slide. 

Use the context-sensitive drawing tool-

bar to set your fill and line color. You can also 

add a shadow effect. Most of the fine-tuning 

for a drawing object in Impress is done via 

the Graphic Styles dialog box. You access this 

by right-clicking on the drawing object and 

selecting Edit Style. Here you can select and 

edit the properties for your shape’s line, fill, 

shadow, transparency, and text effects for any 

text entered into the shape. Add transpar-

ency to the shadow of the star (50% should 

be a good setting) and use a gradient fill to 

make it stand out against the background.

The Fontwork Gallery is the Impress 

equivalent of WordArt. Select the Fontwork 

 FIGURE B.9
Alignment menu in 
Impress

 FIGURE B.10
Fontwork example 
in Impress

Note that you cannot add placeholder text boxes to a 
group, just as in PowerPoint.
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away to access the original. You can select 

all of the rectangles and format them at the 

same time using the drawing object toolbar 

or you can format each of them separately.

You can type directly into these rect-

angles by simply clicking on the shape and 

typing with the keyboard. Add one adjec-

tive to each rectangle. You are now going to 

use the linking objects to add arrows from 

the rectangles to your picture. Selecting the 

Connector icon from the toolbar at the bot-

tom of the interface and choose which con-

nector you want. These connectors are not 

as flexible as those in PowerPoint, so you 

cannot use them to point inside of an object; 

they will either point to empty space around 

the slide or they will link directly to one 

of the connection points of an object. The 

adjectives you add should therefore describe 

the picture in general. Format the connec-

tors using the standard 

line properties. The result 

is shown in Figure B.11.

clicking the Slide icon in the main toolbar 

across the top. You are going to add your pic-

ture to this slide, so type a suitable caption 

for the image in the slide title placeholder. 

Make sure you format your text to match 

the formatting for your name on the title 

slide. Consistency is essential for a success-

ful presentation.

Select the From File icon on the toolbar 

at the bottom of the screen. This will open 

a dialog box for you to select an image that 

is stored on your computer. Once you have 

selected an image, it should display in the 

middle of your slide. The context-sensitive 

picture editing toolbar will also appear. You 

can apply a number of effects and filters to 

your image using this toolbar. Set your image 

to Grayscale using the drop-down menu. You 

can also crop your image using the Crop tool 

the same way you would in PowerPoint.

Insert three rectangles using the toolbar 

across the bottom and click and drag in the 

slide to define the shape. If you want to draw 

one rectangle and copy and 

paste it for the other two, 

the command is the same 

as in any other program 

on a PC: Ctrl-C copies the 

object and Ctrl-V pastes 

the copy. (The Macintosh 

equivalent of these simply 

substitutes the Command 

(or Apple) key for the 

Control (Ctrl) key.) In 

Impress, pasting an object 

places it directly over the 

original item, so you have 

to click and drag the copy 

 FIGURE B.11
Completed example 
with connectors in 
Impress
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can do so by clicking and dragging the slide 

you want to move in the left-hand Slides 

pane. You can also click on the Slide Sorter 

tab across the top of the design pane to see 

thumbnails of each of your slides that you 

can click and drag to move as needed. Just 

click the Normal tab when you are finished 

to get back to your design view.

The last slide of your presentation will 

be the contact slide. If you type a Website 

address or email address, Impress will auto-

matically convert it to a hyperlink. You can 

also add a hyperlink manually by selecting 

the Hyperlink icon in the main toolbar. This 

will open a dialog box allowing you to enter 

the destination to which you want to link 

and the text you want to display.

To change the color of your hyperlink 

from the default blue, you have to set it 

as a global setting for your document. To 

do this, click on the Tools menu and select 

Options to open the Options dialog box. 

Select OpenOffice, then Appearance. You 

should now see a list of default colors used 

in your document. Change the color of both 

the Unvisited Links and Visited Links to 

format your hyperlink color correctly. These 

are found in the Appearance category of the 

menu that appears as shown in Figure B.12.

Add clip art to enhance your contact 

slide at the end of your presentation. Now 

you just need to polish your presentation 

by adding transitions. You can add these 

by selecting the Slide Transition tab on the 

right-hand pane of the interface. Whenever 

you select an option in this menu, you are 

applying it only to the currently selected 

slide. You can also click the Apply to All 

Add your next slide. This is going to be 

either a slide listing your hobbies or one list-

ing things you like to eat. Format the title 

for this slide to match the rest of your pre-

sentation. The text entry process in Impress 

is similar to PowerPoint: You simply click 

inside the text box to type. The context-

sensitive outlining toolbar lets you change 

the indentation of items and move them up 

and down in the list by clicking on the arrow 

icons. You can also change the bullet style 

using the Bullets and Numbering dialog box.

Impress does not offer a clip art library, 

so if you want any extra images to spice up 

your presentation, you will have to pick from 

what is already on your computer or get 

them from Office.com. Impress accepts the 

clip art file type, so you can use the Office.

com copy feature and paste images directly 

in your slide. Visit Office.com and select a 

piece of clip art that works with your list.

Add a new slide with the title This Is 

Me Working; this is where you will add a 

screenshot to your presentation. There is no 

icon or shortcut for placing a screenshot into 

Impress. You will have to take the screen-

shot manually; this process is described 

in Chapter 10. You can either insert this 

screenshot as an image or paste it into your 

Impress document on the current slide. You 

can crop your screenshot just like any other 

image.

Remember that if your slides get out of 

order or you want to rearrange them, you 

Holding down the Control (Ctrl) key while 
cropping in Impress helps you get a more pre-
cise result.
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changed for later use by using the 

Rename Master icon in the tool-

bar. When you are finished editing 

this slide master instance, click 

Close Master View to return to the 

Normal view for your presenta-

tion. If you later wish to change 

the theme for your presentation, 

you can select Master Pages and 

choose a new layout and theme by 

clicking on one of the slide mas-

ters, but any changes you made to 

the previous slide master will not carry over 

to the new slide master.

In Impress, you can access the options 

for bullets and numbering by right-clicking 

on the text box and selecting Numbering/

Bullets. This opens a dialog box where you 

can edit the style for the current level that is 

selected. You can also use the Customize tab 

in the dialog box to alter each layer of the 

outline from a single screen, including the 

bullet size, character, and color.

When using Impress, you can edit the 

footer text on the slide master just as you 

would in PowerPoint. To activate any of the 

footer options for your slide show, select the 

View menu and then Headers and Footers. 

In this dialog box, you can enable or dis-

able all of the options that you can use in 

PowerPoint, including omitting the footer 

from the first/title slide.

OpenOffice Impress offers you the abil-

ity to print multiple types of handouts just 

as you can in PowerPoint. In Impress, this is 

done by selecting the appropriate setting for 

the Document entry on the Print dialog box; 

your options are Slides, Handouts, Notes, 

Slides button to make the transition part of 

every slide you have. Select Fade Smoothly 

from the choices and apply it to all of the 

slides. 

Now go back to the title slide to add a 

sound effect to your transition. Remember 

that sounds can be irritating to an audience, 

so they should be used with caution. Select 

applause from the Sound menu under Apply 

Transition in the Slide Transition panel. 

Save your work (as you should do often), and 

press F5 to play your presentation. Listen to 

that applause; you’ve earned it!

Advanced Features of 
Impress

If you are using OpenOffice Impress, 

you can edit the slide master by opening the 

Master Pages tab in the pane on the right 

side of the interface, right-clicking on the 

slide master you wish to use, and selecting 

Edit Master. This will open a small toolbar 

for use with the instance of the slide master 

that you have opened. You cannot change 

the theme of this slide master once you 

have selected it, and there are no one-click 

options for fonts and colors. You have the 

option to rename the master that you have 

B.1.2.3

 FIGURE B.12
Appearance dialog 
box in Impress
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externally before the media file is added to 

the presentation.

Impress has the same quick link func-

tionality for adding tables that is available 

in PowerPoint from any of the content place-

holder text boxes. You must select the num-

ber of rows and columns for the table and it 

will be inserted to fill the placeholder. You 

can also insert a table by using the Insert 

menu and selecting Table. The context-

sensitive Table toolbar will appear when-

ever you click on a table; you can use this to 

format the settings of your table just as you 

can with the ribbon interface in PowerPoint. 

The color and border settings will apply only 

to the selected cells. You can add or delete 

rows or columns from this toolbar as well as 

merge and split cells.

There is a single icon in the toolbar 

to add a chart to a slide in Impress. When 

you have added the default chart, you can 

edit the chart data by right-clicking the 

chart and selecting Chart Data Table; you 

can also select this icon from the context-

sensitive Chart toolbar. A small window will 

open with the chart data displayed. You can 

rename and format the values in the spread-

sheet here. When you close window, you can 

use the Chart toolbar to format the ele-

ments of the chart using the drop-down list 

of items and the available formatting com-

mands. Click the Chart Type icon to open a 

dialog box that allows you to select the type 

of chart you want to include.

Impress does not have an equivalent 

for SmartArt. You can create the effect of a 

SmartArt graphic, though, by using drawing 

objects with text. SmartArt is really just a 

or just an Outline containing the slide text. 

You can select how many slides you want 

to appear per page as well. The OpenOffice 

Impress tab contains additional options 

such as the inclusion of hidden slides and 

the ability to set the color output, and the 

Page Layout tab is where you can customize 

the slide order.

In Impress, the Handout tab works 

almost exactly like the Handout Master. You 

have four text boxes with predefined infor-

mation that you can edit, move, or delete. 

You can select a layout with different slide 

arrangements in the Task pane on the right-

hand side of the interface under the Layouts 

tab. To exit the handout master in Impress, 

select the Normal tab in the main design 

pane.

In Impress, the Notes tab across the 

main design pane serves as the Notes pane 

and the Notes Master found in PowerPoint. 

This tab allows you to apply text format-

ting and effects directly to the notes section 

of each individual slide. You can return to 

the design view of your slides by clicking the 

Normal tab.

Impress has the ability to import audio 

and video just like PowerPoint. To add a 

video or audio element to an Impress pre-

sentation, click the Insert menu and then 

choose the Movie and Sound icon. The tools 

for editing these files are more limited than 

they are in PowerPoint. You can preview 

the file, set it to repeat, and adjust the vol-

ume setting for the sound of the file using 

the Movie and Sound toolbar that appears, 

but any file trimming needs to be done 
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make a hidden slide visible again by select-

ing Show Slide in the Slide Show menu.

Impress offers more export options for 

images than PowerPoint. These include 

Encapsulated PostScript (EPS) and Scalable 

Vector Graphics (SVG) formats, which are 

used in the professional text editor TeX. 

Impress also has a native PDF writer that 

converts a document to the compressed and 

sharable Adobe Portable Document Format 

(PDF). These options are available in the 

Export dialog box, which is accessed by 

choosing the File menu and then selecting 

Export.

OpenOffice Calc
The OpenOffice alternative to Excel 

is a program called Calc. As with the 

other OpenOffice programs, Calc is part 

of the larger OpenOffice program and 

does not act as a standalone application. 

You can create a Calc document from the 

File menu of any of the OpenOffice pro-

grams in the suite. The native document 

type for Calc is ODF Spreadsheet (.ods). 

The interface of Calc should be familiar if 

you have been using the other OpenOffice 

programs. The primary difference is in 

the document pane where the informa-

tion is organized into rows and columns 

that intersect in cells. Each tab in the doc-

ument pane represents a single spread-

sheet in the overall workbook.

Anatomy of OpenOffice Calc

The interface for Calc, shown in 

Figure B.13, is similar to the interface 

for Writer. By default you will see the 

Formatting toolbar and the Find toolbar 

B.1.3

B.1.3.1

convenience tool to allow you to create these 

graphics quickly from text entry rather than 

designing them from a blank slide.

In Impress, the animations are all con-

trolled by the Custom Animation tab in the 

Tasks pane on the right side of the interface. 

To add an animation, just click on the object 

or group and select the Add button. This 

gives you a choice of effects similar to those 

offered in PowerPoint, including Entrance, 

Emphasis, Exit, and Motion effects. You can 

alter the settings for Start, Direction, and 

Speed once you have added the effect. All 

of the animations for the slide are added to 

the text area beneath the settings options. 

You can click any of these to change the set-

tings or use the arrow icons beneath the 

list to move them up or down in the order 

of display. The Play button will preview the 

animation, and the Slide Show button will 

display the current slide in Slide Show view 

to preview the animation as it will appear 

during a presentation.

You can edit the slide size in Impress by 

selecting the Format menu and then choos-

ing Page. On the Page tab of the Page Setup 

dialog box, you can set the height and width 

values for your slide, as well as the page 

orientation. 

Impress does not allow you to define a 

custom layout, but you can define a custom 

slide master with your own layout variation. 

You can apply the slide master by selecting 

the slide you want to change and clicking 

the slide master icon you want to use in the 

Master Pages tab of the Tasks pane.

The Hide Slide option in Impress is 

located in the Slide Show menu. You can 
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will also be highlighted. The bottom of the 

interface contains tabs for the individual 

spreadsheets used within the overall docu-

ment. You can use the arrows in the lower-

right corner to switch between spreadsheets 

or click directly on the tabs. You can add, 

delete, and rename the tabs using the right-

click menu. The bottom of the interface also 

contains an automatic sum calculation for 

the currently selected cells and a slide bar 

for the zoom settings.

Inside the actual spreadsheet, you can 

navigate through the various cells using 

the directional arrow keys on the keyboard. 

Holding the Shift key along with a direc-

tional arrow allows you to select multiple 

cells, whether you are using the directional 

arrows or the mouse. You can also highlight 

an entire column or row by clicking the 

header for it; this allows you to format or 

change data for an entire row or column at 

the same time.

beneath the menu selection area. Several 

of the menu options for Calc are different 

from the standard menus in the rest of the 

OpenOffice suite. Calc has a new set of for-

matting options for numeric data values in 

the Format menu and a new Data menu; 

these two menus will be used for the major-

ity of your cell and data-specific commands. 

The File menu contains the same standard 

functionality common to most applications. 

The new Formatting toolbar for Calc has 

several number formatting commands and 

an icon menu for adding cell borders.

The biggest departure from any of the 

other OpenOffice applications you have 

encountered so far is the arrangement of the 

main document pane. The document pane is 

divided into columns (denoted by letter) and 

rows (denoted by number). The intersection 

of these rows and columns is called a cell, 

and these cells are where you enter data. 

The highlighted cell is called the active cell, 

and the respective row and column header 

Main 
menu

Toolbars
Task pane

Help

Column labels

Formula bar
Active cell

Row labels

Document pane

Spreadsheet tabs
Zoom setting

 FIGURE B.13
Anatomy of Calc
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the cell beside the “Net Income” label; apply 

currency formatting and then remove the 

decimal places.

You can customize the format for cells 

that contain formulas or numbers by using 

the right-click menu on the selected cell or 

cells and choosing Format Cells (or by select-

ing the Format menu and choosing Cells). 

The Format Cells dialog box can be seen in 

Figure B.14. The different tabs in this dialog 

box allow you to set the background fill and 

borders of the cells.

Calc can predict simple series entries 

the same way as Excel, so you can use it to 

automatically fill in the months of the year; 

to do this, type January in 

cell C3 and February in cell 

D3, select both, and drag 

Creating a Budget in Calc

To use Calc to create the budget docu-

ment described in Chapter 13, begin by 

entering your row headings into column A. 

You will be using the same information and 

configuration described for Excel, but the 

tools are not necessarily located in the same 

place. When you have finished, though, 

there should be no difference between your 

resulting budget document and the one 

created using Excel. You should also add 

your desired savings percentage beneath 

the Savings category heading; the Percent 

(%) number format you need to apply to 

this cell is available as a shortcut icon on 

the Formatting toolbar. As you enter text 

or values into your cells, you can adjust the 

column width or row height by clicking and 

dragging the separator line between the col-

umn or row headings; you can also manu-

ally enter values for the column width or 

row height by selecting the Format menu 

and choosing either Column and Width or 

Row and Height, respectively.

You can use the Formatting toolbar in 

Calc to bold the category head-

ings and the “Income” label. 

Add your budget values in col-

umn B. Cell B3 should contain 

the text “Budget Amount.” 

Enter your values up to the 

Savings category, including 

your projected monthly income. 

Leave the cells next to the cat-

egory headings blank because 

you will use a formula to cal-

culate these sums. Select all of 

the values from cell B4 down to 

B.1.3.2
Calc has no direct equivalent to the Accounting 
format in Excel. However, you can apply your 
own unique formatting code to recreate the 
style using the Format Cells dialog box. The 
code for this style (which you can also see in 
Figure B.14) is as follows: _(“$”* #,##0_);_
(“$”* \(#,##0\);_(“$”* “-”??_);_(@_)

 FIGURE B.14
Format Cells 
dialog box in Calc

MSOffice-Beyond-CH18-Appendix-B.indd   472 6/10/2014   12:13:37 PM



Appendix  B  — Al t ernat e  Product iv i ty   So f tware  — 473

Finally, apply a double-line bottom border to 

the row of cells containing the values labeled 

“Net Income.” You can freeze cells in Calc 

to preserve your column and row headings 

as you scroll your spreadsheet. To do this, 

select the first cell you want to scroll (in the 

example, it is cell C4), select the Window 

menu, and choose Freeze.

Formula entry works the same way in 

Calc as it does in Excel, so you can follow 

the instructions for entering the correct 

formulas in Chapter 13. The instructions 

for filling cells from Chapter 13 also apply 

in Calc; to fill adjacent cells in Calc, select 

the cells you want to copy and the cells you 

want to fill, click the Edit menu, choose Fill, 

and then select the direction you want to 

fill. You can also fill cells using the grip point 

of the last selected cell to copy its contents 

(or the series if multiple cells are selected) 

in the direction you drag. The navigation 

shortcuts for Excel also function in Calc. As 

a final step for this portion of the project, 

rename your first spreadsheet tab (which 

the grip point on the lower-right corner of 

cell D3 to the right to complete the series all 

the way through December in row 3. You can 

also access the series prediction parameters 

by highlighting the cells you want to use to 

predict the series and the cells you want to 

fill, clicking on the Edit menu, selecting Fill, 

and then selecting Series. Finally, add the 

heading Annual Amount to cell O3.

Use the Format Cells dialog box to add 

a background color (such as the pale green 

used in the example) to the column head-

ings from cells B3 to O3; this option is acces-

sible on the Background tab of the dialog 

box. You can also use this tool to format the 

text alignment within the cells by selecting 

the desired alignment style for Horizontal 

and Vertical in the Alignment tab of the 

Format Cells dialog box. The Alignment tab 

also contains the Wrap text automatically 

checkbox for whether you want your text to 

wrap to multiple lines. Select all of the cells 

from cell B3 to the cell at the intersection of 

column O and the row containing the “Net 

Income” label for your budget. Activate 

the Format Cells dialog box and select the 

Borders tab; apply a thin border to the left, 

right, and center of the cells, as shown in 

Figure B.15. You can do this by clicking on 

the diagram at the left until the border you 

wish to apply is shown; you can adjust the 

parameters for the border you have selected 

(it should be surrounded by the dotted line) 

on the right. In this example, you will just 

apply a thin, single line.

Repeat these steps to apply a bottom 

border to the row of cells containing the val-

ues for the savings percentage each month. 

 FIGURE B.15
Borders tab of 
Format Cells 
dialog box in Calc
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as the series title in the chart, as shown in 

Figure B.17.

The next step is to modify the series 

information and the category labels for the 

chart. The categories here will be months, 

so use the Select Data Range icon to choose 

January through December in your spread-

sheet (this will hide the original dialog box 

and show only the cell reference and the 

spreadsheet data until you hit the Enter key 

to accept the values you have chosen). Next, 

you should choose Modify for the Y-Values 

for the Income series to remove the refer-

ence to the budget amount in column B 

from the actual data. Finally, select Add to 

add a second series to the chart; this time 

you will select the cell containing the label 

Total Expenses as the Name value and select 

the entries for January through December 

as the Y-Values for the series. The completed 

example is shown in Figure B.18.

As a final step in the wizard, add your 

chart title and axis labels. You should dis-

play the grid for the Y-axis. The completed 

example for the final step of the Chart 

Wizard is shown in Figure B.19. When you 

click Finish, the chart will be pasted into 

your current spreadsheet. 

Click on the chart elements 

(such as the legend or one of 

the axes) to access a special for-

matting toolbar just for chart 

elements; this will allow you to 

change the format of the font, the 

appearance of the lines, and the 

tick marks for the axes. Click on 

the chart, cut it from the current 

spreadsheet, and move it to the 

contains your budget data) by right-clicking 

the tab name, selecting Rename Sheet, and 

giving it the name Monthly Budget; you 

should also delete the third spreadsheet tab 

(which should be labeled Sheet 3) by right-

clicking on the tab.

Adding Charts in Calc
You should now rename your budget 

sheet as MyBudgetChart and add sample 

values for the expenses and income for the 

year. The Chart icon in the Standard tool-

bar will launch the Chart Wizard, which is 

the primary means of constructing a chart 

in OpenOffice. To create the chart of income 

versus total expenses, select the row con-

taining the Income values from column A 

to the column representing the value for 

December and then click the Chart icon. 

The first step in the wizard that appears is 

to select the type of chart you want to use. In 

this case, select Line and then choose Lines 

Only, as shown in Figure B.16.

The next step is to choose the data 

range. This should already be correct if 

you have highlighted the relevant cells for 

income. Check the box next to First col-

umn as label to use the label in column A 

B.1.3.3

 FIGURE B.16
Chart Wizard 
Step 1 in Calc
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Advanced 
Features of  
Calc

To merge cells in 

Calc, select the cells 

you want to combine, 

click the Format menu, 

and select Merge Cells. 

This acts as a toggle on 

the menu, so you can 

undo the merge for 

cells by selecting them 

and unchecking Merge 

Cells.

Adding rows or 

columns in Calc works 

just as it does in Excel. 

You click on a col-

umn or row label, use 

either the right-click 

menu or the Insert 

menu, and select the 

option to insert columns or rows as needed. 

New rows are added above the current loca-

tion, and new columns 

are added to the left. 

You can also select the 

column or row labels 

and use the right-click 

menu to delete the 

cells, or select the cells 

you want to remove, 

click the Edit menu, 

and choose Delete 

Cells; in either case, 

you will be prompted 

B.1.3.4

sheet currently labeled 

“Sheet 2.” Rename the 

spreadsheet Budget Chart 

to complete the project.

 FIGURE B.17
Chart Wizard Step 2 in Calc

 FIGURE B.18
Chart Wizard Step 3 
in Calc

 FIGURE B.19
Chart Wizard Step 4 
in Calc
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To apply an alphanumeric sort, select from 

the lower-right corner of your data to the 

upper-left corner and then click the Sort 

Ascending icon. The cell that is active will 

be used as the column to sort. Sorting will 

remove the existing filter, so you may need 

to apply the filter again.

You can convert a single column of text 

to multiple columns in Calc by selecting the 

column you want to convert and choosing 

the Data menu and Text to Columns. You 

will be prompted to enter the delimiters for 

separating the columns. For this example, 

select Space. A preview will display at the 

bottom of the dialog box.

In Calc, you can format a group of cells 

as a table using the AutoFormat command 

in the Format menu with the cells selected. 

Choose the option from the list to format 

the cells as you desire. You can manually 

adjust any formatting after this is applied. 

The selection Black 1 is the closest to the 

example formatting used in Excel.

In Calc, you can define your own cell 

styles by using the Styles and Formatting 

selection under the Format menu. There 

are a few predefined styles that will alter 

the text display and the cell size, but you 

will need to create your own for some of the 

more advanced options such as background 

and text color.

Calc allows for conditional formatting 

on a selection of cells with up to three con-

ditions. To apply conditional formatting, 

select the range of cells to which you want 

the formatting to apply, open the Format 

menu, and choose Conditional Formatting; 

a new dialog box will open where you can 

to resolve the deletion just as you would be 

in Excel. 

You can hide columns or rows in Calc by 

selecting the label of the columns or rows, 

activating the right-click menu, and choos-

ing Hide. To display the contents of hidden 

rows or columns again, select the neighbor-

ing rows or columns, right-click, and select 

Show.

Absolute referencing in Calc uses a 

period (.) instead of an exclamation point 

after the name of the spreadsheet for a ref-

erence across sheets in a document. The 

example then becomes =‘Supply List’.A4.

You can alter how data is pasted into 

your document in Calc by right-clicking 

where you want to paste the content and 

choosing the Paste Special option. The avail-

able choices will be displayed in a list from 

which you can select.

To remove duplicate values in Calc, you 

can apply a Standard Filter (from the Filter 

selection under the Data menu) and set the 

criteria to always be true (such as Column A 

= -not empty-), then click the More icon, and 

select the checkbox next to No duplication. 

This will remove the duplicate values from 

the display, but they will be hidden and not 

fully deleted. To fully remove the duplicates, 

copy the visible cells to a new worksheet or 

somewhere else in the existing worksheet 

and delete the original list.

To apply a filter in Calc, select the range 

to which you want the filter applied, open 

the Data menu, choose Filter, and then 

choose AutoFilter. This allows you to define 

the filter criteria in each column or select 

specific values from the drop-down menu. 
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to Calc will perform these syntax transla-

tions for you, so your formulas can be trans-

ported between the two applications.

Representations of true and false in 

Calc are actually formulas instead of literal 

values, so to get a true result, you would use 

TRUE(), and to get a false result, you would 

use FALSE().

Calc also allows you to change the auto-

matic calculation setting for your work-

sheets. To change whether the spreadsheet 

is calculated automatically or manually, 

check or uncheck the AutoCalculate item 

in the Tools menu under Cell Contents. You 

can force a manual recalculation by either 

pressing the F9 key or navigating back to 

the Tools menu under Cell Contents and 

choosing Recalculate.

In Calc, you can view the dependents 

and precedents of a formula using the 

Detective tool. You activate these items by 

selecting the Tools menu, choosing Detective, 

and then selecting either Trace Dependents 

or Trace Precedents. These traces can be 

removed using the same submenu by elect-

ing to remove the dependents, precedents, 

or both with Remove All Traces.

You can add data validation in Calc as 

well. To do this, select the data on which you 

want to enforce validation rules, select the 

Data menu, and choose Validity. This will 

open a dialog box where you can enter the 

data type and rules for your cell or cells. You 

can also use the Input Help tab to display 

the criteria or range to a user when the cell 

is selected and use the Error Alert tab to 

define the error message that appears if the 

established rules are violated.

define your criteria. For this example, you 

will need to use two of the conditions to 

match the account types. You will also need 

to create new styles for the cells to format 

them as red or green; when you are defining 

the new styles, select the font color from the 

Font Effects tab and the background color 

from the Background tab.

In Calc, you can change the color of a 

tab by selecting the Format menu, choosing 

Sheet, and then choosing Tab Color. Select 

whatever color you want and click OK to 

apply it.

You insert a comment in Calc by select-

ing the cell where you want the comment 

placed, clicking the Insert menu, and select-

ing Comment. The icon for a comment is 

a small red box in the upper-left corner of 

the cell; the comment will appear when you 

hover the mouse over the icon. To delete 

a comment, right-click inside the cell and 

choose Delete Comment from the menu.

The text box is located on the Drawing 

toolbar in OpenOffice. To add a text box in 

Calc, select the View menu, choose Toolbars, 

and then select Drawing; the Drawing tool-

bar should appear at the bottom of the inter-

face. From here, you can select the Text icon 

and draw the area you want for your text 

box.

There is only a slight variation in the 

syntax of formulas in Calc. Instead of an 

exclamation point being used to reference 

cells on other spreadsheets, a period (.) is 

used. Also, to separate the arguments (or 

parameters) of a function, you must use a 

semicolon (;) instead of the comma that is 

used in Excel. Copying contents from Excel 
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drag Revenue to Value Fields, which will 

convert it to a summation. You should then 

select the More button and change the des-

tination of the DataPilot so it does not over-

write your source information. The Options 

button allows you to change the automatic 

calculation formula. When you are fin-

ished, click OK to place the DataPilot in the 

spreadsheet. You can utilize the subcategory 

of Client Company, but this will make it 

much more difficult to look up values from 

the DataPilot for a later step. 

The GETPIVOTDATA function works 

in Calc as well; you just have to provide the 

starting value of the DataPilot where the 

pivot table reference begins. The rest of the 

formulas and references should be the same 

for both applications.

To activate Goal Seek in Calc, select 

the Tools menu and select Goal Seek. This 

works the same as it does in Excel.

You can actually use Calc to define a 

database in the Base program that is also 

part of the OpenOffice suite. 

In Calc, you can perform the Split oper-

ation on the current view of your document 

by selecting the Window menu and choos-

ing Split. This acts as a toggle, so you can 

uncheck it to return to the standard view.

GOOGLE DRIVE
Google Drive is another online appli-

cation that provides free file storage and 

online document creation and collaboration. 

Google Drive allows simultaneous access 

to a document by multiple authors (each 

author must be authorized to edit the docu-

ment by the original document creator). 

B.2

You can group rows and columns in 

Calc by highlighting the selection you want 

to group, clicking on the Data menu, choos-

ing Group and Outline, and then selecting 

Group. The groups in Calc function just as 

they do in Excel; you can use the plus or 

minus icons in the margin to show or hide 

grouped elements. You can also show or 

hide grouped elements from the Group and 

Outline submenu of the Data menu; this is 

also where the Ungroup command is located 

for removing existing groups.

In Calc, you can create subtotals by 

selecting the data you wish to use, opening 

the Data menu, and selecting Subtotals. This 

will open a dialog box where you can select 

up to three grouping levels by column head-

ing and function. You should select Account 

Number and SUM for the first group. You 

can also select the Options tab on the dialog 

box to identify any other modifications you 

wish to make.

The Calc equivalent of a pivot table is 

called a DataPilot. You can create a DataPilot 

by selecting the range of values you want to 

use (in this case, the sales information in 

the January Sales sheet) and choosing the 

Data menu, selecting DataPilot, and then 

selecting Start. This will open a dialog box 

in which you can select the source for your 

information; this should be the current 

selection. Next, a window will appear in 

which you can select the Page Fields (which 

allows a selection of results to use similar 

to a filter), Row Fields, Column Fields, and 

Data Fields. These are roughly equivalent 

to the field options for Excel. Drag the Sales 

Representative box to Row Fields and then 
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name in the main interface. You can also 

create new documents by selecting the 

document type from the Create New menu 

and choosing Document, Presentation, or 

Spreadsheet.

Document
The document application in Google 

Drive allows you to perform most of the 

tasks necessary for word processing. The 

interface, as shown in Figure B.21, is a menu 

and toolbar interface. The toolbar contains 

most of the font and paragraph formatting 

commands. You can use the File menu to 

save the document, rename it, and close it. 

You can also use the File menu to download 

the document (using the Download As com-

mand) as an ODT, Word, PDF, or HTML 

document to your local machine.

B.2.1

You can register for a Google Drive account 

the same way you can register for Gmail by 

Google. You do not have to have a Gmail 

address to access Google Drive; any Google 

account comes with this functionality, 

including a YouTube account. You can see 

the Google Drive interface in Figure B.20. 

You can access Google Drive by selecting 

Drive on the account interface once you are 

logged into your account.

From this interface, you have the abil-

ity to upload documents and folders to your 

Google Drive account, which stores them 

online. Google Drive provides 1 GB of stor-

age space for any files that are not created 

in the Google Drive format (or converted 

to that format). You can view your folders 

and the documents contained within your 

account on the main page. You can open 

an existing document by selecting the file 

 FIGURE B.20
Google Drive 
Interface

 FIGURE B.21
Document 
Example in Google 
Drive
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the + icon by the slide thumbnail view or by 

selecting the Slide menu and choosing New 

slide; this opens a dialog box in which you 

can select the slide layout you want to use. 

You can see an example of the interface for 

the presentation application in Figure B.22. 

You can add speaker notes at the bot-

tom of the interface in the Notes section. You 

can use the View menu to start the presen-

tation as a slide show by selecting Present. 

The Insert menu allows you to add vari-

ous media elements to your slide including 

images, videos, and tables. You can rename 

the file using the File menu (by selecting 

Rename). The download options (accessed 

by selecting the File menu and choosing 

Download As) for the presentation are PDF 

and PowerPoint.

Spreadsheet
The spreadsheet application in Google 

Drive allows you to manage data in cells just 

as you can with other spreadsheet software. 

You can utilize formulas and formatting on 

the cell entries as well as add new worksheets 

B.2.3

The Edit menu contains the commands 

for undoing and redoing actions, copying 

and pasting, selecting all content, and the 

find and replace functionality. The View 

menu can be used to toggle the display of 

the rulers and spelling suggestions. The 

Insert menu allows you to add hyperlinks, 

images, headers, footers, page breaks, equa-

tions, and symbols to your document. The 

Format menu has a shortcut to the available 

formatting effects. The Tools menu contains 

the command to calculate the word count 

and the Table menu is used to manage and 

insert tables into the document.

Presentation
The presentation application of Google 

Drive starts you with a single slide and asks 

you to select a theme for formatting. You 

can alter a theme to your presentation by 

selecting the Format menu and choosing the 

Slide menu and then Change theme; this 

will open a dialog box where you can select 

the presentation theme you want to use. You 

can add slides to your presentation by using 

B.2.2

 FIGURE B.22
Presentation 
Example in Google 
Drive
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linked to the toolbar. The File menu can be 

used to rename your document and save any 

changes. You can download your document 

using the File menu by selecting Download 

As; the formats supported include PDF, 

Excel, OpenOffice format, and HTML.

to the document. The interface, shown in 

Figure B.23, is a menu and toolbar inter-

face. The formula bar is located beneath the 

main toolbar. The Insert menu allows you to 

add rows and columns to your spreadsheet. 

The rest of the functionality available is 

 FIGURE B.23
Spreadsheet 
Example in Google 
Drive
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C
Odd Numbered Answers  
to Knowledge Check Exercises

IN THIS CHAPTER

Chapter 1
1. D

3. D

5. C

7. A

9. A

Chapter 2
1. A

3. B

5. A

7. A

9. A

Chapter 3
1. A

3. D

5. A

7. A

9. A

Chapter 4
1. A

3. E

5. B

7. C

9. D

Chapter 5
1. B

3. A

5. B

7. D

9. B

Chapter 6
1. B

3. B

5. A

7. B

9. A

Microsoft Office 
2013/365 and 

Beyond
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Chapter 12
1. B

3. B

5. C

7. B

9. A

Chapter 13
1. C

3. A

5. B

7. B

9. D

Chapter 14
1. A

3. B

5. A

7. C

9. D

Chapter 15
1. A

3. B

5. D

7. A

9. A

Chapter 16
1. A

3. C

5. C

7. F

9. A

Chapter 7
1. C

3. F

5. B

7. A

9. A

Chapter 8
1. B

3. E

5. E

7. D

9. A

Chapter 9
1. B

3. A

5. A

7. A

9. E

Chapter 10
1. D

3. D

5. A

7. D

9. B

Chapter 11
1. A

3. A

5. D

7. A

9. A
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D
On The Companion  
Disc

IN THIS CHAPTER

The textbook provides a DVD inside the back cover that includes resources 

for the student. This disc includes all of the PROJECT TEMPLATES and 

FILES needed to complete the chapter exercises within the text. You will also 

find VIDEO TUTORIALS, a repository of HIGH-RESOLUTION IMAGES 

from the chapters, and SAMPLES OF COMPLETED PROJECTS for 

comparison. 

Upon adoption, all of these files may be found online at www.authorcloudware.com. 

Microsoft Office 
2013/365 and 

Beyond

on the dvd
 

MSOffice-Beyond-CH20-Appendix-D.indd   485 6/21/2014   2:41:59 PM



MSOffice-Beyond-CH20-Appendix-D.indd   486 6/21/2014   2:41:59 PM



Index
IN THIS CHAPTER

A
abstract, 187

Access database application, 400

Access ribbon, 403

Access user interface, 401–402

database, creating, 402–403

database table, creating, 403–405

data type, 409–411

Design view, working with, 405–406

primary key, 406–409

Account Settings dialog box, 118

Acrobat ribbon, 223

active cell, 325

active Exposé view, 33

Add-Ins ribbon, 222

additional document elements, 186–187, 

201–202

adding a cover page, 187–188

adding a table of contents, 188–190

equations, 203–204

shapes, 205–206

symbols, 202

tables, 204–205

Adjust panel, 235

Adobe Reader, 441

Adobe Reader Tools, 443–445

Microsoft OneNote, 445–449

Microsoft Word Notebook Layout View for 

Macintosh, 449–451

PDF, 442

Adobe Reader Tools, 443–445

Adobe Reader X for Windows, 442, 443–444

Adobe Reader XI for Macintosh, 444–445

advanced cell reference, 354

advanced media, adding, 297

animations, 310–312

charts, 304–307

SmartArt, 307–310

sound and video, 297–301

tables, 301–304

Advanced Research Projects Agency  

(ARPA), 50

Index
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Aero Peek feature

Windows 7, 13

Windows 8, 14–15

alignment, 207

on graphic, effect of, 282

alignment commands, 236

analogous colors, 264, 265

AND function, 381

Animation pane, 311–312

animations, 310–312

Animations ribbon in PowerPoint  

2013, 310–312

Apache OpenOffice software

OpenOffice Calc, 470–478

OpenOffice Impress, 461–470

OpenOffice Writer, 453–461

Appearance and Personalization  

options, 28

Appearance dialog box, 468

Appearance ribbon, 450, 451

Apple menu, Mac OS X, 17

Apple Safari, 61–62

application, 2

Application Parts, 405

Applications folder, navigating  

Mac, 31

Area chart, 367

Arial, 172

ARPANET, 50–51

arrow settings, 238

aspect ratio, 236

asynchronous communication, 74

Audio Notes ribbon, 451

Audio Tools ribbons, 298

AutoCorrect dialog box, 456

AutoCorrect options,  

Microsoft Word 2013, 156

AutoFormat button, 462

AutoFormat command, 476

AVERAGE, 376

B
Backstage view in Office 2013, 218

Bar chart, 366, 367

basic formulas, adding, 337–340

bibliography, creating, 182–183

binary system, 10

Bing search engine, 124

BIOS, 7–8

blank pages, 187

blended logo, 271

body of email, 75

booting process, 8

borders, 187

Border tab, Format Cells dialog box, 336

brightness, 235

Bring Forward icon, 207

browsing, 64

Build option, 426–427

bullets, 155

Bullets and Numbering dialog box, 456, 

467

business application, 374–375

common functions, 375

business rules, 402

C
cable high-speed Internet, 55–56

Calculate Workbook command, 331

calculation option, functions, 383–385

calendars in Microsoft Outlook, 122–124

captions, adding, 184–186

Category (x) axis labels, 345

cell reference, 339

advanced, 354

cells, 324

formatting, 335–336
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grouping, 385–386

merging and splitting, 352

central processing unit (CPU), 3

functions of, 10

chain of custody, 416

chart data, 342–344

Chart Layout ribbon,  

PowerPoint 2011, 306

charts, 304–307, 365

adding, 342

chart data, 342–344

exploring, 343

formatting charts, 344–345

Area, 367

Bar, 366, 367

column, 365, 366

line, 365–366

Pie, 366, 367

Scatter, 367–368

Charts ribbon

Microsoft Excel 2011, 329

PowerPoint 2011, 306

Chart toolbar, 469

Chart Wizard, 474, 475

citations, 179

managing, 179–181

creating bibliography, 182–183

footnotes and endnotes, 181–182

Citation Source Manager, 180–181

citations window, 180

client-based software program, 3

clip art

handling, 246–249

Office 2011, 245–246

Office 2013, 244–245

Office.com, 246

using, 248

Clip Art Browser, 245

clipboard options, 153–154

Clockwise command, 443

Close Master View, 468

cloud computing, 102

creating Microsoft account, 102–103

Google Drive, 110

iCloud, 110

security risk, 102

cognitive guidance, 274

color saturation, 235

color tone, 235

color wheel, complementary and 

analogous colors, 264, 265

Colossus, 4

column chart, 365, 366

columns, 324, 340

adding and deleting, 352–353

formatting, 184

hiding, 353–354

Columns dialog box, 184

Command Prompt window, 53

comma-separated values (CSV) file, 391

comments, 363–364

in Word 2013, 210–211

Comments object, 405

Comment tool, 443

common functions, 375–376

Compact & Repair Database feature, 414

Compare Documents dialog box in Word 

2013, 208

complementary color, 264, 265

completed query, executing, 427

Compress Picture, 235

Compress Pictures dialog box, 317

computer hardware, 3–4

identification, 10

computer monitor screen, 9

computers
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Create Graphic panel, 309

Create PivotTable dialog box, 387

Create ribbon, 402, 433

creating folders, 35, 36, 38, 39

cropping, 235, 236

CSV file. See comma-separated values file

Ctrl, 341

Ctrl-A or Command-A. See Select All 

Content

Ctrl-C or Command-C. See Copy 

command

Ctrl-End, 342

Ctrl-F. See Find command

Ctrl-H. See Replace command

Ctrl-Home, 342

Ctrl-N or Command-N. See New 

Document

Ctrl-O or Command-O. See Open 

Document

Ctrl-Page Down (PGDN), 342

Ctrl-Page Up (PGUP), 342

Ctrl-P or Command-P. See Print 

Document

Ctrl-Q or Command-Q. See Quit

Ctrl-Shift, 342

Ctrl-S or Command-S. See Save 

Document

Ctrl-V or Command-V. See Paste 

command

Ctrl-X or Command-X. See Cut command

Ctrl-Y or Command-Y. See Redo Last 

Action

Ctrl-Z or Command-Z. See Undo Last 

Action

Custom Carts, 363

custom color scheme, 264

custom date formats, 411

Custom Filter option, 356

definition of, 2

needs, 5–7

shutdown procedures, 18–20

working of, 7–8

data storage, 11–12

input hardware device, 8–9

output hardware device, 9–10

processing hardware devices, 

10–11

working with files, 39–40

TextEdit for Macintosh, 42–43

WordPad on Windows, 40–42

computer software, 2–3. See also 

computer hardware

computer system, purchasing, 4–7

computing technology, history and 

background, 4

CONCATENATE function, 377

conditional formatting, 362–363, 476

connection speed, 55

contacts in Microsoft Outlook, 124–125

Contacts object, 405

context-sensitive Chart Tools ribbons, 

306

context-sensitive drawing toolbar, 465

context-sensitive ribbon in Word 2013, 

203, 205

context-sensitive SmartArt tools ribbons, 

309

contrast, 235

Control Panel, navigating Windows 

desktop, 27

Copy command, 139

Counterclockwise command, 443

COUNT function, 376

cover letter, writing, 149–151

cover page, 187–188

CPU. See central processing unit
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Design ribbon, 205

Microsoft Word 2013, 143

PowerPoint 2011, 306

PowerPoint 2013, 222, 225, 273, 309

PowerPoint Web App, 227

Design view, 406, 411, 425

creating field in, 408

saving table from, 409

working with, 405–406

desktop, 26

integrating OneDrive, 105–108

Windows 8, 14–15

desktop computer, 2

Detective tool, 477

dialog box, 26

dial-up connection, 55

Digital Subscriber Line (DSL), 56

directional fill, 340–341

disk formatting, 11

Dock, 31

Mac OS X, 17

navigating Macintosh OS X desktop, 

31, 32

Dock Preferences window, 33

Dock to Desktop, 445

document comparison in Word 2013, 

208–209

Document Elements ribbon, Microsoft 

Word 2011, 146

document management, 135–137

Document Map pane, 178–179

Microsoft Word 2011, 146

document review, 155–156

find and replace, 158–159

spelling and grammar check, 156–157

thesaurus, 157–158

documents

editing existing, 208

custom layout, creating in PowerPoint 

presentation, 315–316

Cut command, 139

D
Dashboard, navigating Macintosh OS X 

desktop, 32–33

data, 50

exporting, 391

importing, 391

database, 400

compressing and repairing, 414–415

creating, 402–403

database backups, 414

database table, creating, 403–405

Database Tools ribbon, 402, 419

data integrity, 411–413

DataPilot, 478

Data ribbon

Microsoft Excel 2011, 329, 330

Microsoft Excel 2013, 326, 327

Microsoft Excel Web App, 331

Datasheet view, 404

database instance in, 405

data storage, 11–12

data storage device, 3

data type, 409–411

data type character length, adjusting, 

410

Data Type Parts, 404

data validation, 385

Data Validation dialog box, 385

Decrease Decimal command, 334

Defense Advanced Research Projects 

Agency (DARPA), 51

Delete dialog box, 353

Delete icon, 211

delimiter, 358
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adding attachments, 87

addresses, 76–77

creating personal account

accounts types, 77–78

Gmail by Google, 84–87

Microsoft Windows Live Hotmail, 

78–84

deleting, 74

etiquette, 94–95

introduction, 74

in Microsoft Outlook

creating new email, 119–120

formatting email content, 120–121

incoming, 121–122

responding, 122

push technology, 76

remote connection, 93–94

saving a draft, 87

structure, 74–76

email client, 75, 87–88

advantage of, 88

Macintosh Mail, 90–91

Microsoft Outlook, 88

Microsoft Windows Live Mail, 88–90

Mozilla Thunderbird, 91–93

RTF format, 121

Encapsulated PostScript (EPS)  

format, 470

endnotes, 181–182

envelope, email structure, 74

EPS format. See Encapsulated PostScript 

format

equation in Word 2013, 203–204

Ergonomics, 6

Error Alert tab, 477

example letter for Mail Merge, 196

Excel. See Microsoft Excel

Excel spreadsheet, 400

comments, 210–211

comparison, 208–209

Track Changes, 209–210

outlining, 176

document templates, 159–160

domain name, 53

Domain Name Server (DNS) address, 53

Download Manager, 59

download speed, 55

drag-and-drop functionality, 445

Drawing toolbar, 477

Draw ribbon, 446, 447

driver, 8

Drop Cap, 201–202

DSL. See Digital Subscriber Line

dual-channels process, 280

duplicates, removing, 357–358

dynamic password, 19. See also static 

password

E
e-commerce, 58

editing in PowerPoint presentation, 312

creating custom layout, 315–316

hiding and showing slides, 316

opening and editing, 312–314

optimizing and exporting images from 

slides, 317

slide setup and orientation, 314–315

Edit menu, 443

Edit Relationships dialog box, 419, 420

electronic mail. See email

elements

arranging and grouping, 206–208

arranging, linking, and grouping, 

236–240

Elements toolbar, 462

email
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Finder, navigating Macintosh OS X 

desktop, 31–32

Find toolbar, 454, 470

Firefox, 52, 60–61

firmware, 7

flash drives, data storage, 11–12

Flash Player, 62

folders

creating, 35, 36, 38, 39

organizing in Windows and Mac, 

35–39

Font dialog box, 153

Font Effects tab, 477

font options in PowerPoint, 268, 269

Font panel, 152–153, 162

fonts, 152, 172–174

Fontwork Gallery, 465

footers, 162–163

Footnote and Endnote dialog box, 182

footnotes, 181–182

formatting elements, 361

comments, 363–364

conditional formatting, 362–363

tab color, 363

text boxes, 364–365

Force Quit, navigating Macintosh OS X 

desktop, 34–35

Format Background, 296

Format Cells dialog box, 333, 472, 473

Border tab, 336

Number tab, 333

Format command, 335

Format Movie ribbon,  

PowerPoint 2013, 300

Format Paintbrush icon, 458

format painter, 154–155

Format ribbon, 205, 306

for Drawing Tools, 229

Exit or Close command, 134

exporting data, 391

Exposé, navigating Macintosh OS X 

desktop, 33–34

expression builder, accessing, 428

external data management, 391–392

External Data ribbon, 402

external data sources, 391

external hard drives, data storage, 11

F
Fade In effect, 301

Fade Out effect, 301

Fair Use doctrine, 66

FALSE argument, 379

false negative, 157

false positive, 157

fanfare, 298

Fields ribbon, 405

File menu, 133–135, 414

commands, 134

for PowerPoint 2013 and 2011, 219

files, 39

options for saving, 136–137

organizing in Windows and Mac, 

35–39

saving and opening, 135

working in computer, 39–43

Fill command, 340

Fill Down command, 341

Filter Recipients, 201

filters, 356–357

find and replace, 158–159

Find and Replace dialog box, 158, 456

Find and Replace pane, Microsoft Word 

2011, 146

Find command, 158
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Full Screen view, Microsoft  

Word 2011, 147

Function Wizard, 382–383

G
GETPIVOTDATA function, 389, 478

Gmail by Google. See also Microsoft 

Windows Live Hotmail

composing an email, 86–87

creating an account, 84–85

logging out and logging in, 87

navigating and opening email, 85–86

Gmail message editing window, 86

Goal Seek, 389–390

Goal Seek dialog box, 390

Google Drive, 110, 478–479

document, 479–480

presentation, 480

spreadsheet, 480–481

Google search, 63

graphical user interface (GUI), 26

graphic elements, adding, 184–186

Graphic Styles dialog box, 465

gridlines, 183

GUI. See graphical user interface

H
Handout Master, modifying, 294–295

Handout Master ribbon, 295

handouts, creating, 294

modifying Handout Master, 294–295

modifying Notes Master, 295–297

Hand Tool, 444

hard drives, 5–6

data storage, 11

hardware. See computer hardware

hardware device

input, 3, 8–9

output, 4, 9–10

PowerPoint 2013, 298, 300, 309

Format Shape dialog box, 231, 232, 238

formatting cells, 335–336

formatting charts, 344–345

formatting columns, 184

formatting email, in Microsoft Outlook, 

120–121

formatting text, 151, 331–333

Font panel, 152–153

format painter, 154–155

Paragraph panel, 154

Formatting toolbar, 470, 471, 472

formatting values, 333–334

Format toolbar, 454

Formula Bar, 327

Excel 2013, 325

Formula Builder. See Function Wizard

formulas, 324

freezing cells in, 338–339

mathematical calculations, 337–338

SUM function, 339

using in Excel, 340

Formulas ribbon

Microsoft Excel 2011, 329

Microsoft Excel 2013, 326

Freeze Panes option, 336

freezing cells in formulas, 338–339

freezing panes, 336–337

functionality, 327

functions

calculation option, 383–385

common, 375–376

data validation, 385

Function Wizard, 382–383

IF statements and logic, 381–382

text, 377–378

tracing variables, 383

value lookup, 378–381
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Hypertext Transfer Protocol (HTTP), 51

protocol, 56–67

I
iCloud, 110

icon, 26

IF statements, 381–382, 389

iMac desktop, 16, 17

IMAP. See Internet Message Access 

Protocol

Inbox in Outlook 2013, 121

incoming mail port number, 94

incoming mail security settings, 94

incoming mail server, 94

Index, 189

indexing, 412

information, 50

inner and outer joins, implementing, 

428–430

input hardware device, 3, 8–9

Input Help tab, 477

Input Mask Wizard, 411, 412

Insert Address Block dialog box in Word 

2013, 198

Insert Caption dialog box, 186

Insert Chart dialog box, PowerPoint 

2013, 305

Insert Index/Table dialog box, 459, 460

Insert Placeholder menu, PowerPoint 

2013, 315, 316

Insert ribbon, 204, 446

Microsoft Excel 2013, 326

Microsoft Excel Web App, 330

Microsoft Word 2013, 142

Microsoft Word Web App, 148

PowerPoint 2013, 221, 225

PowerPoint Web App, 225, 226

processing, 10–11

Header and Footer dialog box, 268

Header & Footer Tools ribbon, Microsoft 

Word 2013, 162

headers, 162–163

of email, 75

Headers and Footers dialog box, 468

headphones, 10

help files, 137

hibernate, 19

hibernation mode, 19

Hide Slide icon, 316

Hide Slide option, 470

Highlight tool, 443

HLOOKUP, 380

homepage, 54

Home ribbon, 268, 269, 402, 445, 450

Microsoft Excel 2011, 328

Microsoft Excel 2013, 326

Microsoft Excel Web App, 330

Microsoft Word 2011, 145

Microsoft Word 2013, 142

Microsoft Word Web App, 148

in Outlook, 122, 123

in PowerPoint, 307

Word Font panel, 152

Word Paragraph panel, 154

Hotmail account, 77

Hotmail login portal, 78

Hotmail new message editor, 83

Hotmail registration form, 79

HTML. See HyperText Markup 

Language

HTTP. See HyperText Transfer Protocol

HyperText Markup Language (HTML), 

136

export format, 391

managing email in Outlook, 136
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leading, 173

LEFT function, 377

Libraries feature

to create new folder, 36

navigating Windows desktop, 29–30

Light Shading option, 205

Linear format for quadratic formula, 203

line chart, 365–366

linked media, 285

Linked Notes, 447–448

liquid crystal displays (LCDs), 9

list management, 354–355

removing duplicates, 357–358

table formatting, 360–361

text to columns, 358–360

using sorting and filters, 356–357

live presentations, 283–285

local area network (LAN), 54

logic function, 381–382

Lookup Wizard, 424

selecting, 422

Loupe Tool, 444

LOWER function, 378

M
Macintosh

Adobe Reader XI for, 444–445

Microsoft Word Notebook Layout 

View for, 449–451

organizing files and folders on, 38–39

Macintosh Mail, 90–91

Macintosh OS X desktop, 16–18

navigating, 31

Dashboard, Exposé, and Spaces, 

32–34

Dock, 32

Finder, 31–32

Force Quit, 34–35

Insert Table dialog box, PowerPoint 2013, 

302

Insert Table option, 204

Install Font, 174

intellectual capital, 2

internal hard drive, data storage, 11

Internet, 50. See also Web

searches, 63

Internet connections, types, 55–56

Internet Corporation for Assigned Names 

and Numbers (ICANN), 54

Internet Message Access Protocol 

(IMAP), 78

Internet Options dialog box, 64

Internet Service Provider (ISP), 54

connecting to Internet, 55–56

ISP. See Internet Service Provider

Issues object, 405

J
Jump List, navigating  

Windows desktop, 27

junction table, 417, 418

for many-to-many relationship, 418

K
kerning, 173

keyboard, 9

keyboard shortcut, 29

L
LAN. See local area network

laser pointer, using the mouse as, 284

layer visualization in Word 2011, 207

Layout ribbon, 205

Microsoft Excel 2011, 328

Microsoft Word 2011, 146

layouts modification, 280

LCDs. See liquid crystal displays
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Microsoft Access, working with 

relationships in, 415–424

Microsoft account, 89

creating, 102–103

Microsoft Clip Gallery, 246

Microsoft Excel, 324

anatomy, 324–325

Microsoft Excel 2011, 327–329

anatomy of, 328

Charts ribbon, 329

Data ribbon, 329, 330

Formulas ribbon, 329

Home ribbon, 328

Layout ribbon, 328

Review ribbon, 329, 330

SmartArt ribbon, 329

Tables ribbon, 328–329

Microsoft Excel 2013, 325–327

anatomy of, 325

Chart Elements menu, 343

completed budget headings in, 332

Data ribbon, 326, 327

formula in, 337

Formulas ribbon, 326

Freeze Panes functionality, 327

Home ribbon, 326

Insert ribbon, 326

mathematical calculations in, 337–338

monthly budget values in, 334

Page Layout ribbon, 326

Quick Layout menu, 343

Review ribbon, 326, 327, 363

View ribbon, 327

Microsoft Excel Web App, 329–331

anatomy of, 330

Data ribbon, 331

Home ribbon, 330

Insert ribbon, 330, 331

sleep mode, 19

viewing file information, 43

Mac OS X, OneDrive integration on, 

107–108

mail accounts preferences, 91

Mailings ribbon, Microsoft Word 2013, 

143, 196, 197, 198

Mail Merge, 196

Microsoft Word 2011, 200–201

Microsoft Word 2013, 196–200

OpenOffice Writer, 458–461

Mail Merge Manager in Word 2011, 200

Mail Merge Recipients dialog box in 

Word 2013, 197

Mail Merge wizard, 199

mail message composition window, 91

Mail Submission Agent (MSA), 74

Mail User Agent (MUA). See email client

malware, 64

managing email in Outlook, 52

many-to-many relationship, 420

creating, 417

junction table for, 418

outer join using, 430

Match Fields dialog box in Writer, 460

mathematical calculations, Excel, 337–

338

MAX, 376

Mayer, Richard, 266

Media, adding and organizing, 450–451

media elements, 364

media players, 62

Memo data, 409

menu, 26

Merge Cells, 352

Merge Formatting, 139

microphone, 9

Microprocessor, 6
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benefit of, 81

composing an email, 82–83

creating an account, 79–80

creating a password, 80

logging out and logging in, 83–84

navigating and opening email, 80–82

Microsoft Windows Live Mail, 88–90

Microsoft Windows OS, 12

Microsoft Word 2011, 144–147

anatomy of, 145

Document Elements ribbon, 146

Document Map pane, 146, 179

Find and Replace pane, 146

Full Screen view, 147

Home ribbon, 145

Layout ribbon, 146

Mail Merge in, 200–201

Notebook view, 147

Outline view, 147

Publishing view, 147

Reviewing pane, 146

Review ribbon, 146

Search pane, 159

Thumbnail pane, 146

Microsoft Word 2013, 141–144

anatomy of, 140–141

AutoCorrect options in, 156

bibliography and selection menu in, 

183

Design ribbon, 143, 177

Font icon selection in, 177

Footnote and Endnote dialog box, 182

Header & Footer Tools ribbon, 162

Home ribbon, 142

Insert ribbon, 142

Mailings ribbon, 143

Mail Merge, 196–200

Navigation pane, 178

View ribbon, 331

Microsoft Exchange accounts, 78

Microsoft Internet Explorer (IE), 58–59

Microsoft Office, OneDrive integration, 

108–109

Microsoft OneDrive, 102–103

uploading and downloading files, 

103–105

Microsoft OneNote, 445–449, 446, 449

anatomy of, 446

Microsoft Outlook, 116

adding contacts, 124–125

creating tasks, 125

managing contacts, 124–125

managing email

creating new email, 119–120

formatting email content, 120–121

incoming, 121–122

responding, 122

tasks and notes, 125

Microsoft Outlook 2011

anatomy of, 118–119

interface and ribbons, 118

message creation window and ribbons 

in, 119

Microsoft Outlook 2013

anatomy of, 116–118

interface and ribbons, 117

message creation window and ribbons 

in, 119

Microsoft PowerPoint 2011, 223–225

Microsoft PowerPoint 2013, 220–223

Microsoft PowerPoint, anatomy of, 

218–220

Web App, 225–227

Microsoft PowerPoint Viewer software, 

285

Microsoft Windows Live Hotmail
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N
narration, recording, 285

National Hot Dog & Sausage Council, 

277, 278

navigation

Macintosh OS X desktop, 31

Dashboard, Exposé, and Spaces, 

32–34

Dock, 32

Finder, 31–32

Force Quit, 34–35

process monitoring in Windows and 

Mac OS X, 31

spreadsheets, 341–342

Windows desktop, 26–27

Control Panel, 27

Jump List, 27

Libraries feature, 29–30

Task Manager, 27–29

Navigation pane, 116, 140, 141, 158, 

178–179

tabs, 144

nesting functions, 376

Netscape®, 52

network, 50

network adapter, 53

Network Interface Card, 53

New command, 134

New Document, 138

New Slide command, 221

New Style from Selection option, 458

New Technology File System (NTFS), 11

NeXT™ computer, 51

Nonprinting Characters, 462

Normal style, 177

Notebook Layout View, 449–450, 451

Notebooks, saving and sharing, 448–449

Notebook view, 449

Page Layout ribbon, 143

References ribbon, 179, 180

Review ribbon, 143

Styles pane, 177

Table of Contents dialog box, 188, 189

View ribbon, 143, 144

versus Word 2011, 144

Microsoft Word Notebook Layout View 

for Macintosh, 449–451

Microsoft Word Web App, 147–149

Home ribbon, 148

Insert ribbon, 148

Review ribbon, 148

Share option, 149

View ribbon, 148

MIME. See Multipurpose Internet Mail 

Extensions

MIN, 376

monospacing, 172, 173

motherboard, 7

mouse, 9, 26

Movie (.mov), 286

Mozilla Firefox, 52, 60–61

Mozilla Thunderbird, 88, 91–93

account settings, 92

email message composition window, 

93

interface, 92

security feature, 93

Multipurpose Internet Mail Extensions 

(MIME), 76

MyBrokenRobot presentation, 312–314

MyBusinessWorkbook, 374–375

My Documents folder,  

new folder in, 36, 37

MyMergeDocument, 196, 197

MySalesPitch file, 295
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OpenOffice Calc, 470–478

adding charts in, 474

advanced features of, 475–478

anatomy of, 470–471

creating a budget in, 472–474

OpenOffice Impress, 461–470

advanced features of, 468–470

anatomy of, 463–464

completing projects in, 464–467

OpenOffice Impress tab, 469

OpenOffice Math, 462

OpenOffice Writer, 453–461

open source, 52

operating system (OS), 3, 6, 12

file properties, 43

Windows 7, 13–14

Windows 8, 14–16

Options button, 478

Options dialog box, 317, 467

OR function, 381

organizing files and folders

on Mac, 38–39

in Windows, 35–37

OS. See operating system

outer joins, implementing inner and, 

428–430

outgoing mail security settings, 94

outgoing mail server, 94

Outline view, Microsoft Word 2011, 147

outlining, document, 176

output hardware device, 4, 9–10

P
page breaks, 187

page layout

setting, 183–184

adding graphic elements and 

captions, 184–186

Microsoft Word 2011, 147

Note Flags Panel, 450

Notes, adding and organizing, 450–451

Notes Master, modifying, 295–297

Notes Master ribbon, 296

NOT function, 381

NTFS. See New Technology File System

numbering, 155

Number panel, formatting values, 333

Number tab, Format Cells dialog box, 333

numerical functions, 377

O
object grouping, 206, 207

Objective-C®, 51

OneDrive, 147. See also cloud computing

accessing on remote device, 110

creating a new Word file, 148, 149

document storing, 163

file management in, 105

integration

on Mac OS X, 107–108

with Microsoft Office, 108–109

Windows 7, 105–106

Windows 8, 106–107

interface, 103, 104

saving a file to, 109

sharing a Word document in, 149

OneNote, printing to, 448

one-to-many relationship, 416, 420

establishing, 421

setting, 422

one-to-one relationship, 416

Open command, 134, 208

Open dialog box, 141

Open Document, 138

OpenDocument Format, 137

opening slide, example of, 277, 278
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constructing, 387–388

values in formulas, 388–389

pixel, 172–173

Plain text, 136

Playback ribbon, PowerPoint 2013,  

298–299, 300

plug-in, Web browser, 62

PMT function, 390

POP3, 78

Port 25, 78

Portable Document Format (PDF) file, 

136, 441, 442

power button of computer, 7

PowerPoint 2011, 261, 285, 286

Chart Layout ribbon, 306

Charts ribbon in, 306

Design ribbon, 306

SmartArt ribbon, 309

Table Layout ribbon, 304

Table Tools ribbons, 303

PowerPoint 2013, 275

Animations ribbon, 310–312

audio icon and audio tools ribbons in, 

298

complex animation sequence in, 311

Design ribbon, 303, 309

Fade In and Fade Out effects, 301

Format Movie ribbon, 300

Format ribbon, 298, 300, 309

Handout Master interface in, 295

Insert Chart dialog box, 305

Insert Placeholder menu, 315, 316

Insert Table dialog box, 302

Notes Master interface in, 296

Page Setup dialog box, 314

Playback ribbon, 298–299, 300

print options for, 294

Slide Size dialog box, 314, 315

formatting columns, 184

modifying page sizes, 184

Page Layout ribbon, 206

Microsoft Excel 2013, 326

Microsoft Word 2013, 143

Page Layout tab, 469

Page Setup dialog box, 470

PowerPoint 2013, 314

Page Style dialog box, 458, 459

pane, 26

Paragraph dialog box, 154

Paragraph panel, 154, 162. See also Font 

panel

partition, 11

Paste command, 139

Paste options in Excel 2013, 355

Paste Special option, 476

PC. See personal computer

PDF file. See Portable Document Format 

file

personal account, creating

Gmail by Google

composing an email, 86–87

creating an account, 84–85

logging out and logging in, 87

navigating and opening email, 

85–86

Microsoft Windows Live Hotmail, 

78–79

composing an email, 82–83

creating an account, 79–80

logging out and logging in, 83–84

navigating and opening email, 

80–82

types, 77–78

personal computer (PC), 6

picture superiority effect, 280

pivot table, 326, 387
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presentation software,  

introduction to, 218

Presentation Wizard, 463

Presenter view, 283, 284

primary key, 406–409, 418

creating, 414

Print command, 134

Print Document, 138

printer, 9

Print Preview, viewing a report in, 431, 

432

privacy and security, Web, 63–66

process monitoring, Windows and Mac 

OS X, 35

productivity shortcuts, 137–138

productivity software, 132

document management, 135–137

File menu, 133–135

help files, 137

productivity shortcuts, 137–138

system clipboard, 138–139

proportional spacing, 173

Publishing view, Microsoft Word 2011, 147

push technology, email, 76

Q
quadratic formula, linear format for, 203

queries, data manipulation using, 424–

430

query design, 425–428

Query Design view, inner join in, 429

Query Wizard, 425

Quick Access Toolbar, 141, 145, 328, 445

for PowerPoint 2011, 224

Quit, 138

R
RAM. See random-access memory

random-access memory (RAM), 5

SmartArt Graphic dialog box, 308

SmartArt Tools Design ribbon in, 308, 

309

Table menu from Insert ribbon in, 303

Trigger attribute, 312

Trim Audio dialog box in, 299

video tools playback ribbon and pop-

up video menu in, 300

PowerPoint presentation, editing in, 312

creating custom layout, 315–316

hiding and showing slides, 316

opening and editing, 312–314

optimizing and exporting images from 

slides, 317

slide setup and orientation, 314–315

PowerPoint Web App, 225–227

presentations, 274, 283–287

building the need for, 277–279

diving into, 227–228

adding text and hyperlinks,  

240–244

arranging, linking, and grouping 

elements, 236–240

clip art and screenshots, 244–249

inserting, manipulating, and 

cropping images, 234–236

screenshots, inserting, 250–251

shapes, inserting and formatting, 

230–233

sorting slides, 249–250

text formatting, 228–230

transitions, 251–252

exporting your, 287

Google Drive, 480

grabbing attention in, 277

main contribution, 279–281

outline for, 274–276

sharing, 285–287
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Microsoft Word Web App, 148

PowerPoint 2011, 225

PowerPoint 2013, 222, 225

Word 2013, 208

ribbon interface, 88

in Outlook 2013, 116

ribbon user interface, 88

Rich Text Format (RTF), 136

RIGHT, 377

ROM. See read-only memory

ROUND, 376

router, 54

rows, 324. See also columns

adding and deleting, 352–353

hiding, 353–354

RTF. See Rich Text Format

S
sans-serif, 172

Save As command, 134

Save As dialog box, 135, 140, 463

Save command, 134

Save Database As option, 414

Save Document, 138

Save Workspace command, 392

Scalable Vector Graphics (SVG) format, 

470

Scatter chart, 367–368

Scheduling Assistant in Outlook 2013, 

124

screenshots, inserting, 250–251

ScreenTip button, 243

search engine, 62–63

search history, 64

Search pane, 179

in Word 2011, 159

Select All command, 342

Select All Content, 138

RDBMS. See relational database 

management system

read-only memory (ROM), 5

recipient list for Mail Merge, 196

Recolor in PowerPoint 2011, 235

record narration, 285

Redo command, 220

Redo Last Action, 138

References ribbon, 179, 180

rehearse timings interface, 283, 284

relational database management system 

(RDBMS), 400, 401

Relationships tool, 419

Remove Duplicates command, 326

Remove Hyperlink in PowerPoint 2013, 

244

Replace command, 158

Report Layout Tools, 431

reports, learning to develop, 430–432

Report Wizard, 431

research article, writing, 174–176

outlining the document, 176

using and managing styles, 176–178

using Navigation pane and Document 

Map pane, 178–179

Reset Picture, 235

restarting computers, 20

resume writing, 160–162

Reveal Formatting tool, 208

Reviewing pane, 209

Microsoft Word 2011, 146

Review pane, 179

Review ribbon, 446

Excel 2013, 363

Microsoft Excel 2011, 329, 330

Microsoft Excel 2013, 326, 327

Microsoft Word 2011, 146

Microsoft Word 2013, 143
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branding your, 269–274

PowerPoint presentation

hiding and showing in, 316

optimizing and exporting images 

from, 317

slide setup in PowerPoint presentation, 

314–315

Slide Show ribbon in PowerPoint 2013, 

222

Slide Show view, 223, 225

Slide Size dialog box, PowerPoint 2013, 

314, 315

slide sorter view, 249

Slides/Outline pane, 223, 225

SmartArt, 307–310, 469–470

SmartArt Graphic dialog box, 

PowerPoint 2013, 308

SmartArt graphics, 282, 309

SmartArt in Word and charts, 202

SmartArt ribbon

Microsoft Excel 2011, 329

PowerPoint 2011, 309

SmartArt Styles panel, 309

SMTP. See Simple Mail Transfer Protocol

soften setting, 235

software suite, 132

sorting, 356–357

sorting slides, 249–250

sound, PowerPoint, 297–301

spaces

configuration settings, 34

navigating Macintosh OS X desktop, 

33–34

Sparklines, 326, 365

speakers, 9–10

spelling and grammar check, 156–157

split cells, 352

Split command, 392

Select Tool, 443

Send Backward icon, 207

Send/Receive ribbon in Outlook 2013, 

116

sequences, spreadsheets, 334

serif, 172, 173

shapes

adding and formatting, 205–206

inserting and formatting, 230–233

shapes menu in Word 2013, 205

Share option, Microsoft Word Web App, 

149

sharpen setting, 235

shortcuts, 137–138

Show Table dialog box, 415–416, 419, 426

Shut Down menu, 19

shutdown options, 18

shutdown procedures, 18–20

Sidebar, Mac OS X, 17

Sign tool, 445

simple form, developing, 432–434

Simple Mail Transfer Protocol (SMTP), 

74, 78

SkyDrive, 102, 448, 449

sleep mode, Macintosh OS X desktop, 19

sleep, shutdown procedure, 18

slide, 224

slide footers, adding and formatting, 

267–268

Slide Master, 222, 260

Bullets and Numbering in, 266–267

formatting text on, 268–269

modification of, 261

Slide Master ribbon, 261

slide notes, adding, 275

slide orientation in PowerPoint 

presentation, 314–315

slides
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PowerPoint 2011, 304

Table of Authorities, 189–190

table of contents, 188–190

Table of Contents dialog box, 188, 189

Table of Figures, 189

tables

adding, 204–205

typing, 205

word processing software in, 301–304

Tables ribbon, 205

Microsoft Excel 2011, 328–329

Table1 tab, 407

Table Tools ribbons, PowerPoint 2011, 

303

Taskbar and Start Menu Properties, 29

task manager, 30

Gmail, 85

navigating Windows desktop, 27–29

Tasks object, 405

templates, 159–160

creating, 273–274

Templates and Documents dialog box, 

457

text

adding and formatting, 331–333

converting to columns, 358–360, 378

formatting. See formatting text

text box, 364–365

adjusting width and height of, 434

in Word, 201

Text data, 409

TextEdit for Macintosh, 42–43

Text Effects, 230

Text Filters option, 356

text flow. See text wrapping

text formatting, 228–230

text function, 377–378

in January Sales spreadsheet, 379

spreadsheets

adding and formatting text, 331–333

adding basic formulas, 337–340

versus database, 374

formatting cells, 335–336

formatting values, 333–334

freezing panes, 336–337

Google Drive, 480–481

navigating, 341–342

using directional fill, 340–341

using sequences, 334

spreadsheet software, 324

SQL view, 425

working with, 428

Standard toolbar, 454, 455

static password, 19

styles, 174, 176

using and managing, 176–178

Styles and Formatting pane, 458

subfolder, 39

Subtotal command, 386

Subtotal dialog box, 386, 387

subtotals, 385

constructing, 386–387

group cells, 385–386

SUM function, 339, 375–376

Suppliers tab, 375

SVG format. See Scalable Vector 

Graphics format

symbol in Word 2013, 202

system clipboard, 138–139

System Preferences, 32

T
tab color, 363

Table button, 404

table formatting, 360–361

Table Layout ribbon, 205
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U
Undo Last Action, 138

Ungroup command, 478

Uniform Resource Locaters (URLs), 54

individual pieces of, 56–57

Uninterruptable Power Supply (UPS), 19

unmerging cells, 352

upload speed, 55

UPPER function, 377–378

UPS. See Uninterruptable Power Supply

URLs. See Uniform Resource Locaters

Users object, 405

V
validation, 411–413

VALUE function, 378

value lookup, 378–381, 389

value proposition, 260

variables, tracing, 383

video cameras, 9

video cards, 6, 8

Video option in PowerPoint 2013, 286

video, PowerPoint, 297–301

Video Tools ribbons, PowerPoint 2013, 

300

View ribbon, 446, 447

Microsoft Excel 2013, 327

Microsoft Excel Web App, 331

Microsoft Word 2013, 143, 144

Microsoft Word Web App, 148

PowerPoint 2013, 222, 226

PowerPoint Web App, 227

visual design of presentation, 262

visualization, effective, 280

visualizing layers in PowerPoint 2011, 

239

visual style, establishing, 260–261

branding your slides, 269–274

Text Highlight Color option, 153

Text Shadow icon, 268

Text to Columns command, 326

text wrapping, 185

theme, assigning, 262–263

theme colors to blend text, 271, 272

Theme selection in PowerPoint 2013, 

263, 264

Themes ribbon in PowerPoint 2011, 224

thesaurus, 157–158

3G/4G networks, 56

thumb drives. See flash drives

Thumbnail pane, 179

Microsoft Word 2011, 146

Times New Roman, 172

Timing panel, 312

toolbar, 26

Tools ribbon in Outlook 2011, 118

Top-Level Domain (TLD), 57

trace dependents, 384

trace precedents, 384

TRACERT command, 54

Track Changes in Word 2013, 209–210

tracking, 173

transitions, 251–252

Transitions ribbon, 226

Trigger attribute, PowerPoint 2013, 312

Trim Audio dialog box in PowerPoint 

2013, 299

Trim Audio interface, 301

TRUE argument, 379

TrueType font, 173

two-column slide layout, example of, 278, 

279

two-level bullet list, 241

typespace, 172

typing tables, 205

typography, 172–174
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Web Page format, 136

Web portal, 3

Web server, 51

Website, 51

what if analysis, 389–390

wide area network (WAN), 54

Windows, 26

organizing files and folders, 35–37

Windows 7, 13–14

font preview, 174

OneDrive integration in, 105–106

Start menu, 27

Windows 8, 14–16

OneDrive integration in, 106–107

Windows desktop, 26–27

navigating

Control Panel, 27

Jump List, 27

Libraries feature, 29–30

Task Manager, 27–29

Windows Live ID, 89

Windows Live Mail 2011 interface, and 

Accounts ribbon, 89

Windows Media Video (.wmv), 286

wireless 3G/4G networks, 56

wizard, 196

Word Help interface, 137

WordPad on Windows, 40–42

word processing, 140

additional document elements,  

201–206

arranging and grouping elements, 

206–208

bullets and numbering, 155

document review, 155–156

find and replace, 158–159

spelling and grammar check, 

156–157

Bullets and Numbering in Slide 

Master, 266–267

colors, fonts, and effects, 263–265

design, planning your, 262

formatting text on Slide Master, 

268–269

slide footers, adding and formatting, 

267–268

Slide Master, modifying, 261

theme, assigning, 262–263

VLOOKUP. See value lookup

Voice over IP (VoIP), 55

VoIP. See Voice over IP

W
WAN. See wide area network

watermarks, 187

Web, 50

addresses on, 56–57

background and history, 50–52

connecting to Internet, 55–56

and fair use, 66

privacy and security, 63–66

using search engines to find, 62–63

working of, 52–54

Web-based application, 3

Web browser plug-in, using, 62

Web browsers, 51–52

using, 56

addresses on Web, 56–57

Apple Safari, 61–62

installing, 61

Microsoft Internet Explorer (IE), 

58–59

Mozilla Firefox, 60–61

Web crawler service, 62–63

Webmail clients, 78

Web page, 52
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worksheet, constructing, 352

adding and deleting rows and 

columns, 352–353

advanced cell reference, 354

hiding rows and columns, 353–354

merging and splitting cells, 352

workspace, arranging, 392

World Wide Web. See Web

Wrap Text command, 332

Writer

advanced features of, 461–462

anatomy of, 454–455

completing cover letter in, 455–456

completing the resume in, 457–458

Mail Merge in OpenOffice, 458–461

X
XML, export format, 391

XML Paper Specification (XPS), 136

XPS. See XML Paper Specification

thesaurus, 157–158

document types for saving file, 163

editing existing documents, 208–211

formatting text, 151

Font panel, 152–153

format painter, 154–155

Paragraph panel, 154

Mail Merge, 196–200

using document templates, 159–160

using headers and folders, 162–163

writing a cover letter, 149–151

writing a resume, 160–162

word processing documents, setting page 

layout, 183

word processing software, 140. See also 

productivity software

in tables, 301–304

writing research article, 174–179

workbook, 324
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